# Table of Contents

1. Introduction ................................................................................................................. 1
   - Welcome to TreeAge Pro .......................................................................................... 1
   - TreeAge Pro Interface ............................................................................................ 1
   - Get technical support ............................................................................................. 1
   - What's New in TreeAge Pro ................................................................................. 2

2. Using TreeAge Pro ....................................................................................................... 15
   - Get Started Layout ............................................................................................... 15
   - Launch Pad ............................................................................................................ 18
   - Model Building Assistants ................................................................................... 19
   - Tree Editing/Reporting Pane ............................................................................... 21
   - Tree Diagram Editor ............................................................................................ 22
   - Tips for Navigating TreeAge Pro ........................................................................ 25
   - Controlling the display with perspectives/layouts ........................................... 29
   - TreeAge Pro Views ............................................................................................... 33

3. Example Models and Files ........................................................................................ 38
   - Example Models ................................................................................................... 38
   - Create a project/folder for your models/documents ............................................. 40
   - Working within a project/folder - saving and comparing models ...................... 41

4. Get Started with Decision Analysis .......................................................................... 43
   - What is decision analysis? .................................................................................... 43
   - Modeling ................................................................................................................ 43
   - Expected values and optimal decisions ............................................................... 44
   - Sensitivity analysis ............................................................................................... 45
   - Decision tree structure ....................................................................................... 45
   - Further reading ...................................................................................................... 46

5. Get Started - Building a Decision Tree Model ......................................................... 47
   - Defining the problem ............................................................................................. 47
   - Create the tree structure ..................................................................................... 48
   - Setup Model Configuration .................................................................................. 53
   - Entering payoff values ......................................................................................... 57
   - Entering probabilities ........................................................................................... 60
   - Calculating the tree ............................................................................................. 61
   - Next steps .............................................................................................................. 62

6. Get Started - Building a Healthcare Decision Tree Model .................................... 64
   - Defining the problem ............................................................................................. 64
   - Create the tree structure ..................................................................................... 65
   - Setup Model Configuration .................................................................................. 69
   - Entering payoff values ......................................................................................... 74
   - Entering probabilities ........................................................................................... 78
   - Calculating the tree ............................................................................................. 79
   - Next steps .............................................................................................................. 81

7. Influence Diagrams .................................................................................................. 82
   - Influence diagrams ............................................................................................. 82
   - Constructing an influence diagram ...................................................................... 82
   - Converting an influence diagram to a decision tree ......................................... 89

8. Printing and Presenting Trees .................................................................................. 91
   - Printing ................................................................................................................ 91
   - Exporting Pictures ............................................................................................... 92
36. Building and Analyzing Markov Models .............................................................. 561
   Traditional versus Within-Cycle Correction Models ........................................ 561
   Markov modeling basics ...................................................................................... 561
   Building a Markov cycle tree in TreeAge Pro ................................................... 564
   Analyzing a Markov model ................................................................................. 585
   A note on microsimulation .................................................................................. 609
   Cost-effectiveness Markov models ...................................................................... 610
37. Markov Modeling Tools and Techniques .......................................................... 614
   Keywords and time-dependence ......................................................................... 614
   Discounting Rewards .......................................................................................... 618
   Probability/rate conversion functions .................................................................. 619
   Converting Distributions to Transition Probabilities - DistTransProb ................. 621
   State/transition probability functions .................................................................. 624
   Half-Cycle Correction ....................................................................................... 625
   Assigning onetime costs and utilities .................................................................. 626
   Cloning Markov models ...................................................................................... 630
   Counting "time in state" with tunnels .................................................................... 634
   Markov decision processes ................................................................................ 641
   Extra Rewards ...................................................................................................... 641
   Other advanced Markov options ......................................................................... 642
38. Partitioned Survival Analysis ............................................................................ 648
   Introduction to Partitioned Survival Analysis ...................................................... 648
   Partitioned Survival Analysis: An Example ....................................................... 648
   Build Partitioned Survival Analysis (PartSA) Model Structure ......................... 652
   Enter Partitioned Survival Analysis Node Inputs ............................................... 652
   Enter Survival Curve Node Inputs ...................................................................... 654
   Survival Functions ............................................................................................... 655
   Survival Curve Graph .......................................................................................... 665
   Accumulating Value (Adding Costs and Utilities) ............................................. 666
   PartSA Analysis and Reporting .......................................................................... 675
   PartSA and Other Analyses ................................................................................ 679
   Three-State PartSA Model .................................................................................. 681
   Survival Curve Crossovers ................................................................................ 682
   Converting a PartSA model to a Markov model ............................................... 684
   Generating PartSA Survival Curve from a Markov Model ............................... 686
39. Markov to Excel Conversion ............................................................................. 687
   Capability Overview ............................................................................................ 687
   Convert a Markov Decision Tree to Excel .......................................................... 688
   Structure of the Workbook ................................................................................ 691
   Tunnels in Excel models ...................................................................................... 707
   Within-Cycle Correction in Excel models ........................................................ 709
   Discounting in Excel models .............................................................................. 711
   Validation prior to conversion .......................................................................... 713
   TreeAge Pro features supported by the conversion process ............................ 713
   License eligibility ............................................................................................... 714
40. Export Model Scenarios to Excel ................................................................. 715
   Export Model Scenarios to Excel Wizard ........................................................... 715
   Examine the Excel Model .................................................................................... 719
41. Individual-Level Simulation ............................................................................ 725
47. State Transition Diagrams

State transition diagrams ........................................................................................................ 851
Constructing a state transition diagram .................................................................................. 851
Converting a state transition diagram to a decision tree ....................................................... 856
Converting a Markov model to a state transition diagram .................................................... 857

48. Model Dashboard and Documentation

Using the Model Dashboard ..................................................................................................... 859
Create Model Documentation Help File ................................................................................ 860

49. Model Debugging and Validation

Debug Using the Calculation Trace Console ......................................................................... 863
Using Debug functions to control output .............................................................................. 871
Model Debugging examples .................................................................................................. 875
Model Validation ................................................................................................................... 875

50. Preferences

Tree Preferences ...................................................................................................................... 879
Tree Preference Sets ............................................................................................................... 880
Tree Preferences Dialog ........................................................................................................ 882
Calculation Method ................................................................................................................ 882
Payoff Preferences ................................................................................................................ 887
Numeric Formatting ................................................................................................................ 890
Roll Back ................................................................................................................................. 892
Risk Preferences ................................................................................................................... 893
Regional Settings .................................................................................................................. 894
Other Calc Settings ............................................................................................................... 896
Tables .................................................................................................................................... 897
Markov/DES .......................................................................................................................... 898
PartSA .................................................................................................................................... 899
Fonts ....................................................................................................................................... 900
Node Text/Comments ............................................................................................................ 902
Printing .................................................................................................................................... 903
Terminal Columns .................................................................................................................. 904
Terminal Nodes ...................................................................................................................... 906
Tree Editing/Layout ............................................................................................................... 907
Variables/Markov Info ........................................................................................................... 908
Dynamic Links ...................................................................................................................... 909
Identifying Variables ............................................................................................................. 909
Debugging/Calculation Trace ................................................................................................. 910
51. Technical Details & Utilities ......................................................................................................................... 926
   TreeAge Pro products and modules ................................................................................................................ 926
   Node Types .................................................................................................................................................. 926
   Random number generator details ................................................................................................................ 928
   Report Output Files (*.rptx) .......................................................................................................................... 928
   Importing TP 2009 Simulation Output ........................................................................................................ 930
   TreeAge Pro News Reader ............................................................................................................................. 931
   Integration with other software ...................................................................................................................... 932
   Installation and system requirements ........................................................................................................... 932
   Cross-Platform Compatibility ....................................................................................................................... 932
   File compatibility ........................................................................................................................................ 933
1. Introduction

You have installed TreeAge Pro Healthcare - primarily used for health economic modeling.

If you work in the areas of business, law or oil/gas, you likely have the wrong product. Please contact sales@treeage.com for assistance.

1.1 Welcome to TreeAge Pro

TreeAge Pro implements the techniques of decision analysis in a visual, intuitive and easy-to-use manner. It transforms decision analysis from a potentially tedious exercise into an easily applied means of:

1. Organizing the decision making process;
2. Analyzing the problem at hand; and
3. Communicating the structure of the problem, the nature of the uncertainties, and the basis for a strategy recommendation.

If you are experienced in decision analysis, you will find TreeAge Pro easy to use following only a cursory review of the software commands, although the richness of the program will become more apparent with further study of the manual.

If you are looking for features added to recent releases, please refer to the What's New in TreeAge Pro section of this chapter.

If you have no, or only limited experience with decision analysis, TreeAge Pro will make it much easier to learn. Go to the Get Started with Decision Analysis Chapter for a basic decision analysis theory. Then proceed to either the Get Started - Build a Decision Tree Model (non-Healthcare) Chapter or Get Started - Building a Healthcare Decision Tree Model Chapter. Each chapter provides step-by-step instructions for building and analysing an example model.

1.2 TreeAge Pro Interface

TreeAge Pro Interface is based on the Eclipse development environment. For an introduction to the layout of interface and navigation tips, please refer to the Using TreeAge Pro chapter.

1.3 Get technical support

There are several ways to get help in using TreeAge Pro.
1.3.1 Using the online help

TreeAge Pro installs with the Online Help you are currently reading. This Help is quite extensive and describes both modeling techniques and technical aspects of TreeAge Pro. Use the search field at the top of the Help View to look for help with specific topics.

1.3.2 Technical support and web site resources

The support section of our web site includes a variety of information for users of the software:

http://www.treeage.com/support

Resources available via this page include the following:

- Access to the Knowledge Base.
- Submit a request for technical support.
- Contact us by phone for support.
- Product demos.
- This manual in pdf.

1.3.3 Example models

Most topics in this manual include references to Example Models, which are installed on your computer with TreeAge Pro. The Example Models and Files Chapter describes how to access these models.

1.4 What’s New in TreeAge Pro

This section identifies new features in the latest releases.

1.4.1 TreeAge Pro 2020, Release 1

The following features are included in TreeAge Pro 2020, Release 1:

- Model Calibration
  - Calibration allows you to automatically adjust model input values to match results to targets based on observed clinical data.
  - The calibration process then adjusts the input values iteratively until the model generates outputs that best match your targets.

- Partitioned Survival Model Enhancements
  - Use Hazard Functions to measure survival against time.
  - Convert PartSA models to Markov models with initial estimates of transition probabilities.
  - Incorporate Exit Rewards (typically costs) into your model.
- Generate Reward Graphs from the PartSA Time Report.

- Markov to Excel Conversion
  - The Excel workbook format was significantly enhanced based on customer feedback.

- Variable Sets/Data Scenarios
  - Store different sets of root node variable definitions within a model to analyze it under different scenarios.

- PERT distribution
  - The PERT distribution is useful as it represents a continuous, yet bounded distribution based on the Beta distribution. You can use this instead of a Triangular distribution when you want your samples bounded.

- Distribution PDF/CDF
  - When creating and parameterizing your distributions, you can now see the probability density and cumulative distribution graphs to help validate that your distribution is appropriate.

- Enhanced Probability Normalization
  - Normalization for branch node probabilities was enhanced to allow the use of the hashtag for one of the branch probabilities. Normalization only occurs if the other probabilities exceed 100%.

- Enhanced PSA report
  - We enhanced the All Data Report from Probabilistic Sensitivity Analysis to include columns for each strategy's Net Monetary Benefit and which strategy is optimal for that model calculation.

- TreeAge Pro Business
  - TreeAge Pro Business is now a separate product, so non-healthcare modelers have a streamlined interface uncluttered by features that do not apply.

### 1.4.2 TreeAge Pro 2019, Release 2

The following features are included in TreeAge Pro 2019, Release 2:

- Partitioned Survival Analysis
  - Quickly and easily build PartSA models that track state membership based on survival curves derived from parametric distributions or from Kaplan-Meier curves.
- Use PartSA models within the familiar TreeAge Pro modeling framework to take advantage of built-in tools for cost-effectiveness analysis, sensitivity analysis, probabilistic sensitivity analysis, etc.
- Convert PartSA Models to Markov Pathways.

- Generate PartSA Survival Curves from Markov Models
  - Convert a PartSA model to the Markov model structure to add elements beyond the scope of the PartSA modeling technique – more complex transitions, patient simulation, etc.

- Correlation of Model Inputs
  - Generate PartSA survival curves to validate that disease progression within a Markov model matches up with your known survival data. Use this to calibrate your model.
  - Multi-Normal distributions have always handled correlated parameters and patient characteristics. Entry of Multi-Normal distributions was fully redesigned for ease and clarity of use.

- Sensitivity Analysis ICER Graphs
  - Sensitivity Analysis ICER Graphs were enhanced to include CE thresholds and to highlight points of discontinuity where the ICER is undefined due to incremental effectiveness of 0.

- Tornado Diagrams
  - Tornado diagrams were enhanced to include the base case parameter value and the order (low to high or vice versa) can be matched to the increasing or decreasing output values.

The following features were included as part of Release 2, but were not made public until TreeAge Pro 2019, R2.1.

- Improved Seeding Options
  - You now have better control over seeding for repeatable results from the overall analysis and from inner loop calculations within complex analyses like sensitivity analysis, PSA and EVPPI.

- Faster Sensitivity Analysis with Microsimulation
  - The Sensitivity Analysis/Microsimulation process was restructured to run more efficiently as a unified analysis.
  - You can still run the old way by choosing the slower pre-2019 option.

- 2-way and 3-way Sensitivity Analysis with Microsimulation
  - With the new Sensitivity Analysis/Microsimulation process, you can now run both 2-way and 3-way Sensitivity Analysis with Microsimulation.
1.4.3 TreeAge Pro 2019, Release 1

The following features are included in TreeAge Pro 2019, Release 1:

- Improved User Experience - This release makes it easier than ever to get started with TreeAge Pro, and it helps experienced users learn new tips and work more efficiently.
  
  - Get Started Layout: When you start TreeAge Pro for the first time, you will be presented with a simplified layout that highlights the most commonly used modeling tools and analyses. When you’re ready, simply choose another layout to see the full set of features.
  - Launch Pad: The TreeAge Pro Launch Pad directs you to your next task so you can move forward quickly.
  - Assistants: Model building Assistants are now available to walk you step by step through the process of building and analyzing cost-effectiveness decision trees and Markov models.
  - Intro Videos: Short videos show you how navigate the TreeAge Pro interface and perform initial model building tasks.

- Export Model Scenarios to Excel - Create an Excel workbook with results generated from your TreeAge Pro model using different data scenarios. Results from any kind of model can be shared including decision trees, Markov models, patient simulation models and discrete event simulation models.

- Improved Reporting
  
  - Numeric Reports: Improved with gridlines, shading, numeric formatting and custom payoff headings to improve readability.
  - ICE Scatterplot: Improved readability of the WTP line within the graph. Streamlined Preferences Preferences were streamlined to make it easier to customize both the TreeAge Pro software and individual models.

- Python - Connect TreeAge Pro to a specific version of Python installed on your computer.

- Excel Export - Free Access to the two Excel export capabilities, Markov to Excel and Export Model Scenarios to Excel is extended through 2019 on Full TreeAge Pro Healthcare Licenses (not student licensed). Note that you will need to repeat the authorization process in your software to extend access to this capability from the end of 2018 to the end of 2019.

1.4.4 TreeAge Pro 2018, Release 2

The following features are included in TreeAge Pro 2018, Release 2:

- Tornado Diagram - Cost-effectiveness models now support additional outputs including Incremental Net Monetary Benefits, Incremental Cost and Incremental Effectiveness (INMB, IC and IE) tornado diagrams. Models with a single primary payoff now support the additional output Incremental Expected Value (IEV) tornado diagram.
- Tornado Diagrams for Microsimulation Models - In addition to 1-way sensitivity analysis for microsimulation models, this version now supports Tornado diagrams for individual patient simulation models.
- Sensitivity Analysis Outputs - Sensitivity analyses, including 2-way and 3-way, now provide more text-based reports. These reports have more options to look at different parameter combinations. These reports are easily exported to Excel for additional processing outside TreeAge Pro.
- Cohort-Level Patient Flow Reports for DES Models - The Time Reporting tools have been extended to generate cohort-level reports (similar to Markov cohort reports) for DES models. Continuous time-based events are aggregated into Markov-like cycles to provide visibility/transparency for patient flows.
- Print/Export Model Wizard - Use the new wizard to print and generate image files for model structure (tree diagram). Hide/show numeric elements in the model. Split up large models into separate images.

1.4.5 TreeAge Pro 2018, Release 1

The following features are included in TreeAge Pro 2018, Release 1:

- Dynamic Cohort - Easily add to your cohort size for cohort or simulation models using the new “Entry” node type. Cohort reports now provide data based on the cohort size for dynamic cohort models.
- Parallel Patient Simulation - Create interaction among individual patients using Python scripts to review and update patient data based on a global view of the model. This will help you introduce resource constraints and patient-to-patient interaction into your models.
- Enhanced Debugging Trace - Validate your model by generating debugging trace for specific calculations and/or for a subset of the full analysis.
- Enhanced Microsimulation Reporting - Patient tracking and cohort-level reports from simulations have been enhanced to support parallel patient processing and to include tracker information.
- Python Scripts - Python scripts can now read and update patient data during simulations. Syntax errors are reported better to help debug your code.
- External Python - Use additional Python language options by installing additional libraries on your computer (e.g., NumPy and SciPy) and linking that Python installation to TreeAge Pro.
- Markov-To-Excel Conversion Extended - We have extended complimentary access to the Markov-to-Excel option through the end of 2018.

1.4.6 TreeAge Pro 2017, Release 2

The following features are included in TreeAge Pro 2017, Release 2:

- Cohort-Level Transparency for Microsimulation Models - Generate the familiar Markov Cohort Extended Report format from Markov Microsimulation models. This provides cohort-level visibility into the flow of individuals through the model and the accumulation of value at specific
Markov state and transition nodes. This report provides the same transparency for Markov Microsimulation models that you already had for Markov Cohort models.

- Patient Tracking Report for Microsimulation Models - Generate a patient trace for any individual passing through a Markov or DES Microsimulation Model. This provides the full pathway experienced by any patient passing through the model including the accumulation of values at specific nodes.

- Markov-to-Excel Model Conversion Enhanced - The Markov to Excel Conversion process introduced in TreeAge Pro 2017, R2 has been improved in significant ways. We have also extended free access to this capability to January 2018. The conversion process now supports the following.
  - A table of cost-effectiveness results that identifies dominated strategies and calculates ICERs on the undominated strategies.
  - Within Cycle Correction (WCC) configuration as well as traditional models using Half-Cycle Correction.
  - Tunnel states for tracking time-in-state.
  - Option to show calculation on a strategy in a single worksheet as well as in separate worksheets by health state.
  - Logic nodes.
  - Dirichlet distributions which return multiple probability values (for use as distribution means, not sampling).

- More Robust and Flexible Tornado Diagrams - New tornado diagrams provide more robust and flexible graphical output. This includes multiple graph options for cost-effectiveness models including ICER, NMB, cost-only and effectiveness-only. ICER tornados now provide visibility into whether increases in a specific parameter cause the ICER to increase or decrease.

- Convert Time-to-Event Distributions to Transition Probabilities - Use the DistTransProb function to generate a transition probability for each Markov cycle from a distribution representing the time to a specific event. For example, if you have a Weibull distribution that represents time to event, you can use this function to generate transition probabilities for every Markov cycle based on the cycle start time and cycle length.

1.4.7 TreeAge Pro 2017, Release 1

The following features are included in TreeAge Pro 2017, Release 1:

- Convert Markov Models to Excel - Convert a TreeAge Pro Markov cohort model to a working stand-alone Excel model with a single mouse click. The Excel model contains editable model inputs for Markov cohort analysis with full transparency. Results from each strategy are then summarized to compare treatment strategies. Click here for more details and to opt-in for access to this new capability. Please note that starting in July, this capability will be sold as a separate component which extends the functionality of the basic TreeAge Pro Healthcare product.
- Probability Distributions/Histograms - Histograms better handle appropriate bars for values over a range. Customize your histograms by setting the minimum and maximum bar edges and either the number of bars or the bar width.

- Net Monetary Benefits (NMB) vs. Willingness-to-Pay (WTP) Graph - Run the NMB vs. WTP graph on any cost-effectiveness model to see how the optimal strategy may change as WTP changes. This functions as sensitivity analysis on WTP.

- TableProb Distribution for Sampling Time-to-Event - Convert a mortality table to a distribution for sampling background mortality in a DES model.

- Conditional Distribution Sampling - Draw time-to-event samples from distributions for a portion of the sampling range. For example, draw a sample from a time-to-death distribution based on a mortality table given that the person is alive at a certain age.

- Excel Add-in and Bilinks for Mac - The Excel Add-in and Bilinks have to this point only been available on the Windows platform. With this release, these functions will also be available on the Mac platform. Functions include:
  - Editing model inputs in Excel.
  - Pulling values from Excel at runtime via Bilinks.
  - Exporting most TreeAge Pro graphs to Excel.

1.4.8 TreeAge Pro 2016, Release 2

The following features are included in TreeAge Pro 2016, Release 2:

- New Markov Cohort Reports with Increased Transparency - Use the new Markov cohort reports to review all calculations from a cohort analysis. The basic report now separates state rewards from transition rewards. The extended report shows original inputs, discounted inputs, and calculated rewards at every node in the model, including all states and transitions.

- Within-Cycle Correction (WCC) - In Markov Cohort Analysis, WCC calculates cost and effectiveness for a health state based on the percentage of the cohort in the state at both the beginning and the end of the cycle. Markov models can use either the traditional or the new WCC algorithm.

- High-Resolution Displays - TreeAge Pro better handles high-resolution displays for both Windows and Mac operating systems. If you see small toolbar icons on a high-resolution display, perform a full reinstallation to pull in the new components related to this display issue. Installers can be downloaded from www.treeage.com/install.

- Probability Distribution Analysis - Generate probability distribution output with better and more flexible data grouping.

- Improved Histograms - Generate clearer and more flexible histograms from your simulation output.

- Copy/Paste Model Inputs - Copy variables, distributions, tables, and trackers from one model to another.
- New Distributions - Use the new Gompertz and Generalized Gamma distributions.
- New Functions - Use the new Probit and ERF functions.
- Exporting Images - Exporting images of models and graphs with new file formats and color options.
- Probability Formatting - Show probabilities as percentages in rolled back models.
- Store Regional Settings in Model Configuration - Share models with colleagues in other countries using the regional settings built into the model regardless of the settings on other computers.
- Summary Report via Object Interface - Generate the Monte Carlo simulation Summary Report from the programming Object Interface.

1.4.9 TreeAge Pro 2016, Release 1

The following features are included in TreeAge Pro 2016, Release 1:

- Time Reporting for Microsimulation – Generate time reports that show all changes to individual patients’ data as they move through the model. This provides additional transparency and debugging for Microsimulation models as well as time-based statistical reporting like survival curves. Time Reporting is available both for Markov models and DES models.
- Node ID Display/Report – Display node IDs in the Tree Diagram Editor or generate a Node ID Report. Use this with Time Reporting to review the path of patients through a Microsimulation model.
- Post-Analysis Bilinks – Write analysis outputs to Excel via post-analysis bilinks. Bilinks now support three communication types during analyses – send input data to Excel, receive updated data from Excel, and send analysis outputs to Excel.
- Convert Markov to DES – Convert an existing Markov model to a Discrete Event Simulation (DES) model. Additional changes will be required after the conversion.
- Built-in Python Editor – Use the new built-in Python editor to create programming logic for complex calculations and processing.
- Quick Search Tool – In any model input view (Variable Properties, Distributions, etc.), select an item and click the Search icon to find all definitions and references to that item.
- Select Prior Expressions – In both the Formula Editor and Content-Assist, select recently entered expressions.

1.4.10 TreeAge Pro 2015, Release 2

The following features are included in TreeAge Pro 2015, Release 2:

- The the Markov Info View now provides more visibility into health state rewards and transition rewards when the Markov node is selected. This provides a more consolidated view of the values accumulated across the entire Markov model.
- Enhancements to the entry of Markov Termination Conditions to make it easier to keep the conditions consistent throughout the model.
- If tree preferences are set to “Calculate extra payoffs”, the Rankings Report now shows results for all enabled payoffs rather than only the payoffs active for that calculation method.
- New Debug functions to allow for more flexibility in generating output for debugging, verifying and validating models. We include examples to demonstrate how to have greater control over the debug output.
- Reorganized Monte Carlo simulation output to group secondary reports by their functional purpose. Helpful groups, such as Probabilistic Sensitivity Analysis, allow users to navigate the reports more easily.
- Added the Expected Value of Perfect Information vs. WTP Report to show EVPI across a range of willingness-to-pay values.
- The Expected Value of Perfect Information Details Report from Probabilistic Sensitivity Analysis is modified to better organize the data to reflect the purpose of the report.
- Improved quality of graph export images as well as changed the export process to provide more flexibility.
- Updated functionality to better control over which distributions are sampled or not for Microsimulation, Sensitivity Analysis and EVPPI.
- Added new Keywords, including _node_label (useful in Debug Functions), _pre_analysis to allow the execution of commands immediately before the analysis begins.
- Added alternative distribution parameters option for the Weibull distributions.

1.4.11 TreeAge Pro 2015, Release 1

The following features are included in TreeAge Pro 2015, Release 1:

- Monte Carlo simulation performance has been significantly improved through the incorporation of a faster database engine and more efficient data storage/queries and by allowing simulation data to be stored on disk rather than exclusively in memory. Not only will your simulations run faster, you will also be able to run larger simulations than previously possible.
- New perspectives/layouts (Build, Analyze) arrange the application window for efficient work and provide toolbar icons for commonly used functions.
- TreeAge Pro now prompts you for data input of node labels, branch probabilities, payoff entries, etc. to simplify data entry within the model. This is highlighted in the Decision Tree Tutorial Chapter.
- TreeAge Pro’s formula editor has been improved to make it easier to build numeric expressions within the model.
- The Model Setup Wizard walks you through the key Tree Preferences categories to quickly configure your model for proper calculation and display.
- The Model Dashboard presents an "at a glance" view of model configuration and model inputs with immediate access to edit these elements.
- Global Discounting allows you to discount all entries for each payoff/reward set with a single change to the Tree Preferences.
- Create a Bilinks Report to review the connections between your model and an Excel workbook.
- Better identify optimal, rejected and excluded strategies when a model is rolled back.
- Multi-attribute weights can now be entered using variables and expressions.
- Hide/show all notes in the tree editor via Tree Preferences.
- Restructured example model folders to make it easier to find example models in the Projects View.
- More efficiently export large simulation data sets through a new more efficient export option.
- Quickly copy graph images for pasting into documents.

### 1.4.12 TreeAge Pro 2014, Release 2

The following features are included in TreeAge Pro 2014, Release 2:

- Sensitivity analysis now supports adjustments up and down relative to the parameter base value.
- Cost-effectiveness sensitivity analysis output now includes net monetary benefit for each strategy. This allows you to more easily identify thresholds in the main output.
- New functions support continuous time discounting within discrete event simulation (DES) models.
- The Add/Edit Distribution dialog now provides access to the Help files for access to distribution formulas, which may be helpful when entering distribution parameters.
- Filtered simulation output now shows the count of filtered rows relative to the entire dataset.
- New global matrix functions differentiate between data storage, retrieval, increment, initialize and export. The separate functions allow better Help for proper function syntax.
- Models now support custom functions for specific commands/formulas. Pass different arguments to the functions to use the custom function in different contexts.
- New back/forward toolbar buttons allow you to move among the open tabs for models and analysis output.
- Perspectives/layouts were updated to better group related views in the same pane within the application window. To use the updated layouts, you must create a new workspace.
- The bottom of the application window now displays node counts, both for the whole model and for the selected node and its subtree.
- A new tree preference option allows you to show Markov and DES rewards for all enabled reward sets rather than just the reward sets selected for the calculation method.
- New model validation rule checks for consistent use of half-cycle correction.
- New keyword _node_id provides access to the identifier for the current node. This data can be stored in global matrices for patient tracking.
1.4.13 TreeAge Pro 2014, Release 1

The following features are included in TreeAge Pro 2014, Release 1:

- Time-to-Event simulation: New node types and functions were added to facilitate time-to-event simulation.
- Monte Carlo output filtering: Filter output data based on user-defined criteria. Change active payoffs without rerunning the analysis. Generate secondary reports based on the filtered data.
- Performance: Enhanced software to improve viewing and editing performance when working with large models.
- Clones: View the full read-only structure of clone copies. When errors occur within the expanded clone copy, highlight the proper node in the clone copy. This option had been disabled in prior software versions.
- Analysis keywords: Added/improved analysis keywords. Some keywords allow execution of commands after analyses or before/after specific iterations within simulations. Other keywords accumulate rewards within the analysis within time-to-event simulations to drive model flow or verify/debug models.
- Monte Carlo output reports: Hide PSA-specific secondary that are only valid for Probabilistic Sensitivity Analysis from Microsimulation results.
- Enhanced branch and path probability functions: BranchProb and PathProb functions can now be used within the model rather than only at terminal nodes.
- Restructured categories in model input views: Improved UI to use less space for categories except when specifically working with categories.

1.4.14 TreeAge Pro 2013, Release 2

The following features are included in TreeAge Pro 2013, Release 2:

- Simple interface option: A simple interface "skin" helps new users focus on tree modeling and analysis basics, speeding up the learning process. A new Welcome View provides new users with support, training and demo resources directly from the initial presentation window.
- Cost-effectiveness analysis: CEA graphs and reports have been enhanced to better highlight the favored strategy.
- Function Helper: Use the Function Helper to see microhelp for built-in functions and as a guide for function argument entries.
- Node-level Probability Coherence Override: Allow non-coherent probabilities or normalize probabilities at specific chance and Markov nodes.
- Summation Nodes: Use a summation node when the values of a nodes branches need to be combined together to calculate the total value of the summation node.
- Variable Definition Entry: Enter complex variable definitions in the Add/Change Variable dialog.
- BilinkName Function: Reference Bilinks by name rather than by index.
- File Compatibility: Use model validation to identify features that require new or recent versions of TreeAge Pro before sending a model to a colleague.

1.4.15 TreeAge Pro 2013, Release 1

The following features are included in TreeAge Pro 2013, Release 1:

- State Transition Diagrams: Create a state transition diagram to represent a Markov model. Convert the state transition diagram to the decision tree format. Convert your completed Markov model in decision tree format back to a state transition diagram.
- Influence Diagrams: Create an influence diagram as a combination of decision, chance, deterministic and value nodes. The nodes are connected by arcs which represent the time relationship among the events represented by the nodes. Convert the influence diagram to a decision tree.
- Strategy Exclusion: Exclude specific strategies from all analyses.
- Model Validation: Identify and highlight common model flaws.

1.4.16 TreeAge Pro 2012, Release 2

The following features are included in TreeAge Pro 2012, Release 2:

- Bayes Revision: Revise probabilities using Bayes' Theorem when your model includes imperfect tests. This feature handles both sensitivity/specificity and a general m by n grid.
- Enhanced Search/Replace with Highlighting: This enhancement allows you to view and/or replace the search results in a structured list. Search results are also highlighted in the model structure.

The following features were included in Release 2.1:

- Object Interface Enhancements: The programming interface has been modified and enhanced to provide better access to modeling objects and analysis output. It is now possible to access secondary analysis output from Monte Carlo simulations and sensitivity analyses.
- Highlighting Expressions: The Variable Properties, Tracker Properties, Distributions and Tables Views were enhanced to allow you to highlight the use of a model input within the Tree Diagram Editor.
- Image Exports: Generate higher quality images of graphs and models for presentation and publication.
- Improved User Interface Presentation: the Tree perspective has been rearranged to show the most commonly used Views and to place similar views in the same area of the user interface. Right-click on the Tree perspective and choose Reset to use the new format.
1.4.17 TreeAge Pro 2012, Release 1

The following features are included in TreeAge Pro 2012, Release 1:

- Sensitivity Analysis and Microsimulation: Run one-way sensitivity analysis and Microsimulation at the same time. Microsimulation mean values are used as the expected values for each variable value.
- Distributed Simulations: Use slave computers to speed up long simulations.
- Variable Definition Arrays: Create variable definitions with multiple expressions via an array. The individual expressions are then referenced by index.
- Exportable summary report output: Output provided by the Markov Cohort Summary Report and the Cost-Effectiveness Text Report are now more easily exported to Excel.
- Model Documentation: Create a Help HTML file to describe your model to colleagues.
- News Reader: Keep informed about product releases/updates, training, etc. via the TreeAge Pro News Reader.

TreeAge Pro 2012, R1.0 Feature List

1.4.18 TreeAge Pro 2011, Release 2

The following features are included in TreeAge Pro 2011, Release 2:

- The TreeAge Pro Player: Create a Model Interface to allow non-licensed users of TreeAge Pro to review and/or analyze your model within the TreeAge Pro Player.
- Cohort size option multiplied by rewards in Full Markov Cohort output.

TreeAge Pro 2011, R2.0 Feature List

1.4.19 TreeAge Pro 2011, Release 1

This was the first release of TreeAge Pro using Eclipse RCP. All functions were "new" in this release.
2. Using TreeAge Pro

TreeAge Pro includes many functions that are dispersed among a set of editors, views, menus and toolbars. This chapter helps you navigate through these system elements to perform tasks associated with building and analyzing models.

We recommend that you start with the Get Started Layout, described in the first section of this Chapter. When you are ready for more complex tasks, switch to the more advanced layouts (Build and Analyze).

2.1 Get Started Layout

TreeAge Pro layouts (a.k.a, perspectives) control the way your application screen is presented. When you change layouts, you will see a different arrangement of editors and views as well as changes to the toolbar and menu.

The Get Started Layout highlights the most important tools for basic modeling and analysis. When you are ready for more complex tasks, switch to the more advanced layouts (Build and Analyze).

- a limited set of functions focusing only on the most common tasks
- videos that will help you navigate through the software
- assistants that provide step-by-step instructions to help you build your first models

Get Started Layout

If it is the first time you have used TreeAge Pro, TreeAge Pro will startup with the Get Started Layout on and the Launch Pad activated. The Launch Pad has four components, and you will start with the Intro to TreeAge Pro video component, which consists of a series of very short videos to help you navigate the software.
Get Started perspective, showing the Intro to TreeAge Pro video. Play each short video to quickly learn about the software.

We recommend you watch all the videos, which in total last about 5 minutes. After each video, click the Next button to proceed to the next one. After the last video, click Finish to move to the Create new component of the Launch Pad.

At the top right of the screen, you will see a list of available layouts - Get Started, Build, Analyze and Simple. Stay in the Get Started Layout when you first begin using TreeAge Pro. When you have more experience with TreeAge Pro, switch to the Build layout for building models and the Analyze layout for analyzing models.

You may see different perspectives in your workbench based on a workspace created with an older version of TreeAge Pro. To use the new perspectives, you can create a new workspace. Click here for instructions in the TreeAge Software Knowledge Base.
Perspectives: Get Started, Build, Analyze and Simple

The Get Started perspective is arranged into the following sections:

- Top left pane: The main pane for the Launch Pad, models and analysis output
- Bottom left pane: The model input pane for entering model input data
- Right pane: The helper pane for opening models, accessing TreeAge Pro Help and model building assistants
2 Using TreeAge Pro

Get Started perspective with Launch Pad, Help Views and Input Views

While this is the default display, the components of these panes can change as you open additional TreeAge Pro views.

2.2 Launch Pad

You can access the Launch Pad at any time by clicking on the tab in the top left pane of the application window. The "home" button in the toolbar will also access the Launch Pad.

Access the Launchpad via the House icon

*The Launch Pad is a quick way to:
2 Using TreeAge Pro

- Create new models using the Assistants
- Create new models
- Open recent models
- Play the Intro to TreeAge Pro Video

Launch Pad as seen in the Get Started perspective

2.3 Model Building Assistants

The model building assistants provide step-by-step instructions for building models - specifically a CE Decision, a CE Markov Model or Legal Tree.

Open the Assistants from any of the following locations:

- Toolbar via the icons
- Launch Pad via the links (Decision, Markov or Legal Assistants)
- Help View using the link
- Help menu where the Assistants is an option (not shown in the figure below)
TreeAge Pro with some of the ways to open the Assistants highlighted

The Assistants will open within the Help View. If you open an Assistant directly from one of the buttons, a new tree will also open as the starting point for building a model using that Assistant.
2 Using TreeAge Pro

2.4 Tree Editing/Reporting Pane

The top left pane within TreeAge Pro is used to build model structure and to review analysis output (reports and graphs).

Typically, you will have multiple tabs open in this pane - one for each open model and each open model output. The currently active tab will be shown with a gray tab, while the inactive tabs will have a white tab. Simply click on one of the other tabs to change the active tab within the pane.

Note that this pane is the main controller for the overall application window. When you select a model, the toolbar will change and the elements within the bottom right model input pane will change to allow you to see/edit elements of the active model. When you select model output, the toolbar will change again and the model input pane will display nothing because no model is currently "active".

Note that the main application toolbar includes yellow back and forward arrows to that allow you to move among the open tabs for models and analysis output.
The next section describes the Tree Diagram Editor used to create your model structure.

### 2.5 Tree Diagram Editor

The Tree Diagram Editor is the primary modeling window within TreeAge Pro. You create the model structure within the Tree Diagram Editor by adding, editing, moving and deleting nodes. Changes made within an editor are not saved until you instruct TreeAge Pro to save the model document.

You can open multiple models at once, and each will be presented within a different Tree Diagram Editor tab within the overall pane.

The Launch Pad is always the left-most tab. The "+" option to create a new model is always the right-most tab.

To maximize the size of the Tree Diagram Editor, double-click on the tree editor pane. This will help you see more of the structure for large trees. Double-click on the tree editor pane again to return the editor to its prior size and position.

The Tree Diagram Editor consists of a modeling pane and a modeling palette (to the right-hand-side).

The *Modeling Pane* is the primary editing window, which contains the visual representation of the model. If the size of the model exceeds the size of the Modeling Pane, scroll bars will appear.

Several actions are performed within the Modeling Pane:

- Add/delete nodes in the model.
- Click on a node label to enter/edit label text.
- Drag nodes to different places within the model.
- Enter probabilities beneath the branches of chance nodes.
- Select a node to change the perspective of node-specific views (Node Properties, Variable Definitions, etc.).
Modeling Pane edit options

The *Modeling Palette* contains tools for creating model structure and for viewing the model. Access the palette using the little arrow at the top right of the tree editor pane.

You can add branches to the right of any node by double-clicking on the node. Double-click will typically add two branches if there are no existing branches and one branch if there are existing branches.

You can also use the toolbar to add new branches and nodes into your model. You do this by selecting the location for the new branch and node, then use the toolbar to add a new branch. If you want to add nodes within the existing structure rather than as additional branches, use the Insert Node option either via the Node menu or the right-click > Insert node context menu option. Both of these options are shown in the figures below.
Select a node and then use the tool bar to add nodes and branches.

You can also drag nodes from the palette into the modeling pane to add a branch/node to the model. The location of the new node is controlled by where it is dropped within the model. The new node line and branch connector will appear as you drag a new node around the existing model.
The zoom in and out buttons allow you to zoom in and out within the modeling pane. First, click on the zoom in or out button in the palette, then click on the model in the modeling pane. The modeling pane will visually recenter and resize based on your selection. To stop the zoom (in and out), just select the arrow from the top of the pallet.

The note and arrow buttons allow you to add those non-structural elements to your model. Click on either element button, then drag a note or arrow onto the model and use for making comments.

Undo any actions which are wrong by using the Blue back arrow in the tool bar.

To UNDO any action during model building, click the blue and black return arrow in the toolbar or choose Edit > Undo from the menu.

2.6 Tips for Navigating TreeAge Pro

There is an Intro to TreeAge Pro video which is available from the Launch Pad. We strongly recommend watching this to get an overview of how to navigate the software. This section repeats some of the tools and provides some additional tips too.

Maximize an editor or view:

- Select an editor or view by clicking the tab.
- Double-click on the tab to maximize that editor or view to populate the entire application window.
- To return to the original size, double-click again on the tab to return it its original size.
A Tree Editor maximized to take up all of the interface.

Re-sizing panes

- Hover over any “margin” between two different panes until a double arrow appears.
- Left-click with the mouse and drag the pane to the size you require.
Use the arrows between panes to re-size editors and views

Minimizing, maximizing and resetting panes

Panes are different sections of the overall interface with tabs for different editors and views within the pane. There are typically 3-4 panes visible in each layout. Panes can be minimized to allow more space for other panes.

- At the top of the pane, click the “minimize” icon (the same as in Windows or Mac) to minimize the pane.
- The pane will be minimized to the edge of the interface.
- Within each minimized group, you can either:
  - Restore the entire pane by clicking on the “restore” icon from the edge of the interface.
  - Restore a given View temporarily by clicking on the icon for that specific view within the minimized pane. When you click another place in the interface, that view will return to the minimized pane.
Detach views

Individual Views (but not editors) can be detached from the main application window. This can be useful if you have a second screen.

- Right-click on the tab for the View you want to detach.
- Select “Detached” from the menu.
- The View will now be “floating” above the interface and can be moved around your screen(s).
- To reattach to the interface, right-click on the tab of the detached pane and deselect “Detached”. The View will be incorporated back into the interface.

Moving views between panes

You can move a View to another Pane within the interface via click and drag.

- Click on the tab at the top of the View you want to move and hold the mouse key down.
- Drag the selected View to the new location/pane and release the mouse button.

Tree Diagram Editor tabs and model result tabs cannot be moved to a different pane.

Splitting panes

The Tree Editor tabs (models and analysis output) cannot be moved to another pane, but you can split the Tree Editor pane to look at two or more tabs side-by-side.
- Click on a Tree Editor pane tab and hold down the mouse button.
- Drag the tab to the left, right, top, or bottom of the Tree Editor pane.
- A **bold** line will appear down the center of the Tree Editor. Release the mouse button and the moved tab will appear in a separate section or the Tree Editor pane.
- To move back, click and drag the tab back to its original location.

![TreeAge Pro interface](image)

Split the Tree Editor to look at two models (or outputs) side by side.

### 2.7 Controlling the display with perspectives/layouts

A perspective (or layout) is a collection of views and editors that makeup the layout of your display. Perspectives are linked to the TreeAge Pro software and not to your specific model. You can create/use different perspectives associated with different sets of tasks. Get Started, Simple, Build and Analyze perspectives come preinstalled with the software.

You may see different perspectives in your workbench based on a workspace created with an older version of TreeAge Pro. To use the new perspectives, you can create a new workspace. Click here for instructions in the TreeAge Software Knowledge Base.

Perspectives can be selected from the top-right corner of the TreeAge Pro application window. The pre-installed perspectives may meet all your needs, but you can manipulate and then save the layout to suit personal preferences.
2.7.1 Build, Analyze and Simple Layouts

New users of TreeAge Pro will start with the Get Started layout. This layout shows the most common views and actions. When you are ready to move beyond the basis, select the Build and Analysis layouts for additional functions associated with building and analysing models, respectively.

The Simple perspective is a more concise layout for simple modeling.

The three perspectives are shown in the figures below with different tools associated with each. You can roll over each tool icon with a mouse and the tool tips (comments associated with that tool) will describe what each tool does.
Build perspective
Analyze perspective
2.7.2 Manipulating layouts

The current layout remembers the layout as you change the organization of views and editors to meet your needs. The next time you open TreeAge Pro with that layout, the visual organization will be the same as when you left it.

If you ever want to return a layout to the original "factory specs", right-click on the layout and choose Reset from the context menu.

2.8 TreeAge Pro Views

TreeAge Pro includes several views to support different features of the software. All TreeAge Pro views fall into one of these three categories.

1. Associated with the active model (e.g., Variable Properties, Distributions).
2. Associated with the selected node in the active model (e.g., Variable Definitions, Markov Info).
3. Helper views not associated with a model (e.g., Help, Files).
You can open any of the Views from the tool bar by selecting the dropdown Views menu, as in the figure below.

Open any Views from the dropdown Views menu in the toolbar

The following table lists some of the most commonly used TreeAge Pro views, along with a link to the section(s) of the Manual where each view is described in detail.

<table>
<thead>
<tr>
<th>View/Description</th>
<th>Manual Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Model Dashboard:</em> Provides an overview of the important model configuration and model inputs in the model.</td>
<td>Model Dashboard and Documentation Chapter</td>
</tr>
<tr>
<td><em>Files View:</em> Manages sets of documents associated with a folder/project, including but not limited to model documents. The Files View provides a standard tree/explorer interface to help you navigate to files and open files with double-click from within the software.</td>
<td>Example Models and Files Chapter</td>
</tr>
<tr>
<td><em>Tree Explorer View:</em> Allows you to navigate to nodes within a tree using a standard tree/explorer navigational interface.</td>
<td>Tools and Functions for Complex Trees Chapter</td>
</tr>
<tr>
<td><em>Model Overview:</em> Presents a miniature view of the active tree in the Tree Diagram Editor. The portion of the model that is currently visible in the Tree Diagram Editor is highlighted.</td>
<td>Tools and Functions for Complex Trees Chapter</td>
</tr>
<tr>
<td>View/Description</td>
<td>Manual Reference</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Tree Properties View</strong>: Edits the properties of a tree. Includes several tabs for different tree elements.</td>
<td>TreeAge Pro 201x Interface Chapter</td>
</tr>
<tr>
<td><strong>Variable Properties View</strong>: Edits variables in the model.</td>
<td>Working With Variables Chapter</td>
</tr>
<tr>
<td><strong>Tracker Properties View</strong>: Edits trackers in the model.</td>
<td>Individual-Level Simulation and Markov Models Chapter</td>
</tr>
<tr>
<td><strong>Tables View</strong>: Edits the properties and data of the model's tables.</td>
<td>Creating and Using Tables Chapter</td>
</tr>
<tr>
<td><strong>Distribution Properties View</strong>: Edits the model's distributions.</td>
<td>Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis Chapter</td>
</tr>
<tr>
<td><strong>Clone Masters/Copies View</strong>: Edits the model's clone masters and copies.</td>
<td>Tools and Functions for Complex Trees Chapter</td>
</tr>
<tr>
<td><strong>Node Properties View</strong>: Edits the properties of the selected node and the elements associated with that node.</td>
<td>TreeAge Pro 201x Interface Chapter</td>
</tr>
<tr>
<td><strong>Variable Definitions View</strong>: Edits variable definitions of the selected node.</td>
<td>Working With Variables Chapter</td>
</tr>
<tr>
<td><strong>Tracker Modifications View</strong>: Edits tracker modifications of the selected node.</td>
<td>Individual-Level Simulation and Markov Models Chapter</td>
</tr>
<tr>
<td><strong>DES Info View</strong>: Edits DES info at the selected node.</td>
<td>DES Models Chapter</td>
</tr>
<tr>
<td><strong>State Bindings View</strong>: Edits Markov state bindings of the selected node.</td>
<td>Markov Modeling Tools and Techniques Chapter</td>
</tr>
<tr>
<td><strong>Evaluator View</strong>: Calculates numeric expressions of the selected node.</td>
<td>Working With Variables Chapter</td>
</tr>
<tr>
<td><strong>Probability Wheel</strong>: Uses the wheel to edit numeric probabilities for branches of the selected node.</td>
<td>Making Changes to Tree Structure Chapter</td>
</tr>
<tr>
<td><strong>Console</strong>: Views system output.</td>
<td>Calculation Trace Console: Output generated by calculations. Debug output is written to this console. Report Console: Output generated by report generation.</td>
</tr>
</tbody>
</table>
### TreeAge Pro Views

<table>
<thead>
<tr>
<th>View/Description</th>
<th>Manual Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Object Interface Console:Output generated by the Object Interface.</td>
</tr>
</tbody>
</table>

#### 2.8.1 Tree Properties View

The Tree Properties View allows you to edit the properties of a tree. The contents are tied to the model in the active Tree Diagram Editor. Switching editor windows will change the contents of the view.

The following tabs are available within the view to edit particular sets of tree properties:

- **General**: Edits model document information - creator, description. Also allows you to freeze the model from changes.
- **Variables**: Edits variable names, properties, default values and sensitivity analysis ranges. The contents of the Variables Tab are the same as those in the Variable Properties View.
- **Trackers**: Edits tracker names, properties and default values. The contents of the Trackers Tab are the same as those in the Tracker Properties View.
- **Tables**: Edits table properties and data. The contents of the Tables Tab are the same as those in the Tables View.
- **Distributions**: Edits distribution properties, type and parameters. The contents of the Distributions Tab are the same as those in the Distributions View.
- **Clones**: Edits clone master properties. The contents of the Clones Tab are the same as those in the Clone Master/Copies View, which is described in the Tools and Functions for Complex Trees Chapter.

#### 2.8.2 Node Properties View

The Node Properties View allows you to edit the properties of a specific node and the elements associated with that node. The contents are tied to the selected node within the model in the active Tree Diagram Editor. Selecting another node or switching editor windows will change the contents of the view. If no node is selected, the view is disabled.

The following tabs are available within the view to edit particular sets of tree properties:

- **General**: Edits label, probability (for branch of chance node), and payoffs (for terminal nodes) of the selected node.
- **Variables**: Edits variable definitions at the selected node. The contents of the Variables Tab are the same as those in the Variable Definitions View.
- **Trackers**: Edits tracker modifications at the selected node. The contents of the Trackers Tab are the same as those in the Tracker Modifications View.
- **Markov**: Edits Markov info for the selected node. This tab is only visible for nodes within Markov models. There are three different contexts for the view for Markov nodes, Markov state nodes and Markov transition nodes. At the Markov node, the Markov Info View shows information about the Markov node, Health States and Transition Rewards in one place.

- **State Bindings**: Edits Markov state bindings at the selected node. The contents of the State Bindings Tab are the same as those in the State Bindings View.

**Node Properties View Tabs**

Note that variable definitions are associated with a specific node, while variable properties are associated with the entire model.
3. Example Models and Files

TreeAge Pro's Files View will help to organize your model documents. The Files View will provide a way to access files on your computer or network from within TreeAge Pro.

![Files View - showing all the example models](image)

The Files View provides a hierarchical view of the documents/resources from within TreeAge Pro. From here, you can open files for editing or select resources for operations such as exporting.

The folders within the Files View are also known as projects.

Right-click on any resource in the Files View to open a pop-up menu that allows you to perform operations such as copying, moving, creating new resources, comparing resources with each other, or performing other operations.

⚠️ Changes made to your folders within TreeAge Pro are immediately visible in the Files View. However, changes to the file system made outside TreeAge Pro are not reflected in the Files View until you refresh the View via the right-click context menu (and select Refresh).

3.1 Example Models

When you start TreeAge Pro for the first time, you will have an Example Models folder in the Files View. The Example Models folder contains the tutorial models that are installed on your computer with TreeAge Pro. Many of these example models are referenced within this manual.
3.1.1 References to Example Models

Within this manual, we will reference the Example Models. The following table shows the location of the model we reference them in tutorials. You should refer back to this section often to find the location of the models.

<table>
<thead>
<tr>
<th>Help file reference to the Example</th>
<th>Where to find the Example in Files View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Started tutorial example</td>
<td>Example Models \ Get Started</td>
</tr>
<tr>
<td>Business tutorial example</td>
<td>Example Models \ Business</td>
</tr>
<tr>
<td>Health Care tutorial example</td>
<td>Example Models \ Health Care</td>
</tr>
<tr>
<td>DES tutorial example</td>
<td>Example Models \ Discrete Event Simulation</td>
</tr>
<tr>
<td>Health Care Training tutorial example</td>
<td>Example Models \ Health Care Training Examples</td>
</tr>
<tr>
<td>Legal tutorial example</td>
<td>Example Models \ Legal</td>
</tr>
<tr>
<td>Oil tutorial example</td>
<td>Example Models \ Oil</td>
</tr>
<tr>
<td>Special Features tutorial example</td>
<td>Example Models \ Special Features</td>
</tr>
<tr>
<td>Bilinks tutorial example</td>
<td>Example Models \ Special Features \ Bilinks</td>
</tr>
<tr>
<td>Clemmens et al tutorial example</td>
<td>Example Models \ Others \ Clemmen Marshall Skinner et al</td>
</tr>
<tr>
<td>TreeAge Pro interface tutorial example</td>
<td>Using the TP Object Interface</td>
</tr>
<tr>
<td>Other tutorial example</td>
<td>Example Models \ Others</td>
</tr>
<tr>
<td>PartSA tutorial example</td>
<td>Example Models \ Partitioned Survival Analysis</td>
</tr>
</tbody>
</table>

3.1.2 Recreating the Example Models

If, at any time, you delete and modify the Example Models and want to recreate them, you can follow these instructions to do so.

Open the File menu and select Projects > Recreate Tutorial Examples. Follow the prompts and either overwrite the current "Example Models" folder or provide a new folder name for the Example Models (we used "Recreated Example Models" for the new name in the figure below).
3.2 Create a project/folder for your models/documents

A project is a reference to a folder on the file system on your computer or network where project-related files are stored. At any time, you can create a new project for new or existing models and related documents.

To create a new empty project:

- Right-click in the empty space within the Files View and select New > Project from the context menu.
- In the New Project Dialog, expand the group General and select Project. Click Next.
- Enter a project name. The name you enter will be the name of the Folder you are creating.
- Specify the existing folder where you want to place the new the project and its files. Uncheck the box "Default location" if you want the folder to be outside the current workspace.
- You do not need to specify the working sets or referenced projects options.
- Click Finish.

The new project will then appear in the Files View. Models can then be saved within that folder via the menu: use File > Save in Project.

To create a new project from an existing folder:

- Right-click in the empty space within the Files View and choose New > Project from the context menu.
- Expand the group General and select Project. Click Next.
- Enter a project name. The name you enter will be the name of the Folder you are creating.
- Uncheck the box "Default location".

Recreated Example Models in the Files View.
- Specify the folder where the project files are located. (This is usually a folder on your computer or network).
- You do not need to specify the working sets or referenced projects options.
- Click Finish.

The new folder now provides a shortcut directly to the folder (and subfolders) where your project files are located. Existing files in that folder can then be accessed directly from the Files View.

If a project already exists, perhaps on a network share, you can import it directly into the Files View. 

**To import an existing project into your workspace:**

- Right-click in the empty space within the Files View and choose Import from the context menu.
- Expand the group General and select Existing Projects into Workspace. Click Next.
- Click on the Browse button next to the Select root directory input.
- Navigate to a folder within which there are one or more projects and click OK.
- The existing projects will be presented in the Projects list. Check the projects you want to select.
- Click the Finish button.

### 3.3 Working within a project/folder - saving and comparing models

Once you have a folder in the Files View, you can immediately open documents within that folder via double-click. Double-click will open trees via the Tree Diagram Editor. It will also open files that require additional editors like Excel™ and Word™. The right-click menu provides access to file editing options like delete, move, and rename.

In addition, Files View provides limited version control through the Team, Compare With and Replace With menus. These allow you to compare the current version of the file with prior versions.

When choosing where to **save a file**, you have two options from the menu:

1. **File > Save in Workspace**: Save your file within an existing project in the workspace. The file will be saved within the project's root folder, which could be on your computer or on a network.
2. **File > Save As**: Save your file as an independent document on your computer or on a network.

Note that when you save your models within a Project, TreeAge Pro provides tools to allow you to see revisions of the model and compare versions. Hidden revision files are stored within your TreeAge workspace to provide access to revisions beyond what you save directly.

**To compare with recent revisions:**

1. Right-click on a model file and choose Compare With > Local History from the context menu.
2. Choose a revision to compare to the latest copy.

**To compare two model files:**

1. Click on one model file to select it.
2. Hold the Control key down and click on a second file to select both files.
3. Right-click on either selected file and choose Compare With > Each Other from the context menu.
4. Get Started with Decision Analysis

This chapter introduces the core concepts and methods of decision analysis as implemented in TreeAge Pro.

4.1 What is decision analysis?

Decision analysis — as it is taught and practiced today in diverse fields such as healthcare, law, business, engineering, and oil/gas exploration — is a systematic approach to decision making under uncertainty. The process is designed to help decision makers think clearly about the many elements of complex decisions, such as:

- the range of possible consequences of actions (or inaction)
- preferences among different sets of consequences
- the impact of complex, unpredictable systems and processes (e.g., markets, geological structure, health)
- the actions of others (e.g., consumers, competitors, regulators, patients)

The concepts and methods of decision analysis are uniquely suited to incorporating into the decision making process both what is known about a problem, and also what is uncertain. TreeAge Pro is used in two of the key steps in decision analysis, modeling and analysis.

4.2 Modeling

Using decision analysis, a complex problem can be disaggregated into smaller problems and elements, which can be easier to understand. These components are then employed in building a model of the problem’s essential elements.

First, a set of alternatives (strategies) is compiled. Then, events and other factors that may affect the outcome of an alternative are identified. A factor whose impact on the final outcome is not known at the time of the decision is referred to as an uncertainty. It can be represented as either a structural element of the model, or a parameterized distribution used in a formula in the model. Based on the decision maker’s objectives, one or more attributes are selected to quantify preferences for the range of possible final outcomes (and, ultimately, to rank alternatives). For example, a monetary scale would be used to measure different project cost scenarios and then to rank alternatives.

Compared to basic spreadsheet analysis or statistical modeling, a particular strength of decision analysis is the intuitive, visual form of the model. The model may be either a decision tree or an influence diagram, which are different means of visually representing the same problem.

TreeAge Pro models take the form of a decision tree. A decision tree is a branching structure in which various node symbols are used to represent different kinds of events, including decisions and
uncertainties. A node’s branches represent the outcomes or alternatives associated with that event. Every series of actions and outcomes is clearly represented with a distinct path.

Alternatively, the same problem often may be represented more compactly by an influence diagram. In a influence diagram, each factor that directly or indirectly affects the final outcome is represented with a single node. Arcs between nodes show that one factor either affects another or precedes it in time. Note that TreeAge Pro supports influence diagrams, but analysis is only performed on models using the decision tree format.

### 4.3 Expected values and optimal decisions

While a model’s explicit identification of the sequence and linkage of events is of great value in decision making, decision analysis is designed to do much more. Using basic concepts from probability theory and statistics, the decision maker can calculate a mean value (or expected value) for each course of action. By calculating the value of each possible chain of events, and weighing uncertain results by the probability of each outcome, the decision maker can identify the sequence of decisions that will maximize value, minimize costs, or balance multiple attributes.

These calculations are commonly illustrated with a decision about playing a simple lottery, which can be thought of as a random variable having a simple probability distribution of outcomes as follows.

A $20,000 lottery offers a 1-in-1000 chance of winning. The expected value of playing this lottery — ignoring the ticket price — equals $0.001 \times (\$20,000) + 0.999 \times (\$0)$, or $\$20$. Based on expected value, a reasonable decision would be to purchase a ticket if it costs $\$20$ or less.

Typically, decision analysis problems involve multiple uncertainties, with the outcome of the first lottery being a second lottery, and so on. The analysis of compound lotteries works backwards, calculating an expected value for the final lottery and using this result in the calculation of the prior lottery. When all lotteries have been resolved in this way, decisions are evaluated by optimization — picking the alternative with the best expected value.

A decision maker’s attitude towards risk can be incorporated into model calculations. Using the techniques outlined in utility theory, a choice between different lotteries can be made based on their expected utilities or certainty equivalents. These in turn depend on the decision maker’s attitude towards risk, quantified using a utility function.
4.4 Sensitivity analysis

As illustrated with the lottery example, one way in which decision analysis deals with uncertainty is to reflect it explicitly in the model’s structure. Events which have a significant impact on outcomes, and which are not under the decision maker’s control, can be described using chance nodes and incorporated into the model calculation. A problem may involve numerous uncertainties; not all of them can or should be represented in the structure of the model. To deal with this, deterministic sensitivity analysis and probabilistic sensitivity analysis are used to examine the potential impact of parameter assumptions and other uncertainties.

Deterministic sensitivity analysis can take a variety of forms, including 1-way, 2-way, and 3-way sensitivity analysis and tornado diagrams. It can be used to identify critical uncertainties by examining the extent to which a model’s calculations and recommendations are affected as a consequence of changing selected assumptions. Probabilistic sensitivity analysis (PSA) can incorporate all parameter uncertainties. PSA quantifies the level of confidence that can be placed in the model’s results.

Sensitivity analysis and other analytical tools can also be used to improve decision making. This is done by determining the potential value of obtaining various kinds of information (perfect, imperfect, or sampling information) that might help resolve critical uncertainties.

4.5 Decision tree structure

In building a decision tree, there are some basic guidelines to be considered:

• In the tree, events are ordered from left to right. The tree often follows a time ordering of events, as outcomes become known to the decision maker. Time ordering is only critical, however, when a decision is made prior to knowing the outcome of a different event or when the probabilities of one event are dependent on another.

• Different kinds of events are distinguished using shapes called “nodes.” A decision node (square) indicates a choice facing the decision maker. A chance node (circle) represents an event which has multiple possible outcomes and is not under the decision maker’s control. A terminal node (triangle) denotes the endpoint of a scenario. Other node types are used in more complex models, like Markov models.

• Branches “sprouting” from a decision node represent the set of actions being considered. Decision alternatives are not required to be mutually exclusive. For example, one set of options could be “install smoke detectors,” “install fire extinguishers,” and “install smoke detectors and fire extinguishers”.

• Branches from a chance node represent the set of possible outcomes of the event. The branches must be mutually exclusive and exhaustive — in other words, defined such that all possibilities are covered and none overlap. Their probabilities must sum to 1.0 (100%).
• Terminal nodes are assigned a value, referred to generically as a "payoff". All right-most nodes (those without branches) must be terminal nodes and have a payoff representing the net value (e.g., profit, cost, or utility) of that particular scenario’s series of actions and events.

4.6 Further reading

For additional background on decision analysis in general, here are some suggested references:


There are also numerous books and journals dealing with the application of decision analysis in specific fields and industries. Here are just a few selected references:

5. Get Started - Building a Decision Tree Model

There are two “get started” chapters. This chapter focuses on a simple legal model with one outcome – legal damages. The next chapter focuses on a healthcare model with two outcomes – cost and effectiveness. Much of the contents are repeated, so use the chapter that is appropriate for the types of models you will build.

You may want to review the TreeAge Pro Interface Chapter before continuing, in order to familiarize yourself with the many elements of the user interface.

5.1 Defining the problem

Let us consider a legal case where we are the Defendant in a civil lawsuit. The Plaintiff alleges that we are liable for damages. We will build a model to assess the value of the case (to advise our client).

In a more realistic legal model, proving liability would likely involve several steps. It is likely that the Plaintiff would have to prove they suffered damages and that the Defendant’s negligence caused the damages. For the purposes of illustration, we will focus on a single step of proving liability on the part of the Defendant.

5.1.1 Representing the problem as a model

We have a decision to make regarding our legal strategy. We have two strategies:

1. Proceed with litigation; or
2. Settle the case out of court.

If we choose to settle, there is only one outcome which is to pay the Settlement amount.

If we choose to litigate, there are two outcomes:

1. Jury finds we are liable for the damages; or
2. Jury finds we are not liable for the damages.

The final issue is the size of the damages award if we are found liable. There will be several estimates for the damages award amount.

We can represent this problem with a decision tree based on the information above. However, we will also need numeric values associated with this problem, specifically probabilities and damage estimates.

5.1.2 Numeric Values

At the first decision, we are faced with a settlement option based on a demand from the Plaintiff.
- Settlement demand: $1 million

If we choose to proceed with litigation, then we need to know the likelihood of the jury finding us liable.

- Probability the jury finds us liable: 30%
- Probability the jury finds us not liable: 70%

If the jury finds we are not liable for damages, we are not required to pay compensation.

- Damages if not liable: $0

If the jury finds we are liable, then we need to pay damages. The jury may award a range of damages, so we will use three estimates for damages – High, Medium or Low. It is a common technique in legal models to use High, Medium and Low damage amounts with probabilities 25%, 50%, and 25%, respectively.

- High damages: $4.5 million (25% likely)
- Medium damages: $2.5 million (50% likely)
- Low damages: $0.5 million (25% likely)

We now have all the information we require to build a decision tree in TreeAge Pro. The remaining sections of this chapter go through how to build this example model and analyze the model to make an informed decision. The finished model can be found in the Get Started Example models, and is called Plaintiff v Defendant.

5.2 Create the tree structure

We will now create the tree structure for the legal Plaintiff vs Defendant model described in the previous section.

The software has a perspective/layout to assist with building models. Select the Build perspective from the top right hand corner of the application window, and the interface will present you with toolbars, editors, and views related to model building.

5.2.1 Create a new tree

To create a new tree document:

- Select File > New from the menu or click Ctrl-N on the keyboard.
- ... OR ...
- In the toolbar click the icon for New Decision Tree.

This opens a new empty tab within the Tree Diagram Editor. The new model will consist of a single Decision Node.
A Model Setup dialogue will appear, asking if you want to configure the calculation method and outcomes for your model. Click ‘No’, but in the future you may choose to setup your model before building. (You can return to the Model Setup at any point by selecting the gears icon in the toolbar).

The node furthest to the left within the model is the root node. All models must have a single root node from which all other nodes emanate, either directly or indirectly.

You should always Enter a label for every node in the model, including the root node. The red text that appears above the node in the Tree Editor prompts you to enter the label.

Prompts for data entry include:
- Enter label: Appears above branches and prompts you to enter a label for the branch.
- Enter prob: Appears below the branches (nodes to the right) of a chance node and prompts you to enter the probability.
- Enter condition: Appears below the branches of a logic node and prompts you to enter the condition to test at the logic node.
- Enter time: Appears below the branches of a time node branch for Discrete Event Simulation models.
- Enter payoff: Appears at terminal nodes and prompts you to enter values for a scenario.

5.2.2 Selecting a node

TreeAge Pro shows a node is selected by filling in the node symbol.

To select a single node using the mouse:
- Click on the node line or the node symbol.

5.2.3 Entering and resizing node labels

When a single node is selected, a box will appear around the node label text. In the case of a new node, the initial text will be “Enter label”.

To enter a node label:
- Click where it says "Enter label", above the node line, and an input text box will appear.
- Enter a brief phrase in the box to describe the event — in this case Plaintiff v Defendant.
- Press ENTER on your keyboard to save the new text as the node label.
- To undo the text you have typed…
  - Select ‘esc’ on your keyboard if you have not already saved the node label text.
- Choose Edit > Undo from the menu if you have already saved the node label text.

**To resize a node label (or text box):**

Node (and other) labels entered into text boxes may wrap depending on the length of the description. Follow these instructions to resize the text box.

- Use the tick markers *above and to the right* of the text box in the ruler bar.
- Hover over the tick mark until a double arrow appears and then drag to resize the text box, as in the figure below.
- All text boxes directly above and below a given text box will also change size.
- Fonts and alignments of the node labels and nodes can also be changed via the Tree Preferences > Display settings which you can access via the tool bar.

**5.2.4 Adding branches/nodes**

A branch must be added to the decision node to represent each strategy. For this model, add branches *Litigate* and *Settle at current demand*.

**To add branches:**

- Select the Decision Node.
- Click the ‘Add branches’ toolbar icon which will add two branches.
- ... OR ...
- Drag a chance node from the Tree Diagram Editor Palette to the right of the existing decision node. A red line will appear indicating where the node can be placed. Release the mouse when the new node is visible as a branch of the decision node.
- Repeat this for a second chance node which should also be a branch of the decision node.
- ... OR ...
- Right-click on the decision node and select Add Branch from the context menu. Two chance nodes will be added as branches.
Don’t be confused by the terms branch and node. They both refer to the same element of a tree model. The term branch is normally used to describe the specific nodes that emanate directly from a parent node (the closest node to the left).

For more information on changing tree structure, refer to the following sections:

- Deleting nodes (refer to Deleting nodes/branches)
- Zoom in or out (refer to Tree Building and Navigating the Tree)
- Navigating the tree using the keyboard (refer to Tree Building and Navigating the Tree)

### 5.2.5 Label the strategy nodes

Now we can enter node labels for our strategy nodes.

- Select the top branch from the decision node, opening the text box, and type *Litigate*.
- Select the bottom branch from the decision node, opening the text box, and type *Settle at current demand*.

The tree should now look like this:

![Tree Diagram](image)

- Rather than entering extensive comments in the node itself, it is often better to use note boxes or node comments (refer to the Annotation Chapter).
- Many tree-building commands are found under the Node menu or by right-clicking on a node.
- If you delete a branch that is a parent (i.e., that has branches), its subtree (i.e., its children as well as their descendants) will not be deleted; instead the children and their descendants will move up one generation. Refer to the Changing the Tree Structure Chapter for more information on inserting and deleting nodes.

### 5.2.6 Complete the tree structure

The decision tree has two strategies. The Settle strategy only needs to incorporate the settlement demand value, which is entered via Payoffs. The Litigate strategy requires additional structure to replicate the jury’s findings.

**Add two branches to Litigate and label:**

- Select the Litigate node and use either the tool bar to add 2 branches (or double-click on the node);
- Label the two new nodes:
  - Jury finds Defendant liable for damages; and
  - Jury finds Defendant not liable for damages.

Add three branches to Jury finds Defendant liable for damages and label:
- Select Jury finds Defendant liable for damages node and add three branches (using techniques as above);
- Label the three branches:
  - High damages awarded;
  - Medium damages awarded; and
  - Low damages awarded.

The tree should now look like this:

5.2.7 Saving the tree

Now that all necessary nodes have been added, it is a good time to save your work.

TreeAge Pro models are documents. You save, open, and close trees and other documents in TreeAge Pro the same way you do in other programs — using the File menu commands.

To save a TreeAge Pro document:
- Choose File > Save … OR … select the "save" icon (floppy disc) on the tool bar.
- In the Save As dialog, select or create a directory, type "Legal Example Tree" for the file name, and press ENTER or click Save.
TreeAge Pro can be set to periodically autosave each document that you open and modify. You can adjust the backup/autosave settings under Window > Application Preferences. In case of a problem, you can recover the latest auto-saved copy. You should still save your work periodically. It is also recommended that you save your tree files in a location that is regularly backed up. If you open and save files in the Files View, a local history for the file will be maintained. Right-click on the file in the Files View to access the local history.

5.3 Setup Model Configuration

In addition to its structure and numeric values, models must be setup or configured so that they are calculated and displayed in an appropriate way.

Setting up the model is essential to ensure the calculation preferences are set prior to analyzing the model, that is setting the way a model calculates and displays the model.

Model configuration settings are stored in Tree Preferences. The most important Tree Preference is the Calculation Method, which determines how TreeAge Pro selects the optimal strategy at each decision node. For this legal example tree, we want the “simple” calculation method, which uses a single outcome measure (damages). As the defendant, we want to choose the strategy that minimizes the damages.

It is useful to set Tree Preferences for numeric values to use appropriate Numeric Formatting when displaying calculated values (number of decimal places, currency symbols, and abbreviations like K for thousands).

These Tree Preferences can be set with or without the Model Setup Wizard, which navigates through the most commonly used Tree Preferences. We recommend using the Model Setup Wizard but also provide details below of how to configure the model directly via Tree Preferences.

Each tree has its own independent set of preferences. Changes to this tree’s preferences will not affect other trees.

5.3.1 Setting Tree Preferences with the Model Setup Wizard

When you create a new decision tree, the Model Setup Wizard prompt will ask if you want to configure your model. To deactivate this prompt, check the box as highlighted in the figure below. To reactivate this prompt, choose Tree > Auto-Configure New Models from the menu.
Creating a new tree prompts you to use the Model Setup Wizard.

To start the Model Setup Wizard at any other time, click the gears icon highlighted in the figure below or choose Tree > Model Setup Wizard from the menu bar.

The Model Setup icon, highlighted in the tool bar.

The Model Setup Wizard walks you through the most commonly used Tree Preferences listed below:

- Calculation method
- Additional options associated with the selected calculation method including the active payoff(s)
- Number of enabled payoffs
- Global discounting
- Custom payoff names
- Numeric formatting

The figure below shows the first step in the Model Setup Wizard. Choose the Next, Back, and Finish buttons as highlighted below to navigate through important Tree Preferences.
5 Get Started - Building a Decision Tree Model

The Model Setup Wizard walking you through important Tree Preferences.

In this Legal Example Tree, there are two things we are going to set via the Model Setup Wizard:

- Calculation method; and
- Numeric formatting.

In other models, additional Tree Preferences may need setting. We will use the Next button to skip through the other preferences. Open the Model Setup Wizard and then:

Configure the model:

- Select the "Simple" calculation method.
- Select "Low" as the optimal path. The model will identify the strategy with the lowest Expected Value as the optimal strategy. As the Defendant we want to minimize costs. Choose Next.
- Skip Payoffs. We do not want to enable any additional payoffs.
- Skip Global Discounting.
- Skip Custom payoff names. We could change payoff 1 to “Cost” here.
- In Numeric formatting, we want to set the format as Currency. Set:
  - Decimal places to “0”;
  - Select to use thousands separator;
  - Show numbers in thousands; and
  - Select units as Currency.
- Click Finish.

**Tree Preferences - Calculation Method** is set to Simple with the optimal path as "low"

**Tree Preferences - Calculation > Numeric Formatting**

To find out more details about setting model preferences, refer to the Preferences Chapter.

### 5.3.2 Setting Tree Preferences without the Model Setup Wizard

Using the Model Setup Wizard will prompt you to enter the most important Tree Preferences (recommended). You can also choose to set individual Tree Preferences without the Wizard. Use the toolbar to open the Edit Tree Preferences dialogue.

To set each required Tree Preference for the Legal Example Tree, open the Tree Preferences and then...

**Set the Calculation Method:**

- Navigate to the category Calculation > Calculation Method.
- Select the "Simple" and select the optimal path as "Low".

**Set the Numeric Format:**

- Navigate to the category Calculation > Numeric Formatting.
  - Change the numeric formatting for Payoff 1 as follows:
    - Decimal place to "0";
    - Select to use thousands separator;
    - Show numbers in thousands; and
    - Select units as Currency.

Press ENTER or click "Apply and close" to apply changes, and save the tree again now, by choosing File > Save.

Refer to the Preferences Chapter for more details on numeric formatting and other tree preferences, including information on creating and using preferences sets.

### 5.4 Entering payoff values

We have created the tree structure and set the Tree Preferences. Now we need to complete the tree structure by terminating the end nodes and entering payoffs.

Every path from the root node to an end node within the model represents a *scenario*. When a scenario is terminated with a terminal node, you must assign value(s) to that scenario. In TreeAge Pro, this is done by entering payoff values.

The *Settle at current demand* node is the end of a *scenario*, so it can be terminated.

**To change an endpoint to a terminal node:**

- Right-click on a node with no branches (in this case the *Settle at current demand* node).
- Select Change Type > Terminal from the context menu (see figure below).
  - ... OR ...
- Select the *Settle at current demand* node.
- Click the "Change node type" icon on the toolbar and select terminal from the list of node types.
  - ... OR ...
- Select the *Settle at current demand* node.
- Press *Control+T* on the keyboard and select terminal from the list of node types.
5 Get Started - Building a Decision Tree Model

Change node type via context menu

After changing *Settle at current demand* to a terminal node, TreeAge Pro automatically opens an Edit Payoff dialog for the node.

Edit Payoff Dialog for the selected node

Use the Edit Payoff dialog to assign the value for the *Settle at current demand* scenario ending at this terminal node. Specifically, set the Active Payoff value to 1000000 where it says "Enter payoff" and click OK.

*Note* the "Use custom payoffs names" check box in the Enter Payoff dialogue. If you check this box, you can edit the Payoff Set Label. This would allow us to edit the label *Active Payoff* to another name, such as Cost.

The payoffs are displayed in the Tree Diagram Editor to the right of the terminal node, as in the figure below. For more information about setting payoffs see the Changing what the tree calculates section.
Decision tree with Settle at current demand terminated and payoff set as 1000000.

Note that the entered payoff value does not use the numeric formatting we set via Tree Preferences. The numeric formatting will be used in the outputs when we analyze the model. You can format the entries with currency symbols and thousands separators if so desired.

To change the payoff value(s) at an existing terminal node:

- Double-click on the terminal node or the payoff values to the right (an ellipsis if no payoff values have been entered yet).
- ... OR ...
- Right-click on the terminal node and select Edit Payoffs from the context menu.

Finish the Plaintiff v Defendant Tree structure by terminating the remaining scenarios and entering payoffs at terminal nodes.

**Terminate the Jury finds defendant not liable for damages branch:**

- Select the *Jury finds Defendant not liable for damages* node and change the node type to Terminal.
- In the Edit payoff dialog, enter the payoff value of 0 for Payoff 1 and click OK.

**Terminate the three branches awarding damages:**

- Select the *High damages awarded* node/branch and change the node type to Terminal.
- In the Edit Payoff dialog, enter the payoff value of 4500000 for Payoff 1 and click OK.
- Repeat this process twice more for the remaining scenarios:
  - *Medium damages awarded*. Payoff = 2500000.
  - *Low damages awarded*. Payoff = 500000.

We have now terminated every end node in the model and provided payoff values for each scenario. The model should now have the same structure as the Plaintiff v Defendant model from the Files View.
5.5 Entering probabilities

The model includes chance nodes where we cannot control the outcomes represented by its direct branches. We need to enter probabilities for each branch to account for the likelihood of that specific outcome. The branch probabilities for each chance node must sum to 100% (or 1.0).

To enter a probability:

- Click on the red "Enter prob" prompt beneath the Jury finds defendant liable for damages node. An input field will appear.
- Enter 0.3 into the input field and press the ENTER key.
- ... OR ...
- Select the Jury finds defendant liable for damages node and click the toolbar icon for Enter Branch Expression.
- Enter 0.3 into the input field and press the ENTER key, see figure below.

![Decision Tree Diagram](image)

The same steps can be repeated for the remaining branches with the following probabilities:

- Jury finds defendant not liable for damages node, probability of 0.7.
- High damages awarded node, probability of 0.25.
- Medium damages awarded node, probability of 0.5.
- Low damages awarded node, probability of 0.25.

The model is now complete and can be calculated.

You can enter the hashtag ("#") for one branch of each chance node. The hashtag will evaluate to the complement of the sum of all other branch probabilities. For example, if you have branch probabilities of 0.2, 0.3, and #, the hashtag will evaluate to $1 - (0.2 + 0.3) = 0.5$. 
Regional (e.g., European) numeric settings:
- If your computer is set up to use commas ("","), to represent decimals, rather than periods ("."), you should enter numbers in TreeAge Pro this way. Normally, you will enter numbers in TreeAge models just as you would in a spreadsheet or calculator.
- If your model will be shared by users with different regional numeric settings, use a special tree preference to instruct TreeAge Pro to override a computer's regional settings (i.e., reverse the usage of separators) for that particular tree. This setting is found in the Tree Preferences under Regional Settings (see below).

5.6 Calculating the tree

The tree is now ready for analysis – the structure is complete and all necessary numeric values have been entered. Start by rolling back the tree, which performs the expected value calculations described in the Get Started with Decision Analysis chapter.

To roll back the tree:
- Select Analysis > Roll Back from the menu.
- ... OR ...
- Click the "beach ball" icon in the toolbar.

The rolled-back tree should look essentially like the picture below.
Expected value (EV) calculations start by calculating the payoff values at each terminal node. We just entered fixed numeric values, so those calculations are simple. In a typical model, there would likely be formulas here that require calculation.

At chance nodes, the EV is calculated as the weighted average of the EV of its branches – the sum of the EV of each branch multiplied by its probability.

At decision nodes, the optimal path branch is selected based on the calculation method. Our calculation method is “Simple” (one active payoff) with “low” as the optimal path. Therefore, the optimal strategy is the branch with the lowest EV.

The optimal strategy will be highlighted with a green branch connector. All rejected strategies are highlighted with a red branch connector with a double "strike through" marker. If a strategy were excluded from the analysis, its branch connector would be colored grey.

If TreeAge Pro displays an error message, examine the text for the course of the problem. Possible problems include endpoints that are not terminal nodes, and missing probability or payoff values.

If roll back works, but the reports look different than those shown below, you may need to check your work, and fix any probability or payoff that was entered incorrectly.

Note that changes cannot be made to structure or values while Roll Back is on. Roll back is on when the tree looks as in the figure above and the beach ball icon is “depressed” in the toolbar.

To turn off roll back display:

- Select Analysis > Roll Back from the menu.
- ... OR...
- Click the "beach ball" icon in the toolbar.

5.7 Next steps

You have completed the Get Started Building a Decision Tree tutorial: Plaintiff v Defendant. You are now ready to use TreeAge Pro to build your own decision trees.
Some questions you may have at this point:

- How can I build a tree to calculate cost-effectiveness? Refer to the Get Started - Building a Healthcare Decision Tree Model chapter which follows the same structure as this chapter, but for a cost-effectiveness model. More advanced details can be found in the Building and Analyzing Cost-Effectiveness Models Chapter.

- How do I add more payoffs? The Plaintiff v Defendant example requires only Payoff 1. However, each tree can use many payoffs or attributes; refer to the Tree Calculation Methods and Preferences Chapter for details.

- How can I customize the appearance of payoffs and other visual elements of trees? The Tree Display Preferences and Options Chapter describes how to customize these elements.

- How can I include my model in a presentation? Refer to the Printing and Presenting Trees Chapter.

- How can I do sensitivity analysis? Refer to the Introduction to Variables and Sensitivity Analysis Chapter.

- How can I handle complex values and formulas? Refer to the Building Formulas Using Variables and Functions.

You might take some time now to review the topics in these chapters. As you work with the software and have questions about functionality, bear in mind that the table of contents at the front of the manual will simplify finding answers.
6. Get Started - Building a Healthcare Decision Tree Model

There are two “Get Started” chapters. The previous chapter focuses on a simple legal model with one outcome – legal damages. This chapter focuses on a healthcare model with two outcomes – cost and effectiveness. Much of the content is repeated, so use the chapter that is appropriate for the types of models you will build.

You may want to review the TreeAge Pro Interface Chapter before continuing, in order to familiarize yourself with the elements of the user interface.

6.1 Defining the problem

Let us consider a Healthcare problem where we are comparing a new treatment to the existing treatment. The new treatment is more costly but is more likely to be successful in treating the disease, leading to better health outcomes. We will build a model to choose the most cost-effective treatment.

Most cost-effectiveness models project into the future using Markov models. Markov models are covered in detail in the Building and Analyzing Markov Models Chapter. In this simple example, we will use estimated future cost and life expectancy instead.

6.1.1 Representing the problem as a model

We have a decision to make between the two treatment options. These are:

1. Existing treatment; or

For each treatment option there are two outcomes:

1. Treatment success; or
2. Treatment failure.

Treatment success will result in a longer life expectancy. However, we don’t yet know whether this increased life expectancy can justify the higher cost.

We can represent this problem with a decision tree based on the information above. However, we will also need numeric values associated with this problem, specifically probabilities, treatment costs and life expectancy estimates.

6.1.2 Numeric Values

Each treatment has a probability of success:

- Existing treatment: 70%
- New treatment: 90%

Each treatment has a cost:
- Existing treatment: $7,000
- New treatment: $10,000

Successful and unsuccessful treatments have different life expectancy estimates. Note that these values are used in each treatment, but the new treatment will result in a higher percentage of people being treated successfully.
- Successful treatment: 10 years life expectancy
- Unsuccessful treatment: 7 years life expectancy

We now have all the information we require to build a decision tree in TreeAge Pro. The remaining sections of this chapter go through how to build this example model and analyze the model to make an informed decision. The finished model can be found in the Get Started Example models, and is called Evaluate New versus Existing Tx.

6.2 Create the tree structure

We will now create the tree structure for the Healthcare model described in the previous section.

The software has a perspective/layout to assist with building models. Select the Build perspective from the top right hand corner of the application window, and the interface will present you with toolbars, editors, and views related to model building.

6.2.1 Create a new tree

To create a new tree document:
- Select File > New from the menu or click Ctrl-N on the keyboard.
- ... OR ...
- In the toolbar click the icon for New Decision Tree.

This opens a new empty tab within the Tree Diagram Editor. The new model will consist of a single Decision Node.

A Model Setup dialogue will appear, asking if you want to configure the calculation method and outcomes for your model. Click ‘No’, but in the future you may choose to setup or configure your model before building. (You can return to the Model Setup Wizard at any point by selecting the gears icon in the toolbar).
The node furthest to the left within the model is the root node. All models must have a single root node from which all other nodes emanate, either directly or indirectly.

You should always Enter a label for every node in the model, including the root node. The red text that appears above the node in the Tree Editor prompts you to enter the label.

Prompts for data entry include:
- Enter label: Appears above branches and prompts you to enter a label for the branch.
- Enter prob: Appears below the branches (nodes to the right) of a chance node and prompts you to enter the probability.
- Enter condition: Appears below the branches of a logic node and prompts you to enter the condition to test at the logic node.
- Enter time: Appears below the branches of a time node branch for Discrete Event Simulation models.
- Enter payoff: Appears at terminal nodes and prompts you to enter values for a scenario.

6.2.2 Selecting a node

TreeAge Pro shows that a node is selected by filling in the node symbol.

To select a single node using the mouse:
- Click on the node line or the node symbol.

6.2.3 Entering and resizing node labels

When a single node is selected, a box will appear around the node label text. In the case of a new node, the initial text will be "Enter label".

To enter a node label:
- Click where it says "Enter label", above the node line, and an input text box will appear.
- Enter a brief phrase in the box to describe the event — in this case Evaluate new treatment.
- Press ENTER on your keyboard to save the new text as the node label.
- To undo the text you have typed...
  - Select ‘esc’ on your keyboard if you have not already saved the node label text.
  - Choose Edit > Undo from the menu if you have already saved the node label text.

To resize a node label (or text box):
Node (and other) labels entered into text boxes may wrap depending on the length of the description. Follow these instructions to resize the text box.

- Use the tick markers above and to the right of the text box in the ruler bar.
- Hover over the tick mark until a double arrow appears and then drag to resize the text box, as in the figure below.
- All text boxes directly above and below a given text box will also change size.
- Fonts and alignments of the node labels and nodes can also be changed via the Tree Preferences > Display settings which you can access via the tool bar.

6.2.4 Adding branches/nodes

A branch must be added to the decision node to represent each strategy. For this model, add branches Existing treatment and New treatment.

To add branches:

- Select the Decision Node.
- Click the ‘Add branches’ toolbar icon which will add two branches.
- ... OR ...
- Drag a chance node from the Tree Diagram Editor Palette to the right of the existing decision node. A red line will appear indicating where the node can be placed. Release the mouse when the new node is visible as a branch of the decision node.
- Repeat this for a second chance node which should also be a branch of the decision node.
- ... OR ...
- Right-click on the decision node and select Add Branch from the context menu. Two chance nodes will be added as branches.

Don't be confused by the terms branch and node. They both refer to the same element of a tree model. The term branch is normally used to describe the specific nodes that emanate directly from a parent node (the closest node to the left).

For more information on changing tree structure, refer to the following sections:

- Deleting nodes (refer to Deleting nodes/branches)
- Zoom in or out (refer to Tree Building and Navigating the Tree)
- Navigating the tree using the keyboard (refer to Tree Building and Navigating the Tree)

6.2.5 Label the strategy nodes

Now we can enter node labels for our strategy nodes.

- Select the top branch from the decision node, open the text box, and type Existing treatment.
- Select the bottom branch from the decision node, open the text box, and type New treatment.

The tree should now look like this:

![Diagram]

- Rather than entering extensive comments in the node itself, it is often better to use note boxes or node comments (refer to the Annotation Chapter).
- Many tree-building commands are found under the Node menu or by right-clicking on a node.
- If you delete a branch that is a parent (i.e., that has branches), its subtree (i.e., its children as well as their descendants) will not be deleted; instead the children and their descendants will move up one generation. Refer to the Changing the Tree Structure Chapter for more information on inserting and deleting nodes.

Tips

6.2.6 Complete the tree structure

Each strategy has two outcomes:

- Treatment success; or
- Treatment failure.

For each strategy, repeat the following steps:

- Select the strategy node and add two branches.
  - Double click to add two branches ... OR ...
  - Use the toolbar to add two branches.

- Label the top branch Treatment success and the bottom branch Treatment failure.

The tree structure is now complete and the model needs to be configured before incorporating the numeric values.

The tree should now look like this:
6.2.7 Saving the tree

Now that all necessary nodes have been added, it is a good time to save your work.

TreeAge Pro models are documents. You save, open, and close trees and other documents in TreeAge Pro the same way you do in other programs — using the File menu commands.

To save a TreeAge Pro document:

- Choose File > Save … OR … select the "save" icon (floppy disc) on the tool bar.
- In the Save As dialog, select or create a directory, type "Healthcare Example Tree" for the file name, and press ENTER or click Save.

TreeAge Pro can be set to periodically autosave each document that you open and modify. You can adjust the backup/autosave settings under Window > Application Preferences. In case of a problem, you can recover the latest auto-saved copy. You should still save your work periodically. It is also recommended that you save your tree files in a location that is regularly backed up.

If you open and save files in the Files View, a local history for the file will be maintained. Right-click on the file in the Files View to access the local history.

6.3 Setup Model Configuration

In addition to its structure and numeric values, models must be setup or configured so that they are calculated and displayed in an appropriate way.

Setting up the model is essential to ensure the calculation preferences are set prior to analyzing the model, that is setting the way a model calculates and displays the model.

Model configuration settings are stored in Tree Preferences. The most important Tree Preference is the Calculation Method, which determines how TreeAge Pro selects the optimal strategy at each decision node.

For this healthcare example model, we want to use Cost-Effectiveness Analysis (CEA) to choose the optimal strategy, so we will set the Calculation Method to “Cost-effectiveness”, which uses two outcome
measures - cost and effectiveness. CEA will use both outcomes to determine the optimal strategy at the decision node. More details about the CEA theory can be found in the chapter about Cost-Effectiveness modeling.

For CEA, Willingness-To-Pay (WTP) is often used along with cost and effectiveness to choose the optimal strategy. In this model we will set the WTP to be $50,000.

It is useful to set Tree Preferences to use appropriate Numeric Formatting when displaying calculated values (number of decimal places, currency symbols, and abbreviations like K for thousands).

These Tree Preferences can be set with or without the Model Setup Wizard, which navigates through the most commonly used Tree Preferences. We recommend using the Model Setup Wizard but also provide details below of how to configure the model directly via Tree Preferences.

Each tree has its own independent set of preferences. Changes to this tree’s preferences will not affect other trees.

### 6.3.1 Setting Tree Preferences with the Model Setup wizard

When you create a new decision tree, the Model Setup prompt will ask if you want to configure your model. To deactivate this prompt, check the box as highlighted in the figure below. To reactivate this prompt, choose Tree > Auto-Configure New Models from the menu.

Creating a new tree prompts you to use the Model Setup Wizard.

To start the Model Setup Wizard at any other time, click the gears icon highlighted in the figure below or choose Tree > Model Setup Wizard from the menu bar.

The Model Setup Wizard walks you through the most commonly used Tree Preferences listed below:

- Calculation method
- Additional options associated with the selected calculation method including the active payoff(s)
- Number of enabled payoffs
- Global discounting
- Custom payoff names
- Numeric formatting
The figure below shows the first step in the Model Setup Wizard. Choose the Next, Back, and Finish buttons as highlighted below to navigate through important Tree Preferences.

The Model Setup Wizard walking you through important Tree Preferences.

In this Healthcare Example Tree, there are two things we are going to set via the Tree Preferences:

- Calculation method;
- Cost-Effectiveness Parameters; and
- Numeric formatting.

In other models, additional tree preferences may need setting. We will use the Next button to skip through the other preferences. Open the Model Setup Wizard and then:

Configure the model:

- Select the "Cost Effectiveness" calculation method, and note the default Cost payoff is 1 and the default Effectiveness payoff is 2 (nothing to change). Click Next.
- In Cost-Eff Params (WTP):
  - Set Willingness to pay: 50000; and
  - Check “Show Net Benefits in rollback”.
  - Click Next.
- Skip Payoffs. We do not want to enable any additional payoffs.
- Skip *Global Discounting*.
- Skip *Custom payoff names*. Payoff 1 will be labelled “Cost”, and payoff 2 to will be labelled “Effectiveness” automatically.
- In *Numeric formatting*, we want to set the format as follows:
  - For *Cost*:
  - For *Effectiveness*
    - Decimal places to “0”;
    - Select to use thousands separator and add trailing zeros; and
    - Select units as Currency.
    - Decimal places to “2”;
    - Select to use thousands separator and add trailing zeros; and
    - Select units as Custom suffix and add the suffix $LY$ (for Life Years).

- Click Finish.
Tree Preferences - Calculation > Calculation Method > Cost-Effectiveness > Cost-Eff Params (WTP)

Tree Preferences - Calculation > Numeric Formatting for Cost, Effectiveness and Cost-Effectiveness
To find out more details about setting model preferences, refer to the Preferences Chapter.

6.3.2 Setting Tree Preferences without the Model Setup Wizard

Using the Model Setup Wizard will prompt you to enter the most important Tree Preferences (recommended). You can also choose to set individual Tree Preferences without the Wizard. Use the toolbar to open the Edit Tree Preferences dialogue.

To set each individual Tree Preference for the Healthcare Example, open the Tree Preferences (via the toolbar) and then...

*Set the Calculation Method:*

- Select the category Calculation > Calculation Method and set the calculation method to "Cost-effectiveness"
- Select the category Calculation > Calculation Method > Cost-Effectiveness > Cost-Eff Params (WTP).
  - Set the WTP as 50000.
  - Check the box to “Show the Net Benefits in rollback”.

*Set the Numeric Format:*

- Navigate to the category Calculation > Numeric Formatting.
  - Change the Numeric Formatting as described in the section above “Setting Tree Preferences with the Configure model wizard”.

Press ENTER or click "Apply and close" to apply changes, and save the tree again now, by choosing File > Save.

Refer to the Preferences Chapter for more details on numeric formatting and other tree preferences, including information on creating and using preferences sets.

6.4 Entering payoff values

We have created the tree structure and set the Tree Preferences. Now we need to complete the tree structure by terminating the end nodes and entering payoffs. Every path from the root node to an end node within the model represents a scenario. When a scenario is terminated with a terminal node, you must assign value(s) to that scenario. In TreeAge Pro, this is done by entering payoff values.
There are no variables used in this model (for payoffs or probabilities) because this chapter focuses on basic model building.
Variables are important and should be used in models for consistency and for further analysis such as Sensitivity Analysis.
More information about working with variables and using variables in complex functions can be found following the links.

There are four scenarios in our model which need to be terminated.
Let’s start with the top most scenario: Existing Treatment > Treatment success.

To change an endpoint to a terminal node:
- Right-click on a node with no branches (in this case the Treatment success node).
- Select Change Type > Terminal from the context menu (see figure below).
- ... OR ...
- Select the Treatment success node.
- Click the "Change node type" icon on the toolbar and select terminal from the list of node types.
- ... OR ...
- Select the Treatment success node.
- Press Control+T on the keyboard and select terminal from the list of node types.

After changing Treatment success to a terminal node, TreeAge Pro automatically opens an Edit Payoff dialog for the node.
Edit Payoff Dialog for the selected node

Note that because the calculation method is set to Cost-Effectiveness, the dialog prompts for you to enter payoff values for both cost and effectiveness.

To enter the payoffs at a terminal node:

- Use the Enter Payoff dialog to assign the numeric payoff values for each of the payoffs in the Value at Node column. The values associated with the Treatment success node are:
  - Cost: 7000
  - Effectiveness: 10
- Select "OK" when finished.

Note the "Use custom payoffs names" check box in the Enter Payoff dialogue. If you check this box, you can edit the Payoff Set Label. For the Cost-Effectiveness calculation method, the Active Payoffs are Cost and Effectiveness.

When entering the payoff values for cost, you can use the following format: $7k. TreeAge Pro will use the value of 7000 in the calculations but the display of the payoff in the tree will be: $7k/10 instead of 7000/10.

The payoffs are displayed in the Tree Diagram Editor to the right of the terminal node, as in the figure below. For more information about setting payoffs see the Changing what the tree calculates section.
Note that the entered payoff value does not use the numeric formatting we set via Tree Preferences. The numeric formatting will be used in the outputs when we analyze the model. You can format the entries with currency symbols and thousands separators if so desired.

**To change payoff value(s) at an existing terminal node:**

- Double-click on the terminal node or the payoff values to the right (an ellipsis if no payoff values have been entered yet).
- ... OR ...
- Right-click on the terminal node and select Edit Payoffs from the context menu.

Finish the Evaluate New versus Existing Treatment Tree structure by terminating the remaining scenarios and entering payoffs at terminal nodes.

**Terminate other scenarios and assign payoffs:**

- Using the steps described above, terminate the remaining three scenarios by changing the end nodes to Terminal Nodes and entering payoffs based on the values provided below.
- Existing treatment > unsuccessful treatment:
  - Cost: 7000
  - Effectiveness: 7
- New treatment > successful treatment:
  - Cost: 10000
  - Effectiveness: 10
- New treatment > unsuccessful treatment:
  - Cost: 10000
  - Effectiveness: 7

We have now terminated every end node in the model and provided payoff values for each scenario.
6.5 Entering probabilities

The model includes chance nodes where we cannot control the outcomes represented by its direct branches. We need to enter probabilities for each branch to account for the likelihood of that specific outcome. The branch probabilities for each chance node must sum to 100% (or 1.0).

To enter a probability:

- Click on the red "Enter prob" prompt beneath the top most Treatment success node. An input field will appear.
- Enter 0.7 into the input field and press the ENTER key.
- ... OR ...
- Select the Treatment success node and click the toolbar icon for Enter Branch Expression.
- Enter 0.7 into the input field and press the ENTER key, see figure below.

The same steps can be repeated for the remaining branches with the following probabilities:

- Treatment failure node, probability of 0.3.
- New Treatment > Treatment success node, probability of 0.9.
- New Treatment > Treatment failure node, probability of 0.1.

You can enter the hashtag ("#") for one branch of each chance node. The hashtag will evaluate to the complement of the sum of all other branch probabilities. For example, if you have three branches with probabilities of 0.2, 0.3, and #, the hashtag will evaluate to $1 - (0.2 + 0.3) = 0.5$.

In the model we have above, we could use the branch probabilities of 0.9 and #, where the hashtag would evaluate to $1 - 0.9 = 0.1$.
**Regional (e.g., European) numeric settings:**

- If your computer is set up to use commas (",") to represent decimals, rather than periods ("."), you should enter numbers in TreeAge Pro this way. Normally, you will enter numbers in TreeAge models just as you would in a spreadsheet or calculator.

- If your model will be shared by users with different regional numeric settings, use a special tree preference to instruct TreeAge Pro to override a computer’s regional settings (i.e., reverse the usage of separators) for that particular tree. This setting is found in the Tree Preferences under Regional Settings (see below).

![Tree Preferences, Regional Settings](image)

### 6.6 Calculating the tree

The tree is now ready for analysis – the structure is complete and all necessary numeric values have been entered. Start by *rolling back* the tree, which performs the expected value calculations described in the Get Started with Decision Analysis chapter.

**To roll back the tree:**

- Select Analysis > Roll Back from the menu.
- ... OR ...
- Click the "beach ball" icon in the toolbar.

The rolled-back tree should look essentially like the picture below.
For models with the Calculation Method “Cost-Effectiveness”, expected values are calculated separately for the cost payoff and the effectiveness payoff. Both sets of expected values are critical to decision making.

Expected value (EV) calculations start by calculating the payoff values at each terminal node. We just entered fixed numeric values, so those calculations are simple. In a typical model, there would likely be formulas here that require calculation.

At chance nodes, the EV is calculated as the weighted average of the EV of its branches – the sum of the EV of each branch multiplied by its probability.

At decision nodes, the optimal path branch is selected based on the calculation method. Our calculation method is “Cost-Effectiveness” (two active payoffs). The optimal strategy is the strategy with the highest Net Monetary Benefits based on cost-effectiveness analysis methodology. Net Monetary Benefits are described in detail in the Cost Effectiveness Modeling chapter.

The optimal strategy will be highlighted with a green branch connector. All rejected strategies are highlighted with a red branch connector with a double "strike through" marker. If a strategy were excluded from the analysis, its branch connector would be colored grey.

If TreeAge Pro displays an error message, examine the text for the course of the problem. Possible problems include endpoints that are not terminal nodes, and missing probability or payoff values.

If roll back works, but the reports look different than those shown below, you may need to check your work, and fix any probability or payoff that was entered incorrectly.

Note that changes cannot be made to structure or values while Roll Back is on. Roll back is on when the tree looks as in the figure above and the beach ball icon is “depressed” in the toolbar.

To turn off roll back display:

- Select Analysis > Roll Back from the menu.
- ... OR...
- Click the "beach ball" icon in the toolbar.
6.7 Next steps

This completes the Get Started Healthcare tutorial: Evaluate New versus Existing Tx. You are now ready to use TreeAge Pro to build your own decision trees.

Some questions you may have at this point:

- How can I better understand cost-effectiveness analysis? Refer to the Building and Analyzing Cost-Effectiveness Models Chapter.
- How can I include my model in a presentation? Refer to the Printing and Presenting Trees Chapter.
- How can I do sensitivity analysis? Refer to the Introduction to Variables and Sensitivity Analysis Chapter.
- How can I do sensitivity analysis? Refer to the Introduction to Variables and Sensitivity Analysis Chapter and to the Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis Chapter.
- How can I handle complex values and formulas? Refer to the Building Formulas Using Variables and Functions.
- How can I add more outcome measures to my model? Refer to the Tree Calculation Methods and Preferences Chapter.
- How can I customize the visual elements of the model? Refer to the Tree Display Preferences and Options Chapter.

You might take some time now to review the topics in these chapters. As you work with the software and have questions about functionality, bear in mind that the table of contents at the front of the manual will simplify finding answers.
7. Influence Diagrams

In TreeAge Pro, the primary model type is a decision tree. However, influence diagrams can be helpful when creating or presenting a model. You can create influence diagrams in TreeAge Pro for these purposes. However, all analyses must be performed on decision trees.

This chapter consists of a tutorial describing how to create an influence diagram.

- Influence diagrams replace dependency diagrams supported by TreeAge Pro 2012 and earlier.
  - Influence diagrams provide new functionality as well as all functionality supported by dependency diagrams. Dependency diagrams are obsolete, but they can be imported into the new influence diagram format.

7.1 Influence diagrams

Influence diagrams tend to be simpler on their face than decision trees. While they do not display the level of detail found in a tree (i.e., scenarios, probabilities, and payoffs), influence diagrams portray more clearly the factors to consider in decision making, and how those factors are related. Even in complex problems, where the decision tree is far too large to fit on a single printed page, the corresponding influence diagram is almost always small enough for simple reproduction and efficient communication.

The design of an influence diagram is subject to a number of guidelines. Here are the basic ones:

- "Nodes" of different shapes represent the factors relevant to the problem. Each element of the problem — the final objective (e.g., maximizing profit), along with each decision, and random event that can affect the objective — is represented by a single node. A value node (diamond) denotes a measure of the final objective. A decision node (square) is used to indicate a decision. A chance node (circle) is used to represent an event whose value (or outcome) is currently unknown.

- Related nodes are connected by arcs. An arc ending in an arrow is drawn between two nodes to indicate that: (a) the first event precedes the second, and/or (b) the first event or action affects (or conditions) the second. An influence arc might indicate that the probabilities for one event depend on the outcome of a prior event or action. An influence arc might also indicate that an action or event makes some contribution to, or deduction from, the final objective (e.g., project cost, or profit).

7.2 Constructing an influence diagram

The tutorial in this chapter explains in detail the software commands needed to build an influence diagram model of the investment decision described in the Decision Analysis Primer Chapter.
To get started, you will need a new influence diagram document.

To create a new influence diagram:

- Choose File > New Influence Diagram from the menu.

7.2.1 Adding and selecting nodes

Unlike a new tree, which starts with a root node, a new influence diagram window is completely blank. The first step in building the diagram is to add the required nodes. Let’s start by showing the final objective — profit.

To add a node to an influence diagram:

- Click on the appropriate node type in the Diagram Editor Palette — in this case, the red diamond, for a value node. See below.
- Click and drag the node into a space towards the right side of the influence diagram editor to place it.
- Drag the mouse down and to the right to resize the new node.

Influence Diagram Palette

You will see a new, selected value node. TreeAge Pro indicates that the node is selected by showing a rectangular outline with resizing markers on every corner and every edge. The node label will also be selected waiting for you to enter the appropriate text.

The outline around the node can be used to move or resize the node.

When the node is not selected, the rectangular outline will disappear. Since the node label was not entered, it will appear as an elipsis.
- Click inside the node borders.

### 7.2.2 Entering the node label

You should enter a word or brief phrase in the text box to describe this element of the problem — in this case, the investment objective. You can enter the node label when you first create the node, or you can enter/edit the node label later.

**To enter/edit the node label:**

- Select the node.
- Click on the existing node label or the middle of the node if no text has already been entered.
- Type the node label text (in this case *Profit*) in the text area.
- Click outside the node to deselect it.

![Profit node with node label entered](image)

Now add a node for the first event that affects return on investment — the decision.

- Create a decision node (blue square).
- For its label, enter *How should I invest $1000?*

![Added decision node](image)

To force a carriage return in a label press *Control + Enter* within the text.

### 7.2.3 Adding arcs

Earlier in this chapter, arcs were introduced as a means of displaying the relationships between actions, variables, events, and objectives. The direction of influence between the two nodes added so far is from the investment decision to *Profit*, so an arc should be created that points to the value node.

**To draw an arc:**

- Click on Arc in the Influence Diagram Editor Palette (See figure below).
- Click on the influencing node (*How should I...*) and drag the mouse to the conditioned node (*Profit*); then release the mouse button.
Influence Diagram Palette

A new arc will be created pointing from the *How should I invest $1000* node to the *Profit* node.

Add new arc

It is frequently useful to add a comment to a label to describe the influence relationship represented by the arc.

*To edit an arc label:*

- Double-click on the arc.
- Enter text ("Maximize") into the Arc Data dialog Comment field.
- Click OK.

The arc label can also be moved closer/further from the arc.

*To move an arc label:*

- Click on an arc label and drag it to a new location.

As the arc moves relative to its source/destination nodes, the label will automatically move with it.

Now, add the other required node — a chance node representing the risk inherent in choosing the stock — and its influence arc.

- Create a chance node (green circle), and for the node name enter *Market activity*.
- Create an arc from *Market activity* to *Profit* and enter the label "Determines".
- Create an arc from *How should I invest $100* to *Market Activity* to indicate the order of actions within the influence diagram.

Here is essentially how your three-node influence diagram should now look:
Now that all nodes and arcs have been added, take a moment to save your document. You save, open, and close influence diagrams and other documents in TreeAge Pro the same way you do in other programs — using the File > Save As command. Influence diagrams are saved with the file extension *.indx rather than *.trex.

### 7.2.4 Outcomes and Alternatives

Although the influence diagram may appear to be complete, outcomes and alternatives must be added before it can be converted to a decision tree.

- Alternatives represent the choices available to the decision maker at a decision node.
- Outcomes represent the possible events that can occur from a chance node.

**To add alternatives to a decision node:**

- Right-click on the decision node.
- Choose Alternatives from the context menu.
- Click Add to create an alternative and enter label text.
- Repeat the last step to add additional alternatives.
- Click OK.

For this influence diagram, the following alternatives should be added.

**Edit Node Alternatives Dialog**

**To add outcomes to a chance node:**

- Right click on the chance node.
- Choose Outcomes from the context menu.
- Click Add to create an outcome and enter label text.
- Repeat the last step to add additional outcomes.

For this influence diagram, the following outcomes should be added.

![Edit Node Outcomes Dialog]

### 7.2.5 Asymmetry

Asymmetry allows you to eliminate some node combinations from the converted decision tree. For instance, in this chapter’s example, market activity affects the *Risky investment* alternative but has no impact on the *CD paying 5%* alternative.

**To establish asymmetry in the model:**

- Double-click on the arc between *How should I invest $1000* and *Market Activity*.
- Deselect the Influence Type checkboxes for Prob and Value associated with the *Risky investment* alternative to show that the alternative choice has no influence on the *Market Activity* outcomes.
- Deselect the Influence Type checkboxes for Prob and Value associated with the *CD paying 5%* alternative.
- Choose Skip from the Additional Info column options for *CD paying 5%* alternative to indicate that *Market Activity* has no impact on that alternative.
- Click OK.

The choices from the steps above are shown below.
Because there is no impact of the decision alternatives on the chance node outcomes, the arc turns grey and dotted.

The influence diagram is now complete.

**Arc Data Dialog**

Because there is no impact of the decision alternatives on the chance node outcomes, the arc turns grey and dotted.

The influence diagram is now complete.

**7.2.6 More editing options**

Additional options for editing influence diagrams are described in this section.

*To move a node:*

- Select a node and drag its outline (not a resize point) to a new location.

When a node is moved, the arcs attached to it will also move.

*To cut a node:*

- Select a node.
- Choose Edit > Cut from the menu or press Control + X on the keyboard. *Arrows attached to the node will also be cut.*

*To resize a node:*

- Select a node.
- Click and drag one of the resize marks on the rectangular outline around the node.

**To select multiple nodes:**
- Select one node then hold down the Shift key and select another node.
- ... OR ...
- Click on open space in the diagram and drag to create a rectangle that surrounds all elements you wish to select

**To delete an arc:**
- Select the arc.
- Press the *Delete* button on the keyboard.

**To bend an arc:**
- Click on the arc and drag it to another location. Rather than moving the entire arc, it will be split into two line segments, each terminated at the new drag location.
- You can bend this further by dividing up those line segments further using the same technique.

### 7.3 Converting an influence diagram to a decision tree

Now that the influence diagram is complete, it can be converted to a decision tree.

**To convert the diagram:**
- Open and activate the influence diagram editor window.
- Click the Convert to Tree icon in the toolbar.

A decision tree model is then created in the tree diagram editor with the same name as the influence diagram, but with the extension .trex added to the end.
Decision Tree from Conversion

The decision tree structure is created. You would then need to add probabilities and payoffs to the decision tree prior to running analyses.
8. Printing and Presenting Trees

This chapter provides basic instructions on how to customize printouts of your TreeAge Pro models, and how to import pictures of models into document and presentation programs like Microsoft® PowerPoint™, Excel™, or Word™.

8.1 Printing

Printing documents in TreeAge Pro is similar to printing documents from any other Windows application.

To print a document:

- Select the document you wish to print.
- Choose File > Print from the menu or click on the Print toolbar icon (printer).
- Click OK in the Print Dialog.

The Print Dialog includes some options that may be useful.

Print Dialog

Within the Print Dialog, you can select the Printer from among those available to your computer. The Properties button provides access to the printer’s preferences.

The Tree View section provides two options.

- **Diagram**: Print the visual representation of the tree.
- **Text Tree**: Print a textual representation of the models nodes based on their position within the tree.

The Print Range section allows you to select which pages to print. A small model easily prints on a single page. A large tree may not initially print on a single page, but you may be able to get it to fit by shrinking it, or by changing the page orientation to landscape (horizontal).
The Orientation section allows you to select whether to align the paper vertically or horizontally.

The Copies section allows you to print multiple copies of the tree.

The Scaling section allows you to adjust the size of the tree to fit on more or fewer pages.

You can use Print Preview from the File menu to see how your model will be printed on a page. The Print Preview Dialog has a scaling option to allow you to zoom in/out depending on how the model fits on the page(s).

You can also set page header and footer for the tree via the Tree Preferences.

To print a tree in black and white, first follow the instructions to export a picture of a tree in Export Pictures and then print the image.

8.2 Exporting Pictures

You may want to export a picture of a model or part of a model or a graph for insertion into a separate document.

To export a picture of a tree:

- Select the tree you wish to print by having it open in the Tree Editor.
- From the menu, choose File > Save Image where you will be prompted to select the nodes you want to export:
  - Selected Nodes: Exports the nodes currently selected in the Tree Diagram Editor.
  - Subtree: Exports the selected node and its entire subtree.
  - All Nodes: Exports the entire tree.
- Select the image format and file location in the Save As Image File dialog box (see figure below).
- To export and/or print in black and white, check save in greyscale.
- Then click OK.
To export a graph as an image:

- Create any graph (and ensure it is the active image in the Tree Editor).
- Use one of the options for saving the image, any of:
  - Select the Save file or Save image icon from the tool bar; or
  - Select the Save file icon from above and to the right of the graph; or
  - Choose File > Save from the menu.

- Enter a filename and location, and select the image format in Type, as in the Save/Export Chart dialog figure below.
- Selecting different file types, such as PNG, JPEG and BMP, will give you the options of changing the image properties. Dimension is changed by altering the width and height. The resolution is changed by altering the scale parameter.
- Click Save.
Save graph dialog

JPEG, JPG and PNG files are good for presentation on the web. Depending on the type of graph, experimentating with different width, height and scale parameters for the image resolution will produce images of different quality. SVG and PDF files are good for sending to publishers or for further editing in graphic design software.

8.3 Print / Export Wizard

The Print/Export Wizard allows you create the best Tree Diagram image for exporting and/or printing. It provides the options in one place for:

- Paginating the output.
- Showing/hiding elements of the model.
- Choosing the output format.

To use the Print/Export Wizard

- Open the Tree you want to print or save as an image.
- Select File > Print/Export Wizard.
- Choose your Tree Image Layout Options to determine how and whether to split the tree among multiple images.
- Choose your Model Display Options to select which elements of the model to include in the image outputs. You can hide all numeric values to present just the model structure.
- Select the Output Options to send the output to image files or to a printer.
- For Printer: Select the appropriate Printer preferences and then select Print.
- For Images: Select Finish and then the Save As Image dialogue will open. Select the appropriate location to save and image type, and then select Save.

Note that the exported output will reflect the presentation on screen with the exception of the options selected via the wizard dialog. For example, node widths and collapsed subtrees will appear in the output just the same as they do on screen.

Dialog to choose whether/how to split the model into multiple images

The following dialogue appears to help you select what you want to include in the export (selections would display details of values for active payoffs)

Options selected during the export wizard are remembered for the next time you run the wizard.

When you select Finish, the images will either be sent to a printer, or they will open in your computer's native image viewer.
9. Analyzing Decision Trees

This chapter describes in detail the variety of expected value analyses available in TreeAge Pro.

9.1 Numeric Formatting

TreeAge Pro performs calculations at the highest available precision, but values are displayed using a specified number of decimal places — up to 9 — with the option to use abbreviations and unit symbols. As described at the end of the Decision Tree Tutorial Chapter, each tree and graph has its own set of numeric formatting preferences.

To view/modify a document's numeric formatting:

- Select the model.
- Press the F11 key or open Tree Preferences.
- In the Tree Preferences dialog, select the Calculation > Numeric Formatting category.

Tree Preferences - Numeric Formatting

Each Numeric Formatting option is described within in the Preferences Chapter.
Notes on entering numbers:
If your computer is set to use commas (”,“) to represent decimals, rather than periods (".")
enter numbers in TreeAge Pro in this fashion, just as you would in a spreadsheet or calculator.
Particular trees, however, can be set to override the computer’s regional settings and reverse
the usage of decimals via the Regional Settings Tree Preferences.
Independent of numeric formatting preferences, payoffs and other values can be entered
using K/M/B abbreviations and thousands separators (e.g., typing 2K is equivalent to typing
2,000). Scientific notation can also be used when entering very small or very large numbers
(e.g., typing 1e3 is equivalent to typing 1000).

9.2 Expected values

In addition to calculating and displaying expected values for all nodes in a tree (see Roll back in the
next section), TreeAge Pro can also report a single expected value for a selected node. This provides a
useful method of verifying the completeness of a single part of an incomplete tree. Roll back calculates
and displays expected values for all nodes in a tree (see Roll back, below).

To calculate the expected value of a node:
- Select a node.
- Choose Analysis > Expected Value...
- ... OR ...
- Press CTRL-E on the keyboard.

Expected value at node

The result is displayed using the tree’s current numeric formatting preferences; see the previous section
on numeric formatting for details.

Using the expected value result:
The Decision Analysis Primer Chapter includes a detailed description of the basic concepts
used in calculating expected values in decision trees. Refer to that chapter, or one of the
books listed at the end of the chapter for a review of basic concepts.
Calculation details can be reviewed for debugging purposes via Tree Preferences and the Calculation Trace Console. Usage is described in the Markov Microsimulation Chapter, even though the Healthcare Module is not required.

### 9.3 Roll back

As described in the Decision Analysis Primer Chapter, roll back refers to the calculation of expected values starting at the terminal nodes and continuing back to the root node. In TreeAge Pro, a variety of information is reported in the tree when it is rolled back.

*To roll back the tree:*

- Select Analysis > Roll Back (or click the beach ball icon in the tool bar).

The rolled back Business tutorial example, Stock Tree, from the aforementioned chapter, is shown below:

![Roll back display](image)

**Roll back display**

Note that expected values are displayed in roll back boxes at every node. The favored strategy, *CD Paying 5%*, is highlighted in green, while the branch connector to the rejected strategy, *Risky investment*, is highlighted in red and displayed with hash marks.

*To turn off roll back:*

- Select Analysis > Roll Back (again).

#### 9.3.1 Roll back display details

*Decision nodes:* A box to the right of the node reports the name and expected value of the preferred alternative. TreeAge Pro marks the branches of non-optimal alternatives using hashes, and colors the optimal branch.

*Chance nodes:* A box to the right of the node reports the expected value. Probabilities are calculated (if necessary) and displayed beneath the node’s branches.

*Terminal nodes:* A box to the right of the node reports the calculated payoff value.
9.3.2 Customizing the roll back display

A picture of the rolled-back tree can be printed or exported to a graphic file; see Printing and Presenting Trees Chapter complete details.

There are many ways to customize the appearance of the rolled-back tree prior to printing or exporting it. In addition to the basic options described on the following page, there are a wide variety of other tree display preferences related to roll back (for example, setting up terminal node columns); see Tree Display Preferences and Options Chapter.

Values displayed in the rolled back are displayed using the tree’s numeric formatting settings; see the beginning of this chapter for details on modifying these preferences.

When roll back is turned on, initially all nodes in the optimal path are selected (highlighted). Clicking on the tree will deselect these nodes.

Occasionally, a roll back box will cover the text of a branch description or probability. This can be corrected by moving the box.

To move a roll back box:

- Click and drag the box to a better location.

It is also possible to hide individual roll back boxes.

To hide a selected node’s roll back box:

- With the tree rolled back, right-click on the node whose roll back box you want to hide.
- From the pop-up quick menu, choose Hide roll back box.

Notes on roll back boxes:

- Roll back box state will be saved with the tree.
- A hidden roll back box can be redisplayed by right-clicking on the node and choosing Hide roll back box again.
- If you want to reset hidden and moved roll back boxes in a section of the tree, cut the subtree and then paste it back into place.

9.4 Rankings

The Rankings analysis, available when a single decision node is selected, displays a text report listing the alternatives at that node and their expected values, in rank order.

Try the Rankings analysis on the Business tutorial example called Rankings Analysis, which is a slightly more complex version of the Stock Tree from the Decision Tree Tutorial Chapter.

To calculate and rank decision alternatives:
- Select the decision node.
- Choose Analysis > Rankings.

A text report appears which ranks the options, and specifies their expected values. In the case of suboptimal options, it also specifies a marginal (or incremental) value — the amount by which one option is outperformed by the next best option.

The text report dialog includes an Export Report As link to export the displayed text to another program.

### 9.5 Standard deviation

In addition to comparing strategies based on their expected values, TreeAge Pro also offers several ways to look at an option’s risk — the degree of variability in outcomes. The basic statistical measure of risk is standard deviation. In TreeAge Pro, a standard deviation can be calculated for a single strategy (or any other chance node), based on the path probabilities and payoffs of all terminal nodes in its path.

To try the standard deviation calculation, try the Special Features tutorial example, Standard Deviation.

In this tree, despite the fact that the three alternatives look different, a rankings or roll back analysis is indifferent between them — all three have the same expected value: 90. In this case, a choice might be based on minimizing risk as measured by standard deviation.
Standard Deviation Model

To calculate a standard deviation:

- Select the chance node labeled A.
- Choose Analysis > Standard Deviation.

The calculation used is:

\[ SD(Strategy\ A) = \sqrt{0.5(60 - 90)^2 + 0.5(120 - 90)^2} = 30 \]

where 90 is the strategy A’s expected value, or mean. Compare this to the calculated standard deviations for strategies B and C:
If you were to choose a strategy based on minimizing risk, as measured by standard deviation, strategy A would be preferred. Note that B and C are statistically identical, having the same terminal node values and path probabilities, and thus the same standard deviation:

\[ SD(\text{Strategy } B/C) = \sqrt{0.25(40 - 90)^2 + 0.25(80 - 90)^2 + 0.5(120 - 90)^2} = 33.166 \]

### 9.6 Discrete simulation/microsimulation

In decision analysis, the most efficient calculation is to use expected values, as described in the Decision Analysis Primer Chapter and illustrated in this chapter. However, it is also possible to evaluate decision trees using individual-level simulation, sometimes referred to as discrete simulation or microsimulation.

Discrete simulation in decision trees approximates an expected value by “sampling” a representative distribution of paths through the model’s chance events. Discrete simulation of complex models generally utilizes as many “trials” as time allows, in order to improve the EV estimation (ensuring even small probability paths are “sampled” proportionally). If run at a decision node, each trial is repeated for each strategy, to facilitate strategy comparison (e.g., CEA).

- Refer to the chapters on Monte Carlo Simulation and the Individual-Level Simulation for further details on Monte Carlo simulation, including details on running a Monte Carlo probabilistic sensitivity analysis.
- Discrete simulation can also sample values from probability distributions (e.g. to represent characteristics among “individuals”). Refer to the chapter that describes Distributions for the relevant distribution options.
- In survival/Markov models, discrete simulation is particularly useful because it allows modeling any number of continuous and discrete state variables (whereas cohort models work well for more limited numbers of discrete states). The Individual-Level Simulation Chapter provides details on Markov simulation topics.

The current topic provides a very brief example of how to run a discrete (or micro-) simulation in a decision tree, using the simple Stock Tree example from earlier in this chapter. In this model, there are no chance nodes in the “CD” strategy, so there will only be simulation variability in the random walks through the Risky investment strategy.

**To perform a simulation (1st-order trials only, no parameter sampling):**

- Select the node for simulation (in the Stock Tree example, the root, decision node).
- Choose Analysis > Monte Carlo Simulation > Trials (Microsimulation)...
- ... OR...
- Click on the single dice toolbar button.

- Enter a small number of trials, perhaps 100 and click Begin.

Monte Carlo Simulation Dialog

If the simulation is complex enough to require a significant amount of time to complete, the output window displays the incremental progress of the simulation trials. Once the simulation is done, final statistics and other reporting/graphing options are displayed. Refer to the Individual-Level Simulation Chapter for more details.

9.7 Probability distributions

The risk associated with alternatives under consideration can be displayed graphically, using a probability distribution histogram, or *risk profile*. A probability distribution graphs the values (i.e., payoffs) and path probabilities of all terminal nodes within a strategy.

This analysis is *deterministic* (no randomness), and does not use the same approach for generating a probability distribution graph as a Monte Carlo simulation (see above). Simulation generates probability distribution graphs based on long runs of *stochastic*, random walks.
Open the Oil tutorial example model, Oil Drilling Problem. This model has some interesting elements, including multiple decisions nodes.

To create your first probability distributions using TreeAge Pro, start by analyzing a chance node.

To view a probability distribution histogram:

- Select a chance node – in this case the topmost chance node labeled Drill for Oil, in the No Soundings section of the tree.
- Choose Analysis > Probability Distribution.
- Use the default Histogram Type: Probability Distribution.
- Use the default Histogram Parameters. Select OK.

TreeAge Pro displays the analysis results in a graph window as shown below.
More details about customizing histograms can be found in Customizing Histograms section.

### 9.7.1 Probability Distribution Secondary Reports

Every graph window includes a set of "Actions" links to the right of the graph. The Probability Distribution graph includes two additional links/controls in addition to the standard "Edit Chart" option.

- **Edit Chart**: Edit the chart's dimension, scale, format, etc.
- **Text Report (Bars)**: Show the numerical source data for the graph. This changes as we change the number of bars.
- **Text Report (Raw)**: Show the numerical source data in detail including the node, path probability and node EV.
- **Redo Histogram**: Regenerate the histogram, selecting different Histogram parameters or adding/removing a Trend Line.

In the example Probability Distribution graph (not the CDF) shown in the previous section, TreeAge Pro displays a separate bar for each possible payoff. However, this will not always be the case, as some outcomes with similar values may be merged into a single bar within the graph.

Initially, the value range is divided into a reasonable number of intervals. The height (i.e., probability) of a bar is the sum of the path probabilities of all terminal nodes with payoffs in that interval. The height of all bars sums to 1.0 (100%). The vertical axis will scale to the height of the highest bar.

The value/probability associated with each bar can be accessed via the graph's Text Report (Bars).
Probability Distribution Text Report (Bars)

The Text Report (Raw) is similar, except that it will include every outcome (with no summarization by bar) along with the node name associated with the outcome.

Probability Distribution Text Report (Raw)

9.7.2 Downstream decision nodes

As noted above, the Oil tutorial example model, Oil Drilling Problem, includes multiple decisions. To see how the probability distribution analysis is affected by downstream decision nodes, analyze the Seismic Soundings chance node. Each of this node’s branches is a decision node. See below.
Oil Drilling Problem tree

If there are decision nodes anywhere to the right of the analyzed node, as in this analysis, TreeAge Pro calculates expected values, and then selects an optimal strategy at each downstream, or deferred, decision. The histogram only includes terminal nodes from the optimal path, therefore the path probabilities in the histogram will still sum to 1.0. To see which terminal nodes are in the optimal path, you can roll back the tree.
9 Analyzing Decision Trees

The information which is presented in the Probability Distribution is to allow the modeller to make decisions based on the range of possible outcomes/value and the likelihood of these outcomes happening. Using the PDF dialogue presented in the section above, changing the number of intervals or interval size can assist in this process.

The two Text Report links to the right of the graph generate reports showing the underlying data and will give you information about which outcomes are most likely.

The Text report (Bars) displays the individual bar values and their probabilities.

The Text report (Raw) shows the individual terminal nodes that contribute to each bar.

<table>
<thead>
<tr>
<th>Bar Min</th>
<th>Bar Max</th>
<th>Bar Midpoint</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>-800000</td>
<td>-400000</td>
<td>-600000</td>
<td>0.20907</td>
</tr>
<tr>
<td>-400000</td>
<td>0</td>
<td>200000</td>
<td>0.41</td>
</tr>
<tr>
<td>0</td>
<td>400000</td>
<td>200000</td>
<td>0</td>
</tr>
<tr>
<td>400000</td>
<td>800000</td>
<td>600000</td>
<td>0.21905</td>
</tr>
<tr>
<td>800000</td>
<td>1200000</td>
<td>1000000</td>
<td>0</td>
</tr>
<tr>
<td>1200000</td>
<td>1600000</td>
<td>1400000</td>
<td>0</td>
</tr>
<tr>
<td>1600000</td>
<td>2000000</td>
<td>1800000</td>
<td>0.17988</td>
</tr>
</tbody>
</table>
9.7.3 Cumulative Probability Distribution

If the option "Cumulative Probability Distribution" is selected from the same node, a different graph is presented.

This graph shows a complete EV range for all outcomes in the model along with the cumulative probability that the outcome will be less than or equal to a specific bar in the range. In this model there is a 50% chance that the EV will be less than or equal to approximately -600,000, while there is an 80% chance that the EV will be less than or equal to approximately 500,000. Greater precision is available via the secondary reports, which are described later in this section.

9.7.4 Comparative probability distributions

Multiple, cumulative probability distributions can be displayed in a single graph, allowing graphical comparison of options. In a comparative distributions graph, the cumulative distributions are displayed
in outline, instead of using filled bars. This format enables graphical comparison of strategies based on their risk profile.

Details about the graphical interpretation of comparative probability distributions are provided later in this chapter, in the section on dominance.

When a single decision node is selected, the Analysis menu displays the Comparative Distributions command. The comparative distributions analysis can be tried at the root decision node in the Oil Drilling Problem tree.

*To generate a comparative probability distribution graph:*

- Select a decision node.
- Choose Analysis > Comparative Distributions from the menu.

The resulting graph displays the outlines of the cumulative probability distributions for the competing options Seismic Soundings and No Soundings. The outline for a strategy is marked at each corner (where the cumulative probability “curve” rises) with that strategy’s symbol, as listed in the legend to the right of the graph.
9.7.5 Dominance in probability distributions

Comparative probability distributions can be interpreted graphically, by evaluating conditions of dominance. There are two types of dominance that can be identified relatively easily: deterministic and stochastic (also called absolute and extended dominance). Conditions of dominance can provide more insight into a decision than simple expected value comparison.

Deterministic dominance occurs when one option not only has the best expected value, but its worst possible outcome is better than (or equal to) the best outcome of any other option. It can be identified as follows:

- if optimization requires maximizing value (e.g., profit), the worst “bar” of the dominant option (its left-most vertical line) lies on, or to the right of, the best (right-most) “bar” of the dominated option(s);
- if optimization requires minimizing value (e.g., costs), the worst “bar” of the dominant option (its right-most vertical line) lies on, or to the left of, the best (left-most) “bar” of the dominated option(s).

The kinds of problems in which decision analysis is applied will not often display deterministic dominance, however. Stochastic dominance is more likely. Conditions of stochastic dominance — also called extended or probabilistic dominance — are identified as follows:

- if optimization requires maximizing value, the entire outline describing the stochastically dominant option lies to the right of the dominated option’s outline — the lines can touch for part of the graph, but never cross;
- if optimization requires minimizing value, the outline describing the stochastically dominant option lies on, or to the left of, the dominated option’s outline.

9.8 Expected value of perfect information (EVPI)

Assume that you could buy information that perfectly predicted the outcome of a future uncertainty. What would this information be worth to you?

In a decision tree, the option to acquire perfect information (about a single uncertainty) can be modeled by moving the chance node representing the uncertainty to the left of a decision.

Although the uncertain event still follows the decision in time, the decision maker is assumed to have a perfect predictor of the event outcome before making the decision. Keep in mind that perfect information does not mean that you can control the event’s outcome, only that you can predict the outcome.

Ignoring for the moment the cost of the perfect information, the revised tree cannot have a worse expected value than the original tree, and may have a better expected value. This difference in expected value is referred to as the expected value of perfect information (EVPI).
While predictive information is rarely perfect, the usefulness of EVPI is in calculating a maximum reasonable price for information. If perfect information in a particular situation has a base value of x, one should certainly not pay more than x for imperfect information. To see how imperfect information is dealt with in decision analysis, see the Bayes’ Revision Chapter.

Monte Carlo simulation in TreeAge Pro can be used to calculate expected value of perfect information for any number of predictable or resolvable uncertainties; refer to the Monte Carlo Simulation Chapter.

### 9.8.1 How EVPI is calculated

Before trying TreeAge Pro’s shortcut for calculating EVPI in a decision tree, it is instructive to work through the extra steps required to calculate EVPI manually.

- Open the Business tutorial example model, Stock Tree.
- Also open the Business tutorial example model, Perfect Information. This version of the investment problem shows the time reversal of the Market uncertainty and the decision.

The two trees are shown below.

**Stock Tree**

To calculate the EVPI manually:

- Roll back Stock Tree. The tree’s expected value is $50 (equal to CD paying 5%’s value).
- Roll back the Perfect Information tree. The root node’s expected value is $205.
- To calculate EVPI, take the difference between the expected value of the Stock Tree and that of the Perfect Information tree. The difference is $155. (If you were minimizing costs rather than maximizing profit, you would subtract the perfect information value from the regular expected value.)

In the investment model, the expected value of having perfect information about the market activity is $155. This is the most you should be willing to pay to obtain this information, and it affords some basis for appraising to you the value of a less than perfect predictor of market activity.

Now, try TreeAge Pro’s shortcut for calculating EVPI in a tree. It requires only the original Stock Tree.

To calculate EVPI automatically:
- Open the Stock Tree.
- Select the Risky investment chance node and choose Analysis > Expected Value of Perfect Info.

A dialog reports the value of $155.

It is also possible to calculate EVPI automatically in a decision tree when the same event appears in more than one strategy, as in example shown below. The assumption in the model is that each of the two stock investments under consideration is followed by the same uncertainty — whether the market will be up or down at the end of the year.

In order to calculate EVPI in this model, both market uncertainty chance nodes must be selected.

To calculate EVPI for the same chance node in multiple paths:
- Before choosing Analysis > Expected Value of Information, select all nodes in the tree which represent the same event.

If multiple chance nodes are analyzed, they:
- must be descendants of the same decision node;
- must be “siblings”; and
- must have identical branches using identical probabilities. It does not matter if there are differences in the subtrees further to the right.

If there is more than one decision prior to the selected chance event, TreeAge Pro will prompt you to identify the decision for which EVPI should be calculated.

### 9.8.2 Avoiding EVPI errors

It is important to understand that it is possible to force invalid EVPI calculations. For example,

- Open the Oil Drilling Problem tree again.
- Select the Drill for Oil node in the No Soundings subtree and choose Analysis > Expected Value of Perfect Info.

In the resulting dialog boxes, you are presented with the option of having the analysis performed at the root, soundings decision node or at the drilling decision.

Performing the calculation at the No Soundings node is similar to the analysis undertaken above in connection with the EVPI tree. It certainly makes sense to calculate the value of knowing the state of oil reserves before deciding whether or not to drill.

However, what if you perform the EVPI calculation at the root decision node? The value reported is $437,632, significantly higher than at the No Soundings node. Is this a meaningful EVPI calculation?

The structure of the tree already includes the option of securing imperfect information in the form of a seismic test — this is the initial decision. Performing EVPI by placing the chance node representing the uncertain amount of oil to the left of this decision is meaningless. Having already received perfect information, the decision as to whether to obtain additional imperfect information regarding the same subject should have no value or relevance. Refer to the Bayes’ Revision Chapter for more information on imperfect information.

### 9.9 Other Analyses

The last section of this chapter covers three simple analysis tools.

This chapter does not cover all analyses. Refer to later sections of the user's manual for information on additional analysis options:

- **Sensitivity analysis** using variables is covered in the Variables and Sensitivity Analysis and More Sensitivity Analysis Tools Chapters. This includes 1-, 2-, and 3-way sensitivity analysis, as well as tornado diagrams.
- **Monte Carlo probabilistic sensitivity analysis** using inputted parameter distributions is covered in Monte Carlo Simulation and Distributions Chapters.
- **Markov cohort analysis** and **microsimulation** are covered in the Building and Analyzing Markov Models and Individual-Level Simulation and Markov Models Chapters.
- *Cost-effectiveness analysis* is covered in the Cost-Effectiveness and Cost-Effectiveness Simulation Chapters.

### 9.9.1 Range of possible payoffs

This analysis will tell you the highest and lowest payoffs which may occur from the selected node in your tree.

*To view the minimum and maximum payoffs in a subtree:*

- Select a node, and choose Analysis > Payoff Range.

![Payoff Range from root node of Oil Drilling Problem model](image)

Payoffs from all terminal nodes are included in this analysis, not just those in the optimal path.

### 9.9.2 Over/under probabilities

The Over/Under analysis calculates the probability of achieving an outcome with a payoff over a target value, and the complementary probability of an outcome under the target.

*To calculate the over/under probabilities:*

- Select a node and choose Analysis > Over/Under….
- Enter a target value. Indicate whether payoffs equal to the target value should be included in the “under” range. Press enter or click OK.

![Over/Under from root node of Oil Drilling Problem model](image)
Over/Under analysis only includes outcomes reached assuming the decision maker follows the optimal path at decisions.

### 9.10 Excluding Strategies from Analyses

TreeAge Pro allows you to exclude specific strategies from all analyses. When excluded, a strategy will not be presented in the analysis results. The Get Started tutorial example model, Climber Cost, is used to illustrate this technique.

**To exclude a strategy:**

- Right-click on the strategy node you wish to exclude.
- Choose Exclude Strategy from Analysis from the context menu.

The strategy is then marked as excluded by placing hash marks on its branch connector, coloring the branch connector grey and by collapsing the subtree.

![Climber Cost model with top strategy excluded, coloring the connector grey.](image)

See how roll back and rankings exclude the strategy.

![Roll back with top strategy excluded and the preferred strategy highlighted in green.](image)

![Rankings with strategy excluded](image)
Other analyses such as Monte Carlo simulation would also exclude the strategy.

*To reverse the strategy exclusion:*

- Right-click on the strategy node you wish to exclude.
- Choose Include Strategy in analysis from the context menu.
10. Graph Windows

This chapter includes details on customizing, printing and exporting TreeAge Pro graphs.

10.1 Customizing graphs/charts

Whenever TreeAge Pro displays a graph, you will see two links to the right of the graphical output (specific graph types will provide additional links).

1. *Edit Chart*: Customize the graph’s appearance.

This section focuses on options associated with Edit Chart. The next few subsections focus on general graph customization. We will use the probability distribution graph generated from the *Risky investment* strategy of the Get Started tutorial example tree "Stock Tree" to examine these customizations. However, they are not limited to probability distribution graphs.

![Stock tree - probability distribution](image)

**10.1.1 Changing the chart type and orientation**

A probability distribution graph is a standard bar graph. If you click the Edit Chart link, an Edit Chart dialog opens providing a large number of options for the graph.
Edit Chart Dialog - Select Chart Type tab

The first tab is labeled "Select Chart Type". This allows you to change the chart type from "Bar" to some other format. In the case of a Probability Distribution, you probably would not change the chart type, but the option is there.

Within the selected chart type, there are subtypes and other properties. For example, you could change the Dimension option to 2D With Depth, and the chart would look like this.
10 Graph Windows

Bar graph with depth

You could also change the orientation by flipping the axes. Then the graph would look like this.

Bar graph with flipped axes

10.1.2 Changing the chart data

The second tab in the Edit Chart dialog is "Select Data".
Edit Chart Dialog - Select Data tab

These options allow you to select different data from the graph's text report. Note that the text report data is presented in this tab when the "Show data preview" option is selected. In general, TreeAge Pro will select the data that is appropriate for the graph. These options should only be used with care.

10.1.3 Changing the chart format

The third tab in the Edit Chart dialog is "Format Chart".
Edit Chart Dialog - Format Chart tab

The Format Chart tab allows you to change chart attributes like the chart title, hide/show legend, etc via the selections in the left frame.

In addition, you can change formatting options related to the X-axis and Y-axis by selecting the axis in the left frame, then clicking the Format button.
Edit Chart Dialog - Format axis

That will open the Edit Format dialog, which allows you to edit the formatting of the selected axis.

Edit Format Dialog

After the changes are applied, the graph's X-axis is reformatted.
10.1.4 Changing the chart data scale

You can also change the data scale by clicking the Scale button with one of the axes selected. This allows you to change the minimum, maximum and step values for the selected axis.

![Axis Scale Dialog](image)

10.2 Customizing Histograms

Although a probability distribution was used to illustrate general graph customization options, there are also some options specific to any type of histogram.

![Probability Distribution](image)

**We will refer to probability distribution graphs as histograms throughout the Help files but we can use these terms interchangeably.**

All histograms group data together and then divide the total range into a number of bars. By default, TreeAge Pro creates bars that start/stop on regular intervals (e.g., 100K, 200K, etc.) with an assumed default of 20 bars. The number of bars will increase/decrease based on the actual data being reported.
You can override the default settings to customize the presentation data via a dialog that opens when you first generate a histogram, or when you click the "Redo Histogram" link to the right of the graph.

We will use the Special Features Example model Distributions.trex to demonstrate these options. This "model" does nothing except generate the distributions when we run Probabilistic Sensitivity Analysis.

Generate histogram of distribution samples

- Open the Distributions view.
- Select the Table distribution, Dist_Table
- In the toolbar for the Distributions view select the "Graph It" icon.
- Select "OK" to use the default number of samples and generate the graph below. See below for setting different Histogram parameters.

In TreeAge Pro, most probability distributions will include a Redo Histogram link to the right of the graph. This allows you to redraw the graph with more or fewer bars. You can also control the number of bars more precisely, as described below.

Histogram settings

To customize the Histogram parameters use the Histogram Settings dialogue which is generated when you create a histogram or when you "Redo Histogram" which is an option in the menu on the right hand side of every histogram.

- Create a Histogram.
- In the Histogram Settings dialogue, select Custom Histogram parameters.
- Select either the Interval Size or the Number of Bars.
10 Graph Windows

Histogram Settings dialogue

Histogram parameters

- **Custom Interval Size.** This will set the size of the interval of each bar. (Option is to either select Interval Size or Number of Bars).
- **Custom Number of Bars.** The bar width will be generated according to the number of bars entered here taking into account the Bar Max and Bar Min. (Option is to either select Interval Size or Number of Bars).
- **Bar Min.** Change this value from the default to the required minimum bar value.
- **Bar Max.** Change this value from the default to the required maximum bar value.
- **Trend Line.** Select this box to add a trend line to the histogram. To remove, select to redo the histogram and un-select.

The Histogram Settings box will appear everytime you generate a histogram. If you don't want to see it and want to use the default parameters, then check the box at the bottom. Once the histogram is generated, you have the option to "Redo Histogram" from the tool bar to the right-hand side of the graph.

If you selected to not see the default parameters and want to change the option, go to the menu: Window > Application Preferences > Analysis Tools > Histograms and uncheck the box.

**Example: Table Distribution**

The Histogram generated from Dist_Table uses the default settings which display all the discrete values in the table. We can demonstrate changing the interval size with this Histogram Settings dialogue. Firstly, look at the table of values the Histogram is drawn from and see how the histogram above represents each row in the table with corresponding probability.

- Edit the histogram of the distribution of samples for Dist_Table by selecting Redo Histogram.
- In Histogram Settings select Custom.
- Change the interval size to 2.
- Select OK.

Histogram of distribution samples for Dist_Table with custom settings, i.e. interval size 2.

Raw data in Sample_Table in the example model Distributions.trex

In the customized histogram, the interval sizes has increased to two and now incorporates two rows of data rather than one. This changes the probability for each bar, in this instance the probability is doubled due to the nature of the discrete data.

*Example: Normal Distribution*

The histogram generated from Dist_Normal generates the graph below showing the typical Normal shape. The graph can be edited through the Histogram Settings using the Custom selection, as above.
10.3 Customizing cost-effectiveness graphs

This section describes customization options specific to cost-effectiveness graphs.

The graph below was generated by running cost-effectiveness analysis from the root node of the Health Care tutorial example tree "Extended Dominance".

Probability Distribution graph or Histogram for Dist_Normal (continuous data)
Cost-Effectiveness Graph

Even before the graph is generated, you are offered the option to show the graph with options inverted. You can also generate the inverted graph by clicking the "CE Graph (inverted)" link. The inverted graph is presented below.
Another option on this graph is to hide extended dominance lines. Clicking on that link removes the horizontal and vertical lines associated with extended dominance.

Cost-effectiveness graphs show not only points for each strategy, but also use markers for dominated strategies versus undominated strategies. Because of this, changing the chart type and other formatting options can cause unexpected effects on the graph. You can still make changes to scale and most other graph properties.

### 10.4 Customizing line graphs

This section describes customization options specific to line graphs. The following graph was generated from a CE one-way sensitivity analysis. Specifically, this is the x vs ICER graph.
Line graph

Note that the x-axis labels are impossible to read because the values are formatted with too many decimal places. This can be adjusted via the Edit Chart Dialog, Format Chart Tab.
Edit Chart Dialog - X-axis formatting

Select the X-Axis in the left pane then click the Format button. Then change the Fraction Digits to 2. See below.
You could also use this dialog to add a custom prefix or suffix to the values.

Let's say you also wanted to add a horizontal line to the graph to highlight the ICER value of 35,000. Select the X-Axis in the left pane then click the Markers button. In the Axis Markers dialog, click the Add Line button, then set the value and properties of the line.

The example above creates a red horizontal line at ICER value 35,000. The combination of the changes above generates the following graph.
10.5 Customizing scatterplot graphs

This section describes customization options specific to scatterplot graphs. The graph below was generated from a probabilistic sensitivity analysis simulation on the Health Care tutorial example model CE Markov Sampling. Specifically, the graph is an ICE scatterplot comparing Rx A to Rx B.
ICE scatterplot

You might want to change the X-axis scale to show the 0 value for Incremental Effectiveness. This is described earlier in this chapter.

You might also want to change the plot marker format in the Format Chart tab by selecting the appropriate series and clicking the Marker button. In the example below, the Series markers are changed from circles to triangles.
Edit scatterplot - change marker type

Note that if the scatterplot has more than one data series, change the second, third, etc. marker type in the Series Marker dialog to adjust those series.

To change the color of the points in the scatterplot:

- Click the Edit Chart link.
- Select the Format Chart tab.
- Select the category Series (not Value (Y) Series).
- Click the Series Palette button at the bottom of the dialog (may need to scroll down).
- Click on the down arrow to the right of the first palette and select the color you want.
- Click Finish in the main Edit Chart dialog.
Edit scatterplot - change series color

You might also want to reduce the number of points presented in the scatterplot if the scatter is too dense.

- You can do this by setting a filter on the data points in the Select Data tab.
- Click the Filters button.
- Then add a filter to limit the data points to be displayed.

How to reduce the number of points presented:

In the example below, a filter was added to show only the bottom 20 pct of the simulation iterations based on the iteration number. The iteration number is not correlated with any output measure, so you introduce no bias into the new graphical output.
Beyond standard scatterplot options, the ICE scatterplot has a few specific options that are available under the category ICE Scatterplot in the left frame. This allows you to change the number of points to draw, whether to draw the ICER line, the ICER line's slope and the size of the dots in the scatterplot. See below.

**Edit scatterplot - filter data**

Beyond standard scatterplot options, the ICE scatterplot has a few specific options that are available under the category ICE Scatterplot in the left frame. This allows you to change the number of points to draw, whether to draw the ICER line, the ICER line's slope and the size of the dots in the scatterplot. See below.
Edit scatterplot - options specific to the ICE scatterplot

The Confidence Interval subcategory allows you to create a custom confidence interval rather than using the default 95% confidence interval. See below.
Edit scatterplot - confidence interval

The net result of all these changes yields the following graph format.
10.6 Customizing region graphs

To change the pattern/color of the regions in a region graph:

- Click the Edit chart link.
- Select the Format chart tab.
- Choose the category “Series”.
- Click the Series Palette button.
- Click on the first bar and an option arrow will appear at the right of the bar.
- Click on this arrow to change first bar to the desired color or pattern.
- Repeat the prior two steps for additional entries in the palette list as needed.

10.7 Printing, exporting and saving graphs

Graphs can be printed, exported and saved via the TreeAge Pro menu or the tool bar when the graph is selected.

To print a graph:

- Select the graph.
- Choose File > Print from the menu OR select the printer icon from the tool bar.

**To copy a graph to insert directly into a document:**

- Select the graph.
- To copy the graph and paste a copy into a document, choose from the menu Edit > Copy OR click the Copy icon to the top-right of the graph pane.
- The Copy Chart Image appears, as in the figure below, to select the type of image you want to copy as (jpeg, png, bmp) and to select the Image dimensions and Scale.

![Copy Chart Image](image.png)

**Copy Chart Image appears when copying a graph to insert directly into a document.**

**To save a graph as an image file:**

- Select the graph.
- Choose File > Save As from the menu OR use the Save Image icon in the tool bar.
- Enter the file name and location in the Save Chart As Dialog. (See below)
- Choose an image file format for the file Type such as JPG or PNG.
- Enter the appropriate image dimensions and scale.
- Select Save.
To save a graph in its native TreeAge Pro format:

- Select the graph.
- Choose File > Save from the menu.
- Select the file name and location in the Save Chart As Dialog. (See below)
- Leave the Type as RPTX.
The RPTX format is the native report output format for TreeAge Pro. You can open the RPTX file in TreeAge Pro any time in the future to see the graph and/or text report.
11. Tree Calculation Methods and Preferences

Any single tree may be calculated and evaluated in a variety of ways, simply by switching between different payoffs, or from single- to multi-attribute calculations. This chapter covers tree calculation method preferences, including two kinds of multi-attribute calculation methods.

An additional multi-attribute calculation method, Cost-Effectiveness, is available to users of the Healthcare module; refer to the Building and Analyzing Cost-Effectiveness Models for details.

Other chapters cover the other preferences categories; refer to the Preferences Chapter for an overview of all preferences.

11.1 Changing what the tree calculates

Some basic tree calculation preferences were introduced at the end of the Decision Tree Tutorial Chapter and the beginning of the Analyzing Decision Trees Chapter:

- the calculation method
- the active payoff(s)
- the optimal path criterion
- numeric formatting

Note that a set of Tree Preference Values can be stored in a Preference Set.

To view in detail the tree’s current calculation method, or to make changes to these settings, open the Preferences dialog.

To view/edit the calculation method preferences:

- Choose Tree > Tree Preferences from the menu.
- Select the category Calculation > Calculation Method.
11.1.1 Selecting calculation method

The choice of calculation method determines the formula used to calculate values for nodes in your tree. There are two kinds of calculation methods:

- Simple, single-attribute calculations;
- Multiple-attribute calculations, including: Benefit-Cost and Multi-Attribute (weighted);
- Healthcare module users can use a third form of multi-attribute calculations, Cost-Effectiveness.

Simple calculations are just that — expected values are calculated for the nodes in the tree based simply on the values in the active payoff set. If, as described above, your tree included multiple attributes — such as monetary benefits in payoff #1 and costs in payoff #2 — the two sets of payoff values could be combined in a single calculation using the Benefit-Cost calculation method’s formula.

To change the calculation method:

- Roll back must be turned off.
- With the Preferences dialog open to the Calculation Method category, select the radio button for the appropriate calculation method.
- If you select a calculation method for the first time in a particular tree, the settings for payoffs, optimal path criterion, and numeric format may need to be modified.

Calculation method notes:
- Changing calculation method (or other) preferences will not affect the content of your tree. Values or formulas already entered in payoff #1 will not be lost by switching the active payoff set from #1 to #2, for example. Only the calculation and display of values will be affected; the changes to the calculation preferences can be reversed at any time.
- When the Preferences dialog is closed, TreeAge Pro updates the information in the status bar. If you have switched Simple calculations to use payoff 3, “Payoff 3” will appear in the status bar. If you select Benefit-Cost using payoffs 4 and 2, the status bar will read “B-C, 4-2.” If you select Multi-Attribute, then “MultiAttr” will show in the status bar.

Additional Tree Preference categories contained within the Calculation Method group are used to specify preferences associated with each calculation method. These categories are described in subsequent sections.

11.1.2 Calculation method "Simple"

The Simple Tree Preferences category is presented below.
11 Tree Calculation Methods and Preferences

Tree Preferences - Simple Calculation Method

Optimal path

All calculation methods in TreeAge Pro require you to specify how decisions should be made in the tree (i.e., during roll back). This is done using the option labeled *Optimal path*.

The default optimal path criterion used for new trees is High, unless you save new default Preference Set. This setting would be changed if, for example, you were modeling project costs (to find the strategy with the lowest expected cost).

*To set the optimal path criterion:*

- Select the tree and press the F11 key to open the Tree Preferences dialog.
- Select the category Simple within the Calculation Method group.
- Next to the label Optimal path, select the radio button for either High (maximize expected values) or Low (minimize expected values).

For a tree set to High (e.g., one whose payoffs are in terms of life expectancy), at each decision node TreeAge Pro will select the alternative with the *highest* numeric value.

For a tree set to Low (e.g., one whose payoff formula is in terms of costs), the alternative with the *lowest* numeric value is selected.

Each of the nine payoff sets stores its own optimal path criterion for Simple calculations, and each form of multi-attribute calculations also has its own optimal path setting.

Active payoff

In TreeAge Pro, you can enter any number of payoffs at each terminal node. In a Simple analysis, you can use any one of the enabled payoff/reward sets. The *Active payoff* tree preference is used to select the active payoff for the Simple Calculation Method.

The *Active payoff* option will allow selection of any enabled payoff set. Based on the default Preference Set, two payoff sets are enabled, but this can be changed in the Payoffs Tree Preferences category.

*To change the active payoff:*

- In the Calculation Method/Simple preferences, select a payoff set in the Active payoff field.
When you change to a new Active payoff for the first time in a tree, ensure that you select the appropriate optimal path criterion and numeric formatting for that payoff.

### 11.1.3 Calculation method "Cost-Effectiveness"

The Cost-Effectiveness Tree Preferences category is presented below. Note that this calculation method is only available if your license includes the Healthcare Module.

#### Cost payoff

Select the payoff set to use for cost calculations from among the enabled payoff sets.

#### Effectiveness payoff

Select the payoff set to use for effectiveness calculations from among the enabled payoff sets.

Both the above controls work the same as the Active payoff in the Calculation Method/Simple preferences.

#### Additional cost-effectiveness options

Additional Tree Preferences related to the cost-effectiveness calculation method are described in the next two sections.

### 11.1.4 Calculation method "Cost-Effectiveness", C/E Parameters

The Cost-Effectiveness, C/E Parameters Tree Preferences category is presented below.
11.1.5 Calculation method "Cost Effectiveness", Weighted Multi-Attribute

Content of the new section ...

![Tree Preferences - Weighted Multi-Attribute Costs](image)

11.1.6 Enabling payoffs

TreeAge Pro supports any number of distinct payoffs sets (attributes) in a tree. By default, only two payoff sets are enabled, but this can be changed via the Payoffs Tree Preferences category.

![Tree Preferences - Payoffs](image)

*Calculate extra payoffs*

Check this box to calculate all enabled payoffs rather than calculating only the active payoffs for the Calculation Method. This option is described in detail in the next section.

*Number of enabled payoffs*

Select the number of payoff sets to enable within the model. For example, if you change the number of enabled payoffs to 5, then payoff sets 1 through 5 will be enabled.

11.1.7 Calculate extra payoffs

It is possible to calculate the tree and optimize at decision nodes based on the current active payoff method and set(s), but report expected values for other payoff sets. For example, you could roll back the tree based on minimizing costs in payoff #1, but also report expected values for some types of utility attributes which you have entered in payoffs #2 and up.

In the Payoffs Tree Preferences category, check the box labeled *Calculate extra payoffs*, and adjust the *Enable payoffs* setting to control how many extra payoff sets will be calculated.

If *Calculate extra payoffs* is checked, extra payoffs are included in several analyses outputs.

- Extra payoffs are reported in Rankings report in the last columns of the report. The column headings will use any custom payoff names given to the extra payoffs.
- Extra payoffs are included in Monte Carlo simulation output and its secondary reports.
- Extra payoffs are included in Markov Cohort Analysis (Quick) output.

If you activate the calculation of extra payoffs, you must fill in the enabled payoff sets at all terminal nodes, even though they are not specifically required by the current calculation method.

Under Multi-attribute calculations, weight values must be specified for every enabled extra payoff. Use a 0 weight to exclude an extra attribute from the regular, weighted expected value calculation (this will not zero the extra payoff’s reported value).

To illustrate the Rankings Report with calculate extra payoffs enabled, consider the Healthcare tutorial example tree MarkovExtraPayoffs.trex.

This example has 5 payoffs enabled, including Cost and Effectiveness. The model is calculated using the active payoffs of Cost and Effectiveness but displays the additional 3 payoffs in the rankings report in the last 3 columns, as illustrated in the figure.

### Cost-Effectiveness Rankings

<table>
<thead>
<tr>
<th>Category</th>
<th>Strategy</th>
<th>Cost</th>
<th>Incr Cost</th>
<th>Eff</th>
<th>Incr eff</th>
<th>Incr C/E (CER)</th>
<th>NMB</th>
<th>C/E</th>
<th>Prog to Metastases</th>
<th>Local Cancer Death</th>
<th>Metastases Death</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excluding dominated</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>undominated</td>
<td>Tx1</td>
<td>457,847</td>
<td>11.53</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>undominated</td>
<td>Tx2</td>
<td>468,840</td>
<td>10.904</td>
<td>11.72</td>
<td>0.19</td>
<td>56,938</td>
<td>137,312</td>
<td>59,993</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>undominated</td>
<td>Tx1</td>
<td>457,847</td>
<td>11.53</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>undominated</td>
<td>Tx2</td>
<td>468,840</td>
<td>10.904</td>
<td>11.72</td>
<td>0.19</td>
<td>56,938</td>
<td>137,312</td>
<td>59,993</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All referencing common baseline</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>undominated</td>
<td>Tx1</td>
<td>457,847</td>
<td>11.53</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>undominated</td>
<td>Tx2</td>
<td>468,840</td>
<td>10.904</td>
<td>11.72</td>
<td>0.19</td>
<td>56,938</td>
<td>137,312</td>
<td>59,993</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Rankings report with extra payoffs displayed in the last 3 columns

### 11.2 Calculations using multiple attributes

While many analyses will require only one attribute (e.g., cost), some models may have multiple attributes (e.g., benefits and costs) or different perspectives on the same attribute (e.g., societal, personal, or institutional costs of disease).

TreeAge Pro includes two basic calculation methods that combine multiple payoffs: benefit-cost and weighted multi-attribute calculations. (If you have the optional Healthcare module, a third calculation method using multiple payoffs is available: Cost-Effectiveness. See the Healthcare module documentation for details.)

The first step in preparing a multi-attribute model is setting the calculation preferences.

To select a multi-attribute calculation method:
- Select the tree and press the F11 key to open the Tree Preferences dialog.
- Select the category Calculation Method.
- Change the Calculation Method pop-up menu selection from Simple to one of the multi-attribute options.
- If you select Benefit-Cost...
  - Select the Benefit/Cost category (see below).
  - Select two payoff sets to represent the two attributes in your tree.
  - The optimal path will automatically be High (maximize value).
- If you select Multi-Attribute...
  - Select the Multi-Attribute category (see below).
  - Select the Optimal path option.
  - Enter a weight for each enabled payoff.

11.2.1 Entering multiple payoffs

With both kinds of multiple-attribute models — benefit-cost and multi-attribute — you will enter at least two payoffs at each terminal node. The process of entering multiple payoffs values at a terminal node is very simple — the payoff sets in the Enter Payoff window correspond to the Use payoff selections made in the Preferences dialog.
Enter Multiple Payoffs at Terminal Node

If a multi-attribute calculation method is used, the payoff titles in the window will indicate which payoffs are to be used. For benefit-cost, they will be labeled “Benefit” and “Cost.” For weighted multi-attribute models, they will be labeled by payoff set number (as above).

If you require more payoff sets in your model (e.g., for weighted multi-attribute calculations), you can enable additional payoffs.

11.2.2 How benefit-cost calculations are performed

This calculation will subtract the cost of a scenario, represented by one payoff, from its benefit, represented by a different payoff. Therefore, both attributes in a benefit-cost analysis must be measured in the same monetary units. All analyses available under Simple calculations (1-, 2-, 3-way sensitivity analysis, for example) are also available under the Benefit-Cost calculation method.

This calculation does not divide costs by benefits, as is done in some forms of cost-benefit analyses. To create a custom cost/benefit analysis calculation method, refer to the section on the Calculate extra payoffs preference and the Node() function.

11.2.3 How weighted multi-attribute calculations are performed

Unlike the Benefit-Cost calculation method, the weighted Multi-Attribute calculation method does not require that all attributes/payoffs be assigned using the same units. Instead, a linear equation is set up that combines up to nine payoffs; attributes given a non-zero weighting are made part of the multi-attribute calculations.

For example, if you assigned a weight of 1 to Attribute 1 and a weight of 0.5 to the next three attributes, each terminal node would be evaluated based on the expression Attribute 1 + 0.5 * Attribute 2 + 0.5 * Attribute 3 + 0.5 * Attribute 4.

Variables (see Variables Chapter) can be used in the weighting expressions. This is useful when there is uncertainty concerning how much one factor should be weighted versus another.

Weightings are entered through the Multi-Attribute Tree Preferences category within the Calculation Method group (see earlier section).

All analyses available under Simple calculations are available under Multi-Attribute calculations as well.
11.3 Roll back analysis options

Before dealing with multiple-attribute analysis methods, let’s look at some calculation preferences related to roll back.

Typically, roll back boxes display the expected value of each node, along with the path probability at terminal nodes. TreeAge Pro can display a variety of other calculated values during roll back; these are described below.

**To change the quantity to be calculated during rollback:**

- Select the tree and press the F11 key to open the Tree Preferences dialog.
- Select the category Calculation Method.
- Select an option from the group labeled *Rollback calculates*.

Here is a brief description of the other options:

**Expected values**: Display the expected values (the default setting) at all nodes.

**Payoffs only**: Display only the values of terminal nodes. Optimal paths will be indicated using hash marks and colored lines, but no expected values will be displayed.

**Path probabilities**: Suppress the display of expected values. Path probabilities are calculated for all terminal nodes (does not take into account the optimal path). If there are any decision nodes, the sum of the path probabilities of all terminal nodes will be greater than 1.0.

**Maximin**: Consider only the most pessimistic possibility at each uncertainty, regardless of probabilities. Then, at each decision point, the best option is selected. More details are provided in the following section.

11.3.1 Maximin and minimax roll back

Maximin calculations may be useful during early stages of certain models, before probabilities have been assigned to the tree. Here, specifically, is how a tree is rolled back under Maximin:

- The value assigned to every chance node is equal to the worst (least optimal) value of any of its potential outcomes. *Probabilities are ignored*, and may be left blank.
- The value assigned to every decision node is equal to that of the best alternative, as usual.

If you use the Options > Reverse Optimal Path command at selected decision nodes, these nodes will work like chance nodes, as described above.

Maximin calculations take a pessimistic view of events. They are based on the idea that one way to deal with risk is to identify the worst case scenario for each alternative and then select the strategy which yields the best of these worst case scenarios.

Below is a picture of the example file Rock Climber using Maximin roll back. The value of the Treat foot strategy is simply its worst outcome, which is the patient dying (utility = 0). The Amputate foot option has no uncertainty, and it is simply equal to its payoff. The decision then maximizes between the available options, as usual.

In a Maximin roll back of a tree whose optimal path preference is set to High, the roll back boxes at chance nodes will be labeled MIN: at decision node the boxes will be labeled MAX:, in order to indicate the operation being performed. These prefixes are switched if the optimal path preference is set to low (minimization).

11.4 Regional/international numeric settings

By default, the regional numeric settings specified in your operating system determine which character TreeAge Pro will recognize as a decimal separator when you enter numbers — usually either a “.” or a “,” — and which character, if any, represents a thousands separator.

For example, your computer’s settings are used to decide whether the entered number:

1,375

should be interpreted with comma = decimal as

1 + 375/1000

or with comma = thousands separator as

1375
The operating system’s regional settings are also, by default, used by TreeAge Pro to determine what decimal and thousand separator characters are used in displaying calculated values.

However, TreeAge Pro includes preferences that enable particular trees to override the operating system’s regional numeric settings, allowing you to specify which characters to use for decimal and thousands separators.

To enable custom regional numeric settings in a tree:
- Select the tree and press the F11 key to open the Tree Preferences dialog.
- Select the category Regional Settings.
- Check the box *Use custom regional numeric settings*.
- Modify the regional settings options as necessary.

These settings will apply when this particular model is opened, modified, and analyzed on any computer, no matter what the operating system’s regional numeric settings.

These settings are particularly useful when sharing models with colleagues in other countries.

### 11.5 Overriding the optimal path at decision nodes

TreeAge Pro selects an optimal path at decision nodes based on the calculation method preferences covered in previous chapters.

At a selected decision node, you can force TreeAge Pro to apply the *opposite optimal path* criterion to that specified in the tree’s preferences.
To change the optimal path for a given decision node:

- Select the decision node.
- Choose Node > Change Optimal Path from the menu.

The decision node will reappear with an arrow inside it. The arrow will point upward if that decision node has been reset for maximization, or downward if the node has been reset for minimization. If you reverse the optimal path for an entire tree in which the optimal path of one or more nodes has been individually changed, the arrows in all of the individually changed nodes will reverse, signifying that they remain different from the rest of the tree.

To revert back to the original optimal path selection, simply repeat the steps above.
12. Selecting Subtrees and Multiple Nodes

While some tree-building tasks require that a single node be selected, other operations can, or must, be performed on multiple nodes. This chapter describes the different methods used to select multiple nodes.

12.1 Selecting a subtree

In decision trees, a subtree refers to a part of a tree. A node's subtree is comprised of all nodes and branches to its right (its “descendants”), but not including the original node (the subtree's root).

A few tree-building operations — copying, pasting, cutting, clearing, and cloning — require a special method for selecting a subtree.

To select a subtree:

- While holding down the CONTROL key, click on the subtree’s root node.
- ... OR ...
- Right-click on the subtree’s root node and choose “Select Subtree” from the context menu.

The figure below shows the result of selecting the Risky Investment node’s subtree. Note that the Risky Investment node itself is not selected.

12.2 Selecting multiple, unrelated nodes

TreeAge Pro offers several methods for selecting multiple, unrelated nodes. These techniques can be used when changing node types, entering payoffs, and a few other tasks.

To select a set of unrelated nodes:

- Select any node.
- While holding down the **SHIFT** key, select another node by clicking on it. Continue adding to the selection using the same shift-clicking operation.

**To remove nodes from the selection:**

- Hold down the **SHIFT** key and click, one after the other, on each of the selected nodes that you wish to deselect.

It is possible to select multiple nodes by dragging a selection rectangle around them.

**To select several adjacent nodes:**

- Click and drag to create a selection rectangle that encloses the adjacent nodes you wish to select.
- Release the mouse button.

![Select Multiple Adjacent Nodes](image)

> Note that you must enclose the entire node line and label for each node you want to select via the selection rectangle.

### 12.3 Selecting multiple nodes by characteristic

TreeAge Pro allows you to automatically select sets of nodes that share a node type or a position in the tree.

**To select multiple nodes by characteristic:**

- Choose Tree > Select Nodes If from the menu.
- Choose a selection method in the left pane of the Select Nodes If Dialog.
- Select the options associated with that method in the right pane of the Select Nodes If Dialog.
- Click OK.

This Select Nodes If Dialog is presented below.
Selecting Subtrees and Multiple Nodes

Select Nodes If Dialog
13. Making Changes to Tree Structure

Building a tree is often a process of frequent revision. Also, new tree projects can often make use of subtrees from existing models. This chapter starts with a review of the basic tree building commands from the Get Started - Build a Decision Tree Model Chapter, and then covers a set of features designed to help you move, remove, and duplicate parts of a tree (called “subtrees”).

13.1 A note on tree terminology

In tree models, familial terms are often used to help identify particular nodes and branches based on their relative locations.

- Nodes in its path back to the root node are its ancestors.
- Nodes in the paths to its right are its descendants.
- Branches of a parent node are its children.
- Branches of a parent node are also each other’s siblings.

13.2 Tree building and navigating the tree

Here is a quick review of some of the basic tree-building commands introduced in the Get Started - Build a Decision Tree Model Chapter.

To add branches:

- Select a node.
- Click the ‘Add branches’ toolbar icon which will add two branches.
- ... OR ...
- Drag a node from the Tree Diagram Editor Palette to the right of the existing node. A red line will appear indicating where the node can be placed. Release the mouse when the new node is visible as a branch of the existing node.
- ... OR ...
- Right-click on the node and select ‘Add Branch’ from the context menu.

To delete a branch:

- Select the node.
- Choose Edit > Cut from the menu to cut the node from the model.
- ... OR ...
- Right-click on the node and choose Cut from the context menu.

Note that branches can also be cut by performing the control + X keyboard shortcut.

To change a node’s type:
- Right-click on the node.
- Select Change Type from the context menu and select the new node type.
- ... OR ...
- Select a node.
- Click the "change node type" icon on the toolbar.
- Select the appropriate node type from the list.

To zoom in or out of the Tree Diagram Editor:

Use the palette within the Tree Diagram editor:

- Click on the zoom in or zoom out icons (magnifying glass) in the palette toolbar.
- Click on the model in the Tree Diagram Editor to recenter the model with the new zoom perspective.
- Click on the pointer/arrow in the palette toolbar again to turn off the zoom in/zoom out.

Navigating the tree using the keyboard:

In addition to using the mouse to select a particular node, it is also possible to use the keyboard to change the selected node.

Even if no node is currently selected, there is a keyboard shortcut that will select the root node.

To select the root node:

- Hold down the CONTROL key and press the HOME key.

To move the selection from the current node to an adjacent node, use the arrow keys. Try using the arrow keys to select the top branch.

To move the selection one node to the right:

- Press the right arrow key.

13.3 Editing a single node vs. subtrees

Many revisions to tree structure can be accomplished by inserting, deleting, or moving one node/branch at a time, or by changing the order of branches emanating from a node.

The Cut, Copy, and Paste commands described later in this chapter can be used to efficiently carry out similar, but more complex, tree modifications – including inserting, deleting, and reordering subtrees, as well as duplicating nodes or subtrees.
13.4 Inserting nodes/branches

Nodes/branches can be inserted into a model in one of two ways - via the node context menu and via the Modeling Palette.

Note that inserted branches can be removed using the Undo command by selecting Edit > Undo from the menu or clicking CONTROL + Z on the keyboard.

13.4.1 Insert node via context menu

The Insert Branch options, in comparison to Add Branch, provide greater control over how and where new branches and nodes are created. In addition to the Add Branch functionality, Insert Branch can be used to add a sibling above or below a selected branch, or to make “generational” changes — i.e., inserting a node between a “parent” and its “children.”

To insert a new node into a model via the context menu:

- Open the Get Started tutorial example tree, Rock Climber.
- Right-click on the chance node "Treat foot".
- Select Insert Node > To Left from the context menu.

A new branch, ending in a chance node, is inserted between the root, decision node and the "Treat foot" node. See below.
Repeat the menu command, but try different directions to see what happens.

- Right-click on the chance node "Treat foot".
- Select Insert Node > To Right from the context menu.

This time a new branch is inserted after the "Treat foot" node, whose existing branches are now attached to the new chance node. See below.

After inserting branch to right

- Right-click on the chance node "Treat foot".
- Select Insert Node > Above from the context menu.

In this case, the new node is added as a higher sibling of the "Treat foot" branch. See below.

After inserting branch above

If a new node were inserted below the "Treat foot" node, the new node would be added as a lower sibling of the "Treat foot" branch.

13.4.2 Insert node via Modeling Palette

Nodes can also be inserted into a model by dragging a new node from the Modelling Palette into the Tree Diagram Editor.

First select the node type you wish to insert from within the options in the Modelling Palette. See below.
Select node type in Modelling Palette

Then drag the new node into the model where you want the new node inserted. Release the mouse button when the node is in the correct place.

The four figures below show how to insert a new node to the left, right, above, and below the "Treat foot" node.

Insert/drag node to the left

Insert/drag node to the right
13 Making Changes to Tree Structure

13.5 Moving/reordering nodes

In prior versions of TreeAge Pro, a separate dialog was used to reorder branches. However, starting with TreeAge Pro 2011, moving/reordering nodes is handled by drag and drop functionality within the Tree Diagram Editor.

The prior section described how to insert nodes by dragging new nodes from the Modelling Pallete. The same drag and drop options can be used with nodes that already exist within the model.

To move a node within a model:
- Click on an existing node.
- Drag it to a new location within the model.
- Release the mouse button when you reach the proper destination location.

For example, you can reorder the branches of the "Treat foot" node in the Rock Climber tree by dragging the "Foot saved" node below the "Infection not cured" node. See below.
After dragging the node, the branches are reordered. See below.

![Diagram showing reordered branches]

**After move/reorder node**

Be careful moving nodes that are not endnodes (furthest to the right). For example, if you move the "Infection not cured" node back below the "Foot saved" node, the subtree anchored at the "Infection not cured" node will not automatically move with the node.

To move a node and its subtree together, first collapse the subtree, then move the node (see below). Alternatively, you can select the node and all the nodes in the subtree, then move the node to its new location.

![Diagram showing node and subtree moved]

**Move/reorder node with subtree**

### 13.6 Deleting nodes/branches

You can delete any node from the model.

To delete a node:

- Select the node.
- Right-click on the node and select Delete from the context menu.
- ... OR ...
- Choose Node > Delete from the menu.

Refer to the next section for information on deleting/cutting nodes that are not end nodes.
13.7 Cut, copy, and paste nodes and subtrees

Frequently, sections of a tree can be reused in another part of the same tree, or a different tree that you are working on. TreeAge Pro allows you to select a node, a set of nodes, or an entire subtree, copy or cut it, and then paste it to one or more nodes in any open tree.

In addition to being able to duplicate and move subtrees in the Tree Diagram Editor, it is also possible to manipulate subtrees using the mouse and CONTROL key in the Tree Explorer View. Refer to the Tools and Functions for Complex Trees Chapter for details on working in the tree explorer.

💡 Besides text, tree nodes, and subtrees, other items that can be copied and pasted in TreeAge Pro include dependency diagram nodes, variable definitions, and links with Excel. Items that can be copied from, but not pasted into, TreeAge Pro include text reports, model images, and graph images.

13.7.1 Cut/copy/paste a single node

The Cut, Copy, and Paste commands are available for any node or set of nodes.

To copy a node:

- Select a node.
- Select Edit > Copy from the menu.
- ... OR ...
- Click CONTROL + C on the keyboard.
- ... OR ...
- Right-click on the node and select Copy from the context menu.

Once copied to the clipboard, the node can be pasted to any node as a new branch. It can be pasted to any non-terminal node (branches not allowed) in the same tree or a different one. All aspects of the node (i.e., probability, payoff, variable definitions, etc.) are included with the copy.

To paste a copied node:

- Select any single node that is not a terminal node.
- Select Edit > Paste from the menu.
- ... OR ...
- Click CONTROL + V on the keyboard.
- ... OR ...
- Right-click on the destination node and select Paste from the context menu.

After being pasted, the copied node remains in the clipboard, and can be pasted at additional locations. It will remain in the clipboard until something else replaces it in the clipboard — including from an application other than TreeAge Pro.
It is also possible to cut a node — i.e., remove it from its current location, in order to paste it in a new location.

**To cut a node:**

- Select a node.
- Select Edit > Cut from the menu.
- ... OR ...
- Click CONTROL + X on the keyboard.
- ... OR ...
- Right-click on the node and select Cut from the context menu.

Special care must be taken when cutting and/or pasting anything other than a single endnode (i.e., any node without branches, except the root node). These actions can sometimes cause unexpected shifts in the model structure.

Note that you can always use the Undo command (CONTROL + Z) to undo the last changes to the model.

Consider what happens if you cut a node that is not an endnode.

![Diagram of a tree structure showing the effects of cutting a non-endnode](image)

**Cut non-endnode**

If you cut the node "Infection not cured" in the model above, the cut node's branches all shift to the left to become descendents of the original node's parent, in this case the "Treat foot" node. See below.

![Diagram of a tree structure after cutting a non-endnode](image)

**After cutting non-endnode**

The chance node "Infection not cured" can then be pasted elsewhere, but its descendents are not pasted with it. However, if you first collapse the subtree (Node > Collapse Subtree in the menu), then the subtree is copied with the node.
13.7.2 Cut/copy/paste a subtree

Duplicating large tree structures, rather than building each one from scratch, can both save time and avoid errors. In many trees, some alternatives will be structural identical or closely similar, differing perhaps in particular probabilities or payoffs.

Before a subtree can be copied, it must be selected.

To select a subtree:

- Right-click on a single node that has branches attached (i.e., not an endnode) and choose "Select Subtree" from the context menu.
- ... OR ...
- Hold down the CONTROL key and click on a single node that has branches.

When the subtree is selected, all the descendents of the "subtree root" will be selected while the "subtree root" itself will not be selected as it is not considered part of the subtree itself. The collection of nodes in the selected subtree can then be copied or cut. In the figure below, the subtree emanating from the "Treat foot" node was selected.
Once a node’s subtree is selected, the Copy Subtree command becomes available.

**To copy a subtree:**

- Choose Edit > Copy from the menu.
- **... OR ...**
- Click **CONTROL + C** on the keyboard.

Once copied to the clipboard, the subtree can be pasted to any non-terminal node — one with or without branches, in the same tree or a different one.

**To paste a subtree:**

- Right-click on any single non-terminal node and choose Paste from the context menu.
- **... OR ...**
- Select any single non-terminal node and click **CONTROL + V** on the keyboard.

⚠️ If you want to carry all information (e.g., Markov, DES) from the source subtree to the pasted subtree, be sure the source and destination subtree root nodes have the same node type.

In the figure below, the "Treat foot" subtree was copied to the new node "Treat foot copied subtree".

---

**After pasting subtree**

Note that the node "Treat foot copied subtree" above was not created by the copy and paste subtree functions. That node was created separately.

To move a subtree, rather than duplicate it, use the Cut Subtree commands.

**To cut a subtree:**

- Select a subtree as specified above.
- Choose Edit > Cut from the menu.
- **... OR ...**
- Click `CONTROL + X` on the keyboard.

This will cause the subtree (but not the subtree’s root) to be removed from the tree and placed on the clipboard. As with a copied subtree, when a subtree is cut to the clipboard, the Paste Subtree command becomes available.

### 13.7.3 Cut/copy/paste multiple nodes

When a subtree is cut/copied/pasted, the structure of the subtree is maintained to preserve the parent/child relationships among the nodes. When an assortment of nodes are selected, there may or may not be parent/child relationships among the nodes. Therefore, special care must be taken to ensure that the cut/copy/paste functions change the model as desired.

For example, if you select the three nodes as shown below, there is a parent/child relationship among the nodes. Therefore, those nodes could be copied and pasted to another location while maintaining those relationships in the pasted destination (i.e., the nodes "Patient dies" and "Leg amputated" will remain children of the node "Infection not cured").

![Select multiple nodes with parent/child relationship](image1)

Select multiple nodes with parent/child relationship

However, in the next figure, there is no parent-child relationship among the selected nodes. Therefore, the selected nodes would all be pasted as branches of the destination node.

![Select multiple nodes without parent/child relationship](image2)

Select multiple nodes without parent/child relationship

It is also possible to cut/copy/paste a set of nodes where there are parent/child relationships among some of the nodes and not among others. In such a case, existing parent/child relationships will still be maintained.
13.8 Cut, copy, and paste text

It is possible to cut, copy, paste, and delete text in node descriptions, as well as in probabilities, payoffs, and any other formulas or values you type in TreeAge Pro.

Before cutting, copying, or deleting text, you must select the targeted letters, numbers, or words.

To select individual characters of text or formulas:
- Either use the mouse to: a) click and drag from one end of the desired selection to the other; or b) click in front of one end of the selection, and then shift-click after the other end.

To select one or more words of text (or a formula):
- Use the mouse to either: a) double-click on the first word of the selection and drag to the last word; or b) double-click on the first word of the selection, and then shift-double-click on the last word.

Once the text is selected, then you can choose the appropriate command from the Edit menu.

To copy (duplicate) selected text:
- Choose Edit > Copy.
- ... OR ...
- Click CONTROL + C on the keyboard.

To cut (move) selected text:
- Choose Edit > Cut.
- ... OR ...
- Click CONTROL + X on the keyboard.

The Copy and Cut commands both place the selected text on the clipboard. The text on the clipboard can then be pasted into any TreeAge document, or into another program.

The Cut, Copy, and Paste commands can also be accessed by right-clicking on the selected text and choosing the command from the context menu.

The Paste Text command can be used to insert text or formulas both place the selected text on the clipboard. This text can then either be pasted into any TreeAge document, or into another program.

To paste (insert) text:
- Place the text cursor in the desired location.
- Choose Edit > Paste.
- ... OR ...
- Click CONTROL + V on the keyboard.
Selected text can be deleted without placing it on the clipboard by pressing the DELETE key or the BACKSPACE key.

13.9 Multiple clipboards

TreeAge Pro has four tree clipboards, where one is active at any one time. This means, in effect, that you can cut or copy subtree X without losing subtree Y that is currently on the active tree clipboard.

Prior to cutting or copying another subtree, simply activate one of the empty tree clipboard’s by selecting it in the Edit menu.

To select a different clipboard:
- Choose Edit > Tree Clipboard > Clipboard # from the menu.

13.10 Undo and Redo

Each tree (and dependency diagram) retains in memory details of the last actions that you took. Beginning with the most recent action and working back one action at a time, you can remove most all changes to structure, values, preferences, etc.

Note that the Undo “chain” is broken by some analysis and tree-building commands – TreeAge Pro will usually warn you also if a command cannot be undone.

To undo a change to your model:
- Choose Edit > Undo.
- ... OR ...
- Click CONTROL + Z on the keyboard.

If you go back too far in undoing modifications to the model, you can use the Redo command, also found in the Edit menu. The Redo command essentially allows you to undo previous Undo action(s).

To redo an undone change to your model:
- Choose Edit > Undo [action].
- ... OR ...
- Click CONTROL + SHIFT + Z on the keyboard.

13.11 Find and replace text, formulas, and values

You can quickly search for and modify text and formulas at nodes in a tree using the Find/Replace tool. With some exceptions, this is often the best way to fix the spelling of a word used frequently in a
tree, or to change a formula that appears in many payoffs, definitions, or other expressions. It is also often useful for simply finding particular nodes.

### 13.11.1 The Search Tree Dialog

*To open the Search Tree dialog:*

- Choose Tree > Find from the menu.
- ... OR ...
- Click `CONTROL` + F on the keyboard.
- The search dialog will default to "Search Open Trees" tab with "Search active tree only" checked. This will search only the currently active model.

![Search Tree Dialog](image)

**Search Tree Dialog**

The Search Tree dialog allows you to find and/or replace specific text in certain portions of the model or throughout the entire model.

### 13.11.2 Find Text

*To find text in a tree:*

- Open the Search Tree dialog.
- Enter text in the box labeled "Find what".
- Choose the matching options ("Whole word only" and "Case sensitive").
- Choose one or more search location(s).
- Click the Search button.
If you check the "Whole word only" option, TreeAge Pro will not search for partial word matches. If "Case sensitive" is checked, matching text must have the same combination of upper and lower case letters as the search text that you specify.

The locations refer to portions of the tree which should be searched for the search text.

The search results are then presented in the Search View.

**Search Tree View**

In the above example, the search text was "0.65". The nodes that include that text are presented in the Search View. Each nodes can be expanded/collapsed. When expanded, the node property or properties that contain the search text are displayed. If you double-click on the node (or its property), the node will be selected in the Tree Diagram Editor.

**13.11.3 Replace Text**

*To replace text in a tree:*

- Open the Search Tree dialog.
- Enter text in the box labeled "Find what".
- Choose the matching options ("Whole word only" and "Case sensitive").
- Select one or more search location(s).
- Click the Replace... button.

The Replace Text Matches dialog will open to prompt you to enter the replace text.
You then have two options for replacing text. If you click OK, all occurrences of the Search Text that fit both the matching options and search locations will be replaced.

If you click Preview, then a Replace Text Matches preview dialog shows all replacements that could be made by this action.

The Replace command is not recommended for changing a variable's name. Instead, edit the variable's properties in the Variables and Tables list.
13.12 Using the Probability Wheel View

A frequent problem encountered in decision analysis is the assignment of subjective probability assessments to chance events. Many people find it easier to use a graphical aid in assigning probabilities. One tool designed for this task is a probability wheel. TreeAge Pro provides this functionality through the Probability Wheel View.

The Probability Wheel View is a tool for assigning probabilities to each branch of a selected Chance node. The Probability Wheel View works whether or not you have already assigned probabilities to the branches. If you have assigned probabilities, they will be used as initial values for the wheel. Each branch will be assigned its own colored portion of the wheel.

As an example, the probability wheel could be used to aid in assigning relative weights to the two outcomes of the risky investment in the Get Started tutorial example tree, Stock Tree, used in earlier chapters.

To open the Probability Wheel View:

- Select a chance node with branches.
- Choose Views > Probability Wheel from the toolbar.

The probability wheel shows sections of the wheel to represent the probability associated with each branch. Drag the pointers around the edge of the wheel until the sizes of the section match your best assessment of the relative likelihood of outcomes.
If the selected node has three or more branches, you will see a check box named "Keep proportions". If checked, the probability bounded on the right side by the selected marker is changed independently, while ratios are maintained for the remaining probabilities.

Click the mouse button on any wedge to display the numeric value (probability) of that wedge. Right-clicking will display that wedge’s starting value.

Click the OK button to apply the probabilities from the Wheel to the branches of the selected Chance node. If you don’t want to use the new branch probability values, just close the Probability Wheel View or select another element in the Tree Diagram Editor.

The probability wheel should only be used to edit probabilities that are entered as numerical expressions. Other expressions can be converted to numerical expressions within the probability wheel to allow for editing.

Note that it is also possible to store the probability values from the probability wheel in variable definitions. To do so, you must first create the variable(s) via the Variable Properties View. After adding two variables $p_{\text{increaseLarge}}$ and $p_{\text{increaseSmall}}$ to the model and clicking off and back onto the Risky Investment node, additional options are shown in the Probability Wheel View. See the figure below with both the Probability Wheel and Variable Properties View displayed.
13 Making Changes to Tree Structure

The new variables can now be selected for storage of the probability values from the wheel as shown below. Note that the complement "#" was selected for the third branch.

After clicking the Update Branches button, the variables are defined at the specific branches with the value from the probability wheel as shown below.
Variable definitions created by Probability Wheel

You might choose to move those variable definitions to the root node to make them accessible in other areas of a model.
14. Annotating the Tree

In addition to the basic ability to enter text labels at event nodes in the tree, TreeAge Pro includes a number of other options for annotating trees covered in this chapter.

The next chapter covers a variety of options for controlling the layout, formatting, and contents of decision trees.

14.1 Node label options

14.1.1 Text wrapping

Every node in a tree has a node label that is used to describe the purpose/function of a node. Entering node label text has been covered in earlier chapters. However, this section will describe how to control text wrapping of the node label.

In past versions of TreeAge Pro, node label text would not wrap unless you entered a carriage return (via the ENTER key). In TreeAge Pro 201x, the node label text wraps automatically based on the width of that node generation.

Also, in TreeAge Pro 201x, if you click the ENTER key when entering the node label, the currently entered node label text will be stored with the label and application control leaves the node label. You can still force wrapping at specific points in the text by clicking CONTROL + ENTER on the keyboard.

The keyboard command to force wrapping on a Mac is also CONTROL + ENTER.

Since the node no longer stretches to accommodate the length of the node label text, you can now stretch a node generation via the ruler at the top of the Tree Diagram Editor.

In the figure below, the top node's label forces the text to wrap several times.
Node label text wrapped - before stretching node generation

Note the "tab pointer" in the ruler that is highlighted above. By dragging the "tab pointer" to the right, the entire node generation is stretched to make more room to display node label text, variable definitions, etc. See below.

Node label text wrapped - after stretching node generation

A node generation represents the set of nodes that are aligned vertically within the model. The ruler can be used to stretch a node generation, but it cannot be used to shrink the node generation beyond the standard minimum length.
14.1.2 Text formatting

TreeAge Pro supports multiple fonts, font styles and font sizes. The Fonts category of Tree preferences control the default text formatting for specific elements of a tree (e.g., node labels, probabilities, etc.). However, you can also set text formatting to a specific node label.

To change the text formatting for a specific node label:

- Right-click on the node and choose Format > Font from the context menu.
- Set the formatting options for the node label using the following Font dialog.

Font dialog

14.2 Label nodes

A label node, which uses a simple black “zigzag” as its symbol, acts like a placeholder. Label nodes have no impact on calculations, and cannot have more than one branch. A label node (or a series of them) can be inserted between event nodes to more clearly identify additional steps in a particular path.

To add a label node before an event node:

- Right-click on the event node and choose Insert Node > To Left from the context menu.
- Right-click on the new node and choose Change Type > Label from the context menu.

You could also change an existing endnode to a label node, and then use the Add Branch or Insert Node command to add the one allowed branch to the label node. A node with more than one branch cannot be changed to a label node.

For calculation purposes, a label node behaves like a decision node with one branch, or a chance node with one branch having a probability of 1.0. The value of the label node is simply the value of the node immediately to its right.
You can use a label node to separate dependent calculations. For example, you might have a tracker variable that is used in an expression, but the tracker needs to be assigned a new value before it is used in the expression. In such a case, you could insert a label node to the left of the node with the expression. Then you could assign the new value to the tracker in the label node. The tracker will then have the new calculated value when you reach the node with the expression the references that tracker.

14.3 Notes and arrows

Models often benefit from the use of longer explanations than are desirable in branch descriptions. Node comments, described in the previous section, are useful for the model builder, but not for someone looking at a printout or image of the model.

Using notes and arrows, you can provide the model's audience with an overview of the whole model, or specific nodes or subtrees.

14.3.1 Creating notes

Any number of notes can be created. Boxes are initially placed independent of any node, but can be bound to particular nodes if desired. Each box can use a different font, but all must use the same outline format (solid/dashed/none).

To draw a note in a tree:

- Click on Note in the Tree Diagram Editor Palette. The mouse cursor becomes crosshairs.
- With the mouse, click and drag somewhere in the Tree Diagram Editor. Make the box large enough to hold the text you wish to enter.
Create note

A yellow rectangular box is created that resembles a "Post-It" note. Within the box is a blinking text insertion caret, indicating that text can be entered in the note by typing. Text entered in the note will automatically wrap to the width of the box. If you enter text that does not fit into the box, the visible text will be truncated with an ellipsis (…) indicating that some text is not visible. Resize the note to display additional text (see next section).

After note is created and text is entered

The font of the active note can be changed. Each note can use a different font, but all text within a single note uses the same font.

*To change the font of a note:*
- First deselect the node by clicking elsewhere in the tree.
- Right-click near the edges of the note box (away from the text), and choose Format > Font from
  the context menu.
- Select the font options from the font dialog.

To see what the note will look like when printed, deselect it by clicking elsewhere in the tree.

The other options in the right-click context menu can be used to change the note's other visual
characteristics, including text, fill, and line color.

To change the note outline:
- Right-click on the note and choose from the Format > Line Color or Line Type sub-menus.

14.3.2 Changing text in a note

To change the text in a note, you must first activate the text.

To activate the text in a note:
- Select the note box, and then press the F2 key.
- ... OR ...
- Click three times on the text in the note. (The first click selects the note shape, the second
  selects the text box within the note shape, and the third activates the text insertion caret within
  the text.)

Once the text is activated, you can modify the text by typing or using standard editing commands
(BACKSPACE, DELETE, cut/copy/paste, etc.).

14.3.3 Moving, resizing, hiding and deleting notes

In order to move, resize, or delete a note, you must first select it. A note that is activated for text entry,
displaying the blinking text caret, is not selected.

To select a note:
- Click once on the note.

The selected note will display a small square with "handles" at each of its four corners and on each of
its sides. These handles are used to resize the note.

To resize a note:
- Move the mouse over one of the note's handles until the cursor appears as a double-sided
  resizing arrow.
- Click on the handle.
- Click and drag the handle to change the size and proportions of the note. The corner handles allow you to resize both the height and width of the note, while the side handles only allow you to resize one or the other dimension.

To move a note:
- Click on the note and drag it to the desired location.

The right-click context menu can be used to cut, copy or delete a note.

To delete a note:
- Right-click on the note and select Cut or Delete from the context menu.

The context menu's Copy command can be used to copy a note into the clipboard. The main menu's Edit > Paste command can then be used to create a duplicate copy of the original note.

14.3.4 Displaying/Hiding all notes

When notes are placed in a model, it may sometimes be useful to hide all the notes which have been created.

- Open Tree Preferences > Display > Node Text/Comments.
- Check the box "Hide all notes" to either hide/unhide all notes.

14.3.5 Binding a note to a node

When a note is placed in a model, it remains fixed in place relative to the top left corner of the tree window, and will not adapt to changes made to the tree. If nodes are added or deleted, for example, an existing note may overlap another object. This problem can be avoided by binding a note to a node.

To bind a note to a node:
- Click on the note and drag it just above the node to which you want to bind your note.
- When the red line appears above the node, release the mouse button.
14 Annotating the Tree

Bind note

The bound note will be aligned directly above the selected node, and will move with the node as the tree structure changes. The width of the note will be tied to the width of the bound node, and the text will automatically wrap to display all text.

After binding note

You can resize the node generation to better accommodate the contents of the bound note.
A bound note box can still be cut/deleted via the right-click context menu.

### 14.3.6 Creating arrows

You can draw arrows in conjunction with annotating a tree. Arrows are generally used to associate an unbound note with one or more nodes.

**To draw an arrow from a note to a node:**

- Click on the Arrow in the Modeling Palette.
- Move the mouse to the note. When over the note, the cursor shape will be an arrow without the "not allowed" character.
- Click on the note and hold down the mouse button.
- Drag the mouse to the node.
- Release the mouse.

When the Arrow option is selected from the Modeling Palette, the mouse pointer will change to the shape of an arrow with a "not allowed" character. When the mouse is over an element in the Tree Diagram Editor that is valid for an arrow connector, the "not allowed" character will disappear.

By default, the arrow will be displayed as a dotted line with no arrow markers at either end. However, the arrow's format can be edited. The figure below shows a note with arrows to three nodes. The format of each arrow is different, and the formatting context menu (via right-click) is shown.
14.4 Node comments

Detailed comments can be assigned to the branches of a node and saved with the tree. Unlike notes and branch labels, the text of node comments is hidden.

Node comments are particularly useful for recording the basis on which probability assignments were made for the branches of a chance node.

To add node comments:

- Select a node that has at least one branch.
- Choose Node > Node Branch Comments from the menu.
- Enter node comments.
- Click Save.
Edit Node Comments Dialog

The dialog allows you to enter notes for each branch of the selected node. The notes can be formatted using the formatting toolbars. Formatted comments generate HTML output.

A red flag will appear above any node for which node comments have been entered. See below.

Node comments shown in Tree Diagram Editor and Node Properties View
Node comments can also be seen in the Node Properties View. Click on the ellipsis button to edit the node comments for the selected branch. See above.

To remove node comments, delete the text in the Edit Node Comments Dialog.
15. Tree Display Preferences and Options

This chapter covers a wide variety of options for controlling the layout, formatting, and appearance of trees. Some of these features apply to calculated values displayed following roll back, while others affect display of the tree’s structure.

15.1 Collapsing/hiding subtrees

The Collapse Subtree command can be used to temporarily hide any subtree (including the root node’s subtree). It is particularly helpful when working with or presenting large trees.

To collapse a subtree:

- Select a node with visible branches.
- Choose Subtree > Collapse Subtree (or CONTROL + J on keyboard).

Collapsed subtree

The subtree emanating from the selected node is hidden and a plus sign (+) is displayed in its place, to the right of the node. The plus sign will also appear in place of the hidden subtree in printouts and exported images of the tree. Collapsing a subtree does not affect calculations.

15.1.1 Expanding hidden subtrees

Hidden subtrees can be uncollapsed in two ways: showing one generation of branches; or unhiding the entire subtree.

To expand a collapsed subtree one generation at a time:

- Select a node with a plus sign to the right.
- Choose Subtree > Expand Subtree Once (or CONTROL + SHIFT + J on keyboard).

The branches of the selected node will be displayed, but any subtrees attached to these branches will remain hidden and plus signs are displayed in their place.

To expand an entire collapsed subtree:

- Select a node with a plus sign to the right.
- Choose Subtree > Expand Subtree Once (or CONTROL + ALT + J on keyboard).
Visible clone copies (see Complex Trees Chapter) can be collapsed. Collapsing a subtree in the tree explorer pane does not collapse the subtree in the regular tree view.

15.2 Aligning selected nodes

TreeAge Pro includes two options for adjusting the vertical alignment of nodes in a tree. This section deals with the use of the Skip Generation command to make manual adjustments to the vertical alignment of selected nodes. It is also possible to specify that all terminal nodes be vertically aligned automatically; this is covered in a later section, on tree display preferences.

In many trees, asymmetry in intervening events results in the related nodes not lining up vertically. It is sometimes desirable to force these related nodes to line up, resulting in a more intuitive layout of the tree.

To align a selected node with a node in a different subtree:

- Select a node.
- Choose Node > Skip Generation (or CONTROL + []).

This will extend the length of the selected node by one node generation and moves the selected node’s subtree to the right.

Skipping one or more generations can be used to line nodes up vertically — for example, the multiple nodes representing a particular decision, in different paths. To skip more than one generation, simply select the menu command repeatedly.
To reverse the effects on the tree, simply un-skip generations at the node which skips a generation.

To remove an extra generation from the selected node:
- Select a node which is set to skip a generation.
- Choose Node > Unskip Generation (or CONTROL + f).

Skipping generations does not affect calculations.

15.3 Displaying terminal columns/roll back columns

When a tree is rolled back, TreeAge Pro normally displays next to each terminal node a roll back box containing the node’s calculated payoff and, in an optimal path, its path probability. Previous chapters described some of the customizations that can be made to the roll back display.

Instead of showing the standard roll back boxes at end nodes, a tree can be set up to display user-defined columns of values to the right of visual end nodes during roll back.

Calculated values and other information that can be displayed in roll back columns include:
- payoffs, including extra (non-active) payoffs
- individual components of a complex payoff formula
- path probabilities
- scenario (i.e., terminal node) numbers

Roll back column options

Some important features of roll back columns include:

- During roll back, the table of values can be copied to a spreadsheet or other applications for reporting or further analysis.
- A row will be displayed for every visual end node, even those that are not terminal nodes — for example, if a node’s subtree is collapsed (see above) or is a hidden clone copy (refer to the Complex Trees Chapter), a row is shown for the node at the base of the collapsed subtree.
- Calculated values can be displayed using custom numeric formatting.

Terminal column features

To add terminal columns in your model:
- Choose Tree > Tree Preference from the menu to open the Tree Preferences Dialog.
- Select the category Display > Terminal Columns.
- Check the "Show terminal columns" box.
- Click the "plus" button to add a terminal column.

Note that you can uncheck the "Show terminal columns" box later to return to regular payoff calculations without losing the terminal column preferences.
There are five columns in the terminal columns grid.

1. **Header**: Text to display above the column.
2. **Calculation**: Type of calculation to perform.
3. **Custom calculation**: Expression to calculate if Calculation value is "Custom".
4. **Numeric format**: Existing format option to apply to column.
5. **Custom**: Check to enter a custom format for this column

**Columns in terminal columns grid**

There are five Calculation options.

1. **Custom**: Enter any expression in the Custom calculation column.
2. **Expected Value**: The payoff value for the active payoff set.
3. **Incremental Value**: The difference in value between strategies.
4. **Path Probability**: The cumulative probability of reaching that terminal node. Only shows the recommended strategy.
5. **Scenario Number**: Counts from the top terminal node to the bottom.

**Calculation options**

The Special Features tutorial example tree "Terminal Columns" illustrates the use of terminal columns. Note the terminal columns from the tree preferences.

**Terminal Columns in Tree Preferences**

The terminal columns display...

1. **Expected Value**: - the EV calculated for the active payoff (2).
2. **Custom - Node(1)**: - calculate the EV for a non-active payoff (1).
3. Custom - Total_Cost - calculate the value of the variable at the terminal node.
4. Path Probability - the path probability for each terminal node of the recommended strategy.
5. Custom - PathProb() - the path probability for every terminal node.
6. Custom - PathProb() * Total_Cost - the EV multiplied by the path probability

When you roll back the tree, the terminal columns are displayed to the right of each terminal node.

Terminal Columns roll back

Terminal columns are a convenient way to show extra payoff values at each terminal node. Note that the "Calculate extra payoffs" tree preference must be checked to output additional payoffs.

When you roll back a model with terminal columns, you are given the option to export the terminal column data to a tab-delimited *.xls file in the same folder as the model.

Export terminal column data dialog

The file can then be opened in Excel. If you do not have excel, you can open the tab delimited file in a text editor.

15.4 Other tree display preferences

Each tree created in TreeAge Pro can be given its own distinct set of display preferences. Refer to the Tree Preferences Chapter for settings not covered here.
15.4.1 Hiding and boxing payoffs

By default, the active payoff formula is displayed at each terminal node when the tree is not rolled back. This information can be hidden if, for example, you want to simplify a visual presentation of the tree.

To hide terminal node payoff formulas:
- Choose Tree > Tree Preferences from the menu or press the F11 key to open the Tree Preferences dialog.
- Select the Terminal Nodes preference category.
- Uncheck the option labeled Display payoff names, and press ENTER or click OK.

Stock tree with payoffs hidden

Or, the tree’s payoffs can be displayed in boxes, even when the tree is not rolled back.

To enclose payoffs in boxes when the tree is not rolled back:
- In the Terminal Nodes preferences category, check the option labeled Display payoff names and the option labeled Boxed.

15.4.2 Hiding probabilities and branch labels

The numbers or formulas entered for probabilities can be hidden from view. Node branch labels can also be hidden.

To turn off the display of probabilities and/or node names:
- Choose Tree > Tree Preferences from the menu or press the F11 key to open the Tree Preferences dialog.
- Select the Node Text/Comments preference category.
- Check the option labeled Hide probabilities only, or the option labeled Hide all node texts. Press ENTER or click OK.

15.4.3 Displaying a "skeleton" tree

The skeleton tree display option has not yet been implemented.
15.4.4 Terminal node numbers

To show scenario/terminal node numbers:

- Choose Tree > Tree Preferences from the menu or press the F11 key to open the Tree Preferences dialog.
- Select the Terminal Nodes preference category.
- Check the option labeled Automatic node numbering.
- Enter the Numbering text format. The default entry will simply number the nodes.
- Press ENTER or click OK.

The text you enter for terminal node numbering must use the caret ("^") as a placeholder for the node number. The caret can be used alone or with additional text, as in "Outcome ^". The terminal node number and text will be displayed whether or not the tree is rolled back.

15.4.5 Number all nodes

Instead of just numbering terminal nodes, TreeAge Pro can apply the numbering format you specify to all nodes in the tree.

To show node numbers for all nodes:

- In the Terminal Nodes preferences, check the option labeled Automatic node numbering. Refer to instructions in prior section.
- Also check the sub-option All nodes in tree.

15.4.6 Increasing or decreasing vertical white space

If two branches that are vertical neighbors appear too close together, there is a way to increase the space between them.

To increase the vertical spacing between two nodes:

- Click on the bottom branch’s text label, to the left of the first word in the label.
- Press CONTROL + ENTER one or more times, inserting carriage returns until you have created sufficient white space.
- Press ENTER to commit the text edits.
A tree can be compressed vertically, reducing white space and yielding a very compact tree.

**To compress a tree vertically:**

- Choose Tree > Tree Preferences from the menu or press the F11 key to open the Tree Preferences dialog.
- Select the Tree Editing/Layout preference category.
- Check the option labeled Minimize empty space. You must first ensure that Align endnodes is not selected.
- Press ENTER or click OK.

The figure below illustrates how TreeAge Pro compresses the display of the tree.

---

**Tree with added vertical whitespace**

This tree preference does not yet account for the position of payoffs. Notice the payoff for the bottom strategy is presented on top of another node.

You can increase vertical white space in conjunction with this tree preference to correct this error manually until this issue is resolved.

If the display of your tree looks broken when the Minimize empty space setting is turned on, review these potential conflicts:

- The Minimize empty space and Align endnodes settings are incompatible.
- Minimize empty space can cause problems when a tree is rolled back, because of a lack of space for roll back boxes.
- Using both the Minimize empty space and Branch lines at right angles settings can result in branch lines which slice through node symbols.
- Minimize empty space is likely to cause problems with the display of terminal node columns.

### 15.4.7 Vertically aligning terminal nodes

There is a quick way to align all terminal nodes in a tree with the right-most terminal node.

To align all terminal nodes at the right edge of the tree:
- Choose Tree > Tree Preferences from the menu or press the F11 key to open the Tree Preferences dialog.
- Select the Tree Editing/Layout preference category.
- Check the option labeled Align endnodes.
- Press ENTER or click OK.

![Tree with end nodes aligned](image)

For instructions on aligning specific nodes in the tree, refer to the Aligning selected nodes section at the beginning of this chapter.

### 15.5 Changing fonts

The font, size, and style of any text that appears in a tree can be easily changed. Fonts can either be changed for selected objects or globally, via a tree’s preferences.

#### 15.5.1 Changing the font of selected objects

You can change the appearance of text within the model. You can modify the node font for the following attributes: node label, probability, expected value and variables. Each attribute can use a different font.

For notes, the only attribute available is the node text.

To change the font of the selected node:
- Right-click on a single node.
- Choose Font > [Attribute] from the context menu.
  
  Each [Attribute] option refers to different text that can be associated with a node.
- Select the font preferences from the Font dialog and click OK.

Once a selected node’s font has been modified, it is independent of the tree’s global font preferences, described in the next section. Changes made to the tree’s font preferences will not affect the selected node.

Fonts can be changed for multiple selected nodes and/or subtrees in the same manner as above, using the right-click menu on one of the selected nodes.

Fonts can also be changed for notes by right-clicking and choosing Font from the context menu.

### 15.5.2 Changing font preferences

The Fonts Tree Preferences category makes it possible to specify, for the entire tree, the font used for node names, probabilities, expected value boxes, and (if displayed) definitions of variables. Each button calls up the standard font, size, and style dialog, but changes made in those dialogs apply only in the limited context that their names reflect.

The *Node Font* button will change the branch text font for nodes subsequently created in the tree. It is also applied to existing nodes in the active tree, with the exception of selected nodes and subtrees at which you have individually changed the font.

The *Prob Font* button will change the probabilities font for the active tree. Like the Node Font, this is used for new nodes and existing nodes in the active tree, with the exception of nodes and subtrees at which you have individually changed the probability field font.

The *EV Font* button allows you to change the font for roll back boxes displayed upon roll back of the active tree.

The *Variables Font* button allows you to change the font for variables displayed beneath nodes in the active tree, if you elect to display full variable definitions in the tree.
16. Introduction to Variables and Sensitivity Analysis

This chapter provides a basic tutorial on the use of variables and one-way sensitivity analysis in decision trees.

Subsequent chapters cover TreeAge Pro’s many useful tools for working with variables, as well as more complex, multi-way and probabilistic sensitivity analysis. In particular, refer to the first sections of both the Building Formulas Chapter (on defining variables non-numerically) and the More Sensitivity Analysis Tools Chapter (on avoiding sensitivity analysis problems).

Some users may wish to refer to the Index to find out more about special uses of variables in Markov microsimulation, user-defined Python functions, and clones.

16.1 Sensitivity analysis background

Sensitivity analysis was introduced in the Decision Analysis Primer Chapter as a means of assessing the extent to which a model’s calculations and recommendations are affected by uncertainty. Specific questions about the model that sensitivity analysis can help answer are:

1. Is a model sensitive to a particular uncertainty — e.g., does varying a parameter’s value result in changes in optimal strategy?
2. If a model is sensitive to a particular uncertainty, at what value(s) of the parameter does the model recommend a change in strategy?
3. Does the sensitivity analysis result make sense? (This is a model debugging question.)

The tutorial in this chapter shows how to prepare a tree for sensitivity analysis, how to perform a one-way sensitivity analysis, and how to interpret the results. The More Sensitivity Analysis Tools Chapter covers multi-way sensitivity analysis and tornado diagrams. The Monte Carlo Simulation Chapter covers the use of probability distributions and Monte Carlo simulation to analyze models with complex or numerous uncertainties.

The Working With Variables Chapter and the Building Formulas Chapter provide important details on working efficiently with variables in decision trees. The information in these chapters can help you improve your productivity when building complex decision trees, and also insure against costly modeling errors.

16.1.1 Variables and sensitivity analysis

Up to this point in the tutorial, decision trees have been analyzed on the basis of baseline, numeric values for payoffs and probability values. In order to perform sensitivity analysis on an uncertain quantity, however, its numeric value must be replaced with a variable — a named parameter.
In the investment decision modeled in the first few chapters, subjective estimates for probabilities and payoffs were used. The resulting tree is shown below, rolled back. The expected value calculations suggest that the CD investment is optimal.

Investment tree rolled back

The basic uncertainty is that, at the time of the decision, the investor cannot know what the price of the equity will be in one year. A simple probability distribution — a chance node with three branches — represents a range of possible changes in the risky investment’s value. Assuming that you have a mix of different expert opinions about the risky investment, it would be useful to be able to perform sensitivity analysis on the related parameter uncertainties. The extreme, 10th and 90th percentile values in the payoff distribution — a $600 decline or $500 rise in value — are possible candidates for sensitivity analysis. Another option is to vary the probabilities.

The next section of this chapter shows how to replace selected numeric values in the tree with variables. *This is a prerequisite to performing sensitivity analysis in TreeAge Pro.*

### 16.2 Using variables in a tree

In TreeAge Pro, a variable is a named parameter which functions as a placeholder for a numeric value (or a formula). Variables have a variety of functions in TreeAge Pro, including:

- representing uncertain or unknown values, usually in preparation for sensitivity analysis
- acting as placeholders for mathematical formulas that include functions, tables, spreadsheet links, and other variables (for example in defining a complex payoff)

The tutorial in this chapter focuses on the use of variables as a basis for sensitivity analysis. The Building Formulas Chapter will discuss the creation of payoff formulas using variables.

When building complex models, variables are often used from the outset. The investment decision tree has already been completed using numeric payoffs and probabilities, however, so this tutorial will take a different course, replacing existing numeric values with variables.

Some procedures explained in this chapter are not required steps for using variables in the investment tree. Optional steps will be identified as such.
16.2.1 Steps for using variables

There are three basic steps to remember when using a variable as a parameter in a decision tree:

1. **Declare name** — Based on its intended function in your model, decide on a clear name for the variable (following the naming guidelines outlined below). Add the name to the list of recognized variables in the tree.

2. **Define, assign** — Define the variable at a node, often the root, by assigning it a value (or a formula).

3. **Use** — Anywhere the corresponding value is used in the tree (e.g., payoffs or probabilities), in its place substitute the variable name.

TreeAge Pro offers multiple methods for each step; this chapter illustrates a few possible methods.

16.2.2 Guidelines for naming variables

Variable names must conform to certain rules (similar to Microsoft® Excel’s rules for cell names). Each variable name must:

- begin with a letter or underscore character (“_”)
- contain only letters, numbers, and underscore characters
- be no longer than 32 characters

TreeAge Pro will alert you if you try to use an invalid variable name.

It is recommended that you follow some kind of naming convention when creating variables in a particular model. For example, you could use the prefix “prob” or “p” for probability variables, “c” for cost variables, and so on.

Variable names are not case-sensitive. For example, the names probUp, PROBUP and probup are equivalent; prob_UP would be a different variable, however, since it includes an extra character.

16.2.3 Creating and defining variables

As explained at the beginning of this chapter, there are two apparent sensitivity analysis approaches in the investment tree: vary the extreme probabilities or the extreme payoff values.

The tutorial will start by using variables in the branch probabilities of the extreme outcomes, and after that in the payoffs. The tree will eventually look like the picture shown here.
It is a good idea, if you already have a working version of your tree without any variables, to keep a backup copy of the tree. For information about creating a project to store your test model, refer to the Example Models and Projects Chapter.

The first step is to create and define a variable that can be used to replace the numeric probabilities of the Large increase and Large decrease branches with a variable placeholder.

**To create and define a new variable in a tree:**
- Open the Variable Properties View.
- Click the "+" icon in the view toolbar. The Add/Change Variable or Function dialog will open.
- Enter the variable name `prob_extreme` in the name field.
- Enter description and comment information for the variable (optional).
- Enter 0.3 into the Root Definition - Build Expression field.
- Click OK.
Create new variable prob_extreme

The name “prob_extreme” has been added to the list of recognized variable names in the tree, and it has been assigned a default numeric value of 0.3 at the root node. You will see the definition beneath the root node in the Tree Diagram Editor.

Tree showing new variable prob_extreme

The assignment of a value (or formula) to a variable at a node is called a definition. Which node you define a variable at determines where the variable definition will apply in the tree (i.e., which payoffs and probabilities can use the variable name).

The root node definition of prob_extreme, for example, applies at the root node and everywhere to the right, including at the Large increase terminal and at the Large decrease node, both of which will be updated to use the variable.
16.2.4 Finding and fixing problems with definitions

The variable definition, prob_extreme = 0.3, should be visible at the root node of the tree. If the definition is not visible below the root node, as in the above picture, it does not mean that the definition does not exist. The first thing to check is whether the display of variable definitions has been turned on in the tree’s preferences.

To display variable definitions in the tree:

- Choose Tree > Tree Preferences from the menu or press the F11 key to open the Tree Preferences dialog.
- Select the category Display > Variables/Markov Info.
- Select "Show definitions" from the "Display definitions at node" options.
If the tree is set to display *variable definitions*, but the definition `prob_extreme=0.3` does not appear at the root node, determine whether the variable was created and defined.

Individual variables can also be hidden/shown in the tree using the Variable Property "Show in tree".

The list of named variables in the tree can be viewed and modified in a number of ways. A quick way to access the variables list is by right-clicking on a node (use the root node for now).

**To view the list of tree variables in a "quick" menu:**

- Right-click on the root node and choose Define.
- If any variables exist in the tree, their names will be listed (below the New… command).
Later, we will look at using the Variable Properties View and Variable Definitions View to manage a tree’s variables.

To open the Variable Properties View:
- Choose Tree > Show View > Variable Properties from the menu.

To open the Variable Definitions View:
- Choose Node > Show View > Variable Definitions from the menu.

16.2.5 Placing variables in a tree

Previously in this documentation, quantities (payoffs, probabilities, etc.) in the tree were entered as numeric values. However, TreeAge Pro allows for the flexibility of entering quantities as expressions using numbers, variables, tables, functions and distributions. We’ll start with the single variable that we created earlier. We’ll use two different methods to place the new variable in two probability expressions.

To use the variable prob_extreme in the model:
- Select the Large increase terminal node and press \texttt{SHIFT-TAB} to edit the probability.
- Delete the numeric probability of 0.3, and in its place type a new variable name \texttt{prob\_extreme}.
- Press \texttt{SHIFT-TAB} (or click outside the node) to have TreeAge Pro check the changes you made to the probability expression.
- Click with the mouse in the probability editor, below the Large decrease terminal node.
- Click on the function editor ("f(x)") to open the Formula Editor.
- Clear the 0.3 from the formula editor.
- Select variable in the formula editor's left pane, then double-click the variable \texttt{prob\_extreme} in the right pane and click OK.

At this point, the variable \texttt{prob\_extreme} has replaced two numeric value probability values 0.3 in the model.
16.2.6 Adjusting complementary probabilities

Our changes to the probabilities in the tree are not complete. If the value of the variable prob_extreme is changed, for example during sensitivity analysis, the probabilities at the chance node will no longer sum to 1.0 — unless a change is made to the 0.4 probability at Small increase.

The two options for Small increase’s probability are to:

- enter an expression in terms of the new variable (e.g., “1-prob_extreme*2”); or
- use TreeAge Pro’s automatic complement calculator (“#”).

Let’s use the second option, the "#". The benefit of using the "#" is that it recalculates if the value of prob_extreme is changed.

To assign a remainder expression to a probability:

- Delete the numeric 0.4 probability of the Small increase node.
- Replace it with # (a hashmark), which will still calculate as 0.4 unless the definition of prob_extreme changes.

Use complement calculator with variables

Now, if we change the value of prob_extreme to 0.25, the probability of Small increase will automatically be recalculated as 1 - 0.25 - 0.25, or 0.5, and the chance node’s probabilities will continue to be coherent (sum to 1.0).

Once prob_extreme has been defined and used properly, and the chance node’s probabilities have been adjusted appropriately, you could skip ahead to the section on performing sensitivity analysis, and try analyzing the impact of this uncertainty on your decision.

16.2.7 Create, define and use additional variables

At this point, we have introduced the variable prob_extreme into the model. Now we will introduce variables into the payoff expressions for the Large increase and Large decrease terminal nodes.

We will use the same method we used earlier for the first variable and a different method for the second.

To create and define a new variables in a tree:

- Choose Tree > Show View > Variable Properties from the menu.
- Within the Variable Properties View, click the "plus" icon.
- Enter the variable name (pay_down), optional description and optional comment.
- Check the box "Define numerically at root" and enter the value -600 into the Value field.
- Click OK.
- Repeat these steps for the variable pay_up with value 500.

Now, we will enter the new variables into the payoff expressions for the appropriate terminal nodes.

To update the payoff expression for Large increase (Method 1):
- Double-click on the payoff expression 500 to the right of the Large increase node.
- In the Edit Payoff dialog, replace the value 500 with the variable name pay_up and click OK.

To update the payoff expression for Large decrease (Method 2):
- Right-click on the Large decrease node and select Edit Payoffs from the context menu.
- Click on the payoff expression -600 and delete it.
- Click on the ellipsis ("...") button to open the formula editor.
- Select variable in the formula editor's left pane, then double-click the variable pay_down in the right pane and click OK.

The tree should now look like the figure below - with three variables defined and used in the mode.

Stock tree with three variables

The finished version is available as the Get Started tutorial example tree "Three Vars".

16.3 Performing one-way sensitivity analysis

TreeAge Pro can perform sensitivity analysis at a selected node using a range of values for a single variable (one-way sensitivity analysis) or across ranges of values for two or three variables simultaneously (multi-way sensitivity analysis). This chapter covers one-way sensitivity analysis. Multi-way sensitivity analysis, and other advanced sensitivity analysis topics, are described in the More Sensitivity Analysis Chapter.

In the previous section, variables were created at the root node. We have the variables prob_extreme, pay_up and pay_down all with numeric definitions. All these variables would be valid choices for one-way sensitivity analysis as independent model inputs. That is: they are defined only once at the root.
node as a fixed value or parameter distribution. There are examples of the warning/error messages which you will receive if you choose an invalid parameter for sensitivity analysis.

Start by analyzing the sensitivity of the decision to changes in the probability variable, prob_extreme.

To perform a one-way sensitivity analysis:

- Open the Three Variables tree you created in the previous section (or open the Get Started Tutorial example tree "Three Vars").
- Select the decision node.
- Choose Analysis > Sensitivity Analysis > 1 Way..., or click the toolbar button (see below).
- In the Sensitivity Analysis dialog, click on the Variable column to see a dropdownlist and select the variable prob_extreme.

If you specified a low and high value in the variable’s properties, that range will be shown. Otherwise, the range will be set using default values (0 to baseline value). In this example, the saved range is 0 to 0.5.

The checkboxes related to Microsimulation allow you to run a set of trials through the model for each value within the variable range. Refer to the Individual-Level Simulations Chapter for details.

As noted above, you will receive a warning if the variable you have selected for Sensitivity Analysis is not a variable defined at the root node, as a number or as a distribution. The figures below show these two warnings.
16.3.1 Setting the sensitivity analysis range

This section will explain the different ways you can set the range of a variable for sensitivity analysis. The current definition of prob_extreme is 0.3. Recall from earlier in the chapter that our initial interest in sensitivity analysis with the Stock Tree is to test different probability assumptions for the risky investment. For instance, we would like to vary the probability estimates for the extreme outcomes testing values from 0.25 to 0.3.

It is important to remember that prob_extreme is used in two out of three branches, with the remainder (or complement) assigned to the middle branch. If we set prob_extreme to 0, the remainder calculated for the Small increase branch will be 1.0. So, prob_extreme = 0 can be the minimum value for the sensitivity analysis.

If we try to set prob_extreme to anything above 0.5, probability coherence errors will occur: for example, at prob_extreme = 0.501 the extreme branches sum to greater than 1.0. The maximum possible value for the variable therefore is 0.5. The key estimates for prob_extreme, 0.25 and 0.3, are found within this range, and so the model will not create an error for this range.

*How to enter the range of sensitivity analysis values:*
The sensitivity analysis range can be entered in three ways. When you select One-way Sensitivity Analysis, the entries in the *Type* column can be selected from a dropdown menu. The following list explains those different options:

- **Values**: Enter low and high values for the range directly.
  - Low entry of 0, high entry of 0.5 would be used directly as the sensitivity analysis range values.

- **Adj%**: Enter percentages to be applied to the baseline value to calculate the low and high values for the range.
  - Low entry of 10%, high entry of 20% would be applied to the baseline 0.3 value.
  - Low value would be: \(0.3 \times (100\% - 10\%) = 0.27\)
  - High value would be: \(0.3 \times (100\% + 20\%) = 0.36\)

- **Adj#**: Enter numeric adjustments to be subtracted from and added to the baseline value to calculate the low and high values for the range.
  - Low entry of 0.1, high entry of 0.2 would be applied to the baseline 0.3 value.
  - Low value would be: \(0.3 - 0.1 = 0.2\).
  - High value would be: \(0.3 + 0.2 = 0.5\).

**Example of running the sensitivity analysis:**

- Select the Decision node and then Analysis > One-way Sensitivity Analysis (as above).
- In the dialogue, once the variable prob_extreme is selected, select the Type: Values.
- In the Low value column, enter 0, and in the High value column, enter 0.5.
- Change the number of intervals to 10. Dividing the range into 10 intervals results in 11 recalculations at the decision node, for prob_extreme equal to 0, 0.05, 0.1, 0.15, 0.2, 0.25, 0.3, 0.35, 0.4, 0.45, and 0.5.
- Press enter or click OK to run the analysis.

TreeAge Pro should immediately begin the analysis. If the analysis were a long one, you could monitor its progress in the status bar at the bottom of the TreeAge Pro window. When it is complete, a graph is displayed.
16 Introduction to Variables and Sensitivity Analysis

If the analysis does not complete due to errors, read the error message and make note of the node where TreeAge Pro reports a problem. Most likely, the problem is either too wide a range for the uncertain variable, or a problem with the assignment of probability variables in the chance node branches.

If a tree is saved after running sensitivity analysis, the sensitivity analysis range for each variable is saved in the Variable Properties.

16.3.2 The sensitivity analysis graph and report

Because the analysis was done at the decision node, there should be two lines corresponding to the two alternatives, Risky investment and CD paying 5%. Each alternative’s expected value is plotted as a function of the increasing value of prob_extreme.

Each strategy’s line is composed of line segments connecting the line marker symbols that identify that alternative’s expected value at successive intervals of the analysis. A legend to the right identifies the symbol assigned to each particular alternative.

Deviations of a line from the horizontal indicate that strategy’s sensitivity to the variable. An alternative represented by a horizontal line in the graph, such as the "CD paying 5%" option in the example, is unaffected by the changes in the variable. In contrast, the payoff represented by the "Risky investment" line is a decreasing function of the variable.

The analysis text report, showing the underlying calculated values, can be opened by clicking the Text Report link to the right of the graph.
16 Introduction to Variables and Sensitivity Analysis

1-way sensitivity analysis text report

This text report essentially mirrors the output from the Rankings text report, except with a separate group showing separate results for each variable value specified by the sensitivity analysis range/ intervals. Note the strategies are sorted within each grouping based on the value (lowest to highest) by default. With this presentation, the incremental value can be used to determine the optimal strategy. However, you can also choose to override the default sort via the option "Change order of strategies" to the right of the report.

Select the option "Change order of strategies" to choose a custom order of strategies.

With this option you can choose the strategy order you want. The same order will be applied to all values of the parameter. The text report can be exported to Excel using the "Open in New Excel Spreadsheet"
icon to the far right of the report toolbar. There are two export options - one showing each strategy in its own row and one showing all strategies in the same row.

Thresholds are described in the next section.

![Tip] If the trend of a line in the graph does not make intuitive sense, this may indicate a problem with the definition or use of the variable in the model. Sensitivity analysis can be used to look also for errors in complex formulas, which might be indicated if changing the value of a parameter (even one that is certain) does not have the anticipated effect on calculations. The visual elements of the one-way sensitivity analysis graph, like other line graphs, can be customized in a number of ways, as described in the Graphs Chapter. This includes changing graph size, texts, line markers, and numeric formatting.

### 16.4 Sensitivity analysis thresholds

The sensitivity analysis results can be interpreted graphically.

If two lines in the graph intersect, at the corresponding value of the variable these two alternatives have the same expected value. Crossing points that represent a change in the optimal strategy are called thresholds. From the standpoint of expected value, the decision maker should be indifferent between the two options at a variable’s threshold value.

#### 16.4.1 Threshold lines

At each threshold, you will see a dotted vertical line. The line stretches up from the x-axis through the crossing point for optimal strategies. The variable value associated with the threshold is shown next to the threshold line.

In the previous section's example, the threshold line marks a crossing point when \( \text{prob\_extreme} = 0.17 \). For values higher than that, including the baseline 0.3 probability, the CD has a higher return and is therefore optimal. For values of \( \text{prob\_extreme} \) less than 0.17, Risky investment is optimal.

In this analysis, the threshold is not close to our two best estimates, 0.25 and 0.3, so perhaps the model is not sensitive to this particular uncertainty.

Among other options for formatting graphs, you could change the numeric formatting of the x-axis to calculate the threshold to a greater degree of accuracy.
16.4.2 Thresholds Report

You can also pull threshold information from the analysis by clicking on the “Thresholds Report” link to the right of the Sensitivity Analysis output graph. This report focuses on the variable value and strategies associated with each threshold in the analysis. See below.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Var Value</th>
<th>Strategy</th>
<th>Exp. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>profit</td>
<td>0.07</td>
<td>risky</td>
<td>50</td>
</tr>
</tbody>
</table>

Sensitivity Analysis Thresholds Report

Note that the report shows the variable, its threshold values, the strategies that are equivalent at the threshold and the EV value for the strategies at that threshold.

16.4.3 A caveat on thresholds

If all of the lines in a sensitivity analysis graph are straight, the threshold analysis in the graph will be exact. However, if any lines appear curved, the threshold analysis is a linear approximation, and its accuracy will increase as the width of the intervals decreases.

The analysis performs calculations only at the ends of the N number of intervals specified when running the analysis. The lines plotted on the graph are accurate at these N+1 discrete points, but not necessarily in between (e.g., if an alternative’s expected value is an exponential or other non-linear function of the variable’s value).

The sensitivity analysis graph will not recognize a threshold if the optimal strategy is the same at both ends of the interval, but changes back and forth within the interval. The likelihood of this error can be reduced by increasing the number of intervals, thus reducing their width.

A more sophisticated, non-graphical form of threshold analysis is described in the More Sensitivity Analysis Tools Chapter. This chapter also includes more information on one way sensitivity analysis and other kinds of sensitivity analysis.
17. Working With Variables

This chapter expands on the aspects of TreeAge Pro’s variables interface introduced in the previous chapter, and also introduces a number of important windows, dialogs, and other tools that facilitate working with variables in trees.

For information on managing tables, refer to the Tables Chapter. Also refer to the Building Formulas Chapter for information on building complex variable definitions and using functions.

Users of the Excel Module can refer to the Using the Excel Module Chapter to learn about features available for managing variables in Excel.

Note that the methods used to manage variable properties and definitions have changed significantly in TreeAge Pro 201x. This chapter will describe the new methods.

17.1 Variable Properties View

The Variable Properties View is used to manage variable properties. Unlike variable definitions, variable properties apply to the entire tree. Therefore, the Variable Properties View is a tree-level view rather than a node-level view.

**To open the Variable Properties View:**

- Choose Views > Variable Properties from the toolbar.

Below is an image of the Variable Properties View from the Get Started tutorial example model Three Vars.

![Variable Properties View](image)

**Variable Properties View**

The main grid contains a list of the tree’s variables along with a few of the key variable properties. These properties can be edited within the grid. If you change the variable name, all references to that variable within the tree will be modified as well.

The Variable Properties View toolbar provides additional functions.

![Variable Properties View toolbar](image)

The functions associated with the icons are presented below. Each function is described in subsequent sections.
1. Edit Variable
2. Add Variable
3. Add Multiple Variables
4. Delete Variable
5. Convert Variable to Tracker
6. Copy Variable
7. Paste Variable
8. Edit in Excel
9. Generate Variables Report
10. Highlight
11. Find References in Tree
12. Filter Text/Clear
13. Show Categories Tree/Group Variables by Category

Variable Properties View toolbar functions

**17.1.1 Edit Variable**

This function is used to edit the properties of the selected variable. Only one variable can be selected. The Add/Change Variable or Function Dialog will open with the properties of the selected variable displayed.
Add/Change Variable or Function Dialog

Within this dialog, you can edit the variable’s properties - name, description, comment. You can also enter a variable definition at the root node either by entering the definition or via the formula editor or content-assist.

Within the Root Definition section, there are two main areas Build Expression and Add to Expression.

1. **Build Expression**: The expression that is being modified by the Formula Editor.
2. **Add to Expression**: The elements to add to the expression are found here and are:
   1. **Group**: Element type to display in the Element section.
   2. **Element**: Individual item to add the the expression.
   3. "+": A Button to add the selected Element to the Build Expression editor. An

When the changes are complete, click OK to save.

Note that the Add/Change Variable or Function dialog contains three property categories.

1. **General** - Maintains main variable properties as described above.
2. **Sensitivity Analysis** - Maintains sensitivity analysis range and correlations. Refer to Sensitivity Analysis Variable Properties Section.
3. **Categories** - Maintains Variable Categories associated with the variable. Refer to Variable Categories Section.

### 17.1.2 Add Variable

This function is used to add a new variable to the model. The Add/Change Variable or Function Dialog (see prior section) will open with a default variable name and default properties (mostly blank). If you have selected to add a variable and you are not at the Root node, you will be able to select where you want to Create the Definition either: *Root Node* or *Selected Node*. A Variable should either be added at the Root node or at the Selected node.

Enter the new variable's name and properties within the dialog.

Add/Change Variable or Function prompting to define at either the Root or the Selected node.

Click OK to save the new variable.

### 17.1.3 Add Multiple Variables

This function works the same as Add Variable except that you can add a number of variables at a time.
17.1.4 Delete Variable

This function is used to delete one or more selected variables from the tree. Deleting variable(s) will also delete all definitions for the affected variable(s).

Expressions that reference deleted variables will no longer function correctly. These expressions will need to be updated.

17.1.5 Convert Variable to Tracker

This function converts the variable into a tracker. Trackers are used in Microsimulation to store and retrieve data associated with individual trials. Refer to the Individual-Level Simulation and Markov Models Chapter for details on the use of trackers.

When executed, this function opens the Add/Change Tracker Dialog to allow you to create the tracker from the existing variable.

After you click OK, the variable is converted to a tracker.

17.1.6 Copy and Paste Variable(s)

These functions copy one or more variables (including names and root node definitions) and paste them into another model.

To copy a variable:

- In the variable properties view, select the row to copy by clicking anywhere in the row. The 'copy' icon will become active.
- Select the copy icon, as highlighted in the figure below.
To paste a variable

- Open the destination model, and select the 'paste' icon in the Variable Properties view.

To copy multiple variables, select one variable, then hold down the Ctrl key while selecting other variables. Then use the steps outlined above to copy the selected variables for pasting in the destination model.

The copy/paste icons are used to copy/paste the entire model input (row).
To copy/paste specific entries within the variable row, such as the variable name or root definition, use the Ctrl+C (Command+C on Mac) to copy and Ctrl+P (Command+P on Mac).
Individual entries can then be copy/pasted into different expressions in this or another model.

17.1.7 Edit in Excel

This function exports the tree’s variables to an Excel worksheet. You can then edit the variables within the worksheet and send the new properties/values back to TreeAge Pro.

This function requires the optional Excel Module. It is described in the Using the Excel Module Chapter.

17.1.8 Generate Variables Report

This function creates a report listing...

1. A complete variables list for the the tree including each variable’s name and selected properties.
2. For a single selected node, a list of variables defined at or to the left of the node and their properties.
The Variables Report can be useful in determining which variables are unused (and might be deleted). It can also be used to retrieve calculated values based on the applicable variable definition (at the selected node or closest one to the left).

Similar to other reports, the Variables Report can be exported to a number of external formats including HTML and Excel.

17.1.9 Highlight

When this option is depressed, the selected variable is highlighted within the model in the Tree Diagram Editor. See below.

17.1.10 Find References in Tree

Click this icon to trigger an immediate search within the model for that variable. The Search will find all variable definitions and all references to the variable.

17.1.11 Filter Text/Clear

The Filter Text field allows you to filter the list of variables to show only variable names that match the Filter Text. For example, if you entered "pay" into the Filter Text, the variables pay_up and pay_down would be displayed, but not prob_extreme.

Enter an asterisk before the expression to look for text in the middle of the variable name rather than the front. For example, if you entered "*down" into the Filter Text, the variable pay_down would be displayed, but not pay_up or prob_extreme.
17.1.12 Show Categories Tree/Group Variables by Category

The Show Categories Tree toggle switch splits the Variable Properties View into two panes, adding a left-side pane for managing Variable Categories. Click the icon again to hide the category pane. Refer to the Variable Categories section for details.

The Group Variables by Category function changes the display within the Variable Properties View to group the variables within the assigned categories.

17.2 Variable Definitions View

The Variable Definitions View is used to manage variable definitions at different nodes within the tree. Variable definitions are created at specific nodes, so the Variable Definitions View is a node-level view. The contents of the view reflect the context of the selected node.

Several Views, such as Variable Definitions View, are node specific. If you have not selected a node or are not on the correct node type, a warning will appear in the View.

To open the Variable Definitions View:

- Choose Views > Variable Definitions from the toolbar.

Below is an image of the Variable Definitions View from the Get Started tutorial example model Climber Cost with the root node selected.

Variable Definitions View

The main grid contains a grouped list of variable definitions. Groups can be collapsed and expanded. Two of the groups are described below.

- **Defined** contains variable definitions at the selected node.
- **Undefined** contains variables that are not defined at the selected node.
As previously mentioned, the Variable Definitions View is a node-level view. Note how the display changes if we select a different node, specifically via the path *What is appropriate... > Use standard antibiotic > Foot saved.*

![Variable Definitions View at the Foot Saved node](image)

At the *Foot Saved* node, only two variables are defined, while others are listed in the *-- Undefined --* group.

In addition, you can now see the *--Inherited--* group that contains variable definitions that are "inherited" from nodes to the left of the selected node. The *Foot Saved* node’s immediate parent node is *Use standard antibiotic*, which has no variable definitions. Moving one more step to the left, you see the *What is the appropriate...* node (the root node), which has several variable definitions.

The Filter Text field allows you to filter the list of variable definitions to show only variable names that match the Filter Text.

The Variable Definitions View toolbar provides additional functions.

![Variable Definitions View toolbar](image)

The functions associated with the icons are presented below. Each function is described in subsequent sections.

1. Add Variable Definition
2. Edit Variable Definition
3. Delete Variable Definition
In addition, a section below describes how to edit variable definitions directly in the view's grid.

17.2.1 Add Variable

This function is used to add a new variable to the model. This function is the same as the function from the Variable Properties View.

Adding variable definitions is done within the views grid.

17.2.2 Edit Variable Definition

This function is used to edit the selected variable definition. Only one variable definition can be selected.

The Define Variable Dialog will open with the selected variable definition displayed.

![Define Variable Dialog]

Edit the variable definition in the Build Expression element and click OK to save the changes.

Note that you can select and edit an *Inherited* variable definition as well. This will edit the variable definition at the node where the definition currently exists.

17.2.3 Delete Variable Definition

This function is used to delete one or more selected variable definitions from the tree. Deleting variable definition(s) will not delete the variable(s) from the tree.

Only definitions at the currently selected node can be deleted.
To delete variable definitions in the Variable Definitions View:

- Select one or more variable definitions for the currently selected node.
- Click the "X" delete toolbar button.

### 17.2.4 Edit Variable Definitions in grid

Variable definitions can also be added or edited directly in the Variable Definition View’s grid.

For example, if you enter a new definition into one of the --Undefined-- variables, a new definition is created for that variable at the selected node.

Below is an image of the grid contents before adding a definition.

```
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Treatment</td>
<td>Antibiotics</td>
</tr>
<tr>
<td>numExpt</td>
<td>4</td>
</tr>
<tr>
<td>Antibiotics</td>
<td>501</td>
</tr>
<tr>
<td>chaAsAmpu</td>
<td></td>
</tr>
</tbody>
</table>
```

Variable Definitions View - Before adding definition

Next, a new definition for the variable cAntibiotics is typed into the grid.

```
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Treatment</td>
<td>Antibiotics</td>
</tr>
<tr>
<td>numExpt</td>
<td>4</td>
</tr>
<tr>
<td>Antibiotics</td>
<td>501</td>
</tr>
<tr>
<td>cAntibiotics</td>
<td>901</td>
</tr>
<tr>
<td>chaAsAmpu</td>
<td></td>
</tr>
</tbody>
</table>
```

Variable Definitions View - Adding definition

After the new variable definition is added, it can be seen in the --Defined-- group.

```
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Antibiotics</td>
<td>501</td>
</tr>
<tr>
<td>chaAsAmpu</td>
<td></td>
</tr>
<tr>
<td>cAntibiotics</td>
<td>901</td>
</tr>
<tr>
<td>Treatment</td>
<td>Antibiotics</td>
</tr>
<tr>
<td>numExpt</td>
<td>4</td>
</tr>
</tbody>
</table>
```

Variable Definitions View - After adding definition

Similarly, you can type a new definition into the --Defined-- group to replace the existing definition.

### 17.2.5 Cut/Copy/Paste Variable Definitions

You can cut/paste variable definitions to move them from one node to another. You can also copy/paste variable definitions to copy them from one node to another.

To cut a variable definition in the Variable Definitions View:

- Right-click on a variable definition.
- Select Cut from the context menu.

To copy a variable definition in the Variable Definitions View:

- Right-click on a variable definition.
- Select Copy from the context menu.

*To paste a variable definition:*

- Select the destination node in the Tree Diagram Editor.
- Right-click on the top row of the Variable Definitions View (refers to variables defined at the selected node).
- Select Paste from the context menu.

17.3 Defining a Variable at a Specific Node

The easiest way to define a new or existing variable at a specific node is to select the node and then right-click. This lets you define a new variable or define an existing variable at the Specific Node from the dropdown menu, as in the figure below.
Defining a variable at the “Foot saved” node by right clicking

In the figure above it indicates both cTreatment and numDays are both defined at the node selected.

To **define an existing variable at a specific node**, select the variable to define (we use "numDays" in the figure) and the Define Variable Dialog opens. The Define Variable Dialog has been used several times in this and prior chapters. Some additional information on this dialog is provided here.
The Define Variable Dialog is used to add or update a Variable Definition within the context of a specific node. It tells you the Node where you are defining a variable: in this case, *Foot saved*. The read-only Variable Info at the bottom of the dialogue is populated from the the Variable properties. The Build Expression and the Add Expression fields are described in detail in earlier chapters.

The Definition info field is free text that can be used to describe the definition itself.

Another method to *define an existing variable at a specific node* is via the Variable Definitions View. The Variable Definitions View is node specific and the information presented in this view changes depending on which node you have selected in the model. More information of the Variable Definitions View is given in the above section.

To *define a new variable at a specific node*, right-click on the node and choose Define Variable > New Variable... from the dropdown menu. This will open the Add/Change Variable or Function dialog. Note that the "Create definition at" option will default to "Selected node", which you can override to create the definition at the root node.

The Add/Change Variable or Function dialogue for defining a new variable at a specific node with the default variable definition set to "Selected node"

Another method to *define a new variable at a specific node* is via the Variable Definitions View. Once you have selected the node where you want to add a new definition, use the toolbar associated with
the Variable Definitions View and select the "+". The Add/Change Variable or Function dialogue will appear. This dialogue will be the same for both methods of adding a new variable, as shown in the figure above.

17.4 Variable Sets

You can create multiple variable sets to store different model input scenarios within a model. Each variable set contains a different set of root node variable definitions. No definitions at other nodes or other model inputs are affected by variable set selection.

We will use the Get Started tutorial example model Investment Vars.trex to examine variable sets.

Investment Vars.trex and its variable list

Note the designation of this set of root node variable definitions as **Variable Set: Default** at the right of the Variable Properties View tooobar.

To create a new variable set:

- Click the down arrow to the right of "Variable Set: Default".
- Choose the option Add/Rename Set.
- Click the "+" icon.
- Use the default name "Variable Set 2" (or provide a new name).
- Click the down arrow to the right of "Variable Set: Default".
- Choose the new variable set "Variable Set 2".

Note that nothing has changed in the model because the root node variable definitions in the new set match the ones in the original set. Once you change any variable definitions in the new set, it becomes
a separate set of definitions. If you then return to the Default set, all the variable definitions return to their prior values.

The Special Features tutorial example Investment Variable Sets already has two variable sets - Optimistic and Pessimistic. Switch between the two sets to see the payoff variables change.

**Optimistic variable set**

**Pessimistic variable set**

### 17.5 Variable Categories

You can use variable categories to help organize long lists of variable definitions in a tree. Use the Variable Properties View to create a hierarchical structure of variables via variable categories.

The categories can be used both in the display of variable definitions in the tree window (under nodes), as well as in the Variable Properties View.

We will use the Get Started tutorial example tree Three Vars as an example. We will categorize the pay_down and pay_up variables under the category "Payoffs" and the prob_extreme variable under the category "Probabilities".

**Variable Properties View**

*To create a variable category:*
- Click the "Show Categories Tree" button. The categories pane within the view will be displayed to the left of the variables list.
- Click the "plus" icon in the categories pane. A new category "Category1" will be created.
- Click the new category in the categories grid and rename it. In this case, enter "Payoffs".
- Repeat the prior two steps to create the category "Probabilities".

Variable Properties View - Categories Pane

Once the categories have been created, you can assign each variable to one or more categories by dragging the variable onto the category name to the left. You can also assign categories via Categories property category within the the Add/Change Variable Dialog using the Edit Variable function.

Add/Change Variable Dialog - Categories property category

In the figure above, the variable pay_down has been assigned to the variable category Payoffs.

The Variable Properties View then shows the categories assigned to each variable. Note that the "Group items by category" toggle icon is also depressed.

Variable Properties View - Categories assigned

You can create a hierarchical structure of variable categories by creating subcategories within other categories using the "Add sub-category" icon in the categories pane. Variables can be assigned to one or more categories, regardless of each category's position in the hierarchy. To assign variables to sub-categories, drag the variable from the main window into the subcategory. The categories and sub-
categories the variables are listed in will appear in the Category column in the main Variable Property pane.

17.5.1 Categories for other inputs

Categories are most-commonly used for variables. However, other model inputs (distributions, trackers, tables) can also be categorized in the same way.

17.5.2 Variable Category Tree Preferences

The tree’s variables display preferences allow you to display variable definitions in the model by category.

Tree Preferences - Variable Categories

When checked, the tree shows categories for variable definitions under each node. See below.

Tree showing Variable Categories
17.5.3 Variable Categories in the Variable Report

If variable categories are used in the model then the variable report will also show the categories including any subcategories, as in the Figure below.

Variable Report showing the Categories and sub-categories.

If you select to "Group items by categories" in the Variable Properties view before generating the Variable Report, the Variable Report will show the variables grouped by categories too.

17.6 Sensitivity Analysis Variable Properties

Variable Properties include information related to Sensitivity Analysis. This information is maintained in the Sensitivity Analysis category of the Add/Change Variable dialog.

Add/Change Variable dialog - Sensitivity Analysis category
The "Low value", "High value" and "Range type" properties are the defaults used when running sensitivity analysis using the specific variable. If the values are changed when running sensitivity analysis, the variable properties are automatically updated to reflect the values used for analysis.

17.7 Sensitivity analysis correlations

Correlations can be set up between any number of pairs of existing variables. When a sensitivity analysis is performed on a variable correlated to another variable, the option is presented to simultaneously vary correlated variables over their own value ranges.

To define variable correlations:
- Open the Add/Change Variable Dialog.
- Choose the Sensitivity Analysis tab.
- Select from the list of available variables.
- Click the "+ >" button for a positive correlation or the "- >" button for a negative correlation.
- Click OK to save the changes.

The linked variables will now be listed to the right of the Correlations buttons, with plus or minus symbols indicating the type of correlation. The identical correlation will show in the properties of the two correlated variables. The correlation can be modified or removed from either variable’s Properties dialog.
Add/Change Variable Dialog - Correlation

To remove a correlation:

- Open the Add/Change Variable Dialog.
- Choose the Sensitivity Analysis tab.
- Select from the list of correlated variables (the list to the right).
- Click the "<" button.
- Click OK to save the changes.

You can also click the "<<" button to remove all correlations. To change a correlation’s type (e.g., from negative to positive), you must remove the existing correlation and recreate it with the proper correlation.

Sensitivity analysis using variable correlations is described in the More Sensitivity Analysis Tools Chapter.
17.8 Variables testing tools

In addition to using TreeAge Pro’s Analysis menu commands to see the results of node calculations, TreeAge Pro also provides tools for testing individual variables.

17.8.1 Debugging variable calculations during analysis

The Calculation Trace Console can be used to report on every variable calculation during an analysis. This feature can be used to search for problems in complex formulas.

Please look at the Chapter Model Debugging and Validation for more details.

17.8.2 The Evaluator View

The Evaluator View is designed for testing variables and formulas - like a calculator. Any valid expression can be entered into the Evaluator View. The expression is calculated within the context of the currently selected node.

This Calculator/Evaluator is an Expected Value-based tool. Distributions return their mean values, and Markov counters and trackers return their default values. For calculations within the context of a Markov Cohort Analysis or Monte Carlo simulation, debugging output may be more useful.

To calculate a variable or formula at the selected node:

- Select the node at which you want to perform the calculation.
- Click on the "=" icon in the application toolbar to open and/or activate the Evaluator View.
- Enter the expression you want to calculate into the top pane of the Evaluator View.
- Click on the "Calculator" icon in the Evaluator View. The calculated value will appear in the bottom pane of the Evaluator View.

In the following model Climber Cost, from the Get Started tutorial examples, the variable Total_cost is calculated at the selected node, Amputate foot. Note that the calculated value is $24,000.
Evaluator view in action

Tree Preferences were set to show internal calculations, so the Calculation Trace Console shows the inputs that contributed to the value of Total_cost.

Note that the Evaluator View includes formula editor lookup frames to the right and also supports auto-fill.

17.9 Formula Editor

The Formula Editor in TreeAge Pro helps you create expressions consisting of variables, functions, distributions and all other quantity values in a tree. The formula editor specifically includes the option to select variables to include in your expression.
17 Working With Variables

The Formula Editor is described in detail in the Building Formulas Using Variables and Functions Chapter.

17.10 Variable Definition Arrays

Variable definitions can consist of an array of expressions that can be referenced by index. For example, you could create a variable definition like this...

\[ \text{myVarArray} = [10; 20; 30; 40] \]

Then any reference to the variable myVarArray would require an integer index value between 1 and 4, to reference one of the four expressions in the array. For example, \( \text{myVarArray}[3] \) would return the value 30.

The individual expressions within the array can reference any other variables, trackers, tables, distributions, functions, etc. However, the array cannot refer recursively to itself.

The Special Features tutorial example model, Variable Definition Array, demonstrates this technique.

![Variable Definition Array Model](image)

Note that when you look at the root node definition for varArray in the Define Variable dialog, it is automatically presented in grid format.
Define Variable Dialog in Grid mode

The "+" button adds another row to the grid. The "Flat View" button presents the variable definition as an array with the individual expressions presented together within square brackets and separated by semicolons.
17 Working With Variables

17.10.1 Using Variable Definition Arrays with Tables

Suppose you wanted to reference different complex expressions within a table. This is not possible with a table alone because tables support only numeric expressions. A variable definition array alone might not be sufficient if you wanted to be able to associate the expressions with specific lookup index values as is done with tables. However, a combination of tables and variable definition arrays provides a possible solution.

For example, let's say you wanted to use different expressions in a Markov model for different age ranges as presented below.

<table>
<thead>
<tr>
<th>Age</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-10</td>
<td>cEarly * rr1</td>
</tr>
<tr>
<td>11-20</td>
<td>cTeen * rr2</td>
</tr>
<tr>
<td>21-40</td>
<td>cAdult * rr3</td>
</tr>
<tr>
<td>41-60</td>
<td>cOldest * rr4</td>
</tr>
</tbody>
</table>

Expressions for variable array

Define Variable Dialog in Flat mode

Use the Flat mode to eliminate rows by deleting an expression and a semicolon.
You could first setup a variable definition array to cover all the individual expressions. The array is shown below in Flat view.

\[\text{myVarArray} = [\text{cEarly} \times \text{rr1}; \text{cTeen} \times \text{rr2}; \text{cAdult} \times \text{rr3}; \text{cOldest} \times \text{rr4}]\]

You could then setup a table that returns the proper variable array index for each age range (using interpolation).

<table>
<thead>
<tr>
<th>Index</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
</tr>
<tr>
<td>11</td>
<td>2</td>
</tr>
<tr>
<td>20</td>
<td>2</td>
</tr>
<tr>
<td>21</td>
<td>3</td>
</tr>
<tr>
<td>40</td>
<td>3</td>
</tr>
<tr>
<td>41</td>
<td>4</td>
</tr>
<tr>
<td>60</td>
<td>4</td>
</tr>
</tbody>
</table>

\text{myTable table data}

The expression would then use the table to determine the proper expression within the variable array as follows.

\[\text{myVarArray[ myTable[age] ]}\]
18. Building Formulas Using Variables and Functions

This chapter focuses on how to use variables to build complex formulas for any expression in the model, including payoffs, variable definitions, probabilities, etc.

The Introduction to Variables and Sensitivity Analysis Chapter covers using variables for the purposes of sensitivity analysis on parameter uncertainties in the model.

18.1 Quantity expressions in a model

Quantities must be included in a model in order to analyze the model. Some of the quantities in models are:

1. Payoffs/rewards
2. Probabilities
3. Variable definitions
4. Distribution parameters
5. Function arguments

Quantities in models

Although these quantities can be entered for as simple numbers, TreeAge Pro allows the entry of numeric expressions, consisting of any or all of the following elements.

1. Numbers
2. Variables
3. Table lookups
4. Distributions
5. Functions
6. Operators
7. Keywords

Elements of expressions

There are different reasons to use specific elements within an expression. This chapter does not discuss the reasons. Rather, this chapter focuses on how to construct simple and complex expressions.

18.2 Formula Editor

The Formula Editor is a tool to create expressions from expression elements.

Within TreeAge Pro, there are many inputs where an expression is required. In most of those inputs, you can open the the Formula Editor to help build the expression. You open the Formula editor by clicking on the "=fx" button within the expression entry. Below are a few examples using the Get Started tutorial example model Climber Cost.
Open Formula Editor from Payoff entry dialog

Once the proper expression has been built using the Formula Editor, the expression is placed back in the tree based on the original expression input from which the Formula Editor was opened.

The Formula Editor itself is split into two sections which have different elements in them.

1. **Build Expression**: The expression that is being modified by the Formula Editor.
2. **Add to Expression**: The elements to add to the expression are found here and are:
   1. **Group**: Element type to display in the Element section.
   2. **Element**: Individual item to add to the expression.
   3. "+": A button to add the selected Element to the Build Expression editor. An alternative is to double-click the left mouse key.
Formula Editor: The window tells you what you are editing, in this case “Edit Probability”

If you click on an item in the Group section, the Element section will show elements that match the selected type.

If you double-click on an item in the Element section, that item is added to the expression. Alternatively you can use the "+" button.

Click OK to close the Formula Editor and replace the original expression in the tree with the new expression from the Formula Editor.

Click Cancel to close the Formula Editor and leave the original expression in the tree unchanged.

18.3 Content-Assist

Many expressions in TreeAge Pro allow you to use the content-assist feature. Content-assist is available whenever you see the small light bulb to the left of the expression field. The figure below shows the content-assist indicator in a probability expression field within the Get Started tutorial example tree, Climber Cost.

Content-assist option in probability expression

Content-assist attempts to help you complete any partially-typed element in the expression.
To trigger content-assist:

- Select a field with content-assist enabled.
- Begin typing an element.
- Press Control + Space on the keyboard.

For example, if you click on the probability expression in the figure above, type the letter "n", then trigger content-assist, you are presented with options to complete the element starting with "n". See below.

![Using content-assist in probability expression](image)

Note that you are presented with several possible elements starting with "n" - the numDays variable from the tree and the the node and npv functions built into the software. A brief description of each available item is presented in the off-white panel. In the figure above, you can see that the variable numDays has the value 4 at this node. If you select one of the content-assist options, it becomes part of the expression.

If no text is entered prior to triggering content-assist, then all possible options are presented.

Content-assist works with any element within the expression. It is not limited to the expression as a whole.

If no prompt is entered before pressing Control + Space, you will see recently entered expressions within the list of options.

### 18.4 Function Helper

The Function Helper attempts to provide guidance on how to use built-in functions. The Function Helper is available within the Formula Editor and in most expression inputs.

In the Formula Editor, when a function is added to the expression via double-click, micro-help related to that function is immediately presented. In addition, placeholders are added as function arguments. The first argument placeholder text is selected, so you can immediately replace it with the appropriate data/expression for that argument.
Function Helper from Formula Editor

After entering the first argument, press the tab key or enter a semi-colon argument separator, and the next argument placeholder is selected for entry. This continues until all arguments are entered. Shift-tab will return to the prior argument.

If you choose a function via content-assist, the same Function Helper micro-help will appear with the argument placeholders.

If you type a function into an input field or into the formula editor, the same Function Helper micro-help will appear, but without the argument placeholders, after you enter the open parenthesis after the function name.

18.5 Summation nodes

A summation node can be used to add together the values from portions of a tree. During calculations, the expected value (EV) of a summation node is equal to the sum of the EVs of all branches.

A chance node’s EV is equal to the weighted average of its branches EVs. The summation node functions similarly except that the “weight” of each branch would be 100%.

The Legal tutorial example tree, LegalTreeSummation, illustrates the use of the summation node.
Note that the EV of the legal case if negligence is proven is the combined EV of compensatory damages and punitive damages, less legal fees. The summation node allows you to present the three value elements separately and explicitly, while combining them for the total value of winning in court.

When the tree is rolled back, you can see that the EV at the Combined damages node is equal to the sum of the EVs for its three branches.

Note that some analyses are not supported for summation nodes - specifically probability distribution graphs. You can still run Roll Back, Rankings, Sensitivity Analysis and Probabilistic Sensitivity Analysis.

Also note that summation nodes cannot be placed to the right of a Markov node.

### 18.6 User-defined python functions

User-defined functions can be created within variable definitions, using the Python script language.
User-defined functions are entered as variable definitions, using a regular variable and the Define Variable Dialog. Python functions require indenting and carriage returns, so the Define Variable Dialog window’s behavior changes slightly when it recognizes you are entering/editing a user-defined function.

Refer to the Tools and Functions for Complex Trees Chapter for more details.

18.7 Variable formula examples

This chapter will continue the tutorial on variables by explaining, in detail, the logic that dictates where variables should be defined in a tree and how variables are evaluated during tree calculations. Provided a basic understanding of how TreeAge Pro searches for variable definitions, it will become easier for you to identify the best location for each variable definition you create.

18.7.1 Building a complex cost formula

The example model used in this chapter is based on the following medical treatment scenario. The assumption is that you are evaluating a new pharmaceutical treatment used in your hospital for advanced infections in an diabetic population. Initially, the modeling of the new intervention is being done on a cost basis, looking only at foot infections.

Previously, the treatment decision was between prompt amputation of the foot, and a course of high-dose, intravenous antibiotics. The new intervention is an antibiotic that works much faster that the old drug, so you will know sooner if it is going to halt the infection and save the foot; soon enough to have complete certainty that performing an amputation below the knee will avoid any mortality risk. For this reason, the new drug has already been adopted.

However, the new drug actually halts fewer infections over its shorter course of treatment, which results in a higher number of amputations. Based on the experience of your medical center, you estimate the costs and probabilities and put them into a decision tree, shown below.

Cost Formula tree
The figure above is of the Special Features tutorial example tree, Cost Formula. As shown in the model, the original high-dose, intravenous antibiotics combined with surgical debridement (removal of tissue) offers a 65% probability of curing the infection and saving the foot. If the antibiotics do not stop the infection, there is an 15% probability of death with the remaining 85% surviving and requiring amputation at the knee.

The new, experimental antibiotic has a different set of outcomes. It has a 62.5% probability of curing the infection, with the remainder having amputation at the knee.

With the immediate amputation of the foot option, the outcome is assumed to be certain: the patient will survive. With immediate amputation of the foot, or later amputation at the knee, a prosthesis will be fitted and physical therapy will be required.

The following table contains the component costs that are used to calculate total cost for each scenario.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular antibiotic</td>
<td>$500</td>
</tr>
<tr>
<td>New antibiotic</td>
<td>$500</td>
</tr>
<tr>
<td>Inpatient cost per day*</td>
<td>$1,000</td>
</tr>
<tr>
<td>Foot amputation</td>
<td>$5,000</td>
</tr>
<tr>
<td>Foot prosthesis</td>
<td>$2,000</td>
</tr>
<tr>
<td>Loss of foot, physical therapy</td>
<td>$10,000</td>
</tr>
<tr>
<td>Leg amputation</td>
<td>$10,000</td>
</tr>
<tr>
<td>Leg prosthesis</td>
<td>$10,000</td>
</tr>
<tr>
<td>Loss of leg, physical therapy</td>
<td>$25,000</td>
</tr>
<tr>
<td>Life saving measures</td>
<td>$10,000</td>
</tr>
</tbody>
</table>

Cost formula parameters

* To calculate the basic cost of the hospital stay associated with the various scenarios, the number of inpatient days for each is also estimated and multiplied by the per diem cost.

The numeric cost payoffs specified for each outcome in the Cost Formula tree have been hand-calculated using a formula combining the appropriate costs for each particular scenario, including costs of hospitalization, drugs, surgery, prosthetics, physical therapy, and other care.

As reflected in the rolled back tree, shown on a previous page, the least costly option is to treat with the standard antibiotic. A Ranking analysis can be used to calculate the additional cost per patient of the experimental antibiotic, $3427.
18.7.2 Implementing a cost formula using variables

The baseline information may be useful in a budget impact calculations. However, you may want to analyze the model on the basis of different estimates of component costs, some of which are uncertain. To do this kind of analysis manually would be tedious, so you decide to implement the cost calculations using a cost formula and perform sensitivity analysis on the component variables.

Start by making a copy of the tree:

- Open the Special Features tutorial example tree, Cost Formula.
- Save a copy of the tree, changing the name to Cost Variables, and save it in a separate project.

To save some time, a list of definitions of the cost component variables has already been pasted into the tree, at the root node.

Open the Variable Definitions View to see these definitions:

- Select the root node.
- Choose Node > Show View > Variable Definitions from the menu.

Much of the work required to make the tree more flexible has already been accomplished. All necessary variables have been created in the tree, and each has at least one definition.

The remaining tasks to be done in the tree are:

- assign Total_Cost as the payoff of every terminal node;
- redefine the variable (i.e., not fixed) components of Total_Cost for each outcome, as necessary.

The tree below illustrates how and where to add definitions of the variables used in the Total_Cost formula (other solutions are possible, as will be seen later in this chapter). Compare the tree you have opened to the picture of the completed tree.
18.7.3 Variables with multiple definitions

Note that, in the solution, several variables have multiple definitions. Note that, in the solution, several variables have *multiple definitions*. However, with the exception of numDays, no single variable has more than one numeric definition. As a general rule, it is advisable to avoid giving a single variable more than one numeric definition – for example, to represent the probability of two or more distinct events. It is important to follow this rule if you want to be able to perform sensitivity analysis on the variable in question.

⚠️ The quantity represented by numDays, used in calculating cHospital, is not intended to be used in sensitivity analysis. If it were, separate variables would be used for each scenario.

18.7.4 Incorporate the formulas into the tree

Start by assigning the Total_Cost variable to all of the payoffs. Instead of deleting the existing numeric cost payoffs that are found in payoff #1, however, switch to payoff #2 and assign Total_Cost there.
To switch to payoff #2:

- Choose Tree > Tree Preferences from the menu or press F11.
- Navigate to the Tree Preferences category Calculation > Calculation Method > Simple.
- Change the Active payoff to 2.

All terminal nodes should now indicate that no payoff has been assigned. Now, update all the terminal nodes to use Total_Cost as the formula for payoff #2.

To change the payoffs:

- Double-click on the payoff expression next to the top terminal node.
- Enter "Total_Cost" as the expression for Payoff 2.
- Repeat for the remaining terminal nodes.

At this point, although the tree can calculate without causing errors, it will not calculate costs correctly because most of the components of Total_Cost are still defined equal to 0.

Examine the tree to see where and how variables are currently used and defined in the tree, and where definitions need to be added or modified.

To calculate the payoff of any node in the tree, TreeAge Pro must evaluate Total_Cost. To do this, it will search start searching for a definition of Total_Cost at the terminal node, and work leftward until it finds a definition. In this case, the first definition it will find is the default definition of Total_Cost from the root node, which accumulates the following components:

\[(\text{cost of inpatient care}) + (\text{cost of treatment}) + (\text{cost of prosthetic}) + (\text{cost of physical therapy})\]

The component variables cHospital, cTreatment, cProsthetic and cPhysTher need to be evaluated. TreeAge Pro restarts the search for each variable’s definition at the terminal node which is being calculated. This right-to-left search is restarted for each variable encountered in the calculation. (The same process occurs for probability formulas, with a search rooted at the branch being calculated.)

Therefore, for every path in the tree, each variable in the cost formula must have an appropriate definition. Note that for some outcomes, some components do not apply. For example, there are three terminal nodes which represent non-amputation scenarios, and which therefore have no prosthetic or therapy costs. These components should have 0 values in these paths.

Incorporate the remaining variable definitions into the model. For example, at the Amputate foot node, you will need to add three additional variable definitions (for variables cTreatment, cPhysTher and cProsthetic).

You should confirm that, when rolled back, the Cost Variables tree provides the same results as the original tree. You can test this by changing the active payoff back and forth from 1 to 2.
There are two important exceptions to the right-to-left search rule. One involves the recursive definitions of variables, which will be covered at the end of this chapter. The other exception involves the evaluation of tracker variables; refer to the Healthcare Module documentation for details.

All payoff values are set to the variable Total_Cost, but the value are different for each terminal node. Let’s examine one of the payoff calculations in detail, specifically at the Amputate foot node.

The Variable Definitions View for the node shows all the definitions we need to calculate the value of Total_Cost.

```
<table>
<thead>
<tr>
<th>Defined</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>cPhysTher</td>
<td>cFootPhys</td>
</tr>
<tr>
<td>cFootAmpu</td>
<td>cFootProsth</td>
</tr>
<tr>
<td>Treatment</td>
<td>cFootAmpu</td>
</tr>
<tr>
<td>numDays</td>
<td></td>
</tr>
<tr>
<td>Undefined</td>
<td></td>
</tr>
</tbody>
</table>
```

Variable definitions at Amputate foot node

Based on the right-to-left lookup rule, Total_Cost is first defined at the root node.

\[
Total\_Cost = cHospital + cTreatment + cProsthetic + cPhysTher
\]

In order to do that calculation, the individual components need to be calculated based on their closest definitions.

\[cHospital = c\text{PerDiem} \times numDays = 1,000 \times 7 = 7,000\]

\[cTreatment = c\text{FootAmpu} = 5,000\]

\[cProsthetic = c\text{FootProsth} = 2,000\]
cPhysTher is calculated from its definition at the current node, which in turn requires a definition of cFootPhys from the root node.

\[ c\text{PhysTher} = c\text{FootPhys} = 10,000 \]

Now we can see the full calculation of the Total_Cost value.

\[ Total\_Cost = 7,000 + 5,000 + 2,000 + 10,000 = 24,000 \]

If you run roll back and check the payoff at the Foot amputated node, the value is $24,000.

18.8 Using mathematical, statistical, and other functions

TreeAge Pro includes a wide variety of functions which make it easier to perform some commonly-used mathematical operations, or in some cases to provide access to special features in TreeAge Pro.

- TreeAge Pro’s built-in functions are case-insensitive, with the name followed by parentheses, and in most cases take arguments in the parentheses.
- Functions that have multiple arguments must use semicolon (“;”) separators.
- In most cases, any valid expression can be used as an function argument (with the exception of MatrixMult).
- In the tree window, use the Formula Editor for help in assigning the correct parameters to each functions.
- Functions which here indicate an argument named “LIST” take a flexible number of arguments. For example, Average( ) returns the arithmetic mean of all of its arguments, so Average(1;4;8;13) = 6.5.
- To test a function, use the Calculator/Evaluator tool described in Chapter 13.
- The Distributions Chapter covers a special set of functions used in Monte Carlo simulation.
- The Excel Linking Chapter covers a special set of functions that take text string arguments, instead of numeric or variable expressions.
The Markov Modeling Tools Chapter covers a special set of functions used in Markov modeling, for example in calculating transition probabilities.

**Notes on using functions in formulas**

### 18.9 Arithmetic functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abs(x)</td>
<td>Absolute value of x</td>
</tr>
<tr>
<td>Average(LIST)</td>
<td>Arithmetic mean of a LIST of values/expressions</td>
</tr>
<tr>
<td>Ceiling(x)</td>
<td>Smallest integer greater than or equal x</td>
</tr>
<tr>
<td>Exp(x)</td>
<td>“e” to the xth power</td>
</tr>
<tr>
<td>Floor(x)</td>
<td>Greatest integer smaller than x</td>
</tr>
<tr>
<td>GammaFn(x)</td>
<td>(n-1)! for integers less than 19; Stirling's approximation otherwise. For factorial use GammaFn(x+1)</td>
</tr>
<tr>
<td>Int(x)</td>
<td>Integer component of x</td>
</tr>
<tr>
<td>Ln(x)</td>
<td>Natural (base “e”) logarithm of x</td>
</tr>
<tr>
<td>Log(x)</td>
<td>Base 10 logarithm of x</td>
</tr>
<tr>
<td>Max(LIST)</td>
<td>Maximum, or highest value, of a LIST</td>
</tr>
<tr>
<td>Min(LIST)</td>
<td>Minimum, or lowest value, of a LIST</td>
</tr>
<tr>
<td>Modulo(x; y)</td>
<td>Remainder of x divided by y</td>
</tr>
<tr>
<td>Prod(LIST)</td>
<td>Product of a LIST</td>
</tr>
<tr>
<td>Root(x; y)</td>
<td>yth root of x</td>
</tr>
<tr>
<td>Round(x)</td>
<td>x rounded to the nearest integer</td>
</tr>
<tr>
<td>Round(x; y)</td>
<td>x rounded to the number of decimal places specified by y</td>
</tr>
<tr>
<td>Sqrt(x)</td>
<td>Square root of x</td>
</tr>
<tr>
<td>Stdev(LIST)</td>
<td>Standard deviation of a LIST of numbers</td>
</tr>
<tr>
<td>Sum(LIST)</td>
<td>Sum of a list</td>
</tr>
</tbody>
</table>

**Arithmetic functions**

In the arithmetic functions, “e” represents the base of the natural logarithm (approximately 2.718.)
### 18.10 Financial/discounting functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annuity(rate; periods)</td>
<td>To calculate the net present value of a series of equal future payments, multiply this function times the amount of a single payment.</td>
</tr>
<tr>
<td></td>
<td>( (1 - (1 + rate)^{-periods})/rate )</td>
</tr>
<tr>
<td>Compound(rate; periods)</td>
<td>Returns the compound interest rate (effective yield) at a fixed rate over a fixed number of periods. If used as a multiplier, this function can be used to calculate future value; if used as a divisor, it can be used to calculate discounted, present value.</td>
</tr>
<tr>
<td></td>
<td>( (1 + rate)^{periods} )</td>
</tr>
<tr>
<td>Discount(value; annual_rate; time_period)</td>
<td>Discounts a specific value (cost or utility) to account for the discounting of the present value of future values.</td>
</tr>
<tr>
<td></td>
<td>( util / ((1 + rate)^{time}) )</td>
</tr>
<tr>
<td></td>
<td>The value is the value to be discounted. The annual_rate is the annual discount rate. The time_period is the future time when the value is applied in the model in years. Note in a Markov Model the time_period is usually a function of <em>stage</em>.</td>
</tr>
<tr>
<td>DiscountCont(util; rate; time_start; time_end)</td>
<td>Discounts a specific value (cost or utility) at the specified rate on a continuous basis for DES models. DiscountCont requires that you provide the start and end time in years. DiscountContDES uses the defaults of _prior_time and _time for the start and end time. This only works correctly if the time measurement is annual.</td>
</tr>
<tr>
<td>DiscountContDES(util; rate)</td>
<td></td>
</tr>
<tr>
<td>FV(pmt; pv; rate; payments)</td>
<td>Returns the future value of a series of equal, periodic payments. The “pv” parameter represents an initial payment.</td>
</tr>
<tr>
<td></td>
<td>( [pmt * ((1 + rate)^{payments} - 1)]/rate + pv * (1 + rate)^{payments} )</td>
</tr>
<tr>
<td>NPV(rate; LIST of flows)</td>
<td>Returns the net present value of periodic cash flows, discounted.</td>
</tr>
<tr>
<td></td>
<td>( (f_i/(1 + rate)^{i}) )</td>
</tr>
<tr>
<td>PMT(principal; rate; term)</td>
<td>Returns the size of equal, periodic payments required to pay off a loan, given the principal, interest rate, and term of the loan.</td>
</tr>
<tr>
<td></td>
<td>( principal * (rate/(1 - (1 + rate)^{-term})) )</td>
</tr>
<tr>
<td>PV(pmt; fv; rate; payments)</td>
<td>Returns the present value of equal, periodic payments at a fixed interest rate. The “fv” parameter represents a final payment.</td>
</tr>
<tr>
<td></td>
<td>( [pmt * (1 - (1 + rate)^{-payments})]/rate + fv/((1 + rate)^{payments}) )</td>
</tr>
<tr>
<td>Function</td>
<td>Explanation</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UtilDiscount()</td>
<td>Obsolete. See Discount(), above.</td>
</tr>
</tbody>
</table>

**Financial/discounting functions**

In functions, a “rate” argument can be entered as either a percent or a decimal. For example, eight percent can be represented as either “8%” or “.08,” but not simply as “8.” Do not enter a very small percentage as “.08%”. However, it is OK to enter “0.08%”. References to periods/payments specifically mean the number of periods/number of payments.

### 18.11 Miscellaneous functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bilink(index)</td>
<td>Returns the value associated with a dynamic link. Refer to the Excel Linking Chapter.</td>
</tr>
<tr>
<td>BranchProb()</td>
<td>Returns the calculated branch probability for the node being calculated. Unlike PathProb(), this function only includes the probability at the specific branch node.</td>
</tr>
<tr>
<td>Choose(index;LIST of values)</td>
<td>Returns a value based on its location in the LIST, as specified by the index. The index must be a positive integer; an error is reported for fractional or out-of-range values. For example, “Choose(2;100;200;300)” returns 200, because the index is 2, and 200 is the second value in the list. This function can often be used to replace complex nested If functions.</td>
</tr>
<tr>
<td>erf(x)</td>
<td>Error function, also known as Gauss error function for a given value of x.</td>
</tr>
<tr>
<td>If(condition; trueval; falseval)</td>
<td>Evaluates a condition and returns “trueval” if the condition is true or “falseval” if the condition is false. For example, “If(x&lt;0;50;75)” would return 50 if x were negative and 75 if x were non-negative.</td>
</tr>
<tr>
<td>Inf()</td>
<td>Returns infinity (#). Although no arguments are accepted, you must type the left and right parentheses.</td>
</tr>
<tr>
<td>Link(index)</td>
<td>Returns the value associated with a DDE link. See Bilink() above.</td>
</tr>
<tr>
<td>Pi()</td>
<td>Returns #, or approximately 3.1416.</td>
</tr>
<tr>
<td>PathProb()</td>
<td>Returns the cumulative path probability for the node being calculated. In a Markov subtree, PathProb() returns the cumulative path probability from the Markov state to the node being calculated. In a non-Markov tree, you can use this function to calculate the percentage of an overall cohort that reaches a specific node.</td>
</tr>
</tbody>
</table>
Function | Explanation
---|---
Probit(x) | Calculates the inverse of the cumulative distribution function of the standard normal distribution (mean 0, standard deviation 1) for a given probability x. Also known as a quantile function.
StateProb(A; B) | Returns the state probability of one or more states at the start of the current cycle. Refer to the Markov Modeling Tools Chapter for details on this Markov modeling function.
Sub(index) | Obsolete. See Bilink() and Link(), above.

**Miscellaneous functions**

*Choose() function tip:* Performing a sensitivity analysis on a variable used as the index of the Choose() function, from 1 to the number of list items, can show the impact on calculations of the different values specified in the list.

*Nesting functions:* All functions can be nested. The If( ) function is frequently used nested within another If( ) function call. This is because the If( ) function tests for one condition, and can return either of two values, normally. However, by using another If( ) function as one of the return values, it is possible to perform two tests and return any of three values (and so on).

*String functions:* The Tools and Functions for Complex Trees Chapter covers a special set of functions that take text string arguments, instead of numeric or variable expressions.

*Markov functions:* The Markov Modeling Tools Chapter covers a special set of functions used in Markov modeling, for example in calculating transition probabilities.

### 18.12 Using mathematical, statistical, and other functions

- TreeAge Pro’s built-in functions are case-insensitive, with the name followed by parentheses, and in most cases take arguments in the parentheses.
- Functions that have multiple arguments must use semicolon (";") separators.
- In most cases, any valid expression can be used as an function argument (with the exception ofMatrixMult).
- A separate section at the end of the chapter covers the special set of functions that take text string arguments, instead of numeric or variable expressions.
- Functions which here indicate an argument named "LIST" take a flexible number of arguments. For example, Average( ) returns the arithmetic mean of all of its arguments, so Average(1;4;8;13) = 6.5.
- In the tree window, use the Function Helper (see Chapter 13) for help in assigning the correct parametersto each functions. The functions are described
18.13 Recursive variable definitions

A recursive variable definition means a definition in which the variable being defined also occurs in the definition. Recursive definitions can be an effective way to build complex cost formulas, like those in the Cost Variables tree. Rather than creating one or more long formulas, you can gradually build the formula, adding components as events occur in each particular scenario.

18.13.1 How recursive definitions work

During calculation of a probability, payoff, or Markov reward, when the standard right-to-left search for a definition of a particular variable (e.g., “costX”) first locates a definition (e.g., “costX=1,000”), TreeAge Pro stops looking for additional definitions of that variable. However, when the first definition TreeAge Pro encounters in the search is a self-referential, recursive definition (e.g., “costX=costX+1,000”), the variable (e.g., “costX”) is flagged as a recursive variable, and TreeAge Pro continues searching for additional definitions of that variable to the left of the node where the first, recursive definition was found.

Open the Special Features tutorial example tree Recursive Variables, shown below, to see an example of this process.

Recursive Variables model

All payoffs in the tree reference the same variable, costX, which has no default definition. The decision node’s topmost subtree, labeled Good Recursion, illustrates a valid recursive definition. When calculating the payoff of the first terminal node in the Good Recursion subtree, labeled High, the normal,
right-to-left search for a definition of costX finds the self-referential definition costX=costX+10 at that terminal node.

For the purposes of the current terminal node payoff calculation, costX is now identified as a recursively defined variable. The search for additional definitions of costX is now continued one node to the left, at the Good Recursion node. There, the non-recursive definition costX=10 is found, the search is complete, and the payoff calculation can be carried out.

Select the terminal node labeled High in the Good Recursion subtree, and choose Analysis > Expected Value. The calculated value is 20.

A non-recursive definition of the recursive variable, like costX=10 at the Good Recursion node, must eventually be found; definitions can’t be infinitely recursive.

Look at the second branch of the decision node, labeled Bad Recursion. In this subtree, when either terminal node’s payoff is evaluated, TreeAge Pro’s variable definition search locates a recursive definition. In both cases, the search for additional definitions is started one node to the left, at the Bad Recursion node. No non-recursive definition of x has been made there or at the root node. Therefore, if you try to calculate the Bad Recursion subtree, an error message will be shown. To see this, select the Bad Recursion node or either of its terminal nodes and choose Analysis > Expected Value command.

Multiple recursions, using a series of recursive definitions of a variable, will work, as shown in the Multiple Recursion subtree. Simply ensure that a numeric definition of the recursive variable will eventually be found. For example, in calculating the payoff of the terminal node labeled Middle in the Multiple Recursion subtree, the variable definition search locates the recursive definitions costX=costX+10 and costX=costX+5, and finally the non-recursive definition costX=0. Thus, the calculated value of the Middle terminal node is 15.

18.13.2 Complex recursion

Other variables may be referenced in a recursive definition. To see how TreeAge Pro’s variable definition search works with a combination of recursive and non-recursive variables, open the tutorial example tree “Multi-Variable Recursion”.
Multi-Variable Recursion

To better explain this complex example, the text will illustrate the incremental changes in the payoff calculation formula during TreeAge Pro’s variable definition search.

All payoffs in the Multi Variable Recursion tree use the same variable, costX (payoff = costX). When the terminal node labeled Z is evaluated, the variable definition search finds the recursive definition costX = costX + costZ at the terminal node (payoff = costX + costZ).

Before a recursive search for costX is continued one node to the left, TreeAge Pro looks for a definition for costZ. The variable costZ is evaluated as a normal variable, which means that the search for a definition of costZ is started at the node being calculated, the terminal node Z. A normal right-to-left search locates the non-recursive definition costZ = 1000 at the root node (payoff = costX + 1000).

The recursive search for additional definitions of costX is then continued at the Low Y chance node, which is one node to the left of the node where the initial, recursive definition of costX was found. Another recursive definition, costX = costX + costY, is found at the chance node labeled Y (payoff = [costX + 1000] + costY).

As above, before the recursive search continues, a normal variable definition search for costY is initiated at the terminal node being calculated, Z. At the chance node Low Y, the non-recursive definition costY = 200 is located (payoff = [costX + 1000] + 200).

TreeAge Pro proceeds with the search for additional definitions of costX, starting at the root node. A non-recursive definition of costX is required, and found: costX = 100. The final payoff formula for node Z, therefore, is [100 + 1000] + 200. Calculating an expected value for the Z terminal node returns the value 1300.

Before using complex recursion in your models, it is important that you be thoroughly familiar with the logic underlying both standard and recursive variable definitions in TreeAge Pro. You are also urged to test your model to make sure it appears to be calculating correctly.

In summary, the payoff value is costX ...

\[ \text{payoff} = \text{costX} \]
Based on the recursive definition at node Z, the expression changes to...

\[ \text{payoff} = \text{cost}X + \text{cost}Z \]

Substituting in the recursive definition for \text{cost}X at node Y, the expression changes to...

\[ \text{payoff} = (\text{cost}X + \text{cost}Y) + \text{cost}Z \]

Now the right-to-left definitions for each variable can be resolved...

\[ \text{payoff} = 100 + 200 + 1,000 = 1,300 \]

The expected value at node Z is, in fact, 1,300.

18.14 Operators

Mathematical expressions used in TreeAge Pro necessarily contain operators (such as addition or multiplication signs). This section describes operators available in creating expressions.

18.14.1 Arithmetic operators

These operators perform arithmetic on the values that surround them. TreeAge Pro uses the traditional syntax for expressions, known as infix notation. For example, an expression that adds three and seven would be written 3 + 7, rather than 3, 7 +.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>x + y</td>
<td>Addition. Returns the sum of x and y.</td>
</tr>
<tr>
<td>-</td>
<td>x - y</td>
<td>Subtraction. Returns the difference between x and y. (Also used for negation, i.e., to denote negative numbers.)</td>
</tr>
<tr>
<td>*</td>
<td>x * y</td>
<td>Multiplication. Returns the product of x and y.</td>
</tr>
<tr>
<td>/</td>
<td>x / y</td>
<td>Division. Returns the quotient of x and y.</td>
</tr>
<tr>
<td>^</td>
<td>x ^ y</td>
<td>Exponentiation. Returns x to the yth power.</td>
</tr>
<tr>
<td>()</td>
<td>x * (y+z)</td>
<td>Grouping. Returns the product of x and the sum of y and z.</td>
</tr>
</tbody>
</table>

Arithmetic operators

18.14.2 Relational operators

These operators return a true or false value, depending on the veracity of the expression in which they appear. A true value is represented by a numeric 1, a false value receives a numeric value of 0. Relational operators are useful in many settings: in If() and Choose() functions, in expressions evaluated at logic nodes, and in a Markov termination condition.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>x &lt; y</td>
<td>Less than. Returns true if x is less than y, and false if x is greater than or equal to y.</td>
</tr>
</tbody>
</table>
18 Building Formulas Using Variables and Functions

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;=</td>
<td>x &lt;= y</td>
<td>Less than or equal to. Returns true if x is less than or equal to y, and false if x is greater than y.</td>
</tr>
<tr>
<td>&gt;</td>
<td>x &gt; y</td>
<td>Greater than. Returns true if x is greater than y, and false if x is less than or equal to y.</td>
</tr>
<tr>
<td>&gt;=</td>
<td>x &gt;= y</td>
<td>Greater than or equal to. Returns true if x is greater than or equal to y, and false if x is less than y.</td>
</tr>
<tr>
<td>=</td>
<td>x = y</td>
<td>Equals. Returns true if x equals y, and false if x is not equal to y.</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>x &lt;&gt; y</td>
<td>Not equal to. Returns true if x is not equal to y, and false if x equals y.</td>
</tr>
</tbody>
</table>

Relational operators

It is also possible, using the appropriate relational expression syntax, to test one value in terms of two others. There are a number of acceptable forms, with the two basic ones being:

- `y < x < z` - Returns true if x is both (a) greater than y and (b) less than z.
- `y > x > z` - Returns true if x is both (a) less than y and (b) greater than z.

Other valid forms of this syntax can be created by substituting ">=" for ">" or "<=" for "<" (for example, expressions of the form "y <= x < z" and "y >= x >= z" are valid). These are the only valid substitutions, though (for example, expressions of the form "y < x > z" are not valid). Failure to follow these rules when creating relational expressions of this kind will likely result in unintended calculation results.

18.14.3 Logical operators

Three logical operators are also available: logical AND, logical (inclusive) OR, and logical NOT.

AND is represented by the ampersand (&), OR by the vertical bar (|), and NOT by the exclamation mark (!). Like the relational operators (which return 1 if a comparison is true and 0 if not), these logical operators are zero-centric. That is, any operand that is non-zero is treated as true, and only a zero operand is treated as false. The returned value is 1 if the evaluation is true, and 0 if false.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;</td>
<td>w&lt;x &amp; y&lt;z</td>
<td>Logical AND. Returns true if w is less than x AND y is less than z.</td>
</tr>
<tr>
<td></td>
<td>w&lt;x</td>
<td>y&lt;z</td>
</tr>
<tr>
<td>!</td>
<td>!(w&lt;x)</td>
<td>Logical NOT. Returns true if w is not less than x.</td>
</tr>
</tbody>
</table>

Logical operators
18.14.4 Operator precedence

In most situations, you will not need to know the details of which operators bind most tightly. However, when formulas do not appear to calculate correctly, you should check this section to see if precedence is a factor.

Operator precedence is how TreeAge Pro decides where you intended to put parentheses. Consider the following example:

\[ A + B \times C + D \]

A quick check of the precedence list below indicates that multiplication has higher precedence (binds more tightly) than addition. TreeAge Pro will therefore interpret your expression as:

\[ A + (B \times C) + D \]

This process is continued until all uncertain bindings are resolved.

The table below lists the operators available in TreeAge Pro in order of precedence. Operators with higher precedence will bind more tightly. Adjacent operators having the same precedence value will be applied from left to right.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Character</th>
<th>Precedence Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unary minus</td>
<td>-</td>
<td>8</td>
</tr>
<tr>
<td>Logical NOT</td>
<td>!</td>
<td>8</td>
</tr>
<tr>
<td>Exponent</td>
<td>^</td>
<td>7</td>
</tr>
<tr>
<td>Multiplication</td>
<td>*</td>
<td>6</td>
</tr>
<tr>
<td>Division</td>
<td>/</td>
<td>6</td>
</tr>
<tr>
<td>Addition</td>
<td>+</td>
<td>5</td>
</tr>
<tr>
<td>Subtraction</td>
<td>+</td>
<td>5</td>
</tr>
<tr>
<td>Comparators</td>
<td>&lt;, &lt;=, etc.</td>
<td>4</td>
</tr>
<tr>
<td>Logical AND</td>
<td>&amp;</td>
<td>3</td>
</tr>
<tr>
<td>Logical OR</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parentheses, Brackets</td>
<td>() , []</td>
<td>1</td>
</tr>
<tr>
<td>Functional argument separator</td>
<td>;</td>
<td>1</td>
</tr>
</tbody>
</table>

**Operator precedence**

Notice that parentheses are at the bottom of the list. This simply means that the operators inside the parentheses will bind tightly to stay within the parentheses. They are your most useful tool for indicating your particular precedence requirements.
## 18.15 Keywords

Keywords are reserved values auto-generated by TreeAge Pro that can be accessed within your model.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_stage</td>
<td>Markov cycle counter (starts with 0)</td>
</tr>
<tr>
<td>_tunnel</td>
<td>Markov cycle-in-state counter (starts with 1), requires state to be configured with tunnel max value</td>
</tr>
<tr>
<td>_state_index</td>
<td>Index for the Markov state counting down from the top (top state is 1, next down is 2, etc.)</td>
</tr>
<tr>
<td>_strategy</td>
<td>Returns the number of the strategy, defined as a branch directly coming from a decision node (numbered top to bottom). The value is undefined to the left of the first decision node or if the model has no decision node.</td>
</tr>
<tr>
<td>_trial</td>
<td>Index for the trial/iteration being processed in the Microsimulation loop of a simulation (always 1 when not running Microsimulation)</td>
</tr>
<tr>
<td>_trial_size</td>
<td>Number of trials/iterations for the Microsimulation loop</td>
</tr>
<tr>
<td>_sample</td>
<td>Index for the sample/iteration being processed in the sampling/PSA loop of a simulation (always 1 when not running PSA)</td>
</tr>
<tr>
<td>_sample_size</td>
<td>Number of samples/iterations for the PSA simulation loop</td>
</tr>
<tr>
<td>_voi_sample</td>
<td>Index for the value of information (VOI) iteration being processed, the outer most simulation loop in EVPPI analysis (always 1 when not running EVPPI)</td>
</tr>
<tr>
<td>_voi_sample_size</td>
<td>Number of iterations for the outer most simulation loop in EVPPI analysis</td>
</tr>
<tr>
<td>_node_id</td>
<td>Returns the numeric identifier for a specific node</td>
</tr>
<tr>
<td>_node_label</td>
<td>Returns the label for a specific node</td>
</tr>
<tr>
<td>_thread_index</td>
<td>Index for the thread which is running all or a portion of the overall simulation (simulations can run as multiple threads to increase the speed of the simulation)</td>
</tr>
<tr>
<td>_parallel_trials_clock</td>
<td>The current _clock value during a parallel trials discrete event simulation that uses the _CLOCK value to keep the trials synchronized.</td>
</tr>
<tr>
<td>_parallel_trial_creator</td>
<td>If you turn off probability coherence, you can create individuals in a parallel trials simulation. This keyword can be used by a new trial to get the number of the trial that created it (i.e., via a transition/chance event with non-coherent probs).</td>
</tr>
<tr>
<td>_parallel_trials_set</td>
<td>The index for the current set of parallel trials.</td>
</tr>
<tr>
<td>_parallel_trials_sets_size</td>
<td>The number of sets of parallel trials in the simulation.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>_cache_level</td>
<td>When using the Node() function to access parts of the tree, this returns the “depth” of the calls from nested Node() functions.</td>
</tr>
</tbody>
</table>

**TreeAge Pro Keywords**
19. More Sensitivity Analysis Tools

The last 3 chapters provided detailed instructions on representing uncertain values using variables and performing one-way sensitivity analysis. This chapter covers sensitivity analysis options, multi-way sensitivity analysis, and special variations on one-way sensitivity analysis.

19.1 Analyzing variables with multiple definitions

While first learning how to use variables, it is not uncommon to unintentionally end up with a variable defined numerically at multiple nodes. While there are good reasons why TreeAge Pro allows the same variable to be defined at multiple nodes — as described in prior chapters — this situation is usually neither necessary or desirable with a variable intended for sensitivity analysis, as it may result in errors.

> It is strongly recommended that sensitivity analysis be limited to parameters defined at the root node with a numeric value. Variables that are defined by other variables, functions, etc. or that are defined at multiple nodes are generally not good candidates for sensitivity analysis. It is almost always possible to restructure variable definitions in such a way that the variable in question can be isolated as a numeric value at the root node.

We recommend that you avoid running sensitivity analysis on a variable with multiple definitions. However, this technique is shown for illustration only. If you must run sensitivity analysis on a variable with multiple definitions, you must specify which definitions should be used/changed within the sensitivity analysis.

We will look at running sensitivity analysis on the Get Started tutorial example tree, Climber Cost, specifically on the variable `numDays`.
Climber Cost tree

Note that there are several definitions for the variable numDays. You might want to run sensitivity analysis specifically on the number of days in the hospital associated with leg amputation. In such a case, you would only want to use the numDays variable definitions at the two nodes labeled Leg amputated.

A better and safer way to achieve this result would be to define separate numeric parameters numDaysLegAmpu, numDaysFootAmpu, etc. at the root node. Then you could set the generic numDays variable equal to the appropriate numeric parameter at different nodes in the tree. Then you could run sensitivity analysis on the specific numeric parameter in question.

After selecting the variable numDays for sensitivity analysis in the One-Way Sensitivity Analysis Setup Dialog, click on the ellipse in the Definitions column.
Sensitivity analysis setup dialog

You are then presented with another dialog to select the specific nodes where you want the variable definitions used for sensitivity analysis.

Sensitivity analysis setup - select nodes

Note that only the two Leg amputated nodes are selected. When sensitivity analysis runs, only the definitions at those two nodes will be altered.

19.2 Tornado diagrams

Tornado diagrams study the impact of any number of individual parameters, then present them together in a single analysis. Essentially, it is a consolidated set of one-way sensitivity analyses.

As a reminder from previous chapters, any variable which is defined at the root node as a fixed value or parameter distribution, is a valid choice for sensitivity analysis. There are examples of the warning/error messages which you will receive if you choose an invalid parameter for sensitivity analysis.

In the graph, a horizontal bar is generated for each variable being analyzed. Expected (or incremental) value is displayed on the horizontal axis, so each bar represents the selected node’s range of expected (or incremental) values generated by varying the related variable. A wide bar indicates the associated variable has a large potential effect on the expected value of your model (given the range provided for each variable).
The graph is called a tornado diagram because the bars are arranged in order, with the variable with the biggest impact at the top and the variable with the smallest impact at the bottom, resulting in a tornado-like appearance.

- Tornado diagrams were improved in the 2017 R2.0 release. This section refers to Tornado diagrams in versions of the software after and including 2017 R2.0. For editing Tornado Diagrams in versions prior to 2017 R2.0 refer to both sections Cost Effectiveness Tornado Diagrams (Legacy) and Customizing Tornado Diagrams (Legacy).

- This section considers Tornado diagrams for models using the Simple Calculation Method. For Cost-Effectiveness models, refer to Sensitivity Analysis on Cost-Effectiveness Models.

The Business Tutorial example tree, Airline Problem, is used to generate a tornado diagram. The model uses the Simple Cost Calculation method and each of the inputs may be varied to see how it affects the expected value.

Airline Problem Tree

To create a tornado diagram:

- Select the decision node.
- Choose Analysis > Sensitivity Analysis > Tornado Diagram. OR select the Run Tornado Diagram icon in the tool bar (in Analyze mode).
- In the Tornado Diagram setup dialog, select each variable to analyze and enter the variable's low and high values and intervals (see figure below).
- If model calculations requires Microsimulation, check the box "Run microsimulation rather than EV". This is unlikely for non-healthcare models.
- Click OK to start the analysis.
Tornado diagram setup

You will receive a warning if the variable you have selected for Sensitivity Analysis is not a variable defined at the root node and a variable defined as a number or as a distribution. You will receive a warning if you select a variable that does not appear to be a parameter. See figures below.

Warning if any of the variables selected for Tornado Analysis are not a variable defined at the root node

Warning if the any of the variables selected for Tornado Analysis are not a constant or a distribution (i.e., Total_Cost, Total_Revenue)

The option to choose the Tornado diagram based on the Rewards or Incremental Rewards will be show, as in the figure below. We will examine both.
Choose the appropriate Report Option to present the Tornado Diagram as either Reward or Incremental Reward.

19.2.1 Reward Tornado

Select Reward, then click Open Report. The Tornado Diagram with the Reward report options for the Airline decision is shown below.

There are three areas in the Tornado graph editor, which we will describe in detail:

- The Tornado Diagram and text report
- The Chart Settings (on the left-hand side)
- Secondary reports (Actions) (on the right-hand side)

The bars on the Tornado graph represent individual one-way sensitivity analysis performed at the selected node for each variable. The tornado diagram includes a vertical dotted line indicating the expected value. You can use this as a visual fulcrum, to view the impact of each variable relative to the original (baseline) expected value.

Tornado diagrams can be created at chance nodes and decision nodes. At a decision node, any threshold (i.e., change in strategy) will be identified in a variable’s tornado bar with a heavy vertical line. Threshold lines are drawn at the expected value on the x-axis at which the optimal path changes. Note the heavy vertical line at the left end of the Cap_Sched bar of the Tornado Diagram (top bar on the left-hand-side). This indicates a change in strategy to the Money Market strategy as the Expand Airline strategy value drops below the value of the Money Market strategy (optimal is the highest value). Since the Money Market strategy is fixed at $4,200, none of the bars can extend lower than that.

The heavy vertical line indicating a strategy change can be turned on and off via the Chart Settings, checking the box 'Show Thresholds'.

If a threshold appears at either end of a bar, this usually indicates that an alternative which is optimal for part of the analysis range has an unchanging expected value in that range. More details about the change in strategy indicated by the threshold line can be seen from the corresponding One-Way Sensitivity Analysis graph, which can be opened via the links.

To better understand the threshold for the Hours Flown parameter, click on the One-Way Sensitivity Analyses secondary report for "Hours flown" to generate the following graph.
One-Way Sensitivity Analysis on Hours Flown

Since the tornado diagram only shows the optimal strategy (highest value), the bar's low end is at the
Expected Value of 4,200 where there is a strategy change.

If you click on the Tornado Text Report link to the right of the Tornado graph (in the Actions section),
you will see the input and output range for each parameter.

Tornado Text Report

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Variable Description</th>
<th>Variable Low</th>
<th>Variable High</th>
<th>Low</th>
<th>High</th>
<th>Spread</th>
<th>Spread %</th>
<th>Risk %</th>
<th>Cum Risk %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cap_Sched</td>
<td>Capacity on scheduled flights</td>
<td>0.4</td>
<td>0.6</td>
<td>400</td>
<td>2000</td>
<td>1600</td>
<td>0.425</td>
<td>0.425</td>
<td>0.425</td>
</tr>
<tr>
<td>Charter_Price</td>
<td>Charter price/hour</td>
<td>0.2</td>
<td>0.8</td>
<td>400</td>
<td>2000</td>
<td>1600</td>
<td>0.425</td>
<td>0.584</td>
<td>0.584</td>
</tr>
<tr>
<td>Charter_Ratio</td>
<td>Ratio of charter to scheduled flights</td>
<td>0.5</td>
<td>1.0</td>
<td>400</td>
<td>2000</td>
<td>1600</td>
<td>0.425</td>
<td>0.727</td>
<td>0.727</td>
</tr>
<tr>
<td>Hours_Flown</td>
<td>Hours flown</td>
<td>50.02</td>
<td>1000</td>
<td>400</td>
<td>2000</td>
<td>1600</td>
<td>0.425</td>
<td>0.858</td>
<td>0.858</td>
</tr>
<tr>
<td>Ticket_Price</td>
<td>Ticket price/hour</td>
<td>1.0</td>
<td>10</td>
<td>400</td>
<td>2000</td>
<td>1600</td>
<td>0.425</td>
<td>0.966</td>
<td>0.966</td>
</tr>
<tr>
<td>Insurance</td>
<td>Insurance</td>
<td>1.0</td>
<td>10</td>
<td>400</td>
<td>2000</td>
<td>1600</td>
<td>0.425</td>
<td>0.966</td>
<td>0.966</td>
</tr>
<tr>
<td>PctFinanced</td>
<td>Percent financed</td>
<td>0.3</td>
<td>0.5</td>
<td>8960.75</td>
<td>10081.25</td>
<td>1425</td>
<td>0.234</td>
<td>0.997</td>
<td>0.997</td>
</tr>
<tr>
<td>Interest_Rate</td>
<td>Interest rate</td>
<td>0.155</td>
<td>0.13</td>
<td>9450</td>
<td>10325</td>
<td>875</td>
<td>0.000</td>
<td>1.000</td>
<td>1.000</td>
</tr>
<tr>
<td>Price</td>
<td>Purchase price</td>
<td>83000</td>
<td>80000</td>
<td>9450</td>
<td>10325</td>
<td>875</td>
<td>0.000</td>
<td>1.000</td>
<td>1.000</td>
</tr>
</tbody>
</table>

Tornado Diagram Text Report

The variable range columns (Variable Low and Variable High) show the range you entered for each variable. The Low and High columns show the lowest and highest expected value for the cost (in this model) based on the optimal strategy at each point. Note that none of the values in the low value can reach below $4,200, since that is the fixed value for the Money Market strategy.

The Tornado Diagram Text Report also includes:

- **Spread**: This is the width of the bar (i.e., High EV minus Low EV).
- **Spread^2**: The spread value, squared. Adding the Spread^2 values to calculate a net risk value, two additional measures of uncertainty are then calculated for each variable: Risk % and Cumulative Risk%.

- **Risk %**: This is a measure of how much of the total uncertainty is represented by the specified bar (equal to: Spread^2 / NetRisk). The Risk% values sum to 1.0 across all the variables.

- **Cum Risk %**: A cumulative version of Risk %, making it easy to scan the bars and say “to address 90% of the risk, I must consider the uncertainty represented by the following variables…."

The Chart Settings allow modification of the Tornado diagram easily. The figure below shows the elements of the Chart Editor and they are described in more detail below.

**Chart Settings for a Tornado diagram**

- **Show title**: Check this box to show/hide the title. The title can be changed using the text box below the Show Title check box (currently ‘Tornado Diagram’).

- **Show legend**: Various options for show/hide variables names and descriptions. The Numeric format of these variables is changed via selecting the button ‘Numeric formatting...’ to change: number of decimal places; add trailing zeros and use thousand separators.
- **Show variable range:** This is included in the Show Legend grouping above:
  - **Order by EV impact:** This orders the variable description by their EV impact. This allows you to see from the key whether the the EV increases or decreases as the variable changes.
  - **Order by parameter value:** This orders the variable description by their parameter value from lowest to highest.
  - **Include base case:** This includes the base case parameter value prior to the parameter's uncertainty range.
  - The figure below shows the differences in these two options specifically for the impact of the Insurance parameter. The 1-way sensitivity analysis graph shows how increasing Insurance, decreases the EV.

- **Axis:** Change the label, range and numeric formatting on the horizontal axis.
- **Show EV Line:** Check box to show the EV line and edit the text and numeric formatting via ‘Numeric formatting…’ button.
- **Show thresholds:** This turns on and off the Threshold where there is a change in strategy (see above for further explanation).
- **Extend bars using threshold info (NMB Tornado Only):** Tornado diagrams include calculations at specific points in the variable parameter range based on the number of intervals. TreeAge Pro interpolates between each pair of calculations to draw graph lines and identify CE thresholds. Occasionally, the CE threshold identified through interpolation will be beyond the edges of the calculated values themselves to the left or right. This option extends the width of the bar to include the interpolated threshold value for the parameter.
- **Bar colors:** Edit the colors of the bars or select grey scale colors for each variable.

Use the double arrow at the top to hide or view the Chart Settings.

After making any changes, use the Apply button to make the changes to the Tornado diagram.
19 More Sensitivity Analysis Tools

Compare differences in Legend for the Tornado diagram. This figure highlights the Insurance parameter: "Order by EV impact"; "Order by parameter value"; 1-way sensitivity analysis output.

The 1-way sensitivity analysis graph is a great way to understand the impact of any parameter on the EVs.

19.2.2 Incremental Reward Tornados

A Tornado diagram can report the sensitivity of the incremental/marginal value calculated between two strategies.

To create an incremental tornado diagram:

- Run a regular tornado diagram as described above.
- In the first section, select "Incremental Reward".
- Then select the pair of strategies, setting one as the Comparator and one as the Base line.
- Then Open Report.

Note that every combination of strategies will be an option, including each pair switching the comparator and baseline. Incremental values are calculated as Comparator - Baseline.
Choose the appropriate Report Option to present the Incremental Tornado Diagram, selecting which strategies are Comparator and Baseline.

These options generate the Incremental Reward Tornado shown in the figure below.

Incremental Reward Tornado Diagram with Chart Settings and Actions

The incremental tornado may actually be of more value because it shows how the difference between the two strategies changes with the changes in each parameter.

Note that the EV line in the middle represents the incremental value between the two strategies using the base case value for each parameter. As the parameters deviate from their base case values, the incremental value changes.
For the top parameter Capacity, the incremental value increases as the parameter increases with the blue bar section representing the parameter range from the low uncertainty value to the base case, while the red bar section represents the parameter range from the base case to the high uncertainty value. In contrast, the Insurance parameter moves the other direction - the incremental value decreases as the parameter value increases.

If the parameter bar passes through the zero point on the x-axis, then that parameter’s uncertainty range includes a strategy change. These can be highlighted using the option on the left to “Show 0 line” which is not visible above due to scrolling. Note that the three parameters with thresholds - Capacity, Hours, Charter Price - are the same three parameters that showed thresholds in the Reward Tornado graph.

The secondary reports and report options here are similar to those for the Reward Tornado.

19.2.3 Including correlated variables in the tornado diagram

As in all sensitivity analyses, if you select a variable for the tornado diagram which has correlations, the correlated variables will vary together. The Analyzing correlated variables section contains additional information related to sensitivity analysis on correlations. The names of the correlated variables are shown in the list of variables available for inclusion in a Tornado Diagram. A pair of correlated variables cannot both be selected for the Tornado Diagram as they would have identical results.

19.3 Two-way sensitivity analysis

Two-way sensitivity analysis is used to examine the impact on a decision of simultaneous changes in the values of two variables. One method is to run a series of one-way analyses, each time incrementing the value of a second variable.

Another method available in TreeAge Pro is to automate this series of analyses and present the results in a region graph. The region graph very efficiently identifies changes in the optimal policy as the values of the two variables change.

The two-way sensitivity analysis setup dialog resembles the one-way dialog, except that you must specify two variables and a range of values for each. A decision node must be selected in order to perform a two-way sensitivity analysis.

To perform a two-way sensitivity analysis:

- Open the Get Started tutorial example tree, Three Vars.
- Select the root node.
- Choose Analysis > Sensitivity Analysis > Two-Way.
- For one variable, select pay_up, and specify the range from 200 to 800 with 6 intervals.
- For the second variable, select prob_extreme, and specify the range from 0 to 0.5 with 5 intervals.
- Do not check the box to "Run microsimulation" because this is a cohort model. This is an option for Patient Level Simulation models.
- Click OK to run the analysis.

Two-Way Sensitivity Analysis Setup

Be careful not to select variables that are formulas, rather than numeric parameters defined at the root node. A warning will alert you to this issue if you have selected such a variable.

The resulting graph is shown below. It identifies which strategy is optimal in regions of values of the variables; thresholds are simply the border between two regions.

**Sensitivity Analysis on pay_up and prob_extreme**

Two-Way Sensitivity Analysis Graph

The first variable in the setup dialog (pay_up) forms the horizontal axis of the graph, while the second variable (prob_extreme) forms the vertical axis.

It is recommended that you use two-way analysis only when the two variables are independent. If the two variables are a correlated pair, be sure to turn off the correlation.
19.3.1 Choosing intervals

Based on the selecting X intervals for one variable, and Y intervals for the other, TreeAge Pro recalculates the tree \((X+1)(Y+1)\) times, for the different combinations of values of the two variables. In the example on the previous page, 42 \((7 \times 6)\) recalculations occur, creating a grid of sensitivity analysis results.

You may find that a two-way analysis requires more intervals per variable to attain a reasonable level of accuracy than a one-way analysis. This is because a two-way analysis graphically represents only the threshold values – the optimal path crossings. The one-way analysis may show significant details which are simply not shown in the two-way analysis.

The graphical representation of the results of two-way sensitivity analysis has some unavoidable limitations; this also applies to three-way analysis.

⚠️ The accuracy of threshold lines may be compromised around the edges of the graph. The unavoidable result of using approximation techniques to identify thresholds is the appearance of distortion when two edges of a region of optimality draw closer together than one-half the width of an axis interval. Accuracy can be enhanced by running the analysis using more intervals.

Threshold lines represent points of indifference. Regions of indifference, however, are not shown. Areas of the graph where indifference exists are instead assigned to one alternative. You should use the text report (accessed via the Actions > or Graph > Text Report…) command to identify any areas of indifference by comparing the expected values at each interval. Isocontours (next section, but not yet implemented.) of small magnitude may also help identify where indifference ends.

19.3.2 Two-way sensitivity analysis text report

The region graph’s text report is accessible from the "Text Report" link to the right of the graph. There are two other options of text reports "Text Report (Flat)" and "Text Report (html)" with different formats of the same report. The text report displays a grouped matrix of results.
## Two-Way Sensitivity Analysis Text Report

The text report’s layout is based on the graph axes. There are two columns for each variable, one for `pay_up` and one for `prob_extreme`. The third column gives the strategy and the forth column the value of the strategies, depending on which combination of variables have been selected.

There are two chart options:

- Change order of variables: This changes the order of the variables between column 1 and 2.
- Change order of strategies: The changes the outputs in the value column based on the new order of the strategies.

The variable in the first column can be used to group the outputs by using the ‘+’ and ‘-’ buttons. By changing the order of the variables or strategies (using the links on the right hand side) you can present the results as required.

### 19.3.3 Custom iscontours

Isocontours were not implemented in TreeAge Pro 201x.
19.4 Three-way sensitivity analysis

The three-way sensitivity analysis dialog looks the same as the to the two- and one-way sensitivity analysis dialog except that three variable ranges are entered.

Three-Way Sensitivity Analysis Setup

Three variables cannot be presented clearly in a two-dimensional graph. Therefore, the results of a three-way sensitivity analysis are presented as an animated two-way sensitivity analysis region graph. The third variable is represented not with its own axis, but rather using a series of two-way graphs — if four intervals are specified for the third variable, then five graphs will be created, and shown in series.

Three-way sensitivity analysis

Use the Animate button or the scroll bar to cause the third variable to cycle through its range. The successive frames of the three-way analysis shows how the two-way region/optimality graph for the first two variables is affected by varying the value of the third variable.

19.4.1 Three-way sensitivity text report

The three-way version of the region graph now allows viewing and exporting the text report for all combinations of variables.

The three variable inputs, strategies and the corresponding output (value) are displayed in columns. The grouping is based on the first, second and then third variable.
Three-way sensitivity analysis text report

There are two chart options:

- Change order of variables: This changes the order of the variables between columns 1, 2 and 3.
- Change order of strategies: The changes the outputs in the value column based on the new order of the strategies.

19.5 Threshold analysis

This specialized form of sensitivity analysis offers the ability to search more thoroughly and accurately for threshold information. The result of this analysis is a detailed, textual description of how the optimal strategy is affected by changing the value of a single variable across a designated range.

In a standard one-way sensitivity analysis, the user designates the number of intervals into which the range is to be divided; actual calculations occur only at these intervals. As a result, the accuracy of the associated threshold analysis is limited to values determined by linear interpolation.

In contrast, threshold analysis has been designed to maximize accuracy of the analysis in situations where accuracy is more critical than speed. The specified range is iteratively searched until a specified minimum tolerance is reached.
This section will use the Get Started tutorial example tree Three Variables to illustrate threshold analysis.

To run threshold analysis:

- Choose Analysis > Sensitivity Analysis > Threshold Analysis from the menu.
- In the Threshold Analysis dialog, specify a variable and range, a tolerance and a degree of linearity. See below.

Threshold Analysis Dialog

The variable selection is the same as for one-way sensitivity analysis.

The tolerance is stated in the same units of value as the variable in question; it is not a percentage. The tolerance is related to the value of the variable, not to expected value. Thus, entering a tolerance of 0.1 means that the actual location of any threshold will be within plus or minus 0.1. For example, if TreeAge Pro indicates finding a threshold at \( \text{Var}=0.391 \), this means that the threshold definitely occurs somewhere between 0.381 and 0.401. Because TreeAge Pro applies linear interpolation after it meets your tolerance, you can expect the actual reported value to be even more accurate than the tolerance.

The Degree of non-linearity is used to try to avoid missing thresholds by dividing up the range into smaller intervals for the first pass. See note at the bottom of this section for more details.

The resulting Threshold Analysis Report is presented below.
The threshold analysis report shows the thresholds (rows) and information about each threshold (columns) in a table. The columns include:

- **Attribute**: The value for which thresholds were identified. This is usually EV for expected value.
- **Variable**: The variable for which the value was varied to identify thresholds.
- **Var. Value**: The value of that variable at the threshold.
- **Strategy 1, Strategy 2**: The strategies with equal expected value at that threshold.
- **Exp. Value**: The expected value of the two strategies at that threshold.

A sensitivity analysis may indicate multiple threshold values. However, this series of changes in policy will be identified correctly by TreeAge Pro only if the thresholds appear in different intervals in the first iterative pass. Since linear interpolation is used to find thresholds in a sensitivity analysis, only one threshold can be found per analysis interval.

For example, suppose that two thresholds exist in the same analysis interval, with optimality switching between the same decision options. Since the same policy is optimal at both ends, notwithstanding the intervening thresholds, TreeAge Pro will assume that no thresholds occur in that interval. There is no way to avoid this problem entirely. TreeAge Pro could subdivide a range into 100 intervals and still miss policy changes within an interval if the same optimal policy is specified at both ends. Even if different strategies are optimal at either end of an interval, and TreeAge Pro identifies a threshold in that interval, it is still possible that one or more additional thresholds in that same interval will have been missed.

For example, three alternatives, A, B, and C, might be compared using a sensitivity analysis; A is optimal at the beginning of an interval, B in the middle, and C at the end. Although you know that two thresholds (A to B, then B to C) actually occur, TreeAge Pro will find just one (a nonexistent one, A to C) from looking at the optimal alternative at the ends of the interval. The non-linearity hint is an attempt to minimize the likelihood this will occur. The more non-linear you describe the graph to be, the smaller the interval used by TreeAge Pro, so as to ensure catching any double thresholds.

### 19.6 Analyzing correlated variables

Linkages (i.e., perfect positive or negative correlations) between pairs of variables can be specified, for use during sensitivity analysis. These value linkages are set up in the Variable Properties View, Sensitivity Analysis Tab as described in the Working With Variables Chapter.
Correlated variables

Once created, the correlation is identified in the properties of both variables. Thus, when you choose to perform a sensitivity analysis on either member of a correlated pair of variables, TreeAge Pro will auto-adjust the correlated variable at the same time.

To perform a sensitivity analysis using correlated variables:

- Open the Special Features tutorial example tree, Correlated Variables. This tree already includes a positive correlation specified between the variables utilLoseFoot and utilLoseLeg. See above.
- Select the root, decision node.
- Choose Analysis > Sensitivity Analysis > One-Way… from the menu.
- In the Sensitivity Analysis dialog, select the variable utilLoseFoot. Specify 10 intervals and a range of 0.4 to 0.9. Click OK.

As the selected variable utilLoseFoot moves within its range (0.4 to 0.9), the correlated variable utilLoseLeg will move within its range (0.3 to 0.7).
Note that the Treat Foot strategy's EV rises with the value of \( util\text{LoseFoot} \) even though \( util\text{LoseFoot} \) is not referenced by that strategy. This change is a result of the change in the correlated variable \( util\text{LoseLeg} \).

### 19.7 Additional sensitivity analysis topics

Other chapters cover additional software features which can be useful in testing the sensitivity of your trees, but whose use is not restricted to performing sensitivity analysis.

- Creating analysis sequences (Stored Analysis Abstracts and Sequences Chapter)
- Using variable sliders (Working With Variables Chapter)
- Linking trees (Tools and Functions for Complex Trees Chapter)
- Probabilistic sensitivity analysis (Probabilistic Sensitivity Analysis Chapter)

#### 19.7.1 Sensitivity analysis on variables with non-numeric definitions

A sensitivity analysis can be performed on any variable in your tree, whether it has a numeric value definition (e.g., \( X=1 \) or \( X=\text{Exp}(2) \)) or a variable expression (e.g., \( X=\text{Rate}*\text{Util} \)). When performing a sensitivity analysis on a variable defined as a formula, you have multiple options. You can perform a sensitivity analysis on the component variables (e.g., Rate and Util) using variable correlations or a multi-way sensitivity analysis. Alternatively, you can perform a one-way sensitivity analysis on the original variable (e.g., \( X \)) based on an estimated numeric value range.
If you treat X as the independent variable, however, the formula will be ignored during the course of the analysis. Definitions of Rate and/or Util at different points in your tree will not be used during this analysis.

It is advisable to focus sensitivity analysis on the finest-grain parameters. In the example above, X is no longer “finest-grain,” as it has been defined in terms of its two component variables. In general, models should be designed to ensure that the sensitive variables have a single numeric definition.

19.7.2 Checking probability coherence

Most forms of sensitivity analysis offer an option labeled Check coherence. When this option is selected, TreeAge Pro will ensure that, at each interval, (i) all probabilities sum to 1.0 and (ii) no probabilities are negative. The analysis will be halted if at any time either rule is violated.

If the subject variable is used to define a probability, you are encouraged to leave this option selected. This will ensure the validity of your model over the range of the analysis. This is particularly important in the initial stages of testing your model’s validity. The downside is that calculation time is increased. If calculation speed is a concern, and you are not including any probability variables in the sensitivity analysis, you may want to turn off coherence checking.

Also see the section on probability non-coherence in the Advanced Chance Node Techniques and Options Chapter.

19.7.3 Analyzing a single option

Normally, when performing a sensitivity analysis, a decision node is selected and TreeAge Pro displays one line for each of the alternative scenarios rooted at the selected node. It is possible to focus a one-way sensitivity analysis on a single scenario, rather than on all of the scenarios emanating from a decision node.

If the node you select prior to performing the sensitivity analysis is not a decision node, TreeAge Pro will assume that the results should be presented as a single line. This will represent the changing expected value of the scenario rooted at the selected node. (Healthcare module users: Note that this option is not available for cost-effectiveness sensitivity analyses, which must be performed at a decision node.)

If, however, you select a decision node which is an immediate descendant of a decision node, TreeAge Pro will give you the option of drawing one line for the selected node (as a branch of its parent), or multiple lines for the branches emanating from the selected decision node.
20. Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis

This chapter provides instructions on creating and referencing sampling distributions, performing Monte Carlo simulation, and interpreting the results.

The Distribution Functions, Options and Types Chapter provides details on functions for accessing distributions, options/customizations, and other usage details related to the built-in distributions available in TreeAge Pro. Instructions on creating custom, table-based distributions are found in the Creating and Using Tables Chapter.

For detailed information on using the Healthcare module to perform probabilistic sensitivity analysis and microsimulation on Markov and cost-effectiveness models, see the Cost-Effectiveness Simulation Reports and Graphs Chapters and the Individual-Level Simulation and Markov Models Chapter.

20.1 Uses of Monte Carlo simulation in modeling

The first section of this chapter summarizes some common applications of Monte Carlo techniques and tools in TreeAge Pro. The rest of the chapter focuses on setting up distributions in your model, and running probabilistic sensitivity analysis.

For tutorials on performing individual-level simulation (in particular, on Markov models), refer to the Individual-Level Simulation and Markov Models Chapter.

20.1.1 Monte Carlo overview

Each of the analyses described in previous chapters, including sensitivity analysis, is deterministic. There is no randomness in these types of expected value (EV) calculations: each parameter uses a specified point value, and every path through the model has a deterministic weight in the EV calculation based on its path probability (no matter how unlikely). If roll back or another analysis is repeated using the same parameters and tree, results do not change.

In contrast, there are many situations where it is useful to introduce random, or stochastic, elements into some part of the analysis. In such situations, Monte Carlo techniques can be applied.

A decision analysis model is a way of visualizing a potentially very complex equation. One level of uncertainty in a particular problem and its corresponding model is made visible with chance nodes: our uncertainty about the current and future state(s) of a modeled individual or experimental outcome. Discrete (or micro-) simulation can be used to explore this 1st-order uncertainty (perhaps better labeled as variability). In decision analysis, the goal of such a simulation is generally still to calculate an expected value for each strategy being compared (in this case, an approximation based on long-run averaging of many random walks).
A separate, distinct level of uncertainty about a problem is, of course, parameter uncertainty. In this case, a parameter refers to some aspect of the system or world in which all our subjects, individuals, or experiments will operate (as opposed to some variable characteristic/state of a single subject). In some models and some systems, selected parameters (e.g., gravitational constant) may be known with precision, based on experimentation. In most decision analysis models, important system parameters (e.g., failure or survival rates) have not yet, or may never be, defined precisely through experimentation. Monte Carlo probabilistic sensitivity analysis (PSA) can be used to calculate an expected value over 2nd-order uncertainties for a particular strategy.

Of course, in addition to reporting simple mean values, simulation “experiments” can be performed: individual-level, discrete simulation and/or probabilistic sensitivity analysis. Simulation output can be examined to account for uncertainty, calculating standard deviations/errors, percentiles or credible intervals, and a wide variety of other statistics.

Finally, multi-dimensional expectations can be carried out (when required), in which case the 2nd-order/parameter uncertainties (or value of information) are of primary interest and placed in an outer loop, while each repetition of the PSA expected value calculation may be approximated using a separate, inner, discrete simulation expectation/loop.

Additional overview of different Monte Carlo applications follows.

20.1.2 Discrete (or micro-) simulation

Discrete simulation (microsimulation or 1st-order trials) is commonly used in the analysis of complex survival/failure models. Such simulation applications are covered in detail in the Individual-Level Simulation and Markov Models Chapter.

A much simpler, non-Markov discrete simulation, using the Stock Tree, is illustrated in the Analyzing Decision Trees Chapter. As described in the example, one way to look at a discrete simulation is as an approximation to expected value (EV) calculations in a decision tree. Simulation basically approximates EV calculations by sampling a representative distribution of paths through a model’s chance events. A discrete simulation of a complex model will often repeat as many “trials” as time allows, in order to improve the EV approximation.

In a single discrete simulation trial, a random walk (i.e., a series of uniform, pseudo-random numbers) selects a path through the chance nodes in the tree, with higher probability paths being more likely.
Running \( n \) simulation trials results in a list of \( n \) randomly-chosen outcomes, for example 10,000 “individuals” and their 20-year costs and life expectancy.

Although discrete simulation has less relevance in the average tree than in typical Markov projects, it is possible for very unwieldy trees to be greatly simplified or made more realistically by substituting probability distributions (e.g., Normal, Gamma, Exponential, etc.) for chance nodes, which are basically just discrete “distributions.” The required model changes are simple; the main sacrifice would be the requirement to use simulation instead of familiar EV analyses (like 1-way sensitivity analysis).

For example, the investment tree from the Analyzing Decision Trees Chapter could be revised with the risky investment chance node removed, and payoffs updated to include a likelihood distribution (e.g., Normal) representing change in investment value. Repeated investment decisions could also easily be modeled.

So, in discrete simulation models, variability can have two sources: chance node probabilities and parameterized distributions. In addition to possibly replacing event nodes in the tree, distributions have another, more common, application in simulation models. While simulation models sometimes assume a “homogenous cohort,” and include no initial variability in the characteristics of trials/entities, other models sample initial characteristics/states from probability distributions.

For example, a trial’s age might be sampled from a 1st-order distribution describing the population age distribution. Or, individuals might be bootstrapped from a table. (In an EV/cohort analysis model, in comparison, an initial series of chance nodes would explicitly separate subgroups based on patient characteristics, e.g., a few age groups.)

When parameterizing a distribution which represents 1st-order variability, simply change the sampling rate behavior from the default setting (for 2nd-order uncertainty) to instead sample per individual/1st-order trial.

### 20.1.3 Probabilistic sensitivity analysis

Like deterministic, \( n \)-way sensitivity analysis, Monte Carlo probabilistic sensitivity analysis (PSA) recalculates expected values in a tree multiple times, and is used to understand the impact of parameter uncertainties on the model results. One advantage of PSA is that any number of parameter uncertainties can be incorporated into an analysis. Sampling also enables greater weight to be placed on likely parameter values and combinations of parameters. PSA results estimate the total impact of uncertainty on the model, or the confidence that can be placed in the analysis results.

Probabilistic sensitivity analysis is covered in detail in the subsequent sections of this chapter.

### 20.1.4 Parameter distributions and model non-linearity

During a non-sampling analysis like rollback, all distributions in your model are fixed at their mean values. In some cases, taking an expected value from roll back will be equivalent to taking the sampling
mean from a probabilistic sensitivity analysis. However, this is not the case with all models and all parameters.

In a probabilistic sensitivity analysis on an uncertain rate in a survival model, for example, the sampling mean outcomes may differ significantly from the simple roll back “expected values” based on the point/mean value for the parameter. In such cases, the Monte Carlo PSA sampling means are the correct and preferred “expected values” for the model (assuming the likelihood distributions for the parameters are well-formed).

To support the complex, potentially lengthy types of analysis described in this chapter, TreeAge Pro can utilize up to eight processors on a single computer when performing Monte Carlo simulation.

20.1.5 EVPI/value of information analysis

Monte Carlo simulation can be used to perform various kinds of “value of information” analysis, similar to the structural form of EVPI described in the Analyzing Decision Trees Chapter.

The Analysis > Expected Value of Perfect Information command in TreeAge Pro calculates the difference between the baseline expected value of a decision, and the expected value when a chance node is temporarily shifted to the left of the decision. In a Monte Carlo simulation, the calculation of EVPI is done differently.

For example, if the optimal strategy changes depending on the values sampled for critical parameter uncertainties, then there would be some benefit to having “perfect information” about the uncertainty prior to the decision. The average of the values of each recalculation’s best option is the expected value with perfect information; it will either be equal to or greater than the best average value for any single alternative. Calculating the difference gives the expected value of perfect information.

Earlier versions of TreeAge Pro added EVPI reporting and charting options to the Monte Carlo simulation output window’s Graph popup menu. EVPI (and partial EVPI) are described later in this chapter.

20.2 Creating distributions

This section describes the basic steps for performing probabilistic sensitivity analysis:

- Define distributions for your parameters;
- Use the distributions in the tree;
- Run a Monte Carlo simulation, to repeatedly: A) sample from distributions and B) recalculate expected values.

As detailed in the previous chapters on performing deterministic, n-way sensitivity analysis in TreeAge Pro, parameters targeted for analysis must be defined using variables. Similarly, before using Monte
Carlo simulation to perform probabilistic sensitivity analysis in TreeAge Pro, uncertain parameters must be defined using distributions.

Probability distributions can be employed in any formula in a tree, including variable definitions, payoffs/rewards, probabilities, and even parameters of other distributions. TreeAge Pro includes 20 built-in distribution types (Normal, Beta, etc.), as well as enabling sampling from custom, discrete “table” distributions. The Distribution Functions, Options and Types Chapter describes the functions and options available with distributions.

In TreeAge Pro, the distributions that you define are stored in a list in the tree like variables. Unlike variables, distributions are assigned an integer index (and a name, optionally). A distribution can be referenced in the tree with the $Dist(n)$ function (where $n$ is the distribution’s index) or alternatively by the distribution’s variable-type name. To illustrate the basic steps for probabilistic sensitivity analysis, the simple Stock Tree will be used. The tree – with variables but no distributions yet – is shown below.

20.2.1 Defining a parameter using a distribution

The first steps are to change the payoff of the Large increase terminal node from a point estimate of 500 to a Normal distribution with a mean of 500 and a standard deviation of 100.

To define a distribution in the tree:
- Open the Get Started tutorial example tree “Three Vars”.
- Save a copy named “Stock Simulation”.
- Choose Views > Distributions from the menu to open the Distributions View
- In the Distributions View, click the “plus” toolbar icon to create a new distribution. The Add/Change Distribution dialog will open.
- Enter the new distribution’s properties (type, name, description) and parameters (mean, std dev). Leave 'override mean' blank. The values are presented in the screen print below. After clicking OK, the new distribution will be listed in the Distributions View (see below).
The PDF/CDF graphs show you the shape of the underlying distribution. Use the Help icon ("?" at the bottom left) in the Add/Edit Distributions Dialog to access documentation including the formulas TreeAge Pro uses for each distribution.

When a model references a parameter distribution (Sample per EV), it will use a distribution sample for each recalculation of the model within the PSA analysis. When not running PSA analysis, references to the distribution will use the distribution mean by default. If you want non-PSA analyses to use a different value than the distribution mean, enter an expression into the "Override mean" field in the dialog below. Overriding the mean handles the case where the distribution represents uncertainty that is not "centered" around the base case parameter value - meaning the uncertainty suggests the is more likely to be either greater than or lesser than the original parameter base case value.

At this point, you have created the distribution, but it has not been integrated into the model. The new distribution represents the value for a high return from the risky investment. Therefore, it could be
entered directly as the payoff value for that terminal node, or it could be used in the definition for the variable pay_up. We will use the second option.

**To use the distribution in the pay_up variable definition:**

- Right-click on the root node.
- Choose Define Variable > pay_up from the context menu.
- Clear out the existing definition (500).
- In the Group list, choose Distributions then double click on the distribution in the Element list.

![Define Variable pay_up](image)

**Define pay_up with distribution dNorm_500_100**

You could also have used the syntax `Dist(1)` instead of the distribution name since the distribution's index is 1.
Distribution notes:
During roll back and other non-sampling analyses, a distribution is equal to its mean value. In the example, pay_up will still equal 500 during expected value calculations, because this was specified as the mean value of the Normal distribution.
To override the mean value in non-sampling analyses, use the 'override mean' function in the Add/change Distribution.
The Dist() function in TreeAge Pro is equivalent to the DistSamp() function in DATA and earlier versions. Other versions of the distribution function, including DistForce() and DistKids(), are described in the next chapter.
During a single iteration of a sampling simulation, all references to a particular distribution return the same sample value because the default sampling rate (Once per EV) was used. The sampling rate can be set to resample more frequently, for example in Markov microsimulations.
Each named distribution can be presented in a list at the root node of the tree. To show the list on the face of the tree, turn on the "Show named distributions" option within Tree Preferences under Display > Variables\Markov Info category.

20.2.2 Distributions View
Distributions are managed (added, edited and deleted) through the Distributions View. This is a tree-level view since distributions are "global" within the context of a tree (like variable properties, but not like variable definitions).
Below is a screen print of the view showing one of each of the possible distribution types supported by TreeAge Pro.

![Distributions View](image)

**Distributions View**

The toolbar executes the following functions within this view.

- **Edit**: Open the Add/Change Distribution Dialog to edit the properties and parameters of a single distribution selected in the list.
- **Add**: Add a new distribution via the Add/Change Distribution Dialog.
- **Add new distributions**: Add multiple distributions via the Add/Change Distribution Dialog.
- **Delete**: Delete the distribution(s) selected in the list.
- **Copy distribution**: Select the row with the Distribution(s) you wish to copy. Click the copy icon to copy the Distribution(s) into the clipboard. See the Variable Properties View for details about copying/pasting.
- **Paste distribution**: Copy distribution(s) (as above from another model) and click the paste icon to paste the distribution(s) into the active model. See the Variable Properties View for details about copying/pasting.
- **Group by Category**: Show the distributions list grouped by category.
- **Edit in Excel**: Output the distribution properties and parameters to Excel, where they can be edited and returned to TreeAge Pro.
- **Report**: Generate a report showing parameters and EV values for each distribution.
- **Graph It**: Sample from the distribution and create a graph displaying the sampled values. **WE STRONGLY RECOMMEND USING THE GRAPH IT OPTION TO VALIDATE EVERY DISTRIBUTION AFTER IT IS CREATED.**
- **Highlight**: Highlight the distribution within the model in the Tree Diagram Editor.
- Search: Find all references to the distribution in the model.

### Distributions View Functions

The next chapter contains additional information on managing distributions.

The Edit in Excel button can be used to export selected distributions to a table in a new Excel worksheet where they can be edited. From Excel, the Add or Update Distributions command in the TreeAge Add-In menu can be used to update the active tree with any changes. Refer to the Graphing, Reporting and Modeling Using Excel Chapter for details.

### 20.3 Performing probabilistic sensitivity analysis

After defining and using distributions in your tree, you can run a Monte Carlo simulation to see how resampling parameter values affects calculations at a selected node. Simulations can be run at any node except a terminal node, making it possible to analyze only part of a tree.

To perform a probabilistic sensitivity analysis/Monte Carlo simulation:

- Select the root node of the "Stock Simulation" tree built in the prior section.
- Choose Analysis > Monte Carlo Simulation > Sampling (Probabilistic Sensitivity)…from the menu. The Monte Carlos Simulation Dialog will open.

If you have defined distributions in the Distributions View (even if they are not used anywhere in the tree), the Monte Carlo Simulation Dialog will present a variety of options for the analysis. In this case, you simply specify the desired number of distribution samples and corresponding model recalculations.

Now, specify the settings to use for this simulation:

- Change the number of distribution samples to 500.
- Click Begin to start the simulation.
In running this simulation, TreeAge Pro will randomly sample 500 values from the distribution defined in the tree and recalculate expected values for the branches of the selected decision node based on each parameter sample.

Monte Carlo Simulation Progress Dialog

The simulation output window shows the progress of the simulation. During long running simulations, it may be helpful to run the analysis in the background to allow you to continue working in TreeAge Pro. You can also click the Cancel button to stop the analysis.

Once the simulation is complete, a final statistical summary will be displayed. The summary includes mean, standard deviation, and other summary statistics for each strategy.

Probabilistic Sensitivity Analysis Output

If a simulation is performed at a decision node, the summary statistics for each branch are presented from left to right starting with the top branch. The statistics report can be exported to several formats (HTML, Excel, Word, etc.) by clicking the "Export Report As..." toolbar icon in the simulation output window. See the section Probabilistic Sensitivity Analysis Reports for more details on all the reports.

Note that the mean value above for the *Risky investment* strategy is close to but is not equal to 10 (the expected value without simulation). If more iterations (samples) were selected for the simulation, that mean would move closer to the expected value. Note that there is no variance in the *CD Paying 5%* strategy since it does not reference a distribution.
Since there is only one symmetrical distribution (normal) in the model, the mean from the simulation should approach the mean from expected value analyses. However, the mean from simulations will not always approach the mean from expected value analyses as noted in the non-linearity section.

Unless you use “seeding,” there should be statistical variation from one simulation to the next.

20.3.1 Probability coherence

Sampled probabilities can sometimes generate a set of branch probabilities that do not sum to 100%. This will cause the PSA simulation to fail. There are a few options to correct the non-coherent probabilities:

1. Use beta distributions for probabilities; Beta distributions always generate samples between 0 and 1.
2. Use Dirichlet distributions for chance nodes with more than two branches. A single Dirichlet distribution will generate all branch probabilities, guaranteeing that the sum is 100%.
3. Normalize probabilities to force non-coherent probabilities to sum to 100%.

Correcting non-coherent probabilities

20.4 Probabilistic Sensitivity Analysis Reports

In the section Performing Probabilistic Sensitivity Analysis, the model generated a report which has a number of different categories of reports we can examine.

Cost-effectiveness probabilistic sensitivity analysis generates additional output. These outputs are described in the Cost-Effectiveness Simulation Reports and Graphs Chapter.

The following sections look at the reports within each category, as in the figure below.
20.4.1 Data Reports

The Data Reports are organised into a list of key reports and then a list of Other reports. The key reports are:

- *Summary Report*: Displays aggregated data for the simulation outputs. The report headings are the same as for the All Data Report, see figure below.

**PSA: Summary Report**

*PSA Reports for Stock Simulation.trex expanded to see all sub-headings*
- **All Data Report**: Displays the complete output from each iteration of the simulation. For PSA simulations, each iteration represents a recalculation of the model based on its parameter distribution samples. The report lists the Iteration, the values for each Strategy and values for each Distribution, see the figure below.

![Monte Carlo All Values Report](image)

**PSA: All Data Report**

- **All Data Report Export**: Creates a report which is exactly the same as the All Data Report but will export directly to *.xls/*.txt format. This is more efficient than creating the All Data Report first and then exporting.

- The **Other** Reports are:
  - **Strategy Values**: This report shows the calculated expected value for each sampled iterations of the simulation. The report window is broken down into pages for viewing and can also be exported to external reports.
  - **Identifying variables**: This report allows you to review the specific values the variables were set to when you ran the simulation. This is useful if you run/save multiple simulations with different variable values. For details about setting Identifying Variables, see the Identifying Variables section (LINK) later in this Chapter.
  - **Expected Values**: This report is a subset of the All Data Report and presents the mean values for the enabled or active payoff sets.
  - **Distributions (by name)**: This report lists the sampled distribution values from the simulation by name.
  - **Distributions (by index)**: This report lists the sampled distribution values from the simulation by index.

### 20.4.2 PSA Outputs

Expanding the PSA Outputs, there are two reports:
- **Strategy Selection Frequency**: This generates the *Strategy Selection Frequency* graph which shows the percentage of iterations for which each strategy is optimal. You will be promoted for an indifference threshold which specifies the minimum significant difference between strategies such that one is optimal. The graph is presented below.

![Monte Carlo Strategy Selection](image)

- **EVPI/EVPPI Summary Report**: More details about the EVPI/EVPPI can be found in the following section called Expected Value of Perfect Information (EVPI/EVPPI) Reports and Charts.

### 20.4.3 Expected Value of Perfect Information (EVPI/EVPPI) reports and charts

Probabilistic sensitivity analysis simulations performed at decision nodes include a detailed EVPI report and summary chart. Both the report and chart are included under the "PSA Outputs" heading of the simulation output.

1. The EVPI reported for a microsimulation (versus a sampling simulation) might be interpreted as the value of being able to predict all chance nodes’ outcomes. Using the Stock Tree, for example, compare the Analysis > Expected Values of Perfect Information result at the single chance node in the model to the simulation EVPI report/chart in a simulation performed at the decision node.

2. Please refer to the section in the Cost-Effectiveness simulation Chapter for details about performing EVPI in cost-effectiveness models.

The calculation of EVPI in simulations is relatively straightforward:

1. Determine the *overall optimal strategy*, using the Net Monetary Benefits based on the specific ICER threshold.
2. Determine the *optimal strategy for each sample iteration* in the simulation.
3. For each iteration, if the optimal strategy is not the overall optimal strategy, calculate its *incremental net benefits value* (i.e., iteration optimal minus overall optimal), which will be $\geq 0$.

4. Report the average (expected) value of perfect information over all iterations.

**Steps for EVPI calculation in simulation**

This process hypothetically eliminates the simulated uncertainties by suggesting that the parameters for each iteration are perfect. This process estimates the value of what is lost by making suboptimal decisions for some of the simulation iterations.

The simulation run earlier in this chapter generates an *EVPI/EVPPI Summary Report* link. Clicking on this link generates the following report.

**EVPI/EVPPI Summary Report**

The EVPI value reflects the total EVPI from each iteration divided by the number of iterations as described above. To see the details from the individual iterations, click the EVPI/EVPPI Details link.

**EVPI/EVPPI Details Report**

To perform partial EVPI (or EVPPI), usually a two-level sampling loop is required. To handle this analysis robustly, in case of any nonlinearity in model parameters, TreeAge provides a 3-dimensional simulation option (3rd dimension can be a microsimulation loop).

When choosing Analysis > Monte Carlo Simulation > EVPPI Sampling, you will be prompted to enter:

- VOI Samples: This is the number of samples (Value of Information) for EVPPI;
- Second Order parameter samples: Number of samples for PSA; and
- 1st Order Simulation trials: Number of trials required for Microsimulation (if required).
In an EVPPI two-level sampling loop, use the Distribution Sampling options to select the distributions to sample in the outer sampling loop. The remaining distributions will be sampled in the inner sampling loop. In the example below, Distribution 1 is sampled in the outer loop and Distribution 2 is sampled in the inner loop. The figure below shows the

As in the figure below, a warning will appear to remind you to select the distributions to use in EVPPI. If you do not select any distributions to use in EVPPI, a screen prompt will remind you no distributions are selected.

Warning message to remind you to select distributions to use in the EVPPI analysis.
Monte Carlo Distribution Sampling. Expand the appropriate section to select when the distributions are sampled.

The parameter(s) of interest are sampled in the outer sampling loop N times; for each outer iteration, an inner loop samples the remaining uncertainties (and recalculates expected values) M times, in case of non-linearities in these remaining distributions.

For more information on EVPI/EVPPI simulation options in TreeAge Pro, refer to the current recommendations on performing EVPPI and related analyses found in the journal of the Society for Medical Decision Making (and elsewhere):

http://www.smdm.org/

20.4.4 Histograms

The Histograms are split into two sections: Sampling Distributions and Output Distributions.
20.4.4.1 Sampling Distributions

Following the Sampling Distributions link takes you to a list of all the distribution samples associated with the model. In this model, only one distribution has been sampled, but when more distributions are sampled additional links would be available.

Selecting a link for a given distribution will allow you to generate a probability distribution graph (histogram) for each of the distributions sampled in the analysis. In this case, there is only one - Dist(1) dNorm_500_100. When you click on a link for a distribution, you are prompted for an approximate number of bars to include in the probability distribution. After entering a value, the probability distribution is displayed, as in the figure below.

![Probability Distribution generated from the Sampling Distribution](image)

20.4.4.2 Output Distributions

This group generates probability distributions for outputs from the model. In this case, there is a single subgroup - EV (expected value) with an item for each of the two strategies (Risky Investment and CD Paying 5%). Other models/simulations can include other types of outputs. See the figure below.
Options under Output Distributions, expanding EV for the two strategies in the model

The graph below shows the probability distribution for the Risky Investment strategy's expected value.

![Monte Carlo Probability Distribution](image)

Output Distribution for Risky investment strategy
Note that the Redo Histogram link (for both Sampling and Output Distributions) allow you to regenerate the graph with more or fewer bars. For a discussion of the options available in TreeAge Pro for working with and customizing distribution graphs, refer to the Graphs Chapter, specifically the Customizing Histograms section.

**20.4.5 Rankings**

The link to Rankings Report shows the order of each strategy based on the Tree Preferences set. In this model, the optimal strategy is the one with the highest value, that is, CD Paying 5%. The incremental value is also given.

Note that these results are from the mean values based on the full set of PSA calculations.

![Rankings report for the Stock-Simulation example](image)

**20.4.6 Report Options**

This section provides you with options to customise your reports as show from the categories in the figure below.

![Options available under Report Options](image)
20.5 Saving Monte Carlo Simulations

Depending on the complexity of the model, and the number of samples and recalcuations you specify, running a simulation can be time consuming. For this reason, the simulation output window can be saved separately from the tree as a report output (*.rptx) file. Saving the simulation output will allow you to share the complete results with other TreeAge Pro users, or to generate graphs and reports from the simulation at a later time.

To save the Monte Carlo output window:

- Select the Monte Carlo output as the active view.
- Choose File > Save As… from the menu or click the Save toolbar icon in the simulation output window.
- Select the appropriate project/folder, enter a file name and click OK.
- The *.rptx file will be saved in the project/folder.

You will notice the extension *.rptx will be added to the title of the tab displaying the simulation output. You can open the *.rptx file later to reopen the output file.

Monte Carlo simulation output files grow relative to the number of rows and columns. Sizes of ~1 GB would be achieved with 1 million rows and 150 output columns. Use a Zip compression program to shrink file size.

Output *.rptx files contain database tables holding the report output data. Refer to the Technical Details Chapter for information on querying the data using an external tool.

20.6 Simulation options

This section describes options you can select when running simulations.

20.6.1 Multi-threading

To better handle lengthy simulations, TreeAge Pro will use multiple processors on a single computer when performing Monte Carlo simulation.
If you are running simulations on a dual-processor computer, you can instead specify to use only one simulation thread, which will leave one processor idle during the simulation (allowing other programs to run quickly while the simulation is running). If you are running a multi-threaded simulation, it is recommended that you leave the Optimize all expressions... setting on.

### 20.6.2 Distributed simulations

TreeAge Pro provides a mechanism to run Monte Carlo simulations on multiple computers. This can help speed up long simulations. Distributed "slave" computers are setup in Application Preferences for use with any model.

*To setup distributed computers:*

- Choose Window > Application Preferences from the menu.
- Select the category Analysis Tools > Monte Carlo - Distributed Processing
- Check the box labeled Use distributed computers.
- Click the Add button and enter the slave's computer name or IP address. Click OK.
- Check the boxes next to the slaves you want to use for the simulation.
- Click OK to save the Application Preferences changes.

**Setup distributed computers**

You can enter an IP range to scan for available distributed computers on your network. For example, enter 192.168.1.100-192.168.1.200 to search for distributed computers within that IP address range.

Once a set of slave computers is added, the list will look like the image below.
Application Prefs - Distributed Computers

**Distributed Simulation Licensing/Software Versions:**

- Master computers must have active Maintenance to use distributed slave computers.
- Slave computers require no TreeAge Pro license.
- Master and slave computers must be running the identical software build version. If the versions do not match, the slave computer will not be used for the analysis. You can check the version in the Application Preferences.

To use slave computers, the "Use distributed computers" box must be selected and individual computers must be selected. The master computer must be selected in the list of Distributed Computers in order to use it for simulation batches. This allows you to choose whether to utilize the master computer's system resources.

When you then run a Monte Carlo simulation, the master computer will send batches of iterations to each slave computer. The slave computers will return the iterations back to the master computer, where they are collected and eventually reported back through the user interface.

Note that there is overhead associated with passing data back and forth among computers, so you will not see the simulation speed double by adding a second identical computer for iteration batches.

On the slave computers, you can see that batches are being processed within the Object Interface Console. See below.
20.6.3 “Seeding” the random number generator

Normally, Monte Carlo simulations use dynamic information from the computer’s clock to initialize a sequence of pseudo-random numbers. If you ever need to force the same set of samples and/or trials for several different simulations of the same model, you can specify to use the same, predictable sequence of pseudo-random numbers.

To seed a simulation:

- In the setup dialog for a Monte Carlo simulation, click the “Seeding…” button. This opens the Tree Preferences Dialog to the Analysis Settings > Monte Carlo Options > Random Number Seeding Options category.
- Check the Seed random number generator box, and specify an integer seed value (from 1 to 64,000).
- Select a seeding behavior (described below).
- Click OK to save the Tree Preferences.
- Then run your model as intended.
Random Number Seeding Options in Tree Preferences

The seeding behavior options are described below.

- **Seed random number generator**: Check this box to stabilize the overall model results from one simulation to the next.
- **Seed**: If the prior option is checked, you set the initial seed for the random number sequence. Changing this value will generate a different but repeatable set of results.
- **Stabilize Microsimulation when run as inner loop within PSA**: This option applies only to Microsimulation when running within the context of PSA. Checking this box ensures consistency among sets of patients within the Microsimulation as the outer loop PSA sampled inputs change.
- **Stabilize PSA sampling when run as an inner loop with EVPPI**: This option applies only to EVPPI simulations, which have two PSA loops. Checking this box ensures that the same set of samples are drawn from the PSA-level distributions while the outer-loop PSA sampled inputs change.
- **Stabilize Microsimulation when run as inner loop within Sensitivity Analysis**: This option applies only to Microsimulation when running within the context of deterministic sensitivity analysis (1-way, 2-way, 3-way, tornado). Checking this box ensures consistency among sets of patients within the Microsimulation as the input parameters vary within their respective ranges.

**Seeding options**

All seeding should be used cautiously. Seeding generates repeatable results from analysis to analysis or from inner loop to inner loop. It is not a substitute for running a representative number of iterations to stabilize the overall mean results from any analysis.
20.6.4 Turning off sampling of selected distributions

You have the option of specifying that only a subset of the distributions should be sampled during a simulation. Non-sampled distributions will be set at their mean.

To sample from selected distributions during a simulation:

- In the setup dialog for a Monte Carlo simulation, click the Distributions… button. This opens the Tree Preferences Dialog to the Analysis Settings > Monte Carlo Options > Distribution Sampling Category.
- There are three options:
  - Sample all;
  - Sample none; and
  - Sample some (make selections below).
- If the option "Sample some" is selected, use the left/right buttons to move the appropriate distributions between the available list on the left to the sample list on the right.
- Click OK to save the Tree Preferences.
It can be useful to associate identifying information with simulation output, especially when you have more than one simulation output window open at once, or if you are saving and reopening or sharing the Monte Carlo simulation files. Simulation output can be "labeled" with identifying variable values and with a simulation comment.  

Identifying variables  
Simulation output windows can be labeled using the values of variables in your tree. The resulting simulation output window will display a list of the variables and their default values.

Monte Carlo simulation identifying values are particularly useful in combination with the stored analysis features in TreeAge Pro (Stored Analysis Abstracts and Sequences Chapter).

To add identifying variable values in the simulation window:
- In the setup dialog for a Monte Carlo simulation, click the Identifiers… button. This opens the Tree Preferences Dialog to the Analysis Settings > Monte Carlo Options > Identifying Variables Category.
- Use the left/right buttons to move the appropriate variables between the available list on the left to the identifier list on the right.
- Click OK to save the Tree Preferences.
Identifying Variables Tree Preferences

Note that the pay_up variable was not selected because its value is defined using a distribution, and those distribution values would already be included in the simulation output.
The Identifying Variables are stored in the Tree Preferences, so that you do not need to re-select them for each new simulation.

After the simulation is executed, the values of the identifying variables are available through the simulation output's "Identifying Variables" link.

![Monte Carlo Simulation Identifying Variables](image)

**Monte Carlo simulation output - Identifying Variables**

20.6.6 "Downstream" decision nodes during microsimulations

If your tree includes decision nodes to the right of the node where a simulation is being performed, each trial must select a single path when it encounters such embedded decisions. For simulations using only expected value calculations (e.g., PSA with no trials), TreeAge Pro always re-evaluates the optimal path at the embedded decision, and utilizes the optimal strategy's expected value.

For trials, however, embedded decision nodes can be handled in three ways:

1. based on expected values calculated prior to the simulation, a single optimal policy can be followed for all iterations;
2. select the topmost branch;
3. if any parameter uncertainty (e.g., PSA) distributions are used in the tree, the optimal policy can be re-evaluated for each sample iteration based on the current distribution sample values.

**Downstream Decision Options**

To set the downstream decision algorithm for a simulation:

- Open the Tree Preferences dialog.
- Choose the category Analysis Settings > Monte Carlo Options > Downstream Decision Options.
- Select the option that is appropriate for your model.
- Click OK to save the Tree Preferences.
Tree Preferences - Downstream Decision Options

The Special Features tutorial example model Downstream Decisions illustrates the three options.

Downstream Decisions tree

Note that the root node is not a decision node, so the Choose node is a downstream decision node. Therefore, the downstream decision options selection will control which investment is selected for each trial.

The payoffs for the two investments are both distributions sampled by EV/set of trials. The investment 2 option has a larger mean value, but the two distributions' standard deviations are large enough that some PSA iterations will favor investment 1.

If the "Use the same policy for all iterations (best expected value)" option is selected, then all trials select investment 2 because it has a larger mean value.
If the "Use the same policy for all iterations (top branch)" option is selected, then all trials select investment 1.

<table>
<thead>
<tr>
<th>ITERATION</th>
<th>STRATEGY_1</th>
<th>DIST_1</th>
<th>DIST_2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>485.845004545</td>
<td>485.845004545</td>
<td>893.883421772</td>
</tr>
<tr>
<td>2</td>
<td>978.234512342</td>
<td>978.234512342</td>
<td>1274.362257347</td>
</tr>
<tr>
<td>3</td>
<td>1105.301251232</td>
<td>1105.301251232</td>
<td>1606.825323612</td>
</tr>
<tr>
<td>4</td>
<td>849.9040532080</td>
<td>849.9040532080</td>
<td>1193.843206914</td>
</tr>
<tr>
<td>5</td>
<td>790.9530543475</td>
<td>790.9530543475</td>
<td>1162.819861931</td>
</tr>
<tr>
<td>6</td>
<td>901.2752432767</td>
<td>901.2752432767</td>
<td>790.790062244</td>
</tr>
<tr>
<td>7</td>
<td>1098.3686455237</td>
<td>1098.3686455237</td>
<td>1185.621505899</td>
</tr>
<tr>
<td>8</td>
<td>1109.8643512525</td>
<td>1109.8643512525</td>
<td>781.102385264</td>
</tr>
<tr>
<td>9</td>
<td>1086.8292147623</td>
<td>1086.8292147623</td>
<td>1184.399012738</td>
</tr>
<tr>
<td>10</td>
<td>910.3585699657</td>
<td>910.3585699657</td>
<td>615.329631081</td>
</tr>
</tbody>
</table>

Downstream decisions simulation - option 2

If the "Re-evaluate optimal path for each iteration" option is selected, then all trials will select the investment with the larger sampled value. Note that in iterations 8 and 10, the trials selected investment 1 rather than investment 2.

<table>
<thead>
<tr>
<th>ITERATION</th>
<th>STRATEGY_1</th>
<th>DIST_1</th>
<th>DIST_2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1279.0158411713</td>
<td>0789.5029681849</td>
<td>1279.0158411713</td>
</tr>
<tr>
<td>2</td>
<td>1279.0158411713</td>
<td>0789.5029681849</td>
<td>1279.0158411713</td>
</tr>
<tr>
<td>3</td>
<td>1289.8123131679</td>
<td>1094.1320853236</td>
<td>1289.8123131679</td>
</tr>
<tr>
<td>4</td>
<td>1231.10967128128</td>
<td>1454.3955435885</td>
<td>1231.10967128128</td>
</tr>
<tr>
<td>5</td>
<td>1347.8233631308</td>
<td>1029.0333697923</td>
<td>1347.8233631308</td>
</tr>
<tr>
<td>6</td>
<td>1579.9985641418</td>
<td>1251.4115533418</td>
<td>1579.9985641418</td>
</tr>
<tr>
<td>7</td>
<td>1262.3512797642</td>
<td>1055.5495352088</td>
<td>1262.3512797642</td>
</tr>
<tr>
<td>8</td>
<td>1067.2125170027</td>
<td>1627.2125170027</td>
<td>1050.404088019</td>
</tr>
<tr>
<td>9</td>
<td>1396.4639073821</td>
<td>1011.3440682823</td>
<td>1396.4639073821</td>
</tr>
<tr>
<td>10</td>
<td>924.9335099952</td>
<td>943.0398689952</td>
<td>634.1564923057</td>
</tr>
</tbody>
</table>

Downstream decisions simulation - option 3

20.6.7 Distribution options

Each distribution created in a tree can be extensively customized. Refer to the Distribution Functions, Options and Types Chapter for complete details on distribution types, functions, and sampling behavior options.

20.7 Customizing simulations

The previous section described the various simulation options that can be explicitly set prior to running the simulation. For more complex situations, there are additional methods at the modeler’s disposal for customizing the behavior of simulations.

20.7.1 The TreeAgeProLib (Excel add-in)

The TreeAgeProLib library enables writing macros to control setup and execution of simulations via the Object Interface. Refer to the Using the TreeAge Pro Object Interface Chapter for more details.
### 20.7.2 Keywords

A variety of simulation keywords (built-in counters) can be used in expressions (e.g., tracker modifications, rewards, probabilities) during simulation. The table below describes each keyword.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_stage</td>
<td>Markov cycle counter (starts with 0)</td>
</tr>
<tr>
<td>_tunnel</td>
<td>Markov cycle-in-state counter (starts with 1), requires state to be configured with tunnel max value</td>
</tr>
<tr>
<td>_state_index</td>
<td>Index for the Markov state counting down from the top (top state is 1, next down is 2, etc.)</td>
</tr>
<tr>
<td>_strategy</td>
<td>Returns the number of the strategy, defined as a branch directly coming from a decision node (numbered top to bottom). The value is undefined to the left of the first decision node or if the model has no decision node.</td>
</tr>
<tr>
<td>_trial</td>
<td>Index for the trial/iteration being processed in the Microsimulation loop of a simulation (always 1 when not running Microsimulation)</td>
</tr>
<tr>
<td>_trial_size</td>
<td>Number of trials/iterations for the Microsimulation loop</td>
</tr>
<tr>
<td>_sample</td>
<td>Index for the sample/iteration being processed in the sampling/PSA loop of a simulation (always 1 when not running PSA)</td>
</tr>
<tr>
<td>_sample_size</td>
<td>Number of samples/iterations for the PSA simulation loop</td>
</tr>
<tr>
<td>_voi_sample</td>
<td>Index for the value of information (VOI) iteration being processed, the outer most simulation loop in EVPPI analysis (always 1 when not running EVPPI)</td>
</tr>
<tr>
<td>_voi_sample_size</td>
<td>Number of iterations for the outer most simulation loop in EVPPI analysis</td>
</tr>
<tr>
<td>_node_id</td>
<td>Returns the numeric identifier for a specific node</td>
</tr>
<tr>
<td>_node_label</td>
<td>Returns the label for a specific node</td>
</tr>
<tr>
<td>_thread_index</td>
<td>Index for the thread which is running all or a portion of the overall simulation (simulations can run as multiple threads to increase the speed of the simulation)</td>
</tr>
<tr>
<td>_parallel_trials_clock</td>
<td>The current _clock value during a parallel trials discrete event simulation that uses the _CLOCK value to keep the trials synchronized.</td>
</tr>
<tr>
<td>_parallel_trial_creator</td>
<td>If you turn off probability coherence, you can create individuals in a parallel trials simulation. This keyword can be used by a new trial to get the number of the trial that created it (i.e., via a transition/chance event with non-coherent probs).</td>
</tr>
<tr>
<td>_parallel_trials_set</td>
<td>The index for the current set of parallel trials.</td>
</tr>
<tr>
<td>_parallel_trials_sets_size</td>
<td>The number of sets of parallel trials in the simulation.</td>
</tr>
</tbody>
</table>
20 Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_cache_level</td>
<td>When using the Node() function to access parts of the tree, this returns the &quot;depth&quot; of the calls from nested Node() functions.</td>
</tr>
</tbody>
</table>

Simulation keywords

The most useful will be: _trial and _sample. These allow you to reference the trial index and/or sample index in expressions within the tree.

💡 For information on the parallel trials keywords, refer to the Individual-Level Simulation and Markov Models Chapter.

20.7.3 Monte Carlo keywords

Normally, the only calculations that are done between iterations of a microsimulation or probabilistic sensitivity analysis are distribution resampling. However, you can force user-defined expressions to be executed at strategic points between simulation iterations.

Special variables differ from keywords in that you have to define them as variables. Once you define the variable with the proper name, it's definition will be executed at the appropriate time in the model.

Create a variable with one of the following names and define it at the root node with the appropriate expression. At the appropriate time in the simulation, the expression will be executed. This can be useful for working with Global matrices or using Debug commands.

For example:

```plaintext
_monte_pre_trial_eval = DebugWriteForce("--- Starting Trial " + Str(_trial) + " ---")
```

would write text marking the beginning of the trial to the Calculation Trace Console.

<table>
<thead>
<tr>
<th>Special Variable</th>
<th>Expression is executed...</th>
</tr>
</thead>
<tbody>
<tr>
<td>_monte_pre_trial_eval</td>
<td>Before each trial is run. Not executed for parallel trials.</td>
</tr>
<tr>
<td>_monte_post_trial_eval</td>
<td>After each trial is run. Not executed for parallel trials.</td>
</tr>
<tr>
<td>_monte_pre_cycle_eval</td>
<td>Before each cycle starts. Only executed for parallel trials.</td>
</tr>
<tr>
<td>_monte_stop_cycle_eval</td>
<td>After trials reach stop or terminal node and before trials continue from a stop node. Only executed for parallel trials.</td>
</tr>
<tr>
<td>_monte_post_cycle_eval</td>
<td>After each cycle finishes. Only executed for parallel trials.</td>
</tr>
<tr>
<td>_monte_pre_cycle_trial_eval</td>
<td>Before each trial starts a cycle. Only executed for parallel trials.</td>
</tr>
</tbody>
</table>
Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis

Monte Carlo Special Variables

To use they keywords in your simulations, just define a variable with the same name as the keyword. The Add/Change variable dialogue makes this easy by showing a list of keywords to the right of the Name editor, as in the figure below.

The dropdown menu of keywords is accessible from the dropdown menu in the Add/Change Variable dialogue.
These keywords can be used to initialize and output global matrices at specific times during the simulation. For example, you can output trial-level data within a two-dimensional simulation where the standard simulation output would only provide mean values for the trial sets.

Use the _post_analysis keyword to output data when the entire analysis is complete. Note that the _post_analysis keyword can be run for other analyses, while the other keywords are only executed within the context of Monte Carlo simulation.

20.8 Two- and three-dimensional simulations

In most models, a probabilistic sensitivity analysis should recalculate expected values for each new set of parameter samples to see the effects of parameter uncertainty.

However, there is an alternative method for recalculating the tree after each set of parameter samples: estimating an expected value by averaging many first-order trials. This process – estimating expected values by averaging a sufficiently large number of random, individual outcomes – is sometimes called microsimulation.

20.8.1 Recalculate using first-order trials (microsimulation)

In most models, two-dimensional simulation for the purposes of probabilistic sensitivity analysis is unnecessary. It is normally preferable to run a 1-dimensional loop that recalculates EVs for each set of randomly sampled parameter values – except in the case of certain types of models, for example:

1. Markov models using tracker variables to follow detailed event history. Refer to the Individual-Level Simulation and Markov Models Chapter for details on trackers.
2. Trees using distributions to represent variability among individuals (much like a chance node does) rather than just parameters whose values are uncertain. Refer to the Distribution Functions, Options and Types Chapter for more information on sampling rates.

Scenarios requiring two-dimensional simulation for PSA

Both of these situations call for microsimulation (described at the beginning of this chapter).

Depending on the complexity of the model, each microsimulation may require thousands of first-order trials in order to adequately approximate an expected value. Therefore, in the context of a probabilistic sensitivity analysis, using a microsimulation for each recalculation of the tree (for a new set of samples) can be very time consuming. This is why two-dimensional simulation is generally avoided unless a model requires microsimulation to calculate an expectation.

To perform probabilistic sensitivity analysis using first-order microsimulation trials for model recalculations:

- Select the root node of your tree, or a node to the right, to set the context for analysis.
- Choose Analysis > Monte Carlo Simulation > Sampling + Trials…from the menu.
- Enter the number of samples for the 2nd-order parameter loop.
- Enter the number of trials for the 1st-order trials loop.

Monte Carlo Simulation setup for two-dimensional simulation

Specify a sufficient number of 1st-order trials to get a good average for each new sample value (or set of values). Initially you should experiment with smaller number of iterations in both the sampling loop as well as the inner, microsimulation loop.

In the context of Markov models using trackers with microsimulation, refer to the Individual-Level Simulation and Markov Models Chapter for more information on two-dimensional simulations.

20.8.2 Two-dimensional simulation details

In microsimulation models also requiring probabilistic sensitivity analysis, a two-dimensional (or two-loop) approach to is used:

1. \( N \) number of parameter samples and \( I \) number of microsimulation trials are specified.
2. Draw one set of samples for the parameter distributions.
3. Holding the sampled parameter values constant, a group of \( I \) microsimulation trials are performed. The mean of the results from the trials is reported (e.g., cost and/or effectiveness values, as well as tracker values).
4. Steps 2 and 3 are repeated for each of the \( N \) sets of parameter samples.

Two-dimensional simulation detailed steps

Once the simulation is complete, the final report will include \( N \) rows, showing each set of parameter samples and the corresponding mean values for \( I \) microsimulations. The distribution of these results reflects the total uncertainty resulting from the parameter distributions.

Note that the detailed results for each of the \( I \) trials within each sample are not reported.
20.8.3 Three-dimensional, value of information simulations

To perform partial EVPI (or EVPPI), usually a two-level sampling loop is required. TreeAge provides a 3-dimensional simulation option to handle these more complex values of information simulations. In this case, the innermost loop or “dimension” allows for a set of microsimulation/individual trials to be used in the innermost expectation step of the EVPPI simulation (if required).

More information can be found about EVPI in the Chapter about Analyzing Decision Trees in the section Expected Value of Perfect Information (EVPI).

Information about performing EVPI in Cost-Effectiveness models can be found in the Chapter about Cost-Effectiveness Simulation Reports and Graphs in the section Cost-Effectiveness Value of Information (EVPI).

Click here to review seeding options for stabilizing inner loops within a multi-dimensional analysis.

Obviously, as noted in the previous section, multi-level/multi-dimensional Monte Carlo simulations can be very time consuming. Distributed simulation can divide the required processing time among multiple computers. And, if carefully used, special microsimulation error reduction seeding options can be used to reduce, to some extent, the number of sampling iterations required to get stable 2nd-order uncertainty measures.
21. Distribution Functions, Options and Types

This chapter provides information about each of the built-in sampling distribution types available in TreeAge Pro.

Derivations and detailed explanations of the distribution formulae provided here may be found on many math/statistics web sites, and in most texts on probability theory. See, for example, Christensen, Ronald; Data Distributions: A Statistical Handbook (2nd Ed.); Lincoln, Massachusetts: Entropy Limited, 1989.

Refer to the following chapters for information on using distributions in trees.

- More Sensitivity Analysis Tools
- Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis
- Advanced Chance Node Techniques and Options
- Individual-Level Simulation and Markov Models Chapter

21.1 Distribution functions

Distributions can be referenced in two different ways: by name (if an optional name is defined in the distribution properties) or by index. The following functions employ the argument index to reference a distribution defined for the tree. With the exception of DistKids(), they are intended primarily for use during Monte Carlo simulation.

Most distribution functions can reference the distribution index or the distribution name. If using the distribution name, place the name within quotation marks to treat this name as a string and not a numeric expression to be calculated.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dist(dist_index)</td>
<td>During expected value calculations, this function returns the indexed distribution’s mean. During Monte Carlo simulations, this function returns the most current random sample for the distribution (unless the distribution is flagged to not sample).</td>
</tr>
<tr>
<td>Dist(dist_index; column)</td>
<td>For a multi-variate distribution (i.e., a Dirichlet, Multivariate Normal or multi-column table distribution), returns the sample value (or mean, if not sampling) from the designated value column.</td>
</tr>
<tr>
<td>Dist(dist_index; 1)</td>
<td>For a univariate distribution (i.e., not Dirichlet, Multivariate Normal or multi-column table), forces a sample from the distribution, even during non-sampling analyses. It is recommended that you use the DistForce function rather than this function (see below). For a table distribution, use the first value column for probabilities.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Dist(dist_index; 2)</td>
<td>For a univariate distribution (i.e., not Dirichlet, Multivariate Normal or multi-column table), returns the stored sample value for a virtual branch created using the DistKids() syntax, below. For a table distribution, use the second value column for probabilities.</td>
</tr>
<tr>
<td>DistForce(dist_index)</td>
<td>Unlike the Dist function, DistForce() always samples a value, even during non-sampling analyses such as roll back. DistForce(index; column) also works for multi-variate distributions. Note that DistForce(index; 1) must be called first in order to trigger a new set of sample values for all columns; then the stored sample values for the other columns can be referenced.</td>
</tr>
<tr>
<td>DistForce(&quot;dist_name&quot;)</td>
<td></td>
</tr>
<tr>
<td>DistForce(dist_index; column)</td>
<td></td>
</tr>
<tr>
<td>DistForce(&quot;dist_name&quot;; column)</td>
<td></td>
</tr>
<tr>
<td>DistProb(dist_index; val)</td>
<td>For the specified distribution, returns the approximate cumulative probability of the specified value.</td>
</tr>
<tr>
<td>DistProb(&quot;dist_name&quot;; val)</td>
<td></td>
</tr>
<tr>
<td>DistSampleCond(dist_index; lower_bound; upper_bound)</td>
<td>Draw a sample from the appropriate distribution that is bounded by the lower_bound and upper_bound values provided. The upper_bound argument is optional.</td>
</tr>
<tr>
<td>DistSampleCond(&quot;dist_name; lower_bound; upper_bound&quot;)</td>
<td></td>
</tr>
<tr>
<td>DistTransProb(dist_index; time_cycle_start ; time_cycle_length)</td>
<td>Calculate transition probabilities from a time-to-event distribution. For further details are available in the Markov Modeling Tools and Techniques Chapter.</td>
</tr>
<tr>
<td>DistTransProb(&quot;dist_name; time_cycle_start ; time_cycle_length&quot;)</td>
<td></td>
</tr>
<tr>
<td>DistTrim(dist_index; min; max)</td>
<td>Same as the Dist() function, except it will resample (up to a maximum of 10 times) until a sample is returned that falls between the specified minimum and maximum values.</td>
</tr>
<tr>
<td>DistTrim(&quot;dist_name&quot;; min; max)</td>
<td></td>
</tr>
<tr>
<td>DistValue(dist_index; prob)</td>
<td>For the specified distribution, returns the approximate value at the specified cumulative probability.</td>
</tr>
<tr>
<td>DistValue(&quot;dist_name&quot;; prob)</td>
<td></td>
</tr>
<tr>
<td>DistSamp(dist_index)</td>
<td>Obsolete. Use the Dist() function.</td>
</tr>
<tr>
<td>DistSamp(&quot;dist_name&quot;)</td>
<td></td>
</tr>
<tr>
<td>DistSamp(&quot;dist_name&quot;; _time)</td>
<td>Used with time-to-event distributions, particularly in Partitioned Survival Analysis models. Returns the complement of the cumulative probability that an event has occurred at any given time. If a distribution represents progression, then DistSamp returns the probability that the progression has not yet occurred. DistSamp(&quot;DistributionName&quot;) = 1 - DistProb(&quot;DistributionName&quot;; _time) The second argument allows you to specify the probability at a specific time.</td>
</tr>
<tr>
<td>DistSurv(&quot;dist_name&quot;)</td>
<td></td>
</tr>
<tr>
<td>DistSurv(&quot;dist_name&quot;; _time)</td>
<td>334</td>
</tr>
</tbody>
</table>
Function | Description
--- | ---
The second argument can also convert the time units for the appropriate units within a model. For example monthly distribution to annual model: DistSurv("dist_name";_time/12)

Distribution Functions

The DistTrim will usually generate a value between the min and max arguments. However, it is possible for 10 consecutive samples to fall outside this range. This function can be used in conjunction with the Min and Max functions to guarantee a value within the range.

Min(maxValue; Max(minValue; DistTrim(distIndex; minValue; maxValue)))

21.2 Distribution options

Some special options can be used to make distributions more flexible.

21.2.1 Changing sampling rate for microsimulation models

While most distributions are used to sample possible values of uncertain parameters for probabilistic sensitivity analysis, distributions can also be used to instead represent individual variability/patient characteristics. These two different classes of distributions should be identified via the TreeAge Pro distribution’s sampling rate property. This is particularly important if a model includes both types of distributions.

To change the sampling frequency for a particular distribution:

- Open a model with at least one distribution.
- Choose Views > Distributions from the toolbar.
- Select a distribution from the list.
- Click the "edit" toolbar button to open the Add/Change Distribution dialog.
- Select the Sampling rate option "Once per individual trial".
Add/Change Distribution Dialog - set sampling rate

This option will be of interest in specific models:

1. Markov models using tracker variables to follow detailed event history, including discrete event models.
2. Trees using some distributions to represent variability among individuals (in the same way that a chance node could).

Characteristics of models that might use distributions that sample once per trial

By default, distributions are set to sample once per tree EV recalculation. In a two-dimensional simulation, this would be per “group of trials”. By default, a simple microsimulation resamples only distributions set to sample per 1st-order trial or Markov stage.

It is also possible to set a distribution’s sampling frequency to generate a new sample value at each Markov cycle/stage during first-order trials and/or cohort/EV calculations. The DistForce() syntax can be used to resample more frequently.

21.2.2 Sampling during non-simulation, EV calculations

During non-simulation analyses, such as roll back and sensitivity analysis, a reference to a distribution normally returns the mean value every time it is referenced. If ‘Override mean’ is used, this value would be the override value. The Dist() function can, however, override this behavior and return a randomly sampled value from the referenced distribution during any EV calculation.
To cause a random distribution sample to be returned by the Dist() function during expected value (EV) calculations, simply add a second parameter to the function with a value of 1. The formula DistForce(n), or Dist(n;1), will sample a new value from distribution number \( n \) each time the distribution is referenced in a tree calculation.

This also means that at each place in the tree where the distribution is referenced, a different sample value will be returned.

### 21.2.3 Defining distribution parameters non-numerically

Distribution parameters can be defined using variables or formulas, instead of fixed numeric values. This makes it easier to modify a distribution's parameters and it may also help someone viewing the model understand the significance of a particular distribution.

**Using variables for distribution parameters**

Clicking on the button to the right of a distribution parameter’s text box will open an expression editor dialog. This dialog, like a variable definition window, makes it easier to set up a complex expression, including existing variables, functions, and even other distributions, to represent a distribution parameter.

Variables that are referenced in the parameter of a distribution must be defined with a default value for the tree, at the root node.

![Normal Distribution Parameters](image)

Distributions are "global" within the context of the model. Therefore, the root node variable definition will be used to define the distribution properties. You cannot define a variable differently in other portions of the model and expect the parameters of the distribution to change.

Microsimulation tracker variables (refer to the Individual-Level Simulation and Markov Models Chapter) can be used in the parameters of a distribution; however, the distribution must either be set to sample per Markov stage, or use DistForce() syntax, in order for a sample to be generated based on an updated value of the tracker.

Finally, it is possible to use one distribution ("X") in defining the parameters of another distribution ("Y"). TreeAge Pro requires that the dependent distribution have a higher numeric index than the input distribution – e.g., \( X = \text{Dist}(1), Y = \text{Dist}(2) \).

A distribution cannot reference itself recursively as a parameter.
21.2.4 Approximating distribution parameters from statistical information

Some of the built-in distribution types supported in TreeAge Pro use parameters that may be difficult to find. For example, the Log-normal distribution is parameterized using the “mean of the logs” and the “standard deviation or error of the logs”.

TreeAge can approximate some distributions’ parameters from more straightforward statistical summary values. Distributions that support parameter approximation will include a list box allowing you to approximate the distribution parameters. Supported distributions include the real-number form of the Beta, the Log-normal, and the Gamma distribution.

In the example below, beta distribution parameters are required.

After choosing Pick approximation > From Mean, Std Dev..., the appropriate approximation inputs are presented for input entry. After entering the mean and standard deviation, the approximated distribution parameters are displayed.
In a later section of this chapter, some of the details of these approximations are provided.

21.3 Distribution Formulas

Click here to view the formulas TreeAge Pro uses to generate distributions.

If you are unable to access the distribution formulas via the link above, click here to access the formulas in PDF format.

When creating distributions via the Add/Change Distribution dialogue, you can also access the formulas there, as in the figure below.
21.4 Sampling from tables during Monte Carlo simulation

If it is not feasible or desirable to use one of TreeAge Pro’s built-in distributions to represent the particular probability distribution you need, there are at least two ways to create custom sampling distributions. These methods use built-in distributions and tables.

Table distributions can be helpful in defining individual characteristics (i.e., gender, ethnicity) to trials during microsimulation based on the probability of each value within the cohort. TableProb distributions can be helpful for drawing time-to-event samples for Discrete Event Simulation based on a table of probabilities (like a mortality table).

21.4.1 Creating a Table distribution

One way to sample values from a custom distribution is to create a new table in TreeAge Pro describing the distribution’s discrete probability function (not the data set). This table can then be assigned to a Table distribution.

Each row of the table defines a distribution value (entered in the index column) and its probability (entered in the value of a table entry). The probabilities in the value column must total 1.0.

To create a Table distribution from an existing empirical data set:
- Use the Table Properties View to create a table and populate it with data that represents the custom distribution function. Refer to the Creating and Using Tables Chapter for details (see below).
- Within the Distribution Properties View, click the "add" toolbar icon to create a new distribution.
- In the Add/Change Distribution Dialog, select the distribution type "Table".
- Under "Distribution parameters", select the table from the list of the model's tables.
- Enter a name and description for the distribution.
- Click OK to save the distribution and close the Add/Change Distribution Dialog.

**Table used as basis for the Table Distribution**

Create Table Distribution. The Table must be referenced as highlighted.
To randomly sample from the Table distribution, simply reference the distribution in the standard way: use either the distribution’s name or the Dist(n) function using the distribution’s index within the model.

Sample values will only be drawn from exact table entry indexes, regardless of which lookup method you specify. TreeAge will not interpolate in a Table distribution. The mean value of the Table distribution will be used as the distribution’s expected value in non-Monte Carlo calculations. Use the Dist(index; 2), Dist(index; 3), etc. distribution reference sequence to sample based on probabilities in the second, third, etc. value column.

21.4.2 Creating a TableProb distribution

TableProb distributions allow you to use a table of probabilities as the basis of a distribution for drawing time-to-event samples. This is particularly useful for integrating background mortality into a DES model since background mortality frequently does not conform to a parametric distribution (like Weibull or Gompertz).

A TableProb distribution uses a table as its primary parameter. The table can be either a probability table or cumulative probability table. Typically, a TableProb distribution would use a published mortality probability table.

We will use the DES Tutorial Example, TableProb Distribution.trex model, which has examples of two TableProb distributions, one from a probability table and one from a cumulative probability table.

21.4.2.1 Review the probability tables (mortality)

In the example model there are two tables:

- **tMortBackground**: A probability table with sparse index entries. The first value starts at 0 and last value ends at 1, see tMortBackground in the figure below.
- **tMortBackground_CumInt1**: The cumulative probability table (from tMortBackground).

For both types of probability table, the first and last rows in the table must have values 0 and 1, respectively. The index for these tables represents time in cycles (typically years).
The background mortality (probability) table with value entries starting at 0 and ending at 1.

21.4.2.2 Converting between probability tables and cumulative probability tables

Depending on the data available you may want to convert between probability and cumulative probability tables.

- In the Table Properties View select the table to convert.
- Select the icon "Convert Table".
- Using the Convert Table dialogue, as per the figure below, give the new table a name.
- If converting from a probability distribution with sparse indices, choose the option "interpolate the interval size = 1" which will create an entry at every index.
- Select OK to close and create the new Table.

Convert Table dialogue to convert between probability and cumulative probability tables.

The interval size of 1 mimics interpolation in a standard table lookup. Using this interval, the resulting cumulative probability table will include index values for every year with the cumulative probability interpolated from the closest rows in the probability table.

💡 The same conversion logic used to create a cumulative probability table directly is used implicitly when you create a TableProb distribution using a probability table.
21.4.2.3 Create a TableProb Distribution

To create a TableProb distribution from a standard probability table (e.g., mortality):

- Use the Table Properties View to create a table and populate it with data that represents a Mortality Table. Refer to the Creating and Using Tables Chapter for details. In the Example model, this table is called tMortBackground.
- Within the Distribution Properties View, click the "add" toolbar icon to create a new distribution.
- Enter a name and description for the distribution (the model uses TimeToDeath_ProbTable_Int1).
- In the Add/Change Distribution Dialog, select the distribution type "TableProb".
- Under "Distribution parameters", select the table (tMortBackground) from the list of the model's tables.
- Select table type: Probability (Mortality) Table; and select: Interpolate to interval size =1, if your table does not have a row for each Index.
- Select Sampling Rate: Resample per individual trial.
- Click OK to save the distribution and close the Add/Change Distribution Dialog.

TableProb distributions using cumulative probability tables perform no interpolation. If you want better control than linear interpolation between rows of a probability table, you can convert to a cumulative probability table, then modify the data for a better fit for your parameter.
To create a TableProb distribution from a cumulative probability table:

- Use the Table Properties View to create a table and populate it with data that represents a Mortality Table. Refer to the Creating and Using Tables Chapter for details. In the Example model, this table is called tMortBackground_CumInt1.
- Within the Distribution Properties View, click the "add" toolbar icon to create a new distribution.
- Enter a name and description for the distribution (the model uses TimeToDeath_CumTable_Int1).
- In the Add/Change Distribution Dialog, select the distribution type "TableProb".
- Under "Distribution parameters", select the table (tMortBackground_CumInt1) from the list of the model's tables.
- Select table type: Cumulative Probability Table.
- Select Sampling Rate: Resample per individual trial.
- Click OK to save the distribution and close the Add/Change Distribution Dialog.

Create TableProb distributions from cumulative probability table

21.4.2.4 Sampling from a TableProb distribution

You can reference the distribution anywhere in your model to use a sample during simulations. The internal mechanism performed during the sampling is described below.
When a TableProb distribution is sampled, a random number between 0 and 1 is drawn. That random number is then used do a reverse lookup in the values in the cumulative probability table, returning the appropriate index value.

If the TableProb distribution references a probability table, that table is internally converted to a cumulative probability distribution (with or without interval interpolation) prior to the reverse lookup described above.

21.4.3 Using a distribution to lookup values in a table

There are situations where distributions cannot be easily represented using a standard distribution type, or a regular Table distribution as described above.

For instance, perhaps you have a table of age-dependent probabilities or costs that you want to do a probabilistic sensitivity analysis on. Or, you might have a set of observed parameter values that you want to bootstrap from with each row’s value given an equal probability (or even selected in order).

In these cases, you could populate the table and then use a separate distribution to sample row indexes and/or columns indexes.

For example, you could fill a table with observed data, numbered from 1 to N, and then pick values randomly from the table using a uniform distribution with a range equal to the range of table indexes. In this case, use the integer form of the Uniform distribution (to return only integers in the index range).

To sample from a table using a Uniform distribution:

- Enter/paste your data set into a TreeAge Pro table, using consecutive integer indexes in the index column and the data set’s values in the value column.
- Within the Distribution Properties View, click the "add" toolbar icon to create a new distribution.
- In the Add/Change Distribution Dialog, select the distribution type "Uniform".
- For the low value, enter the lowest integer index from your table (i.e., 0 or 1). For the high value, enter the highest integer index from your table.
- Enter a name and description for the distribution.
- Click OK to save the distribution and close the Add/Change Distribution Dialog.

The actual reference in a tree formula should look something like the following:

```
TableX[Dist(1)]
```

where “TableX” is the name of the custom distribution table, and inside the square brackets is the reference to the Uniform distribution (assumed to have the index 1 in the example above). During a second-order simulation, the Uniform distribution will be resampled within its range, causing different rows from TableX to be drawn randomly with an essentially equal likelihood if done correctly.
It may also be possible to pick rows from the table in order during a simulation by using the keyword \_sample (for sampling, use \_trial for microsimulation) in place of the Uniform distribution. The \_sample counter corresponds to the current iteration of the probabilistic sensitivity analysis simulation, incrementing by one at each resampling iteration.

To pick from a particular column in a multi-column table, simply add the appropriate column parameter to the table reference, such as:

\[TableX[Dist(1); 2]\]

To convert a time-dependent table of values for sampling, you might add additional columns that represent percentiles or bounds of each row. Then, you would use a distribution to sample a column index (i.e., between 2 and 3):

\[TableX[\_stage; 2+Dist(1)]\]

### 21.5 Correlated Inputs - MultiNormal Distribution

Model inputs can be correlated such that changes in one input are related to changes in other input(s). If you sample these inputs from independent distributions, this correlation is ignored. If correlations are ignored within the context of probabilistic sensitivity analysis, it can lead to more variance in your results than is realistic.

Input correlation can range from -1 to 1.

- 1 represents 100% correlation between inputs
- 0 represents no correlation between inputs
- -1 represents 100% correlation in the opposite direction between inputs

To incorporate correlations when sampling values, you can use a MultiNormal distribution. MultiNormal distributions include multiple correlated variates and generate correlated samples for each of those variates. For example, if you have three correlated inputs, you would create a single MultiNormal distribution with three correlated variates, generating three sets of correlated samples.

The rest of this section describes how to create and use MultiNormal distributions for parameters in the context of Probabilistic Sensitivity Analysis (PSA). But you could also use MultiNormal distributions for patient characteristics in the context of Patient Simulation (Microsimulation).

In 2019 R2.0, the MultiNormal distribution was re-implemented to make it easier to use. If you open a model with the older version of a MultiNormal distribution, TreeAge Pro will convert the distribution to the current format. Note that the conversion is not backward compatible.
21.5.1 Correlation Example Model

The Healthcare tutorial example model *TreeAge MultiNormal Distribution Correlation.trex* is a Cost-Effectiveness decision tree comparing two treatments.

![Decision tree with MultiNormal distribution](image)

In each strategy, the patient pathways depend on the probability of eradicating the tumor. The probabilities in the two strategies are different – as represented by the variables pEradicateRad and pEradicateRadSurg.

For Probabilistic Sensitivity Analysis (PSA), those variables reference distributions. The model is set up to sample probabilities either with or without correlation between the two probability inputs. That way we can examine the impact of correlation on the PSA results.

- No correlation – set variable correlatedSw = 0. The two probabilities are sampled from independent normal distributions.
- Correlation – set variable correlatedSw = 1. The two probabilities are sampled from a single MultiNormal distribution which generates two correlated samples.

We will examine the results from PSA with and without correlation later in this section.

Note that typically beta distributions would be used for probability parameters, but normal distributions are used in this example.

21.5.2 Creating a MultiNormal Distribution

Although the example model *TreeAge MultiNormal Distribution Correlation.trex* used in this chapter already has the MultiNormal distribution created, this section describes how to create one.

*Creating a MultiNormal Distribution:*

1. Open the Distributions View.
2. Click the “+” button to create a new distribution.
3. Enter the name of the distribution.
4. Scroll down the list of distribution types to select MultiNormal.
5. Click the Edit Matrix & Options button (See figure Screenshot #1). A second dialog “Edit Matrix & Options” will open (See figure Screenshot #2)
6. Enter the number of variates (minimum 2).
7. Select the appropriate Matrix type based on the form of your correlation data. This likely depends on the software used to generate the correlations.
8. Click on the column headings above the matrix and enter names for each variate within the MultiNormal distribution (optional) (See figure Screenshot #2 where Radiation and Rad_Surg have been entered as the column headings).
9. Enter the correlation data into the matrix grid.
10. Enter mean values for the individual variates.
11. Enter standard deviation (or scaling) values for the individual variates. Note that matrix types have variance built-in, so you would not enter the variate standard deviations.
12. If you have the matrix, mean and standard deviation data in Excel, you can copy and paste the data directly into the Matrix dialogue. Use the copy and paste buttons above the matrix.
13. Click OK to return to the Add/Change Distribution dialog.
14. In this example, the resampling rate is “Resample per EV” for use in PSA, which is what we want in this context.
15. Click OK to save the distribution.

Screenshot #1: Add/Change Distribution dialog for the MultiNormal distribution
Screenshot #2: Edit Matrix & Options dialog for the MultiNormal distribution

For the top two matrix types shown in Screenshot #2 above – Variance/Covariance and Correlation – TreeAge performs the Cholesky decomposition prior to sampling. Use the "Show Cholesky" button to show the calculated Cholesky Matrix as per TreeAge.

For the second two matrix types – Cholesky (Var/Covar) and Cholesky (Correlation) – the Cholesky decomposition has already been incorporated into the matrix, so TreeAge Pro does not apply it again. Depending on the software you have used to generate the correlations, you can enter data in any of these 4 formats.

Once your MultiNormal distribution is created, select the distribution in the Distributions View and click the "Graph It" icon within the Distributions View toolbar to see the samples generated for each variate of the MultiNormal distribution. Note that you can’t see the correlation between the variates via these independent graphs.
21.5.3 Referencing the MultiNormal Distribution in the Model

Although the Healthcare tutorial example model *MultiNormal Distribution Correlation.trex* used in this chapter already has the MultiNormal distribution incorporated, this section describes how it is referenced.

As with any distribution, it must be referenced within the model to have any impact on results. Many distributions just return a single value each time they are sampled, and these would be referenced directly, that is \( pVariable = dist\_for\_pVariable \). Distributions such as MultiNormal and Dirichlet that have variates (that is they can return several values) must be referenced differently, so you can specify the variate you want. The two forms are presented below.

- By name: \( \text{Dist("DistName"; "VariateName")} \)
- By index: \( \text{Dist(DistIndex; VariateIndex)} \)

You can also reference the distribution by name, and the variate by index or vice versa. Note that name entries are always placed in quotes, while index entries are not.

In our example model, the MultiNormal distribution is referenced with the first form above, but it is used only when \( correlationSw = 1 \). Therefore we see the following definitions:

- \( pEradicateRad = if( correlatedSw=1 ; \text{Dist("dist\_pEradicateBoth"; "Radiation"); dist\_pEradicateRad}) \)
- \texttt{pEradicateRadSurg = if( correlatedSw=1 ; \texttt{Dist("dist\_pEradicateBoth"; "Rad\_Surg");
\texttt{dist\_pEradicateRadSurg})

When running PSA with the variable \texttt{correlationSw = 0}, samples for the probabilities are assigned from two independent Normal distributions – \texttt{dist\_pEradicateRad} and \texttt{dist\_pEradicateRadSurg}. When running PSA with \texttt{correlationSw = 1}, samples for the probabilities are assigned from two variates of the MultiNormal distribution.

21.5.4 Impact of Correlation on PSA Results

To see the impact of parameter correlation, we can run PSA on the model first without correlation (\texttt{correlationSw = 0}), then with correlation (\texttt{correlationSw = 1}). In this model there is a high correlation between the parameters (0.8), so we expect the probabilities to change in a similar manner from sample to sample.

We specifically look at the ICE Scatter plot to illustrate the impact of parameter uncertainty – first without correlation, then with correlation.

![PSA results - ICE Scatterplot with no correlation (correlationSw = 0)](image)

Without correlation, incremental effectiveness variance ranges from around 0.6 to 2.3.
PSA results - ICE Scatterplot with correlation (correlationSw = 1)

In the figures above, with correlation, incremental effectiveness variance ranges from around 0.9 to 1.8. With high correlation between the sampled probabilities, the effectiveness values for the two strategies change together. This reduces the incremental effectiveness between the strategies' results. The reduction in the incremental cost range is less visible because incremental cost is also affected by a separate distribution dist_cSurgery.
22. Creating and Using Tables

This chapter provides instructions on creating tables of numeric values for use in custom sampling distributions and other tree calculations.

22.1 Creating and editing tables

TreeAge Pro can store indexed tables of numeric values that represent parameters in your model. Here are some basic facts about tables:

- Tables are typically created and stored with models in *.trex files. This is similar to how *.pkg files worked in previous versions.
- TreeAge Pro supports the use of global tables. However, the default location for global tables is no longer in a "Tables" folder in the TreeAge Pro application folder. Rather, each TreeAge document/project workspace includes a "Global Tables" project. This is the default location of example global tables (e.g., "tMort.tblx"), as well as *.tblx files automatically converted from a previous version's global *.tbl files.
- In TreeAge Pro, each tree has its own preferences related to the use of Global Tables. It is possible to create sub-folders in the Global Tables project specifically for one or a group of tree models, and to use tree preferences to point to the appropriate sub-folder. Or, a tree can be set to ignore the Global Tables project and only utilize tables contained within the model.
- Every table has an index column and a value column. A table can have additional value columns (up to 512) and from one row of values up to tens of thousands of rows.
- Each row’s index value must be unique, but indexes are not required to be consecutive integers. TreeAge automatically numbers the value columns with integers (starts at 1).
- Tables can linearly interpolate values for missing indexes/rows, as well as columns.
- Only numeric values (no variable names or formulas) can be entered in a table.
- In Markov models, tables are often used to represent probabilities that vary over time (or other dimensions). Refer to the Building and Analyzing Cost-Effectiveness Models Chapter.
- A table can represent a parameter’s empirical probability distribution to sample from during Monte Carlo simulation. (Refer to the Distribution Functions, Options and Types Chapter for details on sampling from tables and other distribution types.)
- Table Values can be loaded into a table in a variety of ways, including: paste tab-delimited text; edit via the Excel add-in; query an ODBC database; manually enter index-value combinations.

Facts about tables

22.1.1 Tables View

Tables are created and maintained via the Tables View.

To open the Tables View:
Choose Views > Tables from the toolbar.

Within the Tables View, there are two sets of data and associated controls

1. List of tables and table controls to the left.
2. List of table entries and table entry controls to the right.

When a table is selected in the list, the table entry data and controls apply to that selected table.

The table property toolbar controls are described below from left to right.

- **Edit**: Edit the selected table from the list.
- **Add**: Create a new table.
- **Delete**: Deleted the selected table(s) from the list.
- **Duplicate**: Create a copy of the selected table and edit it as a new table.
- **Copy table**: Select the row with the table(s) you wish to copy. Click the copy icon to copy the table(s) into the clipboard. See the Variable Properties View for details about copying/pasting.
- **Paste table**: Copy table(s) (as above from another model) and click the paste icon to paste the table into the active model. See the Variable Properties View for details about copying/pasting.
- **Import**: Import table(s) from a global table file (*.tblx) into the model.
- **Export**: Export table(s) from the model to a global table file.
- **To Excel**: Copy the selected table and its data to Excel for editing.
- **Graph It**: Create a graph from the selected table’s data.
- **Report**: Create the Tables Used Report.
- **Highlight**: Highlight the table within the model in the Tree Diagram Editor.

The table data toolbar controls are described below from left to right.

- **Delete**: Delete the selected table entries from the table.
- **Add**: Add a new table entry to the table.
- **Copy**: Copy table data with headers and rows to clipboard.
- **Paste**: Paste table data with headers and rows from clipboard to table. Existing data is replaced.
22.1.2 Creating a new table

Before entering values into a table, you must first create a table.

To create a new table:

- Open the Tables View.
- Click the "add" toolbar button. This will open the Add/Change Table Dialog.
- Enter the table name and properties into the dialog (see below). The specific property options will be described later in this chapter.
- Click OK to save the table and close the dialog.

Add/Change Table Dialog

After the table is created, it will appear in the tables list within the Tables View. You can then edit the properties of the new table.

To change the properties of a table:

- Select a table in the list.
- Click the "edit" button in the toolbar.
- Change the table properties in the Add/Change Table Dialog.

22.1.3 Entering values in a table

To populate a simple table, use the table entries toolbar and table data grid.

To enter table data:

- Select the table in the tables list.
- Click the "Add Row" button in the table entries toolbar. A new table row will appear in the table data grid.
- Change the values for the data row as needed.
- Repeat prior two steps to add more data rows.

![Tables View - with table and data](image)

This method of entering data can be time consuming. There are other methods available for loading table data. Those methods are described in subsequent sections.

### 22.1.4 Loading/copying tab-delimited table data

To modify the values in an existing TreeAge Pro table, it may be more efficient to copy the table rows into a spreadsheet or text file for editing. Or, if you have a new, empty TreeAge Pro table, you can create the rows in a spreadsheet, and then copy and paste into the Table Rows list editor.

![Tables View, Rows editor - Copy table data](image)

To edit table data in *Excel* or a text editor:

- Select the table in the Tables view.
- Click the Copy button in the Table Rows editor, as shown above.
- Paste the rows into a spreadsheet or text document.
- Edit the data as tab-delimited text.
- Copy the table data, including headers, into the clipboard.
- Click the Paste button in the Table Rows editor.

Take note of the following requirements:

- A column title row is not required. If one is not included, they will read: Index, Value1, Value 2 etc. Otherwise you can select any column heading (Index or Value columns) and rename them.
- The selected range of cells should use either General, Text, or Number formatting (avoid accounting formats using parentheses for negatives numbers).
- The copied range should not include empty columns or rows.
- Note that the Paste Table command first removes existing rows from the table. However, the command is undo-able.
- If the Paste command is not available, or does not work, see the bulleted list of suggestions above on proper cell formatting in the source document. If all else fails, try first pasting the spreadsheet data into a plain text file to remove formatting, and then copy the text file data into TreeAge.

22.1.5 Editing index and value column headers

You can enter custom column headers for the index and value columns by clicking on the header. You can then enter the custom column header into an input dialog.

22.1.6 Editing table data in Excel

Users with the optional Excel Module can export table data to Excel, edit the data in Excel, then import the edited data back into TreeAge Pro. This technique is described in the Excel Module Chapter.

22.2 Referencing tables in formulas

There are two basic ways to use tables:

1. In order to look up a value in the table from a payoff, probability, or other calculation, you will need to use the proper syntax (below).
2. If a table is used as a sampling distribution, simply select its name from a list of tables when setting up the distribution (described later in this chapter).

22.2.1 Table lookup syntax

In a table composed of index-value pairs (i.e., one column with an index and a value column), a value can be retrieved with the following syntax:

\[ \text{TableName}[\ index ] \]

The table's variable-type name (\textit{TableName}) is followed immediately by square brackets containing an \textit{index} used to pick a table row. The index expression can be a number, a variable, or even another table reference.

If a table has more than one column of values, you will need to specify the number of the column you want to pick from. The syntax will now required row index argument first and then column number:

\[ \text{TableName}[\ index; value\_column ] \]

The \textit{value\_column} expression can also be a number, variable, etc. However, this expression normally resolves to an integer value \(\leq\) the number of columns in the table. Note that when looking at the table, the first value column is actually the second column in the table because the first column contains the index.

For tables with more than one value column, table lookups without a \textit{value\_column} provided will use the default value column defined in the table properties.

\textit{Reverse table lookups}

Special syntax for the Command() function enables reverse table lookups. This is designed to facilitate, for example, using a uniform\([0,1]\) random number to "sample" age-at-event table from an age-indexed table whose value columns describe one or more inverse "survival" functions, or "cdfs". The syntax is:

\[ \text{Command("TABLES";\_t\_events";ReverseLookup"; prob; value\_column)} \]

Other methods are: "ReverseLookupInterpolate", "ReverseLookupTruncate", and "ReverseLookupCeiling". Refer to the Tools and Functions for Complex Trees Chapter for additional information.

22.2.2 Table lookup methods

During tree calculations, if a formula references a table using an index value that matches a row index in the table exactly, TreeAge simply returns the value from the appropriate column in that row. However, when a reference is made to a non-existent row/index, the table's missing row lookup method determines what is returned.
The missing row/column lookup methods are:

- **Truncate**: If rows with lower indexes exist, returns the value from the row with the highest index that is less than or equal to the requested index; otherwise, returns the value from the first row (i.e., the lowest index value).

- **Use linear interpolation**: Returns a value calculated by linear interpolation between existing indexes. This is the default lookup method.

- **Error**: Report an error if an index value is provided that is not in the table.

### Table lookup methods

Each table also has an “Index off edge is error” option. If this option is left unselected, a table that uses truncation or interpolation will allow references to indexes above or below the table’s actual range. In these cases, the table will return the value associated with the closest existing row or column. If this option is checked, on the other hand, an error will be reported.

TreeAge Pro supports interpolation of both rows and columns. The table below is used to show how TreeAge Pro handles table lookups with interpolation.

<table>
<thead>
<tr>
<th>Index</th>
<th>Value1</th>
<th>Value2</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>1,000.0</td>
<td>20,000.0</td>
</tr>
<tr>
<td>20</td>
<td>3,000.0</td>
<td>20,000.0</td>
</tr>
<tr>
<td>30</td>
<td>3,000.0</td>
<td>30,000.0</td>
</tr>
<tr>
<td>40</td>
<td>4,000.0</td>
<td>50,000.0</td>
</tr>
</tbody>
</table>

#### Table interpolation example

Interpolation starts with the value for the index below the provided value. Then it adds the difference between the next higher value and the lower value based on the proportion of the way from the lower index to the higher index.

\[
TestTable[14;1] = TestTable[10] + ((14-10)/(20-10))*(TestTable[20]-TestTable[10])
\]

\[
TestTable[14;1] = 1,000 + (4/10)*(1000) = 1,400
\]

\[
TestTable[30;1.3] = 3,000 + ((1.3-1)/(2-1))*(30,000-3,000) = 11,100
\]

TreeAge Pro supports simultaneous interpolation of both rows and columns. First interpolation is done on the row values and then those row interpolated values are used for the column interpolation.

\[
TestTable[16;1] = 1,600
\]

\[
TestTable[16;2] = 16,000
\]

\[
TestTable[16;1.4] = 1,600 + ((1.4-1)/(2-1))*(16,000-1,600) = 1,600 + (.4/1)*14,400 = 7,360
\]

### 22.3 Model tables and global table files

By default, tables are stored within the model document (extension *.trex). We recommend that you leave the tables within the model. However, it is still possible to create and use Global Table files to store the tables separately.
Global Table files (extension *.tblx) store tables, which can then be referenced by multiple models. During analysis, TreeAge Pro will first look for a table within the model. If the table is not found, it will look for the table in a Global Table file. The name of the Global Table file does not matter, but the location of that file is key.

You can choose whether to look for table data in Global Table files and specify the location of Global Table file(s) for a specific model via Tree Preferences. If the default path is not stored in Tree Preferences, TreeAge Pro will search for Global Table files in the following locations.

1. <workspace>/Global Tables
2. <workspace>/Example Models/Special Features/Global Tables

If a Global Tables file is found in the first location, it will not search the second location.

Open the Special Features tutorial example tree, Global Tables Model.trex to see a model which references a table from a Global Table file in one of the default locations.

The next sections demonstrate how to export tables to and import tables from a global table file.

### 22.3.1 Exporting tables from a model to a global table file

**To export tables:**

- Open a model with tables.
- Choose Views > Tables from the toolbar.
- Select the tables you wish to export.
- Click the "Export Global Tables" icon from the Table Properties toolbar.
- In the Export Tables dialog, specify the tables file and select the tables you wish to export.

![Export tables to global tables file](image)
22 Creating and Using Tables

The global tables file can then be opened as you would open a tree document. When opened, the global tables file will appear in the Tree Diagram Editor. However, its appearance will be very similar to the Tables View for the original model.

Global tables file

22.3.2 Importing tables from a global table file to a model

To import tables:

- Open a model.
- Choose Views > Tables from the toolbar.
- Click the "Import Global Tables" icon in the Table Properties toolbar.
- In the Import Tables Dialog, select the global tables file.
- Select the specific tables from the global tables file that you want to import.
The tables will then be included in the model and can be referenced in expressions.

### 22.4 Importing tables from older versions of TreeAge Pro (2009 and earlier)

You may have TreeAge Pro tables that were created in TreeAge Pro 2009 or an earlier version. Rather than re-entering the table properties and data, the table data can be imported into the current version of TreeAge Pro.

If you look in the Files View, there should be a Global Tables project. This may contain *.tblx files created by automatically importing older *.tbl files found in a previous version’s “Tables” sub-directory. (Each time a new workspace is created, #2 below is automatically performed.)

A *.trex model can utilize the tables contained within a *.tblx Global Table for analysis purposes. These tables can be edited by double-clicking on the *.tblx file to open a tables editor.

There are a number of other options for importing table data into a tree model or a Global Tables project or folder, for example:

1. Import directly into *.trex model from a v200x *.pkg packaged tree, or from a previous version's "Tables" sub-directory.
2. Create a single *.tblx file containing all global tables from a v200x *.pkg, or the v200x "Tables" sub-directory.
3. Create individual *.tblx files for each global tables from a v200x *.pkg, or the v200x "Tables" sub-directory.

In TreeAge Pro 2009 and earlier, by default, tables were written to global table files (*.tbl) stored in a specific folder on your computer. You also had the option of saving your model as a package file (*.pkg), which would include the tables used by the model within the model document itself.

If you open an older package file in the latest version of TreeAge Pro, it will convert both the model and its tables into a current TreeAge Pro model file (*.trex). No specific action is required for the tables because the tables that were included with the original 2009 package file are also included with the current model file.

However, when you open a v200x tree file (*.tre), any referenced tables will not be converted with the model because the tree file does not contain table data. However, the required *.tbl files may already have been imported as *.tblx files in the Global Tables project in your workspace. If this is the case, analyses of the imported tree may work immediately without further action. If required *.tbl files were not accessible (e.g., previous version was on a different computer), you have two options: save the v200x tree file as a package file before conversion, or manually import the global *.tbl table files required by the tree file.
You can import all the 2009 table files (*.tbl) at once from the 2009 global table directory or you can import the tables contained within a 2009 package file (*.pkg). In either case, the tables can be imported either directly into the active tree document, or into a global table file.

To import 2009 tables:

- Click the "Import Tables" button in the Tables view toolbar, and then click the button labeled "Import v200x Tables"; or
- Choose File > Import/Export > Tables Import...
- The Import TreeAge Pro 200x Tables dialog will open.

![Import TreeAge 200x Table Files Dialog](image)

This dialog provides options for selecting the location of the table's source, the list of tables, and the target to receive the tables.

Let's say you want to import some or all of the global tables from your previous TreeAge Pro 2009 installation into the currently open tree document, which perhaps was imported earlier from a v200x *.TRE file. In the dialog you would...

1. Browse to a Tables folder from a previous TreeAge Pro v200x installation. (The default path, if it exists on the computer, will be entered for you.)
2. Select the desired tables to import.
3. Use the default, selected target, which will import into the currently active tree.

After you click Finish, the open tree document's list of tables will be updated to include the imported tables.
Or, instead, you can choose to import the tables into a new or existing Global Tables file for modification and eventual re-import into a Tree Document. After you click the Finish button, the import is executed; if necessary, a new Global Tables project will be created in your TreeAge Pro Workspace. Within the Global Tables project, the *.TBLX files will be updated/created.

Global Tables project with imported tables

To make changes to the imported tables, open the Tables document file (e.g., "04-Feb-10.TBLX") in the Global Tables project. When tables contained in the Tables document are needed for a particular tree, simply go to the tree document's Tables view and import tables from the tables document.

Variations on the import described above include:

- Import 2009 tables from a 2009 package file (*.PKG) rather than the v200x Tables folder.
- Import 2009 tables to an existing global tables document (*.TBLX) rather than a new tables document.
- Import 2009 tables to a folder rather than a single tables document; each table is contained in a separate Global Tables document within the folder.
22.5 The All Tables Report

The All Tables Report displays all the tables that exist and/or are referenced in the tree.

![All Tables Report](image)

The "Unused" column indicates that a table exists in the tree but is never referenced. The "Missing" column indicates that a table is referenced in the tree, but does not exist.

22.6 Managing tables using the Excel module

Users with the Excel/COM module can utilize the TreeAge add-in menu in Excel to update TreeAge with changes made to tables stored in a spreadsheet. Refer to the Graphing, Reporting and Modeling Using Excel Chapter.

It is also possible to use the TreeAgeProLib to script changes to tables. Refer to the Using the TreeAge Pro Object Interface Chapter.

22.7 Linking a table to an ODBC data source

TreeAge Pro includes the option to link a table to an existing database or other data source that has an ODBC driver. Linking a table to a database is an easy way to make table updates automatic.

TreeAge Pro tables can use ODBC to access most commercial and open-source database formats, including: MySQL, SQL Server, Access, Firebird, as well as Excel spreadsheets, text-format files, and XML files. A standard SQL SELECT query is used to select columns and rows from a table in the data source, which then replace the contents of the target TreeAge Pro table.

22.7.1 Using ODBC data sources in Windows

Before you can attach a TreeAge Pro table to an ODBC data source, you must first create the ODBC connection to the data source. Microsoft has published instructions for on ODBC data sources on their website (Windows XP, Windows 7).
Creating ODBC data sources has become more complex with Office 2007 and Windows 7. Please refer to Microsoft documentation regarding creating ODBC data sources. Note that this example uses the 32-bit ODBC driver setup on a Windows 7 computer since no Office ODBC drivers were listed under the 64-bit Data Sources entry in the Control Panel.

In this document, we will create an ODBC data source in Windows XP that connects to the following Excel worksheet saved on the computer.

Excel data source

Note that the data is contained within the named range `DataNamedRange`.

To open the ODBC Data Source Administrator in Windows 7 via the 32-bit drivers:

- Open the 32-bit ODBC Data Source Administrator by executing the program `C:\Windows\SysWOW64\odbcad32.exe`.
- Click the Add button.
- Select the Microsoft Excel driver from the list presented in the Create new Data Source Dialog (see below).
- Enter a data source name and select the workbook in the ODBC Microsoft Excel Setup Dialog (see below).

After creating the System DSN, it will appear in the ODBC Data Source Administrator Dialog.

Now that the ODBC data source is ready, we can connect it to a TreeAge Pro table.
To connect a TreeAge Pro table to an ODBC data source:

- Create a table via the Tables View.
- In the Add/Change Table dialog, click on the SQL Query option in the Table data provider area.
- For Data source, enter the value "ODBC 2.1".
- For Database, enter the name of the data source from the ODBC setup.
- Click Test to verify that the connection can be established.

To connect a TreeAge Pro table to an ODBC data source (continued):

- Click on the Query tab.
- Enter the query expression into the appropriate field. This example refers to the name data range in the Excel document. You can also refer to a worksheet within the document.
- Use the other options as needed.
Setup table with ODBC data source - 1

To connect a TreeAge Pro table to an ODBC data source (continued):

- Click on the Options tab.
- Enter options for when to load data and what to do with missing data from the data source.
Setup table with ODBC data source - 1

The table is now available for use in your model.
Model with ODBC table
23. Stored Analysis Abstracts and Sequences

TreeAge Pro allows you to store the settings used to perform many types of analyses. This chapter provides instructions on saving and using stored analyses. It also describes how to create simple stored analysis sequences that, for example, runs a series of simulations or sensitivity analyses.

For more complicated tasks, such as batching lengthy analyses, automating export of analyses to spreadsheets, or retrieving analysis parameters from a database or spreadsheet, you can use TreeAge Pro's Object Interface.

23.1 Using stored analyses

It is possible to save and reuse the parameters for most of the analyses available in the Analysis menu. This includes Monte Carlo simulation and all forms of sensitivity analysis. Analyses that cannot be stored include Graph Risk Preference Function, Show Optimal Path, Verify Probabilities, and Roll Back.

23.1.1 Create a stored analysis

To create a stored analysis, you must first run a regular analysis. TreeAge Pro can only save the last analysis, so you must save the stored analysis before running a second analysis on the model.

- Open the Three Vars example model.
- Select the root node.
- Choose Analysis > Monte Carlo simulation > Microsimulation (Trials) and start the simulation.
- Either cancel the analysis or allow it to complete.
- Select the tree in the Tree Diagram Editor.
- Choose Analysis > Stored Analyses from the menu. This opens the Tree Preferences category Stored Analyses.
- Click the Save Analysis button.
- Change the default name to something meaningful (see warning below) and click OK.
- Save the model.

Only certain analysis types can be stored - Monte Carlo simulation, sensitivity analysis and tornado diagrams.

For this example, we will save a stored analysis for a Monte Carlo simulation with trials on the Three Vars Get Started tutorial example model.

To store the parameters of an analysis:

- Open the Three Vars example model.
- Select the root node.
- Choose Analysis > Monte Carlo simulation > Microsimulation (Trials) and start the simulation.
- Either cancel the analysis or allow it to complete.
- Select the tree in the Tree Diagram Editor.
- Choose Analysis > Stored Analyses from the menu. This opens the Tree Preferences category Stored Analyses.
- Click the Save Analysis button.
- Change the default name to something meaningful (see warning below) and click OK.
- Save the model.

Use only letters, numbers and spaces in your stored analysis name if you want to use the analysis in a stored analysis Sequence. Sequences cannot handle punctuation.
If you are storing a Monte Carlo simulation to reuse, you do not have to let the simulation run to completion.

The instructions that TreeAge Pro needs in order to perform the exact analysis are stored in the Tree Preferences (the results of the analysis are not).

Tree Preferences - Stored Analyses

The top of the dialog shows a list of stored analyses and sequences. The bottom of the dialog shows the parameters used by the selected stored analysis.

23.1.2 Run a stored analysis

Once an analysis is stored, it is saved with the tree, and can be run as long as no significant structural changes are made where the analysis was originally run.

To run a stored analysis:

- Open the tree in which you have stored an analysis.
- Choose Analysis > Stored Analyses from the menu. This opens the Tree Preferences category Stored Analyses.
- Select a stored analysis from the list.
- Click Run.

Many analyses are dependent on the structure and variable definitions of your tree. For instance, the location (relative to the root node) of the node at which you originally performed a sensitivity analysis
must be unchanged from when you stored the analysis, and all analyzed variable definitions must be present in the same locations. If TreeAge Pro is unable to reconcile the different structures, it will not run the analysis.

23.1.3 Edit/maintain stored analyses

The Tree Preferences category Stored Analyses allows you to edit, rename, delete or copy a stored analysis.

To edit a stored analysis:

- Select an existing stored analysis.
- Edit the comment if desired.
- Click the pencil icon to edit the stored analysis parameters if desired.

Be very careful when editing stored analysis parameters since they are not labeled. In the example above, you could safely change the 100 to a different number of trials. In the case of a sensitivity analysis, you could edit a variable and/or its range.

You can also rename or duplicate an existing stored analysis using the appropriate buttons to the right of the stored analysis list.

23.2 Sequencing stored analyses

In TreeAge Pro, sequences of stored analyses can be defined and stored, like a batched analysis, for future use. Analysis sequences can greatly simplify tasks like batch processing a series of lengthy analyses, such as Monte Carlo simulations. Sequences can also be used, if you frequently do manual kinds of sensitivity analyses, by repeating any of TreeAge Pro’s built-in analyses over a range of variable values.

23.2.1 Creating an analysis sequence

This section provides a simple illustration of how the sequencing feature can be used to automate running a series of separate Monte Carlo simulations, each using a different value of a variable. We will assume that you already created the original Microsimulation stored analysis described earlier in this chapter.

To create a sequence of stored analyses:

- Choose Analysis > Stored Analyses from the menu.
- Click the New Sequence button.
- Enter a name for the new sequence (Simulations with var change).
- Select the new sequence in the stored analysis list.
- Click in the first line of the Content input list.
- Press \textit{CONTROL+SPACEBAR} to use autofill to bring up a list of existing stored analyses.
- Select the Monte Carlo simulation stored analysis.

At this point, you will have a sequence that simply runs a single stored analysis (see below).

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{stored_analysis_sequence.png}
\caption{Stored analysis sequence}
\end{figure}

In addition to stored analyses, you can also make minor modifications to the tree via sequence commands. The most common modification is to change the value of a variable at the root node. This is achieved through the following command:

\begin{verbatim}
Tree.defineRootVariable(variable, definition)
\end{verbatim}

Autofill can help create the sequence command.

The Special Features tutorial example model, Three Vars with Stored Analyses, contains four stored analyses and three sequences.
Note that two sequences "Run_analyses_to_screen" and "Run_analyses_to_RPTX". Both sequences run the three stored analyses "Rankings", "Monte_Carlo_1000_trials", and "Sensitivity_on_prob_extreme". However, the "Run_analyses_to_screen" sequence presents the analysis output within TreeAge Pro, while the "Run_analyses_to_RPTX" sequence suppresses that output from the screen and instead writes the output to a RPTX file, which can be opened later. Saving analysis results rather than displaying them can be helpful when you want to run a large number of analyses that could exceed your system resources if all results remain open.

### 23.2.2 Run/maintain analysis sequences

You can run, rename and delete a stored analysis sequence using the same buttons as for individual stored analyses.

Stored analysis sequences can be edited by selecting the sequence, then editing the Content field.
24. Linking with Excel and Other Applications

This chapter covers dynamic linking (Bilinks), a powerful tool for integrating a decision tree and an Excel spreadsheet.

24.1 BiLinks to connect with Excel

Bilinks facilitate communication between your model and a Excel workbook. This communication can take several forms.

- Pull parameters from Excel data
- Calculate values in Excel based on data passed from TreeAge Pro
- Pass analysis results from TreeAge Pro to Excel

This chapter will focus on each of the above.

24.2 Pull parameters from Excel via Bilinks

The most common use of Bilinks is to pull parameters specified in Excel into TreeAge Pro. This allows you to gather key parameters in Excel from individuals who are more comfortable with Excel, but then use TreeAge Pro for the actual model and analyses.

To illustrate this use of Bilinks, consider the Bilinks tutorial example tree LegalTreeVars-Bilink.trex. See below.
This is a simple legal model with 6 variables. Note that the variables do not have values directly in the tree. Instead, those values are pulled from Excel using the Bilink function. The Bilink function references an index that points to a specific Excel cell (or range). The Excel references are set up in Tree Preferences.

![Bilink Tree Preferences](image)

**Bilink Tree Preferences**

A TreeAge Pro model can only connect to a single Excel worksheet. That worksheet is selected and displayed at the top of the dialog. Note that if no path is provided, the worksheet must be placed in the same folder as the model.

Note that there are three sections to the Dynamic Links category of Tree Preferences.

1. Inputs - TreeAge Pro to Excel
2. Outputs - Excel to TreeAge Pro
3. Post-analysis Statistics Inputs to Spreadsheet

This example only uses the second section to pass data from Excel to TreeAge Pro as follows.

- **Index** - simply an index counter for reference via the Bilink function within the model.
- **Linked to** - reference to the named cell or range in Excel referenced by this link
- **Preview** - the current value of the cell or range from Excel
- **Description** - optional text to describe this link
TreeAge Pro references named cells within Excel via the Bilink(index) function or the BilinkName(name) function. When the TreeAge Pro model is analyzed, the data is pulled from Excel and placed in the variables defined with the Bilink function.

The figure below shows the model rolled back using the data from Excel.

LegalTreeVars-Bilink.trex rolled back

The figure below shows a similar model "LegalTreeVars-BilinkName.trex", which uses the BilinkName function instead of the Bilink function.

LegalTreeVars-BilinkName.trex

24.3 Dynamic linking with Excel via BiLinks

Dynamic linking provides you with a more robust connection between TreeAge Pro and Excel. Essentially, there is a flow of data between the two programs in the following order.

1. Pass data from TreeAge Pro to Excel based on the analysis context (node context, simulation iteration, etc.)
2. Recalculate the Excel workbook, and pass updated data from Excel back to TreeAge Pro.
3. After analysis is complete, send results from TreeAge Pro to Excel.
Steps 1 and 2 above can be useful if you have developed a complex set of cost or utility calculations in a spreadsheet. Step 3 above can be useful if you want the key analysis outputs to be presented in Excel and not just in TreeAge Pro.

Dynamic links work during any type of analysis (e.g. roll back, sensitivity analysis, and Monte Carlo simulation).

To illustrate the basic workings of dynamic links, consider the Bilinks tutorial example tree Bilink-Dynamic.trex pictured below.

Note that the Cost_with_tax variable referenced in each terminal node's payoff is defined using the BilinkName function. Let's examine the Bilink Tree Preferences and the associated Excel workbook to see how this will function when the model is analyzed.

The above Tree Preference settings show the three communication levels between TreeAge Pro and Excel.
1. TreeAge Pro variables *Num_days, Per_diem, and tax_rate* are defined within TreeAge Pro. Those values are passed to Excel cells with the same name ("Linked to" column above). Note that *Num_days and Per_diem* are defined differently in different parts of the model.

2. The Excel cell *Cost_with_tax* is passed back from Excel to TreeAge Pro based on each of the two contexts. For the top and bottom terminal node payoff expression, it uses the appropriate definitions for variables *Num_days and Per_diem*, so the values returned by Excel for *Cost_with_tax* are different.

3. After the analysis is complete, the mean value for each strategy is returned to Excel and placed in cells *result_opt1* and *result_opt2*.

### Communication between TreeAge Pro and Excel

Let's now examine the Excel Worksheet after analysis.

![Bilink-Dynamic-Worksheet.xlsx](image)

While the transfer of data during the analysis was performed twice, the worksheet will reflect the most recent transfer (for the second terminal node). Note that the values *Num_days, Per_diem, and tax_rate* all reflect the appropriate values as they would be used in the second payoff expression. Those values are combined in the formula for cell *Cost_with_tax*, which is then returned to TreeAge Pro.

Finally, the post-analysis mean values for the two strategies is then passed from TreeAge Pro to Excel in cells *result_opt1* and *result_opt2*, and the process is complete.

### 24.4 Creating a BiLinks report

A BiLinks report is useful if you have many dynamic links in your model. The BiLinks report details inbound BiLinks from Excel and outbound BiLinks to Excel.
The report provides the following information about inbound BiLinks from Excel:

- BiLink Index
- Linked Excel cell name
- Value from Excel
- TreeAge variable, if the variable is defined at the root node
- Description, if a description is provided from the BiLink entry.

The report provides the following information about the outbound BiLinks to Excel:

- Linked TreeAge Pro variable
- Linked Excel cell name
- Value to Excel
- Description, if a description is provide from the BiLink entry.

Using the BiLinks tutorial example, BiLinks-after.trex, use the following steps to generate a BiLinks report:

- Open Tree Preferences > Spreadsheet > Dynamic Links, as indicated in the Figure below.
- Select the button "Create BiLinks report" to generate the report.
- To change any of the outputs to and inputs from the spreadsheet, see the next section Calculating payoffs using Dynamic links.
24.5 Calculating payoffs using dynamic links: a simple example

This section describes how to create dynamic links to Excel. First open the BiLinks tutorial example, BiLink-before.tre and BiLink-worksheet.xls.

Once you have opened the tree and spreadsheet, there are three steps to setting up the dynamic link between them:

1. Link the tree to an output cell (or range of cells) in the spreadsheet.
2. Assign tree variable inputs to cells in the spreadsheet.
3. Define a payoff variable or other parameter in the tree to use the spreadsheet output.

24.5.1 Naming a spreadsheet cell

Before TreeAge Pro can connect to any input or output cells in the spreadsheet, these cells must be named. The BiLink tutorial example Excel file BiLink-worksheet.xls already has names assigned to the output cell (Cost) and the two input cells (Per_diem and Num_days).

To assign a name to a cell in Excel:

- Select the cell (or range of cells).
- Click in the Name box (see below) and type a one word name (like a TreeAge variable name).
- Press the ENTER key to save the name.
If a cell (or range of cells) already has a name defined, it will appear in the Name box when the cell (or range of cells) is selected.

### 24.5.2 Linking to a spreadsheet cells

Once an output cell has been named, it can be linked to a TreeAge Pro tree as an input cell or an output cell (not both). In our model, we want to create two input cells for *Days of treatment* and *Cost per day* and one output cell for *Total cost*.

Both input and output cells are created via the Tree Preferences.

*To create the dynamic links:*

- Choose Tree > Tree Preferences from the menu or press the *F11* key to open the Tree Preferences dialog.
- Navigate to the category Spreadsheet > Dynamic Links.
- Click Browse to select the Excel spreadsheet (which must be saved).
- In the "Outputs from Spreadsheet" section, click the Add button. This should add the named cell *Cost*, which is the first named cell when sorted alphabetically.
- In the "Inputs to Spreadsheet" section, click the Add button. This should add the named cell *Cost*. Using the dropdown list within the Variable and Linked to columns, select *Num_days* in place of *Cost*.
- Repeat the above to create a link for the named cell *Per_diem*. 
The links are now set up to send the Num_days and Per_diem values from TreeAge Pro to Excel, recalculate in Excel, and then receive the Cost value back. The inputs to Excel are already linked to TreeAge Pro variables in the Tree Preferences via the Linked to columns. We still need to link the output from Excel value Cost to our tree. This is done via the Bilink function using the index value listed in the "Outputs from Excel" section of the Dynamic Links Tree Preferences.

To define a TreeAge Pro variable using the Excel output cell:
- Right-click on the root node.
- Choose Define Variable > Cost from the context menu.
- Enter the definition \textit{Bilink(1)} for the definition.
  The argument 1 refers to the index value of 1 for the Cost dynamic link in the Tree Preferences.
The inputs and outputs are now ready for calculation.

24.5.3 Calculate using dynamic links

Now, roll back the tree to verify that different values have been recalculated for each terminal node using the spreadsheet formula.

Bilink tree rolled back

Once the dynamic link is created, all calculations will utilize the linkage, not just roll back.

Excel must be running with the appropriate workbook open in order to create and/or use the dynamic links.

If the named linked cell is moved within the spreadsheet, the links will not be affected so as long as the linked cells’ names are not changed or lost.

The Bilink tutorial example model BiLink-after.trex already has the appropriate links. However, they will not work on your computer until the path to the workbook is fixed in the Tree Preferences.

24.6 Using a single link to a range of cells

If a link is created to a named range of cells, the Bilink() function's index argument is followed by two more integer arguments — the row and column of the desired cell within the range. For example...

\[ \text{Bilink}(1; 10; 2) \]

... will retrieve the value from row 10, column 2 of link #1’s region of cells.

This feature is demonstrated in the Bilink tutorial example Bilink-range.trex and Bilink-range.xls. See below.
The tutorial examples Excel model Bilink-range.trex will not work on your computer until the path to the workbook is fixed in the Tree Preferences.
25. Tools and Functions for Complex Trees

This chapter focuses on a number of features in TreeAge Pro that can be indispensable aids to both building and reviewing large and/or complex trees.

25.1 Working with very large trees

Many of the modeling exercises and examples in this manual are based on simple, small trees. The trees required in your own projects may be much more complex, perhaps including hundreds of variables, thousands of nodes, scores of distributions, etc. (Which is not to suggest that a bigger model is a better model, generally.)

Previous chapters detailed some of TreeAge Pro’s many productivity features designed to make it easier to work with large trees:

- Copy and paste subtrees.
- Collapse/hide subtrees.
- Use the zoom feature to see more/less of the tree structure in the editor.
- Use preferences that compress the tree.

This chapter focuses on additional productivity features relevant to complex modeling projects:

- Use the Explorer View and Model Overview for navigation
- View/edit the tree document’s XML
- Clone subtrees (rather than copying/pasting)
- Creating user-defined functions with Python
- Link calculations to other trees/subtrees
- Using special functions to perform specialized tasks automatically during calculations (e.g., run a macro, enable debugging, or export the Global matrix)

25.2 TreeAge Pro Workspace, Tree Explorer and Model Overview

The TreeAge Pro Workspace is highly customizable, allowing you to move, resize, hide and maximize views and editors based on the task at hand. If you have a very large model, you might consider customizing the workspace in different ways. To rearrange your workspace for greater efficiency when working in complex models, you might try reducing one of the arrangements shown below.
Workspace with Tree Diagram Editor maximized

Workspace with Tree Properties View and Node Properties View visible

You can save these customized workspace presentations in Perspectives. Existing perspectives are shown at the top right corner of the workspace. Click the add button to create a new one.
Within the workspace, two views in particular, the Tree Explorer and Model Overview, can be especially helpful when working with large trees.

### 25.2.1 The Tree Explorer View

The *Tree Explorer* shows a collapsible text view of the model.

![Tree Explorer](image)

You can use the Tree Explorer to navigate to specific nodes. When you select a node in the Tree Explorer, focus is set on the same node in the Tree Diagram Editor. You can also open the node-specific context menu by right-clicking on a node in the Tree Explorer.

### 25.2.2 The Model Overview View

The *Model Overview* presents a high-level view of the overall model, highlighting the portion of the model that is currently visible in the Tree Diagram Editor.
25.3 Viewing/editing document XML

TreeAge Pro documents are stored in XML format. TreeAge Pro provides the option to edit the document's XML in an XML editor or a text editor.

Unless you are quite familiar with the XML syntax used by TreeAge models, it is recommended that you use the TreeDiagram Editor to make all edits in models (in particular, adding/deleting nodes), rather than editing the XML text file itself. It is easy to render a model unreadable by making bad edits to the file XML.

However, it is simple to manually create copies/backups of *.TREX files before editing the XML. The Files view also supports robust text compare/local history features, via the right-click menu. This makes it possible to track and remove/reverse selected edits to any of your project files (whether changes are made in the Tree Diagram editor or a text/XML editor). Finally, the powerful Search/Find/Replace functionality used in combination with the Files view allows regular expression search/replace within the XML (and any other text-based project documents).

To open a tree in an XML editor:

- Right-click on a model in the Files View.
- Choose Open With > Text Editor.
The "default" method of opening the selected model will change when opened in this way. This means that next time you simply double-click on the file, it will again use the "Text Editor" to open. Therefore, it is necessary to right-click and choose Open With > Tree Diagram Editor in order to restore the original, default opening method.

To open a tree in an XML editor:

- Right-click on a model in the Files View.
- Choose Open With > XML Editor.

Open "Cost formula.trex" with XML Editor

The tree will appear in an XML editor within the workspace. You can also open the tree in a Text Editor, which shows the XML in plain text format.

The Special Features tutorial example tree "Cost Formula" is shown below in the XML editor.
XML consists of a hierarchical structure of textual data. In the XML editor, each level of the structure can be expanded or collapsed.

A portion of the basic XML structure of a TreeAge Pro tree is presented below.

```
Document
  - tree:Tree
    - - Node
    - - - Definition
    - - - Node (child)
    - - - - Node (child)
    - - Variable
    - - Sensitivity Range
    - - Categories
    - - Preferences
    - notation:Diagram
```

XML structure

Some notes on the XML format:

- The highest-level elements within the tree document structure are tree and notation.
- The `tree` element includes the building blocks of a model - variables, nodes, preferences. etc.
- The *notation* element contains details related to presenting the model in the Tree Diagram Editor.
- *Variable* elements are nested within the *tree* element because variables exist at the tree level.
- *Definition* elements are nested within a specific *Node* element because variable definitions are defined at the node-level.
- Some XML elements are not presented above (Markov info, payoffs, etc.), but they do exist within the XML structure.

A more complete, but not exhaustive, list of XML elements is presented in the following table:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Parent Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>tree</td>
<td>Highest level of the tree structure.</td>
<td>&lt;top level&gt;</td>
</tr>
<tr>
<td>notation</td>
<td>Controls presentation of the model in an editor.</td>
<td>&lt;top level&gt;</td>
</tr>
<tr>
<td>Variable</td>
<td>Variable name and properties.</td>
<td>tree</td>
</tr>
<tr>
<td>Sensitivity Range</td>
<td>Sensitivity analysis range for a variable.</td>
<td>Variable</td>
</tr>
<tr>
<td>Node</td>
<td>Node and its properties. Nested according to its location within the tree.</td>
<td>tree or Node</td>
</tr>
<tr>
<td>Definition</td>
<td>Variable definition associated with a node.</td>
<td>Node</td>
</tr>
<tr>
<td>CategoriesRoot</td>
<td>Variable categories for the tree.</td>
<td>tree</td>
</tr>
<tr>
<td>PreferenceSet</td>
<td>Tree preferences.</td>
<td>tree</td>
</tr>
<tr>
<td>Termination</td>
<td>Termination condition for a payoff set/calc methos</td>
<td>Node (type Markov)</td>
</tr>
<tr>
<td>Prob</td>
<td>Branch probability.</td>
<td>Node (with parent chance node)</td>
</tr>
<tr>
<td>MarkovData (state)</td>
<td>Collection for Markov information associated with Markov State (state rewards).</td>
<td>Node (with parent Markov node)</td>
</tr>
<tr>
<td>MarkovData (transition)</td>
<td>Collection for Markov information associated with Markov Transition (transition rewards, jump state).</td>
<td>Node (in transition subtree)</td>
</tr>
<tr>
<td>Payoff</td>
<td>Payoff expression for a specific payoff set at that terminal node</td>
<td>Node (type Terminal)</td>
</tr>
</tbody>
</table>

**XML Elements**

### 25.3.1 Editing XML data

You can edit the structure of the model or properties of a model element within the XML view of the document (although this is not recommended). Consider the following image of a tree both in the Tree Diagram Editor and the XML Editor.
Consider the `Value` attribute within the `Payoff` element for the `Node Foot Saved`. If we change the Value from 4500 to 5500, then save the file in the XML editor, the Tree Diagram Editor will reflect the same change.
Be sure to save all changes in the Tree Diagram Editor before opening the XML Editor for changes. Otherwise, you run the risk of overlaying your editor changes with a freshly updated version from the XML Editor.

Additional notes on XML editing:

- You can delete XML elements or move elements around within the XML structure.
- You can add new elements to the XML structure, but the xml:id must have a unique value for the new item.
- The File Search (Control + F) results are listed in XML format, so some knowledge of the XML format can be useful.

25.4 Cloning subtrees

Cloning subtrees allows you to reuse portions of the model structure without having to create or maintain the duplicated structure.

While you can duplicate existing subtrees by copying and pasting, subtree clones provide the advantage of keeping the original structure and the cloned structure synchronized, so any changes you make to the original clone master subtree are also automatically integrated into the cloned copy subtree.

- Copy/paste: copied structure is independent and can be edited.
- Clone: cloned structure cannot be edited because it remains synchronized with master structure

Clone copies function exactly like their associated clone master. However, variables within the clone master (and copy) can reference different variable definitions. This allows you to use different values for those variables within the clone master and copy. See cloning example below.

A few notes on clones:

- Multiple clone masters can be used in a tree, and can be nested.
- Each clone master can have multiple associated clone copies.
- Variables (and state bindings) referenced within a clone master can calculate differently in clone copies if the variables are defined differently outside the master/clone.
- Cloning only works within a single model tree.

### 25.4.1 Creating clone masters and attaching copies

The first step in the cloning process is to select a clone master subtree for the purpose of being replicated at another location in the tree. The clone master does not have to be a finished structure; all that is required is a single branch. The master subtree can continue to be updated after copies of it have been attached to other nodes in the tree.

In addition to the standard method described below for creating/attaching/detaching clones, TreeAge Pro also supports handling most of these operations in the Clone Master/Copies view as shown here. This view lists the tree's clone masters and all of the clone copies for a selected clone master. See the end of the section for more details.

Each subtree that is a designated clone master can be identified by a heavy bar beneath the branch leading to its root node. Like a copied subtree, what will be "cloned" will not include the root master node - only its subtree.

The remainder of this section uses the Health Care tutorial example model, Cloning Example.trex, shown below with existing clone masters/copies listed in the Clone Master/Copies View.
Cloning Example tree

To create a clone master:

- Identify the master subtree and and select the "anchor" node to the left of that subtree.
- Choose Subtree > Create Clone Master from the menu.
- Provide a short, descriptive name to identify this clone master (survival).
Clone masters are also assigned a numeric index which appears next to the clone master node.

Note that the clone master above is anchored at the complications node, which is not actually part of the clone master subtree. However, all nodes to the right of that anchor node are part of the clone master subtree.

Once the clone master has been created, the next step is to attach the clone copies at the appropriate node(s).

Clone copies can only be attached to nodes which have no branches. The nodes where you attach a clone copy should have the same node type as the root node of the master subtree. Attaching a clone copy to a node will not automatically change the type of the node to match the clone master’s root node. This change can be made manually, if necessary, either before or after attaching the clone copy. In our example, we will attach the new clone master to the no complications node (note that its subtree has been deleted before the attach clone steps below.

To attach a clone copy:
- Select an appropriate "anchor" node (i.e., a node with no descendants) where you want to attach the clone copy subtree.
- Choose Subtree > Attach Clone.
If you have only a single clone master in the tree, it will be attached to the selected node automatically. Otherwise, you must select the name of the appropriate clone master from a list, and click OK.

Currently, clone copies are always hidden, showing only references to the clone masters. In the future, the "Hide clone-copy subtrees" option in the Tree Preferences will be enabled so that you can uncheck the option. See below.
Tree Preferences - Show/hide clone copies

The "Hide clone-copy subtrees" option is currently checked and disabled. In the future, the option will be enabled to allow you to uncheck it to see the entire clone copy subtrees, which will be done in gray in order to distinguish them from editable subtrees.

To see a clone copy displayed prior to this tree preference being fixed:

- Save a temporary copy of the model.
- Detach the clone copy.
- When prompted, choose to create an editable copy of the clone master.

Currently, with the "Hide clone-copy subtrees" option always checked, you see a reference to the clone copy in the tree, but not the entire subtree. This reduces the overall size of the displayed tree. Showing/hiding clone copies does not affect calculations in any way.
Reducing the tree size by hiding clone copies enhances the clarity of the tree. The essential features of the replicated subtree can be seen by examining the clone master, which is the only instance of the subtree being displayed. In addition, the cloning linkages within the model, which might otherwise be missed, are clearly visible as each clone copy indicates the master to which it is linked to.

### 25.4.2 Destroying and detaching clones

If you want to remove clone copies from a tree, you can either destroy the current clone master (automatically detach its clone copies) or detach the selected clone copies one at a time.

There are two ways to destroy a clone master.

**To eliminate a clone master in the tree:**

- Select the clone master subtree or the subtree's root node.
- Choose Subtree > Destroy Clone Master from the menu.

**To eliminate a clone master using the Clones dialog:**

- Select the clone master in the list, and click the Delete ("Trashcan") toolbar button.

Destroying a clone master will “un-publish” the subtree. The subtree which was formerly the clone master will remain in the tree; all of its clone copies will be removed. You will be prompted with the option to replace those clone copies with independent copies of the clone master.

**To detach clone copies:**

- Select the clone copy subtree or the subtree's root node.
- Choose Subtree > Detach Clone Copy from the menu.

You will be asked if you want to keep an editable copy of the cloned subtree at the selected node. If you answer Yes, then the clone copy subtree is replaced by an independent copy of the clone master subtree. If you answer no, the clone copy subtree is simply removed.

### 25.4.3 The Clone Masters/Copies View

The Clone Masters/Copies View allows you to view and edit clones within the tree.

**To open the Clone Masters/Copies View:**

- Choose Views > Clone Masters/Copies from the toolbar.
Clone Masters/Copies View

The arrows in the figure above demonstrate the relationships between the clone masters/copies in the view and in the model.

Clone masters are listed in the left pane of the view. When one is selected, the clone copies associated with that view are listed in the right pane.

Both clone masters and clone copies can be deleted through this view with the same options and restrictions associated with deleting these elements in the Tree Diagram Editor, as described in an earlier section.

The arrows in the two toolbar of the Clones View can be used to move directly to either a clone master or a clone copy in the Tree Diagram Editor.

25.4.4 Nesting Clones

An important aspect of clones is the ability to nest clone masters. In other words, a single subtree may be comprised of multiple independent clone masters and also include various clone copies.

The tree shown below in the next section has three nested clone master subtrees. Clone masters 2 and 3 are nested within other clone masters and their copies.

You cannot attach a copy of a master subtree to itself. To create recursion, use a Markov node instead.
25.4.5 Using variables within clones

Calculations in clone copies are performed as if a full copy of the master subtree existed at the location of the clone copy. This is true even if you have turned off the display of clone copies in the tree.

Since clone copies are identical to the clone master, variables must be used in the clone master if you want its copies to have different probabilities and values. The probability, reward, and payoff expressions in the clone master and its copies will all use the same variables. However, each will be able to use different values for these variables based on how the variables are defined outside the clones. Variables referenced within the clones can be defined outside the clones. By defining variables differently to the left of the clone master and its clone copies, different values can be used by the same variable references within the clone master and copies.

The Health Care tutorial example tree "Cloning Example" provides a relatively simple example of using variables with clones.

Clones referencing a variable with different definitions

Note that the variable \( p\text{Compl} \) is used in the clone master, meaning it is also used in the clone copies. However, at the root of the clone master and clone copies, the variable is defined differently. This allows a different probability to be used for each of the subtrees.

25.5 User-defined Python functions

If there is no built-in function that does what you require, you can write a user-defined function using Python script and simply embed it in a regular variable definition in your tree.

Refer the the Python Chapter for more details.
25.6 Node(), Tree(), User(), Global() and other special functions

TreeAge Pro includes a variety of special functions which can be useful in complex models; several of these functions use string arguments. These functions are described in the next several sections of this chapter.

25.6.1 String-arguments and concatenation

Most TreeAge Pro functions accept only numeric arguments, although those numeric arguments can be provided via variables and expressions. However, a variety of functions use text/string function arguments. For example, the Tree function requires string arguments.

\[
\text{Tree("myTree_1.tre","Node(1;0)"})
\]

Most string arguments can be constructed using concatenation; in other words, text and calculated values can be combined into a new string. For example, the filename in the Tree() function could be concatenated (with a variable called "pick", in this case):

\[
\text{Tree("myTree_"+pick+".tre","Node(1;0)"})
\]

Similarly, the worksheet name in the function...

\[
\text{Command("Excel","ExportGlobalMatrix","Workbook;SheetName;CellName;LabelText")}
\]

... could be concatenated with a variable:

\[
\text{Command("Excel","ExportGlobalMatrix","Outfile.xls","sheet_+_trial+"_;...} \]

25.7 The Node() function

The Node() function can act as an internal linking function within a particular tree, allowing a node in one part of a model to retrieve calculated data from another part of the model. Some possible uses for the Node() function include:

- Access calculated expected values in non-active payoff sets (only use in terminal columns).
- Reuse a subtree at different locations in a tree for the active payoff set (similar to the way cloning is used, but with additional flexibility.

Note that the Node() function can be called from within another Node() function.

The simplest form of the function is presented below...

\[
\text{Node( attribute )}
\]

...where attribute is an integer referring to a payoff set. This value must be a positive integer referring to an enabled (not necessarily active) payoff set. The Terminal Columns model described in the Tree
Display Preferences and Options Chapter uses this Node() function syntax to display the expected value from a non-active payoff set in a terminal column.

The more complete function syntax is presented below:

Node( attribute; method; branch list )

- The argument attribute refers to the payoff set to use for the calculation.
- The argument method refers to the type of calculation to perform.
- The argument branch list refers to the node at which to perform the calculation.

The different forms of the Node function are described in the following table.

<table>
<thead>
<tr>
<th>Function Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node(Attribute)</td>
<td>Returns the stored expected value of the current node. Attribute is a positive integer corresponding to the number associated with an enabled payoff as specified in tree preferences. This syntax can be used to report extra payoffs in Terminal Columns only.</td>
</tr>
</tbody>
</table>
| Node(Attribute; 0; LIST)         | Returns the expected value as above, but from a node whose path is defined by LIST. Attribute:
   - Use -1 to perform CE calculations and return the new cost calculation
   - Use -2 to return a stored effectiveness calculation without recalculation after previously using -1
   - Use -12 to perform CE calculations and return the new effectiveness calculation
   - Use -11 to return a stored cost calculation without recalculation after previously using -12
   
   Method:
   The method argument 0 returns data from an expected value calculation rather than microsimulation. See below for Microsimulation option.
   
   LIST:
   The LIST argument is a reference to the path from the root node to the node where you want calculations performed. Refer to the figure below for a description of how the path LIST is defined. |
<p>| Node(Attribute; trials; LIST)    | Runs a series of n microsimulation trials at the node whose path is defined by LIST. Returns the average of the trials results. The Attribute and LIST arguments function the same as for the Node(Attribute; 0; LIST) syntax described above. The trials argument defines the number of trials for the microsimulation. |</p>
<table>
<thead>
<tr>
<th>Function Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>It is important to note some differences in behavior in Node() function trials, as compared to regular Monte Carlo microsimulation trials. The Node() function does not reset tracker variables to their default values before each trial (allowing trackers to be used to track information across the group of trials). By default, distributions do not resample per trial. To force distribution sampling, use tracker variables set equal to the DistForce(n) function, for example.</td>
<td></td>
</tr>
</tbody>
</table>

### Node function syntax

The figure below includes node labels that match the appropriate *LIST* value for the Node() function to use when referring to each node.

![Tree Diagram](image)

**LIST values for the Node function**

The Special Features tutorial example model *Node Function Syntax* illustrates the use of the Node function in a simple tree.

![Tree Diagram with Node Syntax](image)

**Node Function Syntax - simple model**

The top two terminal nodes' payoffs use the Node function to reference the *Lottery* node via the LIST value of 2. The top payoff returns the expected value, which is always 500. The second payoff returns
the value calculated by running 1000 trials at the *Lottery* node. This will return a different value near the mean of 500 each time you roll back the tree. The rolled back tree is presented below.

**Node Function Syntax - simple model rolled back**

The Special Features tutorial example model "Node Function Syntax CE" illustrates the use of the Node function in a cost-effectiveness tree.

**Node Function Syntax - simple model**

The top two terminal nodes' payoffs use the Node function to reference the *Survival* node via the LIST value of 2. The top cost and effectiveness payoff return the expected value for cost and effectiveness, which are always 5000 and 5. The second cost payoff returns the cost value calculated by running 1000 trials at the *Survival* node, while the effectiveness payoff returns the stored effectiveness value associated with that set of trials. This will return different cost and effectiveness values near the means each time you roll back the tree, but the cost and effectiveness values will be generated from means that are from the same set of trials. The rolled back tree is presented below.
If the cost and effectiveness payoff sets were reversed (1 vs. 2), then you would use -11 and -12 for the attribute arguments for the Node function.

25.8 The Tree() function

The Tree() function allows you to return a calculated value from another tree. For example, you could have two separate Markov models defined for specific strategies for treating a disease. You could then have a third tree with a decision node that uses the Tree() function to refer to each strategy tree.

The Tree() function is one of a number of TreeAge functions available which take double-quoted string arguments rather than just arguments that can be evaluated numerically. Like all functions, however, the Tree() function returns a numeric value.

For the purposes of this documentation, the tree relationship is described as a calling tree, using the Tree function to access a target tree.

It is recommended that Tree() functions be carefully tested in simple models before being used in complex models.

The Tree() function syntax is described in the table below:

<table>
<thead>
<tr>
<th>Function Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tree( &quot;target tree&quot;; &quot;calculation&quot; )</td>
<td>Opens a hidden copy of the specified tree or package file, and returns the results of the specified calculation. The target tree remains open for additional Tree() function calls. The &quot;target tree&quot; argument specifies the path and filename of the target tree to open for calculation. However, if the file is in the same directory as the calling tree, only the filename is needed. The &quot;calculation&quot; argument defines the calculation to be performed on the target tree. Usually the Node() function will be used here, in order to calculate a specific node in the target tree. Example usage: utilXYZ = Tree( &quot;c:\my docs\projects\xyz.tre&quot;; &quot;Node(1;0)&quot;&quot;) The Node() function, in this case, performs a simple expected value calculation at the root node of the target tree.</td>
</tr>
<tr>
<td>Tree( &quot;target tree&quot;; &quot;calc&quot;; 1 )</td>
<td>Same as above, but if the target tree is already open and visible, the linkage is left intact after the calculation; this allows analysis commands like rollback to be used on the visible target tree for debugging purposes. Note that if you use this option, the variables passed to the target tree will remain in place for further calls to that tree. If you are calling the target tree with other variable definitions later in the model, do not use the third argument.</td>
</tr>
<tr>
<td>Tree( &quot;calculation&quot; )</td>
<td>Can be used during an ongoing Tree() function evaluation in order to perform the given calculation at the root node of the current target tree.</td>
</tr>
<tr>
<td>Function Syntax</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>Tree( integer 0 )</code></td>
<td>Closes any open, hidden target trees. Use this, for example, if you open a target tree using the File menu and save changes to it. This will cause the next <code>Tree()</code> function call to reload the target tree file from disk.</td>
</tr>
</tbody>
</table>

Tree function syntax

When the function opens/accesses a target tree, normally a temporary linkage is created; the target tree’s root node becomes the “child” of the calling node. The power of the `Tree()` function is that a target tree can use variable definitions from the calling tree or to the left of the calling node. This works very much like variables in cloned subtrees. The trick is that the variable can be referenced in the target tree while having no definitions; the definitions can instead be in the calling tree. Note that the variable name must be declared in the target tree’s Variables list, although it would not be defined in the target tree. The target tree must be opened before the roll back to create this active connection.

The function's primary use is for modularization of complex trees. For example, it might offer an alternative to memory-intensive models in which hundreds or thousands of cloned copies of a Markov model are created. For example, 1000 terminal node payoffs could use the `Tree()` function to calculate the same Markov model, just with different variable definitions (rather than attaching 1000 clones of the Markov subtree). Calculation speed in most models will be better if the `Tree()` function is not used, and clones are used instead; expressions in the hidden tree that reference a variable defined in the calling tree cannot be optimized. However, using clones (or regular copies) can sometimes result in a tree whose memory requirements exceed available physical memory, resulting in an extreme decline in calculation speed. Building smaller trees linked by the `Tree()` function would be a good solution in this case.

The following example uses three Special Feature tutorial examples: Tree Function Syntax, Node Function Syntax and Node Function Variable.

- **Tree Function Syntax**: Calling tree that uses the Tree function to call the other two trees.
- **Node Function Syntax**: Self-contained tree referenced at the Lottery node.
- **Node Function Variable**: Same as above except that it needs to receive a definition for the variable `GetDefFromParent` from the Tree Function Syntax tree.

Let's look at the Tree Function Syntax tree - both its syntax and the roll back results.
The *Tree 0* terminal node calls for the expected value of the Node Function Syntax tree at the *Lottery* node, yielding a value of 500.

The *Tree 1* terminal node runs 100 trials on the Node Function Syntax tree at the *Lottery* node, yielding a value near, but not equal to 500.

The *Tree 2* terminal node runs 100 trials on the Node Function Variable tree at the *Lottery* node. The variable definition for *GetDefFromParent (10,000)* is passed from that node to the Node Function Variable tree. This yields a value near, but not necessarily equal to 5,000.

The *Tree 3* terminal node calls for the expected value of the Node Function Variable tree at the *Lottery* node. The variable definition for *GetDefFromParent (1,000)* is passed from that node to the Node Function Variable tree. This yields a value of 500.
The Tree 4 terminal node calls for the expected value of the Node Function Variable tree at the Lottery node. The variable definition for GetDefFromParent (100,000) is passed from that node to the Node Function Variable tree. This yields a value of 50,000. Because the Tree function contains a third argument (1), the connection from the tree to the target tree is maintained, allowing you to roll back the Node Function Variable Tree with the GetDefFromParent variable definition intact.

Target tree rolled back

In the figure above, the payoff expression at the Win node is GetDefFromParent. This evaluates to 100,000 based on the intact variable definition from the Tree Function Syntax tree.

A simpler and perhaps more realistic example is found in the Legal tutorial example models Legal-MainTree.trex and Legal-Subtree.trex. In this example, the subtree is used to determine the probability of proving negligence. The main tree then pulls that probability into the larger legal model considering damages.
Legal Model using Tree Function

The subtree returns the 0.56 probability of proving negligence, which is then used for the variable pWin in the main tree.

### 25.9 The Command() function

The Command() function can be used to perform specialized commands.

<table>
<thead>
<tr>
<th>Function Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Command( &quot;TABLES&quot;; &quot;table name&quot;; &quot;REVERSELOOKUP&quot;; value; column)</code></td>
<td>Returns index of row which matches &quot;value&quot; in specified column.</td>
</tr>
<tr>
<td><code>Command( &quot;TABLES&quot;; &quot;table name&quot;; &quot;REVERSELOOKUPTRUNCATE&quot;; value; column)</code></td>
<td>If value not found, base function, truncate version and ceiling version return an interpolated index, the next lower index and the next higher index, respectively.</td>
</tr>
<tr>
<td><code>Command( &quot;TABLES&quot;; &quot;table name&quot;; &quot;REVERSELOOKUPCEILING&quot;; value; column)</code></td>
<td></td>
</tr>
<tr>
<td><code>Command(&quot;GLOBALMATRIXN&quot;; N; &quot;GetTable&quot;; &quot;myTable&quot;)</code></td>
<td>Load data from a table into a Global matrix. N is the matrix index. GetTable is required for this command syntax. myTable is the table name. startRow is the matrix row to start loading data (optional).</td>
</tr>
<tr>
<td><code>Command(&quot;GLOBALMATRIXN&quot;; N; &quot;GetTable&quot;; &quot;myTable&quot;; startRow)</code></td>
<td></td>
</tr>
<tr>
<td><code>Command(&quot;GLOBALMATRIXN&quot;; N; &quot;GetTable&quot;; &quot;myTable&quot;; startRow; startCol)</code></td>
<td></td>
</tr>
<tr>
<td>Function syntax</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>startCol</strong> is the matrix column to start loading data (optional).</td>
<td></td>
</tr>
<tr>
<td><strong>Command</strong>(&quot;EXCEL&quot;; &quot;Open&quot;; &quot;Path&amp;Workbook&quot;) <strong>Command</strong>(&quot;SPREADSHEET&quot;; &quot;Open&quot;; &quot;Path&amp;Workbook&quot;)</td>
<td>Open a workbook/spreadsheet with the provided path &amp; filename.</td>
</tr>
<tr>
<td><strong>Command</strong>(&quot;EXCEL&quot;; &quot;Macro&quot;; &quot;myMacro&quot;)</td>
<td>Run an EXCEL macro within the opened workbook.</td>
</tr>
<tr>
<td><strong>Command</strong>(&quot;EXCEL&quot;; &quot;ExportGlobalMatrix&quot;) <strong>Command</strong>(&quot;EXCEL&quot;; &quot;ExportGlobalMatrixN&quot;; index)</td>
<td>Export the non-indexed or an indexed global matrix to a new Excel workbook. Note that only one matrix can be exported to a new workbook. To export additional matrices, use an existing workbook.</td>
</tr>
<tr>
<td><strong>Command</strong>(&quot;EXCEL&quot;; &quot;ExportGlobalMatrixN&quot;; index; &quot;Path&amp;Workbook&quot;; &quot;NewSheetName&quot;; &quot;obsolete&quot;; &quot;Text_label&quot;)</td>
<td>Export Global matrix referenced by its index to an existing worksheet with the provided path &amp; filename. The data will be placed in a new worksheet with the name provided. The sixth argument is not used. The Text_label argument will be presented below the data as a label.</td>
</tr>
<tr>
<td><strong>Command</strong>(&quot;GLOBALMATRIXN&quot;; 1; &quot;ColumnLabels&quot;; &quot;Col1&quot;; &quot;Col2&quot;; &quot;Col3&quot;; &quot;Col4&quot;; etc.)</td>
<td>Set custom column labels for the global matrix. Usually done prior to export.</td>
</tr>
</tbody>
</table>

**Command function syntax**

> References to the workbook path must use a forward slash "/" between folders rather than a backward slash.

The Special Features tutorial example model Command Function Syntax illustrates the supported uses of the Command function. To use this example, you will need to change the path to the workbook Test Command Function.xlsm. Also, run the commands one at a time via `CONTROL+E` starting at the top.
25.10 The Debug() functions

Details about the Debug() functions and the Tree Preferences for turning Debug() on can be found in the section within the Model Debugging and Validation Chapter.

25.11 The Global() and GlobalN() functions

These advanced functions can be very powerful tools for accomplishing complex calculations and reporting tasks. It is recommended that they be tested in simple models before being used in complex models.

We recommend using the Global/GlobalN functions that are specifically designed to store, retrieve, increment, initialize and export data rather than the generic Global/GlobalN functions.

<table>
<thead>
<tr>
<th>Function syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlobalSet(row; col; value)</td>
<td>To store and retrieve values globally, use Global() and GlobalN() to calculate &quot;value&quot; and set a cell in a matrix equal to the result (also returns the calculated value). Anywhere &quot;value&quot; is currently used in an expression, it can instead be &quot;wrapped&quot; in the Global function in order to save the calculated value to the matrix (for reporting purposes, for example). A value saved to a global matrix can be referenced using the second form of the Global() function; see below. The entire content of the global matrix can be dynamically saved to a text file using the third form of the function. Excel Module users: a simple Command(&quot;Excel&quot;;...) syntax allows you to output a matrix to a spreadsheet. GlobalN() has an extra parameter matrix (integer &gt; 0) which picks a matrix to use/create, while Global() simply uses a single, default matrix (i.e., matrix 0, not matrix 1 from GlobalN). Usually a few matrices at most will be required, but thousands can be created. The first cell in a matrix is at row=1, column=1. Matrix size increases dynamically as cells are assigned values. Attempting to lookup a cell that is out of range, however, will result in an error. Currently, the maximum total number of cells for all matrices in the tree is 100 million (e.g., 10000x10000, 50x2000000, or 4x5000x5000). Take note of memory usage with very large numbers of matrix cells. If you are exceeding this limit, try saving/dumping a matrix to a file periodically.</td>
</tr>
<tr>
<td>GlobalNSet(matrix; row; col; value)</td>
<td></td>
</tr>
<tr>
<td>Global(row; col; value)</td>
<td></td>
</tr>
<tr>
<td>GlobalN(matrix; row; col; value)</td>
<td></td>
</tr>
</tbody>
</table>

Global matrices are deleted when the tree is closed, and emptied automatically at the start of each analysis.
<table>
<thead>
<tr>
<th>Function syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>GlobalGet(row; col)</code></td>
<td>Retrieves the value at a specified cell in a global matrix for use in a tree calculation. The first cell in the global matrix is at row=1, column=1. See information on GlobalN syntax, above.</td>
</tr>
<tr>
<td><code>GlobalNGet(matrix; row; col)</code></td>
<td></td>
</tr>
<tr>
<td><code>Global(row; col)</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalN(matrix; row; col)</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalIncr(row; col; incr)</code></td>
<td>This syntax is equivalent to: &quot;GlobalN(n;row;col; incr + GlobalN(n;row;col)). If &quot;; incr&quot; is omitted, the increment = 1. Returns the incremented value (fourth argument).</td>
</tr>
<tr>
<td><code>GlobalNIncr(matrix; row; col; incr)</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalExport(suffixNo)</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalNExport(matrix; suffixNo)</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalN(matrix; value)</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalN(matrix; value)</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalExport(path + &quot;custom_file_name.txt&quot;)</code></td>
<td>Text files are saved in the same directory as the tree, using the tree filename followed by the word &quot;.globals_&quot; and the integer part of suffixNo. A calculation in &quot;c:\trees\mytree.tre&quot; of the function &quot;GlobalN(3; 103)&quot; would save the current matrix #3 to a text file called: &quot;c:\trees \mytree_globals_103.txt&quot;</td>
</tr>
<tr>
<td><code>GlobalNExport(matrix; path + &quot;custom_file_name.txt&quot;)</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalInit()</code></td>
<td>Global matrix is emptied; size becomes 0. (Occurs automatically at the start of an analysis, or when the tree is closed. After a simulation/analysis finishes, however, matrices are still available via the above syntax.) Global() and GlobalN() empty only one matrix while GlobalN() and GlobalInitN() empties all created matrices.</td>
</tr>
<tr>
<td><code>GlobalInit()</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalNInit()</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalInitN()</code></td>
<td></td>
</tr>
<tr>
<td><code>Global()</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalN(n)</code></td>
<td></td>
</tr>
<tr>
<td><code>GlobalN()</code></td>
<td></td>
</tr>
</tbody>
</table>
It is important to consider where to place Global matrix commands within the model. If you are running Microsimulation, you can use a tracker modification to execute the global matrix command at any node. If you are running EV calculations, you can add the global matrix call to an existing expression in a probability expression or a payoff expression. However, be sure to multiply the Global matrix call by zero to prevent the call from changing the value of the expression.

Most of the Global/GlobalN syntax options are used in Special Feature tutorial example models called Demo Global Functions.trex (action-specific Global functions) and Demo Global Function.trex (generic Global functions).

(Note: During multiprocessor simulations, Global/GlobalN refers to a set of matrices in the main thread. Separate, simultaneously processing threads evaluating a particular expression which modifies a particular matrix n will take turns updating matrix n; each thread does NOT have its own copy (except in the unusual case of a distributed simulation which divides batches among different computers.)

25.12 Custom Functions

Custom functions allow you to create a single commonly used commands/formula, which can then be used with different arguments for different contexts within the tree. We give two examples below both which show how to create custom formula.

25.12.1 Custom formula to delay Discounting using the Discount function

When using the Global Discount method and an associated discount rate, set at the beginning of the model calculation, it is not possible to change the discount rate dependent on the cycle.

The Special Features example, Custom Function Discount.trex, demonstrates how to delay the discounting by applying a custom function when using the Manual Discount function. This function delays discounting into the future for 5 cycles and then starts discounting as though it is the first stage.

Let value be the variable we want to discount. Define the following:

\[
\text{CustomDiscount(value)} = \text{Discount(value; if(_stage<discount\_stage;0;0.01); _stage - discount\_stage + 1)}
\]

\[
\text{discount\_stage} = 5
\]

\[
\text{int\_rate} = 0.01
\]

Combined, this function will return the value argument discounted at 1% delayed for 5 years. You can run the Markov Cohort Analysis to check the numbers in the model provided.
25.12.2 Custom formula to store variables via the Global Matrix functions

The DES tutorial example, Osteo DES Model.trex, demonstrates this technique.

Custom Functions

Note the variable zgStoreColFunction. The variable name itself includes a reference to arguments within parentheses, which designates this variable as a custom function. This function specifically stores data in a global matrix based on the input parameters inMatrix, inCol and inValue.

Note the variables zgStoreCol01_patient, zgStoreCol02_event_no, etc. Each of those variables calls the zgStoreCol function, with each passing the appropriate values for the input parameters.

25.13 The TrackerIncr() function

Tracker values are normally set by simply providing a new value for the tracker via a tracker modification. A tracker could be incremented at a specific node with a tracker modification like the following.

tracker_name = tracker_name + 1

If you needed to increment a tracker within a separate expression outside a tracker modification, like using a Monte Carlo Special Variable/Keyword, then you can use the TrackerIncr function to increment a tracker value. The syntax for the function is shown below.

TrackerIncr( "tracker_name"; incr)

This command adds the value "incr" to a current trial's value of "tracker_name", and returns the updated value.
25.14 List function

The List function, $\text{List( LIST )}$, is used to contain a parameter list for a multivariate distribution, for example in the Dirichlet distribution.

In any tree, open the Distributions View and select a Dirichlet distribution. The list of Alphas (parameters defining the Dirichlet function) is set using the List(LIST) function. LIST is a set of values separated by semi-colons used to define the Dirichlet distribution. See Distribution Functions, Options and Types for more details about Distributions.

25.15 String Processing

Certain functions within TreeAge Pro use string arguments. Specifically, you might the DebugWrite or DebugWriteForce functions to output text to the Calculation Trace Console. The following table illustrates a few things you can do with strings to generate helpful debug output.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Str(number)</td>
<td>Converts numeric data to a string.</td>
</tr>
<tr>
<td>+</td>
<td>Operator to concatenate two strings together.</td>
</tr>
</tbody>
</table>

String Processing

For example, the following variable definition would use the _monte_pre_trial_eval simulation keyword to output the current _sample and _trial values to the calculation trace console.

```
_monte_pre_trial_eval = DebugWriteForce("_sample=" + Str(_sample) + ", _trial=" + Str(_trial))
```
26. Python

The Python programming language can be used to extend the functionality of TreeAge Pro. For example, a Python script could perform complex calculations that are not easily handled in a native TreeAge Pro variable definition formula. This can include logical syntax like extended if/then/else logic and processing loops which have no equivalent within TreeAge Pro. This chapter will illustrate examples of using Python and the syntax required to build your own Python scripts.

26.1 A Simple Python Function Example

While Python would typically be used to extend TreeAge Pro, we will start with a simple example that does not actually require Python. Specifically, we will create a Python Discount function that we can then validate against the built-in Discount function.

The Special Features/Python tutorial example model, "Python Example – Discount.trex" contains two strategies.

When you open a model with a user-defined Python function, you will be prompted to enable Python scripts. This allows you to review Python scripts in any model you receive from an unknown source (search the model for "def " and "python").

The types of Python commands useful in trees are not a security concern, but the core language does have file and Internet access methods which could theoretically be misused. To turn off the "Do you want to enable python scripts?" dialog, go to Window > Application Preferences then navigate to Analysis Tools > Python and check the box "Do not show enable Python question".

The top strategy’s payoff references the Python function PythonDiscount, while the bottom strategy’s payoff references the built-in TreeAge function Discount(). Rolling back the model shows the values are equivalent.
A Python function is created within a variable definition. In this example, a variable called PythonDiscount has been defined at the root node in the Variable Properties View. The figure below shows how the Add/Change Variable dialogue can be used to edit Python functions.

In the Add/Change variable dialogue, you will see the Python Editor option selected above the Build Expression. TreeAge Pro identifies the definition as a Python function because it starts with the keyword `def`. If you are creating your own function, select this editor option yourself. The Python Editor mode helps you write Python code by allowing required indentation and recognizing Python keywords.

A Python function must begin with the function declaration `def` followed by the name of the function, then parentheses, and finally a colon. If the function requires arguments, they are placed within the parentheses separated by commas.

```
def PythonDiscount(val, years, rate):
    # This function returns the discounted value based on
    # the interest rate and years past
    # Create the denominator value based on the rate and years past
    denom = (1+rate)**years;
    # Return the discounted value to TreeAge Pro
    return val/denom;
```
26.2 Python Access to Model Data

Python functions can directly access data from within the model. The Special Features/Python tutorial example model “PythonExample – Discount.trex” from the prior section used data passed to the Python function via function arguments. Instead, the example model “Python Example – GetTreeAgeData.trex” pulls data directly from the model into the Python function via the `treeage` object.

If performance is critical in your model, try to use the Python interpreter efficiently. For example, a `treeage.eval()` call is slower than passing an argument to the function.

The expression sent via `treeage.eval` can be any valid expression that can be calculated in the model, including variables, trackers, distributions, etc. Note that variables are calculated based on the node context from where the Python function was called. For special Monte Carlo keywords (e.g., `_monte_pre_trial_eval`), the root node context is used.

The `treeage` object has many methods/functions, but this example model uses the two most common ones listed below.

- `treeage.eval("expression")` executes the expression in the model and returns the calculated value to the Python function.
- `treeage.debug("title", "message")` sends debugging output to the TreeAge Pro Calculation Trace Console.
The `treeage.debug` function is useful when debugging functions by allowing you to send text related to code syntax and/or calculated values to the Calculation Trace Console. The following example shows how to comment the Python code and how to use the `eval` and `debug` syntax.

Example Python model “Python Example - GetTreeAgeData.trex” (showing the Variable Properties View below)

Python script for the function `PythonFunctionGetTreeAgeData()` (from the Build Expression field in the Add/Change variable dialogue)

The comment lines (starting with `#`) provide information about the code within the Python function. Additional information is provided here:

- `def PythonGetTreeAgeData():` - This is the function declaration of `PythonGetTreeAgeData()` which is a function with no arguments passed to it. The function uses `treeage.eval()` to get the information it needs from the model.

- `treeage.debug("PythonFunctionGetTreeAgeData", "Start function")` - This sends the text in quotes to the Calculation Trace Console. The comma separating the quotes marks the start of a new line. In the console, you would know that this function has been called.

- `var1 = treeage.eval("myVar1")` - Python uses this syntax to calculate and return the value for `myVar1` from the TreeAge model and places that value in the internal variable `var1` within the
Python model. The subsequent line does the same - assigning var2 the TreeAge Pro value for myVar2.

- product = var1 * var2;: The expression assigns the internal variable product the value equal to the product of the two variables var1 and var2.

- treeage.debug("PythonGetTreeAgeData","End of function, return value " + str(product)). This sends text to the console, specifically the value of product which is the value returned by the Python function to the model.

- return product;: This final command returns the value for product back to the expression that calls the function.

The Calculation Trace Console will show the debug outputs based on the commands described (above) as in the figure below.

Calculation Trace Console with debug output from "Python Example - GetTreeAgeData.trex"

The treeage object provides several other functions listed in the table below.

<table>
<thead>
<tr>
<th>Treeage object function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>treeage.eval(&quot;expression&quot;)</td>
<td>Returns the value of expression from the tree.</td>
</tr>
<tr>
<td>treeage.debug(&quot;title&quot;,&quot;msg&quot;)</td>
<td>Output to trace console view for tree (if detailed debugging preference is on).</td>
</tr>
<tr>
<td>treeage.loadTable(&quot;TableName&quot;, python_array)</td>
<td>Load data from an array in Python to a table within a TreeAge model.</td>
</tr>
<tr>
<td>pt = treeage.getParallelTrials()</td>
<td>Creates an object within Python with access to parallel trials info.</td>
</tr>
<tr>
<td>pt.getTrialNTracker(trial_number, &quot;tracker_name&quot;)</td>
<td>Gets the current tracker tracker_name value for trial number trial_number.</td>
</tr>
<tr>
<td>pt.setTrialNTracker(trial_number, &quot;tracker_name&quot;, value)</td>
<td>Sets the tracker tracker_name equal to value for trial number trial_number.</td>
</tr>
<tr>
<td>treeage.getGlobalTracker(&quot;GlobalTrackerName&quot;)</td>
<td>Gets the current value of a global tracker GlobalTrackerName.</td>
</tr>
</tbody>
</table>
### Treeage object function

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| `treeage.setGlobalTracker("GlobalTrackerName", value)` | Sets global tracker `GlobalTrackerName` equal to `value`.
| `matrix = treeage.getGlobalMatrixN(n)` | Sets a reference to one of the global matrices, whose data can then be accessed/changed. Within Python the matrix is represented as a Python array. See following set of rows.
| `matrix.getRows()` | Get the current number of rows, columns in the matrix.
| `matrix.getCols()` | | |
| `matrix.getElement(int row, int col)` | Get the value from a cell in the matrix at row `row`, column `col`.
| `matrix.setElement(int row, int col, double val)` | Set the value of a cell in the matrix to `val` at row `row`, column `col`.
| `matrix.incrElement(int r, int c, double val)` | Increment the value of cell in the matrix by the amount `val`.
| `matrix.fill(double val)` | Populate the entire matrix with the `val` provided.
| `matrix.fillCol(double val, int col)` | Populate all cells in column `col` with the `val` provided.
| `matrix.fillRow(double val, int row)` | Populate all cells in row `row` with the `val` provided.
| `matrix.fillCol(double val, int col, int rowsUpperLimit)` | Populate the cells in column `col` with the `val` provided from row 1 to row `rowsUpperLimit`.
| `matrix.fillRow(double val, int row, int columnsUpperLimit)` | Populate the cells in row `row` with the `val` provided from column 1 to column `colsUpperLimit`.
| `matrix.getIndex()` | Returns the index of the matrix.
| `matrix.clear()` | Empties the matrix of all data.

**Python treeage object syntax**

#### 26.3 Using External Python and Importing Python Libraries

Python is a widely used, high-level programming language which is very rich. TreeAge Pro has basic Python functionality built into the software. There are many additional Python Libraries available which allow your calculations to support high-level mathematical functions by using pre-built expressions. Using these libraries will extend the expressions and functionality of Python in TreeAge Pro.

To take advantage of these additional complex functions, it is necessary to install additional Python libraries. For example NumPy and Sci Py support high-level mathematical functions for operating multi-dimensional arrays.
For more details on NumPy and SciPy see the websites: http://www.numpy.org/ and https://www.scipy.org/

Installation of Python and Python libraries can be tricky. TreeAge Software cannot support the installation of Python, NumPy, SciPy, py4j or any other external Python modules. Please use Python resources at www.python.org for support.

When any additional Python libraries are installed, it is necessary to install the py4j library. This library allows communication between treeage and the externally installed libraries to work.

To install the py4j library, enter the following command into a command prompt:

```
python -m pip install --user py4j
```

We will use the Special Features tutorial example model, "Python Example – ExternalNumPy.trex" to demonstrate how to enable external python and then use the external libraries. This model uses a NumPy function for multiplication. Clearly, NumPy is not required for multiplication, but if this model runs, you will know you have a successful connection to external Python, including the NumPy library.

When you open a model with Python script, you will be prompted "Do you want to enable python scripts?".

```
Select "yes" when prompted to enable python scripts
```

If you select "No" and later need to enable Python scripts, you will need to save and close the model, re-open and then select enable Python scripts as above.

Once you have selected to enable python scripts you will directed to Application Preferences. If you are using External Libraries - such as NumPy - then select "Use external Python installation".
TreeAge Pro Application preferences which need to be activated to use external Python installation.

To run "Python Example – ExternalNumPy.trex" we need to make sure the steps above are followed which are:

- Set Application Preferences to use external Python.
- External Python is installed including the communication package: py4j.
- The numpy package is installed.

The figure below shows a simple variable definition using the external python library numpy.
The function `PythonImportNumpy` reads in 4 arguments from the model and then does two things:

1. It imports the external Python library `numpy` and gives it the name `np`.
2. It uses one of the functions in `numpy`, `product`, to calculate the product of the 4 arguments and send them back to TreeAge Pro via the `return` command.

Rolling back to model will give you the product of the four arguments in the function. In the model, that is: \(1 \times 2 \times 3 \times 4 = 24\).

If this model runs, you will be able to use other special functions within NumPy and probably also SciPy within your own models.

### 26.4 Python Example with Logical Syntax

A primary reason for using Python in a model is to allow you to introduce logical syntax into your model, including if/then and loop syntax. The Special Features tutorial example model “Python Example – Loop.trex” is a simple illustration of logical syntax within a Python function.
Definition of PythonFunctionLoop(resample_sw) in the variable definition add/change dialogue

Consider the following elements of the Python function:

- The Python function expects a numeric argument called resample_sw. A single argument must therefore be provided within parentheses whenever the Python function is called within the model.
- The function includes a for loop to repeat a code block multiple times. The syntax for dist_index in range(1, 5): designates that the loop should be repeated 4 times with dist_index values 1, 2, 3, 4 (1 at start is inclusive, 5 at end is exclusive, so 5 is not run). The indented code block is then executed 4 times, once for each iteration in the loop.
- Similarly, if/then/else logic syntax with its own indented code.
- Python treeage.debug statement reports information back to the TreeAge Pro Calculation trace console.
- The return statement passes the calculated value back to the model wherever the Python function is called.

Roll back the model and the Calculation Trace Console will show the "for loop" cycling through distributions 1 to 4 and then adding them (sum = sum + dist_sample) before returning the value for Strategy 1 (resample_sw = 0) and Strategy 2 (resample_sw=1).

Note that in the Python function declaration, arguments are separated by commas; however, when calling the function within TreeAge Pro, those arguments are separated by semicolons.
26.5 Python Syntax Errors

Models which use Python will also return error messages if there is an error in the Python script.

The example in the Special Features tutorial example model, "Python Example – SyntaxError.trex", has invalid Python code within the variable definition for function PythonFunctionSyntaxError. Specifically, the internal Python variable `missing_input` is not declared within the function or passed as an argument to the function. Therefore, when `missing_input` is referenced, an error is thrown.

Function definition of PythonFunctionSyntaxError with comments

Rolling back the model creates the error message shown in the figure below identifying where the error in the Python function is, specifically line 5 where `missing_input` is referenced but was never defined.

The error message from rolling back "Python Example - Loop.trex".

If your Python function has invalid syntax, an error like the one above should help you resolve the issue.

26.6 Python-initiated Access to TreeAge Pro models

The TreeAge Pro Object Interface provides computer programs the ability to open, edit, analyze, save, and close models. Python is one of many programming options (Java, Visual Basic, etc.) that can use the Object Interface to interact with models.

Note this method of using Python to interact with models is different other parts of this chapter where a model calls Python for specific calculations during analysis.
26.7 Calling Python via the User function (Pre-2018)

Prior to TreeAge Pro 2018, any user defined Python functions that required arguments could not be called directly and were instead called via the User() function. Whilst this syntax is still supported for backward compatibility, it is no longer necessary to include User() when calling Python functions with arguments.

In the Special Features tutorial example model, "Python Example – Discount-User.trex", we show the equivalence of the Python functions with and without User(). Rolling back the model shows the values are equivalent.

![Python Example - Discount-User.trex](image)

In this example, the payoffs are set equal to two different Python functions. The first branch lets you reference PythonDiscount directly as discussed in section 1 of this chapter. The second branch provides the syntax required prior to TreeAge Pro 2018 and might still be found in some legacy models.

However, if you want to set a variable equal to the Python defined PythonDiscount, you could use the following:

```
myDiscountedVariable = PythonDiscount(5000; 2; 0.04)
```

where the numeric values could also be defined as variables in the model and passed in as arguments.

Prior to TreeAge Pro 2018 you would have used:

```
myDiscountedVariable = User("PythonDiscount"; 5000; 2; 0.04)
```

26.8 Other Python syntax options

TreeAge Pro supports several syntax options for calling Python functions. The standard ones previously mentioned as well as others are described in the following table.
<table>
<thead>
<tr>
<th>Function Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>myPythonFunction</code></td>
<td>Call Python functions that require no arguments by simply referencing the function name.</td>
</tr>
<tr>
<td><code>User( &quot;myPythonFunction&quot;; argument1 ; ... )</code></td>
<td>User command to call Python function and pass arguments to the function.</td>
</tr>
<tr>
<td><code>Python( &quot;expression&quot; )</code></td>
<td>If the current Python can successfully evaluate the variable name, expression, or function, the Python() function will return that value. If it cannot evaluate it, an error is returned. The Python() function returns a numeric value. Example: <code>Python(&quot;10+1&quot;)</code> returns 11 Example: <code>Python(&quot;int('0xff', 16)&quot;)</code> returns 255</td>
</tr>
<tr>
<td>The Python syntax below is not yet supported in TreeAge Pro</td>
<td>Not yet available.</td>
</tr>
<tr>
<td><code>PythonFunc( &quot;module&quot;; &quot;function&quot;; argument1 ; ... )</code></td>
<td>Execute a function from an imported module. This will only work if the module has already been imported. Example: <code>PythonFunc( &quot;random&quot;; &quot;normalvariate&quot;; mu; sd)</code> returns a random number from Normal(mu,sd) where mu and sd are numbers</td>
</tr>
</tbody>
</table>
| `PythonGetList( "list"; "treeage table" )` | The PythonGetList() function copies a two-dimensional Python nested list into a TreeAge table. The Python expression can be a literal list (as seen below), a variable containing a list, or a function returning a list. Example: `PythonGetList(
[[0,.1,.2],
[1,.15,.25]
] ; "myTable")` loads myTable and returns the number of rows (2) |
<p>| <code>PythonRun( &quot;command&quot;; ... )</code> | Returns 0 for failure or 1 for success. Specify a valid Python statement. To run a series of scripts or modules, separate multiple double-quoted paths using semicolons. If Python successfully runs the last specified statement, the PythonRun() function will return a value of 1. If Python encounters an error evaluating your commands, the PythonRun() function returns a 0 value -- not an error. To force a TreeAge Pro error, use the result as the denominator of a division operation. To return the value of variables or functions created or modified by the executed commands, use the Python() function. Example: <code>PythonRun( &quot;from random import &quot; ; &quot;seed(1)&quot;; &quot;x=random()&quot;) = 1 value = Python(&quot;x&quot;) = .134364...</code> |
| <code>PythonRunFile( &quot;scriptfile&quot; ; ... )</code> | Returns 0 for failure or 1 for success. Specify the full path and filename of a valid Python script text file or |</p>
<table>
<thead>
<tr>
<th>Function Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>module to run; or, specify just the file name if it is stored in the Python default path. To run a series of scripts or modules, separate multiple double-quoted paths using semicolons. (Note that forward slashes can be used instead of backslashes in the path specification.) Example: <code>PythonFile( &quot;C:\Python24\lib\TransplantQueue.py&quot; )</code> Using PythonRunFile() to execute a file is equivalent to having Python evaluate the <code>execfile()</code> function: <code>PythonRun( &quot;execfile( 'C:\Python24\lib\TransplantQueue.py')&quot; )</code> If the script/module executes successfully, use the <code>Python()</code> function to return the value of variables: <code>queueWait = Python(&quot;now()&quot;)</code></td>
</tr>
</tbody>
</table>
27. Advanced Chance Node Techniques and Options

This chapter provides information on a number of features which can be used to customize chance nodes in decision trees.

27.1 Using non-coherent probabilities/Normalization

TreeAge Pro normally requires the branch probabilities of each chance node to sum to 100%. Probabilities that meet this requirement are referred to as “coherent.” However, there are some situations where it may be useful to relax or remove this restriction (i.e., dynamic cohort analysis, parallel trials).

TreeAge Pro provides options to override the normal chance node functionality - either for the entire tree or for a specific chance node.

You are urged to employ these options cautiously after giving careful consideration to the potential hazards of overriding normal chance node functionality. Do not use this option simply because your probabilities are not summing to 100%. This is usually an error condition caused by probability expressions and/or distribution samples. Such an error must be corrected to generate valid analysis output.

27.1.1 Allowing non-coherent probabilities at a specific node

You can allow non-coherent probabilities at specific chance and Markov nodes in the model; other node types do not allow this option. It is best to allow non-coherent probabilities only at specific nodes rather than for the whole model as described in the next section.

To change the probability coherence option for a node via the context menu:

- Right-click on a chance node or a Markov node.
- Within the context menu, choose Change Coherence > your desired option.

To change the probability coherence option for a node via the main menu:

- Select a chance node or a Markov node.
- Choose Node > Probability Coherence > your desired option.

The coherence options available are:

- Use Tree Preference setting: Do not override for this node. Use the option from tree preferences.
- Allow < > 100% for this node: Allow non-coherent probabilities at this node.
- Do not allow < > 100% for this node: Do not allow non-coherent probabilities at this node.
- Normalize probabilities: Normalize probabilities to force them to sum to 100%.

Probability coherence options
If the probabilities are allowed to be non-coherent, you will get odd expected values. This is not recommended, except when you need to add/subtract from the cohort size (dynamic cohort modeling).

Normalization will take the probabilities that do not sum to 100% and normalize them to make them sum to 100%. For example, if you had probabilities 0.3, 0.4 and 0.5, the total sum would be 1.2. By dividing each probability by 1.2, the probabilities would be normalized.

Note that you can use probability normalization along with the complement probability hashtag. If you have three branches - two probability expressions and the hashtag, normalization will only occur if the two expressions sum to more than 100%. In that case, those probabilities will be normalized and the hashtag will calculate to 0.

<table>
<thead>
<tr>
<th></th>
<th>Original</th>
<th>Normalized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prob1</td>
<td>0.3</td>
<td>0.25</td>
</tr>
<tr>
<td>Prob2</td>
<td>0.4</td>
<td>0.333333</td>
</tr>
<tr>
<td>Prob3</td>
<td>0.5</td>
<td>0.416667</td>
</tr>
<tr>
<td>Sum</td>
<td>1.2</td>
<td>1.0</td>
</tr>
</tbody>
</table>

Prob normalization

The Special Features tutorial example model ProbabilityNormalization demonstrates this technique.
The first 6 strategies alternate between probabilities sampled from a distribution and the normalized probabilities. The *Raw 1* strategy simply reports the first probability sampled from a distribution. The *Normalized 1* strategy returns the probability after it has been normalized at the chance node.

The bottom strategy is excluded from the analysis because it would fail since the probabilities are not normalized.

Note the red flags above the nodes with probability coherence overrides. This indicator helps identify when a node will function differently from the rest of the model. Node branch comments are automatically created with the text "(Node Probability Override)", which in turn causes the flags to be presented.

Run Monte Carlo Simulation/Sampling on the model to see the original and normalized probabilities. The summary mean values below illustrate the normalization.
Normalization tree analysis results

Note that the original mean value for probabilities 1, 2 and 3 are 0.57, 0.21 and 0.30, while the normalized mean values are 0.53, 0.19 and 0.27.

Contrast this with results from the Special Features tutorial example model ProbabilityNonCoherence. In that model, no normalization is done; the bad probabilities are simply allowed. This is not recommended.

27.1.2 Allowing non-coherent probabilities for the entire model

A Tree Preferences option allows non-coherent probabilities for the entire model. However, it is recommended that non-coherent probabilities be allowed at specific nodes instead. See next section.

To disable errors when using non-coherent probabilities:

- Choose Tree > Tree Preferences from the menu or click F11 to open the Tree Preferences Dialog.
- Navigate to the preference category Calculation > Other Calculation Settings.
- Check the option "Allow probabilities to not sum to 100%".
Tree Preferences - Allow Non-coherent Probabilities

As precautions against unintended use, the status bar at the bottom of the TreeAge Pro window displays text to notify you that this setting is active.

Status bar - non-coherent probabilities

Non-coherent probabilities are not compatible with microsimulation (first-order trials) unless integer values are used for the probabilities for parallel trials, but can be used in probabilistic sensitivity analysis using expected value calculations.

27.1.3 Reporting future net present values in the tree

Discounting is normally used to generate the net present value of future values. In nearly all cases, the net present value of future values is less than the future value itself due to inflation. Decision analysis is then performed using the net present values for all values in the model.

If a decision is to be made at an intermediate node in the tree which occurs in the future (e.g., options valuation), it may be necessary to calculate the net value at the time of the future decision rather than the present time. This would require discounting from the distant future value back to the less distant decision point rather than back to the present.

In situations where it is appropriate, it is possible to use non-coherent probabilities to perform the discounting instead of discounting each terminal node payoff. Net present value discounting is generally performed by dividing by \((1+\text{discount\_rate})^\text{time}\). By turning off probability error checking, this division could instead be performed on each branch probability. If done correctly, the expected
values calculated at the root node of the tree will be unchanged from a standard, payoff discounting model. See the TreeAge web site for more information.

As with other uses of probability non-coherence, care must be taken to ensure that hidden probability errors are not unknowingly introduced.

27.1.4 Discrete and dynamically-sized Markov cohorts

Normally, decision trees are used to calculate an expected, or average, value. In budget-oriented or population-based modeling, however, the ultimate goal may be to determine not an average, but an overall cost or benefit. In some cases, this can be accomplished simply by multiplying the expected value by some number (e.g., the number of projects, or the size of a population). If TreeAge Pro’s probability coherence requirement is turned off, an equivalent option would be to do the multiplication via tree “probabilities.”

Non-coherent probabilities might be used to model a population whose size changes over time. For example, in a Markov model built using the Healthcare module, the starting population can be initialized — sized and distributed among possible health states — prior to the Markov calculation. Then, during Markov calculations, non-coherent probabilities could be used to change the size of the population, modeling entry from other populations (i.e., from uninfected to infected) or internal population growth (births). For an example of this technique, please refer to the Dynamic Cohort Models Chapter.

When allowing non-coherent probabilities, a sub-option to randomize “discrete” individuals is available that will maintain integer probabilities at subsequent chance nodes — in effect, keeping individuals whole by randomizing them at chance nodes (during any analysis, not just simulation). This might be relevant, for example, where small probability events are critical (i.e., in a vaccination model where continued transmission of a contagious disease requires a “whole” carrier).

27.2 Sampling probabilities from a Dirichlet distribution

If a chance node has more than two branches, performing a sensitivity analysis or Monte Carlo simulation that changes the values of these probabilities can be problematic.

One option is to write expressions that normalize the chance node’s probability expressions. For example, let’s say the node has three outcomes: A, B, and C. Rather than assigning variables to two probabilities, and using the # remainder calculation in the third, you could do the following: assign three expressions that always sum to 1.0, like \( p_A/(p_A+p_B+p_C) \) and \( p_B/(p_A+p_B+p_C) \) and \( p_C/(p_A+p_B+p_C) \). No matter what values (\( \geq 0 \)) are assigned to \( p_A \), \( p_B \), and \( p_C \), the three normalized probabilities will always sum to 1.0. (The # remainder could still be used in place of one of these.)

TreeAge Pro offers another solution using a special multivariate form of the beta probability distribution, the Dirichlet distribution. This distribution can be used to represent the uncertainty in all of the
probabilities of a chance event. During Monte Carlo simulation, the distribution can sample probabilities for each branch, while ensuring that probabilities sum to 1.0.

Open the Healthcare tutorial example model, Dirichlet Simple, to follow this section through.

---

**Dirichlet distribution**

If the distribution is parameterized with a list of N \( \alpha \) values, N independent Gamma\[\alpha_n, \beta=1\] distributions will be sampled and the samples normalized to create a list of N probabilities which are guaranteed to sum to 1.0.

Note that using a larger total sum of the alpha values will reduce the variation of each probability from its mean. For example, List(200; 750; 50) generates the same three mean values as List(20; 75; 5), but the sample sets will tend to be closer to the mean values.

Note that you can use a Dirichlet distribution without sampling to normalize probabilities for a deterministic sensitivity analysis (not PSA). The mean values for each value generated from a Dirichlet distribution is equal to the individual List argument divided by the sum of all the List arguments. Therefore, if you adjust one of the List values for deterministic sensitivity analysis, the other values will adjust proportionally to keep the overall probabilities coherent.

To utilize the sampled probabilities in the model, the Dist function is used with a second argument indicating which branch (i.e., alpha) to use, as shown below.
Dirichlet tree

Rolling back the tree shows the mean values of the probabilities, which are simply the normalized alpha parameters.

Performing a simulation in the example tree shows the effect of sampling independent Gamma distribution values, based on the list of alpha parameters, and then normalizing. For each iteration of the simulation, a different set of Gamma random variates is drawn. Each iteration results in a different sum, as well as different ratios of the Gamma random variates to the sum (i.e., the probabilities). Normalization ensures that the resulting probabilities sum to 1.0.

Running PSA on the model yielded the following results.

Dirichlet tree PSA

Note that the mean value from the 100 iterations is close to the roll back expected value. However, the variance among the iterations reflects the different probabilities that are generated by the Dirichlet distribution. The All Data Report shows the three individual probabilities generated from the distribution for each iteration. Note that the first, second and third values from the distributions are near 0.2, 0.75 and 0.05 respectively as expected.
In TreeAge Pro, simulation text reports and graphs only report the first sampled Dirichlet probability. However, it is possible to use either a tracker variable or TreeAge Pro’s Global() matrix function to store and report each sampled probability. For example, to create a table of a branch’s sample values, wrap the Dist() function reference in the Global() function, as in:

```
Global(_sample; branch; Dist(1; branch))
```
28. Bayes' Revision in Decision Trees

This chapter shows how, in the tree window, TreeAge Pro can assist you in performing the calculations that implement probability revision using Bayes' theorem.

28.1 An introduction to Bayes’ revision

If your model includes imperfect tests or forecasts followed by decisions, you may wish to utilize TreeAge Pro’s Bayes’ revision feature. TreeAge Pro can automatically perform probability revisions using Bayes' theorem. The process occurs once during the initial construction of the model; based on your answers to a few questions, TreeAge Pro will generate a set of variable definitions that calculate the revised probabilities. The probability expressions will be recalculated every time the model is evaluated and results can change as your estimates of prior and likelihood probabilities (see below) change.

Bayes’ revision is implemented in both the tree and influence diagram windows. Bayes’ revision in the tree window is able to revise probabilities automatically based upon a single test. The process can be performed more than once within a model for different tests.

There are two methods of applying Bayes’ theorem on your model, each of which is described later in this chapter:

1. For test results using sensitivity and specificity.
2. For a general m-by-n grid.

28.1.1 Probability revision using Bayes' theorem

Bayes’ revision allows decision makers to calculate decision probabilities from likelihood probabilities. Likelihood probabilities, or forecast likelihoods, are answers to questions such as, “If this test is performed on a part known to be faulty, what is the probability of a positive result indicating a problem?” This type of probabilistic information is often available, but is not immediately useful in making decisions. What's needed are the decision probabilities, which address questions such as, “If a particular part tests positive, what is the probability that it is really faulty?”

The decision probabilities are so named because, in the real world, they are the probabilities upon which decisions are based. These are also sometimes called posterior (or a posteriori) probabilities.

The basic formula for revising probabilities is:

\[ P(H \mid E) = \frac{P(E \mid H) \cdot P(H)}{P(E)} \]

where \( H \) is the hypothesis (e.g., faulty or not faulty) and \( E \) is the evidence (e.g., test result). The formula is applied once for each hypothesis-evidence combination — for example, \( P(\text{not faulty positive}) \), or the
Bayes' Revision illustration - part 1

Let's say we have a batch of 10,000 items to be tested.

If the estimated prior probability of defect is 1%, we would expect 100 items in the batch to have the defect. Of these, about 98 should test positive. Of the 9,900 pieces without the defect, we said approximately 3% (297) would test positive.

Thus, a total of 395 (297 + 98) test subjects would test positive (this is one of the marginal test probability).

The Bayes' revision formula is intuitive when illustrated and worked out using a tree, as shown below. The first revised decision probability is the ratio 98/395, or approximately 25%. This is the probability that a positive test actually indicates the presence of the defect. In this case, 75% of the positive tests are in error. The other decision probabilities are similarly calculated. With this information, a decision maker could compare the performance of the new test with existing methods or competing technologies.
28 Bayes' Revision in Decision Trees

28.2 Bayes' Revision - Sensitivity/Specificity

The most common form of Bayes' revision performed in healthcare models relates to imperfect tests using sensitivity and specificity. In a typical model, you screen for a condition, but the test yields some false positives and false negatives. Reported data on the sensitivity and specificity of a test and the prevalence of the disease can be integrated into a model as parameters, which are revised to generate dependent probabilities required for the model.

Sensitivity and specificity are statistical measures of the performance of a binary classification test.

Sensitivity (also called the true positive rate) measures the proportion of actual positives which are correctly identified as such (e.g. the percentage of sick people who are correctly identified as having the condition).

Specificity (also called the true negative rate) measures the proportion of negatives which are correctly identified as such (e.g. the percentage of healthy people who are correctly identified as not having the condition).

For this version of the Bayes' revision, you must first create the model structure to mirror the test results and actual condition. This structure can be anywhere in the tree, but it must follow the structure of a chance node with two branches that are each also chance nodes with two branches.

The Health Care tutorial example model, BayesSensSpec-start.trex, is presented below.
The model contains the standard test and condition node structure as well as the three variables prevalence, sensitivity and specificity.

To initiate the Bayes’ revision using sensitivity and specificity:

- Select the Give test chance node.
- Choose Subtree > Bayes’ Revision > Sensitivity, Specificity from the menu.

You are then presented with a wizard dialog to walk you through the revision process. In the first step, you simply select the test positive node. Then select the two condition positive nodes that follow the positive and negative test nodes. The dialog uses the node label text to guide you through the process. Then click Next.

The radio button for the top branch is always selected in the dialog below. Do not assume that this is the correct selection for your model.

Bayes’ sensitivity/specificity wizard - select nodes

Then you select variables to for the prevalence, sensitivity and specificity values required for the revision. The wizard includes a "Show variable definitions" link if you need to create/define these variables on the fly. In our example, these variables were already defined, so they can simply be selected.

Note that if you create variables on the fly through the mini Variable Definitions View within the Wizard, definitions will be placed at the “root” of the revision, which may not be where you want them. You might choose to create the three required variables first, so you can simply reference them within the wizard.
The wizard also contains a "Show Bayes grid" link to allow you to see the calculated values that will be used in the model.

Bayes' sensitivity/specificity wizard - select probability variables

When you click Finish, the revised probability variables are then defined at the "root" revision node with references to the three independent variables. The revised variables are then placed into the tree's branch probabilities. The revision variables are set to be hidden in the tree structure.
The Health Care tutorial example model BayesSensSpec-end.trex includes the final set of revised probabilities. Roll back shows all the calculated revised probabilities in the model.

Revised model rolled back

### 28.3 Bayes' Revision - Grid

The grid approach to Bayes' revision also revises the known probabilities to create the probabilities needed for the model. However, it differs in two significant ways:

1. It supports any m-by-n sized grid.
2. It generates the tree structure rather than referring to an existing tree structure.
To use the grid Bayes’ revision, you should first obtain numeric values for the likelihood probabilities associated with the test and the \( a\ priori \) probabilities for the hypotheses. Then, use the grid revision wizard to create the model's structure and probabilities.

This chapter will examine the contents of an oil well and a test for seismic soundings. We will assume that we have knowledge about wells in a target area based on prior success in the immediate region. Based on that knowledge, we estimate the likelihood that the well has no oil, some oil or lots of oil as shown below.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Oil</td>
<td>5/10 (50%)</td>
</tr>
<tr>
<td>Some Oil</td>
<td>3/10 (30%)</td>
</tr>
<tr>
<td>Lots of Oil</td>
<td>2/10 (20%)</td>
</tr>
</tbody>
</table>

Based on prior experience, a table is constructed showing what we can expect for test results (test neg, test pos moderate, or test pos high) based on a well’s actual state (no oil, some oil, or lots of oil) as shown below.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Test Low</th>
<th>Test Med</th>
<th>Test High</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Given No Oil</td>
<td>0.6</td>
<td>0.3</td>
<td>0.1</td>
<td>1.0</td>
</tr>
<tr>
<td>Given Some Oil</td>
<td>0.3</td>
<td>0.4</td>
<td>0.3</td>
<td>1.0</td>
</tr>
<tr>
<td>Given Lots of Oil</td>
<td>0.1</td>
<td>0.4</td>
<td>0.5</td>
<td>1.0</td>
</tr>
</tbody>
</table>

\[ This\ example\ uses\ the\ default\ 3x3\ grid.\ Please\ note\ that\ the\ grid\ does\ not\ need\ to\ be\ symmetrical.\]

The starting point for your Bayes’ revision is a chance node with no branches. The subtree generated by the process can then be copied or moved later as needed. The Oil tutorial examples model, BayesGrid-start.trex, is a quick starting point for working with the grid Bayes’ revision.

To start the grid Bayes’ revision:

- Open the BayesGrid-start.trex model.
- Select a chance node with no branches.
- Choose Subtree > Bayes’ Revision > M by N grid from the menu.

The Wizard then opens.
Bayes' revision grid wizard

Note the two spinners at the top that can be used to change the shape of the grid.

The wizard provides entry fields to the left for the condition descriptions (for node labels), for condition short names (for variable names) and variable definitions (for values). It also provides entry fields for test results (for node labels), for test result short names (for variable names) and given conditions (for values).

Based on the information provided earlier, the grid could be filled out as seen below. The "Show Bayes Grid" link has been clicked to show all the Bayes' revision calculated values.
Bayes' revision grid wizard with values

Then click Create Bayes Subtree to create the subtree with all independent, conditional and calculated variables created and defined.
Note the following elements of the subtree that is created.

- The tree structure is built automatically based on the M by N grid.
- The node labels are populated based on the Condition Description and Test Result labels entered in the grid.
- The independent variables are named based on the short names entered for the condition and test results and are defined based on values in the grid.
The revised probability variables are named starting with an underscore and are not "shown in tree." They are defined using Bayes' revision theorem.

The Oil tutorial example, BayesGrid-end.trex, is a tree after the revision with the end nodes changed to terminal nodes to display the path probabilities, as shown below while rolled back.

![BayesGrid-end rolled back](image)

Note that the path probabilities, conditional probabilities and test result probabilities match the values presented in the grid.

The names and values entered in the last Bayes grid are stored with the model. This allows you to create another Bayes subtree using the same data. The Oil tutorial examples model BayesGrid-start-populated.trex is pre-populated with the Bayes grid data described above.
29. Utility Functions and Risk Preferences

TreeAge Pro allows you to set up a risk preference utility function in a tree, which can be used to account for a decision maker’s aversion to risk.

29.1 Risk preference: an illustration

Most decision makers are risk-averse to some degree. They are willing to pay a premium, small or large, to avoid risk. The decision maker’s risk preference can be incorporated into a decision tree.

Assume that a rich uncle offers you an opportunity to win some money. He proposes to flip a coin giving you the opportunity to receive either $10,000 or $1,000, depending on whether you correctly predict the outcome. If you call the flip correctly, you will receive $10,000, and if you are wrong you will receive $1,000.

To make this game more interesting, assume that your uncle complicates matters by offering an alternative opportunity. The alternative is also a coin flip. Under this one, you will receive $50,000 if you are correct, but you will have to pay him $5,000 in the event you lose on the coin flip. There will be only a single coin flip; it is up to you to choose between the two. As you will see, it may not be wise to base your decision solely on traditional expected value calculations.

The tree in Business tutorial examples, Risk Illustration, models your uncle’s offer.

As the tree illustrates, there are two lotteries. Both provide the same (50 - 50) odds of winning, but they have different outcomes. You must choose one of them. On the basis of expected value, you should choose lottery #2. Its expected value ($22,500) is more than four times that of lottery #1 ($5,500).

However, what about the risk posed in lottery #2 that you could actually end up losing $5,000? At least in lottery #1 there is no risk of being out-of-pocket – you are guaranteed to win something. How one responds to the downside risk posed by lottery #2 involves a subjective analysis of the decision maker’s aversion to risk.
29.1.1 Certainty equivalents and risk aversion

Consider lottery #1 described above. The expected value is $5,500. Would you sell the opportunity to play this lottery for $4,000? If you were offered $3,000 by a third party who wanted to buy into the lottery, would you sell?

The minimum value for which you would sell the lottery is your certainty equivalent for this lottery. The certainty equivalent of a lottery can be perceived as the expected value of that lottery, adjusted for risk preference (the risk-adjusted expected value).

A certainty equivalent is similar to an expected value, in that it is a single numeric quantity which represents the value of an uncertain event. The certainty equivalent is a subjective measure; it is the answer to the question, “What is the minimum (or maximum) value for which I would trade this uncertainty?”

Now consider a situation which is undesirable from the start. Lottery #3 is a coin flip in which you will either owe your uncle $2,000 or you will owe him $12,000. In this situation, we are interested in finding the maximum amount that you are willing to pay to a third party to assume your obligation under the lottery. Would you pay $4,000? Or $5,000? Your answer to this question is your certainty equivalent for that lottery.

The certainty equivalent for a lottery is usually in the same numeric range as the expected value. The gap between the certainty equivalent and the expected value is a measure of risk aversion.

Most decision makers are risk-averse to some degree. They are willing to pay a premium, small or large, to avoid risk. Their certainty equivalent for any lottery will be lower than the lottery’s expected value. In contrast, a risk-seeking decision maker is one whose certainty equivalent for a lottery is higher than the lottery’s expected value. The risk taker is willing to pay a premium in order to participate in the lottery.

29.2 Risk preference curves

A straight-line risk-preference curve represents a decision maker who is risk-neutral. This type of decision maker bases decisions on expected values rather than certainty equivalents.

A risk-averse decision maker will have a curve with a decreasing slope, meaning that certainty equivalent is less than expected value. The curve will typically be steeper in the low value range, where aversion to risk is weak, and will grow progressively flatter as the values get larger (both positive and negative), where aversion to risk becomes stronger. The more risk-averse you are, the more your curve will deviate from the 45° straight line representing risk neutrality.

If you encode a curve that includes some unexpected bumps when graphed, this means that some of your responses were inconsistent. You should repeat the process. Don't be discouraged; developing a meaningful non-constant risk utility curve takes hard thinking and careful consideration.
For further reading on risk preference, refer to the general texts on decision analysis listed at the end of Chapter 1.

Risk preference functions can be used only if the calculation method is set to Simple.

29.3 Creating a risk preference function

TreeAge Pro is able to record your risk function as a mathematical curve and apply this curve to the expected value of an uncertainty. Recommendations are then made based on your derived certainty equivalents, rather than on expected values.

There are two types of curves, or risk functions, which TreeAge Pro can use. The constant risk aversion function is calculated using the formula:

\[ U(x) = 1 - e^{(-x/R)} \]

where \( U \) is an arbitrary utility scale, and \( R \) is a risk preference coefficient, described below. The utility scale is used only for internal calculations; the formula's inverse is later applied to find certainty equivalents.

The non-constant risk function is tailored to fit your specific model, and so is superior to the constant risk aversion function in many respects, except that it takes a little longer to set up initially. TreeAge Pro will ask you a series of questions about your certainty equivalents for the model you are working on. It will then create a curve made up of line segments approximating your true risk function.

Both types of risk functions are entered via Tree Preferences.
To use risk preferences when analyzing a model, check the Use risk preference function box and select either Constant risk aversion or Non-constant risk.

29.3.1 Constant risk aversion

If constant risk aversion is selected, you will be asked to supply a single value. Specifically, you will be shown a generic lottery in which you have a 0.5 probability of winning X and a 0.5 probability of losing one-half X, and asked to specify the largest value of X for which you would be willing to take part in the lottery. This value is used as the risk preference coefficient in the above formula.

The lottery might represent an investment in a biotech company which is about to get a judicial ruling on the validity of an important patent. If the ruling is favorable (0.5 probability), the investment will double in value; if unfavorable (0.5 probability), the investment will fall in value by 50%.

What is the most you would invest under these circumstances? This amount is referred to as your risk preference coefficient.

29.3.2 Non-constant risk aversion

Non-constant risk aversion allows you to enter utilities (value to you) for different values in the model. These utilities are used to create a non-constant risk function that is applied to your model.
30. Using the Excel Module

The optional Excel Module enhances TreeAge Pro's ability to communicate with Excel. The major features of the Excel Module are:

1. Edit model inputs (variables, trackers, distributions and tables) in Excel.
2. Create a Tree Workbook to output the model inputs to Excel.
3. Output reports and graphs to Excel.
4. Access models programmatically through the Object Interface.

Features of the Excel Module

Each of these features are described within this chapter.

- Dynamic bi-directional links with Excel are supported by the base TreeAge Pro product and do not require the Excel Module.
  
  Note that Excel's presentation of add-in options changes with each new version of Excel. Excel for Mac also presents add-ins differently. Despite the presentation differences, the functions should work the same way.

30.1 Edit model inputs in Excel

When you want to edit a large number of model inputs, it is often most efficient to do so via Excel. The process works as follows:

1. Export the desired inputs from TreeAge Pro to an Excel worksheet.
2. Edit the values in the Excel worksheet.
3. Import the new values back from Excel to the TreeAge Pro model.

Editing model inputs in Excel

This option is available for variables, trackers, distributions and tables. Each input is described in the next few sections. The Bilink tutorial example model TreeWorkbookTest.trex.

- Updates from Excel are applied to the active model. Therefore, you must select the correct model in the Tree Diagram Editor before sending updates back from Excel to TreeAge Pro.

30.1.1 Edit variables in Excel

If you have the Excel Module licensed, the Variable Properties View toolbar's To Excel icon/function will be enabled.

To edit variables in Excel:

- Open the Variable Properties View.
- Click the Open in New Excel Spreadsheet toolbar icon.
Using the Excel Module

The tree's variables are then exported to an Excel worksheet.

In the worksheet, the original variables are identified by hidden column I. This allows you to rename variables based on the current name. Hidden column H is used to determine which variables have been modified. We recommend that you do not modify the data in either hidden column.

Note that if you add new variables, you will not want to copy the original name in the hidden column. If you do, the existing variable will be replaced by the new variable.

Variables worksheet in Excel

Within the worksheet, you can change the variable properties and the default definitions (at the root node).

To send the new properties/values back to TreeAge Pro:

- Select the correct tree in the Tree Diagram Editor.
- In Excel 2007 or later, choose the Add-ins ribbon then choose TreeAge Eclipse > Add or Update Variables from the Excel menu.
- In Excel 2003 or earlier, choose TreeAge Eclipse > Add or Update Variables from the Excel menu.
Update variables in Excel 2007

Note that Excel's presentation of add-in options changes with each new version of Excel. Excel for Mac also presents add-ins differently. Despite the presentation differences, the functions should work the same way.

The variables in TreeAge Pro will be updated with the new properties/values from the Excel worksheet. There is no need to keep the Excel worksheet after the updates are complete as it can be regenerated at any time.

To refresh the data in the worksheet from the values in TreeAge Pro:

- In Excel 2007 or later, choose the Add-ins ribbon then choose TreeAge Eclipse > Refresh Variables from the Excel menu.
- In Excel 2003 or earlier, choose TreeAge Eclipse > Refresh Variables (from Tree) from the Excel menu.

Refresh will update the existing list of variables with the current values from TreeAge Pro. If you have added new variables within TreeAge Pro, please generate a new list via Edit in Excel from within TreeAge Pro.

If you export variables to Excel at a node other than the root node, you are asked whether to include an additional column of data for the variable definitions at the selected node. If you answer "yes", then the variable definitions at the selected node can also be updated and sent back to TreeAge Pro.
30.1.2 Edit trackers in Excel

Editing trackers in Excel works the same as editing variables, although tracker properties are different from variable properties.

If you have the Excel Module licensed, the Tracker Properties View toolbar's To Excel icon/function will be enabled.

To edit trackers in Excel:

- Open the Tracker Properties View.
- Click the Open in New Excel Spreadsheet toolbar icon (highlighted below).

Tracker Properties View - To Excel function

The tree's trackers are then exported to an Excel worksheet.

Trackers worksheet in Excel

Within the worksheet, you can change the tracker properties and the initial values. Hidden columns are used in the same way as the variables worksheet. See note in prior section.

To send the new properties/values back to TreeAge Pro:

- Select the correct tree in the Tree Diagram Editor.
- In Excel 2007 or later, choose the Add-ins ribbon then choose TreeAge Eclipse > Add or Update Trackers from the Excel menu.
- In Excel 2003 or earlier, choose TreeAge Eclipse > Add or Update Trackers from the Excel menu.
Update trackers in Excel 2007

The trackers in TreeAge Pro will be updated with the new properties/values from the Excel worksheet. There is no need to keep the Excel worksheet after the updates are complete as it can be regenerated at any time.

To refresh the data in the worksheet from the values in TreeAge Pro:

- In Excel 2007 or later, choose the Add-ins ribbon then choose TreeAge Eclipse > Refresh Trackers from the Excel menu.
- In Excel 2003 or earlier, choose TreeAge Eclipse > Refresh Trackers from the Excel menu.

Refresh will update the existing list of variables with the current values from TreeAge Pro. If you have added new variables within TreeAge Pro, please generate a new list via Edit in Excel from within TreeAge Pro.

If you export trackers to Excel at a node other than the root node, you are asked whether to include an additional column of data for the tracker modifications at the selected node. If you answer "yes", then the tracker modifications at the selected node can also be updated and sent back to TreeAge Pro.

30.1.3 Edit distributions in Excel

If you have the Excel Module licensed, the Distributions View toolbar's To Excel icon/function will be enabled.

To edit distributions in Excel:

- Open the Distributions View.
- Click the Open in New Excel Spreadsheet toolbar icon (highlighted below).
Distributions View - To Excel function

The tree's distributions are then exported to an Excel worksheet. See note on hidden columns in Variables section above.

Distributions worksheet in Excel

Within the worksheet, you can change the distribution properties and parameters. Note that the Help/Explanation column provides details on how the parameters are used for the appropriate distribution type.

To send the new properties/parameters back to TreeAge Pro:

- Select the correct tree in the Tree Diagram Editor.
- In Excel 2007 or later, choose the Add-ins ribbon then choose TreeAge Eclipse > Add or Update Distributions from the Excel menu.
- In Excel 2003 or earlier, choose TreeAge Eclipse > Add or Update Distributions from the Excel menu.
Update trackers in Excel 2007

The distributions in TreeAge Pro will be updated with the new properties/parameters from the Excel worksheet. There is no need to keep the Excel worksheet after the updates are complete as it can be regenerated at any time.

A few distribution types have additional options that are not updated through the Excel module (e.g., Fractile Gaussian vs. Swanson). These options must be edited in the Add/Change Distribution dialog.

30.1.4 Edit tables in Excel

Variables, trackers and distributions are edited within a list. However, tables are edited individually in Excel since they contain both properties and data.

If you have the Excel Module licensed, the Tables View toolbar’s Open in New Excel Spreadsheet icon/function will be enabled.

To edit a table in Excel:

- Open the Tables View.
- Select a single table.
- Click the To Excel toolbar icon (highlighted below), which exports the table to an Excel worksheet.
Within the worksheet, you can change the table properties and data. Be careful not to change the structure and/or location of the data in the worksheet.

**To send the new properties/data back to TreeAge Pro:**

- Select the correct tree in the Tree Diagram Editor.
- In Excel 2007 or later, choose the Add-ins ribbon then choose TreeAge Eclipse > Add or Update Distributions from the Excel menu.
- In Excel 2003 or earlier, choose TreeAge Eclipse > Add or Update Distributions from the Excel menu.

**To refresh the data in the worksheet from the values in TreeAge Pro:**

- In Excel 2007 or later, choose the Add-ins ribbon then choose TreeAge Eclipse > Refresh Trackers from the Excel menu.
- In Excel 2003 or earlier, choose TreeAge Eclipse > Refresh Trackers from the Excel menu.

Note that you can add columns to the table in Excel by adding data to the right of the existing columns. Value columns can have custom headings, but the Index column heading should not be changed.
30.2 Tree Workbook

You can quickly export the model inputs described in the previous sections (variables, trackers, distributions and tables) via a Tree Workbook.

To create a Tree Workbook:

- In Excel 2007 or later, choose the Add-ins ribbon then choose TreeAge Eclipse > Create Tree Workbook from the Excel menu.
- In Excel 2003 or earlier, choose TreeAge > Create Tree Workbook from the Excel menu.

A new Excel workbook will be created with a separate worksheet for each model input (variable list, tracker list, distribution list and each table). These model input worksheets are the same as described previously for variables, trackers, distributions and tables. Additional worksheets are described within this section.

The Tree Control worksheet is used to either open or save the model associated with the Tree Workbook. You can change the name of the tree and save the model in a separate document.

If you have different data scenarios you want to save for the same model. You can save multiple Tree Workbooks for the model. Then, you can use the Tree Workbook to update the model's data for that specific data scenario.

30.3 TreeAge Pro Object Interface

This interface is described in the TreeAge Pro Object Interface Chapter.

30.4 Exporting analysis output

The Excel module also allows exporting analysis outputs to Excel. The Open in New Excel Spreadsheet icon is frequently enabled for graphical and text output.

When this icon is enabled at the top right of the output, you can use it to export the results to Excel.
31. Using the TreeAge Pro Object Interface

The Excel Module (included with TreeAge Pro Excel and TreeAge Pro Suite) provides a powerful scripting interface that can be used to open, update and analyze models via program code.

⚠️ The Object Interface for TreeAge Pro is different from previous versions of TreeAge Pro. You can continue to use the older version of TreeAge Pro as you choose to modify the code which accesses TreeAge Pro.

31.1 Java vs. Other Programming Languages

You can open, update and analyze models via program code written in virtually any language, including:

- Java
- Visual Basic in an Excel macro
- Visual Basic in other environments
- C++
- etc.

TreeAge Pro is written in Java, so the Java programming language provides the most transparent look at the Object Interface via the Java package com.treeage.treeagepro.oj. This package includes the model element and analysis objects, which makes coding in Java easier because the Java IDE can "see" the TreeAge Pro objects and provides guidance on programming syntax.

However, many TreeAge Pro customers use the Object Interface through other programs, frequently via Visual Basic in an Excel macro. Languages other than Java connect to the Object Interface through the ActiveX Java package com.treeage.treeagepro.ojactivex. The ActiveX Java package allows you to instantiate the TreeAgeProApplication object. The TreeAgeProApplication object then provides access to instantiate other objects (trees, nodes, etc. from com.treeage.treeagepro.oj).

The API documentation describes the syntax for both Java packages.

⚠️ Note that on some computers, you may need to run TreeAge Pro with elevated privileges in order to access it via an external program.

31.2 Object Interface API Documentation

The Object Interface's Application Programming Interface (API) is described via standard javadoc documentation, which provides documentation for all objects and methods supported by the Object Interface.

A few of the primary application and modeling objects are highlighted in the following table. These and other objects are documented in the API documentation.
<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TreeAgeProApplication</td>
<td>A reference to the TreeAge Pro application. This is the first object you must create to start using the Object Interface when not using Java.</td>
</tr>
<tr>
<td>Tree</td>
<td>Standard tree model created in TreeAge Pro.</td>
</tr>
<tr>
<td>Node</td>
<td>A specific node within the tree.</td>
</tr>
<tr>
<td>Variable</td>
<td>A variable within a tree. Use this object to read/update variable properties.</td>
</tr>
<tr>
<td>VariableDefinition</td>
<td>A variable definition within a tree at a specific node.</td>
</tr>
<tr>
<td>Tracker</td>
<td>A tracker within a tree. Use this object to read/update tracker properties.</td>
</tr>
<tr>
<td>TrackerModification</td>
<td>A tracker modification within a tree at a specific node.</td>
</tr>
<tr>
<td>Table</td>
<td>A table within a tree. Use this object to read/update table properties.</td>
</tr>
<tr>
<td>TableRow</td>
<td>A row of data within a table.</td>
</tr>
<tr>
<td>Distribution</td>
<td>A distribution within a tree. Use this object to read/update the distribution's type, parameters and properties.</td>
</tr>
</tbody>
</table>

### Primary modeling objects

The Object Interface Additional also includes objects that support analysis. Most analyses are run on the Tree object. However, several types of analyses require objects for handling inputs/parameters and outputs.

A few of the primary application and modeling objects are highlighted in the following table. These and other objects are documented in the API documentation.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>Output from any analysis. The type of analysis executed determines the format of the data within the object. Some Report objects can be used to create other Report objects to generate secondary analysis outputs (i.e., graphs from Monte Carlo simulation output). Analysis parameters are passed via a hashmap of named values prior to generating the report.</td>
</tr>
<tr>
<td>Graph</td>
<td>Graphical output from a Report object.</td>
</tr>
<tr>
<td>TextReport</td>
<td>Tabular text and numeric output from a Report object.</td>
</tr>
</tbody>
</table>

### Analysis objects

#### 31.3 Connecting to the Object Interface via Java

When using Java code to connect to the Object Interface, you must create the appropriate file structure to be able to "build" your Java project. This requires some experience with creating a Java build environment.

To avoid the need to create an appropriate development environment, you can simply copy the full structure of the Object Interface Example project (described below) to another location on your
Using the TreeAge Pro Object Interface

computer and network. With the same file structure, you will be able to create Java source code in the folder ..src/com/treeage/treeagepro/tutorials/, placing your new source files alongside the example file UseObjectInterface.java.

Make sure you do not make changes directly in the Object Interface Example project as this project could be overwritten when new software is released.

If a new version of the Object Interface Example project is released, copy the appropriate files to your project. Be sure not to overwrite any of your own source code.

31.3.1 Sample Java code

Sample Java code is provided in the Object Interface Example project installed with your software. You can access the appropriate file through the Files View (see below).

Object Interface Example project

The UseObjectInterface.java source file contains sample Java code that opens, edits and analyzes sample trees. You can use this file as a starting point for creating your own Java source code.

If you choose to create your own source code using this example, be sure to save the file using a different filename. In fact, we recommend copying the entire project to a separate location. Otherwise, your source could be overwritten if an updated version of the example code is released.

This section will introduce you to the sample Java code. However, the Java code itself contains comments that serve as the primary documentation.

The UseObjectInterface.java file contains a Java class of the same name. That class runs as a Java application based on the existence of the method main. The main method instantiates the class, which immediately calls the class constructor UseObjectInterface, which contains the main processing steps. Additional methods provide the details on opening, modifying and analyzing trees.
/*
 * Constructor for class UseObjectInterface.
 * Contains main tree processing.
 */
private UseObjectInterface()
{
    com.treeage.treeagepro.oai.Tree sampleTree;
    com.treeage.treeagepro.oai.Tree cellSimTree;
    // Connects locally to TP2011. For remote use see TreeAgeProApplication
    // constructors
    // such as TreeAgeProApplication(host).
    app = new TreeAgeProApplication();
    if (!app.isValid())
    {
        System.out.println("Cannot find TP2011 application running locally.");
        return;
    }
    try {
        System.out.println("Workspace path: " + app.getWorkspacePath());
        // Open a new tree. The path can be either absolute or relative
        // to workspace root folder.
        sampleTree = this.openTree(sampleTreeOr(g));
        // Save under a new name. The path can be either absolute or
        // relative to workspace root folder.
        sampleTree.saveAs(sampleTreeNew);
        // Output tree characteristics
        outputTreeInfo(sampleTree);
        // Read/update variables.
        updateVariable(sampleTree);
        // Analyze a simple tree and report results.
        analyzeTree(sampleTree);
}

Sample Java code

To execute the code, right-click in the Java code document and select Run As > Java Application from the menu.

Execute Java code

As the sample code executes, it writes a status output to the Java output Console. See below.
31.4 Connecting to the Object Interface via ActiveX

Scripting languages communicate with TreeAge Pro via Java Remote Method Invocation (RMI). When TreeAge Pro starts up it starts a service on port 1099 (or slightly higher) which listens for ActiveX requests.

The non-Java objects are instantiated via the library TreeAgeProOI. This library must be referenced for your code to access the TreeAge Pro Object Interface objects. Below is a picture of the library objects as seen from the Excel Visual Basic Editor's Object Browser.
You can use these library objects to open, modify and analyze trees within Excel or other programming environments. Even when not working in Java, refer to the Java API documentation for object/method syntax.

Since ActiveX is registered on the computer, there are no requirements for a build environment as there are for Java projects. You can save the code anywhere on your computer or network.

### 31.4.1 Sample Visual Basic code

Sample Visual Basic (VB) code is provided in the Excel document "Use Object Interface.xls" in the TreeAge Pro Interface tutorial examples project. See below.

The UseObjectInterface.xlsm document contains sample VB code that opens, edits and analyzes sample trees. You can use this file as a starting point for creating your own VB source code.

If you choose to create your own source code using this example, be sure to save the file using a different filename in a different location. Otherwise, your source could be overwritten if an updated version of the example code is released.

This section will introduce you to the sample VB code. However, the VB code itself contains comments that serve as the primary documentation.

**To see the VB code in Excel 2007 or later:**

- Click on the Office button and then click the Excel Options button.
- In the Popular category, make sure the Show Developer tab in the ribbon box is checked.
- Select the Developer tab in the ribbon.
- Click the Visual Basic button.

**To see the VB code in Excel 2003 or earlier:**

- Choose Tools > Macros > Visual Basic Editor from the menu.

The VB code has a primary macro called TestObjectInterface, which contains the main processing steps. Additional methods provide the details on opening, modifying and analyzing trees.
Sample code and output in Excel's VB editor
32. The TreeAge Pro Player

TreeAge Pro 2011 R2.0 introduced a new feature called the TreeAge Pro Player. The Player allows you to share a model with an individual who does not have a license for TreeAge Pro. A consultant might use this feature to share the model to his/her client.

In order to use the Player, the modeler must first create a Player Interface for the model, resulting in a password protected Player Model with the *.trvx extension. The modeler determines which input variables can be changed and which analyses can be executed. The modeler also determines whether or not the player should be able to display the model structure.

The Player Model can be opened with TreeAge Pro, but functions are limited to those exposed by the model interface. Supplying the password will allow you to use an expanded set of functions.

32.1 Creating a Player Model

You create a Player Model by exporting a model in the player format.

To create a Player Model:

1. Save the latest changes to the model.
2. Choose File > Import/Export > Export as Player Model from the menu.
3. Choose the file name and location in the dialog box.
4. Enter the password associated with the Player Model twice.

The model will be exported as a Player Model will be saved with the *.trvx extension.

Export as Player Model Dialog

You cannot change the structure or values within a model within a Player Model. You must return to the original model file to make such changes. However, you can then create a new Player Model and import the Model Interface elements from an existing Player Model.
If you are modifying a model for which an interface had already been created, you have the option of importing the interface from another Player Model. To do so, follow the instructions above plus the following steps:

1. Check the Import interface box.
2. Select an existing Player Model (*.trvx) file.

The resulting Player Model will include the model structure and details from the model that was exported as well as the interface details from the prior Player Model.

> If any variable names or stored analysis names from the imported interface are not found in the exported model, they will not be usable in the new interface. They will be displayed in red and can be deleted but cannot be used. This can happen if a variable or stored analysis is renamed since a prior interface was created.

### 32.2 Creating the Player Model Interface

Once the Player Model has been exported, you then need to create a Model Interface to provide access to the parameters and analyses. When you open the Player Model, TreeAge Pro will switch to the Player perspective. The Player Perspective limits access to nearly all of the application views used for editing the model.

The Player Perspective includes the following Views:

- Player Model - for using an existing Model Interface.
- Player Design - for creating a Model Interface.
- Tree Diagram Editor - for viewing the model (if allowed by the interface)
- Console - for viewing system output from analysis runs
- Error Log - for viewing system errors
- Projects - for accessing model files

If no interface has been created, you will only able to view the model.

**To create a Player Model Interface:**

1. Open the Player Model.
2. Choose Edit > Enter the Designer Password.
3. Enter the password used when creating the Player Model.

> If you do not have an authorized version of TreeAge Pro, you will not be able to enter the Designer Password.

The Player Design View will become enabled. You create the interface within this view.

There are several components of the interface:
- Variable parameters that can be updated.
- Stored analyses that can be executed.
- A setting to determine whether the interface should show the model structure or not.

**Interface Components**

The figure below shows the Player Design View with all of the variables exposed, all stored analyses exposed and the model structure exposed to the interface. This interface was created from the Special Features tutorial example model Three Vars with Stored Analyses.

**Player Design View**

**Variables**

A model will have many variables that serve several functions in the model. Some variables are model parameters with a numeric definition at the root node. Only variables such as these should be enabled in the Model Interface, and probably only a subset of those variables.

Check the Unlocked box next to each variable you wish to expose in the Model Interface. It will be helpful to the person using the Model Interface if the variable has a clear name and description. You can also enter additional information in the Comments field.

**Stored Analyses**

Within the Model Interface, the regular Analysis menu will not be available. Instead, the modeler must create a stored analysis for each analysis they wish to expose in the Model Interface. Comments can be added to the stored analysis to help guide the user of the Model Interface.

Check the Unlocked box next to every stored analysis you wish to expose in the Model Interface.

You can restrict the secondary output options available within the standard Monte Carlo simulation output to make it easier for the Player Model recipient to find the output of interest.

**Exposing the Model Structure**

The modeler may or may not want the Model Interface to expose the structure of the model. This is controlled by checking or unchecking the box in the Player Design View.
32.3 Using the Model Interface

Once the Model Interface is complete, the Player Model can be opened and analyzed using TreeAge Pro even if the software is not authorized. When the Player Model is opened, the Model Interface will present the specific variable inputs that can be modified, allowing the user to change certain model assumptions. Variable descriptions and comments in the original model can be used to guide someone using the interface, including specifying valid values.

The Model Interface will also show the specific analyses that can be run. The user can run any of the specified analyses and the appropriate output will be presented.
33. Building and Analyzing Cost-Effectiveness Models

The next three chapters provide information on modifying existing decision trees for cost-effectiveness analysis. Cost-effectiveness analysis, sensitivity analysis, and Monte Carlo simulation are also covered in detail. The three chapters related to these topics are:

1. Building and Analyzing Cost-Effectiveness Models (this chapter)
2. Sensitivity Analysis on Cost-Effectiveness Models
3. Probabilistic Sensitivity Analysis on Cost-Effectiveness Models

Cost-effectiveness chapters

Please note that you must have purchased the Healthcare Module to take advantage of the cost-effectiveness features.

Healthcare decisions often take into account differences in both cost and effectiveness between competing treatments, technologies, or strategies. This chapter covers preparing an existing TreeAge Pro decision tree for cost-effectiveness calculations, and performing and interpreting baseline cost-effectiveness analysis.

The Cost-Effectiveness Modeling and Analysis Options LATER SECTIONS IN THIS CHAPTER - give some LINKS - provide information on intermediate and advanced cost-effectiveness modeling and analysis options.

33.1 Before you begin

Cost-effectiveness analysis (CEA) is a collection of methods used by health economists and policy researchers to evaluate policy recommendations on the basis of two different attribute scales (i.e., cost and quality-adjusted life expectancy).

The Healthcare Module (included with TreeAge Pro Healthcare and TreeAge Pro Suite) facilitates cost-effectiveness analysis and survival/Markov modeling and simulation — both so-called early models which rely heavily on rough guesses about outcomes and parameters, as well as evidence-based models that summarize extensive research and meta-analysis.

The basis of CEA in a decision tree is the calculation of expected values for each strategy at a decision node. TreeAge Pro then creates a CEA table, in which the strategies are listed in order of increasing cost, and calculates incremental cost and effectiveness values for the neighboring pairs of options. This is used to determine conditions of dominance and to calculate incremental cost-effectiveness ratios (ICERs), as described in this chapter.

For more background, users are strongly encouraged to consult some of the many references on medical decision making, for instance:

- Periodicals including Medical Decision Making (Sage Science Press) and Value in Health (Blackwell Publishing).
- Decision Making in Health and Medicine, Hunink, and Glasziou (2001), Cambridge University.

Cost-effectiveness analysis references

33.2 Preparing a tree for cost-effectiveness calculations

This chapter uses an example decision tree that already has costs and effectiveness values in two payoffs. The tree is an adaptation of a model described in other decision analysis tutorials.

Open the Health Care tutorial example model "Blindness Prevention - before CE changes".
Blindness prevention model

The model deals with a hypothetical population presenting clinical signs of a possible, but not certain, early-stage autoimmune disorder. If the condition is present, and if it progresses, blindness will result. An imperfect test (biopsy, with the possibility of false negatives) can help determine whether an individual has the disorder.

The model presumes that a reasonably effective and inexpensive therapy exists which lowers the probability of progression to blindness. To keep the example tree small, the possibility of side effects of the therapy is not modeled with a chance node like the other uncertainties. Instead, the side effects are already factored into the costs and life expectancy at the end of each path including treatment.

33.2.1 The Cost-Effectiveness calculation method

Before making any changes to the Blindness Prevention tree, take a moment to examine the assignment of payoffs at a terminal node.

To examine a payoff:
Right-click on the Blindness terminal node in the Treat None subtree (marked by the pointer in the figure above) and select Edit Payoffs from the context menu. This will open the Edit Payoff Dialog for that node.

The numeric effectiveness payoffs displayed on the face of the tree, measuring quality-adjusted life expectancy (QALYs), are entered in payoff 2. In addition, every terminal node also has a numeric cost payoff assigned in payoff 1. The cost payoffs are not displayed, however, because the tree’s calculation preferences are set to Simple calculations, using only payoff #2.

Note on regional (European) numeric settings:
If your computer is set up to use commas (","), rather than periods (".")", you should enter numbers in TreeAge Pro in this fashion, just as you would in a spreadsheet or calculator (even in example trees where numbers already appear using period decimals). However, if you need to setup a tree for use under different regional numeric settings, TreeAge Pro also has preference settings that enable a tree to override a computer’s regional settings or reverse the usage of decimals. Refer to the Tree Calculation Methods and Preferences Chapter for details.

Before you can perform cost-effectiveness analysis, the tree’s calculation method preferences must be set up correctly.

You can do this using the Model Setup Wizard or you can do this manually. In this section, we describe how to set Tree Preferences manually, but the same steps can be carried out using the Configure Model wizard.

To prepare a tree for cost-effectiveness calculations:
- Close the Edit Payoff Dialog.
- Choose Tree > Tree Preferences from the menu or press the F11 key to open the Tree Preferences Dialog.
- Navigate to the category Calculation > Calculation Method.
- Select the option Cost-Effectiveness.
Calculation Method - Cost-Effectiveness

This will enable the special analyses and reports described in this and following chapters. Note that the tree can be changed back to Simple calculations at any time.

To review additional preferences related to cost-effectiveness analysis:

- In the Tree Preferences Dialog, navigate to the category Calculation > Calculation Method > Cost-Effectiveness.
- In this category, you can change the active payoffs for cost and effectiveness (not necessary for this tree).

By default, the Cost-Effectiveness calculation method uses payoff 1 for costs, and payoff 2 for effectiveness; this can be changed. However, in the Blindness Prevention tree, costs are already in payoff 1 and effectiveness values are in payoff 2.
Cost-Effectiveness Payoffs

To set the numeric formatting for calculated costs, effectiveness values, and CE ratios:

- In the Tree Preferences Dialog, navigate to the category Calculation > Numeric Formatting.
- Click OK to save all changes to the Tree Preferences.

The tree stores separate numeric formatting preferences for cost and effectiveness (as well as the other 7 payoff sets), and another group of settings for ratios.

The graphic below illustrates some possible settings for these three sets of numeric formatting used in cost-effectiveness analysis.
Cost-Effectiveness Numeric Formatting

The Blindness Prevention model saved with the Tree Preference changes described in this section is in the Health Care tutorial example model "Blindness Prevention - after CE changes.trex". You can open the updated model directly to run the analyses described below if you want to skip the Tree Preferences changes.

If you plan to create more cost-effectiveness trees, you can use this tree’s calculation method, numeric formatting, and other preferences as the defaults when creating new trees.

The next chapter covers additional special cost-effectiveness preferences, for example: setting a threshold ICER for roll back; inverting effectiveness calculations (if lower values are preferred); or specifying costs using a weighted combination of multiple payoffs.

With the CE calculation method active, the tree displays both the cost and effectiveness payoff expressions for each visible terminal node. A forward slash ("/"") sign is used to visually separate the two payoffs; however, it does not mean that cost will be divided by effectiveness during roll back or other tree calculations.
In addition, if you double-click on a terminal node to open an Enter Payoff window, the two active payoffs are labeled “Cost” and “Eff.”

**Edit cost-effectiveness payoffs**

The tree is now ready for cost-effectiveness analysis. The remainder of this chapter will cover performing cost-effectiveness analysis using the TreeAge Pro Healthcare module. The next chapter covers additional cost-effectiveness modeling and analysis options.

Users of TreeAge Pro who do not have the Healthcare module can open trees using the Cost-Effectiveness calculation method, but cannot analyze them. It is possible to change the calculation method of such trees to Simple in order to analyze one of the payoffs, even without the Healthcare module.

### 33.3 Performing cost-effectiveness analysis

TreeAge Pro’s cost-effectiveness (CE) graphs, and the text report underlying it, are the fundamental tools for cost-effectiveness analysis of your decision trees. They display the key information from the analysis, including incremental values and conditions of dominance.

To generate a CE graph:
- Select the decision node.
- Choose Analysis > Cost-Effectiveness… from the menu.
The optimal strategy from the cost-effectiveness frontier can be identified using the "Add WTP to Graph" link to the right of the graph. See below.

Cost-Effectiveness Graph

The process of interpreting the results of the cost-effectiveness analysis graphically is described in detail later in this chapter. A quick overview is given here.

Strategies which are not dominated will be connected by line segments which form the cost-effective frontier. Only the strategies on the cost-effective frontier could be the optimal choice. The lowest cost option is always part of this frontier; if it dominates all comparators, the graph will have no lines.

Another option provided is the WTP; this shows the willingness-to-pay slope that intersects with the favored strategy. This can can helpful when it comes to choosing a final strategy.

Details are provided later in this chapter on the rules used to determine which options are excluded from the cost-effective frontier.
33.3.1 The CE analysis text report

To see the calculated values underlying the CE graph, open the graph’s text report.

To display the cost-effectiveness analysis text report:

- Click on the Text Report link to the right of the CE graph.

The text report for the Blindness Prevention decision is displayed below.

Cost-Effectiveness Rankings

The Text Report is divided into four collapsible groupings. The columns show a standard cost-effectiveness analysis table, showing average and incremental cost and effectiveness values, as well as incremental cost-effectiveness ratios. This report is described in more detail in the next section.

The Net Monetary Befenifts (NMB) is calculated using the WTP parameter from the Tree Preferences. The optimal strategy will have the largest NMB value given that WTP value.

A text report, when generated from a graph window, uses the formatting of the graph axes. To change the formatting of the CE text report, first change the formatting of the graph, then regenerate the Text Report.

33.4 Dominance and incremental cost-effectiveness

In a cost-effectiveness analysis, sometimes a strategy can be eliminated based on its relative cost and effectiveness compared to another strategy. An option is said to be dominated if it both costs more
and is less effective than a comparator. This condition can be visually identified in a cost-effectiveness graph.

When effectiveness is plotted on the X-axis, a strategy is absolutely dominated if it lies above and to the left of another alternative. The option below and to the right is referred to as dominant, or dominating. TreeAge Pro shows dominated strategies in the graph, but they will not be displayed on the cost-effectiveness frontier.

**Dominance**

In the CE graph shown in the previous section, the baseline analysis of the Blindness Prevention treatment decision, it is visually apparent that Treat None is dominated by Treat All. (However, we will see later that this may not be the case for all estimates of the uncertain or variable parameters, such as the prevalence of the disease, i.e., if a different population is modeled.)

The Health Care tutorial example model, Extended Dominance, represents the cost and effectiveness of five strategies. The tree has been set up to illustrate special dominance conditions.

**Extended Dominance Tree**

The CE graph from this tree is shown below.
Extended Dominance CE Graph

By default, extended dominance lines are not shown, however, there is an option to show them.

Tx D is the only option removed from the cost-effective frontier based on absolute dominance — it is more costly and less effective than Tx B, the least costly option. The cost-effective frontier is defined starting with Tx B, skipping Tx E, continuing to Tx A, and then to Tx C (the most costly and most effective option).

Why is strategy Tx E excluded? It is not dominated in the absolute sense – visually, there is no option below and to the right. TreeAge Pro has, instead, flagged Tx E as being extendedly dominated, marking it in the graph area (with horizontal and vertical lines intersecting the cost-effective frontier which are hidden in the above graph). Interpreting special conditions of extended dominance in a CEA requires an understanding of the related concept of incremental cost-effectiveness ratios (ICERs).

Extended dominance lines can be hidden by clicking the “Hide Ext. Dom.” link to the right of the graph. You can reshow the lines by clicking the “Show Ext. Dom.” link.

33.4.1 Extended dominance and ICERs

A single cost-effectiveness analysis for a particular health condition takes place within a wider context; providing the best range of treatments and prevention is the goal, but financial, human, and other resources eliminate some options.

In CEA, when comparing two non-dominated options, an incremental cost-effectiveness ratio (ICER) is calculated. The ICER of the more effective option is the ratio of the mean incremental cost and mean incremental effectiveness (e.g., in terms of $/QALY). Graphically, it is the slope of the line connecting two, cost-ordered strategies.

\[ ICER = \frac{IC}{IE} \]
ICERs are used in the CEA process in a couple of ways. First, ICERs are used to determine whether options can be removed from the cost-effective frontier based on extended dominance. Lower ICERs correspond to better value (i.e., lower cost per unit of additional effectiveness). As shown in the partial graph, Tx A is more effective than Tx E and has a lower ICER (slope decrease). Thus, the cost-effective frontier connects Tx B and Tx A, but skips Tx E, based on extended dominance.

With effectiveness on the horizontal axis, the slope of the line segment connecting two options corresponds to the ICER. Slopes approaching a horizontal orientation correspond to better (lower) ICERs. In graphs on the previous page, it can be seen that Tx A is more effective than Tx E, and also has a lower ICER than Tx E. In other words, Tx A is a better value than Tx E, relative to Tx B.

In addition to the visual indication of extended dominance provided in the CE graph, the text report provides details about conditions of extended dominance.

**Extended Dominance CE Text Report**

Let's look at the CE Text Report in more detail. The collapsible groups are listed below.

1. **Without dominated options**: Only undominated strategies.
2. **All options**: All strategies ordered from least costly to most costly.
3. **All options referenced by a common baseline**: All strategies with incremental values calculated against the common baseline (least costly option).
4. **Ordered by increasing effectiveness**: All strategies ordered from least effective to most effective.

**CE Text Report Groups**

The columns in the Text report include:

1. **Category**: Grouping from the prior list and whether a strategy is dominated (and if so, how).
2. **Strategy**: The node label for the strategy (branch of the decision node).
3. **Cost**: Cost value for the strategy.
4. **IncrCost**: Incremental cost - difference in cost between this strategy and the previous less costly strategy on the cost-effectiveness frontier.
5. **Eff**: Effectiveness value for the strategy.
6. **IncrEff**: Incremental effectiveness - difference in effectiveness between this strategy and the previous less costly strategy on the cost-effectiveness frontier.
7. **Incr CE (ICER)**: The incremental cost-effectiveness ratio comparing this strategy to the previous less costly strategy on the cost-effectiveness frontier.
8. **NMB**: Net monetary benefits as calculated from the cost and effectiveness for the strategy and the willingness-to-pay (WTP) for the tree. The highest value indicates the favored strategy for the given WTP. More information about the NMB can be found in the next chapter.
9. **Avg CE**: The average cost-effectiveness (Cost divided by Effectiveness) for the strategy.

**CE Text Report Columns**

ICERs are calculated using only the strategies on the cost-effectiveness frontier, excluding all dominated strategies. Therefore, we will focus on the *undominated* group. The undominated strategies are sorted from least costly to most costly: *Tx B*, *Tx A*, *Tx C*. Incremental values are then calculated for each strategy as compared to the previous less costly strategy.

For *Tx A* compared to *Tx B*...

\[
ICER = \frac{IC}{IE} = \frac{(335K - 160K)}{(9 - 4.8)} = \frac{(175K)}{(4.2)} = 41,667
\]

For *Tx C* compared to *Tx A*...

\[
ICER = \frac{IC}{IE} = \frac{(450K - 335K)}{(10 - 9)} = \frac{(115K)}{(1)} = 115K
\]

Note that the ICER, IC and IE values are presented in the Text Report.

In the undominated group, the ICERs will always increase as you move to more costly options. When the ICER decreases in the *all* group, then this indicates that the previous strategy is dominated via extended dominance.

Note that the ICER for *Tx E* is larger than the ICER for *Tx A*, which eliminates *Tx E* from the cost-effectiveness frontier due to extended dominance. This indicates that it would be a more efficient use of resources to switch from *Tx B* to *Tx A* than it would be to switch from *Tx B* to *Tx E*.

**33.4.2 The threshold ICER (or willingness-to-pay, or ceiling ratio)**

The next way in which the ICER is used is to determine if, at some point on the cost-effective frontier, the next more effective option exceeds a threshold ratio, sometimes referred to as the willingness-to-pay, or ceiling ratio. To efficiently allocate resources among competing priorities, there is normally a limit to the additional cost per unit of effectiveness gained – i.e., the ICER – that a rational decision maker will accept to move up the frontier.
If the decision maker assumed a threshold ICER of 40,000, for example, then tx A would exceed this — it might be considered slightly inefficient (too costly per unit of effectiveness gained).

The Sensitivity Analysis on Cost-Effectiveness Models Chapter continues the discussion of CEA thresholds in the context of sensitivity analysis in TreeAge Pro.

**33.4.3 Extended dominance: an additional perspective**

In some cases, strategy selection may involve not just maximizing effectiveness and working within a threshold ICER, but also working under a budget constraint (i.e., a cost threshold). If such a cost ceiling were set at $300K, this would eliminate Tx A because the cost exceeds the cost ceiling.

Theoretically, if a decision maker is making a population-wide policy decision, two (or more) strategies might be combined to create a “blended” strategy that is less expensive (and less effective) than the too costly option. For example, instead of assigning Tx A to all patients, they could be randomly assigned in some proportion to Tx A and Tx B. In the CE graph, this would result in a new strategy somewhere on the line connecting the two strategies.

The line connecting two options in the graph represents the average cost and effect for all possible blends of the two treatments. The intersection of the ICER line with the cost ceiling (a horizontal line) represents the best hypothetical option blending of Tx A and Tx B. This optimal blend point is represented as k calculated as the ratio:

\[(\text{Cost}_A - \text{Cost Ceiling})/(\text{Cost}_A - \text{Cost}_B)\]

The interpretation is that k% of patients treated are given the less effective Treatment B instead of Tx A (or all patients are given Tx B for k% of their treatments, and Tx A the rest of the time). However, questions of equity mean that blends are not often relevant.

The other aspect of the concept of blending, and the blend line, is related to the extended dominance concepts discussed in the previous section. If a blended strategy is created, it may cause an extendedly dominated strategy to become an absolutely dominated one. In the extended dominance example on previous pages, some hypothetical blends of Tx A and Tx B would absolutely dominate Tx E.

**33.5 Net benefits calculations**

The calculation of net monetary benefits (NMB) and net health benefits (NHB) is increasingly prevalent in health economic evaluations, either in addition to or sometimes instead of using ICERs.

In essence, the Net Benefits calculations combine cost, effectiveness and willingness-to-pay into a single measurement. The strategy with the highest Net Benefit is the most cost-effective given the fixed willingness-to-pay parameter.
Willingness-to-pay (WTP) represents how much you are willing to pay for an additional unit of effectiveness. In cost-effectiveness analysis, this is compared to the incremental cost-effectiveness ratio (ICER) to determine if a more expensive treatment should be considered cost-effective.

Willingness-to-pay is a weight on effectiveness in Net Benefits calculations.

The net monetary benefit (NMB) of an alternative is calculated using the following formula:

\[ NMB = E \times WTP - C \]

Where \( E \) represents effectiveness, \( C \) represents cost, and WTP is the willingness to pay (i.e., the decision maker’s threshold ICER).

The net health benefit (NHB) of an alternative is calculated using a similar formula:

\[ NHB = E - C/WTP \]

Some advantages of using net benefits:

- Regardless of the number of strategies, the most cost-effective comparator is simply the one with the highest net benefit, given a threshold ICER (“WTP” in TreeAge Pro).
- When trying to describe uncertainty in CE models with small mean differences in effectiveness (or many competing alternatives), net benefit calculations are not unstable as ratios like the ICER can be.
- Net benefits are the basis for acceptability curves and value of information curves.

Advantages of Net Benefits calculations

Additional background on the net benefits framework and analyses can be found in various journal articles, including:


### 33.6 Net Benefits versus WTP

Net monetary benefits (NMB) calculations integrate a particular WTP value and will prompt you to provide a WTP value range. The *Net Benefits vs. WTP* graph, in both average and incremental formats, functions as a sensitivity analysis on WTP.

An intervention’s mean effectiveness and cost statistics for the simulation are the only other inputs for each calculation of that intervention’s net benefit. Information about generating the Net Benefit versus WTP for a Monte Carlo simulation can be found in the section about CEA outputs.
Using the Health Care Tutorial example model tree, Markov Cancer Decision.trex, we can generate the Net Benefits versus WTP by following these steps:

- Select the Decision node.
- In the Analysis menu, select NMB vs WTP.
- In the NMB vs WTP Parameters dialogue which opens, observe the WTP value range is set from 0 to 100,000 with 20 intervals. Select OK.

The graph below shows output generated as the NMB changes by strategy over the range of WTP. The strategy with the highest NMB at a given WTP is the optimal strategy at that WTP. The optimal strategy changes when the NMB = ICER. If there are more than two strategies, there maybe more than one such strategy change.

33.7 Multi-attribute weighted costs

TreeAge Pro provides access to an unlimited number of payoff/reward sets. In Multi-Attribute calculations (refer to the Tree Calculation Methods and Preferences Chapter for details), this means that all enabled payoffs can be combined using a weighting function — i.e., a set of numeric or variable weights corresponding to pay off or Markov reward sets.

Under the Cost-Effectiveness calculation method, TreeAge Pro allows you to use a weighted cost function in the same way; up to all enabled payoff sets (less one for effectiveness) can be combined as the net cost component of CE calculations.
Using a weighted cost function in a cost-effectiveness model may facilitate clearer identification of the parts of a complex cost formula (for example, drug costs, hospital costs, and inpatient costs). It also makes it easier to switch between CEA using a single cost component, and CEA using different combinations of cost components.

### 33.7.1 Multi-attribute weighted costs: an example

In the example trees in the previous chapter, simple numeric values were assigned to each terminal node’s cost payoff. In most models, however, cost payoffs or rewards will be more complicated. The tutorial from the Building Formulas Using Variables and Functions Chapter includes an example tree in which a more realistically complex cost formula is used. The "Cost Formula" tree uses variables to represent the components of a cost formula. In the tutorial, the Simple calculation method was used, but the same issues apply to cost calculations under the Cost-Effectiveness calculation method.

Instead of representing the costs of hospitalization, surgery/drugs, prosthetics, and physical therapy as components of a single payoff (#1 in the example), each of these components can instead be placed in a separate payoff (i.e., #3-#6). Under the Multi-Attribute calculation method or the Cost-Effectiveness calculation method with multi-attribute costs, a simple weighting function could be used to recombine the component variables into a single cost calculation.

To see how the multi-attribute cost weightings work, open the Health Care tutorial example model CE Cost Formula.trex. This is a CE version of the tutorial example tree "Cost Formula".
If you look at the payoffs for a terminal node, you will see that the current calculation preferences are using the Total_Cost variable for cost calculations, which in turn combines several separate measurements of cost. If you change the number of enabled payoffs through the Tree Preferences, it is also possible to see that four other payoffs (#3 through #6) have been assigned the individual components of the Total_Cost formula. These separate payoff values can be used for multi-attribute weighted cost calculations.
Before making any changes to the tree, perform a cost-effectiveness analysis at the decision node. Later, after changing the payoff calculation preferences in the tree, we can re-run the analysis and compare the results to ensure that no errors were made.

Cost-Effectiveness Analysis on CE Cost Payoff Tree

Now, modify the Calculation Method preferences to use a multi-attribute cost formula, combining the four cost components already in payoffs #3 through #6.

To set up a weighted multi-attribute cost function:

- Choose Tree > Tree Preferences from the menu or press the F11 key to open the Tree Preferences Dialog.
- Navigate to the category Calculation > Payoffs.
- Note that the number of enabled payoffs to 6.
- Navigate to the category Calculation > Calculation Method.
- Change the Active Method to Multi-Attribute.
- Navigate to the category Calculation > Calculation Method > Cost-Effectiveness > Multi-Attribute.
- Enter a weight of 0 for the Cost payoff and weights of 1 for each payoff that represents a component of the overall cost (payoffs 3-6).
  Note that the box corresponding to the effectiveness payoff should be left blank (along with any unneeded payoffs). See below.
- Click OK to save the Tree Preferences.
Note that variables could have been entered for each weight instead of 1. This would provide greater flexibility, including the ability to run sensitivity analysis on the weight variables. If using variables for weights, those variables must be defined in the tree; they are then calculated dynamically when analyses are run.

Run another Cost-Effectiveness Analysis to ensure that the results are the same. They should be since the weighted multi-attribute costs mimic the original cost formula for the variable Total_Cost.

Note that a version of this model with the multi-attribute changes is also available - the Health Care tutorial example model: CE Cost Formula - MultiAttribute.trex.

### 33.7.2 Notes on using multi-attribute costs in CE trees

When weighted, multi-attribute costs are in use in a cost-effectiveness model. Terminal nodes will display the weighted cost payoff formula in brackets; nodes in a Markov model will display separate Markov information line items for each cost reward set.
33 Building and Analyzing Cost-Effectiveness Models

Multi-attribute cost payoff expressions

To turn off the display of multi-attribute payoff expressions, open the Display > Terminal Nodes preferences category inside Tree Preferences, and uncheck the option labeled Display payoff names.

If you do not enter terminal node payoff expressions for each active cost attribute (i.e., each payoff that is enabled and has an assigned multi-attribute weight), calculation errors will occur. If you enter a weight for the payoff set currently assigned to effectiveness, it is simply ignored during cost calculations. If you leave a weight blank, it evaluates to 0. If you subsequently reduce the number of enabled payoffs in the Calculation Method preferences, any disabled payoffs will be excluded from the weighted cost calculation.

The same weighting function will apply if the calculation method is changed to Multi-Attribute, instead of Cost-Effectiveness.

33.7.3 Markov CE models using multi-attribute costs

Just as with regular trees, Markov models can use the Multi-Attribute calculation method or the Cost-Effectiveness calculation method with the multi-attribute cost preferences described above.

TreeAge Pro calculates each Multi-Attribute (or Cost-Effectiveness with multi-attribute costs) Markov process in a single pass, with the cost weighting done during the Markov process, as well as using either the reward set #1 termination condition (for Multi-Attribute) or the CE termination condition. See the Health Care tutorial example model “Multi Cost Markov”.

See the subsequent chapters on Markov modeling later in the manual for more details.

33.8 Inverting effectiveness calculations

A basic assumption in most CE models is that when it comes to effectiveness, higher numbers are always better. When a cost-effectiveness model presents the reverse situation, with lower values of the effectiveness attribute being preferable, you must invert the calculated effectiveness and/or incremental effectiveness calculations in the tree.

Consider a cost-effectiveness study which tracks the number of adverse events as its measure of effectiveness. In this case, the alternative with the lowest calculated effectiveness value is the most
effective treatment. By default, however, TreeAge Pro’s CE analysis algorithm normally identifies options with higher calculated effectiveness value as being preferred. In the case of the adverse event model, leaving this default behavior will result in a CE graph and text report which incorrectly calculates incremental effectiveness and determines dominance.

Net Benefits:
To calculate Net Benefits in trees using inverted incremental effectiveness, TreeAge Pro simply reverses the sign on effects in the Net Benefits calculations. This means that Net Benefits are always negative, but the strategy closest to 0 is optimal.

33.8.1 Inverting incremental effectiveness

When effectiveness measures should be minimized rather than maximized, the strategy selection at decision nodes cannot be done in the standard way. The simplest way to handle this situation in TreeAge Pro is to invert only the incremental effectiveness values for each strategy, so incremental values are inverted.

For example, if a more costly strategy reduces an inverted effectiveness value from 5 to 3, the incremental effectiveness would be calculated as 2 rather than -2. Since the incremental cost is positive, the ICER would also be positive. The positive ICER can then be compared to a WTP threshold.

See the Health Care tutorial example model "CE Inverted Effectiveness" for the following steps.

To invert incremental effectiveness calculations only:
- Choose Tree > Tree Preferences from the menu or press the $F11$ key to open the Tree Preferences Dialog.
- Navigate to the category Calculation > Calculation Method.
- Confirm that the Cost-effectiveness calculation method is selected.
- Navigate to the category Calculation > Calculation Method > Cost-Effectiveness > Cost-Eff Parameters (WTP).
- Click the option labeled Invert incrementals only.
- Click OK to save the Tree Preferences.

Note that the CE Inverted Effectiveness model already has these preferences set for reference. You can use the steps provided for future work.
Tree Preferences - Cost-Effectiveness - Invert incrementals only

Inverting incremental effectiveness calculations results in a correct construction of the cost-effective frontier (with lines sloping down).

Cost-effectiveness graph with incrementals inverted

Analyses that use or report incremental effectiveness values will simply reverse the normal assumptions, instead of calculating how much "less effective" each more preferable option is.
Inverting incremental effectiveness is usually the preferable method of dealing with an inverted measure of effectiveness; it does not complicate the reporting of expected effectiveness, and does not require specifying a maximum effectiveness value, as does the following, alternate method.

### 33.8.2 Inverting expected effectiveness calculations

The second method works by inverting the expected effectiveness values calculated for each node, thereby resulting in inverted incremental effectiveness values.

To invert all nodes’ effectiveness values:

- Choose Tree > Tree Preferences from the menu or press the F11 key to open the Tree Preferences Dialog.
- Navigate to the category Calculation > Calculation Method > Cost-Effectiveness > Cost-Eff Parameters (WTP).
- Click the option labeled Invert average values.
- Assign a fixed maximum effectiveness value from which to subtract all nodes’ calculated effectiveness values during cost-effectiveness calculations.
- Click OK to save the Tree Preferences.

The inversion of calculated effectiveness values (rather than just incremental values, as above) results, again, in a correct ordering of options in the CE report. The options’ calculated incremental effectiveness values (and incremental CE ratios) are the same for both methods.

When inverting all nodes’ calculated effectiveness values, a maximum effectiveness value should be selected which is greater than or equal to the uninverted effectiveness of any particular option (even during sensitivity analysis). This will ensure that no inverted values are negative. You may assign a variable or expression for the maximum; at the root node, this expression will be evaluated prior to analysis.
Effectiveness is not inverted within a Markov process. TreeAge Pro will invert the Markov node’s calculated effectiveness, but Markov analysis graphs and text reports will use uninverted effectiveness values.

33.9 CE roll back optimal path parameters

As described in the previous chapter, the standard method of performing a baseline CEA in the TreeAge Pro Healthcare module is using the Analysis > Cost-Effectiveness or Analysis > Rankings commands at a decision node. In some cases, however, it may be useful to also display the calculated CEA values in the rolled back tree.

In order to roll back a CE tree, TreeAge Pro must be able to automatically select an optimal path at decision nodes. During CE roll back (and any analysis of a CE tree with embedded decision nodes) TreeAge Pro uses a number of special preferences that enable the model builder to customize the roll back algorithm.

To set the optimal path parameters for cost-effectiveness calculations:

- Choose Tree > Tree Preferences from the menu or press the F11 key to open the Tree Preferences Dialog.
- Navigate to the category Calculation > Calculation Method > Cost-Effectiveness > Cost-EFF Parameters (WTP).
- Enter values for willingness-to-pay. This can be a numeric value, such as 50,000, or a variable defined in the model.
- Enter values for minimum effectiveness and maximum cost, if desired.
- Click OK to save the Tree Preferences.
Note that you can use a variable for the "Willingness to pay" value; however, you cannot run sensitivity analysis on that variable because WTP is applied after the model is calculated, not during the model calculation.

While it is possible to set the CE parameters so that TreeAge Pro makes decisions simply by minimizing the CE ratio, it is also possible to have TreeAge Pro do the following:

- eliminate options below a minimum effectiveness
- eliminate options above a certain cost
- select the most effective option within an incremental cost-effectiveness threshold.

It is also possible to invert the effectiveness measure using the Tree Preferences, as described earlier in this chapter.

Clicking on the formula editor buttons next to the parameter entry boxes will open an expression editor dialog where formulas using variables and functions can readily be set up. Expressions entered for the cost-effectiveness parameters will always be calculated at the root node of the tree, regardless of the location of the decision node being evaluated.

33.9.1 The CE optimal path algorithm

In essence, the optimal alternative will be the most effective option with an ICER lesser than the specified willingness-to-pay (WTP). Any analysis that must select an optimal path, from the strategies at a decision node in a CE tree, does so by using the following algorithm:
1. If minimum effectiveness or maximum cost constraints are specified, any option that fails either test is eliminated.
2. The remaining options are ordered by increasing cost.
3. Any option which is dominated by another less costly, more effective option is eliminated.
4. Each option whose ICER calculated is relative to the next least costly option is greater than your WTP criterion is eliminated.
5. The most effective remaining alternative is selected as optimal.
6. If all options fail these tests, then the least costly option will be selected as optimal.

CE Optimal Path Algorithm

💡 If a WTP of 0 is specified, as is the default, ICERs are ignored, and the least costly option will be selected. If a negative WTP is specified, TreeAge again ignores ICERs, but instead picks the option with the lowest C/E ratio.
34. Sensitivity Analysis on Cost-Effectiveness Models

The previous chapter provided instructions on preparing a tree for cost-effectiveness calculations and performing baseline cost-effectiveness.

In a decision tree, threshold analysis involves searching an uncertain variable’s range for values where there is a change in optimal strategy. In a CE model, this means identifying variable values where an alternative changes from being cost-effective to being non-cost-effective (or where the most cost-effective strategy changes).

For a single uncertain variable, CE thresholds can be identified in a number of ways:

- Run a one-way sensitivity analysis while using either a Net Benefits (NHB or NMB) graph or the Incremental CE graph.
- Run a tornado diagram. Net Benefits calculations are used by default in the series of one-way sensitivity analyses.

For varying 2 or 3 variables simultaneously, multi-way CE sensitivity analysis can be used to find thresholds - using 2- and 3-way sensitivity analysis. By default, Net Benefits are used in dividing graph regions, thus indicating thresholds between regions.

The Introduction to Variables and Sensitivity Analysis Chapter covers the use of variables and sensitivity analysis in decision trees generally.

34.1 One-way cost-effectiveness sensitivity analysis

In a CE tree, the steps described in the Introduction to Variables and Sensitivity Analysis Chapter can be used to perform a one-way sensitivity analysis. We will provide brief instructions for one-way sensitivity analysis here too.

The same Healthcare tutorial example model, "CE Decision Tree.trex", is also used in this chapter.

To perform a one-way sensitivity analysis:

- Select the decision node.
- Choose Analysis > Sensitivity Analysis > 1 Way..., or click the toolbar button.
- In the Sensitivity Analysis dialog, the variable pEradicateRadSurg should already be selected with a range of 0.5 - 0.9 and 16 intervals. You can click on the Variable column to see a dropdown list of all the other variables to perform sensitivity analysis on.
- Select OK to run the analysis. (No need to check the box for microsimulation as this is a cohort model).
In CE analysis, multiple attributes and incremental calculations add complexity to the interpretation of results. TreeAge Pro provides several ways to view textual and graphical results of one-way CE sensitivity analysis.

### 34.1.1 One-Way CE sensitivity analysis text report

The immediate output from the one-way CE sensitivity analysis is a text report.
This text report shows model results for each value of the selected parameter within its uncertainty range. The results for each calculation essentially mirror the cost-effectiveness rankings output. The NMB column identifies the optimal strategy (i.e. the highest NMB) for that parameter value based on the WTP entered in Tree Preferences. The Dominance column identifies whether a strategy is dominated.

Note that strategies are sorted within each grouping based on cost by default. The Radiation strategy is the least costly for all calculations in this example, so that is listed first followed by the Surgery and Radiation strategy. However, this may not always be the case. You might choose to override the default sort via the option "Change order of strategies" to the right of the report. In the case where the cost of the strategies changes, this option would allow you to maintain the order of strategies regardless of which was the least costly.

To identify thresholds using the Net Monetary Benefits (CE Thresholds) graph:

- Click the Net Benefits (CE Thresholds) link in the One-way sensitivity analysis text reports.
- In the prompt, enter the Willingness-to-pay as 50000.

Sensitivity Analysis - Change Strategy Order

The text report (default or custom sort) can also be exported to Excel using the "Open in New Excel Spreadsheet" icon to the far right of the report toolbar. There are two export options - one showing each strategy in its own row and one showing all strategies in the same row.

To the right of the text report are links to generate graphs based on the CE sensitivity analysis data. Several of these will be described next.
- Select OK.

CE Sensitivity Analysis Net Benefits (CE Thresholds) Setup Dialog

A line graph will plot the NMB values for each strategy at the given WTP.

One-way sensitivity analysis Net Benefits (CE Thresholds) graph

Note that the variable parameter selected - pEradicateRadSurg - increases the NMB for the Surgery and Radiation Treatment, but has no impact on the Radiation Treatment. At the estimated value of 0.749, the Surgery and Radiation treatment becomes the more cost-effective strategy (highest NMB).

If there were thresholds, where one strategy's line crossed another, the Thresholds Report (link to right of graph) shows each threshold in the graph in a text format. Below is an example Thresholds report for pEradicateRadSurg over the range 0.5 to 0.9 to demonstrate thresholds which could occur.
34 Sensitivity Analysis on Cost-Effectiveness Models

Thresholds Report

Note that thresholds are identified through linear interpolation. Thresholds can usually be identified more accurately by increasing the number of intervals in the original sensitivity analysis.

Several other sensitivity analysis graphs also have a supporting Thresholds Report. They all function in the same way - identifying the points where the maximum (or minimum for cost) value is represented by a change in strategy.

34.1.3 Sensitivity Analysis - ICER Graph

The parameter vs. ICER graph is another good way to look at how the strategies' cost-effectiveness "balance" changes as the parameter value changes.

To open the parameter vs. ICER graph:

- Click the "parameter vs ICER graph" link in the One-way sensitivity analysis text reports.
- Enter the Willingness-to-pay value as 50000.
- Click OK.

The following graph is generated for this example model.
The graph shows how the ICER changes across the parameter's uncertainty range. The vertical dotted red line indicates an asymptote at the parameter value of 0.6. This is where the incremental effectiveness is 0 at that point, so the ICER cannot be calculated. The graph also shows the cost-effectiveness threshold at value 0.749 where the ICER is equal to the WTP.

Note that the cost-effectiveness threshold is estimated using interpolation between model calculations. Since this is generated from a different outcome (ICER), it could identify a slightly different threshold value than the Net Benefits graph in the prior section. By adding more intervals, the thresholds from the two methods will converge.

34.1.4 Additional CE sensitivity analysis graphs

There are several more sensitivity analysis graphs described in this section.

The Cost-Effectiveness (animated) graph and its inverted version show the cost-effectiveness analysis graph for every value of the variable.
Cost-Effectiveness (animated) graph

Each frame shows the CE graph for one iteration of the sensitivity analysis. Pressing the Animate buttons, or using the slider, causes TreeAge Pro to step through each value of the sensitivity analysis variable.

From the primary 1-way sensitivity analysis output, each of the Parameter vs "Value" links show how a calculated value changes as the parameter changes. The Parameter vs Avg. Effectiveness graph below shows the impact of parameter uncertainty on the effectiveness outcome of each strategy.
Variable vs Average Cost graph

The graph above shows the threshold where the most effective strategy switches.

There are additional graphs not described in this section. They all work in the same way - showing how the outcome for the specific graph changes across the parameter range.

34.2 CE Tornado diagrams

Tornado diagrams study the impact of any number of individual parameters, then present them together in a single analysis. Essentially, it is a consolidated set of one-way sensitivity analyses.

There are several forms of tornado diagrams supported by TreeAge Pro. Each presents a distinct calculated value from the model on the x-axis. Each parameter variable selected in the tornado diagram has a horizontal bar representing the range of calculated values generated for the uncertainty range for that parameter.

The graph is called a tornado diagram because the bars are arranged in order, with the variable with the biggest impact at the top and the variable with the smallest impact at the bottom, resulting in a tornado-like appearance.
34 Sensitivity Analysis on Cost-Effectiveness Models

Tornado diagrams were improved in the 2017 R2.0 release. This section refers to Tornado diagrams in versions of the software after and including 2017 R2.0. For editing Tornado Diagrams in versions prior to 2017 R2.0 refer to both sections Cost Effectiveness Tornado Diagrams (Legacy) and Customizing Tornado Digarams (Legacy).

This section considers Tornado diagrams for models using the Cost Effectiveness Calculation Method. For Simple Calculation method models, refer to Tornado Diagrams. This section repeats some details from that section specifically for Cost Effectiveness models.

We continue using the same Health Care tutorial example model, "CE Decision Tree.trex".

To create a tornado diagram:

- Select the decision node.
- Choose Analysis > Sensitivity Analysis > Tornado Diagram OR click the Run Tornado Diagram icon in the tool bar (in Analyze layout).
- In the Tornado Diagram setup dialog, add the desired parameter variables along with their uncertainty range and intervals (just as is done for a single parameter in 1-way sensitivity analysis).
- If model calculations requires Microsimulation (patient simulation), check the box "Run microsimulation rather than EV". This is not needed for this cohort model.
- Click OK to start the analysis and the Tornado diagram options window will open.

As a reminder from previous chapters, only parameters are appropriate selections for sensitivity analysis. Parameters are identified as any variable which is defined at the root node as a fixed value or parameter distribution. If you choose an invalid variable for sensitivity analysis, you will see a warning similar to the two below.
Warning if any of the variables selected for Tornado Analysis are not a variable defined at the root node

Warning if the any of the variables selected for Tornado Analysis are not a constant or a distribution (i.e., Total_Cost, Total_Revenue)

Once the (valid) parameters are selected, click OK to run the analysis. You will then be presented with a number of options for generating tornado diagram graphs.

Tornado diagram options

There are four main areas in the Tornado diagram options:

- **Tornado Information**: Provides the number of strategies and the number of variables included in the Tornado output.
- Report Options: Select the Tornado Diagram you want to generate. The options are presented below.
  - ICER
  - Net Monetary Benefits
  - Incremental Net Monetary Benefits
  - Incremental Cost
  - Incremental Effectiveness
  - Cost only
  - Effectiveness only
  - C/E Rankings

- ICER Settings: Additional options related to the selected report option. For an ICER Tornado diagram, you must pick a pair of strategies. If a different Report Option were selected, then different options would appear in this section.
- Open Report: This generates a Tornado Diagram based on the selections above.

The following sections will examine each of these report options.

34.2.1 ICER Tornado diagram

An ICER Tornado reports the range of ICERs generated for each parameter’s uncertainty range. ICER calculations require a pair of strategies, so you must select two strategies for this graph. (In this model, we only have two strategies so they are both selected by default).

To create an ICER Tornado diagram:

- Select ICER in the Report Options.
- Select the pair of strategies to use in the ICER Settings.
- Select Open Report and see the figure generated below.
ICER Tornado diagram - comparing strategies Radiation vs. Surgery and Radiation

The graph shown above is presented along with options on either side.

- To the left, there are Chart Options that allow you to change the presentation of the graph.
- To the right, are links to secondary report/graph outputs.

Each option is described later in this section.

The Tornado diagram

The graph shows the range of ICERs generated by calculating the model across the uncertainty range of each parameter. The bars are ordered from widest to narrowest, placing the parameters with the greatest impact at the top.

In general, sensitivity analysis examines how uncertainty changes outputs from the base case values using the best estimate for each parameter. That base case ICER value is represented in this model by the dashed vertical line with the label EV: 37,714.29 - which is the model's base case ICER. As the parameter changes across its uncertainty range, the ICER may start to the left (below) or the right (above) of the base case ICER EV line, then will end on the other side of the EV line.

The default presentation displays the ICER bars with the Color bars by parameter range option. This color option presents the bar so that you can immediately see whether an increase in the parameter value leads to an increase or a decrease in the ICER value.

- The blue portion of the bar represents the ICER range when the parameter value is lower than its base case value.
- The red portion of the bar represents the ICER range when the parameter is higher than its base case value.

Let's examine the top two bars in the tornado diagram in detail.

The top bar is for the pEradicateRad variable, which has a base case value of 0.6 and an uncertainty range of 0.5 to 0.7. The blue portion of the bar represents the low part of the uncertainty range - from 0.5 to 0.6 - while the red portion of the bar represents the high part of the uncertainty range - from 0.6 to 0.7. Therefore, increasing the parameter increases the ICER value.

The second bar is for the effEradicated variable. The blue portion of the bar represents the low part of the uncertainty range - from 8 to 10 - while the red portion of the bar represents the high part of the uncertainty range - from 10 to 12. Therefore, increasing the parameter decreases the ICER calculation.

There is a Chart Settings option *Color bars by ICER range* that puts blue for the lower ICER calculations and red for the higher ICER calculations, but then you lose visibility into the impact of the individual parameters. (In this case all bars are coloured blue on the left of the EV line, and red of the right).

Toward the bottom of the ICER tornado, note that there is no bar for the parameter cRadiation. This is because changes to that parameter have no effect on the ICER. Note that cRadiation is included in the cost payoff at every terminal node, resulting in an identical impact on cost for each strategy and no impact on incremental cost.

The bottom parameter - pEradicateRadSurg - has an infinity sign rather than a bar. Within the uncertainty range for that parameter, the incremental effectiveness passes through zero, which makes the ICER calculation undefined. Therefore, a bar would be invalid.

By default the graph also includes a *dashed line for the WTP*. Any bar that passes through that WTP line necessarily means that the underlying parameter has a cost-effectiveness threshold. You can see the value of the thresholds (if any) by selecting on each of the 1-way sensitivity graphs indicated to the right of the Tornado graph.

### 34.2.1.1 Chart Settings

The Chart Settings allow modification of the Tornado diagram easily. For all Tornado diagrams the Chart Settings are on the left-hand side and can be hidden using the arrows (<<) at the top.

*Edit the following items via Chart Settings:*

- *Show title:* Check this box to show/hide the title. The title can be changed editing the text in the box below the check box.
- *Show legend:* Various options for show/hide variables names, descriptions and their range in the legend. The Numeric format of these variables is changed via selecting the button ‘Numeric formatting...’ to change items such as the number of decimal places, trailing zeros and thousand separators.
- **Show variable range**: This is included in the Show Legend grouping above:
  - **Order by EV impact**: This orders the variable description by their EV impact. This allows you to see from the key whether the variable moves from high to low or low to high as the EV changes.
  - **Order by parameter value**: This orders the variable description by their parameter value from lowest to highest.
  - **Include base case**: This includes the base case parameter value prior to the parameter's uncertainty range.

- **Axis**: Change the label, range and numeric formatting on the horizontal axis.
- **Show EV Line**: Check box to show the EV line and edit the text and numeric formatting via ‘Numeric formatting…’ button.
- **ICER (ICER Tornado only)**: This allows the Tornado to use different colors for the bars as described earlier in this section. You can also choose to show the WTP line based on Tree Preferences or set a custom WTP line.
- **Bar colors**: Edit the colors of the bars or select grey scale colors for each variable.

After making any changes, use the Apply button to make the changes to the Tornado diagram.

### 34.2.1.2 Actions/Secondary Outputs

To the right of the ICER Tornado diagram, there are a set of links to secondary outputs including a Tornado Text Report and a graph for each individual parameter included in the primary graph.

**Tornado Text Report**

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Variable Description</th>
<th>Variable Low</th>
<th>Variable Base</th>
<th>Variable High</th>
<th>Impact</th>
<th>Low</th>
<th>High</th>
<th>Spread</th>
<th>Spread^2</th>
</tr>
</thead>
<tbody>
<tr>
<td>pXradiateRad</td>
<td>Probability is eradicated by radiation</td>
<td>0.5</td>
<td>0.6</td>
<td>0.7</td>
<td>Increase</td>
<td>25608.322581</td>
<td>27428.57143</td>
<td>47410.04762</td>
<td>228757.2696.14512</td>
</tr>
<tr>
<td>effRad</td>
<td>Life expectancy if tumor eradicated</td>
<td>8</td>
<td>10</td>
<td>12</td>
<td>Decrease</td>
<td>29777.77778</td>
<td>33000</td>
<td>12312.22222</td>
<td>2408378.65383</td>
</tr>
<tr>
<td>cSurgery</td>
<td>Cost of surgery</td>
<td>40900</td>
<td>30000</td>
<td>00000</td>
<td>Increase</td>
<td>83971.42857</td>
<td>48092.14286</td>
<td>14285.71429</td>
<td>2000818.65383</td>
</tr>
<tr>
<td>cFollowupAnnual</td>
<td>Cost of followup per year</td>
<td>1800</td>
<td>2000</td>
<td>2200</td>
<td>Increase</td>
<td>37514.28571</td>
<td>27924.28571</td>
<td>2000818.65383</td>
<td></td>
</tr>
<tr>
<td>cRadiation</td>
<td>Cost of radiation</td>
<td>25000</td>
<td>30000</td>
<td>35000</td>
<td>Increase</td>
<td>37714.28571</td>
<td>37714.28571</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Tornado text report (ICER)**

The Tornado Text Report includes the following columns.

- **Variable Name**: name of parameter variable.
- **Variable Description**: description for parameter variable.
- **Variable Low**: low end of the parameter's uncertainty range.
- **Variable Base**: base case value for the parameter.
- **Variable High**: high end of the parameter's uncertainty range.
- **Impact**: defines whether the calculated output (ICER) increases or decreases with the parameter range.
- **Low**: lowest value for the ICER.
- **High**: highest value for the ICER.
- **Spread**: This is the width of the bar (i.e., High EV minus Low EV).
- **Spread^2**: The spread value, squared. Adding the Spread^2 values to calculate a net risk value, two additional measures of uncertainty are then calculated for each variable: Risk % and Cumulative Risk%.
- **Risk %**: This is a measure of how much of the total uncertainty is represented by the specified bar (equal to: SpreadSqr / NetRisk). The Risk% values sum to 1.0 across all the variables.
- **Cum Risk %**: A cumulative version of Risk %, making it easy to scan the bars and say “to address 90% of the risk, I must consider the uncertainty represented by the following variables….”

Note that the last two entries in the bottom row of the table are not presented above because they cannot be calculated when there is a parameter with an unlimited spread (the infinity sign in the Tornado diagram).

*Individual Parameter Graphs*

Each individual parameter link creates a graph that demonstrates how the ICER changes with respect to the parameter's uncertainty range. This is the same graph you would get from the "variable vs. ICER" link in a 1-way sensitivity analysis.
34.2.2 Net Monetary Benefit Tornado diagram

A Net Monetary Benefit (NMB) tornado reports the range of NMBs for the optimal strategy generated for each parameter’s uncertainty range. Note that since this is only reflecting the optimal strategy, which can change, the width of the bars is not very meaningful.

However, the NMB tornado diagram does provide value.

1. You can run it for all strategies, not just a pair of strategies.
2. It identifies all parameters with a CE threshold.

The CE thresholds are identified by a bold vertical line within the bar. If you see one or more in any bar, there is a CE threshold. You should then use the secondary graph for that parameter to see the details related to the parameter’s value(s) for the threshold and the change in the optimal strategy.

Many modelers prefer the ICER tornado report to the NMB tornado because it incorporates the relative change in cost and effectiveness between any pair of strategies.
To create a NMB Tornado:

- Select Net Monetary Benefits in the Tornado Diagram Options.
- In the Net Benefits Settings set the Willingness-to-pay (WTP) to an appropriate value for your model. We set WTP to 50000.
- Select Open Report and see the figure generated below.

Net Monetary Benefits Tornado diagram

Just like the ICER Tornado, the graph shown above is presented along with options on either side.

- To the left, there are Chart Options that allow you to change the presentation of the graph.
- To the right, are links to secondary report/graph outputs.

The Tornado diagram

The graph shows the range of optimal strategy NMB generated by calculating the model across the uncertainty range of each parameter. The bars are ordered from widest to narrowest, placing the parameters with the greatest impact at the top. Note that this order is not necessarily meaningful
because optimal strategy NMB is not a good measure of the relative cost-effectiveness of your strategies.

In general, sensitivity analysis examines how uncertainty changes outputs from the base case values using the best estimate for each parameter. That base case NMB value is represented in this model by the dashed vertical line with the label EV: 332,800 - which is the NMB for the optimal strategy - Radiation & Surgery. As the parameter changes across its uncertainty range, the NMB for the optimal strategy may change, and the optimal strategy may change.

If, and when, the optimal strategy changes for a parameter, you will see a black vertical line in the bar. You will need to examine the secondary report to see details about the strategy change. For example, the top bar, the variable effEradicated, contains a black vertical line indicating a CE threshold/strategy change. Use the secondary NMB graph for that parameter to better understand the threshold.

To generate the secondary graph for the parameter effEradicated, click on the appropriate link in the Actions list to the right of the NMB Tornado. The graph is presented below.

![Sensitivity Analysis (WTP=50,000)](image)

One way sensitivity analysis (WTP = $50,000) for parameter effEradicated (Life Expectancy of Tumor Eradicated) indicating the threshold (8.21)
Note the CE threshold at parameter value 8.21 where the optimal strategy switches from Radiation to Radiation and Surgery.

34.2.2.1 Chart settings

The Chart Settings allow modification of the Tornado diagram easily. For all Tornado diagrams the Chart Settings are on the left-hand side and can be hidden using the arrows at the top.

*Edit the following items via Chart Settings:*

- **Show title:** Check this box to show/hide the title. The title can be changed editing the text in the box below the check box.
- **Show legend:** Various options for show/hide variables names, descriptions and their range in the legend. The Numeric format of these variables is changed via selecting the button ‘Numeric formatting...’ to change items such as the number of decimal places, trailing zeros and thousand separators.
- **Show variable range:** This is included in the Show Legend grouping above:
  - **Order by EV impact:** This orders the variable description by their EV impact. This allows you to see from the key whether the variable moves from high to low or low to high as the EV changes.
  - **Order by parameter value:** This orders the variable description by their parameter value from lowest to highest.
  - The figure of the NMB Tornado with Threshold above shows the option of choosing Order by EV impact. In that figure, the impact of Cost of Radiation (35,000 to 25,000) can be seen in the last from bottom bar. The same information can be seen from the 1-way sensitivity analysis graph, showing how increasing values of cost of Radiation decreases the NMB.
- **Axis:** Change the label, range and numeric formatting on the horizontal axis.
- **Show EV Line:** Check box to show the EV line and edit the text and numeric formatting via ‘Numeric formatting...’ button.
- **Show thresholds (NMB Tornado Only):** This turns on and off the Threshold where there is a change in strategy.
- **Extend bars using threshold info (NMB Tornado Only):** Tornado diagrams include calculations at specific points in the variable parameter range based on the number of intervals. TreeAge Pro interpolates between each pair of calculations to draw graph lines and identify CE thresholds. Occasionally, the CE threshold identified through interpolation will be beyond the edges of the calculated values themselves to the left or right. This option extends the width of the bar to include the interpolated threshold value for the parameter.

After making any changes, use the Apply button to make the changes to the Tornado diagram.
34.2.2.2 Actions/Secondary Outputs

To the right of the NMB Tornado diagram, there are a set of links to secondary outputs including a Tornado Text Report and the graphs for the individual parameters included in the primary graph.

**Tornado Text Report (Net Benefit)**

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Variable Description</th>
<th>Variable Low</th>
<th>Variable Base</th>
<th>Variable High</th>
<th>Impact</th>
<th>Low</th>
<th>High</th>
<th>Spread</th>
<th>Spread^2</th>
<th>Risk %</th>
<th>Cum Risk %</th>
</tr>
</thead>
<tbody>
<tr>
<td>effReciated</td>
<td>Life expectancy if tumor reciated</td>
<td>8.5</td>
<td>10</td>
<td>12</td>
<td>Increase</td>
<td>258000</td>
<td>409500</td>
<td>151600</td>
<td>2662500000.00002</td>
<td>0.872</td>
<td>0.872</td>
</tr>
<tr>
<td>pctRadicalRadiation</td>
<td>Prob tumor is eradicated by radiation and surgery</td>
<td>9.5</td>
<td>9.8</td>
<td>0.9</td>
<td>Increase</td>
<td>315500</td>
<td>365400</td>
<td>50800</td>
<td>2505650000.00001</td>
<td>0.986</td>
<td>0.970</td>
</tr>
<tr>
<td>cSurgery</td>
<td>Cost of surgery</td>
<td>40000</td>
<td>30000</td>
<td>60000</td>
<td>Decrease</td>
<td>322800</td>
<td>432800</td>
<td>20000</td>
<td>4000000000</td>
<td>0.813</td>
<td>0.986</td>
</tr>
<tr>
<td>cRadiation</td>
<td>Cost of radiation</td>
<td>9.5</td>
<td>9.6</td>
<td>0.7</td>
<td>Increase</td>
<td>322800</td>
<td>349200</td>
<td>16400</td>
<td>2505650000</td>
<td>0.918</td>
<td>0.996</td>
</tr>
<tr>
<td>cFollowupAnnual</td>
<td>Cost of followup per year</td>
<td>18300</td>
<td>20000</td>
<td>22000</td>
<td>Decrease</td>
<td>331080</td>
<td>385230</td>
<td>3440</td>
<td>1183930000</td>
<td>0.906</td>
<td>1.000</td>
</tr>
</tbody>
</table>

The Tornado Text Report shows the input and output ranges and some statistical columns.

- **Variable Name**: name of parameter variable.
- **Variable Description**: description for parameter variable.
- **Variable Low**: low end of the parameter's uncertainty range.
- **Variable Base**: base case value for the parameter.
- **Variable High**: high end of the parameter's uncertainty range.
- **Impact**: defines whether the calculated output (NMB) increases or decreases with the parameter range.
- **Low**: lowest value for the optimal strategy NMB.
- **High**: highest value for the optimal strategy NMB.
- **Spread**: This is the width of the bar (i.e., High EV minus Low EV).
- **Spread^2**: The spread value, squared. Adding the Spread^2 values to calculate a net risk value, two additional measures of uncertainty are then calculated for each variable: Risk % and Cumulative Risk%.
- **Risk %**: This is a measure of how much of the total uncertainty is represented by the specified bar (equal to: SpreadSqr / NetRisk). The Risk% values sum to 1.0 across all the variables.
- **Cum Risk %**: A cumulative version of Risk %, making it easy to scan the bars and say “to address 90% of the risk, I must consider the uncertainty represented by the following variables....”

The individual parameter links show the range of the NMB (from the Tornado x-axis) vs. the parameter range for that parameter. This was described in the prior section when looking at the details for a CE threshold.

34.2.3 Incremental Net Monetary Benefit Tornado diagram

An Incremental Net Monetary Benefit (NMB) tornado reports the range of INMBs generated for each parameter's uncertainty range. This graph does present the relative cost-effectiveness of two
strategies, so it can be useful, especially when the ICER Tornado is difficult to interpret due to a change in the most effective strategy (infinity sign).

To create an Incremental NMB Tornado:

- Select the Incremental Net Monetary Benefits option in the Report Options.
- In the INMB Settings section on the right hand side, select a pair of strategies. Note that you will typically use the more cost-effective strategy as the Comparator and the less cost-effective strategy as the Baseline (higher vs. lower NMB).
- In the INMB Settings set the Willingness-to-pay (WTP) to an appropriate value for your model. We set WTP to $50,000.
- Select Open Report and see the figure generated below.
The INMB Tornado shows the range of INMB (comparator NMB vs. baseline NMB) generated by calculating the model across the uncertainty range of each parameter. The bars are ordered from widest to narrowest, placing the parameters with the greatest impact at the top.

In general, sensitivity analysis examines how uncertainty changes outputs from the base case values using the best estimate for each parameter. In this example, the base case INMB value is represented by the dashed vertical line with the label EV: 17,200 - which is the model's base case INMB. As the parameter changes across its uncertainty range, the INMB may start to the left (below) or the right (above) of the base case INMB EV line, then will end on the other side of the EV line.

The default presentation displays the ICER bars with the **Color bars by parameter range** option. This color option presents the bar so that you can immediately see whether an increase in the parameter value leads to an increase or a decrease in the INMB value.

- The blue portion of the bar represents the INMB range when the parameter value is lower than its base case value.
- The red portion of the bar represents the INMB range when the parameter is higher than its base case value.

Let's examine the first two bars in the tornado diagram in detail.

The top bar is for the pEradicateRadSurg variable, which has a base case value of 0.8 and an uncertainty range of 0.5 to 0.9. The blue portion of the bar represents the low part of the uncertainty range - from 0.5-0.8 - while the red portion of the bar represents the high part of the uncertainty range - from 0.8-0.9. Therefore, increasing the parameter increases the INMB calculation. Note that for this parameter, no ICER Tornado graph could be presented.

The second bar is for the pEradicateRad variable, which has a base case value of 0.6 and an uncertainty range of 0.5 to 0.7. The blue portion of the bar represents the low part of the uncertainty range - from 0.5-0.6 - while the red portion of the bar represents the high part of the uncertainty range - from 0.6-0.7. Therefore, increasing the parameter decreases the INMB calculation.

The Chart Settings and Actions (graphs and text reports) can be used to change the Tornado digram and generate the one-way sensitivity analysis graphs and text reports as detailed in the previous sections.

34.2.4 Incremental Cost Tornado diagram

An Incremental Cost tornado reports the range of incremental costs generated for each parameter's uncertainty range. It gives the difference between two strategies in one measure.

Use this Tornado diagram to examine how the cost of strategies change based on a set of parameter ranges. Effectiveness is totally ignored in this graph and its secondary outputs.
Incremental Cost Tornado Diagram

The chart options and secondary reports work the same as the prior tornado diagrams.

34.2.5 Incremental Effectiveness Tornado diagram

An Incremental Effectiveness tornado reports the range of incremental effectiveness values generated for each parameter's uncertainty range. It gives the difference between two strategies in one measure.

Use this Tornado diagram to examine how the effectiveness of strategies change based on a set of parameter ranges. Cost is totally ignored in this graph and its secondary outputs.
Incremental Cost Tornado Diagram

The chart options and secondary reports work the same as the prior tornado diagrams.

34.2.6 Cost-only Tornado diagram

Use this Tornado diagram to examine how the cost of the least costly strategy changes based on a set of parameter ranges. Note that the least costly strategy could change. Effectiveness is totally ignored in this graph and its secondary outputs.
34.2.7 Effectiveness only Tornado diagram

Use this Tornado diagram to examine how the effectiveness of the most effective strategy changes based on a set of parameter ranges. Note that the most effective strategy could change. Note that Cost is totally ignored in this graph and its secondary outputs.
Effectiveness only Tornado diagram

The chart options and secondary reports work the same as the prior tornado diagrams.

### 34.2.8 CE Rankings

This link from the Tornado Diagram options generates the CE Rankings for any variable selected in the C/E Rankings Settings. See the section one-way sensitivity analysis for more details about the one-way sensitivity report or C/E Rankings.

### 34.3 2-way CE sensitivity analysis thresholds using Net Benefits

As described in the More Sensitivity Analysis Tools Chapter, in a tree set to calculate a single attribute (e.g., cost or utility), a two-way sensitivity analysis identifies the optimal alternative for each combination of values of the two variables. Based on this, a region graph is created in the two-dimensional variable space with regions assigned to the alternatives based on their optimality. The lines dividing two regions are threshold lines.

It is also possible to run 2- and 3-way sensitivity analysis on cost-effectiveness trees using Net Benefits calculations, making CE thresholds easy to identify.
TreeAge will prompt you for a willingness-to-pay value to use in the Net Benefits calculations for all strategies.

To run 2-way sensitivity analysis on an example model:

- Open the Health Care tutorial example model "Blindness Prevention - after CE changes.trex".
- Select the root node.
- Choose Analysis > Sensitivity Analysis > 2 Way... from the menu.
- Select the variables diseasePrev and testSpec and set the ranges based on the figure below.
- Enter the Willingness-To-Pay parameter and select the calculation type based on the figure below and click OK.

For the given WTP, the strategy having the highest net benefit for any coordinate in the analysis will be assigned that point. Regions of cost-effectiveness can then be constructed on this basis. We entered very large ranges for our two variables, so all three strategy options come into play.
2-way sensitivity analysis graph

Most of the variable value combinations recommend the Biopsy strategy. However, when the test sensitivity is close to zero, the recommended strategy is either Treat None or Treat All. This is not surprising since a test with no sensitivity has no value.

The Text Report for the graph shows cost, effectiveness and net benefit calculations for each strategy at each combination of variables.
2-way sensitivity analysis text report

Note that at the point where \( \text{diseasePrev} = 0.375 \) and \( \text{testSpec} = 0.25 \), the net benefit values for all three strategies are very close, mirroring the border of all three strategies on the region graph.

Note that you can change the order of variables and the order of strategies for this report via the links to the right of the report. The order selections will be included in data exported to Excel via the "Open in New Excel Spreadsheet" icon to the far right of the report toolbar.

34.4 3-way CE sensitivity analysis thresholds using Net Benefits

3-way sensitivity analysis is run and displayed in a similar way to 2-way sensitivity analysis. Instead of selecting two variable with their ranges, you select three. The graphical output is the same except there is an animation option to show you a series of 2-way sensitivity analysis NMB graphs as the third variable changes.

The text report and Excel outputs contain the same options to reorder by strategy and by variable.

34.5 2-way CE sensitivity analysis, cost regions and isocontours

Isocontours have not been implemented in TreeAge Pro 201x.
34.6 Displaying incremental values during roll back

The calculated incremental values of competing strategies in a cost-effectiveness tree are not automatically displayed when the tree is rolled back. The easiest way to report incremental expected values is to generate the CE analysis text report as described in the previous chapter. It is possible, however, to display incremental values in the rolled-back tree.

For a visual display of incremental values in the rolled-back tree, you need to create terminal node columns that display the appropriate incremental values, and then collapse the subtrees to the right of the decision node. Terminal node columns, covered in detail in the Tree Display Preferences and Options Chapter can be used to display incremental values to the right of visual end nodes (not just terminal nodes) during roll back.
35. Probabilistic Sensitivity Analysis on Cost-Effectiveness Models

The Monte Carlo Simulation Chapter covers the basic aspects of performing Monte Carlo simulation: using the simulation output window to display statistical information, a full text report, and graphs describing the probability distribution of inputs and outputs.

TreeAge Pro Healthcare adds a number of graphs and reports designed specifically for Monte Carlo simulation of cost-effectiveness models. These are described in this chapter.

35.1 Performing Cost-Effectiveness Probabilistic Sensitivity Analysis

Probabilistic Sensitivity Analysis (PSA) measures the impact of overall uncertainty on model results. This requires parameter distributions to be integrated into the model. When PSA runs, all parameter distributions are sampled and the model is recalculated. The overall result set is a series of model recalculations, each of which is based on a different set of parameter distribution samples. Many of these individual recalculations will confirm your base case optimal strategy, but some may not. The more recalculations confirm your base case, the more confidence you will have in that conclusion.

Although PSA results is always a set of model recalculations, there are several mechanisms to generate this output.

- PSA - generate each model recalculation via expected value calculations on the model.
- PSA & Microsimulation - generate each model recalculation by running a set of individual trials through the model and return the mean values from the trial set as the expected values.
- EVPPI - isolate one or more distribution from the other parameter distributions in a separate simulation loop, limiting the uncertainty to those selected distributions.
- EVPPI & Microsimulation - isolate one or more distributions as above, but generate the expected values via means from trial sets.

This chapter focuses on the first PSA simulation in the list above. However, the output from all four simulations uses the same format with the same secondary outputs.

💡 When running a two-dimensional simulation (samples and trials, or PSA & Microsimulation), trial-level data is aggregated into means for the entire trial set. TreeAge Pro includes advanced functionality for extracting the details lost when the trial sets are aggregated. Time Reporting can be used to collect trial-level data within the context of a PSA & Microsimulation analysis.

As described in the earlier simulation chapter, Monte Carlo simulations generate outputs that present simulation statistics and provides access to a number of reports and graphs. Simulation outputs can be saved for reference later.
In this chapter, we run PSA on a CE model that already contains distributions. For information on adding distributions to a model, refer to the earlier simulation chapter for non-CE models.

To perform CE Probabilistic Sensitivity Analysis:

- Open the Health Care tutorial example tree "CE Markov Sampling".
- Select the root node.
- From the menu, choose Analysis > Monte Carlo Simulation > Sampling (Probabilistic Sensitivity)...
- Enter 1000 for the number of samples.
- Click Begin.

Simulation setup dialog

Since the simulation was run on a cost-effectiveness tree, statistics for both cost and effectiveness are displayed and split up into three groups:

- Cost: Cost values.
- Eff: Effectiveness values.
- NMB: Net Monetary Benefits values.

If a cost-effectiveness simulation is performed at a decision node, each strategy’s values are displayed in a separate column.
35.1.1 Simulation output common to simple and cost-effectiveness models

A few output options are described in the Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis Chapter that function exactly the same way for cost-effectiveness models, so you should reference that chapter for common outputs. Some of the options which function similarly are:

- Histograms: Information about those Output Distributions which differ for CEA PSA is provided in this chapter.
- Report Options: These are the same for all Monte Carlo Simulations.
- Saving Simulations: These are the same for all Monte Carlo Simulations.
- Simulation Options: These are the same of all Monte Carlo Simulations.

Several options that appear both for PSA of simple and cost-effectiveness trees are described in this chapter because they function differently within each context.

This chapter is split into the following sections which describe the reports found under each report category. The sections are:

- Data Reports
35.2 Data Reports

The Data Reports are organised into a list of key reports and then a list of Other reports. The Key Reports are:

- **Summary Report**: Displays aggregated data for the simulation outputs. The report headings use the names given in the model.

- **All Data Report**: Displays the complete output from each iteration of the simulation. For PSA simulations, each iteration represents a recalculation of the model based on parameter distribution samples. The report lists the iteration, values of Cost and Effectiveness for each Strategy, NMB for each strategy, Optimal strategy and values for each Distribution, see the figure below. Note that the Optimal Strategy for that model calculation is determined by NMB using the fixed WTP from Tree Preferences.
CE PSA All Data Report

- **All Data Report Export**: Creates a report which is exactly the same as the All Data Report but will export directly to *.xls/*.txt format. This is more efficient than creating the All Data Report first and then exporting.

- The *Other* reports are:
  
  - **Strategy Values (Grouped)**: When you select this report you are prompted to enter the range of iterations and the WTP for the report (WTP = $50k here). The figure below illustrates the "grouped" output for each Strategy.

CE PSA Output - Strategy Values

- **Identifying Variables**: This report allows you to review the specific values the variables were set to when you ran the simulation. This is useful if you run/save multiple simulations with different variable values. For details about setting Identifying Variables, see the Identifying Variables section in the Preferences Chapter or refer to the equivalent section in the Monte Carlo Simulation Chapter.

- **Expected Values**: This report is a subset of the All Data Report and presents the mean values for the enabled or active payoff sets for each set of Samples.
- *Distributions (by name)*: This report lists the sampled distribution values from the simulation by name.
- *Distributions (by index)*: This report lists the sampled distribution values from the simulation by index.

### 35.3 PSA Outputs

The PSA outputs are split into the following report groups with section for each below:

- Acceptability Curve
- Acceptability Curve at WTP (Strategy Selection)
- CE Scatterplot
- ICE Scatterplot
- ICER Distributions
- EVPI\EVPPI Summary Reports

#### 35.3.1 Acceptability Curve

The *Acceptability Curve* is a commonly-used visual aid for communicating the results of probabilistic sensitivity analysis in cost-effectiveness models.

TreeAge Pro’s Acceptability Curve presents the relative cost-effectiveness as a function of the ICER threshold (WTP). For each WTP value, the graph uses net benefits to determine the percentage of simulation iterations that favor each strategy. The percentages will increase for more effective strategies as the WTP increases.

*To generate the Acceptability Curve from CE PSA simulation output:*

- Select the graphical output PSA Outputs > Acceptability Curve.
- Enter the curve’s parameters in the Monte Carlo CE Acceptability Curve Parameters dialog (see below). Click OK.
Like a sensitivity analysis, the Acceptability Curve requires a range of values for the WTP (threshold ICER). You can also select the range of iterations to include in the graph. It is recommended that you select all iterations. The Acceptability Curve includes a line series for each strategy, with the values summing to 100% at each interval.

Acceptability Curve

The interpretation usually applied to the net benefits acceptability curves is that the graphed value of any comparator at a particular WTP represents the probability that is cost-effective (most effective option within the threshold ICER), based on the uncertainties included in the simulation.

The value of a comparator at WTP=0 represents the probability that it is the least costly option. As the WTP increases within the range, the relative value of effectiveness increases relative to cost, and the more effective strategies are more frequently the most cost-effective strategies.


The Acceptability Curve’s Text Report provides the numerical data for each option's probabilities at each WTP interval.
Acceptability Curve Text Report

The Combine option to the right of the graph allows you to show both the graph and the text report in the same output window.

35.3.2 Acceptability Curve at WTP (Strategy Selection Frequency)

The *Acceptability at WTP* option shows the percentage of iterations that favor each strategy based on net benefits calculations at a specific willingness to pay value (rather than a range).
35.3.3 CE Scatterplot

The CE graph, which plots the mean cost and mean effectiveness of each strategy, can be naturally extended to a scatterplot for the simulation. The CE Scatterplot uses the cost-effectiveness plane to plot the individual cost and effectiveness pairs for each recalculation of the model. If the simulation is performed at a decision node, each strategy’s set of points uses a different color.
Depending on the number of iterations included in the simulation, it may be useful to either include only a subset of results in the plot (e.g., if the general density of points is too high) or to increase the size of the dots used in the plot (e.g., if there are only a few points to display). These techniques are described in the Customizing scatterplot graphs section of the Graph Windows Chapter. The graph below uses the same output, but only 20% of the scatterplot points.
35.3.4 Acceptability Frontier

The Acceptability Frontier graph is no longer supported in TreeAge Pro.

35.3.5 ICE Scatterplot

The ICE Scatterplot can be run on any pair of strategies. We recommend that you choose the pairing such that the comparator is a more expensive strategy and the baseline is a less expensive strategy. This will result in mostly positive incremental values, which are easier to interpret. You must select the comparator and baseline strategies via the appropriate report link (comparator first and baseline second).

The graph contains axes that represent the incremental cost (y-axis) and incremental effectiveness (x-axis). Each point in the graph represents the incremental cost and incremental effectiveness values (comparator vs. baseline) from a single recalculation of the model.

After you click on an ICE scatter link, a dialog box is presented to allow easy access to the WTP and number of iterations for the graph.

![CE PSA Output - ICE Scatterplot dialog](image)

The WTP, or ICER threshold, is used as the slope of a line intersecting the origin of the plot. The WTP line in the graph intersects points having the specified ICER value, and the region below and to the right of the line includes points where the comparator is more cost-effective than the baseline. This is utilized in the scatterplot’s Text Report and ICE Report to calculate the percentage of simulation iterations for which the comparator is cost-effective. A similar analysis is done using a different graph, the Acceptability Curve, which works for all strategies in the analysis, not just two.
The resulting ICE Scatterplot for Rx A v. Rx B is presented below with incremental effectiveness (IE) on the x-axis and incremental cost (IC) on the y-axis. Note the ellipsis showing the 95% confidence interval.

CE PSA Output - ICE Scatterplot graph

The graph above shows that the Rx B strategy (relative to Rx A) is always more effective, nearly always more costly, and that when it is both more costly and more effective, the ICER is almost always less than the WTP. Overall, Rx B is nearly always more cost-effective than Rx A given a WTP of 50,000.

For details on how confidence ellipses account for correlation between cost and effects, see “Reflecting Uncertainty in Cost-Effectiveness Analysis”, Manning et al, Ch. 8 in Cost-Effectiveness in Health and Medicine, Gold et al., Oxford Univ. Press (1996).

You can customize the scatterplot after it is generated using techniques described in the Customizing scatterplot graphs section of the Graph Windows Chapter. Customizations include:

- Changing the WTP.
- Changing the confidence interval.
- Changing the scale for the axis.
- Changing the marker type and/or size.
- Filtering the number of scatterplot points.

The graph below uses the same output, modified to set the x-axis scale to include the 0 value.
CE PSA Output - ICE Scatterplot graph (customized)

Though not part of the graph itself, the graph's quadrants and components are identified in red above. Each component implies a relationship between the two strategies based on IC and IE relative to the ICER threshold. The components are shown in the ICE Report described later in this section.

The graph's ICE Report summarizes the graph's individual data points by component. See below.

CE PSA Output - ICE Scatterplot ICE Report

This summary can be interpreted to indicate the number of iterations that recommend the comparator strategy over the baseline strategy as follows:

- C1 - Comparator is less costly and more effective. Comparator is recommended because it absolutely dominates baseline.
- C2 - Comparator is more costly and more effective. Comparator is recommended because the ICER does not exceed the WTP.
- C3 - Comparator is less costly and less effective. Comparator is recommended because the ICER does not exceed the WTP.
- C4 - Comparator is more costly and more effective. Comparator is not recommended because the ICER exceeds the WTP.
- C5 - Comparator is less costly and less effective. Comparator is not recommended because the ICER exceeds the WTP.
- C6 - Comparator is more costly and less effective. Comparator is not recommended because it is absolutely dominated by the baseline.

Increasing the WTP value changes the slope of the WTP line, the shape of the component regions #2–5, and thus the report. See the section on Acceptability Curves below for a robust method of testing a range of WTP values for all potentially cost-effective strategies.

The graph’s Text Report shows the IC and IE for each iteration, which becomes the source of the scatterplot. See below.


### 35.3.6 ICER Distributions

These graphs are histograms plotting the distribution of ICERs for each pair of strategies. Select a pair of strategies from within the group to see the appropriate graph. This graph allows you to examine the effect of uncertainty on ICER. We recommend selecting a pair with the more expensive strategy vs. the less expensive strategy.
35.3.7 EVPI\EVPPI Summary Report and EVPI vs. WTP report

The EVPI\EVPPI Summary Report and EVPI vs. WTP report and discussed a separate section later in this chapter. Please follow this link to the section Cost-Effectiveness Value of Information.

35.4 CEA Outputs

35.4.1 Cost-Effectiveness Reports

CE simulations provides three cost-effectiveness graphs, accessible under CE Outputs grouping.

- **CE Graph**: Standard cost-effectiveness graph.
- **CE Rankings**: CE text report.
- **CE Graph (inverted)**: Same as above but with axes inverted.

The Monte Carlo simulation **CE Graph** is the same graph as is generated by the Analysis > Cost-Effectiveness menu command, except for the data source. In the simulation version, each strategy is plotted using the mean cost and effectiveness statistics from the simulation summary, rather than using the expected values directly from the model. The graph includes the standard CEA graph and report format.
CE PSA Output - CE Graph

See the previous two chapters in this manual for detailed descriptions of the cost-effectiveness graph and text report.

The CE Rankings Report option generates a ranked version of the CEA text report.

CE PSA Output - CE Rankings Report

### 35.4.2 Net Benefits vs. WTP

Net monetary benefits (NMB) calculations integrate a particular WTP value and will prompt you to provide a WTP value range. The Net Benefits vs. WTP graph, in both average and incremental formats, functions as a sensitivity analysis on WTP.

An intervention’s mean effectiveness and cost statistics for the simulation are the only other inputs for each calculation of that intervention’s net benefit.
Net Benefits vs. WTP

To graph incremental net benefit curves for any combination of two strategies, click on the appropriate Incremental (INMB) v. WTP link.

Incremental Net Benefits vs. WTP

Incremental net health benefit (INMB) is calculated as:

\[ INMB_{C-B} = NMB_C - NMB_B \]

where C refers to a comparator and B refers to the baseline. An alternative form of the equation, providing the same result, is:
Note that the incremental net benefits graph above shows that INMB is zero at about WTP = 15,500. This threshold is also reflected in the Net Benefits vs. WTP graph further above with the crossing of the two strategies' curves.

### 35.5 Histograms

Cost-effectiveness simulations generate many outputs, including cost and effectiveness for each strategy. For each of these outputs, you can generate a probability distribution histogram.

In cost-effectiveness simulations performed at decision nodes, distributions are available not only for each strategy's cost and effectiveness values, but for incremental values as well. Incremental distribution graphs compare one strategy to a baseline strategy.

The following Histograms are available:

- **Output Distributions:** This group generates probability distributions for outputs from the model. In this case, we are looking at Cost and Effectiveness as the outputs. But the distributions also provide the incrementals between Cost and Effectiveness and the NMB. The section below provides more details.

- **Tracker Distributions:** This group generates probability distributions for Trackers in the model. This would only be available for microsimulation models which use trackers.

- **Extra Payoff Distributions:** This group generates probability distributions for Extra Payoffs in the model. These are payoffs in addition to Cost and Effectiveness.

- **Sampling Distributions:** This group is a list of all the distributions which have been sampled in the model. Each link takes you to the samples associated with each iteration of the model.

**Output Distributions** are described in more detail in the following section, but the reports and options for the other distributions work in the same way.

#### 35.5.1 Output Distributions

For cost-effectiveness models, there are multiple views for **Output Distributions** charts.

- **Cost:** Cost Expected Values (EVs) for each strategy.
- **Incremental Cost:** Incremental cost between any two strategies.
- **Effect:** Effectiveness EVs for each strategy.
- **Incremental Eff:** Incremental effectiveness between any two strategies.
- **Net Monetary Benefits:** Net monetary benefits for each strategy for a specified WTP.

When cost or effectiveness is considered in isolation, each view functions like a single EV value for that strategy. Therefore, the **Cost** and **Effect** options generate output similar to the simple tree's EV output. The **Cost** option is shown below.
CE PSA Output - Output Distributions - Cost

However, incremental values are quite different. Each incremental histogram allows you to select one strategy as the comparator (first) and another as a baseline (second).

Strategy selections for Incremental Cost graph

For example, selecting the top link compares the Rx A strategy against the baseline of Rx B. Since Rx A is generally a more expensive strategy, the incremental cost will be positive.
In addition to reading about the other types of CE simulation graphs and reports below, you can read more about the issues surrounding uncertainty analysis and incremental CE ratios in one of the references given at the beginning of the Cost-Effectiveness Modeling and Analysis Chapter.

Histograms of the distribution of net monetary benefit values for a single option in a cost-effectiveness simulation are generated based on a single WTP value. Before generating a histogram, TreeAge Pro will prompt you to enter the WTP.

More details about customizing histograms can be found in the Customizing Histograms section.

### 35.6 Cost-effectiveness value of information (EVPI and EVPPI)

Using the results of a Monte Carlo simulation performed at a decision node, TreeAge Pro can calculate the expected value of perfect information (EVPI) or partial EVPI (EVPPI).

Information about EVPI or partial EVPI in non-cost-effectiveness models can be found in the section about performing Probabilistic Sensitivity Analysis.

The calculation of an EVPPI report is described below:

1. Determine the *overall optimal strategy*, using the Net Monetary Benefits based on the specific ICER threshold.
2. Determine the *optimal strategy for each sample iteration* in the simulation.
3. For each iteration, if the optimal strategy is not the overall optimal strategy, calculate its *incremental net benefits value* (i.e., iteration optimal minus overall optimal), which will be \( \geq 0 \).
4. Report the average (expected) value of perfect information over all iterations.

This process hypothetically eliminates the simulated uncertainties by suggesting that the parameters for each iteration are perfect. This process estimates the value of what is lost by making suboptimal decisions for some of the simulation iterations.

To generate an EVPI/EVPPI summary report:

- Run a CE PSA simulation at a decision node (as was done earlier in this chapter).
- Expand the PSA Outputs group to the right of the simulation summary data.
- Click on the EVPI/EVPPI Summary Report link.
- Enter the WTP value and the iteration range.

You will be presented with the following EVPI/EVPPI Summary report.
The EVPI/EVPPI reports use net monetary benefit calculations (NMB) using the WTP parameter specified when running the report. Each strategy’s mean cost and effectiveness values are used to determine the overall optimal strategy for that WTP (highest NMB). Then, separate calculations are done to determine the optimal strategy for each of the simulation’s iterations.

When the iteration’s optimal strategy is the same as the overall optimal strategy, its EVPI/EVPPI value is zero. However, when the iteration’s optimal strategy is different, then there is some value to eliminating the uncertainties being simulated. The EVPI (incremental NMB) is equal to the NMB value for the iteration’s optimal strategy, less the NMB value for the overall optimal strategy.

Note that the EVPI Details Report can be broken down into a series of data column groups. Each group reflects values for the optimal strategy for this iteration, the overall analysis optimal strategy, and the incremental value. The groupings start with the strategy itself (no incrementa), but then shows values for NMB, cost, effectiveness, etc.

The average, or expected value of information for all iterations, is reported in the summary report. In the example above, the expected additional cost from perfect information (per patient) is 57.21 and the expected increase in effectiveness is 0.163.

The description of these reports refers to EVPI and EVPPI.

- EVPI is calculated when running regular probabilistic sensitivity analysis with a single parameter sampling loop (and possibly also a microsimulation/trials loop).
- EVPPI is calculated when running two probabilistic sensitivity analysis parameter sampling loops. This allows you to isolate one or more distributions in the outer-most loop to isolate the effect of EVPPI for those specific parameter uncertainties.

You can also generate a graph to show EVPI across a range of WTP values.

**To generate an EVPI vs. WTP graph:**

- Run a CE PSA simulation at a decision node (as was done earlier in this chapter).
- Expand the PSA Outputs group to the right of the simulation summary data.
- Click on the EVPI v. WTP link.
- Enter a range of WTP, number of intervals and iteration range in the dialog, as in the figure below.
- You will be presented with an EVPI vs WTP graph as in the figure below.
The EVPI vs WTP graph shows the overall mean values generated by the EVPI value calculated for each iteration in the simulation, for the given WTP. The Text Report generated from the link on the right of the graph provides the specific EVPPI, Cost and Effectivness values for each value of the WTP as shown on the graph.
36. Building and Analyzing Markov Models

This chapter covers the basics of creating and analyzing Markov processes with TreeAge Pro Healthcare and TreeAge Pro Suite. Some basic conceptual background is provided.

The Markov Modeling Tools and Techniques Chapter covers a variety of important Markov topics including: time-dependent probabilities, discounting, half-cycle correction, tunnel states, and Markov decision processes. Markov microsimulation is covered in detail in the Individual-Level Simulation and Markov Models Chapter.

36.1 Traditional versus Within-Cycle Correction Models

Real processes occur in continuous time, with transitions and other events occurring throughout an interval of time. However, a Markov process occurs as a discrete sequence of snapshots, which can lead to overcounting Markov rewards. With expected value analysis, there are two main types of expected value calculations supported in TreeAge Pro: Traditional and Within-Cycle Correction.

Traditional Markov models accumulate the full cycle’s state reward at the beginning of each cycles with transitions understood to occur at the end of each cycle, even though some portion of the cohort will leave the state during the cycle. Expected values will therefore overestimate life expectancy by about half of a cycle (0.5 years in a one-year cycle length model). Half-Cycle Correction can be used with these models to "correct" for the over estimation.

Within-Cycle Correction models correct the over estimation by applying cycle rewards based on the cohort percentage in that state at both the start and the end of the cycle. Half-Cycle correction cannot be applied to these models.

Most model elements are the same for both types of Markov models; however, this chapter will highlight differences in the approprate sections.

Three models will be used throughout this Chapter. The Health Care tutorial example trees are:

Markov 3 State - Traditional.trex: This model uses traditional entry and accumulation of rewards. This model is used with and without half-cycle correction.

Markov 3 State - Traditional HCC.trex: The Traditional model with half-cycle correction applied.

Markov 3 State - WCC.trex: This model uses Within-Cycle Correction (WCC) for entry and accumulation of rewards.

36.2 Markov modeling basics

While most decision trees include a simple notion of time (i.e., left to right chronologically), there are no shortcuts in a standard tree structure for representing events that recur over time. A state transition
model, also called a Markov model, is designed to do just this. Markov models are used to simulate both short-term processes (e.g., development of a tumor) and long-term processes (e.g., an individual’s lifespan).

### 36.2.1 State transition models

Markov models built in TreeAge Pro often represent discrete-time state transition models (although discrete event modeling is also possible). A discrete-time Markov model usually follows a basic design, such that:

- The time period of interest (i.e., 10 years) is divided into equal intervals, or cycles.
- A finite set of mutually exclusive states is defined such that, in any given cycle, a member of the cohort is in only one state.
- Initial probabilities determine the distribution of cohort members among the possible states at the start of the process (often, the entire cohort starts in the same state).
- A matrix of transition probabilities, applied in each successive cycle, defines the possible changes in state.
- To calculate an expected value for the model, (e.g., net cost or quality-adjusted life expectancy), different cost and/or utility rewards/tolls are accumulated for each interval spent in a particular state.

#### Characteristics of a discrete-time Markov model

### 36.2.2 Graphical representation

In a state transition diagram (see below), each state is represented using an oval, arrows represent transitions, and numbers along the arrows indicate the transition probabilities. The probabilities of the transition arrows emanating from any state must sum to 1.0.
The Health Care tutorial example tree Markov 3 State - Traditional is presented below.

![Markov 3 State - Traditional from the tutorial examples](image)

Markov cycle trees can be appended to paths in a TreeAge Pro decision tree anywhere you might place a terminal node.

### 36.2.3 Calculation basics

There are two commonly-used methods for evaluating a Markov model: expected value calculation (called “cohort” analysis), and Monte Carlo simulation (first-order trials or microsimulation). It is important to understand the difference between the two analysis methods, and to recognize the terms associated with them.

In an expected value analysis, the percentage of a hypothetical cohort in a state during a cycle is multiplied by the cost or utility associated with that state. These products are summed over all states and all cycles. In TreeAge Pro, expected value calculations are the basis of most analyses, including n-way sensitivity analysis and baseline cost-effectiveness analysis.

On the other hand, in a microsimulation (a.k.a., discrete simulation), a single trial’s value is simply the sum of the rewards/tolls/payoffs for the path traversed by an “individual” taking a random walk through the model’s chance nodes (using a Monte Carlo pseudo-random number series). An expected value is estimated by averaging as many trials as possible.

In TreeAge Pro, the same Markov model can be evaluated by either expected value or simulation methods. Generally deterministic, expected value analysis is preferred because it is more computationally efficient; it returns a mean value much more quickly than simulation, which often requires thousands of trials to return a mean value within an acceptable error. However, some models will require simulation; refer to the Individual-Level Simulation and Markov Models Chapter.
Additional background discussion can be found in:


You are urged to consult a variety of publications dealing with the concepts which underlie Markov modeling and simulation.

### 36.2.4 Non-standard Markov models

In TreeAge Pro, the basic Markov modeling rules outlined above can be overruled in a variety of ways, for example:

- Time-dependent Markov models are easily handled using tables, tunnels, and/or tracker variables.
- Discrete event models can combine samplings from event time distributions and simulation features like tracker variables, parallel trials, and dynamic populations.
- A Markov model can be analyzed using the Node() function in such a way that sensitivity analysis and other cohort-type analyses can be used, while the Markov model is actually evaluated using microsimulation trials.
- EV/cohort analysis of a Markov model can make use of a dynamic cohort with a specific starting size and composition that may change over time.

**Exceptions to Markov modeling rules supported by TreeAge Pro**

These kinds of features are covered in the next few chapters.

### 36.3 Building a Markov cycle tree in TreeAge Pro

The design of a basic Markov model requires consideration of a number of components, most of which have been introduced above:

- **Health States** – The set of distinct health states which describe the current health status of a patient. The cohort is split amongst the health states at the beginning of each cycle.
- **Transition Subtrees** - The model structure to the right of each health state that define the events a patient could experience after starting a cycle in that health state. Dead (absorbing) states will have no transition subtree.
- **Cycle length** – The length of time represented by a single cycle (or stage) in a Markov model. This value is implicit in all probabilities, all rewards, and the termination condition.
- **Initial probabilities** – A set of probabilities describing the initial distribution of the cohort among the states. These are used only before the first cycle.
- **Transition probabilities** – The probabilities for all events in the transition subtrees including, but not limited to, transitions between states.
- **Rewards** – Per-cycle costs and/or utilities for each outcome measure being calculated (e.g., costs, QALYs). Rewards may be associated with health states or with events in the transition subtrees.
- **Termination condition** – A logical test evaluated at the beginning of each new cycle to determine if the process should continue or stop.

**Components of Markov models in TreeAge Pro**

These elements will be illustrated using the simple, Markov state transition model illustrated at the beginning of the chapter.

TreeAge Pro supports two primary types of Markov models - traditional and Within-Cycle Correction (WCC). Most elements are the same for each type; however, this chapter will highlight differences in the appropriate sections.

We will use three models throughout this Chapter to illustrate Markov models:

- **Markov 3 State - Traditional.trex**: This model uses traditional entry and accumulation of rewards. This model is used with and without half-cycle correction.
- **Markov 3 State - Traditional HCC.trex**: The Traditional model with half-cycle correction.
- **Markov 3 State - WCC.trex**: This model uses Within-Cycle Correction (WCC) for entry and accumulation of rewards.

### 36.3.1 The Markov node

To begin, a Markov node must be used. Any number of Markov nodes can be included in a decision tree. In this case, the root node of an empty tree will be changed to a Markov node.

**To create a Markov node:**

- Create a new tree by choosing File > New from the menu.
- Choose Blank Tree Diagram from the template dialog.
- Decline Configuring the model at this stage.
- Right-click on the root Decision Node and choose Change Type > Markov from the context menu.
- Type "Markov 3 State - Traditional " for a text description of the new Markov node.
Create a Markov node

Note that, in addition to using the purple Markov node symbol, TreeAge Pro also adds a Markov information box below the node; we will return to this later.

### 36.3.2 Health States

Each direct branch of the Markov node represents a health state, and should be labeled as such. For our simple three-state model, we need three health states.

**To add the Markov states:**
- Double-click on the Markov node twice to add three branches.
- Name the three new nodes *Disease, Well* and *Dead* from top to bottom.

Add Markov states

TreeAge Pro’s use of arcs, rather than straight lines, for the branches within a Markov subtree is simply to make it easier to distinguish Markov subtrees from the rest of a decision tree.

Below the Markov state branches, *initial state probabilities* must be entered to define the initial distribution of the cohort among the states before the first cycle. These probabilities must sum to one. It is often the case that many states will have initial probabilities of 0. In the three-state model, for example, 100% of the cohort begins in the *Disease* state.

**To enter the initial probabilities for the Markov states:**
- Below the branches of the *Disease, Well* and *Dead* states, enter the initial probabilities, 1, 0 and 0, respectively.
Initial state probabilities are used by TreeAge Pro only once during the Markov process, to determine where individuals should start the first cycle of the process. All subsequent movement through the model utilizes *transition probabilities*, which you will specify later.

### 36.3.3 State Rewards

In TreeAge Pro, costs or utilities assigned in a Markov model are called *rewards*. A *state reward* refers to a value that is accumulated by individuals because they spend one cycle in a particular state. This might be a cost or a unit of life expectancy.

Since a state reward is accumulated over a cycle, the reward value provided must be consistent with the cycle length. For instance, if you have decided on a yearly cost of $6000 for a particular state, but your cycle length is 1 month (not 1 year), then the state reward (cost) should be $6000/12, or $500 per cycle.

Assume that the goal is to estimate average life expectancy, and that the model’s cycle length is one year. To calculate life expectancy in terms of years, you would assign a state reward of 1 to any alive state. (If the cycle length were 1 month, a state reward equal to 1/12 would be used to calculate life expectancy in years.)

TreeAge Pro supports two configuration options for calculating Markov rewards - Traditional Markov Cohort and Within-Cycle Correction (WCC). Choose your preferred option in Tree Preferences.

**To choose Traditional Markov cohort or Within-Cycle Correction:**

- Open Tree Preferences.
- Select Calculation > Markov/DES and then select either Traditional Half-Cycle Correction or Within-Cycle Correction.

![Tree preferences for setting half-cycle or within-cycle correction.](image-url)
When you change between Traditional and WCC within Tree Preferences, TreeAge Pro will try to convert the reward values from one configuration to another. However, you will then need to review all state rewards to ensure the data is correct. See the section below 'Conversion between Within-Cycle Correction and Half-Cycle Correction'.

This section now considers both mechanisms. When building a model, the options available are to use the Traditional Markov method with or without half-cycle correction or to use a Markov Model with within-cycle correction.

### 36.3.3.1 Entering State Rewards - Traditional Markov Cohort

For life expectancy (or other) calculations, you must enter three separate state reward expressions at each Markov state. The reasons for having three separate state rewards — primarily for the half-cycle correction — will be explained in detail in the next chapter.

Traditional state rewards are used as follows:

- A state’s initial reward (Init Active Payoff) is assigned only in the first cycle, stage 0, and only to individuals that spend stage 0 in that state.
- The incremental reward (Incr Active Payoff) is assigned in all subsequent cycles during the process.
- The final reward (if any) is assigned after the process is over to individuals ending up in that state.

In this case, we want to assign a reward of 1 for each year/cycle someone spends in the Well state (via variable uWell) and 0.8 rewards for each year/cycle someone spends in the Disease state (via variable uDisease).

To define state rewards:

- Create and define the variables uDisease at the root node with a value of 0.8 and uWell at the root node with a value of 1.
- Select the Disease node.
- Choose Views > Markov Info from the menu. See the section about Markov Info View below for more details about using the Markov Info View.
- In the Markov Info view enter the Init Active Payoff, Incr Active Payoff and Final Active Payoff values uDisease, uDisease and 0, respectively.
- Now enter the state rewards for the other alive Markov state, Well, using the values uWell, uWell and 0, respectively.
- The zero rewards can be left unchanged in the Dead state.
- Save the partially complete tree.
Enter Markov state rewards in Markov 3 State - Traditional

The state rewards are also visible within a box under the Markov state node. This display can be turned on and off via the "Show Markov information" option in the Tree Preferences category Variables/Markov Info. To access the Markov Tree Preferences, use the little gear icon at the top of the Markov Info View.

Technically, assigning an initial reward in Well is unnecessary, because its initial probability is 0. However, it does not hurt to specify it as this gives you the flexibility of later changing the initial probability of Well, for instance, in a sensitivity analysis. Similarly, using variables for the rewards provides flexibility for later modifications.

You can also enter Markov rewards via the State Reward Dialog.

To open the State Reward Dialog:

- Select a reward in the Markov View.
- Click on the "pencil" icon in the view's toolbar.
State Reward Dialog

The State Reward Dialog allows you to enter the three state rewards for that state via internal formula editors. It also provides an option to perform half-cycle correction at the top-right corner of the dialog.

An assumption made in most discrete-time Markov models is that all state transitions occur simultaneously at the end of each cycle. In reality, however, most kinds of transitions typically occur gradually throughout a time interval (on average, half-way through). This assumption does not affect reported probabilities (or the survival curve), but it may result in overestimation of expected survival in most models.

Half-cycle correction (HCC) adjusts an uncorrected expected value calculation which overestimates state based rewards by about half of a cycle. The error without applying HCC will be greater if:

- The cycle length is long (e.g., annual).
- There is a significant difference between the rewards associated with the starting state for the cycle and the destination/jump state at the end of the cycle.

Assuming that transitions occur halfway through a cycle on average, the technically ideal correction is to assign a half-reward corresponding to the current state, and then a half-reward at every transition node (transition rewards are described in the next section) corresponding to the cost or utility associated with the jump-to state.

Most Traditional models, however, use a simpler adjustment called the half-cycle correction. To implement the half-cycle correction, you can simply divide every alive state’s incremental reward in half, and assign the half-reward as its initial and final reward.
In the Markov 3 State - Traditional model, this will result in a correction of about one-half of a cycle’s reward, or about 0.5 years; try the Markov cohort analysis after making this change which is implemented in the model Markov 3 State - Traditional HCC.trex.

The figure below shows how the State Reward Dialogue looks once HCC has been applied. The Markov Cohort reports will then just use the revised values in their calculations.

See the next chapter for information on how to use half-cycle correction.

### 36.3.3.2 Entering State Rewards - Within-Cycle Correction (WCC)

If the WCC method is selected from Tree Preferences, the rewards to set for WCC are:

- **Startup Rwd**: These rewards are accumulated at the state *once* at _stage 0_.
- **Cycle Rwd**: These rewards are accumulated at each state based on the cohort % in the state at the beginning and the end of the cycle. These rewards are accumulated at all stages. More details about calculations are provided below.
- **Event Rwd**: These are accumulated at any state or transition node as fixed values with no impact from WCC. These will be rare at state nodes, but common at transition nodes.

As for the instructions for the Markov 3 State - Traditional model above, we want to assign a reward of 1 for each year/cycle someone spends in the Well state (*uWell*) and 0.8 rewards for each year/cycle someone spends in the Disease state (*uDisease*).

*To define the rewards:*
- Create and define the variables \( u_{\text{Disease}} \) at the root node with a value of 0.8 and \( u_{\text{Well}} \) at the root node with a value of 1.
- Choose Views > Markov Info View from the Views menu.
- Select the Disease node and in the Markov Info View enter \( u_{\text{Disease}} \) into the Cycle Reward. Enter 0 into the Startup and Event rewards.
- Select the Well node and in the Markov Info View enter \( u_{\text{Well}} \) into the Cycle Reward. Enter into the Startup and Event rewards.
- The zero rewards can be left unchanged in the Dead State.
- Save the partially complete tree.

Enter Markov state rewards for Markov 3 State - WCC model

### 36.3.3.3 Conversion between Within-Cycle Correction and Half-Cycle Correction

Markov Models either use the Traditional or Within-Cycle Correction method. Once your model is built, it is possible to convert between the methods with a one-time conversion of your rewards.

**Traditional to Within-Cycle Correction conversion:**

- Open the Markov 3 State - Traditional model. (For your own models which you are converting, save them under a different name first).
- Open Tree Preferences and select the category Calculation > Markov/DES.
- Observe the current model is set for Traditional Half-Cycle Correction.
- Select Within-Cycle Correction and observe the dialogue warning about the conversion.
- Select 'Confirm' and review and edit the rewards via the Markov Info View, as required.
Building and Analyzing Markov Models

Tree preferences with the warning when changing from Traditional to Within-Cycle Correction

The conversion from *Traditional to Within-Cycle Correction* will do the following operations on the rewards:

- Incremental rewards from the Traditional model will be copied into the Cycle rewards of the WCC model.
- Initial and Final rewards will not be converted into the WCC model. They are remembered should you convert back to a Traditional Markov model, but they are not used in the WCC conversion (see Warning below).

*Within-Cycle Correction conversion to Traditional:*

- Open the Markov 3 State - WCC model. (For your own models which you are converting, save them under a different name first).
- Open Tree Preferences and select the category Calculation > Markov/DES.
- Observe the current model is set for Within-Cycle Correction.
- Select Traditional Half-Cycle Correction and observe the dialogue warning about the conversion.
- Select 'Confirm' and review and edit the rewards via the Markov Info View, as required.
The conversion from *Within-Cycle Correction to Traditional* will do the following operations on the rewards:

- Cycle rewards from the WCC model will be copied into the Init, Incr and Final rewards with Half-Cycle Correction applied in the Traditional model.
- The Start-up and Event rewards for WCC Health States will not be converted into the Traditional model. They are remembered should you convert the model back to WCC, but they are not used.

Converting a model into a different format will *only convert the Rewards once*. Let’s assume you convert from Traditional to WCC. With this conversion, the Incr and Final rewards are not used in the new WCC model. Then, if you converted the model back from WCC to Traditional, the model would remember the original Incr and Final rewards from the original Traditional model. The usual conversion algorithm would not work because the model would already have values assigned to Incr and Final from when the model was built. The same is true of models which start as WCC, with rewards for Startup, Cycle and Event.

### 36.3.4 Transition Subtrees and Absorbing States

The direct branches of the Markov node represent the possible health states. The branches (or subtree) emanating from a health state represent possible events that could occur during a cycle started in that health state. This includes but is not limited to transitions to other health states.

The easiest state to complete is *Dead*. This is a state from which an individual cannot exit, and it has no transition subtree; therefore, it is called an absorbing state. To represent an absorbing state, a Markov...
state is simply ended with a terminal node. Markov models are not required to have any absorbing states. In nearly all cases, absorbing states should only be used for death, possibly separate states for different causes of death.

To create an absorbing state:

- Right-click on the Dead node and choose Change Type > Terminal from the context menu.

Contrary to a Markov state transition diagram, the Markov cycle trees that you create in TreeAge Pro can represent a series of events that can occur during a single cycle. Any number of chance nodes, as well as logic and label nodes, can be used to the right of a Markov state.

In the example, the transition subtrees for the Disease and Well states each use two chance nodes (instead of one chance node with three branches). One chance node represents mortality (including excess mortality in the Disease state), and a second represents whether or not an individual gets/stays sick.

The transition subtrees are the same for both Traditional and WCC Markov models, but the assignment of rewards will vary.

To create a transition subtree:

- Double-click on the Disease node to add two chance nodes.
- Label the two new nodes survive and die.
- Create a variable for the transition probability \( p_{DiseaseToDead} \) equal to 0.1 on the Variable Properties View.
- Under the nodes survive and die, enter \# and \( p_{DiseaseToDead} \) respectively.
- Double-click on the new survive node to add two more branches.
- Label the two new nodes recover and stay sick.
- Create a variable for the transition probability \( p_{DiseaseToRecover} \) equal to 0.2 on the Variable Properties View.
- Under the nodes recover and stay sick, enter \( p_{DiseaseToRecover} \) and \# respectively.
- Double-click on the Well node to add two chance nodes.
- Label the two new nodes survive and die.
- Create a variable for the transition probability \( p_{\text{WellToDead}} \) equal to 0.02 on the Variable Properties View.
- Under the nodes \textit{survive} and \textit{die}, enter \# and \( p_{\text{WellToDead}} \) respectively.
- Double-click on the new \textit{survive} node to add two branches.
- Label the two new nodes \textit{no relapse} and \textit{relapse}.
- Create a variable for the transition probability \( p_{\text{WellToRelapse}} \) equal to 0.15 on the Variable Properties View.
- Under the nodes \textit{no relapse} and \textit{relapse}, enter \# and \( p_{\text{WellToRelapse}} \) respectively.

Create a transition subtree for Markov 3 State - Traditional model

The events in the transition subtrees for the Disease and Well states are nearly complete; however, the end nodes for each path in the transition subtrees must be terminated with jump states. These terminal nodes represent the last event in each path during a cycle, not the end of the Markov process. Individuals reaching a transition node are directed to a Markov state where they will begin the next cycle (if the process is not terminated first).

To terminate and nodes and add jump states:

- Right-click on the \textit{recover} node and choose Change Type > Terminal from the context menu.
- TreeAge Pro will automatically open the Edit Jump State dialog. In the dialog, select Well from the list of existing health states as the appropriate jump-to state for the recover node.
- Click OK to save the jump state and close the dialog.

To the right of each transition node’s symbol TreeAge Pro displays the name of the jump-to state for the next cycle.
Add jump states to Markov 3 State - Traditional model

If the wrong jump-to state has been assigned to a transition node, it is easy to change the specified transition.

To change a transition node’s jump-to state:
- Select the terminal node in the Markov transition subtree.
- Double-click on the jump state to reopen the Edit Jump State Dialog.
- Choose the correct jump state from the list.
- You can also change the jump state in the Markov Info View.

If you change the name of a Markov state, TreeAge Pro automatically updates the transition nodes pointing to it.

Now, set up the remaining jump nodes as seen below. Then save the model.
To add a reward associated with an event in a transition subtree, we use different rewards dependent on whether the model is Traditional or WCC. In this model we want to have a negative reward associated with the event of relapse, as explained below.

### 36.3.4.1 Entering Transition Rewards - Traditional Markov Cohort

In the Traditional Model, rewards associated with an event in a transition subtree are defined by transition rewards.

- In the Variable Properties View create and define the variable \( u_{\text{Relapse}} \) as \(-0.2\).
- Select the relapse node and open the Markov Info View.
- In the row labelled Trans Rwd enter the value \( u_{\text{Relapse}} \).
- Observe the box which has appeared below the relapse node indicating that a transition reward has been set.
36.3.4.2 Entering Transition Rewards - Within-Cycle Correction

In a Markov Model using WCC, rewards associated with an event in a transition subtree are defined by Event rewards. The event reward is most commonly used in a transition subtree at a specific event, but can also be used (and set) at a health state using the same method that we describe below.

- In the Variable Properties View define the variable \( u_{\text{Relapse}} \) as -0.2.
- Select the relapse node and open the Markov Info View.
- In the row labelled Event Rwd enter the value \( u_{\text{Relapse}} \).
- Observe the box which has appeared below the relapse node indicating that an event reward has been set.

![Event reward set in a transition subtree in Markov 3 State - WCC model](image)

36.3.5 The \_stage Counter and the Termination Condition

When analyzing a Markov model, TreeAge Pro uses the termination condition to determine whether a cohort analysis is complete. TreeAge Pro evaluates the termination condition at the beginning of each cycle. If the condition is true, the Markov process ends, final rewards are assigned if necessary, and the results are reported.

The termination condition is usually very simple. Often, it just checks how many cycles have been completed and stops when a certain number is reached. The number of cycles that have passed is contained in a built-in counter called \_stage, which TreeAge Pro sets equal to 0 before the first cycle.
and increments by 1 before each subsequent cycle (i.e., before assigning state rewards). For example, a termination condition of _stage=20 would run for 20 cycles (_stage 0 - 19, stopping before _stage 20).

The termination condition can be a more complex expression, referencing variables, distributions, other keywords, etc. For example, you might want to run until a variable age is over 75. In such a case, the following termination condition would be used: age > 75. The termination condition can also include multiple conditions, using the logical operators &, | and !, which represent AND, OR and NOT operators respectively. For example, if you wanted the model to run for 50 years or until the age is over 75, the following termination condition would be used: _stage = 50 | age > 75

TreeAge Pro allows you to set a default termination condition for all Markov nodes. Once set, you will have the option at each Markov node to change the default termination condition of one or all other Markov nodes.

To set the generic termination condition:
- Open the Tree Preferences > Calculation > Markov.
- Set the default termination condition as required for all Markov nodes.

We will set the termination condition at a specific Markov node in the Markov 3 State - Traditional model, using a simple termination condition.

To set the termination condition:
- Select the Markov node.
- Choose Views > Markov Info from the toolbar.
- In the Termination conditions > Term field within the Markov Node tab of the Markov Info View, enter the termination condition _stage = 50.
- Save the tree.
Enter termination condition in Markov 3 State - Traditional

When the termination condition is entered at a Markov node in the model, you will be prompted with the opportunity to change other termination conditions in the model (or only at this node) as well as the default termination condition for new Markov nodes. See the figure below.

Dialogue prompting changes to Markov termination condition, in some, all or no other nodes

In the Markov models built above, the termination condition \texttt{stage = 50} will cause the process to perform 50 cycles (#0 to #49), with an equal number of reward assignments and transitions.

See the next chapter for details on building and interpreting more complex termination conditions.
36.3.6 The Markov Info View

The Markov Info View changes depending on which node you have selected. We will use the Markov 3 State - Traditional model and the Markov 3 State - WCC model in this section to show the information on the Markov Info View.

If you are not on a node within a Markov Model, a message will appear telling you to select a node within a Markov Model.

36.3.6.1 Markov Info View at a Markov Node

If you are on Markov Node, the Markov Info View will have three tabs with the following labels:

- Markov Node
- Health States
- Transition Rewards (Traditional) or Event Rewards (WCC)
- PartSA (feature added in 2019 R2.0)

Above the four tabs is a link to take you to the Markov/DES Tree Preferences settings.

The figures below shows the information you can see when on the Markov Node on the four different tabs.

Markov Info View at a Markov Node - Markov Node Tab

Use the above tab to enter the model's Termination Condition.
Markov Info View at the Markov Node - Health State Tab (WCC)

Use the above tab to edit or review state rewards. Reviewing state rewards here provides the ability to view rewards for multiple states to ensure consistency. The toolbar also has a 'list' icon to let you select which Health States to show/hide.

Markov Info View at the Markov Node - Transition Rewards Tab

Use the tab above to edit or review event rewards. You can use the dropdown menu to list the transition/event rewards (listed as column headings) by either Health State or Jump State. Click the expand all toolbar icon to see transition rewards at every node in every transition subtree.

Markov Info View at the Markov Node - PartSA Tab

Use the tab above to associated Markov health states with a Survival Curve to generate Survival Curve Graphs as you would get from a PartSA model.

When at a Markov Node the tool bar for all the tabs have left and right yellow arrows. These give you the ability to move between different Markov Nodes in your model. The information displayed on the Markov Info View will then be relevant to the Markov Node currently highlighted.
36.3.6.2 Markov Info View at a Health State

If you are on a node which is a Health State within a Markov Model, details about the State Rewards for that node only will be shown.

36.3.6.3 Markov Info View at a Transition subtree

If you are on a node which is part of a Transition subtree within a Markov Model, details about the Transition/Event Rewards for that node only will be shown.

36.3.7 Generating Survival Curves from a Markov Model

Using the Markov Info View you can select which Health States to map to the Survival Curves in a PartSA model. This will allow the Markov Cohort reporting to generate appropriate Survival Curves. You might use these curves to validate the model's disease progression against observed data.

To generate PartSA Curves from Markov

- Select the Markov node and open the Markov Info View.
- Select the PartSA tab and select which of the health states in the model should be mapped to the Survival Curves. The default is PFS, OS and Dead.
- Use the pencil in the toolbar to add/delete Survival Curve names, as required.
- Now run Markov Cohort Analysis but selecting the Markov node, and then Analysis > Markov Cohort.
- The Markov Cohort report opens. Using the menu on the right hand side, select "Markov PartSA" to open the Survival Curves for the Markov Model.

![Image of the Markov Info View]

Use the pencil in the Markov Info - PartSA tab to edit the number of survival curves and their names.
Generate the Markov Cohort report and then select the "Markov PartSA" option

PartSA Survival Curves generated from the Markov Cohort model

### 36.4 Analyzing a Markov model

Once you have completed the Markov model, presumably you will want to analyze it. There are two mechanisms for evaluating a Markov model - Markov Cohort Analysis and Individual Patient Simulation. Markov Cohort Analysis is the preferred method and should be used unless the model requires Individual Patient Simulation. The remainder of this chapter focuses on Markov Cohort Analysis. For information on Individual Patient Simulation and when it should be used, please refer to the appropriate chapter.

Markov Cohort Analysis can be performed in several ways with TreeAge Pro, depending on the level of detail you wish to see. The options are Traditional or Within-Cycle Correction analysis. You can follow either of these options for the remainder of this chapter using these models: *Markov 3 State - Traditional.trex*, *Markov 3 State - Traditional HCC.trex* and *Markov 3 State - WCC.trex* from the Health care tutorial examples.
First, roll back the tree to verify that it is ready to calculate and get the overall expected value(s) for the model.

To roll back the tree:

- Choose Analysis > Roll Back from the menu.

If you have forgotten to perform one of the steps in the Markov modeling tutorial, an error may be reported identifying the problem and selecting the appropriate node. If there are no errors, TreeAge Pro will display the results of the cohort, expected value (EV) calculations on the face of the tree.

Next to the Markov node a roll back box should display an expected value of about 14.101 years (Traditional) or 13.729 years (Within-Cycle Correction). The EV is calculated as the total sum of rewards accumulated from all states and events and for all cycles. These EVs would be used for decision analysis if there were a decision node to the left of the Markov node. The detailed calculations generating these values will be explained and demonstrated in reports below.

The boxes next to the Markov states display the total rewards accumulated within that state, along with the final percentage of the cohort (FP) in that state when the process terminates. These numbers correspond to the last row of the cohort analysis text report, explained below.

Note that because Markov Cohort Analysis always applies rewards based on the percentage of the cohort that reaches that node in that cycle, the overall EV represents the average value accumulated by a person sent through the Markov model.

If roll back is still on, turn it off before continuing with another analysis.

To turn off roll back:

- Choose Analysis > Roll Back from the menu.

There are several reports which can be generated from Analysis > Markov Cohort menu. Which reports you can run depends on whether your model uses Traditional or Within-Cycle Correction (WCC) cohort analysis.

- Traditional - Extended Report
- Traditional - Basic Report
- Traditional - Full (pre 2016)
- Traditional - Quick (pre 2016)
- WCC - Extended Report
- WCC - Basic Report

These reports show more details about the Markov Cohort Analysis, breaking down the overall accumulation of rewards by cycle and state. The reports are described in detail later in this chapter.
After the six sections describing the main reports listed above, there are additional sections describing secondary reports available from all the main reports.

In TreeAge Pro 2017 release 2.0, the software introduced cohort-like reports for Microsimulation models. Previously, the cohort reports were only available for Markov Cohort models. If your model is a microsimulation model and you want cohort-like reports either for the combined microsimulation-cohort or for individuals, see the Chapter Markov Microsimulation Time Reporting.

### 36.4.1 Traditional - Extended Report

For traditional Markov models, the Extended Report provides the most visibility into the internal calculations executed during Markov Cohort Analysis. This report provides a detailed text report showing the movement of the cohort through each state node and transition node as well the accumulation of rewards at each node. In addition, there is a list of secondary text and graphical outputs via the menu on the right hand side.

This section uses the *Markov 3 State - Traditional model* from the Health care tutorial examples to examine this report.

To perform a cohort expected value value analysis (extended):

- Select the Markov node.
- Choose Analysis > Markov Cohort > Extended Report. (In the Analyze perspective select the Markov Extended report icon).
Markov Cohort Analysis Output - extended (Markov 3 State - Traditional)

The Extended output report contains multiple groupings by row for different levels of the model. Each grouping can be expanded or collapsed individually at each row using the '+' icon. Additionally, expanding/collapsing all rows to just the state level rows can be done via the '+' in the State/Transition column heading.

- **Stage** - at the cycle level, you will see summary data row for the total accumulation of rewards within the cycle from all states and transitions.
- **State** - at each health state, you will see the percentage of the cohort starting the cycle in that state along with the rewards accumulated at the state node.
- **Transitions** - at each node within the transition subtree, you will see the percentage of the cohort that reached that event along with the rewards accumulated at that node.

Because so much of the information is presented in a row associated with a specific node, there are fewer columns of data to present. Each row starts with a node type, indicating the type of node the state/transition relates to in the model.

The first three columns show the movement of the cohort through the states and transitions.

- **State/Transition**: The Markov state or event node within the transition subtree. Note the groupings for the whole state and at each subsequent node generation within the subtree.
- **Stage**: The stage (cycle) counter starting with zero.
- **Cohort %**: The percentage of the cohort passing through that node during that cycle. For a state, it is the percentage of the cohort starting the cycle in that state. For an event, it is the percentage of the cohort that hits that event node during that cycle.

The next columns in the report will refer to specific reward sets. A separate column grouping will be presented with different shading for each calculated reward set.

- **Rwd Entry**: The calculated value of the reward expression entered at that node, whether it is a state (state reward) or a transition (transition reward). This will allow you to check the calculations of your reward entry formulas without the cohort percentage yet applied. In this model, the calculated value of the rewards are just simple references to parameter variables. Those variable definitions are calculated.
- **Rwd**: The accumulated reward value based on the reward entry described above multiplied by the percentage of the cohort that passed through that node. This is the amount that is actually accumulated at that node in that cycle. In the Summary row, the Rwd value is the total reward accumulated by all nodes for that cycle.
- **Cum Rwd**: The cumulative reward for all cycles from _stage 0 through this stage.

All the output reports have the following features:

- Rows related to state/transition, stage and cohort % are frozen at the left as you scroll to the right.
- Column headings are frozen at the top as you scroll down.
- Color shading highlights the row groupings by cycle and the column groupings by payoff sets. This example has one payoff set, but typically Cost-Effectiveness examples have two or more payoff sets.

For each stage, all the transitions in all subtrees can be expanded or collapsed using the '+' and '-' buttons. This allows you to check the movement of the cohort through each transition in the analysis.

The Markov Cohort Analysis output provides details on the movement of the cohort among the health states and the corresponding accumulation of rewards. Let's look at a few of the calculations.

At the beginning of Stage 0, 100% of the cohort is in the Disease state, so the state probability is 1. The state reward entered for the Disease state is $u_{Disease}$, which is defined as 0.8. Therefore the reward value for Stage 0, State Disease, is 0.8, as seen below:

- $< Rwd > = < Cohort % > * < Rwd entry > = 1 * 0.8 = 0.8$

The overall stage reward, the cumulative reward, for Stage 0 is equal to the sum of state and transition rewards for the stage. For Stage 0, the cumulative reward is 0.8.

At the beginning of Stage 1, we start to see the cohort split among all the states.

For Stage 1, state Disease:
- \( <\text{Rwd}> = <\text{Cohort}> \times <\text{Rwd entry}> = 0.72 \times 0.8 = 0.576 \)

For Stage 1, state \textit{Well}:

- \( <\text{Rwd}> = <\text{Cohort}> \times <\text{Rwd entry}> = 0.18 \times 1.0 = 0.18 \)

Within the Well state grouping, we also need to account for the transition reward for the proportion of the cohort who \textit{Relapse}:

- \( <\text{Rwd}> = <\text{Cohort}> \times <\text{Rwd entry}> = 0.026 \times (-0.2) = (-0.00529) \)

For Stage 1, state \textit{Dead}:

- \( <\text{Rwd}> = <\text{Cohort}> \times <\text{Rwd entry}> = 0.1 \times 0.0 = 0.0 \)

The total reward for Stage 1 is the sum of the state and transition rewards for the three states:

- \( <\text{Cum rwd}> = 0.576 + 0.18 + (-0.00529) = 0.75071 \)

The extended report helps us to understand how the cohort moves through the model, accumulating rewards as it passes through states and transitions. In the next section, the basic report shows a condensed version of the same information which is calculated in the same manner.

If we scroll to the bottom of the extended report, as in the figure below, we can see the Summary for the model. The Summary gives the Expected Values for the reward(s) for the whole model. In this case, the expected value is \textit{14.10076 years}. If this Markov Model was to the right of a decision node, then this would be this Expected Value which is used to compare strategies.

The Summary section also shows the contribution to the Expected Value from each of the Health and Transition States. The contribution from each state/transition to the overall expected value is: \textit{6.2049 years} from the Disease State, \textit{8.13503 years} from the Well State and \textit{-0.23917 years} from the Relapse event.
With time-dependance in Markov models, *discounting* is an important consideration. When global discounting is implemented, the Extended report for Traditional models changes to indicate which values are discounted.

With the Markov 3 State - Traditional model using a 3% Annual Discount rate, the Extended Markov report is generated, as below.

Markov Cohort Analysis Output - extended (Markov 3 State - Traditional) with discounting
The extended report with global discounting includes details before and after discounting as highlighted below:

- **Rwd Entry**: The calculated value of the reward expression entered at that node, whether it is a state (state reward) or a transition (transition reward). No discounting is applied to this column so you can still check the calculations of your reward entry formulas without discounting and without the cohort percentage applied.

- **Rwd Entry Disc**: The discounted value of the reward in the Rwd Entry column, based on time into the future (_stage). For example, the Well state has reward value of 1, which is not discounted in _stage 0, discounted to 0.97087 in _stage 1, discounted to 0.9426 in _stage 2, etc.

- **Rwd Disc**: The total reward accumulated for either the state or transition based on the Cohort % multiplied by the discounted reward.

All subsequent data is reported using the discounted values.

### 36.4.2 Traditional - Basic Report

The Basic Report for Traditional Markov models uses the same Markov Cohort Analysis data as the Extended Report, but presents a more condensed report.

This section uses the *Markov 3 State - Traditional model* from the Health care tutorial examples to examine this report.

*To perform a cohort expected value analysis (basic):*

- Select the Markov node.
- Choose Analysis > Markov Cohort > Basic Report. (In the Analyze perspective select the Markov Basic report icon).

After the cohort analysis terminates, the Markov Cohort Analysis output is displayed.
Markov Cohort Analysis Output - Basic (Markov 3 State - Traditional)

The Basic output report contains groupings by row for different levels of the model.

- **State** - at each health state, you will see the percentage of the cohort starting the cycle in that state along with the sum of the rewards accumulated at the state node and the rewards accumulated at every transition node to the right of that health state.
- **Stage** - at the cycle level, you will see summary data for the total accumulation of rewards within the cycle from all states and transitions.

Since the Basic Report does not include separate rows for transitions, the rewards from the transitions to the right of the state node are summarized in a separate column.

The state-level columns are:

- **Rwd state cohort**: The accumulated rewards at the state node, which is the calculated value of the reward entry expression multiplied by the percentage of the cohort starting the cycle in that state.
- **Rwd transition cohort**: The accumulated rewards at every transition to the right of the state node, which is the sum of the calculated value of the reward entry expression at each transition node multiplied by the percentage of the cohort that passes through that event in the cycle.

The stage-level columns are:

- **Stage reward**: The reward accumulated for all nodes (states and events) within that stage.
- **Cum reward**: The cumulative reward for all cycles from _stage 0 through this stage.
It is often sufficient to use the Basic Report for reviewing Markov Cohort Analysis output, but additional details and transparency is available in the Extended Report.

With time-dependance in Markov models, *discounting* is an important consideration. When global discounting is implemented, the Basic report for Traditional models changes to indicate which values are discounted.

With the Markov 3 State - Traditional model using a 3% Annual Discount rate, the Basic Markov report is generated, as below.

The basic report with global discounting includes details only after discounting as highlighted below:

- *Rwd state cohort disc*: The accumulated rewards at the state node, which is the calculated value of the discounted reward entry expression multiplied by the percentage of the cohort starting the cycle in that state.

- *Rwd transition cohort disc*: The accumulated rewards at every transition to the right of the state node, which is the sum of the calculated value of the discounted reward entry expression at each transition node multiplied by the percentage of the cohort that passes through that event in the cycle.

The calculations for Stage and Cum rewards are then the same as in the Basic Report, using the discounted values in their place.
36.4.3 Traditional - Quick Report (Legacy, pre-2016)

This report is equivalent to the Basic Report detailed in the previous sections, but includes fewer details. We recommend using the Analysis > Markov Cohort > Basic option, which is an improved version of this report. This quick report is not available for models using within-cycle correction.

To perform a cohort analysis (quick):

- Select the Markov node.
- Choose Analysis > Markov Cohort > Markov Cohort (Quick).

After the cohort analysis terminates, the Markov Cohort Analysis output is displayed.

Markov Cohort Analysis Output - Quick (Markov 3 State - Traditional)

The output shows the accumulation of rewards by stage and state. The stage-level columns are:

- **Stage**: the _stage (cycle) counter starting with zero.
- **Stage reward**: the reward amount accumulated within that stage.
- **Cumulative reward**: the reward amount accumulated from the first stage through this stage.

The output also includes collapsible stage groupings that show state-level data within the stage. The stage-level columns are:

- **State**: The Markov state.
- **Probability**: The percentage of the cohort starting the stage in that state.
- **State reward**: The reward accumulated in that stage and that state.

The sum of the state rewards will be equal to the total stage reward for the cycle.

Markov Cohort Analysis accumulates state rewards by stage and by state as follows...
- For each stage/state, the state reward is the product of the state probability (the portion of the cohort starting the cycle in that state) and the state reward value from the tree (initial for the first cycle, incremental for subsequent cycles).
- The stage reward is the sum of the state rewards for each state.
- The overall expected value for the Markov model is the sum of all the stage rewards.

State reward calculation

The Analysis details are the same for the Extended Report for the Traditional Model, as in the sections above.

When collapsed, the Markov Cohort output shows only the accumulation of rewards by stage. Note that there is a line for Stage 50, even though the analysis is terminated before starting that state. The rewards for that stage would be non-zero if we had entered final rewards for any of the states. The cumulative reward at the final state gives the Expected Value for the model.

With time-dependence in Markov models, discounting is an important consideration. When discounting is implemented, the Quick report for Traditional models does not change because the discounted values are already included in the report values. Using the Basic and Extended Reports give you additional transparency into the calculations when discounting is applied.

**36.4.4 Traditional - Full Report (Legacy, pre-2016)**

This report is equivalent to the extended report detailed in the previous sections, but includes less information. We recommend using the Analysis > Markov Cohort > Extended option. This full report is not available for models using within-cycle correction.

If you run the Full cohort expected value analysis, the Markov Cohort Analysis output provides more detail than the Quick Report.
To perform a cohort expected value analysis (full):

- Select the Markov node.
- Choose Analysis > Markov Cohort > Markov Cohort (Full).
- Enter options for generating the cohort analysis output in the Markov Cohort (Full) dialog (see below) and click OK.

**Markov Cohort (Full) Dialog**

The options above allow you to customize the output. The options are described below.

- **Report probabilities as**: Determine whether events are displayed using decimal probabilities or as numbers representing probabilities multiplied by an arbitrary cohort size. Rewards are also multiplied by the cohort size.
- **Event subtrees**: Used to summarize probability information. The display of events and their probabilities in the expanded report can be simplified in many models by specifying that similar or cloned events be aggregated (“collapsed”), both within a single state and even across states.
- **Rewards**: Determine which columns of per-cycle and cumulative reward information are reported to the right of the transition information.
- **Stages to include**: Specify which stages to include in the output.

**Markov Cohort (Full) Output Options**

The expanded (as opposed to collapsed) output from the "Full" analysis allows you to see the accumulation of rewards in more detail. Specifically, you can see individual transitions within a stage that are not shown in the "Quick" analysis output.
Markov Cohort Output - Full (Markov 3 State - Traditional)

Note that for each stage, all the transitions in all subtrees can be expanded or collapsed. This allows you to check the movement of the cohort through each transition in the analysis. For example, of the 0.9 portion of the cohort that survives, you can see that 0.18 (20%) recovers and 0.72 (80%) stays sick.

With time-dependance in Markov models, discounting is an important consideration. When discounting is implemented, the Full report for Traditional models does not change because the discounted values are already included in the report values. Using the Basic and Extended Reports give you additional transparency into the calculations when discounting is applied.

36.4.5 WCC - Extended Report

Within Cycle Correction (WCC) uses a slightly different algorithm for Markov Cohort Analysis with respect to accumulating values with time during a Markov cycle.

- In Traditional models, state rewards are applied for an entire cycle based on the cohort percentage in that state at the start of the cycle.
- In WCC models, cycle rewards are applied for a cycle based on the cohort percentage in that state at both the start and the end of the cycle.

This report and the WCC - Basic Report use the WCC algorithm. This section uses the Markov 3 State - WCC.trex model from the Health care tutorial examples.

To generate the Extended Report for a WCC model:

- Select the Markov node.
Choose Analysis > Markov Cohort > Extended Report. (In the Analyze perspective select the Markov Basic report icon).

The Extended output report contains multiple groupings by row for different levels of the model.

- **Stage** - at the cycle level, you will see summary data for the total accumulation of rewards within the cycle from all states and transitions.

- **State** - at each health state, you will see the percentage of the cohort starting the cycle in that state along with the rewards accumulated at the state node.

- **Transitions** - at each node within the transition subtree, you will see the percentage of the cohort that reached that event along with the rewards accumulated at that node.

Because so much of the information is presented in a row associated with a specific node, there are fewer columns of data to present.

The first three columns show the movement of the cohort through the states and transitions.

- **State/Transition**: The Markov state node or the event node within the transition subtree. Note the groupings for the whole state and at each subsequent node generation within the subtree.

- **Stage**: The \_stage (cycle) counter starting with zero.
- **Cohort %**: The percentage of the cohort passing through that node during that cycle. For a state, it is the percentage of the cohort starting the cycle in that state. For an event, it is the percentage of the cohort that hits that event node during that cycle.

The next columns in the report will refer to specific reward sets. A separate column grouping will be presented with different shading for each calculated reward set. The WCC report includes extra columns columns to present the WCC calculation algorithm.

The stage-level columns (Stage Rwd and Cum Rwd) are the same as for the Traditional Markov Model. The remaining columns, which are different for the WCC Markov Model, show collapsible stage groupings of state-level data within the stage. The node-level columns are described below:

- **Rwd Cycle Entry**: The calculated value of the cycle reward expression entered at that node. This will allow you to check the calculations of your reward entry formulas without the cohort percentage yet applied. In this model, there are just simple references to parameter variables. Those variable definitions are calculated.
- **Rwd Cycle Cohort before WCC**: The pre-WCC cycle reward value based on the Rwd Cycle Entry described above multiplied by the percentage of the cohort that passed through that node. This value is not accumulated itself, but it is used by WCC to determine the accumulated cycle reward for the cycle.
- **Rwd Cycle Cohort after WCC**: The accumulated value for the cycle reward reflecting the WCC calculation algorithm. This amount is calculated as the average of the cohort cycle rewards calculated at the beginning of the cycle and the end of the cycle. In the Summary row, this column contains the total cycle rewards accumulated by all states for that stage.
- **Rwd Startup Cohort**: The value of the Startup Rwd for that state or for the entire cycle. Note that startup rewards are only accumulated in the first cycle (stage = 0). The cohort % is already applied to this column.
- **Rwd Event Entry**: The calculated value of the event reward expression entered at that node before the cohort % is applied. Event entries are more likely to be used at events in the transition subtrees, but they can be applied at states as well.
- **Rwd Event Cohort**: The accumulated event reward value based on the Rwd Event Entry described above multiplied by the percentage of the cohort starting the cycle in that state.
- **Stage Rwd**: The total rewards accumulated for the entire cycle, including cycle, startup and event rewards.
- **Cum Rwd**: The cumulative stage rewards for all cycles from stage 0 through this stage.

All the output reports have the following features:

- Rows related to stage, state and cohort % are frozen at the left as you scroll to the right.
- Column headings are frozen at the top as you scroll down.
- Color shading highlights the row groupings by cycle and the column groupings by payoff sets. This example has one payoff set, but typically Cost-Effectiveness examples have two or more payoff sets.

For each stage, all the transitions in all subtrees can be expanded or collapsed using the '+' and '-' buttons. This allows you to check the movement of the cohort through each transition in the analysis.

The Markov Cohort Analysis output provides details on the movement of the cohort among the health states and the corresponding accumulation of rewards, which is different for WCC relative to. Let's look at a few of the calculations.

- **Cohort %**:
  - At the beginning of _stage 0_, the Disease state has 100% of the cohort.
  - At the end of the _stage 0_, the Disease state as 72% of the cohort.

  - The **Rwd Cycle Entry** calculates the value of $u_{Disease}$ and returns the value 0.8.
  - The **Rwd Cycle Cohort before WCC** column shows how the reward entry would be applied to the cohort % in a Traditional model, which is another step toward calculating the WCC cycle rewards. Consider the **Rwd Cycle Cohort** column for the **Disease state**:
    - At _stage 0_: $< Rwd cycle cohort before WCC > = < Cohort % > * <Rwd cycle entry> = 0.8 \times 1.0 = 0.8$
    - At _stage 1_: $< Rwd cycle cohort before WCC > = < Cohort % > * <Rwd cycle entry> = 0.8 \times 0.72 = 0.576$

  - The **Rwd Cycle Cohort after WCC** calculates the WCC reward based on trapezoidal rule with 50% weighting of the pre-WCC values for the beginning and end of the cycle. For the **Disease state** at _stage 0_:
    - $< Rwd cycle cohort after WCC > = < Rwd cycle cohort before WCC > (at _stage 0) \times 50\% + < Rwd cycle cohort before WCC > (at _stage 1) \times 50\% = 0.8 \times 0.5 + 0.576 \times 0.5 = 0.688$

  - The **Rwd Cycle Entry** calculates the value of $u_{Healthy}$ and returns the value of 1.0.
  - The **Rwd Cycle Cohort before WCC** column again shows how the reward entry would be applied to the cohort % in a Traditional model, prior to applying WCC. Consider the **Rwd Cycle Cohort** column for the **Well state**:
    - At _stage 0_: $< Rwd cycle cohort before WCC > = < Cohort % > * <Rwd cycle entry> = 1.0 \times 0.0 = 0.0$
    - At _stage 1_: $< Rwd cycle cohort before WCC > = < Cohort % > * <Rwd cycle entry> = 1.0 \times 0.18 = 0.18$

  - The **Rwd Cycle Cohort after WCC** calculates the WCC reward based on trapezoidal rule with 50% weighting of the pre-WCC values for the beginning and end of the cycle. For the **Well state** at _stage 0_:
- \(<Rwd \text{ cycle cohort after WCC}> = <Rwd \text{ cycle cohort before WCC}> \text{ (at _stage 0)} * 50% + <Rwd \text{ cycle cohort before WCC}> \text{ (at _stage 1)} * 50% = 0 \times 0.5 + 0.18 \times 0.5 = 0.09 \)

- The \textit{Rwd Cycle Cohort after WCC} Summary for a given cycle is the aggregated value for all states for a given stage.

- For example, for cycle _stage 0 the value is: \(0.688 + 0.09 + 0 = 0.778\)

- In this example, there is also an event reward at the event \textit{Relapse}. The \textit{Rwd Event Entry} calculates the value \textit{uRelapse} and returns the value \(-0.2\).

- The \textit{Rwd Event Cohort} is calculated based on the Cohort % and the Rwd Event Entry. Since this is an event reward, WCC does not apply. Within the grouping for the \textit{Well} state transition subtree, the event reward associated with the \textit{Relapse} event is calculated as follows:

- \(<Rwd \text{ event cohort}> = <\text{Cohort } \%> * <\text{Rwd Event Entry}> = 0.025 * (-0.2) = -0.00529\)

- The \textit{Stage Rwd} for the entire cycle is the sum of the \textit{Rwd Cycle Cohort after WCC} and the \textit{Rwd Event Cohort} (also the Startup Reward for _stage 0 only). At cycle _stage 1:

- \(<\text{Stage rwd}> = <\text{Rwd cycle cohort after WCC}> + <\text{Rwd event cohort}> = 0.73571 - 0.00529 = 0.73042\)

- The \textit{Cum Rwd} is the total of \textit{Stage Rwd} for all cycles up to the current cycle. For cycle _stage1:

- \(<\text{Cum rwd}> = 0.778 + 0.73042 = 1.50842\)

- Note that rewards associated with a transition are captured in the stage they occur in, as demonstrated by the Stage Rwd at _stage 1 for the Relapse.

If we scroll to the bottom of the extended report, as in the figure below, we can see the Summary for the model. The Summary gives the Expected Values for the reward(s) for the whole model. In this case, the expected value is \textit{13.72919 years}. If this Markov Model was to the right of a decision node, then this would be this Expected Value which is used to compare strategies.
Markov Cohort Analysis Output - extended (Markov 3 State - WCC) - scroll to the bottom for the summary.

The Summary section also shows the contribution to the Expected Value from each of the Health and Transition States. The contribution from each state/transition to the overall expected value is shown below.

- Disease state: 5.81455 QALYs
- Well state: 8.15381 QALYs
- Relapse event: -0.23917 QALYs
- Total: 13.72919 QALYs

The extended report helps us to understand how the cohort moves through the model, accumulating rewards as it passes through states and transitions. In the next section, the basic report shows a condensed version of the same information which is calculated in the same manner.

With time-dependance in Markov models, discounting is an important consideration. When global discounting is implemented, the Extended report for WCC models changes to indicate which values are discounted.

Turn on global discounting and use the discount rate of 3%. Then select the Markov node and generate the Extended Report from the toolbar or Analysis menu as below.
Markov Cohort Analysis Output - extended (Markov 3 State - WCC) with discounting

The extended report with global discounting includes details before and after discounting as highlighted below:

- **Rwd Cycle Entry**: The calculated value of the state reward expression entered at that node, whether it is a state (state reward) or a transition (transition reward). No discounting is applied to this column so you can still check the calculations of your reward entry formulas without discounting and without the cohort percentage applied.

- **Rwd Cycle Entry Disc**: The discounted value of the reward in the Rwd Cycle Entry column, based on time into the future (_stage)_.

- **Rwd Cycle Cohort Disc before WCC**: The value of the state reward accumulated based on the discounted reward entered multiplied by the percentage of the cohort that passed through that node. This is a value used to calculate the WCC reward at that node in that cycle.

- **Rwd Cycle Cohort Disc after WCC**: The calculated value for the state and stage based on the using the discounted rewards in the WCC method. In the Summary row, the value is the total rewards accumulated by all states for that stage. It does not include startup and event rewards.

- **Rwd Event Entry**: The calculated value of the startup and event reward expressions entered at that node, whether it is a state (state reward) or a transition (transition reward). No discounting is applied to this column so you can still check the calculations of your reward entry formulas without discounting and without the cohort percentage applied.

- **Rwd Event Entry Disc**: The discounted value of the reward in the Rwd Event Entry column, based on time into the future (_stage)_.
- **Rwd Event Cohort Disc**: The value of the reward accumulated based on the discounted reward associated with the event multiplied by the percentage of the cohort that passed through that node.

The calculations are then the same as in the Extended Report, using the discounted values in there place.

### 36.4.6 WCC - Basic Report

If you run the basic cohort expected value analysis, the Markov Cohort Analysis output provides a condensed version of the extended report.

This section uses the Markov 3 State - WCC model from the Health care tutorial examples.

**To generate the Basic Report for a WCC model:**

- Select the Markov Node.
- Choose Analysis > Markov Cohort > Basic Report.

#### Markov Cohort Analysis Output - Basic (Markov 3 State - WCC)

The Basic Report presentation is different from the Extended Report due to its condensed format. Specifically, there are rows for stage and state, but not for transitions.

- **Stage** - at the cycle level, you will see summary data for the total accumulation of rewards within the cycle from all states and transitions.
- **State** - at each health state, you will see the percentage of the cohort starting the cycle in that state along with the rewards accumulated either at the state node or at any transition to the right of that state node.
Because so much information is presented in a row associated with the health state, more columns are needed to provide sufficient details in this report.

The first three columns show the movement of the cohort through the states.

- **Stage** The _stage (cycle) counter starting with zero.
- **State** The Markov state node.
- **Cohort %** The percentage of the cohort starting the cycle in that state.

The next columns in the report will refer to specific reward sets. A separate column grouping will be presented with different shading for each calculated reward set. The WCC report includes extra columns to present the WCC calculation algorithm.

- **Rwd Cycle Cohort before WCC**: The pre-WCC cycle reward value based on the cycle reward expression entered at that node multiplied by the percentage of the cohort that started the cycle in that state. This value is not accumulated itself, but it is used by WCC to determine the accumulated cycle reward for the cycle.

- **Rwd Cycle Cohort after WCC**: The accumulated value for the cycle reward reflecting the WCC calculation algorithm. This amount is calculated as the average of the cohort cycle rewards calculated at the beginning of the cycle and the end of the cycle. In the Summary row, this column contains the total cycle rewards accumulated by all states for that stage.

- **Rwd Startup/Event Cohort**: This is the sum of the startup and event rewards for that state (which will often both be zero). Note that the Startup reward is only accumulated in _stage 0, while the event reward is accumulated in every cycle.

- **Rwd Transition Cohort**: The sum of all event rewards accumulated within that state’s transition subtree. Each individual event reward is calculated as the expression you enter at that node multiplied by the percentage of the cohort that passes through the node in that cycle.

For additional details on transitions, use the Extended Report described in the previous section. Both reports use the same WCC calculations.

With time-dependance in Markov models, *discounting* is an important consideration. When global discounting is implemented, the Basic report for WCC models changes to indicate which values are discounted.

With the Markov 3 State - WCC model using a 3% Annual Discount rate, the Basic Markov report is generated, as below.
The basic report with global discounting includes details only after discounting as highlighted below:

- **Rwd Cycle Cohort Disc before WCC**: The pre-WCC cycle reward value based on the discounted cycle reward expression entered at that node multiplied by the percentage of the cohort that started the cycle in that state. This value is not accumulated itself, but it is used by WCC to determine the accumulated cycle reward for the cycle.

- **Rwd Cycle Cohort Disc after WCC**: The accumulated value for the cycle reward reflecting the WCC calculation algorithm. This amount is calculated as the average of the cohort cycle rewards calculated at the beginning of the cycle and the end of the cycle. In the Summary row, this column contains the total cycle rewards accumulated by all states for that stage.

- **Rwd Startup/Event Cohort Disc**: This is the sum of the discounted startup and event rewards for that state (which will often both be zero). Note that the Startup reward is only accumulated in stage 0, while the event reward is accumulated in every cycle.

- **Rwd Transition Cohort Disc**: The sum of all discounted event rewards accumulated within that state’s transition subtree. Each individual event reward is calculated as the discounted expression you enter at that node multiplied by the percentage of the cohort that passes through the node in that cycle.

The calculations for Stage and Cum rewards are then the same as in the Basic Report, using the discounted values in their place.

### 36.4.7 Secondary - Markov Cohort Summary Report

The Markov Cohort Summary Report is a non-grouped grid format for its output. This better matches up with outputs generated from TreeAge Pro 2009 and earlier versions.
With no grouping and a standard grid format, this output is often better for exporting to Excel.

### 36.4.8 Secondary - Markov Cohort Graphical Output

You can also generate graphical data from the Markov Cohort Analysis output by clicking on the links to the right of the output data. Each option generates a graph tracking calculated values against time (stage). The options are described below:

- **State probabilities**: This graph plots the changing state probabilities at each cycle, and is closely related to the survival curve.
- **Survival curve**: Survival curves are a standard means of communicating the results of a Markov analysis. TreeAge Pro will prompt you to select which states represent death, and then will plot the sum of the “alive” state probabilities. This graph can also be used to create probability curves that group other kinds of states — to plot disease-free survival, for example.
- **State reward**: This graph shows, for each state, what reward was received at each stage. (For cost-effectiveness models, cost and effectiveness are plotted separately.)
- **Stage reward**: This graph shows the stage reward (sum of all state rewards) accumulated for each stage.
- **Cumulative reward**: This graph shows the cumulative stage reward as it increases with each stage.

### Markov Cohort Analysis graphical output options

The state probabilities graph shows the transition towards the Dead state as time passes.

---

<table>
<thead>
<tr>
<th>Stage</th>
<th>% - Disease</th>
<th>% - Well</th>
<th>% - Dead</th>
<th>Reward</th>
<th>Cumulative Reward</th>
<th>Rwd - Disease</th>
<th>Rwd - Well</th>
<th>Rwd - Dead</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.8</td>
<td>0.8</td>
<td>0.0</td>
<td>0</td>
<td>0.0</td>
</tr>
<tr>
<td>1</td>
<td>0.720</td>
<td>0.180</td>
<td>0.100</td>
<td>0.7284</td>
<td>1.5284</td>
<td>0.5592</td>
<td>0.17476</td>
<td>0.0</td>
</tr>
<tr>
<td>2</td>
<td>0.345</td>
<td>0.280</td>
<td>0.376</td>
<td>0.69661</td>
<td>2.19546</td>
<td>0.41007</td>
<td>0.26949</td>
<td>0.0</td>
</tr>
<tr>
<td>3</td>
<td>0.233</td>
<td>0.328</td>
<td>0.238</td>
<td>0.60124</td>
<td>2.89689</td>
<td>0.37379</td>
<td>0.26826</td>
<td>0.0</td>
</tr>
<tr>
<td>4</td>
<td>0.261</td>
<td>0.284</td>
<td>0.286</td>
<td>0.58127</td>
<td>3.46867</td>
<td>0.35617</td>
<td>0.24824</td>
<td>0.0</td>
</tr>
<tr>
<td>5</td>
<td>0.322</td>
<td>0.360</td>
<td>0.320</td>
<td>0.51611</td>
<td>3.88418</td>
<td>0.25596</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>6</td>
<td>0.277</td>
<td>0.376</td>
<td>0.367</td>
<td>0.47482</td>
<td>4.35899</td>
<td>0.18376</td>
<td>0.20791</td>
<td>0.0</td>
</tr>
<tr>
<td>7</td>
<td>0.252</td>
<td>0.448</td>
<td>0.402</td>
<td>0.49701</td>
<td>4.85661</td>
<td>0.16866</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>8</td>
<td>0.232</td>
<td>0.334</td>
<td>0.434</td>
<td>0.40232</td>
<td>5.25893</td>
<td>0.14967</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>9</td>
<td>0.216</td>
<td>0.320</td>
<td>0.404</td>
<td>0.37045</td>
<td>5.62938</td>
<td>0.1256</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>10</td>
<td>0.203</td>
<td>0.305</td>
<td>0.402</td>
<td>0.34113</td>
<td>5.96093</td>
<td>0.10067</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>11</td>
<td>0.191</td>
<td>0.291</td>
<td>0.518</td>
<td>0.21418</td>
<td>6.22411</td>
<td>0.11029</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>12</td>
<td>0.180</td>
<td>0.277</td>
<td>0.542</td>
<td>0.20596</td>
<td>6.53007</td>
<td>0.10108</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>13</td>
<td>0.170</td>
<td>0.263</td>
<td>0.567</td>
<td>0.20651</td>
<td>6.77658</td>
<td>0.09381</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>14</td>
<td>0.161</td>
<td>0.250</td>
<td>0.589</td>
<td>0.24546</td>
<td>7.02544</td>
<td>0.08531</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>15</td>
<td>0.153</td>
<td>0.237</td>
<td>0.600</td>
<td>0.22608</td>
<td>7.25152</td>
<td>0.07647</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>16</td>
<td>0.145</td>
<td>0.225</td>
<td>0.630</td>
<td>0.20283</td>
<td>7.45375</td>
<td>0.07222</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>17</td>
<td>0.137</td>
<td>0.213</td>
<td>0.649</td>
<td>0.19086</td>
<td>7.65155</td>
<td>0.06648</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
<tr>
<td>18</td>
<td>0.130</td>
<td>0.202</td>
<td>0.667</td>
<td>0.17666</td>
<td>7.8382</td>
<td>0.06111</td>
<td>0.20140</td>
<td>0.0</td>
</tr>
</tbody>
</table>
| 19    | 0.124       | 0.192    | 0.694    | 0.16271| 8.09081           | 0.05617      | 0.20140    | 0.0
36 Building and Analyzing Markov Models

36.5 A note on microsimulation

Roll back and cohort analysis both evaluate Markov models using cohort calculation methods. Another way to evaluate a Markov model is using Monte Carlo simulation. Microsimulations (a.k.a first-order trials, discrete simulation and individual-level simulation) use random number sequences to send one individual at a time on a single path through the model. This approach is used in some complex models to keep track of an individual’s history (beyond what state branch they are in).
Because individuals are randomized based on probabilities, each simulation of a model returns a different set of results, but the summary statistics converge on the true mean as more trials are run. The more complex a model is (e.g. more states, cycles, and small probability events), the more trials required to converge on the expected value.

For a 1-dimensional simulation, where microsimulation is the only loop, the report will include per-individual payoffs/rewards (e.g., life expectancy, cost, etc.) as well as final tracker variable values.

Refer to the Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis Chapter for general information on Monte Carlo simulation. Refer to the Individual-Level Simulation and Markov Models Chapter for more information on specific issues related to building microsimulation models.

### 36.6 Cost-effectiveness Markov models

Building a cost-effectiveness (CE) Markov model is quite similar to working with a regular CE decision tree (refer to the Building and Analyzing Cost-Effectiveness Models Chapter and the Cost-Effectiveness Modeling and Analysis Options Chapter). First, you must set the appropriate preference settings, including calculation method and numeric formatting.

Separate sets of rewards must be entered in the Markov model for the cost and effectiveness attributes. Just as each terminal node in a decision tree can use up to nine payoff expressions, each Markov subtree has nine corresponding reward sets. In CE calculations, reward set #1 might be used for costs and reward set #2 for effectiveness, but this is flexible. If you already have a single-attribute Markov model using payoff set #1 for effectiveness, simply set CE calculations to use payoff set #2 for costs. You also have the option of specifying in the CE preferences that multiple payoffs be combined for cost.

The model used to describe cost-effectiveness in Markov models in this section assumes the model uses half-cycle correction as opposed to within-cycle correction method. Refer to the Markov Analysis section for details about how the rewards change with the within-cycle correction method.

At each Markov state, the three reward types described earlier — initial, incremental and final — can be entered for each reward set.

**To assign cost and effectiveness state rewards:**

- Select a Markov state.
- Choose Views > Markov Info from the menu.
- In the Markov Info View, enter values or expressions for both cost and effectiveness state rewards.

In a cost-effectiveness tree, rewards are labeled to identify cost and effectiveness rewards in both the Markov Info View and the Tree Diagram Editor.
Cost-effectiveness rewards

Additionally, a CE Markov model requires that you enter a distinct termination condition for the Cost-Effectiveness calculation method. TreeAge Pro maintains separate termination conditions for each Simple, single-attribute calculation, and for Cost-Effectiveness.

To assign a cost-effectiveness termination condition:

- Select the Markov node.
- Choose Views > Markov Info from the menu.
- In the Markov Info View, enter the termination condition.

36.6.1 Cost-effectiveness keywords

There are several Markov keywords available only in a cost-effectiveness model. The keywords _stage_cost, _stage_eff, _total_cost, and _total_eff calculate the single-attribute values; _stage_reward and _total_reward calculate CE ratios, and are not often used in CE Markov models.
CE keywords

These keywords can be used in expressions within the Markov model. For example, you could create a termination condition \( _{\text{stage eff}} < 0.001 \) to stop the analysis when approximately 99.9% of the cohort is dead.

💡 Always change the termination condition to something appropriate for your model! In many models, no effectiveness threshold is needed and the termination condition will only reference the \( _{\text{stage}} \) keyword. If your effectiveness measure is a rare event counter, then either no effectiveness threshold or a lower one might be required.

36.6.2 A cost-effectiveness Markov model

The Health Care tutorial example tree “Treatment Options Markov” combines Markov and cost-effectiveness features. The model compares the cost-effectiveness of two hypothetical treatments using a similar disease model to that of the Three-State Markov process. The tree is shown below.
In this still relatively simple model, Treatment A is presumed to be faster acting, but cannot be used long term. Treatment B is slower acting, but can be used on a maintenance basis over a prolonged period, effectively preventing more relapses.

You can select one of the Markov nodes at a time and perform a Markov cohort analysis, or select the root, decision node and perform a cost-effectiveness analysis, which will yield the following graph.
37. Markov Modeling Tools and Techniques

This chapter covers a number of commonly-used features in Markov models, including using tables of probabilities and discounting rewards. It also covers a number of Markov modeling features that are infrequently used, but may be indispensable in some cases.

Discrete simulation/microsimulation is covered in the Individual-Level Simulation and Markov Models Chapter. Miscellaneous Markov topics are covered in the Markov Technical Details Chapter. Details about Markov models using Parallel Trials and Dynamic Cohorts can also be found in their respective chapters.

37.1 Keywords and time-dependence

TreeAge Pro provides several Markov keywords — built-in variables which are available only in a Markov node or its subtree. The first two listed are integer counters:

- _stage — the number of cycles that have passed (starts at 0 for first cycle)
- _tunnel — the number of cycles spent continuously in a tunnel state
- _stage_reward — the reward received by the cohort in the previous cycle (in Simple calculations)
- _stage_cost, _stage_eff — counterparts of _stage_reward in Cost-Effectiveness (CE) calculations
- _total_reward — the cumulative reward of all previous cycles; at the end of calculations, this is the overall value of the Markov process
- _total_cost, _total_eff — counterparts of _total_reward in CE calculations
- TreeAge Pro also includes a special function, StateProb( ), for accessing current state probabilities during analysis.

Markov Keywords

As illustrated in the previous chapter, in the tutorial on building the Three-State Markov model, the _stage counter is useful in defining the Markov termination condition. This section will describe other important functions of the _stage counter and other keywords.

Refer to the Markov Technical Details Chapter for information on how Markov models are evaluated via the calculation algorithm. This includes when and in what order Markov keyword values are modified, both during cohort analysis and Monte Carlo microsimulation (first-order trials).

37.1.1 Cycle zero

In TreeAge Pro Markov models, the first cycle is referred to as cycle 0 and the _stage counter is equal to 0 during this first cycle. For example, if a model’s cycle length is one year, cycle 0 represents the first year of the process; if this process started with an individual’s birth, cycle 0 would correspond to age 0 – i.e., the year prior to an individual’s first birthday.
The following events occur during the first cycle of a Markov process, while the keyword _stage is equal to 0:

- The cohort is distributed among the Markov states according to the initial probabilities entered under the branches (the only time these probabilities are used);
- Initial rewards are accumulated based on state membership;
- The members of a state traverse the transition subtree based on the transition probabilities, and the percentage of the cohort at a transition node are assigned the transition rewards in the path back to the state (before entering new states for the next cycle).

You should ensure that references to tables in initial and transition probability expressions, as well as initial state rewards and transition rewards, will work correctly when _stage = 0.

The incremental state reward expressions are not accumulated during cycle 0; only the initial rewards are evaluated. The initial probabilities determine which states are populated in cycle 0 and where initial state rewards are required. If half-cycle correction is not used, the initial state reward for a state is often the same as the incremental reward; see the section on half-cycle correction later in the chapter for more details.

### 37.1.2 Using tables of time-dependent transition probabilities – an example

The Three-State Markov model from the previous chapter is an example of a Markov chain — a Markov model in which all probabilities and other parameters remain constant over time. In the kinds of Markov models used to represent healthcare issues, however, probabilities and other values often vary over time. This kind of model is referred to sometimes as a Markov process.

In the TreeAge Pro Healthcare module, any expression in a Markov model (not just the termination condition) can reference tables of stage-dependent values using the _stage counter. Other kinds of time-dependent expressions can also be created using the _tunnel counter, tracker variables, etc.

This tutorial requires two things:

- A copy of the Three-State Markov model you created in the previous chapter. If you did not build the tree, you can open the Health Care tutorial example tree "Three-State Markov".
- A table file called "tMort" to hold time-varying probabilities. Follow the instructions below to create the table. If you have additional questions about working with tables, refer to the Creating and Using Tables Chapter.

To create a new table for use in a tree:

- Choose Views > Tables from the toolbar.
- Click the "add" toolbar button. This will open the Add/Change Table Dialog.
- Enter the table name tMort and select the "Use linear interpolation" option for missing rows.
- Click OK to save the table and close the dialog.
- Click the "add" button in the "Table Rows" section of the Tables View. Click seven more times to add a total of eight rows.
- Edit the data in each row to match the data presented below.

![Table Rows](image)

**tMort table**

Now, update the Three-State Markov model to use the new table of mortality probabilities.

*To look up a transition probability in a table:*

- First define the variable `startAge` at the root node and define it with the value 30.
- Select the `die` branch of the `Disease` state, and change its probability to the formula `tMort[startAge+_stage]`.

![Diagram](image)

**Transition probability from tMort table**

Now, in place of a fixed probability of death from other causes, TreeAge Pro will calculate the transition probability at every cycle using the table lookup `tMort[startAge+_stage]`. The first set of transitions in the Markov process, when `_stage = 0`, will use the value returned by the reference `tMort[30+0]`, which is 0.005.

Each subsequent cycle will use a higher mortality probability, because the values in the tMort table increase as the indexes increase. Also relevant in this case, when you reference a missing index, the table is currently set to interpolate between existing indexes. In the example, the missing value for cycle 1 when the table reference is `tMort[31]` will be calculated using linear interpolation between the table values for indexes 30 and 40. The interpolated probability will be 0.0052. Missing rows at subsequent cycles will be similarly calculated.

If you now roll back the tree, the Markov node should display an expected value of 34.818 – significantly higher than the roll back value calculated in the previous chapter because the early probabilities of
death in the table are lower than the original 0.01 probability of mortality. The updated tree is available with the name Three-State Markov-Time.trex for your review.

If you run a Markov cohort analysis in the new version of the tree, and compare the new state probabilities graph with the graph generated in the previous chapter, you will see that the cohort transitions to death considerably more slowly.

![State Probabilities Graph - death probability fixed](image1)

![State Probabilities Graph - death probability from table](image2)
37.2 Discounting Rewards

In addition to defining stage-dependent probabilities, tables can also describe stage-dependent rewards such as costs or utilities. However, if all you need to do is discount costs and utilities, a simple exponential formula may be used instead of a table. For example, the expression

\[ \frac{cost \cdot X}{(1 + rate)^{-stage}} \]

can be used to discount the reward value at each stage. If the cycle length is not equal to the period of the discount rate (usually 1 year), then \_stage should either be divided (for shorter cycle lengths) or multiplied (for long cycle lengths).

Discounting nearly always needs to be applied to an entire reward set, such as cost and/or effectiveness. TreeAge Pro has two options for discounting.

1. **Apply a single discount rate to an entire reward set:** Use the Tree Preferences to set a specified discount rate to be applied to any given reward set. We call this *Global Discounting*, and we recommend using this approach as it is the easiest to implement.

2. **Adjust each reward manually:** Use the Discount() function as described further below to manually change the value of each reward.

To **apply a single discount rate to the entire reward set**, enter the details in the Tree Preferences as described in the Payoff Preferences section. When the Global Discounting is applied to a reward set, the word "Discounted" appears after the reward name in the Markov Info View, as in the figure below.

![Global Discounting applied to both reward sets for Cost and Effectiveness](image)

The Healthcare tutorial example model Markov.Discounting.trex demonstrates global discounting in a Markov model along with use of the Discount functions for rewards. Note that analysis of the model using each discounting option yields the same results.

If you prefer to manually adjust each individual reward, rather than using TreeAge Pro's Global Discounting function, you can use TreeAge Pro's built-in discounting function, Discount(). This Discount() function represents the exponential formula above and takes three parameters: value, rate and time. For example, the expression

\[ \text{Discount}(cost \cdot X; rate; \_stage) \]
will yield the same result as the exponential formula shown above. The Discount() function is equally applicable to the discounting of costs and utilities.

Discount function in Markov state reward

TreeAge Pro’s built-in functions can be inserted into formulas either by typing them in yourself or by using the Formula Editor or auto-fill.

### 37.3 Probability/rate conversion functions

The following functions are used to convert between rates and probabilities (or odds).

They generally employ one or both of the arguments *rate* (or *prob*) and *time*. In each case, it is essential that the values for these parameters are based on the same scale. For example, if a rate being converted is in terms of years (such as yearly mortality), the time parameter must also be in years.

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| DEALE(rate; time)      | DEALE is an acronym for “declining exponential approximation of life expectancy.”  
                        | \((1 - e^{-rate \times time})/rate\)                                       |
|                        | DEALE() function is cumulative, so the time parameter means “over the course of this amount of time.” |
| OddsToProb(odds)       | Converts odds into a probability.                                            |
|                        | \(odds/(1 + odds)\)                                                         |
| ProbFactor(prob; fac)  | First converts the probability to odds, then multiplies it by the given factor, then converts it back to a probability. See OddsToProb and ProbToOdds. |
| ProbToOdds(prob)       | Converts a probability into odds.                                            |
|                        | \(prob/(1 - prob)\)                                                         |
| ProbToProb(prob; multiplier) | Converts a probability into a rate, multiplies the rate by the given multiplier, and converts back to a probability.  
                        | \(RateToProb((ProbToRate(prob; 1) \ast multiplier); 1)\)                     |
| ProbToRate(prob; time) | Converts a probability into a rate, and divides the rate by time.             |
|                        | \(-\ln(1 - prob)/time\)                                                    |
### Probability/rate Conversion Functions

These functions are sensitive to user errors; you are urged to exercise great care when using them in your models. It is recommended that you use the Calculator/Evaluator to test expressions using these functions.

RateToProb(), as the name suggests, is used to convert a rate into a probability, either for the same time period (in which case you use time=1) or a different time period. For example, if a disease being modeled has a yearly mortality rate of .05, you could convert this to a probability using the formula:

\[
\text{RateToProb}(0.05; 1)
\]

This converts the the *yearly mortality rate* to a *annual probability* of 0.04877 (rounded to 5 d.p.).

ProbToRate provides the reverse function to RateToProb, converting a probability for a given time period to a rate. That means \(\text{ProbToRate}(0.04877;1)\) equals 0.05 (rounded to 5 d.p.) for the same time period.

Using the additive property of rates, rates for two events can be added together and converted back to a probability to get the probability of two events both occurring.

In both RateToProb and ProbToRate, the time parameter (the second argument) will allow you to convert between a rate with time interval of one length and a probability with time interval of a different length. For example converting between daily, weekly, monthly or annual time intervals.

Consider converting an annual probability of 0.5 to a monthly rate. This could be done via:

\[
\text{probtorate}(0.5;1)*(1/12)
\]

This gives a monthly rate of 0.05776. Then, if we wanted the monthly probability from this, we would convert the monthly rate back to a monthly probability:

\[
\text{ratetoprob}(0.05776;1)
\]

to give the monthly probability of 0.05613 (rounded to 5 d.p.).

TreeAge Pro has the ProbToProb function to convert a probability for one cycle length to an equivalent probability for a different cycle length. (You cannot simply multiply the original probability by a factor. Instead, use the ProbToProb function.) The following expression changes an annual probability of 0.5 to a monthly probability:

\[
\text{ProbToProb}(0.5; 1/12)
\]

to give the monthly probability of 0.05613 (rounded to 5 d.p.).

---

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| RateToProb(rate; time)    | Multiplies a rate by time, and converts it into a probability.  
\[ 1 - e^{-rate \times time} \] |
Other common probability examples are:

- Conversion from Annual to Monthly: \( \text{probtoprob}(0.5; \frac{1}{12}) = 0.05612568731830647 \)
- Conversion from Annual to Daily: \( \text{probtoprob}(0.5; \frac{1}{365.25}) = 0.0018959339961140964 \)
- Conversion from Monthly to Daily: \( \text{probtoprob}(0.05612568731830647; \frac{1}{(365.25/12)}) = 0.0018959339961140964 \)

### 37.4 Converting Distributions to Transition Probabilities - DistTransProb

The function DistTransProb converts time-to-event distributions to Markov transition probabilities for any time period.

Survival Analysis may determine that an event occurs within a patient population based on a time-to-event distribution. For example, time to progression may occur based on a Weibull distribution. This data can be used in both DES and Markov models, but in different ways.

- **DES**: In a DES model, the time-to-event distribution would be sampled directly to get a new event time for each patient in the model.
- **Markov**: In a Markov model, you can derive transition probabilities for the event from the underlying time-to-event distribution.

To demonstrate the equivalence of the time-to-event distribution with DES (sampling) vs. Markov (derived transition probabilities), consider the Healthcare tutorial example model *DistTransProb vs DES.trex*.

---

**Model DistTransProb.trex**

The time-to-event distribution Dist_TimeToDeath is a Weibull distribution, which is commonly used for time-to-event distributions.

In the DES model strategy, the Dist_TimeToDeath distribution is used directly in the time expression for death. Each patient will get a different time for death sampled from the distribution.
In the Markov model, the Dist_TimeToDeath distribution is converted to the appropriate probability of death for each cycle using the DistTransProb function.

There are two possible syntax options for the DistTransProb function presented below - referencing the distribution by name or by index. Both are in the model for reference, but only the first is used.

- \( p_{\text{FromDist}} = \text{DistTransProb("Dist\_TimeToDeath"; \_stage; 1)} \)
- \( p_{\text{FromDist2}} = \text{DistTransProb(1; \_stage; 1)} \)

More generically, the two function call options are described below.

- \( \text{DistTransProb("distribution name in quotes"; cycle\_time\_start ; cycle\_time\_length)} \)
- \( \text{DistTransProb(distribution\_index; cycle\_time\_start ; cycle\_time\_length)} \)

The arguments represent the following:

- distribution reference: a reference to the appropriate time-to-event distribution within the model - either by name in quotes or by index without quotes;
- cycle\_time\_start: the start time for each cycle; and
- cycle\_time\_length: the length of the Markov cycle (see below for more details about this argument).

Note that the second and third arguments reflect the specific time period for which you are calculating the probability for the underlying distribution. The argument values depend on the time relationship between the time-to-event distribution and the Markov cycle length. Let's consider some examples.

- Time-to-event distribution is in \textit{years}, and the Markov cycle length is also in \textit{years}.
  - The two time periods are consistent, so one cycle (\_stage) is equivalent to the one time unit from the underlying distribution.
  - Syntax: DistTransProb("distribution\_name"; \_stage; 1)

- Time-to-event distribution is in \textit{months}, and the Markov cycle length is also in \textit{months}.
  - The two time periods are consistent, so one cycle (\_stage) is equivalent to the one time unit from the underlying distribution.
  - Syntax: DistTransProb("distribution\_name"; \_stage; 1)

- Time-to-event distribution is in \textit{years}, but the Markov cycle length is in \textit{months}.
  - The two time periods are not consistent, so one cycle (\_stage) is only 1/12 of a time unit from the underlying distribution.
  - Syntax: DistTransProb("distribution\_name"; \_stage/12; 1/12)

Refer to the Healthcare tutorial example model \textit{DistTransProb vs DES Cycle Length.trex} for syntax examples.
We can run microsimulation on the model *DistTransProb vs DES.trex*, and the output will show almost identical values for the Markov and DES "strategies" of the model. The output is the average life years and this shows, on average, the same results will be returned from a sample from the Weibull Distribution or from the Transition Probability in the Markov model.

Note that there could be a special case where the time-to-event starts later in the analysis. For example, you could have a distribution for time-to-death after progression. In such a case, the distribution time 0 is not the same as the Markov time 0 because some period of time could take place before progression.

In this situation, you would need to record the time of progression for each patient in a simulation to set a "new time 0" point for the time-to-death distribution.

- Store time of progression in tracker: `t_time_prog`.
- Time of death post progression is: `DistTransProb("dist_name"; (_stage-t_time_prog); 1)`

Note that the above would change if the time periods for the distribution and Markov cycle were not consistent.

### 37.4.1 Distributions with special inputs

There are some distributions which need some special consideration when using DistTransProb.

For a *Multivariate distribution*, an additional argument can be used:

- `DistTransProb("distribution_name"; variate; time_cycle_start ; time_cycle_length)`
- `DistTransProb(index_of_distribution; variate; time_cycle_start ; time_cycle_length)`

For *LogNormal and LogLogistics distributions*, using DistTransProb can create an error if the first value to be sampled is at `_stage = 0`, because Log(0) is undefined.

- There will be an error when `_stage = 0` if you use: `DistTransProb("dist_from_log";_stage; time_cycle_length).
- Define instead the probability as:
  - `transition_prob = if(_stage = 0; DistTransProb("dsurvival"; _stage + 1e-9; 12) ; DistTransProb("dsurvival"; _stage; 12))`

This ensures that when `_stage = 0` the is a small constant added "1e-9" to the `_stage`, allowing the first cycle (_`stage = 0`) to run without the error. You can use even smaller values "1e-12", and compare if there is a material change to the transition_prob dependent on the small constant.
37.5 State/transition probability functions

There are other functions with “Prob” in their names that are not used for conversion between rates, probabilities, or odds. The functions listed here have special applications in Markov models. See the section on Dynamic cohort models later in this chapter for details.

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>StateProb(i)</td>
<td>Returns the state probability of state #i at the start of the current cycle. If running a microsimulation, parallel trials are required or returns as 0. In dynamic models using non-coherent probabilities, effectively returns “counts” instead of true percentages. See note below for more details.</td>
</tr>
<tr>
<td>StateProb(_state_index)</td>
<td>Returns the state probability of the state currently being evaluated. The _state_index keyword first returns the index for the current state.</td>
</tr>
<tr>
<td>StateProb(i; j)</td>
<td>Returns the sum of the state probabilities of the set of states from #i to #j.</td>
</tr>
<tr>
<td>StateIndex(&quot;state/binding&quot;)</td>
<td>Returns the integer index (starting at 1) of the named state, or the state pointed to by the named binding. Usually used in combination with the StateProb() function. Use in combination with the StateProb() function. Useful while building the tree, but changing the order of branches or adding branches may affect states’ indexes and cause calculation errors.</td>
</tr>
<tr>
<td>TransProb()</td>
<td>Returns transition path probability of the current node/branch – i.e., the product of the most recently cached transition probabilities. The product does include the probability stored for the node/branch where the calculation is being called/used. However, note that if branch X's probability is being calculated, then branch X's cached probability from the previous cycle will be used in the product!</td>
</tr>
<tr>
<td>PathProb()</td>
<td>Outside of the Markov transition subtree, returns the cumulative path probability for the node being calculated (up to the Markov node in a Markov subtree). Use TransProb() within the Markov subtree.</td>
</tr>
</tbody>
</table>

**State/Transition Probability Functions**

An argument in StateProb() should correspond to the integer index of a branch of the Markov node (e.g., index=1 for the top state, StateProb(1)).

To return the sum of the state probabilities of a range of states, specify the range of branch indexes using two arguments. For example, use StateProb(2;5) to add the state probabilities of states 2 through 5.

Use TransProb() in combination with StateProb() – and perhaps even PathProb() – to determine the percentage of the population/cohort that experience a particular transition at a particular point in time.

If state #n is a tunnel state, StateProb(n) returns the total state probability of all temporary states. StateProb(-x) returns only temporary state x's state probability.
The StateProb() function will work with non-coherent probabilities in a dynamic cohort model.

### 37.6 Half-Cycle Correction

Real processes occur in continuous time, with transitions and other events occurring throughout an interval of time. However, a Markov process occurs as a discrete sequence of snapshots, which can lead to overcounting Markov rewards.

*Traditional Markov models* accumulate the full cycle’s state reward at the beginning of each cycles with transitions understood to occur at the end of each cycle, even though some portion of the cohort will leave the state during the cycle. Expected values will therefore overestimate life expectancy by about half of a cycle (0.5 years in a one-year cycle length model).

Consider the simple example of life expectancy in a simple model with health states *Alive* and *Dead*. *In each cycle, some portion of the cohort is alive and accumulates 1 life year. In reality, however, deaths will occur halfway through a cycle on average.* So, someone that dies during a cycle should lose half of the reward they received at the beginning of the cycle (e.g., -0.5 years of life expectancy in a one-year cycle length model).

*WCC Markov models* account for transitions within a cycle by accumulating rewards based on the percentage of the cohort in a health state both at the beginning and the end of each cycle. *Half-cycle correction should never be applied to a WCC model.*

However, instead of implementing the half-cycle correction as a toll at each transition to death, it is easier to implement it in an absorbing process simply by subtracting a half-reward from the rewards assigned at the beginning of the process, in cycle 0 — i.e., by setting a state’s initial reward to one-half of its incremental reward. This is the primary, though not only, reason that the state rewards are separated into three parts.

In a non-absorbing process, in which a significant percentage of the cohort may be alive when the process terminates, cohort members still alive at the end of the process should be given back the half-cycle “death” correction taken from their initial reward at the beginning of the process. This is done by adding on a half-reward after termination in the final reward for all alive states (it does not hurt to always include the initial and final components at every state).

To perform half-cycle correction:

- Select a Markov state node.
- Open the Markov Info View.
- Enter the initial and incremental rewards.
- Select a reward for the appropriate payoff set.
- Click on the "pencil" icon in the view's toolbar to open the State Reward Dialog.
- Click the Half-Cycle Correct button.
The initial and final rewards will be updated.

![Image of Markov Modeling Tools and Techniques]

**Half-cycle correction via State Reward Dialog**

Any reward that is a function of life expectancy (i.e., medication costs that occur gradually over a cycle) is usually corrected in the same way.

In models that calculate quantities other than simple life expectancy, for example quality-adjusted life expectancy, different alive states will have different rewards. This means that a perfect half-cycle correction might require correcting not just for death transitions, but for other kinds of transitions from higher value states to lower value states (i.e., where someone should receive half a cycle of the starting state’s reward and half of the ending state’s reward). Note, however, that Markov approximation errors in two strategies will often cancel each other out in incremental calculations, and reasonable judgement should be used to decide when to use half-cycle correction.

### 37.7 Assigning onetime costs and utilities

There are a number of different situations which may require assigning a onetime reward in a Markov model, rather than an incremental reward for each cycle spent in a particular state.
37.7.1 Prior costs

In some models, it is necessary to account for costs, utilities, or life expectancy that occurred prior to the Markov process. Consider, for example, a tree which deals with the uncertainties associated with a particular treatment. In this model, a Markov process will be encountered only if a particular event occurs. In the standard tree structure, costs are incorporated into a payoff formula at terminal nodes. In the scenario including the Markov model, though, these costs must also be accounted for in Markov rewards.

Typically, prior value expressions should be entered in the initial state reward of all states with a nonzero initial probability. This would ensure, for example, that all members of the cohort receive the prior costs. In a cost-effectiveness model (or any model with multiple attributes) be sure to use the appropriate reward set. Cost-effectiveness Markov models are discussed later in this chapter. If your model also uses the half-cycle correction (see above), the initial reward expressions must combine the prior values and the half reward.

To include prior costs in a Markov model:

- Create and define a variable or expression that represents all costs accumulated before the Markov process.
- For each state with a nonzero initial probability, update the initial reward expression to add the prior costs expression, remembering to keep the half-cycle correction if needed.

The Health Care tutorial example tree "Prior Costs Markov" is shown below.
37.7.2 Transition rewards

In some models, you may need to account for a cost or disutility associated with a transient event rather than a state. In many such cases, a transition reward can be used. Transition rewards can be assigned at any node to the right of the Markov state nodes (not just the actual transition nodes).

For instance, a one-time cost may be associated with admission as an inpatient. This cost is not incremental and should not be accumulated in each interval spent in the hospital. Nor can the cost be assigned using an initial state reward if the admission event is not just an initial, cycle 0 event (initial rewards are only assigned when _stage = 0).

Another example might be a relatively minor complication event during treatment. Although the complication is not a state itself, and may have no effect on state transition, it may have costs and/or disutilities associated with it.

In the Health Care tutorial example tree "Transition Reward Markov", transition rewards are specified both for costs (in reward set #1) and for effectiveness (in reward set #2).
Markov Transition Reward Tree

To assign a transition reward:

- Select the node where the event occurs, to the right of a Markov state.
- Choose Views > Markov Info from the toolbar.
- Enter values in one or more of the fields Rewards > Trans <Reward Type> in the Markov Info View.

If the Markov information display preference is turned on, transition reward expressions are shown below the branch.

Notes on transition rewards:

- Transition rewards are not accounted for separately from state rewards.
- Transition rewards are associated with the cycle in which they occur.
- In cohort analysis reports, transition rewards are not associated with the state in which they occur; instead, they are divided among the Markov states to which the transition may lead based on the relative transition probabilities.
- Like state rewards, transition rewards are added to the net reward. Thus, transition rewards should be entered using the appropriate sign, positive or negative. For example, transition costs are normally entered as positive numbers, while transition disutilities are normally negative numbers.

### 37.8 Cloning Markov models

A major advantage of using clones in any tree is the ability to reuse a particular structure in multiple parts of a tree. By doing this, you're still retaining the option to vary probability and other value expressions in each “copy,” but you only have to maintain the master subtree (refer to the Tools and Functions for Complex Trees Chapter). In TreeAge Pro, entire Markov models can be cloned within a single tree and parts within a complex transition subtrees can also be cloned.

#### 37.8.1 Using Markov state bindings

Clone copies of Markov transition subtrees will, by default, employ the jump-to state settings specified in the clone master. In TreeAge Pro, Markov bindings can be used to have a transition in a clone copy use a different jump-to state than the clone master.

As described in the Tools and Functions for Complex Trees Chapter, variables can be used in clone copies when numeric values such as probabilities should not be controlled by the clone master. Markov state bindings function similarly; rather than assigning a numeric value to the binding name, a Markov state name is assigned instead. Like variable definitions, Markov state bindings must be defined at an appropriate node. Markov state bindings may be defined at any node on the Markov subtree, including the Markov node. Typically, they are created at the root nodes of the clone master and clone copies.

The use of Markov state bindings can be illustrated using the Health Care tutorial example tree "Markov Bindings", shown below unfinished.

**Markov Bindings Tree**

Transitions must be assigned to the Response and No Response nodes in the clone master. The Response transition node in Drug A’s subtree should jump back to Drug A, while the same node in
Drug B’s clone copy subtree should, instead, jump to Drug B. Similarly, Drug A’s No Response node should point to Drug B, while Drug B’s No Response node should point to End Therapy.

**To define Markov state bindings in the Markov subtree:**

- Open the Markov Bindings tree.
- Select the Drug A node.
- Choose Views > State Bindings from the toolbar.
- In the State Bindings View, click the “add” toolbar icon to add a new binding.
- Enter the Name `continue` and select the State Drug A.
- Add another binding and enter the Name `next line` and select the State Drug B.
- Select the Drug B node.
- In the State Bindings View, add two bindings with the Name/State combinations `continue/Drug B` and `next line/End Therapy`.

Create Markov Bindings

If the display of Markov information is turned on in the tree (in the Tree Preferences dialog, under the Variables Display category), Markov bindings will be displayed below other Markov information, in the form `binding name >> jump-to state name`.

Markov Bindings shown in tree

Bindings that you create have no effect until a binding name is referenced at a Markov transition node in a clone master.

When Markov state bindings are found in the path back to the Markov node, the list of options under Jump state in the Markov Info View will include Markov bindings as well as the regular state names. The binding names displayed in the list are prefixed with the equal sign (=) to distinguish them from
actual states. (Thus, when naming states, you should avoid using a leading =, although this is not strictly forbidden.)

**To use a Markov state binding in a clone master transition:**

- Double-click on *Drug A*'s *Response* node to open the Edit Jump State Dialog.
- In the Edit Jump State Dialog, select the Markov Binding =*continue* and click OK.
- ... OR...
- Select *Drug A*'s *Response* node.
- Choose Views > Markov Info from the toolbar.
- In the Markov Info View, select the Markov Binding =*continue* for the Jump state.

Repeat these steps to set the jump state for the No Response Node to =next line.

**Assign Markov binding via the Edit Jump State Dialog**

**Assign Markov binding via the Markov Info View**

When a binding name is used at a transition node, the search for the binding proceeds in right-to-left fashion, as with variable definitions. Since the Markov state bindings =*continue* and =*next line* are defined differently at the *Drug A* and *Drug B* nodes, the jump states will be different even though the transition subtree is cloned.
To avoid Markov structure errors due to subtle differences in state names, you should use caution when trying to clone part of one Markov process in order to attach copies in a different Markov process. (If you are determined to try, however, TreeAge Pro will allow it!) You might instead try cloning the entire Markov process, creating a clone master at the Markov node. However, there should be no problems with attaching clone copies from one state onto another state within the same Markov process.

### 37.8.2 Cloning an entire Markov process

Consider the Health Care tutorial example tree “Complex Markov Cloned”, shown below.

**Complex Markov Cloned Tree**

*Drug B*’s transition subtree is a clone copy of *Drug A*’s subtree. On the surface, these subtrees appear to be identical, but in fact, the strategies have different termination conditions (assigned at the Markov node, outside the clone master).

State rewards utilize the variables *init* and *incr*. These variables are defined differently at the two Markov nodes resulting in different cost calculations. Similarly, different values could be used for each subtree’s probabilities simply by converting the numeric probabilities to variables in the clone master, and then uniquely defining the variables at both the *Drug A* and *Drug B* Markov nodes.
37.9 Counting "time in state" with tunnels

A tunnel state can be used when you need to keep track of the number of cycles an individual has remained in a particular state. In a cancer state, for example, transition probabilities to other states often depend on how long the individual has been in the cancer state.

Tunnels versus simulation/trackers:
Instead of using tunnel states, some Markov models are built using tracker variables and microsimulation to count time-in-state; each approach has its advantages. Tunnel states work during both cohort analysis (i.e., rollback, n-way sensitivity analysis) and microsimulation. Trackers are more restrictive, requiring microsimulation (a.k.a. individual-level simulation) which is generally a more time-consuming analysis. Trackers, however, are extremely flexible, and can be used to keep track of unlimited continuous and discrete states, transient events, etc. Models built using tracker variables can be made structurally simpler, with fewer states/branches. Refer to the Individual-Level Simulation and Markov Models Chapter for details on tracker variables.

If a model is already using trackers/microsimulation, then it will be more efficient/parsimonious to track time-in-state, rather than “tunnel” it.

37.9.1 Temporary states and the _tunnel counter

In the Markov modeling literature, a temporary state is a state which an individual must exit after one cycle and a tunnel is a series of temporary states. Normally, an individual entering the tunnel state — either from another state, or at the start of the Markov process — enters temporary state #1. If an individual remains in the tunnel state for another cycle, they move in order through temporary states #2, #3, and so on.

One way to model a tunnel is to use a separate state for each temporary state, and manually set up ordered transitions between the states. However, TreeAge Pro allows you to represent a tunnel more efficiently, using a single branch from the Markov node; this makes it easy to create tunnels of any length (even with thousands of temporary states).

When you create a tunnel state in TreeAge Pro, all temporary states will use the same transition subtree. In order to specify different transitions for particular temporary states, you can refer to TreeAge Pro’s temporary state counter, a Markov keyword called _tunnel (similar to _stage). TreeAge Pro starts the _tunnel counter at 1 for someone entering a _tunnel state, and increments the counter by 1 each cycle they remain in the tunnel state. Using _tunnel to count “time in state,” your transition probabilities can look up appropriate values from tables. Logic nodes and statements can also use the _tunnel counter.
37.9.2 Using a tunnel state – an example

Consider the three-state cancer model shown below. Note that since there is no transition from Cancer back to itself, the patient spends one cycle in the Cancer state before exiting to another state, and therefore Cancer is a temporary state (although not a tunnel yet).

Cancer model before tunnel

This model may not accurately represent the basic process of the disease. Cancer should probably unfold in a series of temporary states, with different probabilities of changing state (i.e., remission or death) in each successive cycle/year. And these probabilities should depend on how many cycles someone has spent in the Cancer state (which is not given by the _stage counter, since everyone starts in Pre-cancerous, and a transition to Cancer may occur at any cycle).

An “exploded” version of the cancer Markov model is shown below. An explicit chain of temporary states is used to describe each year of the cancer. While this more detailed model is still relatively small, as the required number of temporary states increases, explicitly representing all of them becomes more problematic. In TreeAge Pro, the chain of temporary states can be represented more efficiently using a single tunnel state.
Cancer model "exploded" with temporary states

The same Markov process (i.e., calculating the same results) can be built in TreeAge Pro with Cancer set as a tunnel state, as illustrated below. See the Health Care tutorial example tree "Cancer Tunnel".

Cancer Tunnel Model

*To change a state to a tunnel state:*

- Select the appropriate Markov state.
- Choose Views > Markov Info from the toolbar.
- In the Markov Info View, set the Tunnel Max value equal to the maximum required number of temporary states.

![Tunnel Max entry in Markov Info View](image)

The number specified determines how high the _tunnel counter will increment (corresponding to the number of copies of the state which TreeAge Pro keeps track of internally during calculations). Individuals that reach the last temporary state and transition into the state again will simply remain in the last temporary state.

Set the number of temporary states to the minimum number that will account for all differences among the temporary states. For example, if the only difference among the temporary states is a probability that changes for the first four cycles then stabilizes, you will need four temporary states.

### 37.9.3 Using the _tunnel counter

Note the use of the _tunnel counter/keyword in probabilities in the Cancer transition subtree shown in the prior section. The Die node probability is \( T\_MORT[\_tunnel] \). As a portion of the cohort remains in the state, _tunnel increases, and a different probability is pulled from the table.

### 37.9.4 Merging results for temporary states

When you perform a Markov cohort analysis at a Markov node that includes a tunnel state, you are given the option to merge each tunnel’s temporary states into a single text report column or graph line. In fact, that is the default presentation of data.

![Collapse Tunnels Dialog](image)

This is particularly useful if there are many temporary states in a tunnel. Prior to running the analysis, TreeAge Pro will present the prompt shown above, asking whether or not to merge temporary states. If you choose not to merge temporary states, the text report will append extra columns for the second and subsequent temporary states.
One positive result of merging a tunnel’s temporary states is a simpler, more coherent line graph, as shown below.

37.9.5 Populating temporary states at cycle 0

Normally, the initial probability expression assigned to a tunnel state is used to populate only the first temporary state. It is possible, however, to distribute members of the cohort among the different temporary states at cycle 0. The Tunnel Info section of the Markov State Information dialog includes an advanced setting that will cause TreeAge Pro to evaluate the initial probability expression in a tunnel state for every temporary state.
Set initial probabilities for tunnel states

In the above example, 25% of the cohort should start the analysis in each of the 4 temporary states associated with this tunnel state.

This could be used, for example, to create a model that uses the _tunnel counter to track the age of the members of the cohort with a realistic age distribution. Every state could be made a tunnel state, with their initial probabilities referencing tables of probabilities using the _tunnel counter (creating the age distribution).

37.9.6 Special binding names and tunnels

Markov bindings were first discussed earlier in this chapter within the context of clones.

TreeAge Pro supports three special Markov binding names:

- Tunnel Crossover
- Tunnel Variable
- Tunnel Table

The **Tunnel Crossover** binding is used at a transition node to allow the _tunnel counter to increment uninterrupted when transitioning from one state to a different state, provided both are tunnel states. Normally, the _tunnel counter would reset to 1 when moving to a different state. If the tunnel crossover value exceeds the maximum number of tunnels for the state, the maximum tunnel value is used.

The **Tunnel Variable** binding is used to dynamically point any transition node to a specific temporary state in the destination tunnel state. The variable must have the name "tunnel_" appended to the front of the starting health state (replace spaces with underscores). See example model Markov Tunnel Bindings for details.

The **Tunnel Table** binding is used in a similar way to Tunnel Variable, except that transitions to particular temporary states are determined by numbers pulled from a column in a TreeAge Pro table. The tunnel table binding will have a name like Tunnel Table C1 where C1 refers to the first value column (not index column) from a table with the name "tunnel_" appended to the front of the starting health state (replace spaces with underscores). When the cohort reaches the tunnel table binding, it looks for the table, finds the row with an index equal to the current _tunnel value, then goes to the appropriate column (C1, C2, etc.) to determine the _tunnel value for the next cycle, regardless of which jump state is selected for the binding. See example model Markov Tunnel Bindings Table for details.
To create a special binding, click "Add Special" on the State Bindings View toolbar. See below.

Create special bindings (Mac)

The Health Care tutorial example model "Markov Tunnel Bindings" illustrates the use of the Tunnel Crossover and Tunnel Variable special bindings.

Special Bindings (Mac)

The Tunnel Variable binding definition made at the Drug A node points to the Drug A state. The use of this binding at the max doses, restart node within the Drug A transition subtree means that this transition will return to the Drug A state for the next cycle. However since the binding is a Tunnel Variable, TreeAge Pro searches for variable tunnel_Drug_A ("tunnel_" + <state name> replacing spaces with underscores) to determine the temporary state for the next cycle. In this case the variable tunnel_Drug_A is defined as 1, so the temporary state will be 1 for the next cycle (restart the doses).
The Tunnel Crossover binding definition at the Drug A node points to the Drug B state and vice versa. This allows the transition for the No Response node to transition to the other state. However, since it is a Tunnel Crossover binding, the temporary state is maintained. The flow would pass from temporary state 1 in the Drug A state to temporary state 2 in the Drug B state and vice versa.

### 37.10 Markov decision processes

Markov decision processes are not currently supported.

> We strongly recommend having a single decision node in healthcare models. This is the only way that all strategies can be shown in analysis results for comparison. If there is a downstream decision, it is best to predefine all decisions in a single strategy. For example, if you have a choice of treatment A or B this year and then treatment C or D next year, four strategies could be A then C, A then D, B then C and B then D.

### 37.11 Extra Rewards

The Tree Calculation Methods and Preferences Chapter described how to use extra payoffs for additional calculations beyond the active payoffs for the specified calculation method. You can enter state and transition rewards for extra payoffs in a Markov model as well.

For Markov state and transition nodes, you can enter rewards for additional payoff/reward sets in the Markov Info View. All enabled payoff/reward sets are displayed beneath the active reward sets and labelled 'Inactive', as below.

![Extra reward sets in Markov Info View - Markov state node](image-url)
By placing a 1 in a Markov transition reward for an extra reward set, you can count the percentage of the cohort that passes through a specific transition. Be careful about your conclusions if the cohort could pass through that transition more than once. Note, it is not necessary to add a reward into the transition rewards for the model to work.

37.12 Other advanced Markov options

37.12.1 Nesting or linking Markov models

TreeAge Pro includes powerful functions – for example, Node(), Global(), GlobalN(), and User() — that can perform tasks such as:

- nest one Markov model within another
- link multiple terminal nodes to one Markov model
- combine a Markov microsimulation with expected value analyses

Function syntax is described in more detail in the Building Formulas Using Variables and Functions Chapter and the Tools and Functions for Complex Trees Chapter. These functions are complex, and we recommend other more typical model building structure above using this approach.

The Special Features tutorial example tree "Node Function" illustrates how to refer to one part of a model from another. The Tree function is similar except it refers to a separate model.
Node Function Tree

The top arm is set up for an expected value calculation and its decision node includes two strategies both linked via the Node() function to the same Markov model at the bottom. Each strategy passes distinct values to the Markov process using the Global() function. The Node() function then calculates the Markov model using microsimulation trials (even during non-simulation analyses of the top decision node).

The Node() function's arguments are used to select a node in the tree and to determine what kind of calculation to use at that node. The syntax is:

\[
\text{Node(attribute; method; branch; \ldots)}
\]

In CE models, the\ attribute argument determines whether to return cost or effectiveness (-1 calculates and returns cost; -2 returns effect from previous calculation; -11 returns cost from previous calculation; -12 calculates and returns effect). In non-CE models, as in the example, use any number other than 0 (which returns 0).

For the method argument, use 0 to calculate the expected value; or specify a negative number to average that number of microsimulation trials (e.g., -100 to run 100 trials), as in the example.

The third and subsequent branch arguments are branch numbers used to select a node starting with a branch of the root node.

In the tree, the complete expression Node(1; trials; 2) returns the cumulative reward (attribute 1), based on the average of 100 trials (method -100) at the Markov microsimulation node (branch 2).

The Global() function is illustrated in this example as well. However, it is not a required element of linking Markov trees. Global matrices can be used to store transient values when it is helpful, such
as when you want to report the changing values of simulation tracker variables used in a subsidiary Markov process.

The following syntax is used to calculate and store a value in a cell in the Global matrix:

\[ \text{Global}(\text{row}; \text{column}; \text{expression}) \]

The function returns the value of the calculated expression, as well as stores it in the Global matrix. The first cell in the global matrix is at row=1, column=1. Up to ten thousand cells are currently supported.

The following syntax can be used to reference a value saved to the global matrix:

\[ \text{Global}(\text{row}; \text{column}) \]

The contents of the global matrix can be dynamically saved to a text file (or emptied) using the third syntax of the Global() function:

\[ \text{Global}() \]

If the value evaluates to a non-zero number, the contents of the global matrix are silently saved to a text file in the tree’s directory. A zero value will empty the matrix. Refer to the Tools and Functions for Complex Trees Chapter for more information.

In the example model, the variable definitions for \( g1A \), \( g1B \), \( g2A \) and \( g2B \) store information in the Global matrix. The definition \( g1A = \text{Global}(1;1;pA) \) stores the value \( pA \) in row 1, column 1 of the Global matrix.

At the unnamed branch of node \( a \), the \( g1a \) and \( g2a \) are executed to generate a non-zero probability for the logic node, thereby placing the "a-related" values in the Global matrix. For the \( b \) strategy, the "b-related" values are placed in the Global matrix.

When the Markov model is evaluated (via Microsimulation) for each strategy by the Node function, the appropriate values are used when referenced in the Global matrix.

37.12.2 Additional notes on the Node() function:

- Node() function syntax is described in more detail in the Tools and Functions for Complex Trees Chapter. The related Tree() and Global() functions are also covered in detail there.
- Trackers are not reset to 0 at the beginning of trials run by the Node() function. This is intentional in order to allow communication between the calling and called nodes.
- Trials run by the Node() function do not resample distributions automatically (even if their properties are set to sample per trial). To force a sample, use the Dist(N; 1) syntax or DistForce(N). To control the sampling rate, put the force sample expression in a tracker evaluation (outside a Markov process, for example).
- The second parameter of the Node() function, possibly specifying a number of simulation trials to be run, can be given a number after a decimal place to indicate that a statistical measure other than the mean should be used from the set of trials. Refer to the "Tools" Chapter.
37.12.3 Sampling probabilities from a multivariate Dirichlet distribution

If a chance node has more than two branches with non-negligible probabilities, performing a sensitivity analysis or Monte Carlo simulation that changes the values of these probabilities can be problematic. One option is to normalize the chance node’s probability expressions. For example, if a node has three outcomes, A, B, and C, rather than assigning variables to two probabilities and using the # remainder for the third, you could do the following: assign three expressions that always sum to 1.0, such as \( p_A / (p_A+p_B+p_C) \) and \( p_B / (p_A+p_B+p_C) \) and \( p_C / (p_A+p_B+p_C) \). No matter what values (\( \geq 0 \)) are assigned to \( p_A \), \( p_B \), and \( p_C \), the three normalized probabilities will always sum to 1.0. (The # remainder could still be used in place of one of these.)

TreeAge Pro offers a similar solution using a special, multivariate form of the beta probability distribution, called a **Dirichlet distribution**. This distribution can be used to represent the uncertainty in all of the probabilities of a chance event. During Monte Carlo simulation, the distribution can sample probabilities for each branch using normalization to ensure that the probabilities always sum to 1.0.

If the distribution is parameterized with a list of three positive \( \alpha \) values, as shown here, TreeAge Pro will samples three independent Gamma[\( \alpha \), \( \beta=1.0 \)] distributions and normalize these to create a list of three probabilities.

For documentation on creating and editing distributions, refer to the Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis Chapter.

The Dist() function is used with a second argument to indicate which branch (i.e., \( \alpha \)) to use. The Health Care tutorial example model, "Dirichlet Simple", is shown below.
Rolling back the tree shows the mean values of the probabilities, which are simply the normalized alpha parameters.

Performing a simulation in the example tree shows the effect of sampling independent Gamma distribution values based on the list of alpha parameters, and then normalizing. For each iteration of the simulation, a different set of Gamma random variates is drawn. Each iteration results in a different sum, as well as different ratios of the Gamma random variates to the sum (i.e., the probabilities), but normalization ensures that the resulting probabilities sum to 1.0.

The following output from a PSA simulation shows the different probability values generated by the Dirichlet distribution for each simulation iteration. Note that the probability values are centered around the respective mean values.

PSA output - Values, Dists, Trackers

37.12.4 Markov cohort analysis using the TreeAge Pro Object Interface

Users of the TreeAge Pro Object Interface can create macros or other automation scripts/programs that run Markov analyses programmatically. For example, the macros would use a
TreeAgeProLib.ApplicationObj variable to create a TreeAgeProLib.TreeObj variable, and then a TreeAgeProLib.MarkovOutput variable.

The advantages of the programmatic approach to running the Markov cohort analysis include:

- Automate repetitive analyses
- Parse sections of the full text report for specific values
- Pause between cycles in order to make complex adjustments to the model (using MarkovEvents)

Refer to the Using the TreeAge Pro Object Interface Chapter for more information.
38. Partitioned Survival Analysis

This chapter introduces Partitioned Survival Analysis (PartSA) models - both the concepts and how to build & analyze one in TreeAge Pro.

38.1 Introduction to Partitioned Survival Analysis

Partitioned Survival Analysis (PartSA) Models mirror real disease progression by mapping the state of the model cohort directly from observed survival data. PartSA models are frequently used to track disease progression in the area of Oncology.

PartSA models include health states like Markov models. However, transitions among states are not driven by transition probabilities. Instead, state membership is estimated based on Survival Functions fitted to the original survival data.

Traditional Markov models provide more flexibility with patient pathways by allowing for both health states states and events. However, it can be hard to create patient pathways and transition probabilities that result in progression that matches to the known survival data. PartSA models avoid that problem by using the survival data more directly.

The cohort flow within a Partitioned Survival model is defined by survival curves over time. Each survival curve describes membership in its underlying health state.

For example, 100% of the cohort may start in a Progression-Free Survival state (PFS) at time 0, but after 1 year, only 90% of the cohort is still progression free. Over time, the percentage in PFS would continue to decrease. The membership in the PFS state is then calculated as the area below the PFS Survival Curve.

If the model has additional non-dead health states, these are represented by multiple Survival Curves. Each health state can accumulate value – typically cost and effectiveness – as is appropriate based on the cost of treatment and the state's utility value.

38.2 Partitioned Survival Analysis: An Example

This section will examine a typical PartSA model that follows cancer progression. Specifically, we will look at the Partitioned Survival Analysis Example Model PartSA-Example.trex. We will look at the basic elements of this PartSA model in this section. Further details including implementation instructions are provided in subsequent sections of this chapter.

In PartSA models, disease progression is represented by a series of Survival Curve nodes, each of which has an underlying health state. Survival Curve nodes are ordered with the healthiest Survival Curve/state at the top and the sickest at the bottom, implying a top down progression through all states to an implicit Dead state following the bottom branch.
In this example model, there are three nodes:

- A PartSA node representing the start of the PartSA model structure;
- A Survival Curve node representing Progression-Free Survival (PFS); and
- A Survival Curve node representing Overall Survival (OS).

Note that the Dead state is implicit, so it is not needed in the model structure. If there were more non-dead states, you would add more Survival Curve nodes.

Each Survival Curve node requires the following information:

1. **Health State**: the name of the health state whose exit is defined by the Survival Curve. For example: *Progression-Free State* for the top branch.
2. **Survival Function**: the Survival Function defines how the cohort exits the state over time. For example, the expression *surv_PF* describes exit from the Progression-Free State.
3. **State Rewards**: define how costs and utility is accumulated based on state membership.

Entry of the information as above is described in the Enter Partitioned Survival Analysis Node Inputs and the Enter Survival Curve Node Inputs sections of this chapter.

The *Survival Function* for Progression-Free Survival is defined by the variable: *surv_PF*. This variable function calculates exit from the Progression-Free Survival State based on an underlying Weibull distribution, *Dist_Surv_ProgFree*. We will discuss Survival Functions in detail in the Survival Functions section of this chapter.

Based on the model's two Survival Functions, the PartSA model generates the following Survival Curve Graph.
The Survival Curves represent the movement between pairs of states. The health states have been added in boxes the graph below.

Survival Curves for PartSA-Example.trex with states marked including the implied state, Dead.

With the Survival Curves in place to describe health state membership, we can now accumulate value – cost and effectiveness – based on the state membership. Both cost and effectiveness are accumulated for the PFS and the PPS states.

In the PFS state, costs are accumulated at discrete times based on the percentage of the cohort in the associated PFS state. Our time unit is annual, and Chemotherapy is given once per month for 6 months – at times 0, 1/12, 2/12... 5/12. Utility is accumulated continuously from state membership based on the area under the curve. In the PPS state, both cost and utility are accumulated continuously based on state membership.

If you run Analysis > Roll Back on the model, you will see the total cost and effectiveness accumulated over the time horizon: $613,870.53 and 6.5596 QALYs. In a decision model, these values would be
used in Cost-Effectiveness Analysis to compare this PartSA model to another strategy. Turn off Roll Back when you are done.

Select the PartSA node, and choose Analysis > Partitioned Survival Analysis > State Report to see details on how each health state contributed to the overall calculations shown in Roll Back. The report also provides the area under the curve for each state, including the implicit Dead state, which represents the total time spent in each state.

Roll back results on PartSA-Example.trex

To see the total time horizon broken down into shorter time periods, select the PartSA node, and choose Analysis > Partitioned Survival Analysis > Time Report to see details on how each health state contributed to the overall calculations (State%, Cost and Effectiveness) broken down into discrete time periods.
38.3 Build Partitioned Survival Analysis (PartSA) Model Structure

A PartSA model consists of a PartSA node followed by a set of terminal nodes representing Survival Curves. Survival Curves must be sorted top down from healthier to sicker states. Each Survival Curve will have an associated Health State, plus there is an implicit Dead state to account for leaving the bottom Survival Curve.

To create the PartSA structure:

- Choose File > New Decision Tree from the menu.
- Decline the Model Setup Wizard, and return to this later when we are adding rewards (costs and utilities).
- Right-click on the root (decision) node and choose Change Type > PartSA from the context menu.
- Enter the node label “PartSA”.
- Double click with the mouse on the PartSA node to add two branches. Each branch will automatically be a Terminal node representing a Survival Curve. If your model requires more branches, double-click to add more branches.
- Enter node labels for each branch:
  - Top: “Progression-Free Survival”;
  - Bottom: “Overall survival”.

You have now created the model structure for the Example model in the previous section.

38.4 Enter Partitioned Survival Analysis Node Inputs

We have created the PartSA model structure, and now we need to enter information associated with the PartSA node via the PartSA Info View. The PartSA Info View changes dependent on which node type is selected. If you don’t see the PartSA Info View, you can open it via the Views dropdown menu in the toolbar.
To enter information associated with the PartSA node:

- Select the PartSA Node.
- Open the PartSA Info View. (Views menu and select PartSA Info).
- Enter information as appropriate for your model by selecting within each cell.
  
  - **Survival Time Unit**: Choose the time unit for your survival data – either annual or monthly. This should match the survival data.
  - **Time Report Unit**: Choose the time unit for the Time Report that breaks down overall progression and value accumulation by time unit – either annual or monthly.
  - **Time Horizon**: Enter the overall time for which the model should run based on the units for the survival data – either annual or monthly. For example, if survival data is calculated in months, enter the number of months for which the model should run. In the example above Survival Time Unit is Annual, so Time Horizon is 10 years. If you had monthly Survival data (Survival Time Unit) and wanted to run the model for 10 years, you would enter 120.
  - **Crossovers**: Choose an option for how to handle crossover points between Survival Curves – either “Stop Analysis” or “Push Downstream”. For example, your OS curve could have a time where there are fewer people surviving than the PFS curve indicates are still progression-free, which is impossible. In such a case, do you want the analysis to
stop, or would you prefer to just have the OS curve “override” the PFS curve. Refer to the Crossover section of this chapter for more details.

38.5 Enter Survival Curve Node Inputs

We also need to enter data associated with each Survival Curve node. For now, we will simply enter the state associated with each Survival Curve node via the PartSA Info View. Later, we will return here to enter rewards – costs and utilities.

To enter the Survival Curve node health state:

- Select the Survival Curve node.
- Open the PartSA Info View. (Views menu and select PartSA Info).
- Enter information as appropriate for your model.
  - **State under Curve:** Enter here the state which is defined by the area under the curve which this Survival Curve node relates to.
  - **Top survival curve:** Progression-Free State
  - **Bottom survival curve:** Post-Progression State
  - **Rewards:** We will cover this in the Accumulating Value section of this chapter.

PartSA Info View with the top Survival Curve node selected in PartSA-Example.trex.
38.6 Survival Functions

Each Survival Curve (the branches from the PartSA node) requires a Survival Function to represent exit from the associated state to the next progression state. Typically, a Survival Function would be represented by one of the following.

1. A parametric distribution describing state membership.
2. A table describing state membership (Kaplan-Meier data).
3. A survival time function.
4. A hazard function.

38.6.1 Survival by Distribution

Frequently in PartSA models, survival analysis is performed to find a “best fit” distribution that represents membership in the health state. TreeAge Pro supports many such distributions – Weibull, Exponential, Generalized Gamma, LogNormal, etc.

TreeAge Pro also provides a function – \texttt{DistSurv} – that calculates state membership as time passes based on the underlying distribution. The combination of the distribution and the \texttt{DistSurv} function creates a Survival Function in a PartSA model.

In the Healthcare Example model PartSA-Example.trex, there are two Weibull distributions. Each has its own scale and shape parameters.

- \texttt{Dist\_Surv\_ProgFree} – describes state membership in the PFS state relative to the PPS state
- \texttt{Dist\_Surv\_Overall} – describes state membership in the PPS state relative to the implicit dead state

The \texttt{DistSurv} function calculates state membership at any time based on the underlying distribution. Each Survival Function based on a distribution uses the \texttt{DistSurv} function to calculate survival vs. time. The Survival functions are:

- \texttt{PFS node: DistSurv(\texttt{"Dist\_Surv\_ProgFree"})}
- \texttt{OS node: DistSurv(\texttt{"Dist\_Surv\_Overall"})}

It is quicker to write: \texttt{DistSurv(\texttt{"Dist\_Surv\_ProgFree")}. But this is equivalent to: \texttt{DistSurv(\texttt{"Dist\_Surv\_ProgFree"}; _time)}.

To incorporate distribution-based Survival into a model:

- Create a distribution that describes survival against time. (See Distributions Chapter for details on creating a distribution). For example:
  - Create a Weibull distribution: \texttt{Dist\_Surv\_ProgFree}
  - The distribution parameters, as per the Example, are: \texttt{rate\_PF} and \texttt{shape\_PF}
- Create a variable to reference the distribution/DistSurv function. In the example model this is:
  \[ surv_{PF} = \text{DistSurv}("\text{Dist_Surv_ProgFree}\") \]
- Click below the Survival Curve node and enter the Survival Function, \( surv_{PF} \).

The Survival Function for Progression Free Survival in PartSA-Example.trex.
Using the DistSurv function to convert units for the Survival Function.

For example, if your model time unit were annual, but your distribution described survival in months, use the expression \( \text{DistSurv}("YourDist\_Monthly"; \_time*12) \). For the opposite conversion of an annual distribution to a monthly model time unit, use the expression \( \text{DistSurv}("YourDist\_Annual"; \_time/12) \). Additional options for the DistSurv function are specified in the Distribution Functions section of Help.

What does DistSurv calculate?

\( \text{DistSurv("Dist\_Name"; \_time)} \) returns the complement of the cumulative probability that an event has occurred at any given time. If a distribution represents progression, then DistSurv returns the probability that the progression has not yet occurred.

\( \text{DistSurv("DistributionName") = 1 - DistProb("DistributionName";\_time)} \)

Using DistSurv with LogNormal or LogLogistic distributions

If the survival function uses a LogNormal or a LogLogistic distribution, this can produce an error when using DistSurv because \( \log(0) \) is undefined.

Instead of using DistSurv("distname"; \_time) for Log Normal or LogLogistic distributions, use the following:

\[- \text{DistSurv("distname"; max(\_time; 1e-12))}\]

The use of \( \text{max(\_time; 1e-12)} \) will ensure 0 is never returned, and instead a very small number is used.

38.6.2 Survival by Kaplan-Meier Table

Survival data is often recorded (and available) as a Kaplan-Meier table of data with the proportion of patients in a state at several times. This data can be used directly in the model.

Using the Partitioned Survival Analysis Example Model, PartSA_KaplanMeierTables.trex, we represent the Survival Functions using Kaplan Meier data. The model structure is the same as in Example model described in the previous sections, with a PartSA node and two Survival Curve nodes representing PFS and OS curves.

Open the Tables View to examine the tables of Kaplan Meier data for PFS and OS. The data in the Table_PFS table shows the time in the first column (Index) and the proportion of the cohort that remains progression-free in the second column. The Table_OS table includes time in the first column and overall survival in the second. For example, in the Overall Survival State there is 1.0 (or 100%) of the cohort in the state at time 0. Later, at time 3.3 there is 98% (or 0.98) of the cohort in that health state.

The table properties are set with the lookup method truncate (as opposed to interpolate). This will generate a step-like survival curve between values in the table. The lookup method interpolate would smooth out the data by interpolating in between time values provided.

To incorporate Kaplan Meier-based Survival functions into a model:
- Create a table of Kaplan-Meier data: the first (Index) column is the times and the second column the proportion of the cohort in the given state. This information can be copied and pasted from Excel. (See the Chapter about Tables for details).
- The Survival Functions simply look up the survival data at any given time directly from the table.
  
  - **PFS node**: Table_PFS[_time]
  - **OS node**: Table_OS[_time]

Using Kaplan Meier tables for the survival function

With the table lookup referencing the keyword _time, the table data is read and applied as time within the model passes.

If the table instead showed the percentage that had left the state (say percent dead for overall survival), then the Survival Function would be \( 1 - \text{Table}_\text{Dead}[\_\text{time}] \).

### 38.6.3 Survival by Time Formula

You can also create an explicit survival function which calculates survival based on the current time value via the keyword _time. You could use this if your model's survival function does not fit a typical parametric distribution, but it can be represented by a formula. We call this a Survival Time Function, which describes exit from a health state at a given time.

*To incorporate Survival Functions as a Survival Time Function:*

Using the Partitioned Survival Analysis Example Model, PartSA_SurvivalTimeFunction.trex, we can see an example of when the proportion of the cohort in each state is described using a function.
- Create a variable in the Variable properties view that describes the time functions for each of the states in the model. In this example, examine the variables:
  - survFunc_PFS
  - survFunc_OS
  - These are both functions of time and other parameters. The functions describe the proportion of the cohort in each state with time (exactly what we need for our Survival Curve nodes).

- Enter these functions directly under the appropriate branches of the PartSA nodes:
  - PFS node: survFunc_PFS
  - OS node: survFunc_OS

Using Survival Time Function for the Survival Function

38.6.4 Survival by Hazard Function

Survival can also be defined by a Hazard function. The Partitioned Survival Analysis Example Model, PartSA-SurvVsHazard.trex includes two strategies that are nearly identical.

This model has equivalent strategies, designed to allow the comparison of the model outputs using different forms of the same Survival Function.

- The top strategy uses the Weibull distribution directly in calculating the Survival Function for the Overall Survival. Specifically, the survival function for Post-Progression is: \( \text{surv}_{OS} = \text{DistSurv}("\text{Dist\_Surv\_Overall"}) \)
- The *bottom strategy* uses a Hazard Function based on the Weibull distribution hazard function for Overall Survival. Specifically, the survival function for Post-Progression is: 

\[ \text{hazard}_{\text{OS}} = rate_{\text{OS}} \times shape_{\text{OS}} \times (\text{time}^{\text{shape}_{\text{OS}} + 1}) \].

- Both functions use the same Weibull distribution parameters, defined by variables `rate_OS` and `shape_OS`.

To incorporate Survival Functions as Hazard Functions:

- Create a variable which describes the Hazard Function. For example:
  - The parameters, as per the Example, are: `rate_OS` and `shape_OS`.
  - The variable defining the Hazard function is: 

\[ \text{hazard}_{\text{OS}} = rate_{\text{OS}} \times shape_{\text{OS}} \times (\text{time}^{\text{shape}_{\text{OS}} - 1}) \]

- Click below the Survival Curve node and enter the Survival Function, `hazard_OS`.
- Select the Survival Curve node, open the PartSA Info View. In the row where it says State Function, select the option: `Hazard Function`. 

PartSA model with Hazard function for Overall Survival (in the bottom strategy)
In this example model, the variable `hazard_OS` contains the Weibull hazard function formula. The model is designed so you can compare the use of the Weibull Distribution and the DistSurv function directly against the Weibull Hazard Function.

The ability to use hazard functions provides flexibility for use of other parameters within hazard functions to account for individual characteristics and/or treatment effects (e.g., Cox Regression models).

### 38.6.5 Survival by Kaplan-Meier and Distribution

Survival data is often recorded (and available) as a Kaplan-Meier table of data with the proportion of patients in a state given at different times. This data can be used directly in a Partitioned Survival Analysis model, as detailed in the section above.

However, after a certain period of time, it maybe necessary to use an estimate for the progression. A distribution is usually defined to represent the data going forward in time. This section defines how to combine both Kaplan-Meier and Distributions in a model.

The Partitioned Survival Analysis Example Model, PartSA-KaplanMeier_and_Distribution.trex includes a function which combines both of these.

To incorporate Survival as functions of Kaplan-Meier tables and Distributions:

- Create a table of Kaplan-Meier data: the first (Index) column is the times and the second column the proportion of the cohort in the given state. This information can be copied and pasted from Excel. (See the Chapter about Tables for details). In this model, the table `tbl_surv_PFS_KM` is for the PFS state and referenced by the variable:

```plaintext
surv_PFS_table = tbl_surv_PFS_KM[time]
```
- Create a distribution that describes survival against time. (See Distributions Chapter for details on creating a distribution). For example:
  - `Dist_Surv_ProgFree` – describes state membership in the PFS state relative to the PPS state
  - It is a Weibull distribution with parameters: `shape_PF` and `rate_PF`
- Create a variable to reference the distribution. In the example model this is: `surv_PFS_dist = DistSurv("Dist_Surv_ProgFree")`
- Create a variable to define the time at which you want Survival to switch from Kaplan Meier data to the distribution. In this example: `time_end_KM = 1`
- Create a time dependent variable which will get the Survival Function at the correct time:
  - `surv_PFS_mixed = if( _time < time_end_KM; surv_PFS_table; surv_PFS_dist/time_scale)`
  - The variable `time_scale` is used to normalise the values between the last Kaplan-Meier table entry used at `_time = time_end_KM` and the start of the first value from `surv_PFS_dist`. This eliminates discontinuity between the two calculations at the switch time.
- Click below the Survival Curve node for PFS and enter the Survival Function, `surv_PFS_mixed`.

The Survival Curve for this model will be a combination of both a step-wise function and the smoother curve from the distribution.

![PartSA Survival Curves](image)

Survival curves where the PFS function is a time dependent Kaplan-Meier and a Distribution

### 38.6.6 Survival for Mixture Cure Models and Mixture Models

Mixture Cure and Mixture models use a combination of survival functions to represent survival for a single health state.
38.6.6.1 Mixture Cure Models

In a Mixture Cure model, it is presumed that a fraction of the cohort in the Post-Progression State (PPS) are cured and only subject to risk of death by background mortality. The PPS survival function combines calculations from both background mortality and excess risk from the disease.

The elements required for Mixture Cure models is shown below.

- \( S_{\text{mixed}}(t) = S_{\text{background}}(t) \times (\text{pct}_{\text{cured}} + (1-\text{pct}_{\text{cured}}) \times S_{\text{disease\_excess}}(t)) \)
- \( S_{\text{mixed}}(t) \) is mixed overall survival
- \( S_{\text{background}}(t) \) is survival derived from background mortality
- \( S_{\text{disease\_excess}}(t) \) is survival derived from the excess risk of death from disease
- \( \text{pct}_{\text{cured}} \) is the percent of cohort that is cured

In essence, the formula breaks the cohort state membership into two groups - cured and uncured - and combines survival for those groups into a single survival function.

The Partitioned Survival Analysis Example Model, PartSA-MixtureCure.trex demonstrates this technique.

Note the following inputs of the model representing the list of required elements needed for a Mixture Cure model.

- \( \text{surv\_Mixed} = \text{surv\_Background} \times (\text{pCured} + (1-\text{pCured}) \times \text{surv\_PPS\_excess}) \)
- \( \text{surv\_Background} = \text{DistSurv}("\text{Dist\_Surv\_Background}\)"
- \( \text{surv\_PPS\_excess} = \text{DistSurv}("\text{Dist\_Surv\_PPS\_excess}\)"
- \( \text{pCured} = 0.20 \)

The mixed survival function \( \text{surv\_Mixed} \) is then placed beneath the Overall Survival node. Note that if you increase the parameter \( \text{pCured} \), the cohort will survive longer.
Be careful with Mixture Cure models.
They assume that cured people are no longer subject to disease risk.
You need to isolate disease risk from background mortality.

38.6.6.2 Mixture Models

In a Mixture model, it is presumed that the cohort in the Post-Progression State (PPS) is subject to background mortality risk from disease. The PPS state is also broken into two subgroups with different excess risk from disease.

The elements required for Mixture models is shown below.

- \( S_{mixed}(t) = S_{background}(t) \times (pct_{mix1} \times S_{disease\_excess1}(t)) + (1-pct_{mix1}) \times S_{disease\_excess2}(t) \)
- \( S_{mixed}(t) \) is mixed overall survival
- \( S_{background}(t) \) is survival derived from background mortality
- \( S_{disease\_excess1}(t) \) is survival derived from the excess risk of death from disease for subgroup 1
- \( S_{disease\_excess2}(t) \) is survival derived from the excess risk of death from disease for subgroup 2
- \( pct_{mix1} \) is the percent of cohort that is in subgroup 1

In essence, the formula breaks the cohort state membership into two subgroups that face different disease-related risk. These elements are applied in the model below.

The Partitioned Survival Analysis Example Model, PartSA-Mixture.trex demonstrates this technique.
PartSA Mixture Model

Note the following inputs of the model representing the list of required elements needed for a Mixture model.

- \( \text{surv\_Mixed} = \text{surv\_Background} \times (pMix1 \times \text{surv\_PPS\_excess1} + (1-pMix1) \times \text{surv\_PPS\_excess2}) \)
- \( \text{surv\_Background} = \text{DistSurv}(\text{"Dist\_Surv\_Background"}) \)
- \( \text{surv\_PPS\_excess1} = \text{DistSurv}(\text{"Dist\_Surv\_PPS\_excess1"}) \)
- \( \text{surv\_PPS\_excess2} = \text{DistSurv}(\text{"Dist\_Surv\_PPS\_excess2"}) \)
- \( pMix1 = 0.20 \)

The mixed survival function \( \text{surv\_Mixed} \) is then placed beneath the Overall Survival node.

In this example, the survival for those in subgroup 1 is greater than the survival for those in subgroup 2. In the model, if you increase the parameter \( pMix1 \), the cohort will survive longer because the risk for subgroup 2 is greater (higher rate) than the risk for subgroup 1 (i.e., therefore increasing the proportion of the cohort - subgroup 1 - who live longer).

38.7 Survival Curve Graph

Once the model structure is in place along with the Survival Function for each Survival Curve node, you can generate a Survival Curve Graph to plot the Survival Functions against time.

To generate the Survival Curve Graph:

- For the Partitioned Survival Analysis Example Model, PartSA-Example.trex, select the PartSA node.
- From the menu, choose Analysis > Partitioned Survival Analysis > Survival Curves.
Survival Curves for PartSA-Example.trex. We have added the states on top of the PartSA Survival Curves generated, including the implied state, Dead.

Each Survival Curve is plotted against time over the full time horizon. Since each Survival Curve represents progression from one state to the next, state membership is represented as the areas around the survival curves as annotated in the figure above.

### 38.8 Accumulating Value (Adding Costs and Utilities)

Just like in Markov models, PartSA models accumulate value (typically cost and utility) based on membership in the underlying health states. With state membership defined by the Survival Functions, we can now enter and calculate cost and utility within the model.

Rewards are added to the model using the PartSA Info View. If it is not visible, open it from the Views list in the toolbar.

The figure below shows the high level information found in the PartSA Info View for the PFS branch in the Partitioned Survival Analysis Example Model, PartSA-Example.trex.
There are five ways to accumulate rewards associated with Survival Curve nodes. These are:

- **Startup**: Accumulated initially (at \(_time = 0\)) for the proportion of the cohort in the state. These are usually costs which occur prior to or at the start of the PartSA model.

- **Continuous**: Accumulated on a continuous basis as time passes based on the state membership. The state membership is defined by the area under the curve.

- **Intervals**: These are accumulated the same as Continuous rewards, but allow different values for different intervals within the overall time horizon. For example, $10,000 cost for the first 3 years, $7,500 for the next 3 years and then $5,000 for the subsequent years.

- **Discrete Times**: Accumulate discrete rewards at specific points in time based on state membership at that time (not as it changes over time). This could be used for a cost that is paid at a specific time even if people exit the state immediately after that time. This is similar to an event based reward in a Markov model.

- **Exit**: Accumulate exit rewards as the cohort exits a state. In the above model, Exit Cost for the PFS state would accumulate as the cohort exits the PFS state and enters the PPS state.

We will refer to two examples - PartsSA-Example.trex and PartSA-Rewards.trex – to examine rewards associated with PartSA models. The Tree Preferences are set up to accumulate the rewards of Cost and Effectiveness via Payoffs 1 and 2, respectively. Tree Preferences can be set up via the Model...
Setup Wizard and you can refer to the Section on Model Setup Configuration for more details about doing this.

To enter rewards:

- Select the Survival Curve Node associated with the state where the reward is accumulated.
- Open the PartSA Info View.
- For Startup, Continuous and Exit Rewards: Enter the rewards associated with the state directly into the PartSA View.
- For Interval Rewards: Click the Edit button and setup a matrix of interval start times and the reward that begins at that time. To stop accumulation, enter the start time for ending accumulation and a value of 0.
- For Discrete Time Rewards: Click the Edit button and setup a matrix of discrete times and the rewards that are accrued at those times.
- The rewards are displayed in the PartSA Information below the node.

### 38.8.1 Startup Rewards

Startup rewards are generally used for up-front costs that occur prior to the disease progression in the PartSA model. For example, if a treatment required an initial surgery, that cost should be paid at the beginning of the time horizon, presumably by everyone.

Startup rewards are accumulated at _time=0 only for the percentage of the cohort in each state. For a typical PFS and OS model, nearly everyone would be in the PFS-related state.

In the model PartSA -Rewards.trex, the variable `cStartup_Surgery` represents the cost associated with a surgical procedure that occurs prior to the PartSA model disease progression (at _time 0).
Startup reward associated with a prior cost accumulated at PFS node. (PartSA-Rewards.trex)

### 38.8.2 Continuous Rewards

Continuous rewards accumulate value on a continuous basis over time.

In the PartSA-Example.trex example model, cost for the PPS state and effectiveness in both states are accumulated as continuous rewards.

These costs are accumulated based on continuous time based on the proportion of the cohort in PPS. The cost is given by the variable cPostProgress.
Continuous cost reward associated with the PPS State as highlighted

The reward is accumulated based on the area under that curve, which represents state membership over time on a continuous basis. The area under the curve is multiplied by the reward, as detailed in the State Report.

Continuous rewards can also be non-fixed. By referencing the keyword _time, a formula can change as time passes.

The example model PartSA-FormulaVariableCost.trex contains a formula for the cost (Cost_PF) related to the PFS curve:

- \( \text{if}(_\text{time}\leq \text{chg\_cost\_time}; \text{cost\_early}; \text{cost\_late}) \)

By referencing _time, that expression would accumulate cost with the value cost_early for the first part of the time horizon and with the value cost_late after the chg_cost_time has passed. Any kind of expression related to _time can be used here. Note the example above could also be handled more easily using the Intervals Rewards described below.
38.8.3 Intervals Rewards

Interval rewards accumulate value on a continuous basis, but using different calculations for different portions of the time horizon.

In the example model PartSA-Rewards.trex, the cost for PFS state is accumulated using Interval rewards.

Select the appropriate state and in the PartSA Info View and click the Edit button next to the label Intervals. this will open a dialog where you can add/edit/delete rows in the time/reward grid.

In PartSA-Rewards.trex, the cost for the PFS state is accumulated with different values for 0-3, 3-6 and 6-and-after years.

Select the Edit button next to the Intervals and add/delete/re-order the times and values as required in the Edit Interval Table.
With the entries above, Cost Interval rewards are accumulated as `cPFS1_First_3years` (10,000) for the first 0-3 years, `cPFS2_Second_3years` (7,500) for the next 3 years and `cPFS3_After_6years` (5,000) for the subsequent years.

### 38.8.4 Discrete Times Rewards

Discrete Times rewards accumulate value at specific points in time. Most commonly, these are used for costs that are accrued based on state membership at that specific time, regardless of what happens before and after that time.

In the example model `PartSA-Example.trex`, the PFS state has costs associated with Chemotherapy which are Discrete Time rewards. These costs happen at specific points in time, that is, once a month for the first 6 months. The costs are accumulated at the time of treatment and take into account the proportion of the cohort at that specific time only. The cost is given by the variable `cChemo_monthly`.

To add Discrete Time Rewards, click the Edit button at the Discrete Time level to open the Edit dialog and add/sort/delete rows from the table of discrete times and value calculations.

In the `PartSA-Example.trex` model, Discrete Time rewards are accumulated for the PFS state.
38.8.5 Exit Rewards

Exit rewards are accumulated as the cohort leaves a state and enters the next sicker state (or implicit Dead state).

In the Partitioned Survival Analysis Example Model, PartSA-ExitCost.trex, there is a cost \( c_{\text{Progress}} \) which accrues as the cohort exits the PFS state and enters the PPS state. If there was a cost associated with death, then you would enter an Exit Cost for the PPS state (because the next state is the implicit Dead state).

To enter Exit costs, first select the state where there is a reward associated with leaving one state and entering the next state. Then enter the appropriate expression for the reward in the PartSA Info view.
under: Rewards > Cost > Exit. The figure above shows where \( c\text{Progress} \) is entered. (This is the same process for any Rewards).

This model is set up to give an example of how to review the Exit Costs separately to the (Overall) Costs. The model includes a third payoff which only accumulates the Exit Costs. The figure below shows the Tree Preferences where you can see: Payoff 1 accumulates to overall cost; Payoff 2 accumulates the utility; Payoff 3 accumulated exit cost (only).

Tree Preferences are used to set up additional payoffs. Then the PartSA Info View is used to accumulate the payoffs. Once the rewards are set up you can create the Time reports to see that the exit cost is applied only to cohort exiting the PFS state.
38.9 PartSA Analysis and Reporting

Partitioned Survival Analysis calculates the overall cost and effectiveness generated from all the health states over the time horizon. These values might be used to perform cost-effectiveness analysis to choose the optimal strategy.

The Analysis options available via the Analysis > Partitioned Survival Analysis submenu are presented below.

- **Survival Curves**: Generate the survival curves based on the Survival Functions in the model showing the proportion of the cohort in each state with time. (See the Survival Functions for details).
- **State Report**: Report gives the total area under each curve including the rewards accumulated in each state, in this case Cost and Effectiveness.
- **Time Report**: Splits continuous time up into discrete time steps and reports the proportion of the Cohort in different health states (according to the model). It allows the modeler to check for accumulation of rewards and the proportion of the cohort in each state, as time passes.
- **Crossovers**: This report provides details of the crossover of one curve over another, where and by how much. There are no crossovers in this model. (See the Crossover section for more details).

**Roll Back**

When the model is rolled back, the total amount of Cost and Effectiveness accumulated are shown in boxes within the tree. At each Survival Curve node, you will see the amount accumulated by that state. At the PartSA node, you will see the total for the entire PartSA model. The area under the curve for each state is shown under the Survival Curve node.

**State Report**

Rollback on PartSA-Example.trex showing Cost and Effectiveness accumulated. The State report is also show below, with Cost, Effectiveness and Area under the Curve per State.
The State Report also includes the values by state and overall in a text report as well as the area under the curve (state membership).

<table>
<thead>
<tr>
<th>State</th>
<th>Area under the curve</th>
<th>Cost</th>
<th>Eff</th>
</tr>
</thead>
<tbody>
<tr>
<td>Progression-Free State</td>
<td>4.22324</td>
<td>575766.84</td>
<td>3.4010</td>
</tr>
<tr>
<td>Post-Progression State</td>
<td>1.81286</td>
<td>38123.89</td>
<td>2.0687</td>
</tr>
<tr>
<td>(Dead)</td>
<td>1.86407</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>10.00000</td>
<td>613076.53</td>
<td>6.5596</td>
</tr>
</tbody>
</table>

State Report

The two states of PFS and PPS are explicitly included in the model within the Survival Curve node. The State Report also provides information about an additional implicit state, Dead, representing the remaining cohort outside of overall survival.

Note that if global discounting were on, the State Report would present both undiscounted and discounted values.

Time Report

The Time Report breaks down the overall time horizon into shorter time periods (annual or monthly which you set in the PartSA Info View), providing more visibility and transparency related to the movement of the cohort and the accumulation of value with time.

- **Start and End Time**: The start and end of each time period based on the interval size you selected earlier for Time Reports (Annual or Monthly).
- **Start % and End %**: This gives the proportion of the cohort in each state at the start and end of each time period. This allows you to validate the accumulation of rewards based on the proportion of the cohort in that state over time.
- **Area under the Curve**: For the given time period, the total area under the curve for each health state. This represents time spent by the cohort in each state during the period.
- **Cost, Eff and other payoffs**: The accumulation of rewards during the time period by state (also cumulative).
Time Report highlighting: Time Interval; Area under the Curve; Cost and Effectiveness.

The secondary graphs for Cost and Eff by time are shown below.

Cost and Eff accumulation over time (from the Charts in the Time Report as above)

Note that most of the cost is accumulated in the first few months from the monthly chemo cost while utility is accumulated continuously.

Setting preferences

There is a link to edit the Tree Preferences for PartSA models at the top of the PartSA Info View when you have selected the PartSA node.
Edit the Tree Preferences, by selecting the link from the PartSA Info View.

Settings you can edit for PartSA models via Tree Preferences include:

**Time Units:**
- Set the Survival time unit and the Time report unit.
- Set the integration step.
- Set the default time horizon.

**Survival curves graph:**
- Set the graphing steps: Number of graphing steps will determine how smooth a curve will be drawn.
- Show parameters dialog: Use this to stop the pop-up window (asking for number of graphing steps) appearing every time you draw a Survival Curve.

**Calculating the Area Under the Curve**
TreeAge uses differential equation solver technology which has been around for over 50 years. Integration is done using a class of algorithms called Runge-Kutta. The software represents the survivor function in the form of differential equations and solves efficiently. The integration step size default is 1/360 of a year.
38.10 PartSA and Other Analyses

PartSA models within can take advantage of other analyses within TreeAge Pro - cost-effectiveness analysis, sensitivity analysis, etc. Note that PartSA models are by their nature cohort-level models, so you cannot run Microsimulation.

38.10.1 Cost-Effectiveness Analysis

We will use the Partitioned Survival Analysis Example Model PartSA-Decision.trex to demonstrate PartSA models for decision analysis via cost-effectiveness analysis (CEA).

PartSA Decision Model

The model above is based on the PartSA-Example.trex model we looked at earlier in detail. However, this model has a decision node with two strategies. The second strategy is a clone of the first one. Two parameters differ between the strategies - the rate/distribution for the PFS state and the cost of chemotherapy.

You can run the PartSA graphs and reports at either PartSA node, but we will focus on CEA. To run CEA, select the Decision node then Analysis > Rankings.

Cost Effectiveness Rankings Report for PartSA-Decision.trex
The cost and effectiveness for the first strategy are 613870.53 and 6.5596, respectively, just as they were for the earlier example model. However, the second strategy has a higher cost and a higher effectiveness, reflecting the higher chemotherapy cost and the lower rate of progression from PFS.

### 38.10.2 Sensitivity Analysis

You can also run all forms of sensitivity analysis on PartSA models - including 1-way, tornado, probabilistic, etc. We will not examine all of these here as those techniques are described in detail in other chapters. (Deterministic Sensitivity Analysis and Probabilistic Sensitivity Analysis on CE models.) We will, however, run a tornado diagram here.

The following ICER tornado was generated with simple 5% adjustments above and below the base case values for 6 of the parameters.

**PartSA ICER Tornado Diagram for PartSA-Decision.trex**

Note that to run probabilistic sensitivity analysis (PSA), you would need to add parameter distributions to the model.
38.11 Three-State PartSA Model

PartSA models are not limited to two Survival Curve nodes. Your model could have three or more Survival Curve nodes. The Partitioned Survival Analysis Example Model PartSA-3State.trex is shown below.

**PartSA-3State model**

The three Survival Curve nodes each represent a living state, along with the implicit Dead state. The Survival Curve graph from this model is presented below.
Note that you could use a three state model to handle a situation where treatment for the Progression-Free state may continue beyond actual membership in that state. The middle curve could use the cost for the Progression-Free state, but the utility for the Post-Progression state. Potentially, the cost calculations for continuation of treatment could be some combination of PFS and PPS costs.

### 38.12 Survival Curve Crossovers

Survival Curve nodes imply an order of progression from healthier to sicker states, ending in the implicit Dead state. The Survival Functions generally should not cross, but let’s examine what happens when they do cross in the Partitioned Survival Analysis Example Model PartSA-Crossover.trex. The Survival Curve graph for that model is shown below.

![PartSA Survival Curves](image)

**PartSA-Crossover.trex model Survival Curve graph**

Note that the Overall Survival crosses over the Progression-Free Survival curve at time 10.719. This is actually impossible as you cannot have part of the cohort in the PFS state and dead at the same time.

At this point, you would probably want to examine your survival analysis to see if you have parameterized the Survival Functions appropriately. However, if you have a very small crossover, you can choose to ignore it and treat the OS survival curve as primary. What this means is that membership in the PFS state would be cutoff by the OS curve and no one would be in the PPS state from time 10.71 to time 15 (end of time horizon).

To allow for small crossovers, there is an option in the PartSA Info View with the PartSA node selected.
Crossover Options

If you select the option Stop Analysis, then the analysis will not continue when the crossover is found. However, if you select the option Push Downstream, the less healthy state will override the more healthy state for the crossover area. Let's examine some reporting output related to crossovers. Choose Analysis > Partitioned Survival Analysis > Crossover Report to see the impact of the crossover.

**Crossover Report**

The report indicates that from time 10.712 to time 15, a portion of the area under the PFS Survival Curve was lost to the implicit Dead state because the OS curve crossed over and superceded the PFS Survival Curve. This resulted in a loss in cost of 94.16 and loss in effectiveness of 0.0847. If these adjustments are small enough, it may be reasonable to continue with the analysis results as adjusted above.

A secondary result of this adjustment is that there will be no one in the Post-Progression state after the crossover time as seen in the time report below.
38.13 Converting a PartSA model to a Markov model

While PartSA models have their strengths, you may find that this technique cannot fully handle the complexity of disease progression. You may instead need to expand to separate health states and events supported by Markov models. If so, you can convert a PartSA model into a Markov model at the click of a button.

The process converts the PartSA structure into a tradition Markov model with Health States and Transitions. Based on the PartSA model, with healthier "states" at the top, the Markov model is constructed with progression from more healthy to less healthy/dead states.

We will use the Partitioned Survival Analysis Example Model PartSA-Example.trex to demonstrate.

To convert the model:

- Right click on the PartSA node and select "Convert to Markov".
- Choose either complex or simple transition probability formulas. For this example, choose complex.

The figure below shows the converted model.
The Markov model contains the following elements:

- A straightforward Markov structure with the original states from the PartSA model as well as the explicit Dead state.
- The original variables and distributions from the originating PartSA model.
- Complex transition probabilities mimicking the PartSA state membership behavior. The transition probabilities are based off the underlying survival functions. The complex conversion front-loads transitions to better mimic the PartSA results. The simpler transitions just use the survival functions.
- Continuous rewards from the PartSA model (note that other reward types are not converted, so the Chemo cost is lost and would have to be added manually).

The figure below compares the PartSA model's survivor curve to the Markov model's survivor curves generated from the Markov Cohort report.
Note that the converted Markov model should not be considered complete. It is a starting point for a representative Markov model. Complex transition probabilities attempt to replicate state membership from the original PartSA model. That does not mean that those transition probabilities are correct. You need to examine the transition probabilities to fit appropriately within the new Markov context. For example, the transitions to states further downstream (PFS to Dead) are set to zero by default. This is probably not appropriate. The simpler transition probabilities will not match the original PartSA results as well, but they may still be a better place to start since transition probabilities will need adjustment.

### 38.14 Generating PartSA Survival Curve from a Markov Model

You can generate Survival Curve outputs from a Markov model for validating back to survival data. This is explained in detail in the Building a Markov Model Chapter.
39. Markov to Excel Conversion

This feature allows the conversion of a TreeAge Pro Markov cohort model to a working stand-alone Excel model with a single mouse click. The Excel model contains editable model inputs for Markov cohort analysis with full transparency. You can then share the Excel model with a person who does not have a TreeAge Pro license and/or is not familiar with the software.

Note that this is not a standard software feature included with all licenses. Click here to review eligibility requirements.

39.1 Capability Overview

You can convert a TreeAge Pro Markov cohort model to a working stand-alone Excel model with a single mouse click. The Excel model contains editable model inputs which immediately change the model analysis calculations within Excel.

The Markov cohort output within the Excel model provide full transparency, including cohort flow through all states and events, and the impact of each state and event on your model outcomes. The results from each strategy are then summarized to compare treatment strategies within the Excel workbook.

Note that this is not a standard software feature included with all licenses. Click here to review eligibility requirements.

The Excel workbook provides you with:

- The ability to share a model with another person who has Excel and/or is not familiar with the software.
- An easy way to share and receive feedback using the converted Excel model, but then having the flexibility and convenience in making those changes quickly and efficiently in TreeAge Pro, rather than having to make the changes directly in Excel.
- The ability to quickly and easily validate an Excel model that is received as part of a submission or otherwise. Rebuild the model using TreeAge Pro, and then convert it to Excel to compare the models like-for-like in Excel.

There will be advanced features and analyses available in TreeAge Pro that cannot be converted to the Excel model. The conversion is only for cohort models, not microsimulation models. Click here for a summary of TreeAge Pro features supported by the conversion tool.

The model types which can be converted include:

- A single Markov model within a larger TreeAge Pro model; and
- A decision tree with two or more strategies that are each a single Markov model.
Converting a supported model will create a stand-alone Excel workbook with a number of worksheets. The model outputs are calculated based on formulas which are embedded in the workbook. These formulas can be reviewed and edited directly in each cell. The TreeAge Pro parameters are converted directly to an Inputs worksheet within Excel. When model inputs are updated the Excel model will recalculate the model outputs and summary sheets.

### 39.2 Convert a Markov Decision Tree to Excel

#### 39.2.1 Introduction to the model

We will use the Health Care Tutorial Example, Markov Conversion Model.trex. This model is a cancer decision model for comparing two treatment strategies, Tx 1 and Tx 2, using cost-effectiveness analysis. Each treatment strategy is represented by a single Markov models, with Tx 2 reusing the Markov structure from Tx 1 via a cloned subtree.

The Markov model has three health states - Local Cancer, Metastases and Dead. The two treatments use different values for the following elements of the shared Markov model structure:

- the cost of the Treatment for Local Cancer;
- the probability of transition from Local Cancer to Dead; and
- the probability of transition from Local Cancer to Metastases.

Each of the Markov Models can be evaluated separately by Markov Cohort Analysis, and the decision tree can also be evaluated using cost-effectiveness analysis.

> You could use a model with more than two treatment strategies to convert to an Excel model. The requirement is that each strategy consists of a single Markov model. The termination condition must be of the format: _stage = The_termination_condition.

#### 39.2.2 Convert the model

In this example, we will convert the whole model including all enabled payoff sets.

*Convert the Markov model:*

- Select the Decision node.
- There are three different menu options to convert the model:
  1. Choose File > Import/Export > Convert Markov Tree to Excel Model, or
  2. Choose Tree > Convert Markov Tree to Excel Model, or
  3. Select the toolbar icon Convert Markov Tree to Excel Model
- The options are presented to add some comments to your converted model. This includes:
- Model description
- Strategies’ descriptions
- Conversion option to show strategies in a single sheet (checked) or a separate sheet for each health state (unchecked). We will proceed with this chapter with the full version by leaving the box unchecked.

Markov to Excel conversion options

To change preferences to remember the conversion options selected for future models, set and change options in Application Preferences. To do this:

- Select Window > Application Preferences.
- Navigate to General > Markov To Excel Conversion.
- Observe the dialogoue as per the figure below and select preferences.
The Structure of the Workbook section provides details about all the sheets in the workbook. If the model has been converted as a Single Sheet per Strategy, details can be found below in the section: State details - Single Sheet per Strategy.

If the conversion is successful, a window will appear advising where the model was saved and asking if you want to open the model now. Click Yes.

The Excel model will be saved to the same folder that holds your original TreeAge Pro Markov model. The file name will be the same as your model with “-TreeModel.xlsm” added to the end. If you convert the model multiple times, a sequence number will be added to the filename.

Excel workbook of the converted model Markov Conversion Model.trex, saved in the same folder as the model

The Excel model will then open and you may need to do the following:

- Enable macros to run in the Excel model. If your Excel settings do not allow Macros to run without confirmation, you will be prompted to Enable Content in a Security Warning. Without enabling macros, the model likely will not be able to perform all required calculations.
- Resize any column width in the first Model Results sheet. This is sometimes required to get the calculated cells to display correctly.

If you have a different model structure, you can select a single Markov Model for the conversion, then follow the same steps as listed above.

39.2.3 Choose Payoffs to Export

If you do not want all payoffs exported, select payoffs to export as follows:

Choose payoffs to Export

- Open Tree Preferences > Calculations > Payoffs > Markov to Excel Payoffs.
- Select which Payoffs to export to the Excel model. The default is all selected.
- Apply and close.
39.3 Structure of the Workbook

The Excel model recreates everything in the TreeAge Pro model required for calculation. The following table provides a cross-reference between each element of the Excel model and its equivalent within the TreeAge Pro model.

<table>
<thead>
<tr>
<th>Excel model</th>
<th>TreeAge Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs &amp; Results</td>
<td>Variable Properties and Distributions View</td>
</tr>
<tr>
<td></td>
<td>Ranking report and CEA graph</td>
</tr>
<tr>
<td>1. Strategy Calcs (for each strategy)</td>
<td>Markov Cohort Analysis Extended Report (for each Markov model)</td>
</tr>
<tr>
<td></td>
<td>Markov Probability (State Prob) Analysis graph</td>
</tr>
<tr>
<td>State Trans Diag</td>
<td>Image of TreeAge Pro State Transition Diagram</td>
</tr>
<tr>
<td>Input Tables</td>
<td>Tables View</td>
</tr>
<tr>
<td>Original Data and Results</td>
<td>Restore: Set the Excel model back to its initial values when exported from TreeAge Pro.</td>
</tr>
<tr>
<td>(including option to Restore original model inputs)</td>
<td>Original model inputs as on Variable Properties and Distributions Views</td>
</tr>
<tr>
<td></td>
<td>Rankings report</td>
</tr>
<tr>
<td>1.1 State Details (for each strategy and state)</td>
<td>Markov Cohort Analysis Extended Report</td>
</tr>
<tr>
<td>For Single Sheet Export option, the State Details are consolidated into a Strategy Results sheet</td>
<td></td>
</tr>
</tbody>
</table>
### Excel vs TreeAge

The remainder of this section will describe each Excel worksheet in more detail.

#### 39.3.1 Inputs & Results

This sheet provides the main model inputs and results. In this example model, this includes:

- **Model description**: As completed when converting the model, any information about model description and strategies is shown here.
- **Inputs**: Data from the Variable Properties View and from the Distributions View.
- **Restore Original Values**: This button will restore the original values (as in the Inputs table) to the Excel model, resetting the original model values.
- **Results**: Two tables, one with the results from least to most costly, the other ranking the results considering dominance with ICER and NMB calculations. The CEA graph is displayed below the table.
Inputs & Results from the Excel workbook

**Inputs**

The figure below specifically shows the section of the Input & Results worksheet highlighting the input parameters.

The values in the green cells can be edited. They are named cells used in formulas within the Excel model's cohort analysis worksheets. You can change any input highlighted in green to generate new results for the Excel model.

Each input has a Reference in TreeAge which is either the variable name or the distribution, depending on its original input type in the TreeAge Pro model.

Distributions are presented with their mean values as the input value. That is consistent with the use of distribution means in TreeAge Pro when not sampling distributions during Monte Carlo Simulation.
Input parameters (zoomed in) from the Inputs and Results worksheet

Model Results

In the Inputs and Results worksheet, there are model results. There are three main sections:

1. Table with the model results, including the option to edit the Willingness To Pay (WTP) in green.
   The expected values for each strategy sorted from least costly to most costly. The expected value for the active payoffs (cost and effectiveness for a CE model) are displayed first, followed by additional payoffs if enabled via Tree Preferences.
2. Table with the ranking results. The table accounts for dominance among strategies, and places dominated strategies at the bottom. Incremental cost-effectiveness ratios (ICERs) and net monetary benefits (NMB) columns are included in this table as part of a more robust presentation of cost-effectiveness results.
3. Cost Effectiveness Analysis graph, generated from the values in the tables.

The WTP is an editable field (green) which will change the NMB for the model (further information in NMB versus WTP section). At a given WTP, the most cost-effective strategy will always have the highest NMB value, regardless of dominance.

Below is the Rankings Report generated from TreeAge Pro. This can also be found in the Original Data & Results sheet of the workbook. It should be noted that when you first export the model to Excel the TreeAge Rankings report should match the results in the second table. At any time, you can compare the Current versus Original Excel Results versus Original TreeAge Pro Results in the Original Data & Results worksheet (see section below).
Rankings report for the same model from TreeAge Pro

Below is a simple example of changing the model inputs in Excel to demonstrate how the model outputs change and how the Excel model is dynamic.

**Example: Changing model inputs to impact model**

This example is to show how changing model inputs recalculates the model results dynamically.

1. Before we change inputs, review worksheet 2.1 *State Details*, to see details about Strategy 2 (Tx2) and Health State 1 (Local Cancer). Note that in the Cycle 0 row in the column labeled Payoff 1 – Cost/1.1 State/Local Cancer, the calculated value for the cell is 11000, which is ½ of the cLocal2 parameter cost to account for half-cycle correction.
2. In the *Inputs & Results* sheet, review the current value: ICER = 32,653.
3. In the *Inputs & Results* sheet change the cLocal2 parameter value from 22000 to 24000.
4. Return to the sheet 2.1. *State Details*. Observe that the value in the same cell has changed from 11000 to 12000 (half the new cLocal2 value).
5. In the *Inputs & Results* sheet, review the current value: ICER = 46,652. (You could also review the cost of Tx2 which has also changed).
2.1 State Details with original value of cLocal2 = 22000

Inputs & Results worksheet showing the recalculated results, ICER = 46,652, when cLocal2 = 24,000
39.3.2 Strategy Calcs

The *Strategy Calcs* worksheets show the Markov Summary report for each treatment, i.e. Strategy 1 results on worksheet 1, *Strategy Results*. This is a summary of overall cohort flow among states and accumulation of outcomes by cycle. It does not contain details of how the cohort flows among events or how outcomes are accumulated at specific states and events. Those details are on the *Strategy Details* worksheets.

Note that if you choose to show strategy results on a single sheet, this sheet will also include all the calculations related to health states and events for the Markov process. This chapter describes a conversion without that selection, so state/event details are in a separate section later in this chapter.

At the left of each sheet, before the results is a Markov Probability (state probability) graph. This is generated dynamically from the results in the Strategy Results worksheet.

The *Strategy Results* worksheet is broken down into three sections:

- **Cycle**: Presents each cycle in the model as the _stage keyword increments.
- **Cohort State Proportions**: Presents the proportion of the cohort that starts each cycle in each health state.
- **Payoffs**: Presents the total value of each model outcome (enabled payoff) accumulated during each cycle

<table>
<thead>
<tr>
<th>Cycle</th>
<th>Local Cancer</th>
<th>Metastases</th>
<th>Dead</th>
<th>Payoff 1 - Cost</th>
<th>Payoff 2 - Effectiveness</th>
<th>Payoff 3 - Prog to Metastases</th>
<th>Payoff 4 - Local Cancer Death</th>
<th>Payoff 5 - Metastases Death</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0.10489648</td>
<td>0.387751</td>
<td>0.508</td>
<td>0.475</td>
<td>0.1489648</td>
<td>0.0198625</td>
<td>0.0198625</td>
<td>0.0198625</td>
</tr>
<tr>
<td>1</td>
<td>0.08243706</td>
<td>0.376879</td>
<td>0.540</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>2</td>
<td>0.07915092</td>
<td>0.373816</td>
<td>0.547</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>3</td>
<td>0.07259092</td>
<td>0.368816</td>
<td>0.552</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>4</td>
<td>0.07019092</td>
<td>0.366816</td>
<td>0.554</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>5</td>
<td>0.06869092</td>
<td>0.364816</td>
<td>0.556</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>6</td>
<td>0.06729092</td>
<td>0.362816</td>
<td>0.558</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>7</td>
<td>0.06599092</td>
<td>0.360816</td>
<td>0.560</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>8</td>
<td>0.06479092</td>
<td>0.358816</td>
<td>0.562</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>9</td>
<td>0.06359092</td>
<td>0.356816</td>
<td>0.564</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>10</td>
<td>0.06239092</td>
<td>0.354816</td>
<td>0.566</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>11</td>
<td>0.06119092</td>
<td>0.352816</td>
<td>0.568</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>12</td>
<td>0.06009092</td>
<td>0.350816</td>
<td>0.570</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>13</td>
<td>0.05899092</td>
<td>0.348816</td>
<td>0.572</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>14</td>
<td>0.05789092</td>
<td>0.346816</td>
<td>0.574</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>15</td>
<td>0.05679092</td>
<td>0.344816</td>
<td>0.576</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>16</td>
<td>0.05579092</td>
<td>0.342816</td>
<td>0.578</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>17</td>
<td>0.05479092</td>
<td>0.340816</td>
<td>0.580</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>18</td>
<td>0.05379092</td>
<td>0.338816</td>
<td>0.582</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>19</td>
<td>0.05279092</td>
<td>0.336816</td>
<td>0.584</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
<tr>
<td>20</td>
<td>0.05179092</td>
<td>0.334816</td>
<td>0.586</td>
<td>0.12273234</td>
<td>0.0134634</td>
<td>0.0253792</td>
<td>0.0253792</td>
<td>0.0253792</td>
</tr>
</tbody>
</table>

Strategy results for Strategy 1 (Tx1) showing cycle, cohort state proportions and enabled payoffs
The totals for each outcome/payoff at the end of the time horizon are given at the bottom of each payoff column, providing the cumulative value for each payoff. These cumulative values are the total expected values for each outcome, and they are presented again in the Inputs & Results worksheet.

The cumulative payoff values in 1.Strategy Results (figure above) are incorporated in the Model Results worksheet (bottom worksheet).

If Global Discounting is turned on in the Markov model, there will be an additional worksheet called Global Discounting. The Strategy Results worksheet will have additional columns stating if the payoffs have been discounted or not. The figure below shows the additional details included in the worksheet and more details can be found in the Time Discounting section of this chapter.
Validating the Strategy Results

To validate the Excel Strategy results with TreeAge Pro:

1. Select a strategy to validate, for example choose the first strategy, Tx 1.
2. In TreeAge Pro, select the Strategy 1 Markov node.
3. Choose Analysis > Markov Cohort > Basic Report from the TreeAge Pro menu (see Markov Reports for more details). You should see the same accumulation of outcomes by cycle in the Summary lines within the report.
4. For output even closer to the Excel strategy summary output, click on the Summary Report link to the right of the Markov Basic Report output.

The Summary report can be directly compared to the worksheet 1. Strategy Report. The TreeAge Pro report uses _stage as the column heading compared to cycle in the Excel worksheet. The meaning is the same. The payoff columns are equivalent between the reports, noting that the Summary report maintains a cumulative totals column for each payoff too.

For example, compare the Cost and Effectiveness in cycle (_stage) 9 and observe:

- Cost: 23180 (to 0 decimal places)
- Effectiveness: 0.52 (to 2 decimal places)

To change the number of decimal places in the TreeAge Reports see how to change the Numeric Formatting. This will give you a comparison with the same decimal points.

39.3.3 State Transition Diagram

This provides the equivalent State Transition Diagram for the Markov models which have been converted. Note that this is a simpler “bubble diagram” presentation of patient flows within the Markov model.

If the model contains clone masters and copies, the worksheet will just display a State Transition Diagram for the clone master.
39.3.4 Input Tables

Any tables in the model will be presented within this worksheet, with the details of the TreeAge Pro table name above the data. In this model there is only one table hence only one table worksheet.

In any of the tables on the Input Tables sheet, you can edit the table values highlighted in green. We recommend against editing the table index entries highlighted in red as this could impact formulas within the Excel workbook.

In this example model, the table is interpolated between rows to calculate the missing values of Death from Background Mortality for missing ages. In the Excel workbook, there is a macro which re-creates the same interpolation.

Please note table lookups in Excel require macros to be enabled.

39.3.5 Original Data & Results

The Original Data & Results worksheet provides:

- The original model inputs from TreeAge Pro when the model was converted.
- Current Model Results based on the inputs within the Inputs & Results spreadsheet. These will change as the Excel model inputs are changed.
- Original Model Results from Excel, giving the values when the model was converted.
- Original Model Results from TreeAge, giving the results as calculated in TreeAge when the model was calculated.
- Restore: This will restore the original values (as in the Inputs table) to the Excel model, resetting the original model values.

The results from the Original Model Results tables should match when the model is converted and they should not change as the inputs are updated.

### 39.3.6 State Details

The *State Details* worksheets presents additional cohort analysis details to provide complete transparency of all calculations in the analysis. This report shows a complete cohort trace through every health state and event in every cycle.

Each worksheet name is of the format: *X.Y State Details*. This indicates *X* is the Strategy number and *Y* is the Health State. In our example model we have six *State Details* worksheets for the combination of 2 strategies and 3 health states. The Health States are numbered based on their order from top to bottom from the Markov node.

The *Strategy Details* worksheet is broken down into three sections:

- **Cycle**: Presents each cycle in the model as the _stage keyword increments.
- **Cohort State/Event Proportions**: Presents the proportion of the cohort that passes through each node. For each health state, this is the cohort percentage that starts each cycle in that health state. For transition subtree events, that is the cohort percentage that passes through the event node.
- **Payoffs**: Presents the total value of each model outcome (enabled payoff) accumulated during each cycle broken down by its source node – health states and/or transitions
1.1 State Details showing the cohort movement for Strategy 1 (Tx1) and Health State 1 (Local Cancer)

The rest of this section will look validation and explanation of the reports and will focus on Strategy 1 (Tx1) considering the first Health States (Local Cancer).

Validating the State Details Report

In this example model, there are three health states. Details from each are represented by a different worksheet:

- 1.1 State Details: Strategy 1 and Local Cancer
- 1.2 State Details: Strategy 1 and Metastases
- 1.3 State Details: Strategy 1 and Dead

All the details from these worksheets can be found in TreeAge Pro on the Markov Extended Report, which can be generated as follows:

1. In TreeAge Pro, select the Strategy 1 Markov node (Tx1).
2. Choose Analysis > Markov Cohort > Extended Report from the TreeAge Pro menu. The Extended report is a detailed version of the Markov Basic Report. You should see the same accumulation of outcomes by cycle in the Summary lines within the report.
3. Using the ‘+’ expansion buttons in the Stage column of the Extended report, expand out the rows in the first cycles to see the details of the cohort movement between the Health States and Transitions. The cohort movement is described in detail in Markov Reports.

Compare the 1.1 State Details worksheet to Markov Extended Report. The transitions in the Local Cancer State are detailed in the Cohort % columns in the 1.1 State Details worksheet. The same cohort
movement is shown in rows on the Markov Extended report (see the figure below). The figures will be described in more detail to show how to validate both the reports.

Markov Cohort Extended Report for Strategy 1 (all Health States)

First, examine the information in the 1.1 State Details worksheet. The column headings describe the following:

- 1.1 is the Local Cancer state. Any transition from this state will start with 1.1.X
  - 1.1.1 Survive Background Mortality. Any transitions from Survive Background mortality will start 1.1.1.X
    - 1.1.1.1 Stay here, i.e. remain in Local Cancer
    - 1.1.1.2 Progress to Metastases, i.e. transition to Metastases
    - 1.1.1.3 Die, i.e. transition to Dead
  - 1.1.2 Die from Background Mortality. There are no transitions from Die from Background Mortality.
The Extended Markov Report has the advantage that all Health States and Transitions are displayed on one report. For example, in stage 0 the report shows the proportion of the cohort who starts in each of the Health States (Local Cancer, Metastases and Dead) and then, of those who start in a Health State, where they transition to, shown by the rows directly below each health state.

In the State Details worksheet for Local Cancer (1.1 State Details) consider the cohort in cycle (stage) 0. The movement of the cohort is as follows (to 3 decimal places):

- Start in Local Cancer: 1.0
  - Survive background mortality: 0.993
  - Die from background mortality: 0.007

- Of those who survive background mortality (0.993):
  - Stay here: 0.824
  - Progress to metastases: 0.149
  - Die: 0.020

Based on the proportion of the cohort in each state and transition, payoffs are accumulated.
For example, in Local Cancer in _stage (cycle) 0, there are two contributions to Cost (half-cycle corrected):

- Local Cancer (State Reward): $1.000 \times c_{\text{Local1}} \times 0.5 = 1.000 \times 20000 \times 0.5 = 10000$
- Progress to Metastases (Transition Reward): $0.149 \times c_{\text{Progression}} = 0.149 \times 1000 = 148.969$
- State Cost total = $10000 + 148.969 = 10148.969$

These calculations can be seen as formula within the cells in the 1.1 State Details worksheet by selecting any cell.

In this given example of 1.1 State Details report, the State/Trans column provides the total payoffs for the cycle if the payoff total is derived from state and transition components (in the case of Cost). In the case of payoffs such as Progress to Metastases, there is only one source so only one column.

If your model has tunnels, refer to the section Tunnels in Excel Models for more details about interpreting the Excel worksheets associated with tunnel states.

If your model uses the Within-Cycle Correction method, refer to the section WCC in Excel Models for details about validating the Excel workbook with TreeAge Pro.

39.3.7 State details - Single Sheet per Strategy

In the two previous sections, the Strategy Calcs and State Details worksheets presented Markov calculation data on separate worksheets by default. You can instead choose to combine the strategy results in a single worksheet by choosing the conversion option "Single Sheet per Strategy". For this model, the results are then presented in two worksheets, one for each strategy.
The first section of the Single Sheet Strategy results show the Markov Summary report for each strategy. This is a summary of overall cohort flow among states and accumulation of outcomes by cycle. It does not contain details of how the cohort flows among events or how outcomes are accumulated at specific states and events. Those details are then provided in further columns to the right-hand side. Details about these results can be found in the above sections: Strategy Calcs and State Details.

### 39.3.8 Time Calcs

The Time Calcs worksheet displays any values included in the model which change by cycle for each Strategy. In our model, two values are dependent on the cycle (_stage):

- age: a function of the start_Age and _stage; and
- pDeathBackground: the probability of death from background mortality which is drawn from a table referenced by age. Again, age is a function of _stage.

Any value in the model which references _stage (time dependent) would also be displayed in the same worksheet in a separate column.

![Excel sheet showing Time Calcs](image)

Time dependent inputs from the Variable Properties in TreeAge Pro (right-hand side) and the Strategy Time Calculations in the worksheet (on the left-hand side)

There is only one Excel worksheet for both strategies and the table will list the Strategy name above the table related to each strategy.
39.3.9 Time Discounting

When Global Discounting is turned on in the model's Tree Preferences, an extra worksheet named *Time Discounting* will be included in the Excel model. The *Global Discounting* worksheet shows the discount factor applied to each reward set by cycle (_stage).

The Health Care Tutorial Example, Markov Conversion Model Discounting.trex is the same as the previous example model, except with discounting on for payoff sets 1 and 2. When you convert that model, you will see the following in the *Global Discounting* worksheet, reflecting an interest rate of 3%.

![Time Discounting worksheet with discount rates per cycle per enabled payoff](image)

The discount factor is used to multiply its corresponding payoff in the *Strategy Calcs* worksheets to give the discounted value of the payoff per cycle.

Refer to the Discounting section for more details.

39.4 Tunnels in Excel models

If a Markov Model uses Tunnels, as opposed to a Traditional Markov model (with or without Half Cycle Correction), then the *Strategy Results* and the *State Details* sheets will include additional data.

The Health Care Tutorial Example model Markov Conversion Model Tunnel.trex already has Tunnels enabled for the Metastases state (state 2) with Tunnel Max set to 2 via the Markov Info View.

The Tunnel impacts the variable pMetastasesToDead, changing the probability of Death from Metastases dependent on how long the cohort has been in the Metastases State. See the definition of pMetastasesToDead in the Variable Properties View.
In the State Details sheet for a tunnel state, the first few columns will display the overall summary for the health state, followed by the individual tunnel states within the overall health state. The values from the tunnel states will always sum up to the values for the overall health state.

The figure below shows State details for the overall Metastases State along with the Tunnel State highlighted as Tunnel State 1, while Tunnel State 2 is out of the picture to the right.

The details can be validated back to the Markov Cohort Extended Report, where the Tunnel States are explicitly detailed. Note that the in stage 2, the overall cost for the Metastases state is 12790.78, which is the sum of the cost from Metastases Tunnel State 1 and Metastases Tunnel State 2 (6136.62 + 6654.16).
If the model was converted with the Single Sheet per Strategy, then the format of the Strategy Results would include the additional columns for the Tunnel States as displayed in the State Details figure above.

### 39.5 Within-Cycle Correction in Excel models

If a Markov Model uses Within-Cycle Correction, as opposed to a Traditional Markov model (with or without Half Cycle Correction), then the `Strategy Calcs` and the `State Details` sheets will include additional data columns.

The Health Care Tutorial Example Markov Conversion Model WCC.trex is already configured to use the Within-Cycle Correction method. The figure below of the Markov Info View shows different rewards compared to a Traditional Markov model.
The Strategy Results sheet for WCC Markov Models uses the same format as the Extended Markov Cohort Report. The column headings will indicate that the values are derived from WCC calculations.

Strategy Results showing additional columns for adjustment by WCC (no discounting).

The State Details sheets are expanded to include columns for how the payoffs would be accumulated prior to WCC followed by the adjusted payoffs after WCC is applied. By comparing those data columns, you can validate the WCC calculations.
39.6 Discounting in Excel models

If the Markov Model has Global Discounting turned on, then the Strategy Results worksheet changes and there is an additional Global Discounting worksheet.

In the Health Care Tutorial Example, Markov Conversion Model Discounting.trex, global discounting is already setup on for the cost and effectiveness payoffs with a discount rate of 3% through the variable int_rate. See below.
Tree Preferences settings for Global Discounting to be turned on

The Global Discounting worksheet has the discount rate which needs to be applied to each payoff, each cycle (_stage). The discount rate formula is given below:

\[
\frac{1}{(1 + \text{rate})^{\text{time}}}
\]

Discount rate formula

The rate is taken from the Discount rate entered in the Tree Preferences. The time is the cycle (_stage). The cells on the Global Discounting worksheet are use in the Strategy Results worksheet to adjust the payoff values when Global Discounting is enabled.

The Strategy Results worksheet will have columns per payoff as follows:

- **No Discount:** The value of the payoff before discounting based on State Details worksheets. All payoffs will have a No Discount column.
- **Discounted:** This only appears if the payoff is discounted. It is the payoff amount for this cycle with discounting applied.
- **Cum Disc:** This is the cumulative value of the payoffs as the cycle (_stage) increases. If the payoff has been discounted it uses the discounted values.
Strategy Results highlighting the additional column for the discounted payoff values (red) and the other "No Discount" column for those payoffs not discounted.

The cumulative values of each payoff are then used in the Model Results worksheet.

### 39.7 Validation prior to conversion

A Markov model can only be converted if it can run in TreeAge Pro. The first part of the conversion involves running the whole model to generate the Rankings Report. If your model does not convert and you receive the error below, run the model in TreeAge Pro to find out what the error(s) are before converting the model.

The error message if your model will not convert asks you to run Rankings in TreeAge Pro to identify the issue.

In the Model Results worksheet, the Model Results (presented at the top) and the TreeAge Pro Calculations (presented at the bottom) should be manually compared. The Model Results at the top are generated from the Excel model and selecting the cells in that section show where the results are generated. The TreeAge Pro Calculations are copied from the Rankings Results in TreeAge Pro. By completing a manual check, comparing like for like results, you can be confident that the Excel model is generating the same results as the TreeAge Pro model.

### 39.8 TreeAge Pro features supported by the conversion process

There are a number of features of TreeAge Pro which are unsupported for the Excel conversion TP 2017 R2.0.

<table>
<thead>
<tr>
<th>Supported features</th>
<th>Unsupported features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Markov models (1 per strategy)</td>
<td>Structures other than Markov models (1 per strategy)</td>
</tr>
<tr>
<td>Input parameters</td>
<td>Most TreeAge Pro keywords</td>
</tr>
<tr>
<td></td>
<td>(Keywords _stage and _tunnel are supported)</td>
</tr>
</tbody>
</table>
### 39 Markov to Excel Conversion

<table>
<thead>
<tr>
<th>Supported features</th>
<th>Unsupported features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complex numeric expressions</td>
<td>Bilinks</td>
</tr>
<tr>
<td>Nested variable definitions</td>
<td>State bindings</td>
</tr>
<tr>
<td>Cloned subtrees</td>
<td>Distribution sampling</td>
</tr>
<tr>
<td>Markov Cohort Analysis</td>
<td>Sensitivity analysis</td>
</tr>
<tr>
<td>Within-Cycle correction</td>
<td>Mircosimulation</td>
</tr>
<tr>
<td>Cost effectiveness rankings and Dominance checks</td>
<td>Global matrices</td>
</tr>
<tr>
<td>Tunnel states</td>
<td></td>
</tr>
<tr>
<td>Logic nodes</td>
<td></td>
</tr>
<tr>
<td>Variable arrays</td>
<td></td>
</tr>
</tbody>
</table>

If you try to convert a model with any of the unsupported features, an error message will usually indicate which features in the model are stopping it from being converted.

### 39.9 License eligibility

This capability may ultimately be sold as a separate component since it extends the functionality of the basic TreeAge Pro Healthcare product. However until January 2020, this component will be made available free of charge to license holders running the latest version of TreeAge Pro Healthcare who meet the criteria below:

- Corporate, Non-Profit, Government or Full Academic license (no student licenses).
- Active Annual License or Standard License with Active Maintenance.
- Access will expire on your Maintenance expiration date.
40. Export Model Scenarios to Excel

You can export your model to Excel to allow others to examine your model results under different scenarios within a simple Excel workbook.

You identify the inputs that can be edited, then the export wizard generates a series of results for the applicable data scenarios. Anyone receiving the Excel workbook can easily change input values and view the associated results.

This chapter will detail how to convert the model by following a simple wizard.

---

40.1 Export Model Scenarios to Excel Wizard

This section gives step-by-step instructions for exporting the model to an Excel workbook. We will use an example model, but the same steps apply to all models.

40.1.1 Introduction to the Model

We will use the Health Care Tutorial Example, Markov Conversion Model.trex. This model is a cancer decision model that compares two treatment strategies, Tx 1 and Tx 2, using cost-effectiveness analysis. Each treatment strategy is represented by a single Markov model, with Tx 2 reusing the Markov structure from Tx 1 via a cloned subtree.

The Markov model has three health states - Local Cancer, Metastases and Dead. The two treatments use different values for the following elements of the shared Markov model structure:

- the cost of the Treatment for Local Cancer;
- the probability of transition from Local Cancer to Dead; and
- the probability of transition from Local Cancer to Metastases.

Each of the Markov Models can be evaluated separately by Markov Cohort Analysis, and the decision tree can also be evaluated using cost-effectiveness analysis.

---

This model is evaluated as a Cohort model using Expected Value calculations. The Conversion also works for Patient Level Simulation models (Markov and DES).
40.1.2 Export the Model

The Workbook Export Wizard walks you through the steps to export the active model to Excel, including adding descriptive text and choosing the editable inputs.

**Convert the model:**

1. Choose File > Import/Export > Export Model Scenarios to Excel from the menu to start the Workbook Export Wizard for the currently active model.
2. Choose the editable inputs from the list of model parameters on the left. To move the parameters, you can use the arrows to move parameters one-by-one or all at once. You can also drag and drop the model parameters into the Workbook inputs section.

3. Sort the selected parameters in the order you wish to have them presented in the workbook. You can drag and drop parameters within the list to change the order.
4. As you add more parameters to the editable input list, more model calculations are required to generate the results for the exported Excel workbook. Each workbook input will take on 3 different values (low, best, high). With three values per input, selecting 7 inputs requires $3^7=2187$ calculations. You can see the number of calculations at the bottom of the figure below, which changes depending on how many inputs you choose.
Workbook Export Wizard with 7 parameters selected as Workbook inputs showing the Number of calculations required is 2187

5. For each selected input, enter a low, best and high value. These entries will default from information already in the model, but they can be edited here.

Use the wizard to set the values for the inputs from low, best and high.

Default Low - from low end of sensitivity analysis range.
Default Best - from the root node definition for the variable.
Default High - from high end of sensitivity analysis range.
6. Choose the proper analysis method for this model. For typical decision trees and Markov models, choose "Expected Value/Cohort Analysis". For patient simulation and DES models, choose "Microsimulation". Also enter the WTP value, which defaults from Tree Preferences.

![Use the wizard to Choose the Analysis Type](image)

The example model we are using is a cohort model, so we selected Expected Value/Cohort Analysis.

7. Choose whether to include a picture of the TreeAge Pro model in the workbook, and enter descriptive details about the model and strategies to help the workbook recipient understand the underlying model.

![Model description](image)

Model description will appear on the Introduction Sheet for the workbook (and can be edited at any time in Excel).

- Check the box "Place a picture of the model tree in the workbook" to include the picture.
- Enter a Model description; and
- Enter a description for each strategy.

8. Once all the details are entered, click Finish.

TreeAge will now run the model through all the parameter value combinations to export those model results to the Excel workbook. If you have a simulation model, this could take quite a few minutes or even hours.

The Excel model will be saved to the same folder that holds your original TreeAge Pro Markov model. The filename will be the same as your model with “-ModelExport.xlsm” added to the end. If you convert the model multiple times, a sequence number will be added to the filename. In this example, our model is saved as: Markov Conversion Model-ModelExport.xlsm.

The Excel model will then open and you may need to do the following:

- Enable macros. If your Excel settings do not allow Macros to run without confirmation, you will be prompted to Enable Content in a Security Warning. Without enabling macros, the model likely will not be able to perform all required calculations.
- Resize any column width in the first Model Results sheet. This is sometimes required to get the calculated cells to display correctly.

40.2 Examine the Excel Model

The exported Excel workbook contains model results under all data scenarios representing every combination of input parameter values. The results are pre-run in TreeAge Pro. If the TreeAge Pro model changes, you can repeat the export process to reflect those changes in a new exported workbook.

The workbook is split into three different sheets described in the following subsections.

40.2.1 Overview sheet

This sheet contains information about the model and its strategies since the receiver of this workbook may not have the original TreeAge Pro model. It also includes instructions on how to use the workbook to generate and save results using different scenarios.

On the Overview Sheet you will find:

- Model description: This contains the text entered in the wizard to describe the model.
- Strategies: This contains the node label from the strategy nodes as well as the text entered in the wizard to describe each strategy.
- Instructions: These instructions tell the recipient of the model workbook how to use it.
- Model Diagram: This section will include a picture of the original TreeAge Pro model if the exporter chose to include a picture in the workbook.

After export workbook is created, you can add/edit text as desired.

40.2.2 Run model sheet

This sheet includes all editable inputs and action buttons described below.
Run model - initial view when nothing has been run (via the Run Model button)

The sheet is split into four main sections:

- **Editable Model Inputs and WTP**: These are the parameters selected in the wizard as editable inputs.
- **Additional Inputs**: These are the other parameters not selected as editable inputs. They are presented here for information purposes only.
- **Action Buttons**:
  - Run Model: Show results for the current selection of input values. Both Rankings and CE analyses will be presented to the right of the buttons.
  - Save Results on New Sheet: Save the current results generated via "Run Model" on a separate sheet for comparison to results for other data scenarios.
  - Restore Base Case Inputs: Set all inputs back to the original base case values.

- **Model results**: Initially there are no model results on this tab, but once you click Run Model, results will appear to the right of these buttons.

When you first open the Run Model tab, all inputs will be set to their base case values. Model results using those base case inputs will be presented in the third sheet "Base Case Results".

**To generate a new set of results:**

- For each of the editable model inputs, click on the green cell to choose from among the three values presented to the right - Low, Base and High.
- Edit the Willingness To Pay (WTP) if desired.
- Click the Run Model button.

The figure below shows the sheet with results.
Run model - with the same base case values in green cells - but with the results generated

The Results are presented as a Rankings Report and a Cost-Effectiveness Analysis Graph (for CE models only) based on the selected inputs. Each time you change the Editable Model Inputs and Run Model, the results on the right in the rankings and the graph will change.

To save a set of results:

- When a set of editable model inputs generates results you want to save, select the Save Results to New Sheet.
- A new tab will open, called Saved scenario 1. Every subsequent set of results will have a sequential number.

To restore the base case inputs:

- If you want to set all the editable model inputs back to their Base case values, select the Restore Base Case Inputs button.
- Once you reset any values, you will need to select Run Model to regenerate the model results.

40.2.3 Base Case and additional sheets

The last sheet generated when the Excel workbook is created has the Base Case results. This and the additional sheets (generated from the Save Results on New Sheet button) are not editable.
The sheet is split into the model inputs on the left hand side and the model outputs - Rankings report and Cost Effectiveness Graph (for CE models only) - on the right hand side.

Base case - generated when the Excel workbook is created from the base case values
An additional sheet generated from running the model with all low inputs - Saved Scenario 1
41. Individual-Level Simulation

In some healthcare models, you may find it necessary to send individual patients through the model so you can track data related to each patient. TreeAge Pro refers to this kind of individual patient simulation as Microsimulation.

Since Microsimulation allows you to track data separately by patient, you can incorporate heterogeneity and event tracking into your model. Those patient-level data items can then drive the probability, cost and utility values in the model, resulting in a more realistic model.

Some other chapters which will provide some background material for this chapter:

- The Analyzing Decision Trees Chapter and the Monte Carlo Simulation Chapter provide general instructions on using Monte Carlo simulation.
- The Distribution Functions, Options and Types Chapter provides details on using distributions for microsimulation as well as probabilistic sensitivity analysis.
- The Probabilistic Sensitivity Analysis on Cost-Effectiveness Models Chapter deals with the interpretation of Cost-Effectiveness simulation outputs and sensitivity analysis.
- The Microsimulation Time Reporting Chapter provides details of time reporting for individual trials and the cohort based on a microsimulation.

41.1 Why Run Individual Patient Level Simulation?

You can run individual patients through a model via Microsimulation, allowing you to incorporate individual data elements into the model - patient characteristics and patient events. This fundamentally expands what you can do with your model by allowing patient characteristics and prior events to affect future values - probabilities, costs and utilities.

Microsimulation runs different individuals through the model via a random walk using Monte Carlo Simulation. Some other names this analysis is also referred to as:

- Microsimulation - a common name in this text
- 1st-order trials
- Individual-level simulation
- Random walk
- Monte Carlo Simulation (we try to avoid using this term in this context because Monte Carlo Simulation is a broader term referring to several types of simulation)

With Markov Cohort Analysis/Expected Value Analysis, there is no way to support different patient characteristics or to use prior events to drive future events, which can limit your ability to model complex diseases. Microsimulation expands the modeller's toolkit to be able to consider how a patient’s characteristics and past events can impact the future events, traits and outcomes of the model.

This chapter focuses on many important aspects of building microsimulation models, including:
- Introducing heterogeneity via patient characteristics
- Tracking patient events via trackers
- Analysing the model via Microsimulation and interpreting the results
- Running Sensitivity Analysis on microsimulation models

### 41.2 Microsimulation – Running Patients Through the Model

When you run Microsimulation on a model, you send a batch of individual patients into the model. Each patient will run through the model until death or until reaching the termination condition for the Markov model (typically a time horizon limit).

#### 41.2.1 Random Walk

As the patient proceeds through the model, he/she will take a random walk through a certain pathway. Every subsequent patient will likely take a different pathway based on the “random walk” points in a model – specifically Chance Nodes and Markov Nodes.

The branches of both Chance Nodes and Markov Nodes require probabilities to control patient flow. In Markov Cohort Analysis/Expected Value Analysis, the cohort would be split into fractions based on the probabilities. With Microsimulation, you cannot break a person into fractions. Instead, a random number is drawn to determine to which branch the patient should proceed.

For example, a patient could reach a chance node with three branches.

- Branch 1 – 20% (random range 0-0.2)
- Branch 2 – 30% (random range 0.2-0.5)
- Branch 3 – 40% (random range 0.5-1.0)

When the patient reaches that chance node, a random number is drawn between 0 and 1. Based on the random number, the patient will move to the appropriate branch.

- If 0 <= random number <= 0.2, proceed to Branch 1
- If 0.2 < random number <= 0.5, proceed to Branch 2
- If 0.5 < random number <= 1, proceed to Branch 3

This process is repeated at every Markov and Chance node in the model as the patient proceeds on the random walk.

#### 41.2.2 Patient Outcomes

When the patient finally finishes his/her pathway through the model, he/she will have accumulated value along the way in payoffs and trackers (described later). The primary outputs for the patient will typically be the total cost and total effectiveness accumulated over the entire patient run.
Each patient’s individual cost and effectiveness is meaningless as isolated values; however, when you aggregate those values into means for a large cohort of patients, you get a good estimate of the expected value (average cost, effectiveness) for each strategy. These average values from the Microsimulation then feed into Decision Analysis to identify the optimal strategy.

Later sections of this chapter will examine individual and aggregate cost and effectiveness values when interpreting the Microsimulation results.

Complex models may require a large number of patients to guarantee that the mean values accurately represent the expected values for each strategy.

### 41.3 Introducing Heterogeneity via Patient Characteristics

In a Microsimulation model, each patient can have his/her own set of characteristics. You would only add these characteristics into the model if they will have an impact on one or more values within the model.

There are two methods to introduce heterogeneity into the model:

1. Assigning patient characteristics by creating distributions
2. Assigning patient characteristics from real world data via Bootstrapping

### 41.3.1 Assigning Patient Characteristics via Distributions

Characteristics of the heterogeneous population can be provided by distributions that are sampled for each patient as he/she enters the model. TreeAge Pro supports many distribution types. Please refer to the Help section Creating Distributions for more details.

Open the Healthcare tutorial example, MicrosimulationCancerModel - Distributions.trex, and examine the distribution: `distStartAge`.

The distribution, `distStartAge`, provides the characteristic of start age for each individual when he/she enters the model. Each patient’s start age is sampled from a Uniform distribution as a value between 30 and 50 inclusive. Due to the characteristics of the Uniform distribution, we would expect approximately the same number of people at each starting age within the range (30 - 50).
Distribution distStartAge showing sampling rate “Resample per Individual Trial”

The sampling rate is set to “Resample per individual trial”, which tells TreeAge Pro to generate a new sampled start age for every person entering the model.

Note you will want to create distributions to match the characteristics of the cohort that experiences the disease being modeled. For example, if you have a population that affects men more frequently than women, you will want to assign patient gender based on the distribution of gender in the disease cohort.

Within the model, you can refer to the distribution directly by name. When a patient reaches a node where the start age is needed, the sampled starting age for that patient will be returned.

Refer to the Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis Chapter for information on creating and managing distributions.

41.3.2 Assigning Patient Characteristics via Bootstrapping

Characteristics of the heterogeneous population can be populated using real-world patient data via bootstrapping. This has an advantage over distributions in that the full set of patient characteristics is tied to a real person, so the appropriate data correlations are maintained.

Bootstrapping is implemented in TreeAge Pro with the following steps:

1. Load the real-world data into a table with each row representing a real patient and each column representing a different patient characteristic. The index column of the table should be numbered in ascending order (1, 2, 3… N, where N is the last row in the table).
2. Create a uniform distribution that returns only integers between 1 and N.
3. Create variable definitions (or tracker modifications) which assign each characteristic by pulling data from the table.
   
   1. The table row would come from the distribution defined above (an integer between 1 and N).
   2. The table column is a fixed integer for each patient characteristic.

The same technique defined above setting patient characteristics equal to variables can also be implemented with Trackers. The next section introduces Trackers and this current example is repeated using trackers instead of variables.

If you use variables, you can define each variable at the root node and reference it anywhere in the model.

If you use tracker modifications, you cannot place them at the root node, so you will need to place them at each branch of the root node. Trackers should be used if you want the given characteristic values included in the Microsimulation results. Doing this would allow you to filter the results by subgroup based on those characteristic values.

Open the Healthcare tutorial example, MicrosimulationCancerModel - Bootstrap With Variables.trex, and examine the distribution distProfile. The distribution generates a new profile number from a Uniform Distribution.

In the table, tProfileData[], each column is assigned a different patient characteristic, in this case tumor type (Col 1) and start age (Col 2). The profile number is used to reference a row in the table tProfileData.

The model uses the entries of the table to populate variables (or trackers) in the model for a given trial. Consider the variables defined at the root node:

- \( v_{\text{StartAge}} = tProfileData[\text{distProfile};2] \)
- \( v_{\text{TumorType}} = tProfileData[\text{distProfile};1] \)

For more details on sampling from tables refer to the Distribution Functions, Options and Types Chapter.

### 41.4 Tracking Events by Patient

Trackers offer a simple way for any number of events to be recorded while simulating individual trials through a microsimulation model (either a Markov or a Discrete Event microsimulation).

Trackers are created for each trial in the model by setting the tracker equal to the initial value used for all patients. The tracker can then be modified in any way at any node, changing the value of the tracker only for that individual.

For example, a tracker could do any of these things, and more.

- Record whether an event has ever happened
- Record how many times an event has happened
- Record when an event last happened

Trackers act like memory for a trial or individual patient allowing details about prior events to be easily recalled, updated and reported.

There are some important differences between Trackers and Variables.

<table>
<thead>
<tr>
<th>Item</th>
<th>Trackers</th>
<th>Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value scope</td>
<td>Applies to an individual trial</td>
<td>Applies to the entire cohort</td>
</tr>
<tr>
<td>Analysis type</td>
<td>Requires microsimulation</td>
<td>No restrictions</td>
</tr>
<tr>
<td>When are definitions/modifications executed?</td>
<td>Immediately at the node where the tracker modification is found</td>
<td>Only when the variable is referenced in a required calculation (i.e., payoff, reward, probability, etc.)</td>
</tr>
<tr>
<td>Initial value</td>
<td>Required at the starting point for each trial</td>
<td>Does not exist</td>
</tr>
</tbody>
</table>

Differences between trackers and variables

### 41.4.1 Creating, Defining and Using Trackers

Trackers are created and defined in a similar way the regular variables described in the variables chapter; however, you create and edit trackers in the Tracker Properties and Tracker Modifications Views rather than their equivalent Variable views.

Trackers also differ from variables in the way they are evaluated during analyses. This will be discussed further within this chapter but it is summarized in the table above.

One quick way to create and define a tracker is by right-clicking on a node that requires a tracker modification. This forces you to select the appropriate node where the tracker should be modified.

Open the Health Care tutorial example model, MicrosimulationCancerModel - Distributions.trex. This has a tracker which counts the number of adverse events which occur, \( t_{AE} \).

**To create and define a tracker:**

- Right-click on a node where you want to create the tracker. In this model its the Metastases > Survive Background Mortality > Adverse Event node.
- Choose Define Tracker > New Tracker from the context menu.
- In the Add/Change Tracker dialog, enter a name and other properties of the tracker and click OK to save it. In this model, the tracker name is \( t_{AE} \). The properties show the default intial value equals 0, which applies appropriately in this case.
- In the Define Tracker dialog, enter the tracker modification and click OK to save it. In this model the tracker modification would be \( t_{AE} + 1 \) telling the tracker to "count" each time it gets to this node.
Add/change tracker dialogue:

The initial value is the value of the tracker at the beginning of each trial. Once a trial has finished, the next trial will start the model with its tracker set to the initial value. In most cases, the default value of 0 is appropriate. An example of an exception case is: If you want to record the _stage value when a certain transition occurs. If the initial value is zero, there will be no way to distinguish between the case where the transition occurred at _stage 0 and the case where the transition never occurred. An initial value of -1 would distinguish between those cases.

The evaluation priority value determines the order in which to evaluate trackers at a node. This only impacts analysis results if you have a tracker that is updated and used in another tracker modification at the same node. In such a case, you might want to ensure that the updated tracker value is set before being used in the other tracker modification. The priority can be set for each tracker; however, the priority is only used if the appropriate Tree Preferences option is set in the Other Calc Settings category.

Display {T}:

When TreeAge Pro displays a tracker modification in the tree view or Define Variable window, it appears with the prefix “{T}”. You should not type the {T} prefix when referring to the tracker in formulas. This is just a display property to distinguish the tracker.
Tracker modifications

Tracker modification dialogue:

To change (or delete) an existing tracker modification, simply right-click on the desired event node and choose the variable from the Define Variable list. Or, use the Tracker Modification view described in the next few sections.

If you are modifying a tracker that already exists, you will only see the second dialog.

Modifications of a tracker at the root node of the tree will be ignored. However, you can make the root node of the tree a label node and place the tracker modifications to the right of that node. This achieves the same outcome, without having the tracker modified at the root node.

41.4.2 Trackers in simulation output

When we run a microsimulation, the values of the trackers at the end of the simulation for each trial will be captured in the output. This makes trackers a simple way for any number of events to be recorded while simulating individuals' “runs” through a microsimulation model.

In the Health Care tutorial example model, MicrosimulationCancerModel - Distributions.trex, the tracker \( t_{AE} \) counts the number of adverse events which occur. In addition, the tracker \( t_{firstAE} \) records when the first adverse event happens.

To see the values of the trackers in the microsimulation output, we need to run the model.

To run a microsimulation at Markov node Tx 1:
- Select the Markov node, labelled Tx 1. (We are running microsimulation just for one strategy).
- Choose Analysis > Monte Carlo Simulation > Trials (Microsimulation) from the menu. OR
- Select the single dice from the tool bar.
- Enter the number of trials, 10,000. Select Begin.

The microsimulation output will show the Expected Values for the active payoffs (Costs and Effectiveness) for Tx 1 (the top strategy) and all the statistics associated with those values aggregated for the payoffs over 10,000 trials.

The report we are interested in is the All Data report (which is explained in more details in the section about Running Microsimulation). For our purposes, we just need to understand that the final values of the payoffs (active and non-active), trackers and distributions are given in the All Data report per trial.

To the RHS of the main Microsimulation output, expand Data > All Data Report. Select the All Data Report as shown in the figure below.

Microsimulation All Data report - each row representing a trial's outcomes.

The report shows the payoffs (active and inactive) accumulated for each trial, where the iteration column shows the trial number. The final value of the trackers is also presented so we can see the number of Adverse Events in the column t_AE and the time of the first Adverse Event in the column t_firstAE_Stage. Those trials who did not have an Adverse Event still show a value in the t_firstAE_stage column of -1.0 (the initial value).

To see when, during the simulation, the tracker values have been updated the model can use Time Reporting which is explained in more detail in the Time Reporting Chapter.
Average tracker values can also optionally be displayed for each strategy. This option is selected in the Tracker Properties View described later in this chapter.

### 41.4.3 Referencing trackers in calculations

Once the model includes trackers, we can report and investigate their values. In addition, we can use the trackers in calculations. Trackers have many applications as inputs to formulas calculating transition probabilities, rewards, individual patient level distributions, termination conditions, or any other numerical expression. In other words, the trackers are not limited to recording events; they can also be used to affect future transitions, events, rewards, etc.

In the Health Care tutorial example model, MicrosimulationCancerModel - Distributions.trex, the tracker \( t_{AE} \) tracks the number of adverse events and impacts the probability of death, \( p_{AE\_Death} \), depending on the number of adverse events.

Examine the following:

- Table \( tDeathAE \): The index is the number of adverse events and the value column is the probability of death from an adverse event.
- Variable \( p_{AE\_Death} \): This variable references the table using the index = \( t_{AE} \). We can see that as the number of adverse events increase, the probability increases.

Once model calculations require trackers in order to be calculated correctly, the model should be analyzed only with microsimulation. Expected value analyses (i.e., roll back, n-way sensitivity analysis, Markov cohort analysis) will ignore the trackers and will probably yield incorrect results. In this model, trackers only impact probabilities, but they could impact cost and utility as well.

### 41.4.4 Trackers Views and Properties

This section describes the views and dialogs related to creating and managing trackers in your model.

#### 41.4.4.1 Tracker Properties View

The Tracker Properties View is used to manage tracker properties. Tracker properties apply to the entire tree (as opposed to the Tracker Modifications View which is node specific). The Tracker Properties View is a tree-level view rather than a node-level view. This view functions in a manner similar to the Variable Properties View, except it is used for trackers.

To open the Tracker Properties View:

- Choose Views > Tracker Properties from the toolbar.

Below is an image of the Tracker Properties View in the Health Care tutorial example model, MicrosimulationCancerModel - Distributions.trex.
Tracker Properties View

The main grid contains a list of the tree's trackers along with a few of the key tracker properties. The properties can be edited within the grid. If you change the tracker name, all references to that tracker within the tree will be modified as well.

Note the option to "Show in Rankings". If selected, the average tracker value for each strategy will be included in Rankings reports.

The Tracker Properties View toolbar provides additional functions.

These functions are described briefly here. Since the functions are nearly identical to the functions for editing regular variables, please refer to the Working With Variables Chapter for more details.

**Edit tracker**: Edit the properties of an existing tracker via the Add/Change Tracker Dialog.

**Add new tracker**: Create a new tracker and enter its properties via the Add/Change Tracker Dialog.

**Add new trackers**: Specify the number of new trackers and then enter their properties via the Add/Change Tracker Dialog.

**Delete selected tracker**: Delete the tracker(s) selected in the view's grid.
*Convert tracker to variable:* Convert the selected tracker to a regular variable.

*Copy tracker:* Select the row with the tracker(s) you wish to copy. Click the copy icon to copy the tracker(s) into the clipboard. See the Variable Properties View for details about copying/pasting. Note that this only copies the tracker entity with its initial value, but no tracker modifications in the model.

*Paste tracker:* Copy tracker(s) (as above from another model) and click the paste icon to paste the tracker into the active model. See the Variable Properties View for details about copying/pasting.

*Edit in Excel:* Use the Excel Module to edit tracker properties in Excel.

*Generate trackers report:* Generate a report on trackers in the model.

*Highlight:* Highlight the tracker within the model in the Tree Diagram Editor.

*Find reference in tree:* Select a tracker and search within the model for that tracker.

*Filter text/clear:* Filter the list of trackers to show only tracker names that match the Filter Text.

*Group trackers by categories:* Group the trackers by category in the view's grid.

### 41.4.4.2 Tracker Modifications View

The Tracker Modifications View is used to manage tracker modifications at different nodes within the tree. Tracker modifications are created at specific nodes, meaning the Tracker Modifications View is a node-level view. The contents of the view reflect the context of the selected node. This view functions in a manner similar to the Variable Definitions View, except it is used for trackers.

*To open the Tracker Modifications View:*

- Choose Views > Tracker Modifications from the toolbar.

Below is an image of the Tracker Modifications View from the Health Care tutorial example model, MicrosimulationCancerModel - Distributions.trex, with the Adverse Event node selected.
Tracker Modifications View

There are two tracker modifications presented in the Tracker Modifications view.

The functions within this view work almost identically to the Variable Definitions View. Please refer to that section for more details.

Note tracker modifications cannot be inherited; that functionality from the Variable Definitions View is not included in the Tracker Modifications View.

To copy/paste Tracker definitions: you can select one or more tracker modifications at a node, right-click and choose Control+X to cut or Control+C to copy the tracker modification into the clipboard. Then select another node and right click on "Defined" in the view then choose Control+V to paste the tracker modification at the currently selected node. For Mac, use Command+X, Command+C, and Command +V for the same actions.

41.4.4.3 Add/Edit Tracker Modification Dialog

The Add/Edit Tracker Modification Dialog is used to edit tracker modifications at a specific node. The dialog is described earlier in this Tracker Section under the heading Creating, Defining and Using Trackers.

41.4.5 Trackers: Assigning Patient Characteristics via Bootstrapping

In the previous section Introducing Heterogeneity, we considered an example of Bootstrapping. Bootstrapping is where characteristics of the heterogeneous population can be populated using
real-world patient data. This has an advantage over distributions because the full set of patient characteristics is tied to a real person, so the appropriate data correlations are maintained.

To recap, Bootstrapping is implemented in TreeAge Pro with the following steps:

1. Load the real-world data into a table with each row representing a real patient and each column representing a different patient characteristic. The index of the table should be 1, 2, 3… N, where N is the last row in the table.
2. Create a uniform distribution that returns only integers between 1 and N.
3. Create tracker modifications (or variable definitions as in the previous section) which assign each characteristic by pulling data from the table.
   1. The table row would come from the distribution defined above (an integer between 1 and N).
   2. The table column is set for each patient characteristic.

Open the Healthcare tutorial example, MicrosimulationCancerModel - Bootstrap With Trackers.trex, and examine the distribution distProfile. The distribution generates a new profile number from a Uniform Distribution.

In the table, each column is assigned a different patient characteristic, in this case tumor type (Col 1) and start age (Col 2). The profile number is used to reference a row in the table tProfileData.

The model uses the entries of the table to populate trackers in the model for a given trial. Consider the tracker definitions which have to occur at the start of each Strategy (Tx 1 and Tx2).

- t_StartAge = tProfileData[distProfile;2]
- t_TumorType = tProfileData[distProfile;1]

The Tracker modifications must occur at each Strategy node. This is because Tracker modifications cannot happen at the root node (unlike the same example with Variables) because the trackers are set to their initial value at the root node.

The benefit of using Trackers for the patient characteristics is that Trackers are reported in the Microsimulation output.
The All Data report shows (if you scroll to the far right), which value was selected from the uniform distribution \textit{distProfile}. The first trial had \textit{distProfile} = 2, and therefore corresponding values of \textit{t_tumorType} = 2 and \textit{t_startAge} = 45. This allows data verification of the input values when the analysis is over via the output values.

With the characteristics included in the output data consistently across strategies, you can use filtering to examine subgroups within the overall heterogeneous cohort.

### 41.5 Running Microsimulation and Interpreting the Results

Open the Healthcare tutorial example tree, MicrosimulationCancerModel - Distributions.trex, which incorporates both trackers and distributions resampled per trial for patient characteristics. If a model is built using Microsimulation, then it needs to be run using specific Analysis, not the usual Expected Value analysis (for example Rankings or CEA graph).

Once model calculations require trackers in order to calculate correctly, the model should be analyzed only with Microsimulation. Expected value analyses (i.e., roll back, Markov cohort analysis) will ignore the trackers and will yield incorrect results.

If you have trackers and/or trial-level distributions in your model, TreeAge will warn you prior to running any analyses that do not include Microsimulation.

To run a microsimulation:
- Select the root node.
- Choose Analysis > Monte Carlo Simulation > Trials (Microsimulation)... OR
- Use the single dice in the tool bar associated with the Analyze perspective.
- Enter 10,000 trials in the Monte Carlo Simulation dialog.
- We want the Average values returned for the trial set, so leave the Average button selected.
  Select Begin.

Run microsimulation for 10,000 trials

After the simulation is complete, you will be presented with summary statistics from the simulation output.

The microsimulation has done the following:

- Each trial, one at a time (sequentially) has moved through the model via a random walk.
- Each trial has been assigned characteristics (from either the bootstrap or distribution).
- Each trial accumulates data in payoffs and has trackers updated at specific nodes it passed through during the patient's pathway through the model, resulting in final values for these outputs by patient.
- Reported Expected Values - that is the average (mean) for the set of trials. If we had selected the Value of Trial sets to be Sum, then the statistics would report the total values (the sum) for all trials at the top of the report. The sum is useful when considering Dynamic Population models.
Microsimulation results

Let's look at each of the elements in the microsimulation output as shown in the figure above.

- **Main report (Monte Carlo Simulation C-E Statistics):** Provides the mean values for the active payoffs, in this case the mean cost and effectiveness for the strategies we are comparing. The mean value represents an estimate of expected value for the strategy. As you increase the number of trials in the microsimulation, you get better and better approximations of expected value. The report also shows various statistics related to the mean value. The expected NMB is indicated further down the report.

- **Additional outputs:** In addition to the mean values per strategy, there are several reports and graphs on the RHS. The most important are:
  - Data > Summary Report. Provides the statistics for each payoff, tracker and distribution in the model.
  - Data > All Data Report. Each iteration's (i.e. each trial's) payoffs, trackers and distribution values are reported on a separate line. These are the individual values which are aggregated to give the Expected Value calculations. In most cases, the individual trial data is not valuable except as a contribution to the overall estimate of expected value.
  - CEA Outputs > CE Rankings. The usual rankings report generated from the Expected Values from the microsimulation.
By default, Probabilistic Sensitivity Analysis (PSA) secondary outputs are suppressed in the Microsimulation output because they are invalid for this kind of analysis. PSA outputs do an iteration-by-iteration incremental comparison between strategies, which is not valid when each simulation iteration is a patient rather than a model recalculation. If you need those outputs from Microsimulation (unlikely), it is possible to change the Tree Preferences (category Analysis Settings > Output Reports) by unchecking the box “Hide PSA reports for micsimulation.”

- Histograms.

Data > All Data Report showing each trials results.
CEA Outputs > CE Rankings generates the standard rankings report from the microsimulation results.

Note that the average tracker values are reported for each strategy.

### 41.6 Filtering Results (Subgroups)

When running microsimulation you may be interested in analysing only a subgroup of the whole population. TreeAge Pro allows microsimulation output to be filtered and/or refactored in the following ways.

- Filter the output to include only iterations that meet selection criteria.
- Change the active payoffs.

Consider the Health Care tutorial example model, MicrosimulationCancerModel - Distributions.trex. When you run a Microsimulation analysis on the model, all patient characteristics and outcomes within the dataset are presented as Microsimulation results, as detailed in the section above.
From the output above, the following CE Rankings report was generated.

In the model, one of the individual characteristics is tumor type, which has either the value "1 = less aggressive" or "2 = more aggressive". We can choose to filter the results by tumor type to see if there is a change in results (and possibly the optimal strategy) dependent on tumor type. Simulation filtering provides the basis for the analysis. In the primary Monte Carlo Simulation CE Statistics analysis output window, click the filter icon to start filtering the results.

To filter microsimulation results:

- To filter for the more aggressive tumor type.
- Select the filter icon at the top-right of the Monte Carlo Simulation CE Statistics and the Preferences for the filter will open.
- To create a filter select “Add” and use the Report filter editor to define the expression. In this case the expression is \( \text{distTumorType} = 2 \). Then, select OK to close the editor.
- In the preferences dialogue there will now be one filter which has automatically been set as Active. We can select Apply and then examine the filter results.
- Note that to make any filter unactive, we select that filter and use the button on the RHS to Unset Active.

![Report filter editor](image)

Report filter editor - use the expression field to set the filter to be applied to the results

The Report Filter Editor provides the option to filter results based on any input characteristic (distributions) or output data (payoffs, trackers).

闲置时

When filters use output data, strategies will not have the same results for each simulation iterations. If you apply a filter to output data, the row will remain in the filtered data set, if the iteration row meets the filter criteria for any of the strategies.

The Report Filter Editor also allows you to change the Active Payoffs for the model’s calculation method. If you had multiple valuations of cost and/or effectiveness, you could change the active payoffs through this editor to re-evaluate the model (CE analysis) using different model outcomes.

To filter for more than one characteristic or attribute, you can combine filters using “and” and “or”. For example, the filter “\( \text{distTumorType} = 2 \) and \( \text{age} > 40 \)” would filter for all trials with a severe tumor type and with an age above 40. You can use the relational operator “or” in an expression like “\( \text{distTumorType} = 2 \) or \( \text{age} > 40 \)” to include iterations where either of the two conditions is true. You can also use parentheses to control multiple conditions like “(condition x and condition y) or condition z”.
In the \texttt{distTumorType = 2} filter, the total number of iterations has been reduced from 10,000 to 3,002, reflecting the iterations with trials with tumor type 2. All secondary outputs, including the CE Rankings report below will now be generated from the filtered set of results.

In the filtered results for the more aggressive tumor, the overall for each strategy is about 0.5 QALYs less. And the ICER increases by around $7000, so the strategy selections would likely be the same. This may not always be the case.

When a filter is created for simulation output, the new filter is automatically copied back into the Tree Preferences for the model, so it can be reused for future analyses. See below.
41.7 Deterministic Sensitivity Analysis and Microsimulation

With a microsimulation model, it is possible to run deterministic sensitivity analysis and Tornado Diagrams.

Consider the Health Care tutorial example model, MicrosimulationCancerModel - Distributions.trex.
41.7.1 1-Way Sensitivity Analysis and Microsimulation

This model requires Microsimulation because it uses individual trial-level distributions and trackers. However, we also want to run one-way sensitivity analysis on the variable $cLocal2$.

To run one-way sensitivity analysis:

- Select the root (decision) node.
- Choose Analysis > Sensitivity Analysis > 1 Way.
- Choose the variable $cLocal2$ and enter the low, high and interval values as seen below.
- Select the option "Run microsimulation rather than EV". (The Legacy option is below but this is a slower way of running 1-way and Microsimulation)
- Click OK.

One-Way Sensitivity Analysis Setup Dialog

You will receive a warning if the variable you have selected for Sensitivity Analysis is not a variable defined at the root node and a variable defined as a number or as a distribution. You will receive a warning if you select a variable that does not appear to be a parameter. See figures below.

Warning if the variable selected for 1-Way Sensitivity Analysis is not a variable defined at the root node
Warning if the variable selected for 1-Way Sensitivity Analysis is not defined as a constant or a distribution

We selected to run Microsimulation rather than Expected Value calculations for this model. Therefore, the Monte Carlo simulation dialog is then presented to enter the number of trials, as below.

Monte Carlo Simulation Dialog for Microsimulation

The check box: "Stabilize trials within Sensitivity analysis" is automatically selected. This ensures the same set of trials is used for every value of the parameter within the overall analysis. This allows the variation between the parameter selected for sensitivity analysis to be examined without noise from variation among trial sets.

All the options available in this dialog are described in a previous section of this chapter.

Based on the sensitivity analysis options, the analysis will consider values of $20K, $21K, $22K, $23K and $24K for variable \( c\text{Local2} \). In a regular sensitivity analysis, expected values would be generated for each variable value using Markov Cohort Analysis. Because this is a Microsimulation model within the sensitivity analysis, five separate microsimulations are executed, one for each variable value.
Sensitivity Analysis Results

The mean values from the first set of Microsimulation results are used for the first set of sensitivity analysis EV results. The other four sets of Microsimulation mean values are used for the remaining sensitivity analysis EVs. This leaves you with a standard sensitivity analysis output as described in earlier chapters (simple, cost-effectiveness).

Generating the Net Benefits (CE Thresholds) graph (with WTP = 50,000) will show there is a threshold in the range at $c_{Local2} = 22,218$, a strategy change from one treatment to another.

41.7.2 Tornado Diagram with Microsimulation

This model requires Microsimulation because it uses individual trial-level distributions and trackers. However, we also want to generate a Tornado diagram for a number of on the variables.
To run a Tornado Diagram:

- Select the root (decision) node.
- Choose Analysis > Sensitivity Analysis > 1 Way.
- Choose the variables to include with the low, high and interval values as seen below.
- Select the option "Run microsimulation rather than EV".
- NOTE: For every combination of variables, the model will need run a microsimulation so consider this in terms of the time it takes to evaluate the model.
- Click OK.

Tornado Diagram Setup Dialog

Be careful not to select variables that are formulas, rather than numeric parameters defined at the root node. A warning will alert you to this issue if you have selected such a variable.

The option we selected was "Run microsimulation rather than EV" to initiate the Microsimulation, while the second option would run Microsimulation using the slower algorithms, pre-2019. When we run Microsimulation, the Monte Carlo simulation dialog is then presented to enter the number of trials, as below. Note the "Stabilize trials within Sensitivity Analysis" option is selected to ensure there is consistency among all trial sets.
Once the Tornado Diagram opens, all the options available in this dialog are described in the CE Tornado diagram options. The ICER tornado is show below.

**Tornado Diagram - ICER**

**Tx 1 vs. Tx 2**

ICER Tornado for Microsimulation Model

### 41.7.3 2-Way and 3-Way Sensitivity Analysis and Microsimulation

This model requires Microsimulation because it uses individual trial-level distributions and trackers. However, we also want to run 2- or 3-way sensitivity analysis on some variables.

**To run 2-way or 3-way sensitivity analysis**

- Select the root (decision) node.
- Choose Analysis > Sensitivity Analysis > 2 Way or 3 Way.
- Choose the variables to include, with appropriate ranges. (You can use the default in the example model).
- Set the value of either NMB or NHB as the calculation type. This provides the value against which we can compare the strategies.
- Select the option "Run microsimulation rather than EV".
- NOTE: For every combination of variables, the model will need run a microsimulation so consider this in terms of the time it takes to evaluate the model.
- Click OK.

For 2-way sensitivity analysis, the resulting graph is shown below. It identifies which strategy is optimal in regions of values of the variables; thresholds are simply the border between two regions.
Two-variable sensitivity analysis graph for microsimulation model

Find out more about two-way sensitivity analysis in the More Sensitivity Analysis Tools section.

Three variables cannot be presented as clearly as in a two-dimensional graph. Therefore, the results of a three-way sensitivity analysis are presented as an animated two-way sensitivity analysis region graph. The third variable is represented not with its own axis, but rather using a series of two-way graphs — if four intervals are specified for the third variable, then five graphs will be created, and shown in series.
3-way sensitivity analysis graph for microsimulation model

Use the Animate button or the scroll bar to cause the third variable (cLocal2) to cycle through its range. The successive frames of the three-way analysis shows how the two-way region/optimality graph for the first two variables is affected by varying the value of the third variable.

Find out more about 3-way sensitivity analysis in the More Sensitivity Analysis Tools section.

41.8 Probabilistic Sensitivity Analysis and Microsimulation

The probabilistic sensitivity analysis method samples sets of parameter values and, for each set, recalculates the expected values for the model. The Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis Chapter covers the general usage of Monte Carlo simulation to perform probabilistic sensitivity analysis.

The theoretical background for this kind of probabilistic sensitivity analysis is discussed in detail elsewhere, for example, in papers published in the Journal of the Society for Medical Decision Making including:


You are urged to explore these and other publications on this topic.

### 41.8.1 Performing Sensitivity Analysis with Microsimulation

Consider the Health Care tutorial example model, MicrosimulationCancerModel - Distributions.trex.

To generate meaningful results with PSA, we need to have distributions which represent the uncertainty we want to examine around certain model parameters. In this model the parameters we want to examine are $c_{Local2}$, $p_{LocalToDead}$ and $c_{AE}$. The figure below shows the distributions which have been selected to represent the uncertainty around each parameter.

<table>
<thead>
<tr>
<th>Index</th>
<th>Type</th>
<th>Type Settings</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gamma</td>
<td>EV</td>
<td>dist_cLocal2</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Beta</td>
<td>EV</td>
<td>dist_pLocalToDead</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Gamma</td>
<td>EV</td>
<td>dist_cAE</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Uniform</td>
<td>Trial</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Table</td>
<td>Trial</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Model distributions, highlighting those resampled per Expected Value

We have changed the parameters to equal the distributions we want to use for PSA (via the Variable properties view) such that:

- $c_{Local2} = \text{dist}_cLocal2$
- $p_{LocalToDead} = \text{dist}_pLocalToDead$
- $c_{AE} = \text{dist}_cAE$

If we ran regular Microsimulation on the model, the PSA/EV distributions are not sampled, and their mean values are used in the analysis. When we run PSA and Microsimulation, then they will be sampled.

To perform probabilistic sensitivity analysis on a microsimulation model:

- Select the root node.
- Choose Analysis > Monte Carlo Simulation > Sampling + Trials from the menu. OR
- Use the tool bar and select the double dice icon in the Analyze perspective.
- In the Monte Carlo Simulation dialog:
  - Enter the number of 2nd-order parameter samples, 1,000. This is 1,000 PSA samples.
  - Check the box to "Run 1st order trials" and enter 1,000 as the number of trials. This is 1,000 trials. This number should equal the same number required for the Base Case.
  - Check the box "Stabilize trials within PSA" to ensure stability in the 1,000 trials. Checking this box means that any variation is due to the samples as opposed to the trial group.
- Press Begin.

![Microsimulation and PSA simulation setup](image)

The number of samples and trials required for stable, accurate results depends greatly on the complexity of the model. For a helpful discussion of determining the number of samples (outer loop= N) and trials (inner, microsimulation loop=n) required to support your analysis objectives, refer to:


Note the "Stabilize trials within PSA" option is selected to ensure there is consistency among all trial sets.

### 41.8.2 Interpreting a probabilistic sensitivity analysis in a microsimulation model

First lets understand what running PSA and microsimulation has done:

1. The model samples from each distribution with a resampling rate per EV to create a sample set defining the parameters for that model calculation.
2. Run Microsimulation for that parameter set.
   1. The model then runs each individual trial, one at a time, through the model via a random walk.
   2. Each trial will be assigned characteristics from distributions in the model which are resampled per trial.
   3. When the batch of 1,000 Microsimulation trials finishes, keep only the mean values from all patients, reflecting the model calculation for that set of parameters.
3. Repeat Steps 1 and 2 until all samples are complete (1,000 in this run).
The final output of the simulation will report the statistical summary across all the microsimulation Expected Values. The statistics are calculated in the following way:

1. Each model recalculation (from a set of trials, microsimulation) is averaged to produce overall mean values reflecting all model recalculations. This is not the primary focus of the analysis, as we are more interested in what happened during individual calculations than the overall summary.

2. The resulting output includes PSA outputs to interpret the results.

If you select the "All Data Report" link to the right of the simulation statistics, TreeAge Pro will display in each single row, the results of a microsimulation. Each iteration (i.e. sample), reports average values for payoffs, trackers and distribution samples, based on the iteration’s group of trials.

All Data Report for Microsimulation with PSA.

It provides averages, each simulating an expected value calculation by averaging the results of multiple trials.

In essence, a mean value from a group of trials is estimating expected value (EV) for the model. Within the context of probabilistic sensitivity analysis (PSA), this EV estimate is used the same way as the EV calculations from PSA described in the Monte Carlo Simulation, Distributions and Probabilistic Sensitivity Analysis Chapter. These PSA outputs are the same, just that each model recalculation used Microsimulation.

The tracker values reported for 2-dimensional simulations, which sample distributions and then run microsimulation trials for each set of sample values, are averages for each group of trials run for a particular set of parameter samples.

### 41.9 More Notes on Trackers

#### 41.9.1 Tracker Modification Location and Timing

- A node’s tracker modifications occur after that node is selected in a random walk (i.e., after any logic or probabilities for the branch and its siblings have been evaluated), and after rewards
(state or transition) are accumulated at that node. If you need the tracker updated first to be used in calculations of cost, utility, etc., we recommend updating the tracker at a label node, then performing the subsequent calculations at the next node to the right.

- Modifications at a Markov node will be evaluated once at the start of _stage 0, when a trial starts the Markov process.
- Modifications at an absorbing state are only evaluated for the first cycle that the trial exists in the absorbing state.
- Modifications at the root node of the tree will be ignored. However, you can make the root node of the tree a label node and place the tracker modifications to the right of that node. This achieves the same outcome, without having the tracker modified at the root node.

Notes on tracker modification location and timing

### 41.9.2 Tracker Modifications that Reference Other Trackers

If you have more than one tracker modification at a particular node, the modifications will be applied in reverse alphabetical order. To avoid errors and confusion, if \{T\} TrackerB is dependent upon the value of \{T\} TrackerA, it is recommended that they be defined at successive nodes. Simply move the dependent tracker modification to a node to the right.

This is accomplished by inserting a single branch to the right of the existing event, and moving the dependent tracker modification to that node. The node between the dependent modifications can be changed to a label node, as shown below.

![Tracker Stroke Diagram](image)

Tracker Strokes set before it is used

### 41.9.3 Trackers and Expected Value Calculations

While expected value (EV) analysis is not recommended for trees in which trackers are referenced in probability or reward calculations, this type of analysis is not disabled. Since tracker modifications are only meaningful within simulation trials, TreeAge Pro generally ignores them during EV calculations, including Monte Carlo PSA. Outside of simulation trials, the values of trackers will be equal to their initialization value.

One exception to this rule is when an expected value analysis makes a call to the Node() function which in turn runs a set of microsimulation trials at another location in the tree. See the information on the Node() function in the Tools and Functions for Complex Trees Chapter and the Markov Modeling Tools and Techniques Chapter.

A more efficient replacement for recursive variable definitions is another possible application of trackers in expected value calculations of regular trees. In Tree Preferences, under Other Calc Settings, there is
a preference that must be turned on for tracker modifications to work like recursive variable definitions during regular, non-microsimulation analyses.

In light of the potential for error, it is advisable to limit analysis of trees that require trackers to microsimulation only. For the purposes of EV analyses like roll back or one-way sensitivity analysis, it may be desirable to either use the advanced Node() linking function or to develop a modified version of the model in which calculations do not depend on trackers.

### 41.10 Debugging Simulations, the Calculation Trace Console

TreeAge Pro has several tools to assist with debugging models. The Calculation Trace Console can be used to display/report a variety of textual information to help debug a model, including: error messages, text-only analysis output, stored analysis summaries, and detailed internal calculations (e.g., step-by-step evaluation of variables). This section will describe these tools.

To turn on output of the Calculation Trace:

- Choose Tree > Tree Preferences from the menu or press F11.
- Navigate to the Tree Preferences category Analysis Settings > Debugging/Calculation Trace Console.
- The Tree Preferences dialogue gives many options to debug your model.
Tree Preferences - Debugging/Calculation Trace Console

**Show Output for: All**

This option gives you the option of sending to the Calculation Trace Console: each variable, probability, and calculation in detail in the Calculation Trace Console View. The Calculation Trace Console View can be found in the Console View, as shown in the figure below.

Calculation Trace Console View

Turning on Internal Calculations can significantly slow the analysis. There are additional, more refined options which will still allow you to examine specific calculations without displaying every single external calculation.
41.10.1 Use Debug output for Selected Elements

This is the most effective way to debug specific elements of your model. This feature, added in 2018 R1.0, allows you to select Variables, Trackers and Distributions to debug by selecting them from the appropriate View (Variable Properties, Tracker Modifications and Distributions).

The figure below shows selecting specific variables in a model to debug. More details about this can be found in the Section: Debug using the Calculation Trace Console.

41.10.2 Using the Debug() function

The Debug() function can be used to control/limit debugging output during simulations, or to add custom text to the pane. This may be of interest when an internal calculation debugging output may be millions of lines per analysis. Use the Debug() function to dynamically turn on and off the flow of calculation outputs to the Calculation Trace Console at strategic points in the analysis.

Refer to the Modelling Debugging and Validation Chapter for details on how to use these tools in your models. The Tools and Functions for Complex Trees Chapter also provides details on the Debug() function syntax.

41.10.3 Using the GlobalN() function

Another more customizable approach to debugging complex simulations involves the Global matrices. The GlobalN() and Global() functions can be used in a variety of ways, and are capable of storing millions of user-specified values and calculation results during simulations and other analyses.

The section on parallel trials and dynamic microsimulation later in this chapter provide additional discussion about using the GlobalN function for reporting. For more details, refer to the Tools and Functions for Complex Trees Chapter.

41.11 Other Aspects of Microsimulation

Markov microsimulation is a very broad topic and TreeAge Pro includes numerous microsimulation options and features which may be of interest in select instances.
41.11.1 Markov Termination During Simulation Trials

By default, Markov process calculations terminate during microsimulation trials when *either* the termination condition is true *or* a trial enters an absorbing state. It is possible to turn off the latter behavior so that trials will continue processing even after entry into an absorbing state. Changing this default setting is likely to be appropriate in only a few Markov models (e.g., where absorbing states do not correspond to dead states or other endings of the Markov process). This setting is found in the Other Calculation Settings category of the Preferences dialog. The default for this option is checked.

![Tree Preferences - Terminate trials](image)

The Terminate upon entry into absorbing state setting generally substitutes for the threshold portion of the default Markov termination condition (i.e., \(_\text{stage\_eff} < 0.001\)”). The threshold part of the condition should generally be removed for microsimulation models.

41.11.2 Using Logic Nodes in a Markov Microsimulation

A *logic node* acts like a decision node, in that it selects one path from its branches; rather than looking at expected values, however, it chooses a path by evaluating logical expressions. Starting at the top branch, the first node with an expression that evaluates to *true* is selected. A simple logic node might have two branches, X and Y, with the expression \(_\text{stage} > 4\) below branch X and \(_\text{stage} \leq 4\) (or \(#\)) below branch Y. When the logic node is encountered, either branch X or branch Y is followed based on the current value of \(_\text{stage}\).

Most logical expressions in Markov processes will reference the values of trackers. For example, in Markov Monte Carlo #2 and #3, a tracker serves to remember the current size of a tumor during a
simulation trial, while a logic node determines whether to transition to a Metastatic state based on the value of this tracker.
42. Microsimulation Time Reporting

Time Reporting allows you to record data updates during Microsimulation, then generate reports based on the time-based data. Standard reporting from Microsimulation includes data for each trial at the end of the analysis. Time reporting extends Microsimulation to allow for reporting on data as it changes during each patient's path through the model.

We will look at two Health Care tutorial example models - one Markov model (here) and one DES model (in another chapter) - as we examine this functionality. We will start with the Markov model since that is the topic of this chapter.

42.1 Configure the Model for Time Reporting

The model Markov.Cancer.TimeReporting.trex is configured for Time Reporting via its Tree Preferences. Let's examine the settings.

Time Reporting Tree Preferences

The preferences above are used to turn on/off the recording of time data and to determine what data items to store.

- **Enable Time Reporting**: Select to turn on time reporting. Turn this off when no Time Reporting is needed as this slows down the analysis.
- **Skip records without data updates**: Check this to limit the number of records stored in the database by skipping records when data has not changed. (Usually you would NOT check this box).
- **Data Items**: Select all the data items you want stored for reporting.

With the selections above, all model data will be recorded.

If you want to store the value of a variable or keyword with Time Reporting data, use a tracker and set the tracker value to the variable/keyword you want stored. Then include the tracker in Time Reporting preferences. In this model, the \texttt{t\_state} tracker is used to store the value of the \texttt{\_state\_index} keyword by cycle at each health state.

### 42.2 Time Reports

Since the model is configured for Time Reporting, there are additional secondary reports available in the Microsimulation results.

To recreate these results, run microsimulation for 1000 trials and see the Monte Carlo Simulation C-E statistics, as in the figure below. Expand the 'Time Reports' to see the additional reports.

The Cohort Report and Trial Report will not run correctly if you do not select in the Tree Preferences to record at least the active payoffs (cost and effectiveness in this model) and 'uncheck' the section 'do not skip records with no data updates'.
Accessing Time Reports

There are six types of links for Time Reports.

- All Data: Report all data by trial and time.
- All Data Export: Export all data to an Excel-compatible format.
- Trial: Report data for a single trial by data item and time period.
- Data Item: Report data for a single data item by trial and time period.
- Cohort (per strategy): Aggregates individual trial data per cycle and presents outputs in relation to the percentage of the cohort.
- Trial (per strategy): Details about how each trial passes through the model.

Each report has additional selection criteria to choose the elements to include in the report. We will look at these reports in detail in the following sections.

You can use Time Reporting for other kinds of debugging/validation as well. If you think of something that would be helpful if integrated into the software, please send us the suggestion.
42.3 Cohort Report (per strategy)

The Cohort Report (per strategy) provides details into the flow of individuals through the model. The report uses the identical format as the Markov Cohort Extended Report; however, the data is generated in two different ways.

- In Markov Cohort Analysis, the Extended Report provides visibility into the internal calculations executed during Markov Cohort Analysis as the cohort moves through the model.
- In Microsimulation Time Reporting, the individual patients are aggregated at each node using the time reporting data as each trial passes through specific nodes (state or transition) in each cycle. The aggregated data is then presented as percentages of the cohort and reward accumulation just like the Markov Cohort Extended Report.

We consider Tx1, one of the two strategies in this model. From the Time Reporting options, select the Cohort (Tx1) report and it generates the Monte Carlo Time Cohort Report in the figure below, which shows some paths expanded.

![Monte Carlo Time Cohort Report](image)

The report accumulates rewards, trackers and payoffs based on the specific node and cycle dependent on the percentage of overall trials. The percentages and the rewards are derived from the actual
numbers of trials in each state/transition and also the rewards accumulated for each trial in each state/transition.

For example, since 1000 trials were run through the model, 821 trials were still in the Local Cancer state at the beginning of _stage 1, resulting in a cohort percentage of 0.821. Those 821 trials, generated a cost of 16,850,000 at the Local Cancer state node, which is shown as a percentage of 1000 trials with the value 16,850.

Individual trials may have data items, such as trackers, which are updated several times per cycle. We can examine each node in detail to see where the trackers are updated using the 'Trial - All Data Items per Time Period' (see later section). In this Cohort Report, the average tracker value for the cohort per cycle is shown. The calculation of this average value is based on the value of the data item across all trials (dead and alive) per cycle.

For example, consider the tracker t_state capturing the state index (via the keyword _state_index) for each trial. There were 1000 trials run through the model and at _stage 0 all trials started in the Local Cancer state. The report will show the average value for tracker t_state using the calculation: 1 *1000 /1000 = 1. For _stage 1, there are 821 trials in Local Cancer State (_state_index = 1), 162 are in Metastases State (_state_index = 2) and 17 are in the Dead State (_state_index = 3). Therefore the average value for tracker t_state is calculated as: (1*821 + 2*162 + 3*17) / 1000 = 1.196.

The summary data at the bottom of the report shows the final breakdown of the 'cohort' from microsimulation among states including the source of all reward data.

The secondary reports on the right-hand side also present the aggregated data for all trials in the microsimulation into cohort type graphs. More details about these graphs can be found in the section: Secondary - Markov Cohort Graphical Output since the output uses the same format.

### 42.4 Trial Report (per strategy)

The Trial Report (per strategy) provides a details on how each individual passes through the model to track patients. The report uses a similar format to the Markov Cohort Extended Report; however, the data is shown for one individual at a time.

Time reporting records the path of each trial by Stage and State/Transition. The Trial Report provides a trace of a single trial's path in a familiar format. Since the report considers each trial one by one, so there is no need for cohort percentages. If a state or transition node is shown, that patient passed through that node in its path. The report follows the path of each trial until its path is complete.

The Trial Report shows the accumulation of rewards (cost and effectiveness) and other payoffs, trackers and distributions. There are no average tracker values here because we are looking at an individual's tracker values over time.
We consider Tx1, one of the two strategies in this model. From the Time Reporting options, select the Trial (Tx1) report and it generates the Monte Carlo Time Trial Report as in the figure below.

The columns in the Trial Report are the same for all Trials, but the number of stages and the states/ transitions for each trial will be different. For example, in the report above Trial 1 starts in Local Cancer and remains there (via the transition Stay Here) until _stage 6 when he/she experiences the transition Progress to Metastases, moving the person to the Metastases state for the beginning of _stage 7. For each state and transition, the patient can accumulate rewards that are reported in the Cost and Effectiveness columns.

Using the buttons at the top of the report or enter the Trial number, we can consider each trial one by one. The path of each trial will be different and this report automatically generates a way to see each trial's path.

Note the final values at the bottom of the Trial Report will match the final values reported in the All Data Report (not time report) as shown below.
Relationship between time reporting and final values in All Data Report

There are no secondary reports for this trial-level tracking report.

42.5 All Data Report

The All Data report outputs all data collected during the analysis. When selected, the following dialog allows you to further specify the data to present. Specifically, choose a trial range and which strategies to include. You can also choose which node-related information you wish to include in the report - node type, node label and/or node ID.

TreeAge Pro 2017 R2.0 introduced new reports for microsimulation that present data in a more recognizable format similar to the Markov Cohort Analysis reports. Refer to the Cohort Report and Trial Report sections earlier in this chapter.
All Data Report Selection

With the selections above, the first 10 trials data for only the first strategy are included in the report.

If you run PSA & Trials or EVPPI/PSA & Trials, you can also select a range for each outer loop iteration (PSA and/or EVPPI).

All Data Report

The All Data Report can be used to see the full path of each patient as it travels through the model. Note the data starts with Trial 1, but has a separate record for every node that patient hits in the model. Meanwhile the other data (like cost/ATTR1 and effectiveness/ATTR2) is also collected.
This report can be exported to Excel via the "Open in New Excel Spreadsheet" icon to the top right of the report data pane. Once the data is in Excel, it can be further formatted to make it easier to see the path of the patient.

You can open the companion document Markov.Cancer.TimeReporting.xlsx to see how the data can be formatted for examination in Excel.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
<th>O</th>
<th>P</th>
<th>Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Generated from Microsimulation &gt; Time Reports &gt; All Data Report</td>
<td>Formatted data from raw data at left showing strategy and node label</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Raw Data</td>
<td>Formatted Data</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>TRIAL</td>
<td>STRATEGY</td>
<td>STAGE</td>
<td>TIME</td>
<td>NODE TYPE</td>
<td>NODE LABEL</td>
<td>PAYOFF 1</td>
<td>PAYOFF 2</td>
<td>T</td>
<td>STATE</td>
<td>TAE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>ChanceNode</td>
<td>Local Cancer</td>
<td>10000</td>
<td>0.475</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>6</td>
<td>ChanceNode</td>
<td>No Adverse Event</td>
<td>10000</td>
<td>0.475</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>TerminalNode</td>
<td>Stay here</td>
<td>10000</td>
<td>0.475</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>ChanceNode</td>
<td>Local Cancer</td>
<td>30000</td>
<td>1.425</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>ChanceNode</td>
<td>No Adverse Event</td>
<td>30000</td>
<td>1.425</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>TerminalNode</td>
<td>Stay here</td>
<td>30000</td>
<td>1.425</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>ChanceNode</td>
<td>Local Cancer</td>
<td>50000</td>
<td>2.375</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>ChanceNode</td>
<td>No Adverse Event</td>
<td>50000</td>
<td>2.375</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>TerminalNode</td>
<td>Stay here</td>
<td>50000</td>
<td>2.375</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>3</td>
<td>ChanceNode</td>
<td>Local Cancer</td>
<td>70000</td>
<td>3.325</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>3</td>
<td>ChanceNode</td>
<td>No Adverse Event</td>
<td>70000</td>
<td>3.325</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>3</td>
<td>TerminalNode</td>
<td>Stay here</td>
<td>70000</td>
<td>3.325</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>4</td>
<td>ChanceNode</td>
<td>Local Cancer</td>
<td>90000</td>
<td>4.275</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>4</td>
<td>ChanceNode</td>
<td>No Adverse Event</td>
<td>90000</td>
<td>4.275</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

All Data Report in Excel

In the Excel document...

- Columns A-J come directly from the time report created above.
- Columns L-R are reformatted versions of the data to make it easier to follow.
- Columns T-U are a lookup table to translate the strategy ID to text.

The data now shows the path each of the first 10 patients took as it passed through the model along with the value for cost and effectiveness accrued at that time. This can be very useful for debugging/validation models.

Note that the All Data Report can also be exported directly to an Excel compatible file format via the "All Data (Export to CSV)" secondary report link.

**42.6 Trial - Data Items by Time Period Report**

The Trial Report includes all data related to a single trial and strategy.
Trial Data Report Selection

Since every update is not shown in the report, you can choose the appropriate Time Period for the report. Native for Markov models is once per cycle. You can use the Roll Up option to show data for fewer time periods. For example, if you have a monthly cycle, but want to report annual results, choose Roll Up with 12 periods. The report below uses the criteria specified above.

Trial Data Report

Note that each row represents a different data item, while each column represents the value for that data item at the end of each cycle.

TreeAge Pro 2017 R2.0 introduced new reports for microsimulation that present data in a more recognizable format similar to the Markov Cohort Analysis reports. Refer to the Cohort Report and Trial Report sections earlier in this chapter.

42.7 Data Item - Trials by Time Period Report

The Data Item Report includes all data related to a single data item reported by trial and by time period.
Data Item Report Selection

You must choose a single strategy and data item for the report. Then choose a trial range and a time period. Roll up is available if you want to report on a time period other than the native cycle length.

Data Item Report

Because the model stored the _state_index value in the t_state tracker, this report provides a history of the movement of each patient among the health states from cycle to cycle. By exporting this report to Excel, you can recreate a Markov trace and a Survival Curve from a Microsimulation model.

TreeAge Pro 2017 R2.0 introduced new reports for microsimulation that present data in a more recognizable format similar to the Markov Cohort Analysis reports. Refer to the Cohort Report and Trial Report sections earlier in this chapter.
Data Item Report in Excel

With the appropriate formulas using the CountIF Excel function, it is possible to count the number of trials in each state at the beginning of each cycle (because the tracker is updated at the beginning of the cycle). See below.
42.8 Time Reporting for DES Models

Time Reporting can also be enabled for Discrete Event Simulation (DES) models. This is described in the Discrete Event Simulation (Time-To-Event) Chapter.
43. Calibration

This chapter describes how Calibration allows you to automatically adjust model input values to match against targets, based on observed clinical data. The calibration process adjusts the input values iteratively until the model generates outputs which best match your targets.

This Chapter focuses on an example with a Markov model and observed survival data as an illustration of the calibration process.

43.1 Calibration Overview

It is important that a model mirrors true disease progression and treatment effects as accurately as possible.

When creating the appropriate patient pathways, it can be challenging to derive appropriate Markov transition probabilities to accurately represent clinical outcomes. You may build a model based on your understanding of disease progression, but the model outputs may not match to observed data.

Calibration automatically adjusts model inputs, so that the resulting outputs match to targets. Prior to running calibration, you must do the following.

1. Setup the calibration with the appropriate optimization algorithm and tolerance levels.
2. Identify the model inputs that can be adjusted.
3. Identify model outputs to match to target values.

The calibration process then adjusts the model input values iteratively to match outputs against your targets.

43.2 Calibration Example Model

Consider the Healthcare Example Model, Calibration-Markov.trex. This Markov model is set up to run Calibration, but this chapter will take you through the steps to set up any model type for calibration.
This model compares two treatment strategies - Tx1 and Tx2 - with each represented by a Markov model. The Markov model structure is the same for both treatments, with Tx1 being a clone master and Tx2 a clone copy.

We have estimated the following transition probabilities for movement between the health states.

- Local Cancer to Metastases (pLocalToMets1 and pLocalToMets2)
- Local Cancer to Dead (pLocalToDead)
- Metastases to Dead (pMetsToDead)

We also have observed 5-year progression-free and overall survival data for both strategies. When we examined the 5-year survival data generated from the model via the Markov Cohort reports, we found that it was too high.

Now let's look at how calibration helps us bring model results in line with observed data.
43 Calibration

43.3 Setting Up Model Outputs for Calibration

We introduced this calibration problem by suggesting that 5-year progression-free and overall survival data from the model is too high relative to observed data. This section describes how we examined the model's survival data and then how we added model outputs specifically for that survival data.

In the Healthcare Example Model, Calibration-Markov.trex, we can examine Markov Cohort Extended report to determine the 5-year survival (PFS & OS) currently generated by the model.

![Markov Cohort Extended Report](image)

**Survival from Markov Extended Cohort Report for Tx1**

Note that the state probabilities (cohort%) at _stage 5_ for Local Cancer and Metastases provide us with the 5-year survival values.

- Progression-Free 5-year Survival (Local Cancer) is 0.41650
- Overall Survival 5-year Survival (Local Cancer + Metastases) is 0.84543

However, imagine that our observed data for Tx1 is lower:

- Progression-Free 5-year Survival (Local Cancer) is 0.401
- Overall Survival 5-year Survival (Local Cancer and Metastases) is 0.836

This indicates that our model is overestimating survival. We did not look closely at Tx 2, but consider the same kind of survival overestimation for that strategy as well.

For the purposes of calibration, we need the PFS and OS 5-year survival to be an *independent outcome of the model*. Therefore, we need to create new payoffs specifically to return those values when the model is analyzed.
Healthcare Example Model, Calibration-Markov.trex already has the outcomes in place, but we can examine these elements of the model. Note that the model is setup for 7 payoff sets. This generates 5 extra outputs beyond the primary ones - cost and effectiveness.

Extra payoffs in calibration model

Custom payoff names are used to identify what each payoff set represents.

Custom payoff names in calibration model

Those Tree Preferences settings establish the two survival measurements as model outputs/payoffs. The model also calculates those survival values appropriately within the Markov model.
In the figure below, you see the Markov Info View's Health States tab for Tx 1. Note that the state reward for the Local Cancer state in both payoffs 6 & 7 (survival) is the formula \( \text{if}(_\text{stage}=5; 1; 0) \). This formula returns 1 only at _stage 5, which is 5 annual cycles into the future. The "1" (in the if statement) is multiplied by the cohort % in that state at that time, such that the output is the cohort %. Therefore, the payoff is only updated with the cohort % at 5 years, resulting in 5-year survival.

Since the Local Cancer state is progression-free, its cohort % is applied to both progression-free survival (payoff 6) and overall survival (payoff 7). However, the Metastases state is post-progression, so its cohort % is applied only to overall survival (payoff 7).

Calculating survival within the Markov model

With these payoffs and state rewards in place, 5-year progression-free survival and 5-year overall survival are now primary outputs of the model, ready for use during calibration.
43.4 Calibration View

The Calibration View is used to setup and run the calibration process. You can open it via the Views menu in the toolbar.

The Calibration View contains four tabs which facilitate the calibration process.

- **Setup:** Set up the calibration analysis type, algorithm and tolerance.
- **Inputs:** Choose the model input parameters that can be adjusted by the calibration process.
- **Targets:** Choose the model outputs and target values for those outputs.
- **Results:** Presents the results from the calibration process.

Subsequent sections will describe each tab in detail.

You can Run/Stop the calibration process with any of the tabs selected.

43.5 Calibration Setup

The Calibration View - Setup Tab is used to configure the calibration process.
The options to set on the Setup tab are:

- **Analysis Type**: The model is run via Cohort Analysis or Microsimulation.
- **Optimization Algorithm**: The calibration supports two algorithms - BOBYQA and Nelder-Mead.
- **Optimization Goal**: Minimize or Maximize the optimization value. For most calibrations, you will minimize an error function (see Targets tab).
- **Optimization Threshold**: Set thresholds to determine when the calibration has identified sufficiently close matches to the targets. Relative refers to the difference between subsequent calculations. Absolute refers to the overall error function calculation.
- **Max Calculations**: The maximum number of calculations done in calibration to find the targets.

**Optimization Algorithms**

Both algorithms use stochastic behavior to determine optimal input values through an iterative process.

- **BOBYQA**: Tends to avoid getting stuck in local optima that may not reflect the global optimum.
- **Nelder-Mead**: Common algorithm used in many software packages.

The Calibration-Markov.trex example model has settings on the Setup tab which are appropriate to begin the calibration. If you are starting from scratch, you can start with the same options for your model.

### 43.6 Calibration Inputs

The Calibration View - Inputs Tab is used to select the input parameters that can be modified by the calibration process. The following figure shows the Inputs Tab prior to selection of any specific inputs.

![Calibration View before any calibration inputs are selected](image)

The tab has the following sections:
- **Available inputs**: This lists all model input parameters. Choose the inputs you want to include from this list via the "Add variable" button. Use the "Delete variable" button to remove a selected input.

- **Selected input list**: This lists the variables which have been selected to be adjusted in the calibration. After selecting a variable, you will need to add details about how they can be changed as part of the calibration process.

In our Example model, the selected inputs are transition probabilities which will directly impact the 5-year survival values. You would select inputs appropriate for your calibration.

**To add parameters to Calibration Inputs:**

- Select the parameter from the Available inputs box and use the "Add variable --->" button below to add it to the list on the right handside. Once selected, you must then enter additional information for each input.

![ Calibration Input Table ]

- **Initial value**: This is the input value used for the first calculation in the calibration process. It is initially populated with the current value from the model.

- **Initial step**: This is the size of the first value change as the inputs are modified by the calculation process. In the example model we have used 0.005.

- **Lower bound**: This is lower limit for the input. The calibration will not change the input value below the lower bound. In this model it will be set to the lowest value of the parameter for pLocalToMets1 which is 0.13.

- **Upper bound**: This is upper limit for the input. The calibration will not change the input value above the upper bound. In this model it will be set to the highest value of the parameter for pLocalToMets1 which is 0.17.

⚠️ Set reasonable lower and upper bounds for your parameters. You don’t want the calibration process trying unreasonable values.

If you enter invalid data (no step, upper bound < lower bound) errors will be reported below the inputs list. See figure above where an error is highlighted by the red arrow.
Healthcare Example Model, Calibration-Markov.trex already has inputs selected and steps/limits defined as show in the figure below.

43.7 Calibration Targets

The Calibration View - Targets Tab is used to select model outputs and the target values for those outputs. The following figure shows the Targets Tab prior to selection of any specific targets.

The Targets Tab contains the following elements:

- **Goodness of fit type**: Select the type of calculation used to measure a model calculation's "goodness of fit". Typically, you can use the default value "Simple Sum of Square Differences" to minimize an error function when matching results. To weight targets differently, choose the
"Expanded Sum of Square Differences" option. "Custom Expression" allows you to create your own function.

- **Available targets:** This lists all model outputs - specifically payoffs and trackers. Choose the outputs you want to include from this list via the "Add target" button. Use the "Delete target" button to remove a selected output.

- **Selected target list:** This lists the the outputs which have been selected to match to target data during the calibration. After selecting an output, you will need to add details related to the target value you wish to match with the model output.

- **Final expression:** This is the actual calculation of the "goodness of fit" function based on the type and/or custom expression entered.

**To add targets to the Calibration View:**

- Select a model output from the Available targets box and click the "Add target --->" button to add it to the selected targets list on the right handside. Once selected, you must then enter additional information for each target.

Payoff 6 (PFS 5-year survival) added as a target for calibration - required for both Tx1 and Tx2.

- **Strategy:** Select the strategy for this target because the model output values are calculated for each strategy. In our model we need to have Payoff 6 for both Tx1 and Tx2, so we will choose that option twice with different matching target values.

- **Target value:** Set the target value for the model output and strategy selected. The calibration process will then attempt to match the output to that target by changing input values. In the example model, Payoff 6 for Tx1 has a target value of 0.401.

- **Weight:** Weighting is specifically used for the "Expanded Sum of Square Differences" fit type. Higher weights will put more emphasis on matching that target over other targets.

- **Final expression:** This is automatically populated based on your selection of Goodness of Fit type and Targets.
If you enter invalid data (repeat targets, missing target values) errors will be reported below the inputs list. See figure above.

In the example model, all the targets have been set and the model is ready to Run.

**43.8 Running Calibration**

Once the Setup, Inputs and Targets are ready, click the "Run" button at the bottom of the Calibration View. The Results Tab will then be selected automatically.

Before running the calibration, it will be blank as shown in the figure below.

The calibration process will start by running the model with your initial values. It will then compare the target model outputs to the target values. Then the inputs will be modified according to the calibration.
algorithm and the model is recalculated with new inputs. This process is repeated iteratively until the
targets match within tolerance or you reach the maximum number of model calculations.

You can stop the calibration at any time via the Stop button at the bottom right. The figure below shows
the calibration stopped after 89 calculations with the 86th calculation marked in green as the best match
of target values.

![Calibration results - highlighting the current best “goodness of fit” combination of inputs.](image)

The Results view during/after a calibration run includes:

- **Results List**: A list of all model results including the value for each input, the "goodness of fit"
  value, each calculated target output and the difference between the output and its target value.
  The best fit row is marked in green.

- **Results Graph**: Shows the change in the goodness of fit for each model calculation (iteration).

  You should see overall improvement in the fit overall as the process continues. We recommend
  viewing this with the Logarithmic scale, which makes it easier to see changes in the fit function
  over time.

- **Save as .RPTX Option**: This will save the calibration output for viewing later.

After the calibration has finished or been stopped, you can choose from these functions:

- **Use inputs in model**: This will replace all the selected input values within the model with new
  input values from the calibration process.

- **Use inputs for new calibration**: This will replace all initial values for your calibration with new
  input values from the calibration process. Then you can run another calibration using the new
  starting point and perhaps a different algorithm.
### 43.9 Interpreting Results

Now, let's examine the final calibration results for our Healthcare Example Model, Calibration-Markov.trex. The results below reflect the pre-established setup, inputs and targets in the example model.

#### Inputs before and after calibration

<table>
<thead>
<tr>
<th>Input</th>
<th>Initial Value</th>
<th>Calibration Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>pLocalToMets1</td>
<td>0.15</td>
<td>0.151409</td>
</tr>
<tr>
<td>pLocalToMets2</td>
<td>0.14</td>
<td>0.141265</td>
</tr>
<tr>
<td>pLocalToDead</td>
<td>0.01</td>
<td>0.014938</td>
</tr>
<tr>
<td>pMetsToDead</td>
<td>0.10</td>
<td>0.092151</td>
</tr>
</tbody>
</table>

Note that the calibration process ran the model 102 times before it found a "goodness of fit" calculation within the defined tolerance.

Remember that the original model overestimated 5-year PFS and OS for both strategies, so we can expect that the calibration would increase progression probabilities to reduce survival. Let's look at the original inputs and outputs relative to those values determined by calibration.

#### Outcome

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Initial Output</th>
<th>Calibration Output</th>
<th>Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>PFS Tx 1</td>
<td>0.417</td>
<td>0.401000</td>
<td>0.401</td>
</tr>
<tr>
<td>OS Tx 1</td>
<td>0.845</td>
<td>0.836001</td>
<td>0.836</td>
</tr>
<tr>
<td>PFS Tx 2</td>
<td>0.442</td>
<td>0.426000</td>
<td>0.426</td>
</tr>
</tbody>
</table>

Note that calibration increased the probabilities for both strategies' progression and the common local cancer death probability, while the metastases death probability was slightly lower.

As a result of these changes to the inputs, we can see how the model's survival outputs now more closely match the target values.
Note that the calibration process was able to match up results nicely with the observed target values.

We can hope that our calibrated model is more realistic since it matches our observed data better. However, this does not guarantee that the model is perfect. You still need to start with a good model that accurately reflects disease progression.
44. Synchronized Patient Simulation

This chapter describes synchronized patient simulation models that run patients in parallel to allow for interaction among patients. We refer to this within TreeAge Pro as parallel trials, which is an option presented when running Microsimulation.

Note that typical microsimulation models do not require synchronization by time, so each patient/trial finishes processing before the next one is run.

This Chapter will focus on a few example models in detail to explain how to set up models analyse parallel trials.

44.1 Synchronizing Patients by Time - Parallel Trials

Synchronized patient simulation models run individual patients/trials through the model in a at the same time. Every trial runs through each Markov cycle before anyone proceeds to the next cycle.

With trial cycles synchronized, you can now build interaction among the individuals within the overall trial set. Here are a few examples of patient-to-patient interaction.

1. One individual might experience a risk of infection that is based on the percentage infected relative to the overall population (e.g., infectious disease).
2. Individuals may compete for a limited resource (e.g., hospital beds).
3. One individual might directly affect another individual (e.g., infection, pregnancy).

Examples of patient interaction

Most microsimulation models will not require this kind of interaction, so the trials can proceed in sequence rather than in parallel. If you do build interaction into your model, you will need to specifically choose to run microsimulation with the parallel trials option selected.

The remainder of this chapter describes different ways to take advantage for parallel trials to build complex models.

44.2 Resource Constraint/Queue Model

This section introduces a synchronized patient simulation model in which patients compete for a limited resource. In this model, the limited resource is access to treatment. When one or more Treatment “spots” is available, a patient can begin treatment. While that person is holding that treatment spot, no other patient can take it.

Parallel trials are required for this model so that patients can compete for this resource in every cycle.

Open the Healthcare tutorial example tree, Parallel Trials - Queue - GlobalTracker.trex. The model structure is a Markov decision model with two strategies: one with 2 resources available (Treatment
Resources 2) and one with 3 resources available (Treatment Resources 3). The strategies use the same Markov model structure via cloning.

The Markov model includes health states:

- Healthy
- Sick - waiting for treatment
- In treatment - holding resources
- Recovered
- Dead

The limited resource is held within the *In Treatment*... state. Only a few patients can be in that state during any cycle. In both the *Healthy* and the *Sick*... states, there are transitions/events where a patient/requests a Treatment resource, but not all patients can get the limited resource.

The figure below shows the structure of the model (with Comments and Variable/Markov Info hidden via Tree Preferences).

Model structure showing the first 3 health states in the Parallel Trials models

Note the two transitions where a trial requires treatment and wants access to the limited treatment resource.
- Healthy > Get sick, Need Treatment
- Sick, Waiting for Treatment > Is Treatment Available

When a patient/trial reaches one of these transitions, its next step depends on whether a resource is available, which in turn depends on whether all of the limited resources are in use by other patients. Trials will generally be split into these categories relative to the resource:

1. Trials who hold the resource
2. Trials who want to hold the resource
3. Trials who do not need the resource

Imagine 10 trials want the resource, but there are only 2 resources available. Only 2 of the trials will get the resource in that cycle, and the other 8 will have to wait, creating a queue of patients waiting for the resource. When one of the 2 trials holding the resource releases it, another trial currently waiting for that resource will get it.

The two Stop nodes in the patient pathways represent that queue. The Stop node forces a trial to wait mid-cycle for other trials to potentially release the resource. Let's examine how trials are processed when run in parallel with Stop nodes.

1. Trial set begins.
2. Start cycle.
   1. Run pre-cycle script.
   2. Run all trials in numerical order for this cycle until each trial reaches either a Terminal node or a Stop node.
   3. Run stop-cycle script.
   4. Finish cycle for each trial held at a Stop node until they all reach a Terminal node.
   5. Run post-cycle script.
3. Repeat Step 2 for all cycles.
4. Trial set is complete.
5. Generate reports by trial and by trial set.

Parallel Trials Processing

Note that a trial who already has a resource will not wait at a Stop node. Instead he/she will continue through a patient pathway to a Terminal node. Along the way, the trial may or may not release the resource.

Other trials who do not need a resource will also continue through a patient pathway to a Terminal node. However, those trials who reach a Stop node will not immediately continue to the end of the cycle. Instead, they will wait until other trials finish the cycle. Finally, all the trials waiting for the resource will run from the Stop node to a terminal node to complete the cycle.
Pre-cycle, mid-cycle and post-cycle scripts facilitate complex logic within the model. These will be discussed later in this chapter.

The figure below shows the first Stop node in the model which is in the Healthy state. This represents one of two Stop nodes in the model that both control access to the same treatment resource.

Stop node in the Healthy State

When it is time to continue on from the Stop node, all resources that will be released this cycle have been released. Trials will be given the resource until there are no more resources available.

The Stop node then functions like a Logic node, with logical expressions under its branches. Those logical expressions will drive the next step in the patient pathway. In this model, the logical expressions reference a Global Tracker to determine if there is a resource available. The expression `GlobaltrkGet("gt_AvailableResources") > 0` will only be true if there is a resource available, sending the trial to the **In Treatment, Holding Resource** health state.

We will discuss Global Trackers in the next Section.

### 44.3 System Environment/Global Trackers

This section continues to examine the Healthcare tutorial example tree, Parallel Trials - Queue - GlobalTracker.trex. Specifically, this section describes the use of Global Trackers to control access to the limited treatment resource.

Global Trackers are used to control the model at a system level - affecting all patients within the system for that particular strategy. This is quite different from regular Trackers which are associated with each specific patient within a strategy. Global Trackers are useful for storing values which need to be accessed and updated by all the trials in the model. They can be read and or updated by any patient at any node in the model.
In this example model, Global Trackers are used to store the number of available treatment resources. The Global Tracker \texttt{gt\_AvailableResources} is defined on the Global Trackers View. This View has similar tools to other Views available in TreeAge Pro. When you create a new Global Tracker, you can edit the initial value via the Add/Change dialogue as in the figure below.

![Add/Change to a Global Tracker](image)

In this instance, we set the initial value of the \texttt{gt\_AvailableResources} to 0 for each strategy. We will need to set the proper number of resources to 2 and 3 for the top and bottom strategies, respectively.

The Add/Change dialogue also allows modifications and ranking report values to be shown or hidden by selecting the check box.

For Global Trackers, there are three commands we can use to change their value.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlobalTrkGet(&quot;gt_Name&quot;)</td>
<td>Retrieves the current value of global tracker \texttt{gt_Name}.</td>
</tr>
<tr>
<td>GlobalTrkSet(&quot;gt_Name&quot;; value)</td>
<td>Sets the global tracker \texttt{gt_Name} equal to value.</td>
</tr>
<tr>
<td>GlobalTrkIncr(&quot;gt_Name&quot;; increment)</td>
<td>Increments the global tracker \texttt{gt_Name} by \texttt{increment}. Note that \texttt{increment} can be positive or negative.</td>
</tr>
</tbody>
</table>

Global Tracker Commands

Note that when a Global Tracker is updated with the second or third function above, you will need a place to enter that into the model. Typically, this can be done through a tracker modification. Note that in this example model, \texttt{t\_action} is used to update the Global Tracker. We don’t care about the value of \texttt{t\_action}, but we will use this tracker to execute the Global Tracker updates.
We can now look at how the Global Tracker is used within the model in conjunction with the Stop node. There are three distinct places where these values need to change within the example model.

<table>
<thead>
<tr>
<th>Node</th>
<th>Syntax</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Markov node tracker</td>
<td>( t _action = \text{if}(_\text{trial}=1; )\text{GlobalTrkSet(&quot;gt_AvailableResources&quot;;} ; )N_resources_total); 0))</td>
<td>Sets the number of available resources for each strategy.</td>
</tr>
<tr>
<td>Waiting for Resource logical expression</td>
<td>( \text{GlobalTrkGet(&quot;gt_AvailableResources&quot;)} &gt; 0 )</td>
<td>Check for whether a resource is available.</td>
</tr>
<tr>
<td>Get Resource tracker modification</td>
<td>( t _action = \text{GlobalTrkIncr(&quot;gt_AvailableResources&quot;}; -1) )</td>
<td>When resource is taken, decrement available resources by 1.</td>
</tr>
<tr>
<td>Release Resource tracker modification</td>
<td>( t _action = \text{GlobalTrkIncr(&quot;gt_AvailableResources&quot;}; 1) )</td>
<td>When resource is released, increment available resources by 1.</td>
</tr>
</tbody>
</table>

**Uses of Global Trackers in Model**

We know that patients currently holding the resource will have the opportunity to release it before patients request the resource because the waiting patients halt mid-cycle at a Stop node.

Let's consider two trials waiting at the Stop node below, where only one resource is available. Note that this would work the same for either Stop node.

**Stop node in the Healthy State**

1. Trial 1 sees the available resource because \( \text{GlobalTrkGet("gt\_AvailableResources")} > 0 \) returns true when there is a resource available.
2. Trial 1 proceeds to the GetResource node.
3. Trial 1 executes the tracker modification \( t \_action = \text{GlobalTrkIncr("gt\_AvailableResources"}; -1) \), which reduces the number of available resources to 0.
4. Trial 2 sees no available resource because \textit{GlobalTrkGet(“gt\_AvailableResources”)} > 0 returns false.

5. Trial 2 proceeds to the \textit{Wait for Available Resource} node, and continues to wait for the resource into the next cycle.

\textbf{Two trials at stop node}

The Global Tracker \textit{gt\_AvailableResources} is incremented when trials have finished with treatment as highlighted in the figure below. This can happen when they finish treatment or die.

Using Global Tracker at ‘Healthy > Get Sick, Need Treatment > Get Resource’ where the number of resources is evaluated at the Stop node and then resource is taken if available.

Now that we have studied the model structure including Stop Nodes and Global Trackers, we can analyze the model.

\textbf{44.4 Analysis for Parallel Trials/Synchronization}

The Healthcare tutorial example tree Parallel Trials - Queue - GlobalTracker.trex is a cost effectiveness model where trials accumulate costs and effectiveness depending on their health state and treatment received. There are two strategies, one with 2 available resources and the other with 3 available resources.

\textit{To run Microsimulation with parallel trials:}

- Select the root node.
- Choose Analysis > Monte Carlo Simulation > Microsimulation from the menu.
- Enter the number of trials as 100.
- Select to report Average, rather than Sum for the “value of trial set(s)” option.
- Within “Trial Sets options”, do not check the box.
- Click Begin.
Microsimulation dialogue for running parallel trials, reporting sum rather than averages.

The Microsimulation output for parallel trials is fundamentally the same as any other Microsimulation output. Refer to the Individual Level simulation Chapter, specifically the Microsimulation Results section for more details.
Note that Time Reporting is on for this model, so we can examine what happened to the individuals within the simulation at each step. Let's first examine the cohort-level time report for the first strategy - Data > Time Reports > Cohort (Treatment Resources 2). Then open the State Prob graph shown below.

State Membership for Strategy 1

This State Probability graph displays population count rather than a percentage of the cohort on the vertical axis because we selected the Value of Trial sets option Sum rather than Average. Note for Strategy 1 no more than 2 individual can be in the In Treatment, Holding Resource state at any time. Also note that after about 60 cycles, no more individuals need treatment.

Let's compare this to the same graph for the other strategy as shown below.
State Membership for Strategy 2

For Strategy 2, no more than 3 individuals can be in the *In Treatment, Holding Resource* state at any time. After about 50 cycles, no more individuals need treatment (Sick, waiting for Treatment becomes 0).

We used Global Trackers in our model and so we have access to three report options. Under Actions, Global Trackers there is the option to look at the *Time Report*. This is the first figure shown below, with time increasing horizontally across the page and Global Tracker values reported accordingly.
Global Tracker Time Report, showing the value in each strategy with time

This report shows the value of the Global Tracker for each strategy at the beginning of each cycle. If you scroll to the right, you will see that eventually the resources are no longer in use.

Under Actions, Global Trackers there is a link to *Graphs and Reports*. This provides the option to see any of the Global Trackers values for any of the Strategies using the dialogue, as below.

Global Trackers Reports and Graph dialogue to generate Reports and Graphs.

With the Open Report option, a report showing values of the trackers selected as they change over time is created.
**Global Trackers Time Report**

With the Open Graph option, a graphical representation of Stage versus value of the Global Trackers is generated. It has a key to quickly see the evolution of the tracker values.
Finally, the Rankings report below shows an overall comparison by strategy.

Note that the Treatment Resource 3 strategy had more people receive treatment (t_treated) and fewer people die without treatment (t_die_no_tx). It may at first appear that people received treatment sooner (t_stage_start_tx) in the Treatment Resource 2 strategy; however, this is misleading because more trials would have a 0 for never treated within that strategy.

44.5 Mid-cycle Processing Using Python

The example we have used for most of this Chapter has focused on using Global Trackers and Stop nodes to control access to a limited treatment resource. However, a limitation of this approach is that resources are allocated to trials in trial number order, without regard to priority and/or wait time.

If you need more complex rules to control the allocation of the limited resource, then you can use Python scripts run mid-cycle at the Stop node to allocate the resource to specific trials. We will start by using Python scripts to achieve the identical results as the prior model, but using Python to set trackers for trials that receive the resource after the Stop node.
Open the Healthcare tutorial example tree, Parallel Trials - Queue - Python.trex, which has the same structure as the Global Tracker model. The model is exactly the same in regards to progression of trials and, as we will show, yields identical results. The main differences are:

- Global Trackers are not used as logic to control access to the resource.
- Tracker \textit{t\_resource\_needed} is set to 1 when a trial needs a resource.
- Tracker \textit{t\_resource\_needed} is set to 0 when a trial no longer needs a resource.
- Tracker \textit{t\_resource\_held} is set to 1 when a trial takes a resource.
- Tracker \textit{t\_resource\_held} is set to 0 when a trial releases a resource.
- The use of the keyword \_monte\_stop\_cycle\_eval executes the Python script \textit{PythonAllocateResources} mid-cycle when some trials have finished the cycle while others may be stopped at a Stop node waiting for a resource.
- The Python script \textit{PythonAllocateResources} allocates the resources by setting \textit{t\_resource\_needed} to 2 for those receiving the resource. The logical expression then checks for \textit{t\_resource\_needed} = 2 to allocate the treatment resource.

Let's review the processing for parallel trials with a focus on the scripts.

1. Trial set begins.
2. Start cycle.
   1. Run pre-cycle script via special keyword \_monte\_pre\_cycle\_eval.
   2. Run all trials in numerical order for this cycle until each trial reaches either a Terminal node or a Stop node.
   3. Run stop cycle script via special keyword \_monte\_stop\_cycle\_eval.
   4. Finish cycle for each trial held at a Stop node until they all reach a Terminal node.
   5. Run post-cycle script via special keyword \_monte\_post\_cycle\_eval.
3. Repeat step 2 for all cycles.
4. Trial set is complete.
5. Generate reports by trial and by trial set.

Parallel Trials Processing

Step 2iii above using the special keyword \_monte\_stop\_cycle\_eval provides the opportunity to execute a Python script to determine who gets the resource as is done in this example model. Everything else is the same as the Global Trackers model.

The figure below shows the structure for the Healthy Health state in the model. There is no visible execution of the \_monte\_stop\_cycle\_eval, but it runs. The branches of the stop node use any updated Tracker values as updated by the Python script. Note that the second Stop node uses the same logic.
Healthy Health State with the stop node where trials will wait mid-cycle for processing after other trials have released their resources

We can examine the updates to the trackers in the model at the Stop Node "Get Sick, Need Treatment" and its branches:

- Get Sick, Need Treatment: The trial needs the treatment resource, so tracker updates needed are:
  - \( t_{\text{resource\_needed}} = 1 \)

- Get Resources: If the trial is getting the resource, then the logic is true for \( t_{\text{resource\_needed}} = 2 \). The tracker updates are:
  - \( t_{\text{resource\_held}} = 1 \)
  - \( t_{\text{resource\_needed}} = 0 \)

The trackers are updated for resource allocation within the Python script, \texttt{PythonAllocateResources}, which is executed by the special keyword \texttt{_monte\_stop\_cycle\_eval}. Note the following root node variable definition.

\[
\texttt{_monte\_stop\_cycle\_eval} = \text{DebugContext}(6) + \text{DebugWriteForce("Executing \texttt{_monte\_stop\_cycle\_eval"})} + \text{PythonAllocateResources}(g_{\text{resources\_available}}; _\text{stage}; _\text{trial\_size}) + \text{DebugContext}(6)
\]

Much of the definition is related to debug output, but the critical piece is the call to the Python function \texttt{PythonAllocateResources}. The basic functions of the Python code are presented below.

1. Receive the current number of available resources as a function argument as derived from a separate script (\( g_{\text{resources\_available}} = \text{PythonGetResourcesAvailable}(_\text{GlobalTrkGet("gt\_TotalResources")}; _\text{stage}; _\text{trial\_size}) \)).
2. Get access to all the parallel trials in the model.
3. Loop through all the trials while there are still resources available.
4. If a resource is available and this trial needs a resource, allocate it to that trial by setting
   `t_resource_needed = 2`.
5. When all available resources are assigned, exit the loop.
6. 
While this section does not go into details of how to set up the Python script, there are certain commands which are useful to know to get details from the TreeAge Pro model into Python. These can be found in the section Python access to model data. The example model script is heavily commented and there are additional extensive Python resources available online.

The model runs in the same way as the parallel trials model with Global Trackers. Select Microsimulation and then enter the number of trials and begin. Note that you will get the same results from this model because the Python function also allocates resources in trial number order.

### 44.5.1 Python Example with Priority Queue

The Python script model described above simply allocates the treatment resources in trial number order just as in the Global Tracker model. However, using Python allows for more complex processing via programming code.

The Healthcare tutorial example tree Parallel Trials - Priority Queue - Python.trex includes additional logic to allocate resources based on a priority score sampled from a distribution. There are comments in the Python code describing how this is done.

### 44.6 Infectious Disease Model

See the section called Infectious Disease Trial model within the Dynamic Cohort Model Chapter for more details about using parallel trials in infectious disease models.

The example model combines the use of both Dynamic and Parallel Trial models.
45. Dynamic Cohort Models

You may want to create Markov models with a specified cohort size, perhaps for budget analysis. This chapter describes how to create models where the cohort is larger than one and/or models where the cohort size is being changes with time. This chapter also covers reporting options for such models.

Note that Dynamic Cohort models can be run as Expected Value calculation models or via Microsimulation, depending on your project needs.

45.1 Cohort size greater than one

In most Cohort models, we are usually considering a homogenous cohort of size "1". This generates outcomes (e.g., Cost and Effectiveness) that are reported as the average values per individual, which is typically approriate for strategy comparison.

However, we can consider a cohort of size greater than one by setting up the model with non-coherent probabilities. TreeAge Pro normally requires the branch probabilities of nodes (Chance, Markov etc) to sum to 1.0. Probabilities which meet this requirement are referred to as “coherent.” However, there are some situations where it may be useful to relax or remove this restriction (i.e., dynamic cohort analysis). Removing the coherence restriction at Markov and Chance nodes allows the model to use branch probabilities in a different way.

Open the Healthcare tutorial example tree, Dynamic Cohort - Markov Cancer.trex. In this model, the cohort size is setup to be greater than one based on non-coherent probabilities to the right of the Markov nodes. This model already has non-coherent probabilities, but the instructions below show you how to set this up.

Set a node to allow non-coherent branch probabilities:

- Select the node.
- Right-click and from the drop-down menu select 'Coherence' and expand to select 'Allow <> 100% for this node'.
- Observe the red flag above the Markov node. This indicates that non-coherence is turned on at this node.
Turning coherence on/off at a given node in the model

Red flags indicate non-coherence is on for the Markov node (Tx 1) in this model.

There are more details about Coherence settings in the Section Using non-Coherent Probabilities.

Once we have non-coherence set at that node, its branches can have probability values which do not sum to one without generating an analysis error.

Examine the model and see the values of the branch probabilities below the Health States from the Markov node. The next section examines the Entry Node, which does not require a branch probability, but the other nodes all have branch probabilities which will define the cohort starting size:

- Local Cancer: Initial Local Cancer cohort value is $n_{StartLocal} = 20000$
- Metastases: Initial Metastases cohort value is $n_{StartMets} = 2000$
This means the starting size of the cohort is 22000. This cohort will now move through the model accumulating rewards (cost and effectiveness) for the whole population. The reports will show significantly higher results than for the analysis when the cohort is of size one.

This model also includes an Entry Node New Patients, which is used to add to the cohort over time. This is covered in the next section.

### 45.2 Entry state - adding to the cohort

The Entry node type provides a mechanism to add to the size of the cohort with each cycle. The Entry node will be automatically executed at the start of each cycle, so it does not require an Initial Probability. Entry nodes are followed by subsequent branches with probabilities which specify the additional population added to the cohort at each cycle.

Consider the Healthcare tutorial example tree, Dynamic Cohort - Markov Cancer.trex first described in the prior section. Note that the Markov node is already set to allow non-coherent branch probabilities (see prior section). This section will focus on the Entry node for adding to the cohort.

**To build a model adding members to the cohort:**

- To add additional members into the cohort, insert an Entry Node as a direct branch of the Markov node.
  - The Entry node does not require an initial probability.
  - The Entry node will be automatically run every cycle.
  - Entry nodes automatically allow non-coherent branch probabilities.

- Add branches of the entry node to add to the cohort by sending new entries to one of the true health states via jump states at terminal nodes. The new entries will appear in those health states at the start of the next cycle.

The figure below shows the Entry node with the red flag indicating non-coherence at the node.

In this model, the Entry node is called New Patients and the subtree associated with the Entry node adds \( n_{NewLocal} \) members to the Local Cancer and \( n_{NewMets} \) members to the Metastases state each cycle.
The "health state" represented by the Entry node will not be included in most of the Markov Cohort reports, but the new additions to the cohort will appear in the health states in the next cycle. In this example the same number of people are added in every cycle, but \( n_{\text{NewLocal}} \) and/or \( n_{\text{NewMets}} \) could refer to formulas that change by cycle.

### 45.3 Reporting - Dynamic Cohort Analysis

Typical Markov models use a cohort size of 1 and present state and event membership as a percentage of the cohort. Dynamic Cohort models with non-coherent probabilities instead present full cohort counts rather than percentages in their report output. These different views of the cohort (percentage vs. counts) feeds directly into Cost Effectiveness reporting.

Consider the Healthcare tutorial example tree, Dynamic Cohort - Markov Cancer.trex, select the Markov node Tx 1 and then generate the Markov Cohort Extended Report.

![Markov Cohort Extended report](Image)

**Markov Cohort Extended report for Tx 1**

There are several features of this report to examine:

- The Entry Node, New Patients, adds 1000 to Local Cancer and 100 to Metastases at each cycle. At stage 0 (and all subsequent stages) we can see this number in the Cohort # column. Those additions will show up in the regular health states in the following cycle.
- There is no cost or effectiveness associated with the Entry node because this is only a mechanism for creating individuals for the model.
- The Cohort column is now recording actual numbers rather than proportions of the cohort. This means that total costs and effectiveness are going to be significantly higher.

The figure below shows how the Entry node adds New Patients to the different Health states.

Consider the contribution to Local Cancer and Metastases in _stage 1 from the combination of the Health States and Entry Node at _stage 0.

The Charts generated for a Dynamic Cohort are also different because of the size of the cohort we are considering.

*State Prob Curve*

The State Prob curve uses actual population counts. The vertical axis is the Count and in this instance we can see how the number Dead dominates the graph, as in the figure below.
State Probability curve for Dynamic model.

Other graphs are also based on the total values, for example the total costs for the population rather than the average value for an individual.

The Summary Report will give a tabular set of results showing the total population number in each Health State.
The model we are examining is a decision tree, so we can also generate Cost Effectiveness Analysis. In the Dynamic Cohort - Markov Cancer example model, select the root node and then run the Rankings Report.

The report has very large numbers for cost and effectiveness because it is considering the whole cohort's cost and effectiveness. Because both strategies (Tx1 and Tx 2) are accumulating rewards for the whole cohort, it is valid to consider the Incremental Cost and Effectiveness and generate the ICER. In this example, the ICER is 38,419 and based on a Willingness to Pay of $50,000 we conclude that Tx 2 is the optimal strategy.

45.4 Reporting - Dynamic Microsimulation Analysis

We will use the same model as the previous sections: the Healthcare tutorial example tree Dynamic Cohort - Markov Cancer.trex. This model can be run as a cohort model, as in the previous sections. We will use the model and run as a Microsimulation model to demonstrate the differences in dynamic reporting for a Microsimulation model. This will obviously not demonstrate heterogeneity and event tracking, but the methods are still the same.

To run a Dynamic Microsimulation model:

- Select the root node and then select Analysis > Monte Carlo Simulation > Microsimulation or use the toolbar to select microsimulation.
- The dialogue for running Monte Carlo simulation will appear. See options below the figure.
- Select the 'Value of trial set(s)'. Select Sum to return the value for the whole population.
- Select Begin to run the Microsimulation. (Results are in the figure below)
For a Dynamic Cohort model, when we select Analysis > Microsimulation, observe the following dialogue:

Consider the elements of the Monte Carlo Simulation dialogue for a Dynamic Microsimulation model:

- **1st-order simulation trials (microsimulation):** This value is fixed as 1 for a Dynamic model because the non-coherent branch probabilities within the model determine the population size.
- **Value of trial set(s):** The two options are Average and Sum. The Average option will give you the model rewards (cost and effectiveness) as the average over the population - similar to usual microsimulation results reporting the average value for a population. The Sum option will add together the costs and effectiveness for the whole population and report the total value. This option is likely more appropriate for a dynamic cohort model. For this analysis, choose Sum.
- **Parallel trials options:** Select this option to run trials in parallel. See Microsimulation with Parallel Trials Chapter. This defaults to checked because this is a dynamic cohort model.
- **Trial sets options:** Select this to run more than one set of trials and set the number of trials to run. For this analysis, leave this unchecked.

The model has the Time Reporting feature turned off because there is a large population and this would slow the model down to report all the outcomes.

*The Microsimulation outputs*
Microsimulation results - showing sum rather than average values. (See top row)

The Microsimulation output's primary output is the sum of the entire trial set, so the top row shows very large cost and effectiveness values. If we had instead chosen to show Average instead of Sum, the primary/top results would be much smaller.

The calculations for both Tx 1 and Tx 2 are using the same method, so considering the Rankings Report from the Actions on the right hand side will still generate an ICER which we can use to recommend the optimal treatment. Note that the full "Sum" values are used for Rankings in this case.
45.5 Infectious disease cohort model

Infectious disease models in TreeAge Pro can be run as either cohort or microsimulation (parallel) trials analysis. This section looks at an Infectious Disease model analyzed via Cohort Analysis.

Infectious disease models are a specific class of models because they depend on the current membership of the health states, which impact the transitions between health states. Simply, the number of people in the infected state impacts the likelihood of an uninfected person becoming infected.

This example is a Susceptible–Infected–Recovered (SIR) epidemiological model, which computes the theoretical number of people infected with a contagious illness over time. The name of this type of model derives from the set of health states: number of Susceptible people (S), number of people Infected (I), and number of people who have Recovered (R). Transitions from one state to another in the model can be derived mathematically, and while the derivation is out of scope of this manual, more details can be found here.

45.5.1 SIR Model structure

Consider the Healthcare tutorial example, Dynamic Cohort - Infectious Disease.trex, shown in the figure below.
Dynamic Cohort - Infectious Disease trex model outline (both variables and notes hidden)

Standard SIR models often do not have vital dynamics (that is no Births and Deaths) because the dynamics of an infectious disease are often much faster than the birth and death rate. In that case, the total population does not change.

In this example, we are showing the basic SIR model with vital dynamics (that is Births and Deaths). This will demonstrate how to add new people into the Dynamic model via the Entry Node.

Consider the following elements of the model:

*Entry State*

The Entry State is described in detail earlier in the section Entry State. In this model the Entry State adds new people into one of the three Health States: Uninfected (S), Infected (I) or Recovered (R). The number of new people is controlled by the values under each of the branches from the non-coherent Entry Node.

In this model we have the variable Add_new_uninfected adding new people into the Uninfected Health State. The model can add patients to the other states by changing the values under each branch. For example, this might be required in a situation where immunity is only provided from birth for a limited period of time.
This node would not be required in the closed version of the model, that is without vital dynamics.

**Non-coherent Markov node**

The Markov node is set to be non-coherent to allow the cohort size to be greater than one and set using the Initial Probabilities of the Markov node. Non-coherence is set at the Markov node by selecting the node, right clicking and then selecting Change Coherence from the menu. More details are provided in the section Cohort Size greater than one.

The initial probabilities at this Markov node are controlled by 4 variables: *Initial_Count_Uninfected, Initial_Count_Infected, Initial_Count_Recovered and Initial_Count_Dead.*

Changing these initial values can impact the speed of infection.

**Deaths in every health state**

This example model includes vital dynamics, which means we need to account for deaths which could occur at every health state. In the closed version of this model, the model would finish with all the population in the Recovered state and each health state would only have the option of progression to the next health state or remaining in the existing one.

### 45.5.2 Calculation of Transition Probabilities

The important mathematics of the SIR model is the relationship between the rates of change to different health states and the proportion of the population in those health states. The specific rates of change included in the calculations are the rates of infection, recovery and death.

The Markov model requires transition probabilities to determine the state membership from one cycle to the next. These transition probabilities are entered below the branches of the Health States. Calculating the probabilities in the model uses the function *RateToProb(Rate ; time)* to convert the rates to probabilities.

The Variables defined for these calculations are all included in the Variable Category ‘Probability Calcs’ as shown in the figure below.

Variable Properties View showing the probability calculation variables converting the rates to probabilities
The parameters for rates of change and other Population Dynamic specific values are included in the Variable Category 'Pop Dynamics' as shown in the figure below.

Let's specifically examine the calculation for the probability of infection.

\[ \text{prob}_{\text{infect}} = \text{RateToProb}(\text{Rate}_{\text{Infection}} \times \text{Proportion}_{\text{Infected}}; 1/\text{CyclesPerYear}) \]

Note that the probability is impacted by \text{Proportion}_{\text{Infected}}, which represents the number of people who are infected as proportion of the number of people who are alive. This is calculated through the following calculations.

\[ \text{Proportion}_{\text{Infected}} = \frac{\text{count}_{\text{Infected}}}{\text{count}_{\text{Alive}}} \]

\[ \text{count}_{\text{UnInfected}} = \text{StateProb}(2) \]

\[ \text{count}_{\text{Infected}} = \text{StateProb}(3) \]

\[ \text{count}_{\text{Recovered}} = \text{StateProb}(4) \]

\[ \text{count}_{\text{Alive}} = \text{count}_{\text{Infected}} + \text{count}_{\text{UnInfected}} + \text{count}_{\text{Recovered}} \]

The StateProb function returns the count of people in the appropriate state (counting down from the top). Therefore, Proportion_{Infected} returns the count of people in the infected state (2) divided by the count of people in any of the alive states (2 to 4).

![Variable Properties View showing the population dynamic parameters and calculations](image)

Changing these Population Dynamic parameters will change the proportion of the population in each health state. The outputs can be seen in the next section.

In this cohort model, the \text{Add}_{\text{new}_{\text{uninfected}}} variable adds the appropriate number of people based on the formula, which may not be a whole number. This makes the model results smooth. See the next section about running individual (whole) trials through the model via microsimulation (parallel trials).
45.5.3 Analysis

This Dynamic Cohort model can be run using Markov Cohort Extended Analysis (or Markov Cohort Basic Analysis). The model does not require microsimulation because the model uses the StateProb() function to determine the proportion of the cohort in each Health State.

The Markov node is set for non-coherence which indicates the analysis should use actual counts rather than percentages of the cohort. The counts will be reported in the analysis.

To run Markov Cohort Analysis, select the Markov node and then Run Markov Cohort Extended Analysis from the toolbar. The figure below shows the Extended Report.

The figure shows the different 'counts' being added by the 'Add new people' Entry node. Looking at the Cost Entry and Eff Entry columns the sero values indicate there is no impact on cost or effectiveness from the Entry state.

In this model, there are only new people added to the uninfected state based on the Birth Rate and the number of the cohort Alive. The numbers in the Cohort # column can be used to confirm the cohort are moving to the correct health state based on those entering and leaving the health states.
From the Graphs on the right-hand side we can generate the usual State Prob curves. In this Dynamic model, because the Markov node is non-coherent, the reports use actual counts rather than percentages, as in the figure below.

State Prob graph generated for SIR with Births and Deaths. Note the actual population count on the vertical axis.

### 45.6 Infectious disease patient level model

Infectious disease models in TreeAge Pro can be run as either cohort or microsimulation (parallel) trials analysis. This section looks at an Infectious Disease model analyzed via microsimulation (parallel) trials.

Infectious disease models are a specific class of models because they depend on the current membership of the health states, which impact the transitions between health states. Simply, the number of people in the infected state impacts the likelihood of an uninfected person becoming infected.

Again, this section (as in the previous section) will consider a Susceptible–Infected–Recovered (SIR) epidemiological model, which computes the theoretical number of people infected with a contagious illness over time. The name of this type of model derives from the set of health states: number of Susceptible people (S), number of people Infected (I), and number of people who have Recovered (R). Transitions from one state to another in the model can be derived mathematically, and while the derivation is out of scope of this manual, more details can be found here.
In addition to the SIR patient simulation model requiring an understanding of Dynamic Cohort models (the rest of this chapter) it also requires an understanding of Parallel Trials models, covered in the chapter Microsimulation with Parallel Trials.

Consider the Healthcare tutorial example, Dynamic Parallel Trials - Infectious Disease.trex, shown in the figure below.

Refer to the details provided in the previous section (Infectious disease cohort model) about the SIR Model structure.

45.6.1 Differences between Cohort and Parallel Trial Infectious Disease models

The Cohort and Trial models are mostly identical in structure. The differences between the two types of simulation in this model are:

- **Parallel Trials**: Due to the nature of infectious disease models, trial (microsimulation) models cannot be run sequentially. Each trial’s state of infection impacts all other trials, i.e. the more trials who are infected impacts the probability of infection via the variable *Proportion_Infected*. 
Therefore trials need to be run through the model in parallel, allowing the number of trials in each health state to impact the transition probabilities.

- **Integer "probabilities"**: When new people are added to a Microsimulation model, "whole" new people need to be added because they are equivalent to a new trial being created in the model. We overcome this by using the integer part of Add_new_uninfected.

- **Running the model**: A microsimulation model is run from the decision node using any of the options to run a Microsimulation model. Because of non-coherence, the dialogue does not present the option to enter the number of trials. This is taken from the initial probabilities in the model.

The Value of trial set(s) can be selected as either Average or Sum. The Sum of the set considers the total values (of cost and effectiveness in this model) over the whole of the population.

- **Time Reporting**: To consider the movement of the population over time, trial and cohort level details can be found using Time Reporting. This model has time reporting turned on, collecting Cost and Effectiveness. Details about time reporting can be found in the chapter Microsimulation Time Reporting. After running microsimulation, open Time Reports > Cohort > State Prob to show how the proportion of the population in each state changes over time, see the figure below. More details can be found in the section about Analysis for Parallel Trials.
As with all microsimulation models, the accuracy of the results depends on the number of trials. In the cohort model described in the previous section, the number of trials was not important in the calculation of the transition probabilities because the model considered proportions of the cohort. With this parallel trials model, the number of trials can impact the results. The outputs, such as the State Prob graph above, will converge to the cohort model with more trials, i.e. the more trials mean a more accurate result.

This parallel trials model does require 10,000 trials to provide accurate results like in the cohort model. The model also requires the use of time reporting to capture all this information so that it can be displayed (as we see above in the State Prob graph). This is computationally intensive, and while the generate of the results may be a few minutes the saving and then generating graphs can take some time. Please be aware of this if you are running the example microsimulation (parallel trials) model.

45.7 A Note on Budget Impact models

The techniques described in this chapter related to dynamic cohort size is often applicable in Budget Impact Models. By beginning with a population of a *determinate* initial size and adding to the cohort to reflect *incidence*, your model will generate a much clearer picture of the overall cost to a payer over time.

For additional background on budget impact modeling, refer to: ISPOR Principles of Good Practice for Budget Analysis.
46. Discrete Event Simulation (Time-to-Event)

This chapter focuses on Discrete Event Simulation (DES) models also known as Time-to-Event models, which allow you to structure models around events and continuous time rather than health states and time cycles of fixed length.

Within this document, we will use DES models and Time-to-Event models somewhat interchangeably.

46.1 Discrete Event Simulation Models

Discrete Event Simulation models differ significantly from Markov models in that movement through the model is driven by events whenever they occur rather than events that may or may not happen within a given cycle. TreeAge Pro uses a similar decision tree model structure for DES and Markov models, but uses specific node types and keywords for DES. It is important to consider that flow through the model is based on events and the progression of continuous time and not discrete time intervals.

TreeAge Pro supports most components of Discrete Event Simulation (DES) models; however, TreeAge Pro does not directly support resource constraints, queues and other elements less frequently used for healthcare models.

Similar to Markov models, DES models can be incorporated into a large decision tree to facilitate cost-effectiveness analysis and other mechanisms to compare treatment strategies. Unlike Markov models, DES models must be analyzed via Microsimulation, which sends individual patients through the model. Individual patient histories are then aggregated into means to generate expected values for decision analysis.

⚠️ DES models must be analyzed via Microsimulation to send individual patients through the model. Cohort-level analyses are not supported.

This chapter will use the DES tutorial example model, DES.Model.With.Health.States. This model compares two treatment strategies with a disease progression through the health states of: mild, severe and dead.

46.2 DES Model Structure

The DES tutorial example tree, DES.Model.With.Health.States, is a typical DES model.
DES model structure

The model contains two strategies, each of which starts with a DES node. The DES node then has three branches - two time nodes for the Mild and Severe states and a terminal node for the Dead state. To the right of the time nodes, there are branches for the possible competing events. In this simple model, an individual trial will only be at each branch once at most.

The remainder of this chapter will highlight the important elements within this model and considerations when building a DES model.

46.3 DES Keywords

Time is a critical element in time-to-event models. TreeAge Pro provides keywords to help track time within the model. Additionally, DES related keywords are used to access rewards (payoffs) accumulated by a patient during a simulation (total and by "cycle").

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_time</td>
<td>Current time for the patient.</td>
</tr>
<tr>
<td>_event_time</td>
<td>Time of the last event.</td>
</tr>
<tr>
<td>_prior_time</td>
<td>Time before the last event.</td>
</tr>
<tr>
<td>_total_rwdx[index]</td>
<td>Total value accumulated by patient in reward (payoff) number index from beginning of time to current event.</td>
</tr>
<tr>
<td>_stage_rwdx[index]</td>
<td>Value accumulated by patient in reward (payoff) number index from beginning of cycle (path from DES node to current event).</td>
</tr>
</tbody>
</table>

DES keywords
The _time keyword is the only keyword you are likely to use frequently. It is often used in the following ways.

- Setting the termination condition.
- Calculating the time-to-event from the current time forward in an event time expression.
- Storing the time of an event in a tracker.
- Discounting rewards manually (unnecessary if you use global discounting).

### 46.4 DES Node Type

Time-to-Event models include two node types - DES and Time.

#### Time-to-event node types - DES and Time

The DES node type indicates the beginning of the DES/time-to-event model, similar to a Markov node beginning a Markov model. The only DES-specific element provided at this node is the termination condition, which indicates when the analysis should stop. For DES models, this would typically be a time horizon.

All DES-related information is entered via the DES Info View. Similar to the Markov Info View, the contents of this view change based on the context within the DES model. At a DES node, the termination condition is entered.

In the above example, the termination condition is true when the patient _time meets or exceeds the timeHorizon variable. Processing of the patient will stop, even if the patient has not reached a node to exit the model.

In the DES.Model.With.Health.States model, the termination condition is true when _time exceeds the value infinite (which is our model is set to 1million). Therefore, the termination condition will never be reached.
Termination conditions on their own may not be sufficient to force the model to stop at a specific time because the patient will not return to the DES node's direct branches at regular intervals. The termination condition is only check when a patient returns to one of these direct branches, which may occur after the desired time horizon. Therefore, the time horizon must be checked at each Time Node. This will require adding a branch to the Time Nodes to check the time horizon (see the section Additional Complications of DES models).

46.5 Time Node Type

Time nodes are the key to DES models. Time nodes function in a similar way to chance nodes in that there are expressions under each of its branches. However, each expression represents the time-to-event for that event rather than a probability of that event occurring within the Markov cycle. The patient will move from the time node to the event with the shortest time-to-event.

Consider the time node Mild in the DES.Model.With.Health.States, as shown below.

![Diagram of Mild time node]

Note there are two events, Mild to Severe and Die from Mild, and each has a time expression beneath it, representing the time passed before each event will occur.

- The expression Time_MildToDead refers to an Exponential distribution, parameterized with a fixed rate.
- The expression Time_MildToSevere is a variable that references the appropriate Exponential distribution for that strategy. This is done to support cloning.

Whether directly or indirectly, both time-to-event expressions reference distributions. When a patient reaches the Mild state, that patient's sampled values from those distributions are compared, and the patient will move to the node with the shortest time-to-event sample.

The second time node Severe only has one event which can happen, which is dying from the Severe condition. Therefore, only that event will occur with the time-to-event sample determining how long it takes for that event to occur.

46.6 Accumulating value - time and event rewards

In DES models, values/rewards are accumulated in a similar, but slightly different way than in Markov models.
In DES models, rewards are accumulated as follows.

- **Time rewards** - accumulated at time nodes based on the amount of time spent waiting for an event to occur (equivalent to a Markov state reward).
- **Event rewards** - accumulated as a fixed value at any node (equivalent to a Markov transition reward).
- **Startup rewards** - accumulated once as a fixed value at time nodes at _time 0.

### DES Rewards

#### 46.6.1 DES Time Rewards

DES time rewards are exclusively accumulated at time nodes. The value/expression entered is appropriate for one time unit (similar to a Markov cycle); however, that value/expression is then multiplied by the time spent at that time node until an event occurs.

This is the equivalent of state rewards in a Markov model, which are accumulated based on membership in a specific health state for a fixed period of time. However, in DES models, there are no fixed cycles. Instead of accumulating a single value for that fixed cycle, the value is accumulated over the entire time spent at that node.

Let's examine this within the context of the DES.Model.With.Health.States. The figure below contains the DES Info View with the _Mild_ node selected.

![DES Info View with Time node (Mild) selected](image)

Note that the active payoffs (1 & 2) are for cost and effectiveness, respectively.

(If you need to change the active payoffs, use the link to Tree Preferences next to the pencil above the Name column.)

The value $c_{Mild}$ is the value for cost and the value $u_{Mild}$ is the value for effectiveness. When the model runs, the time node will select the next time-to-event based on the shortest time-to-event, resulting in the _event_time_.

Let's assume that the following time-to-event values are calculated from formulas/distributions...

- **Time_MildToSevere = 3.80497**
- $Time_{MildToDead} = 11.21743$

**Time-to-event values for Mild time node**

The shortest time is the for the progression from Mild to Severe, so that event occurs next. At the Mild node, it does not matter which event occurs for value accumulation, just the time until that event occurs.

The cost is calculated by evaluating the cost payoff and multiplying it by the time-to-event. Consider we are in Treatment 1:

- $c_{Mild} = c_{Mild1} = 1000$
- time to the progression to severe = 3.80497
- cost accumulated before the first event = $1000 \times 3.80497 = 3,804.97$

Therefore, $3,804.87$ (units of currency) are accumulated at the time node before the transition to the severe state occurs.

### 46.6.2 DES Event Rewards

DES event rewards are usually accumulated at event nodes somewhere to the right of time nodes. The value accumulated is equal to the expression you enter with no adjustment for the time-to-event.

This is the equivalent of transition rewards in a Markov model, which are accumulated based on an individual passing through a specific event in a Markov transition subtree.

The figure below contains the DES Info View with the Mild to Severe node selected.

![DES Info View with event node (Mild to Severe) selected](image)

The cost of the progression from Mild to Severe (parameter variable $c_{Progress}$) is placed in the event reward. Any individual who passes through this event will incur the cost of the progression.

### 46.6.3 DES Startup Rewards

DES startup rewards are accumulated only once in the model at the beginning of the analysis (_time = 0). They function like event rewards in that they are a fixed value rather than being multiplied by the time-to-event. However, they should be placed at the time nodes where an individual can enter the model (initial probability > 0).
DES startup rewards are typically used for one-time-only costs that are incurred at the beginning of an analysis. For example, if you have a model that accounts for a single surgical procedure and then follows the patients into the future, the cost of surgery should be placed in the startup cost.

In many models, all startup rewards will be zero.

46.7 Analysis via Microsimulation

DES models require individual patients, so they must be analyzed via Microsimulation.

To run Microsimulation on the model:

1. Select the root node.
2. Choose Analysis > Monte Carlo Simulation > Trials (Microsimulation).
3. Choose the number of iterations (10000) and click Begin.

The results are displayed below.

Microsimulation output

The primary output is aggregated data generated from the 10000 individual patient histories. Cost-effectiveness analysis is based on the mean values for cost and effectiveness from each strategy. The CE Rankings report from the Microsimulation results are presented below.
Cost-Effectiveness Rankings from DES Microsimulation results

Note the ICER is calculated using the active cost (1) and effectiveness (2) payoff sets.

Many other secondary outputs are described in the Individual-Level Simulation and Markov Models Chapter and will not be repeated here.

46.8 Additional Complications of DES Models

Up until this point, we have focused on fairly simple DES models. However, you may require more complex structures and/or calculations in your models. The next three sections describe how to handle some of these complexities.

1. Using a TableProb Distribution for Time-to-event from a Mortality Table (i.e. your data does not match a parametric distribution)
2. Conditional Distribution Sampling
3. Time Horizon
4. Repeating Events

DES Complexities

We will use a more complicated DES example model DES.Model.With.RepeatingEvents.trex to highlight these items in the following sections.

46.9 Using a TableProb Distribution for Time-to-event from a Mortality Table

Most time-to-event values can be sampled from standard parametric distributions like Exponential and Weibull. However, your model may require a time-to-event value that does not match well to a parametric distribution (e.g., background mortality).
The TableProb distribution type allows you to create a distribution based on a series of probabilities that vary by time. The probabilities can be entered in their natural form (likelihood the event occurs in a specific cycle of time or as cumulative probability (likelihood the event has occurred by a specific time).

The DES Tutorial Example model, TableProb Distribution.trex demonstrates this technique.

Note that the model contains a mortality table (look at the Table View) named tMortBackground, which would be referenced directly in a Markov model. However, in this DES framework, it must be converted into a distribution for time-to-event samples to be sampled.
Table Distribution

Note the following attributes of this distribution.

- The primary parameter is the table that holds the probabilities.
- Choose the radio button for probability vs. cumulative probability based on the table data.
- Interpolate to interval size 1 based on missing age values in the mortality table (nearly always check this box). Our table does not have a value of each age, so we select this box to interpolate correctly.
- Resample for each individual in the model (standard practice for a microsimulation model).

⚠️ For a Table Distribution to work via a closed form solution, your table must start with a value that has a probability zero (in the first row) and end with a value with probability 1 (the last row).

In this example, the probability of death at age 0 is 0, but that is immediately followed by a probability of death at age 0.0001 of 0.008. The probability of death at age 120 is 1.0.

You can generate a histogram of 10000 samples from this distribution using the Graph It toolbar button. The histogram will help us understand the samples generated by this distribution.
Table Distribution Samples

Note that about 1% of people will die before age 5, but then the probability drops and remains low until people reach middle age.

From the distribution, we can generate an age of death. However, this does not fully meet our needs if patients enter the model at any starting age other than zero. The next section on Conditional Distribution Sampling will help us handle non-zero starting age, that is sampling this distribution to start at a given (non-zero) age.

46.10 Conditional Distribution Sampling

Typically, a distribution is sampled normally to determine a time-to-event value for a specific patient. However, there are cases where DES models require additional control over distribution sampling beyond the standard sampling rates. Use of a TableProb distribution for background mortality is a good example where you would need conditional distribution sampling.

Consider the DES Tutorial Example model, TableProb Distribution.trex from the prior section. The starting age for people in that model is 40. We don't want the TableProb distribution to generate any age of background death values less than 40 because the patients have already lived to 40. Therefore, we need to use conditional sampling to determine the age of death given the condition that the person already lived to 40.

The syntax for conditional sampling has two forms:

- \text{DistSampleCond}(\text{distribution\_index}; \text{lower\_bound})
- DistSampleCond(distribution_index; lower_bound; upper_bound)

Note that issuing the DistSampleCond command generates a new sample. Be careful about calling this function too many times and resampling a distribution inappropriately.

The DES Tutorial Example model TableProb Distribution - Standard vs. Conditional Sampling.trex demonstrates the difference between standard sampling and conditional sampling. The histogram for standard sampling is repeated here from the prior section.

[Image of histogram for standard sampling]

Standard Sampling from TableProb Distribution

The histogram for conditional sampling is then shown below.
Conditional Sampling from TableProb Distribution

Note that no samples are generated that do not meet the condition of being 40 or older.

Now let's examine the more complete DES Tutorial Example model DES.Model.With.RepeatingEvents.trex which considers background mortality at both the Mild and Severe states. The figure below shows the Mild Time node with the variable \( \text{Time\_BackgroundDeath} \) representing the time to death from background mortality.

The variable \( \text{Time\_BackgroundDeath} \) is defined as:

- \( \text{Time\_BackgroundDeath} = t\_\text{Age\_BackgroundDeath} - \text{ag e} \)
- where the tracker \( t\_\text{age\_BackgroundDeath} = \text{DistSampleCond}(5; \text{startAge}) \) is set for each treatment and
- where \( \text{age} = \text{startAge} + \_\text{time} \)

There are two important considerations with these non-standard events.

First, the age of death from background mortality is defined by the distribution: \( \text{Age\_BackgroundMort} \). This distribution is sampled from a mortality table. It will return values between 0 and 105 depending on the probabilities in the mortality table (\( \text{tMortBackground} \)). In this model, our patients start at age 50, as defined by \( \text{startAge} = 50 \).

This model uses the \( \text{DistSampleCond} \) function. That function allows you to return a sample from a distribution where the value is conditional. Specifically, in this case the model starts at age 50 based on the \( \text{startAge} \) parameter. It would not make sense to sample an age of death earlier than 50, so the function \( \text{DistSampleCond} \) uses a lower bound of \( \text{startAge} \) to always return an age of death greater than 50.

Note that the \( \text{DistSampleCond} \) function is only called once per person and is stored in a tracker. If that function were placed in the time-to-event expression directly, the distribution would be resampled, which we don’t want.

Second, time-to-event value needs to take into account time passing. In this model, once an event has occurred, a certain amount of time will have elapsed. In the case of background mortality, this is taken into account with the definition \( \text{Time\_BackgroundDeath} \) which subtracts the current age of the patient.

For example, if the age at death from conditional sampling is 75, then the time-to-event from starting age of 50 would be 25 years. Now let’s assume that the person progresses to Severe 10 years later. Then the same expression would be the age at death 75 less the current age of 60, so the time to background would appropriately be 15 years.

### 46.11 Time Horizon

Unfortunately, time horizons are not as easily handled in DES models as they are in Markov models. In Markov models, we know that the process will return to the health states after every cycle, so there is a clean point to check the termination condition to see if the process should stop. In DES models, there is no such clean point because the events in the model could happen after the time horizon should end. Therefore, if you want a fixed time horizon in your model, you need to explicitly add it to each time node.

The DES Tutorial Example model DES.Model.With.RepeatingEvents.trex accounts for the time horizon with an event that can occur off each time node. The time-to-event expression under the Time Horizon events must account for the total time of the model less time already passed for past events.

The time-to-event value is defined as: \( \text{Time\_HorizonExit} = \text{time\_horizon} - \_\text{time} \)
where the parameter $\text{time}_\text{horizon} = 20$ and the keyword $\_time$ will change as the model is analysed. Once $\text{Time}_\text{HorizonExit}$ becomes the smallest time-to-event, the model analysis will finish.

### 46.12 Repeating events

The DES Tutorial Example model DES.Model.With.RepeatingEvents.trex includes a new repeating event "Adverse event in Severe" off the Severe health state. This event creates additional complexity because it can happen multiple times and because it sends patients back to the same time node.

When a patient starts its path through the model, the time-to-adverse-event distribution is sampled based on the sampling rate of "Once per trial". However, when an adverse event occurs, a new sample is needed for the next adverse event, so that the identical time is not used.

TreeAge Pro allows for distribution sampling at any node via the Distributions View.

![Distributions View - resampling the Adverse Event distribution at the Adverse Event node](image)

When a patient reaches the Adverse Event node, the adverse event occurs, and a new time-to-adverse-event sample must be drawn.

Because this event can repeat from the same time node, the time-to-event expression needs to account for three time elements:

1. Time to the next event
2. Starting time for the time to the next event
3. Time already passed

Because this adverse event is the only repeating event, elements 2 and 3 will cancel out, so you only need the distribution in the model. However, if there were two repeating events, like in the The DES Tutorial Example model Osteo DES Model.trex, then you would have to record element 2 in a tracker and use the $\_time$ keyword for element 3.

Let's look at the variable definition for the time-to-event expression for the Hip Fracture in the mode.

$$(\text{TimeToHipFract}_\text{Tx} + \text{T}_\text{last}_\text{hip}_\text{fract}) - \_time$$

1. Time to the next event = indirect reference (see note below) to the time-to-event distribution
2. Starting time for the time to the next event = tracker holding the time of the last hip fracture
3. Time already passed = keyword $\_time$
Notes on distribution resampling:
Unlike variables, distributions are designed with global scope. Therefore, distribution parameters can only be defined within the distribution and/or by referencing the root node definitions for variables. If you redefine a variable to the right of the root node, that definition will not be used when the distribution is resampled.
However, expressions used in distribution parameters (including root node variable definitions) are calculated dynamically, so the parameter values can change as a patient progresses through the model.
For example, if a distribution parameter references a tracker or keyword (i.e., _time), the current values will be used when the distribution is resampled.

46.13 Tracking Events
In time-to-event models, events can be tracked via trackers or in reward sets. While these two storage mechanisms are quite different in a Markov context, they function quite similarly in time-to-event models. Full description of trackers and tracker views is available in the Individual-Level Simulation and Markov Models Chapter.

In the DES.Model.With.RepeatingEvents, trackers are used to record the time of the progression from Mild to Severe. This value is then used to ensure the the time-to-event value for Time_SevereToDead_adj is correct relative to the progression and current time. Trackers are often used in this way because it is easy to reference the current tracker values as needed in the model.

Rewards in the DES context can also be stored and retrieved at any time. Rewards are accumulated as described in the "Accumulating value" section of this chapter. The current value of that reward is available via the _total_rwdx[index] keyword described earlier, where the index refers to the number of the reward set.

46.14 Discounting in DES Models
With the Global Discounting option in Tree Preferences, applying discounting to a DES model is very simple. In the DES.Model.With.RepeatingEvents Model, payoff sets 9 and 10 use the same reward expression as payoff sets 1 and 2, except that global discounting is applied as shown below.
Tree Preferences: Global Discounting

The DES time unit is set to annual because the distributions are sampling time-to-event in years. Time rewards expressions are also consistent with this time unit. Note that the ninth and tenth payoff sets have discount rates set to the variable *Disc_rate*, which evaluates to 0.03.

Based on the Global Discount settings above, payoff sets 1 and 2 will calculate cost and effectiveness with no discounting, while payoff sets 9 and 10 will calculate cost and effectiveness with a 3% annual discount rate. Expressions for all rewards are identical for payoff sets 1 and 9 and for payoff sets 2 and 10, but the expected values for 9 & 10 will be lower due to the impact of discounting.

46.14.1 Discounting Formulas

TreeAge Pro's Global Discounting function uses standard discounting formulas. Time rewards and event rewards use different formulas due to the way those rewards are accumulated. Startup rewards are unaffected by discounting because they are applied at _time 0_.

Event rewards are accumulated at a specific time, so the standard discounting factor is applied.

\[ \frac{1}{(1 + \text{rate})^{\text{time}}} \]

**Discounting formula for event rewards**
Based on applying the discounting factor above, discounting reduces value more and more as time moves into the future. While this formula is applied to event rewards automatically via Global Discounting, you can also apply the formula manually through the Discount function.

Time rewards are accumulated over a period time, so discounting is more complicated.

\[
\text{Discounted Value} = V_a \frac{e^{(b - a)R}}{1 - e^{(b - a)R}}
\]

- \(a\) is the start time for the value accrual
- \(b\) is the end time for the value accrual
- \(V_a\) is the value accrued at a constant rate from time \(a\) to \(b\)
- \(DR\) is the instantaneous equivalent of the annual discount rate (\(DR\)) given by the following formula:

\[
DR = \ln(1 + DR)
\]

Discounting formula for time-based DES rewards

The formula above calculates the discounted value of a reward that is accumulated between times \(a\) and \(b\). Fortunately, you will not have to recreate this formula. Global Discounting takes care of it for you. There are also two discount functions - DiscountCont and DiscountContDES - which you can use to apply the continuous discounting formula yourself.

### 46.15 Order of Calculations

This section highlights the order in which values are calculated within a DES model.

At a time node, calculations proceed as described below.

1. Calculations when entering the time node.
   - Update startup & event rewards (discount based on _time when entering the time node).
   - Update trackers.
2. Calculations when moving from the time node to one of its branch events.
   - Update time rewards (discount on continuous basis from _time entering and exiting the time node).

At non-time nodes, there are no time rewards, so only item 1 above applies.

### 46.16 Time Reporting for DES Models

Time Reporting is described in detail in the Microsimulation Time Reporting Chapter. However, Time Reporting is also possible for DES models as described here.
Time Reporting allows you to record data updates during Microsimulation, then generate reports based on the time-based data. In this section, we will examine Time Reporting in the DES tutorial example model DES.Model.With.RepeatingEvents.

The model is already setup to record all data items for Time Reporting within Tree Preferences. For details on how to setup Time Reporting, refer to the Configure Model for Time Reporting section. After running Microsimulation on the model, note the Time Reporting options.

### Time Reports in Microsimulation Output

All report options are described in the Microsimulation Time Reporting Chapter.

First will focus on how to use the Trial (per strategy) report to verify the DES model is running as designed. Then we will look at how the Cohort (per strategy) report is compiled.

#### 46.16.1 Trial Report (per strategy)

The Trial Report (per strategy) provides a details on how each individual passes through the model to track patients. The report uses a similar format to the Markov Cohort Extended Report; however, the data is shown for one individual at a time. In this model these are the reports called Trial (Tx 1) and Trial (Tx 2).
Time reporting records the path of each trial by Stage and Node. The Trial Report provides a trace of a single trial's path in a familiar format. If a node is shown, that patient passed through that node in its path. The report follows the path of each trial until its path is complete.

We consider the Tx 1 Strategy, one of the two strategies in this model. From the Time Reporting options, select the Trial (Tx 1) report and it generates the Monte Carlo Time Trial Report as in the figure below (shown for trial 2).

The columns in the Trial Report are the same for all Trials, but the number of stages and the states/ transitions for each trial will be different.

Due to the nature of a DES model, the column for each Stage represents where an event has occurred. (DES models do not have fixed time stages due to the continuous nature of time.) The additional Time column records the time each event occurs.

For example, in the report above Trial 1 progresses as follows:

- Stage 0 - Equivalent to Time 0 - 1.906: Trial waits at the Mild node and then progresses to Severe. Cost and Effectiveness are accumulated at the Mild node from time 0 - 1.906. Cost of Progression at Mild ToSevere is added at time 1.906. Trial moves to the Severe node.
- Stage 1 - Equivalent to Time 1.906 - 2.798: Trial waits at the Severe node until an Adverse Event occurs at time 2.798. Cost and Effectiveness are accumulated at the Severe node from time 1.906 - 2.798. There is a cost associated with the Adverse Event of 3,000 and it is added at time 2.798. Trial returns to the Severe node.
- Stage 2 - Equivalent to Time 2.798 - 4.133. Trial waits at the Severe node until Death at time 4.133. Cost and Effectiveness are accumulated at the Severe node from time 2.798 - 4.133.

- Stage 3: Exits model via Dead.

The example above shows how the cost and effectiveness changes for each event. Note changes to trackers and distributions can be seen scrolling further to the right in the Trial Report. This is important where we have distributions which need to be resampled at a given node for the next event.

In 2018 R1 and earlier, there is no option to generate Cohort type reports from trial level data for DES models. This was introduced in 2018 R2.

### 46.16.2 Cohort Report (per strategy)

The Cohort Report (per strategy) provides details into the flow of individuals through the model. This report is very useful when validating that patients are moving through the model in a way that accurately represents the underlying disease and treatment.

The report uses the identical format as the Markov Cohort Extended Report; however, the data is generated by rolling up the continuous time for patient events into discrete time steps.

When patients run through a DES model, events could happen at any time, so aggregation is necessary to show general movements of patients at the cohort level. The aggregated data is then presented as percentages of the cohort and reward accumulation at the beginning of each time period just like the Markov Cohort reports.

Consider the following example.

- A simple DES model contains two health states - Alive and Dead.
- We run 5 patients through the model, and they die at the following times:
- At the beginning of each year, the percentage of the cohort in each state is presented below.
  
  - 1.2 years
  - 1.8 years
  - 2.3 years
  - 2.9 years
  - 3.5 years
  - Year 0: Alive 1.0, Dead 0.0
  - Year 1: Alive 1.0, Dead 0.0
  - Year 2: Alive 0.6, Dead 0.4
  - Year 3: Alive 0.2, Dead 0.8
  - Year 4: Alive 0.0, Dead 1.0
Consider the time at the beginning of Year 2 above - the first 2 patients would have died by then, but the last 3 would still be alive, resulting in the percentages presented above.

We will use the same analysis data from the DES tutorial example model DES.Model.With.RepeatingEvents to examine the cohort-level reporting. From the Time Reporting options, select the Cohort (Tx 1) report to generate the cohort report shown in the figure below.

The report accumulates rewards, trackers and payoffs based on the specific node and cycle dependent on the percentage of overall trials. The percentages and the rewards are derived from the actual numbers of trials in each state at the rolled up discrete time step (0, 1, 2 etc) and also the rewards accumulated for each trial in each state.

For example, since 10,000 trials were run through the model, 7836 trials were still in the Mild state at the beginning of _time 1, resulting in a cohort percentage of 0.7836. Those 7836 trials, generated a cost of 20,440,000 at the Mild node, which is shown as a percentage of 10,000 trials with the value 2,044.

The summary data at the bottom of the report shows the final breakdown of the 'cohort' from microsimulation among states including the source of all reward data.

In the Cohort report, details of all the payoffs and trackers are shown by scrolling to the right (as in the figure below).
Monte Carlo Time Trial Report (for Tx 1 strategy), highlighting distributions and trackers columns further to the right

The secondary reports on the right-hand side also present the aggregated data for all trials in the microsimulation into cohort type graphs. More details about these graphs can be found in the section: Secondary - Markov Cohort Graphical Output since the output uses the same format.

46.16.3 All Data report

This section focuses on the All Data time report, which outputs all data values selected for time reporting. In most cases, the Cohort and Trial reports will provide what you need in a familiar format; however, the All Data time report literally includes "all data". If you want to examine data not included in the Cohort and Trial reports, this All Data time report may be useful. Later in this section, we will export the All Data time report to Excel for formtting and calculations that are helpful in verifying that a DES model is running as designed.

Generate the All Data Time Report using the following parameters to choose the first 10 trials for both strategies.

All Data Report Selection
The resulting report is displayed below.

![Monte Carlo Time Events - All Data](image)

**Time Reports - All Data Report**

If you wanted to generate some customized reporting based on patient pathways, you might export this report to Excel or another program.

### 46.17 Converting a Markov Model to a DES Model

Modelers who are more comfortable with Markov models might choose to convert an existing Markov model to a DES model rather than build the DES model from scratch. The conversion process does not create a fully functional DES model, but it does create an initial structure which you can modify and add required details.

We will try this process with the Health Care tutorial example model Microsimulation Markov Clone.trex, which is a health state-based Markov model. The resulting DES model will include the same health states, rather than the simpler event loop structure described earlier in this chapter. Both kinds of DES models are valid.
Markov Cancer Decision.trex

Right-click on the top Markov node and choose Convert to DES from the context menu. This results in the creation of a new model document as shown below.

DES Model from Conversion

You will notice a few differences between the Markov model and the DES model.

- The Markov node is converted to a DES node.
- The health state Chance nodes are converted to Time nodes.
- All progressions from a state to any other state is represented by a branch of the DES state time node.
- Progressions from a state back to itself are not included in the DES model if all probabilities on the path use the complement (#). Typically these are not required in DES models.
- Progressions from a state back to itself are included in the model if any probability on that path does not use the complement (#). Note there is no such case in this model.
- An extra absorbing state is added to account for the time horizon, which is required for DES, but not for Markov.
- References to _stage are replaced by references to _time.

This conversion process does not create a finished DES model. You will still need to create expressions for time-to-event that likely reference distributions. However, this process can still be helpful when creating a DES model.

ℹ️ Transitions from a health state back to itself for which all path probabilities are not set to the complement (#) probably need to be included in the resulting DES model. This is especially true if the path contains transition rewards and/or tracker modifications. The conversion process will generate a transition which includes "EVENT?" in the node label.
47. State Transition Diagrams

In TreeAge Pro, Markov models are presented and analyzed in decision tree format with health states and transition subtrees. TreeAge Pro also supports state transition diagrams to represent Markov processes, however, analyses can only be run on Markov models in decision tree format.

State transition diagrams can be helpful in providing a simpler representation of the health states and transitions within the model. It can be a good starting point to create a full Markov model and it can also be a good communication tool for an existing Markov model.

This chapter covers the following:

- How to create a state transition diagram
- How to convert a state transition diagram to a Markov model in decision tree format
- How to convert a Markov model in decision tree format to a state transition diagram

47.1 State transition diagrams

State transition diagrams provide a simpler representation of a Markov model than decision trees. While they do not display the level of detail found in a decision tree (i.e., events, probabilities, and rewards), state transition diagrams clearly show the transitions among health states. Even in complex Markov models, where the decision tree is far too large to fit on a single printed page, the corresponding state transition diagram is almost always small enough for simple reproduction and efficient communication.

The design of a state transition diagram is subject to a number of guidelines. Here are the basic ones:

- "States" that represent health status.
- "Arcs" that represent transitions between any two states.

The combination of states and arcs represent the possible movements of a patient from one health state to another over the entire course of the model timeframe.

47.2 Constructing a state transition diagram

The tutorial in this chapter explains in detail the software commands needed to build a state transition diagram loosely based on the simple three state Markov model described in the Building and Analyzing Markov Models Chapter.

To get started, you will need a new state transition diagram document.

To create a new state transition diagram:

- Choose File > New State Diagram from the menu.
47.2.1 Adding and selecting states

Unlike a new tree, which starts with a root node, a new state transition diagram window is completely blank. The first step in building the diagram is to add the required states. Let’s start by creating a *Well* state.

**To add a state to a state transition diagram:**

- Click on State in the Diagram Editor Palette as seen below.
- Click and hold the mouse within the diagram editor diagram to place the node.
- Drag the mouse down and to the right to resize the new node.

![State Transition Diagram Palette](image)

You will see a new, selected state. TreeAge Pro indicates that the state is selected by showing a rectangular outline with resizing markers on every corner and every edge. The node will contain the index value 1 since it is the first state added to the diagram. The node label will also be selected waiting for you to enter the appropriate text.

![New unlabeled state selected](image)

The outline around the state can be used to move or resize the state.

When the state is not selected, the rectangular outline will disappear. Since the state label was not entered, it will appear as an ellipsis.

![New unlabeled state not selected](image)

**To select a state:**

- Click inside the state borders.

47.2.2 Entering the state label

You should enter a word or brief phrase in the text box to describe the health state. You can enter the state label when you first create the state, or you can enter/edit the state label later.
To enter/edit the state label:
- Select the state.
- Click on the existing state label or the middle of the state if no text has already been entered.
- Type the state label text (in this case Well) in the text area.
- Click outside the state to deselect it.

Well state with state label entered

To force a carriage return in a label press Control + Enter within the text.

Now add two more states - Disease and Dead.

Added Disease and Dead states

47.2.3 Adding arcs

Arcs are used to show transitions between pairs of states. The arrow head at one end of the arc indicates the direction of the transition.

To draw an arc:
- Click on Arc in the State Transition Diagram Editor Palette. See below.
- Click on the Well state and drag the arc to the Disease state; then release the mouse button.

A new arc will be created pointing from the Well state to the Disease state.
Add new arc

It is frequently useful to add a comment to describe the influence relationship represented by the arc.

To edit an arc label:

- Double-click on the arc.
- Enter text ("Get sick") into the Arc Data dialog Comment field.
- Click OK.

As the arc moves relative to its source/destination states, the label will automatically move with it.

The arc label can also be moved closer/further from the arc.

To move an arc label:

- Click on an arc label and drag it to a new location.

To bend an arc:

- Select the arc.
- Click on the bend point in the middle of the arc and drag it in the direction you wish to bend the arc.
- Release the mouse button.

Bend an arc

Once an arc has been bent, additional bend points will appear on either side of the bend point that was moved. This allows for more complex arc curvature.
Arcs can be added for transitions from a state back to itself by clicking on the same state for the source and destination of the arc.

Now, add the other required arcs.

- **Recover arc from Disease to Well.**
- **Die arc from Well to Dead.**
- **Die arc from Disease to Dead.**
- **Stay healthy arc from Well to Well.**
- **Stay sick arc from Sick to Sick.**

The state transition diagram is now complete.

The state transition diagram is now complete.

47.2.4 More editing options

Additional options for editing state transition diagrams are described in this section.

To move a state:

- Select a state and drag its outline (not a resize point) to a new location.

When a state is moved, the arcs attached to it will move accordingly.

To cut a state:

- Select a state.
- Choose Edit > Cut from the menu or press Control + X on the keyboard. *Arcs attached to the state will also be cut.*

To resize a state:

- Select a state.
- Click and drag one of the resize marks on the rectangular outline around the state.

To select multiple states:

- Select one state then hold down the Shift key and select another state.
- **Or...**
- Click on open space in the diagram and drag to create a rectangle that surrounds all elements you wish to select

To delete an arc:
- Select the arc.
- Press the Delete button on the keyboard.

To bend an arc:
- Click on the arc points and drag it to another location. Rather than moving the entire arc, it will be split into two line segments, each terminated at the new drag location.
- You can bend this further by dividing up those line segments using the same technique.

To arrange all states evenly:
- Choose Edit > Auto-arrange states.

47.3 Converting a state transition diagram to a decision tree

State transition diagrams cannot provide all the details required for most Markov models. However, you can create a state transition diagram to conceptualize the Markov model and then convert it to the decision tree format.

To convert the diagram:
- Open and activate the state transition diagram editor window.
- Choose Edit > Convert to tree from the menu.
State transition diagram converted to a markov model

The resulting Markov model includes all the states from the state transition diagram. It also includes all the transitions emanating from each state and the arc labels become the node labels for the transitions. Markov rewards and transition probabilities could then be added to the model. The transition subtrees may also be expanded to add events.

The Markov model can be incorporated into a larger decision tree via copy/paste subtree.

47.4 Converting a Markov model to a state transition diagram

Since analyses are run on the Markov model in decision tree format, you might ask why you would want to convert a Markov model to a state transition diagram. Well, you might want a simpler representation of the Markov model for communication purposes. With a state transition diagram, it's easier to see the flow of patients among the health states.

To illustrate this process, you can open the Health Care tutorial example model “Three-State Markov.”

To convert a Markov model to a state transition diagram:

- Right-click on a Markov node in the decision tree.
- Choose Convert to STD from the context menu.

The result is a new state transition diagram with all states and transition arcs. Note that there may be many paths from one state to another, but only one arc will be created.
Markov model converted to state transition diagram
48. Model Dashboard and Documentation

This chapter describes the Dashboard View which gives an overview of your model and Model Documentation which is a mechanism used to document your model.

48.1 Using the Model Dashboard

TreeAge Pro provides a View to give you an overview of your model. You access the Dashboard through the Views menu. The figure below shows what the Dashboard looks like.

Dashboard View

The Dashboard is split into 3 sections, each providing different information about your model. Selecting any of the text highlighted in blue will take you to where you can edit the details (such as Calculation Method) or it will toggle between settings (such as Displayed/Hidden). The 3 sections are:

- **Model Properties**: Access all the main properties of the model including Calculation Method, Payoffs, willingness to pay and any linked Workbooks.
- **Model Structure/Display**: Details the number of strategies, number and type of nodes, and display settings such as whether to show variables, notes, Markov info and clone copies is found here.
- **Model Inputs**: Any information entered into the model can be updated through this pane including variables, distributions, tables and trackers. Selecting any of the blue text will take you to the appropriate View.

When the Dashboard view is not full size, each of the sections appear as selectable tabs to allow access to all the information by clicking through each tab, as in the figure below. This pane can also be detached from TreeAge Pro, right-clicking on the tab and selecting "detach".

---

859
Dashboard View with tabs for each of the 3 panes. Right-click and select Detached to detach and move independently of the main windows.

48.2 Create Model Documentation Help File

TreeAge Pro provides Help html files to describe the software and its functions. You can create a similar Help html file to describe your model.

There are three steps to this process.

- Create an Excel workbook for model documentation based on the model structure.
- Edit the Excel workbook to add documentation text.
- Import the Excel workbook to create a Help html file.

Creating model documentation

We will use the Get Started tutorial example model Three Vars to demonstrate this technique.

To create an Excel workbook for model documentation:

- Open the model.
- Choose File > Model Help/Documentation > Create Help Workbook > Simple Model Docs Template.
- Select the model input types that exist in your model and what you wish to document.

Different Help Workbooks are available for cost-effectiveness and CE Markov models.

This creates a workbook file next to the model file within the same folder with the same name, but with "_ModelDocs.xls" added to the end. The workbook contains placeholder cells for entering model documentation.

To open the workbook for editing in Excel:
- Select the applicable model in the Tree Diagram Editor.
- Choose File > Model Help/Documentation > Open Documentation Spreadsheet.

The cells with labels and "<title>" type tags should be left alone. The cells to the right of these "label" cells are used for entry of descriptive text. See below.

---

**Model Documentation Workbook**

Once the text in the workbook has been updated, it can be imported back into TreeAge Pro to generate the Help html file.

**To create the Help file:**

- Select the applicable model in the Tree Diagram Editor.
- Choose File > Model Help/Documentation > Export Workbook to HTML Help
This creates an HTML file next to the model file within the same folder with the same name, but with "_ModelDocs.html". This Help file is then available for documentation of the model.

**To open the Help file:**

- Select the applicable model in the Tree Diagram Editor.
- Press the F1 key.

The Help file will look like this.

![Help file screenshot](image-url)

Model Documentation Help
49. Model Debugging and Validation

This chapter describes some mechanisms to debug a model and how to validate your model by looking for commonly found flaws within the model.

49.1 Debug Using the Calculation Trace Console

TreeAge Pro provides debugging options to display the internal calculations performed as a model is analyzed. These calculation details can then be reviewed in the Calculation Trace Console, providing valuable validation and debugging information.

The debugging options provide flexibility to generate debug output for the entire analysis or limit the output to specific calculations, Markov cycles, trials, etc.

To setup debugging options, open Tree Preferences and select the category Analysis Settings > Debugging/Calculation Trace Console as shown in the figure below.

The Debugging/Calculation Trace Console options include the following...
- **Show in Console**: Select the items you wish to see in the debug view as TreeAge Pro performs calculations.

  - **Errors, warnings and notes**: Check this box to avoid having TreeAge Pro pop-up dialogs when warnings or error messages need to be displayed; instead, checking this box will have the text added to the Calculation Trace Console.
  - **Text-only analysis output**: Check this box to write text report analysis output to the Console. For example, Rankings output is purely text and would be written to the Console.
  - **Saved analysis abstract/summary**: Check this box to display summary information in the Calculation Trace Console about any new analyses available for storage. This information can be stored for later use via Stored Analysis.

- **Console settings**: Select how you want the output to the console to be displayed.

  - **Clear console before each analysis**: Check this box to clear the console before each new analysis.
  - **Limit console output (if # of lines exceeds)**: Select the maximum number of lines to display within the Calculation Trace Console. Older lines are dropped when the maximum number of lines is exceeded. A larger number holds more outputs in the debug view, which uses more system resources.

- **Show output for**: Controls whether calculations should be written to the console. These are is the most important debugging settings.

  - **All**: Calculation Trace Console will show all calculations executed during the analysis.
  - **None**: No trace output generated.
  - **Selected Elements**: Calculation Trace Console will show calculations only for specific elements within the model. You then need to select the elements you want to debug in your model in model input views.

    - Variable definitions calculations - via the Variable Properties and Variable Definitions Views
    - Tracker modification calculations - via the Tracker Modifications View
    - Distribution parameter calculations and sampling - via the Distributions View

- **Markov Cycles**: Option to limit output to a specific set of cycles for a Markov model.
- **Trials**: Option to limit output to a specific set of trials for a Microsimulation model.
- **Samples**: Option to limit output to a specific set of PSA iterations for a Sampling/PSA analysis.
- **EVPPI**: Option to limit output to a specific set of EVPPI iterations for a EVPPI Sampling/PSA analysis.

Consider the Health Care tutorial example model, Markov Conversion Model.trex. This is a Cancer Model with two treatment strategies. It is not a microsimulation model and can be run with usual
Expected Value calculations. We will run the model with debug turned on for *All* and then for *Selected Elements* in the subsequent sections.

### 49.1.1 Show Debug Output for All

*To show debug output for all calculations:*

- Open the Markov Conversion Model.trex.
- Open the Tree Preferences > Analysis Settings > Debugging/Calculation Trace Console
- In “Show Output for” select All. Then select OK.
- Rollback the model and then examine the Calculation Trace Console.

The Calculation Trace Console shows the extensive output which is every calculation the model makes during analysis. This can be examined for total transparency of the calculations in the model. The figure above shows the first calculations in the model - the termination condition check, the health state initial probabilities, and the Markov rewards for the Local Cancer state.
If your Calculation Trace Console is not open, select the Views menu and select the Console from the dropdown menu.

49.1.2 Show Debug Output for Selected Elements

To show debug output for selected elements/calculations within the model:

- Open the Markov Conversion Model.trex.
- Open the Tree Preferences > Analysis Settings > Debugging/Calculation Trace Console.
- In "Show Output for" select "Selected Elements". Select OK.
- There is an option to limit the output based on Trials, Samples, EVPPI samples and Markov Cycle. We will not limit the output for this example.
- Next, select elements in the model to Debug. In this example we will review calculations of the variable $p_{DeathBackground}$. Open the Variable Properties View, locate the variable $p_{DeathBackground}$, and check the Debug box (as shown in the figure below).
- Rollback the model and then examine the Calculation Trace Console.

In the Variable Properties View select the variables to Debug.
Examine the Calculation Trace Console for \textit{pDeathBackground} we can examine the common elements.

- \textit{******* pDeathBackground - START *****}: Indicates the start of the calculation of the parameter selected for debugging.
  - \textit{Context}: This indicates where in the tree, for which strategy, sample and cycle the calculation is occurring.
  - \textit{Time}: Time of the calculation in TreeAge Pro.
  - Details about the calculations, including the calculations for any other elements in the model which need evaluating to complete the calculation.
- \textit{******* pDeathBackground - END *****}: Indicates the end of the calculation of the parameter selected for debugging.

This format is used for any model element selected for debug output.

Note that if you want to debug a variable definition that is not at the root node, use the Variable Definitions View with the appropriate node selected.
49.1.3 Show Debug Output for Payoffs

To show debug output for a payoff calculation:

- Open the Health Care training example model, Example02-Variables.trex.
- Open the Tree Preferences > Analysis Settings > Debugging/Calculation Trace Console.
- In “Show Output for” select “Selected Elements”. Select OK.
- From the Views menu open the Node Properties View.
- Select the node "Surgery and Radiation eradicate tumor" where there are cost and effectiveness payoffs set (as highlighted in the figure below).
- In the Node Properties View use the tabs on the left hand side to go down to Payoffs and then check the box next to the cost and effectiveness payoffs for debugging. The figure below shows this.
- Rollback the model and then examine the Calculation Trace Console. The output is similar to debugging as variable, as detailed above, but in the context of evaluating the payoffs.

49.1.4 Show Debug Output for Probability Expressions

To show debug output for a branch probability calculation:

- Open the Markov Conversion Model.trex.
- Open the Tree Preferences > Analysis Settings > Debugging/Calculation Trace Console.
- In “Show Output for” select “Selected Elements”. Select OK.
- From the Views menu open the Node Properties View.
- Select the node "Die from Background Mortality" where the probability is pDeathBackground.
- In the Node Properties View use the tabs on the left hand side to go down to Probabilities and then check the box next to pDeathBackground for debugging. The figure below shows this.
- Rollback the model and then examine the Calculation Trace Console. The output is similar to debugging as variable, as detailed above, but in the context of a Probability Expression.

"Die from Background Mortality" selected and Debug checked in the Node Properties View.

49.1.5 Show Debug Output for Trials in a Microsimulation model

For Microsimulation models, you can show debug information for each patient or limit it to specific patients.

To show debug output in a Microsimulation model:

- Open the Health Care tutorial example model, MicrosimulationCancerModel - Distributions.trex. This is a Microsimulation model including Trackers.
- Go to Tree Preferences > Analysis Settings > Debugging/Calculation Trace Console.
- In "Show Output for" select "Selected Elements". Click OK.
- There is an option to limit the output based on Trials, Samples, EVPPI samples and Markov Cycle. We will not limit the output for this example but we will only run two trials in the analysis.
- Next, select elements in the model to Debug. In this example we will review calculations of the variable $p_{AE\_Death}$ and the tracker modification $t_{AE}$ at the Adverse Event node. Open the Variable Properties View, locate the variable $p_{AE\_Death}$, and check the Debug box (as shown in the figure below). Select the Adverse Event node, open the Tracker Modifications View, and check the Debug box next to the tracker modification.
- Run Microsimulation for two trials and then examine the Calculation Trace Console.

⚠️ When running a microsimulation model, if you select Show Output for All, then it is important to limit the number of trials in your analysis. There will be a large amount of data (the internal calculations) sent to the console and if there are too many, the console will crash and you are likely to get an error.
The Calculation Trace Console shows the same details per element selected as with the Cohort model, but now there are also details about the trial included in the context. In the example above, for both trials 1 and 2, \( t_{AE} \) and \( p_{AE\_Death} \) are evaluated at \_stage 8.

Note that if you run a Monte Carlo Simulation analysis on a computer with multiple processors, the debug output will likely be split by thread as each thread process different iterations within the analysis.

Note that you can limit the number of threads used for analysis to consolidate this output if necessary.

Even if the boxes are checked in the Views, unless the Tree Preferences is set to Show Output for All, then there will be no output to see in the Console.
49.2 Using Debug functions to control output

Most of the time, you will use Tree Preferences to control the debug info written to the Calculation Trace Console. However, you can also generate debug info by placing debugging functions directly in the model.

The following table lists the specialized commands which can be executed to debug a model.

<table>
<thead>
<tr>
<th>Function syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DebugOn()</td>
<td>Turn the calculation trace setting on. After issuing this command, all internal calculations will be written to the Calculation Trace Console.</td>
</tr>
<tr>
<td>DebugOff()</td>
<td>Turn the calculation trace setting off. After issuing this command, internal calculations are no longer written to the Calculation Trace Console.</td>
</tr>
<tr>
<td>DebugExport(filename)</td>
<td>Export the current contents of the calculation trace console to a .txt file to a specific location with a specific name. An example of what we could replace file with is: filename = path + &quot;name_of_file&quot; + Str(_trial) + &quot;.txt&quot; where path = &quot;X:\Testing\DocModels\Output_files\&quot;; name_of_file = the new name of the file where we save the export; Str(_trial) = the number of the current _trial in the model; and .txt = sets the file type.</td>
</tr>
<tr>
<td>DebugExport(index)</td>
<td>Export the current contents of the calculation trace console to a file with the same name as the model, followed by &quot;.trace_&quot; plus the index and with the file extension .txt. The .txt file will be located in the same folder as the original model.</td>
</tr>
<tr>
<td>DebugClear()</td>
<td>Clear all the output in the calculation trace console.</td>
</tr>
<tr>
<td>DebugWrite(text)</td>
<td>Send the text argument to the console with a blank line before and after it. Note the text will only be written if debugging is turned on via the Tree Preferences or via the DebugOn() function.</td>
</tr>
<tr>
<td>DebugWriteForce(text)</td>
<td>Send the text argument to the console with a blank line before and after it. Note the text is written regardless of whether debug output is turned on or off.</td>
</tr>
<tr>
<td>DebugTime()</td>
<td>Write the current date/time including milliseconds to the console. Note the text will only be written if debugging is turned on via the Tree Preferences or via the DebugOn() function.</td>
</tr>
<tr>
<td>DebugTimeForce(text)</td>
<td>Write the current date/time including milliseconds to the console. Note the text is written regardless of whether debug output is turned on or off.</td>
</tr>
</tbody>
</table>
If the Debug() function requires the debug output to be turned on then this can be done either via turning on 'Show Output for All' in the Tree Preferences or by using the DebugOn() function.

The Debug() functions can be useful when combined with some of the keywords which are specifically used to select individual trials in Monte Carlo analysis. More information about these keywords can be found on the section about Customizing Simulations, specifically in the section about Monte Carlo special variables. The Model Debugging and Validation Chapter has examples using a number of the Debug tools to debug models.

Below are a couple of examples using the Debug() function.

49.2.1 Example: Using the calculation trace dynamically

It is often useful to turn the Calculation Trace on to examine specific calculations and why the model might be failing. For models with a large number of calculations, it is prohibitive to turn the Calculation Trace on for all trials (microsimulation) and samples (sensitivity analysis). It may take too long for the Calculation Trace to get to the point where the model is failing.

In these situations, looking at the internal calculations from the Calculation Trace Console for all trials may not be required but you may want to look at a specific trial's values.

To pinpoint a specific trial's calculations

Examine the Special Features example model, Debug MicrosimulationCancerModel.trex.

Consider an error which is occurring for trial 999 in a Monte Carlo simulation. To look at the internal calculations for just trial 999, the model has the following definitions included:

- Create a special simulation variable to turn on the calculation trace before trial 999 goes through the model: _monte_pre_trial_eval = if(_trial=999; DebugOn(); 0).
- The special variable/keyword _monte_pre_trial_eval is a built-in keyword in TreeAge Pro. It will ensure the expression it equals will be evaluated before every trial in the model is evaluated. In this case the expression will turn the debug function on, using DebugOn(), if _trial = 999. Otherwise the expression will do nothing.
- Create a special simulation variable to turn off the calculation trace after trial 999 has finished with the model: _monte_post_trial_eval = if(_trial=999; DebugOff(); 0).
- The special variable/keyword _monte_post_trial_eval is a built-in keyword in TreeAge Pro. It will ensure the expression it equals will be evaluated after every trial in the model is evaluated. In this case the expression will turn the debug function off, using DebugOff(), if _trial = 999. Otherwise the expression will do nothing.

Running microsimulation on the model with 2,000 trials will show one output in the Calculation Trace Console, that is the calculations for _trial = 999.
Other useful keywords, like _monte_pre_trial_eval, can be used to customize your models. They can be found in the section about Customizing simulations.

49.2.2 Example: Locating distribution sampling errors

A common Analysis Error which occurs is related to distributions. Distributions may be defined appropriately when sampled independently. However, a combination of distribution samples can cause probability errors during analyses. A typical Error message is shown in the figure below, which was generated by running Probabilistic Sensitivity Analysis on the Special Features example model, Debug WriteForce MarkovCancer.trex.

![Error message generated at runtime from poor distributions.](image)

Open the example model, Debug WriteForce MarkovCancer.trex and examine the two distributions.

Both Dist_p_Local_Death and Dist_p_Local_Mets are Beta distributions with the same parameters, mean of 0.4 and standard deviation of 0.1.

Both the distributions are sampled per Expected Value, so when we run Probabilistic Sensitivity Analysis every re-calculation of the model will re-sample from the distributions.

In the Tree Preferences we have chosen to turn on seeding and threading. We have turned seeding on to replicate the same results over and over again. This is a useful technique if you are trying to locate a problem in a model which keeps moving when the random number seed changes. We have chosen to run the model with a single ("1") thread which means that the calculations have to take place in order. You can find out more about these options in the following section about Simulation Options.

Run the model by selecting the decision node and then Analysis > Probabilistic Sensitivity Analysis. Run 100 samples. The error message should be similar to the Figure above.
To debug this model we have created a variable which we can add to any variable in the model to examine specific output. The variable is:

\[
outputDebug = \text{DebugWriteForce}(\text{"Sample= } + \text{str(}_\text{sample}_\text{)} + \text{"}, \text{Prob LocToMets=} + \text{str(Dist}_p\text{ Local_Mets}) + \text{"}, \text{Prob LocToDead=} + \text{str(Dist}_p\text{ Local_Death)}).\]

Consider the the first few elements of the variable outputDebug:

- \textit{DebugWriteForce( text here )}: This is the command which instructs the model to write whatever is in the place of "text here" to the console. This command will work even if debug is turned off in the Tree Preferences.
- \textit{"Sample = " + str(}_\text{sample}_\text{)}: This is some of the text which is included within the executable section of the function DebugWriteForce. It has three elements:
  - Quotation marks: Anything written within " " will be written to the console. In this case "Sample = ".
  - The + : This is used to concatenate expressions. In this case, "Sample = " will be first followed by the interpretation of str(}_\text{sample}_\text{).
  - str(}_\text{sample}_\text{): The function str() converts whatever is in the brackets to text for the screen. This example converts the keyword _sample (which gets the current sample number) to a string. We would expect in Probabilistic Sensitivity Analysis (PSA) a new sample number for each of the PSA samples.

The other elements which make up the variable are similar. Instead of the sample number being written to the screen, the value of Dist_p_Local_Mets and the Dist_p_Local_Death are written respectively.

This variable outputDebug can be added anywhere within the model. Because all the debug functions have zero value adding this variable to another variable in the model has no impact on the value calculated. In the example model you will see we have added the variable to the probability under the branch at Local Cancer > Progress to Metastases. The figure below shows the output in the Calculation Console Trace immediately before the Error happens.

![DebugWriteForce output in the Calculation Trace Console](image)

The error can now be identified in the model. The sum of all the probabilities at the Local Cancer node must be 1. By including the # under the Stay Here branch, the model first calculates the probabilities at the other two branches and the calculates the probability at the Stay Here branch. The output above
shows that when the PSA gets to the forth sample, the values which are generated from the Beta distributions from \( p_{\text{LocalToMets}} = 0.365 \) and from \( p_{\text{LocalToDeath}} = 0.663 \). The sum of these alone is greater than 1 so the model is unable to define the probability under the Stay Here branch. Whilst both the distributions are valid, the Example model needs to reconsider their combined probabilities.

In addition, look at the String Processing section for syntax related to creating string expressions for the DebugWrite and DebugWriteForce functions.

### 49.3 Model Debugging examples

Examples for debugging models can be found in the previous two sections. This section existed prior to the introduction of global commands in the Tree Preferences for Debugging.

### 49.4 Model Validation

This section describes a mechanism used to validate your model by looking for commonly found flaws within the model.

#### 49.4.1 How model validation works

TreeAge Software has identified a set of common flaws in models; the model validation process checks for these flaws in your model and presents any occurrences of these flaws back to you.

The specific validation checks are:

- **End Nodes Validator**: find end nodes that are not terminal nodes.
- **Missing Probability**: find branches of chance nodes with no probability expression.
- **Missing Payoffs**: find terminal nodes (non-Markov) that are missing payoffs.
- **Missing Jump State**: find terminal nodes (Markov) that are missing a jump state.
- **Unused Tracker**: find trackers that are not used in the model.
- **Unused Variables**: find variables that are not used in the model.
- **Unused Distributions**: find distributions that are not used in the model.
- **Unused Tables**: find tables that are not used in the model.
- **File compatibility**: identify features that are not supported by older versions of TreeAge Pro.

**Model Validation Checks**

More validation checks will be added to TreeAge Pro in future releases.

#### 49.4.2 Determine which validators to run

Tree Preferences provide the ability to turn on/off specific validator checks.
Uncheck any of the model validators to skip that check in the validation process.

### 49.4.3 Run the model validation

To illustrate the model validation process, we will open Special Features tutorial example model ModelValidationTest. As you can see below, it has a few model flaws: missing probabilities, missing payoffs and non-terminal end nodes.

**ModelValidationTest model**

*To run the model validation:*

- Open/activate the model in the Tree Diagram Editor.
- Open the Model Validation View from the Views list in the toolbar.
- Click the Validate button (green circle with white triangle).
The Model Validation View will display the results from all the validation checks. See below.

![Model Validation View](image)

The results are presented in a grid with a row for each validation check/problem. The first column indicates whether the row represents an error, warning or a successful check. A successful check means that no occurrences of problems were found. The second column displays the validator name. The third column displays a message related to the problem. The fourth column displays the context for that error/warning. The context is used to provide a node label or model input name associated with the problem. Double-click on any error/warning line in the grid to move either to the tree diagram editor to the highlighted node with the problem or to the proper model input view for the model input with the problem. This gives you immediate access to the context where the problem can be fixed.

### 49.4.4 File compatibility

Model validation identifies features that are used, but are not supported by earlier software versions. If you have used any such features, you will need to ensure that your colleagues have software that supports those features or they will not be able to open the model. Alternatively, you can modify your model to remove those features.

The following model validation output is from the Legal tutorial example model LegalTreeSummation.
Model validation - file compatibility

As indicated in the validation output above, the summation node feature was introduced with TreeAge Pro 2013, R2.
50. Preferences

This chapter describes TreeAge Pro preferences - Tree Preferences and Application Preferences.

The first section of this chapter describes Tree Preferences, which are specific to the active tree model, and are stored with the tree document. The last few sections describe Application Preferences, which are associated with the TreeAge Pro application and apply generally to the functioning of the software and to all models.

50.1 Tree Preferences

Tree Preferences provide control over many settings and options for the active model, including how it is calculated and how it is displayed. Although they are not part of the model structure or numerical data, Tree Preferences hold important configuration settings for a model that are stored within the model document.

Tree Preferences can be broken into a few main categories:

- Calculation preferences
- Display preferences
- Spreadsheet preferences
- Analysis settings

Some frequently used Tree Preferences can be set by using the Model Setup Wizard. The wizard prompts the user through specific elements of the Tree Preferences as listed below:

- Calculation method
- Additional options associated with the selected calculation method
- Payoffs
- Discounting
- Custom payoff names
- Numeric formatting

It is also possible to edit any Tree Preferences directly using the Tree Preferences Dialog.
Tree Age Pro allows you to save and load Tree Preference Sets, which include all the preference settings from the Tree Preferences Dialog. For example, you might regularly create two kinds of trees, cost-effectiveness trees and simple trees. You could save a Preference Set for each of these types from a model that you have already created. Then you could load the appropriate Preference Set when creating a new tree.

The controls for Preference Sets are at the bottom left corner of the Tree Preferences Dialog.
In the figure above, the down arrow control has been clicked to show the Tree Preference Set controls, which are described below:

- **New Set**: Create a new preference set for the selected model. The new preference set can be copied from an existing preference set already saved with the model.
- **Load Saved Set**: Load a set of preferences from an XML file into a preference set for the selected model. You will be asked to provide a name for the preference set within the context of the selected model.
- **Save AS XML**: Save the current preference set as an XML file. It can then be loaded into other models.
- **Save as default**: Save the current preference set as the default for new models.
- **Reset default**: Reset the default preference set for new models to the set that comes with the original software installation.
50.3 Tree Preferences Dialog

The Tree Preferences Dialog is used to edit Tree Preferences for the active model. You can open the Tree Preferences Dialog by first selecting a model and then using one of the following methods:

- Choose Tree > Tree Preferences from the menu.
- Click the "Tree preferences" icon on the toolbar.
- Windows/Linux: Pressing F11 on the keyboard. Mac OS: Set up a keyboard shortcut, if desired, in the Application Preferences

50.3.1 Tree Preference Categories

Tree Preferences are broken up into a number of categories as shown on the left side of the dialog. The list of available categories changes depending on what, if any, type of document is currently active. The list of categories can be filtered using the filter text input. Choosing a category from the list changes the page of options that appear in the right side of the dialog. The options in each category are described in this chapter.

50.4 Calculation Method

This is the first and most important category related to calculation preferences.
A model's Calculation Method controls the primary manner in which the model is calculated. TreeAge Pro supports four Calculation Methods.

**Calculation Method Selection**

- **Simple**: Make decisions based on a single payoff set.
- **Cost-effectiveness**: Make decisions based on separate payoff sets for cost and effectiveness values (by default, #1 and #2). This enables many analyses and reports associated with cost-effectiveness models, the most common being Cost-Effectiveness Analysis (CEA).
- **Benefit-cost**: Make decisions based on net value (profit) calculated as the benefit payoff set subtracted from a cost payoff set.
- **Multi-attribute**: Make decisions based on a weighted combination of several payoff sets.

**Calculation Methods**

The bottom portion of the dialog will change based on your selection.

### 50.4.1 Calculation Method - Simple

There are a few options available to control the Simple Calculation Method.

**Tree Preferences - Simple Calculation Method**

- **Optimal path**: Select *High* for decision analysis to choose the strategy with the highest value. Use this when your decisions are made on the basis of profit, utility, cash flow, quality of life or
other attributes that should be maximized. Select Low when payoffs are costs or other attributes that should be minimized.

- **Active payoff**: Choose the payoff set to use for decisions. The default is always 1.

### 50.4.2 Calculation Method - Cost-Effectiveness

There are a few options available to control the Cost-Effectiveness Calculation Method. There are also two subcategories: Cost-Effectiveness Parameters and Weighted Multi-Attribute Costs.

#### Tree Preferences - Cost-Effectiveness Calculation Method

- **Cost payoff**: Select the payoff to use for cost calculations within the model.
- **Effectiveness payoff**: Select the payoff to use for effectiveness calculations within the model.

Additional settings for cost-effectiveness analyses are set via the category "Cost-Eff Params (WTP)".

**Cost-Effectiveness Parameters (WTP)**
- **Willingness to pay**: Enter the weighting to place on effectiveness when balancing against cost. WTP is typically compared to ICERs during cost-effectiveness analyses. It is also used in Net Benefits calculations. You can enter a variable, but it cannot be used for sensitivity analysis because WTP is applied after the model is recalculated.

- **Show Net Benefits in rollback**: Check this box to show Net Monetary Benefits (NMB) with calculated EV values in rollback display.

- **Minimum effectiveness**: Check the box and enter a value to activate the minimum effectiveness value in CE calculations. This rejects any strategies that do not meet or exceed the minimum effectiveness threshold.

- **Maximum cost**: Check the box and enter a value to activate the maximum cost value in CE calculations. This rejects any strategies that are not less than or equal to the maximum cost threshold.

- **Inverting effectiveness**: The inversion options allow you to invert effectiveness when the measurement of effectiveness needs to be minimized (e.g., cases avoided) rather than maximized (e.g., life years).

- **Do not invert**: Do not invert the effectiveness value. This is the default value which assumes that you want to maximize the effectiveness measure.

- **Invert incremental only**: Invert only the incremental values among strategies. *This is usually the preferred method to handle minimizing effectiveness values.*

- **Invert average values**: Invert average cost-effectiveness values. This inverts all effectiveness calculations. When selected, you must enter a maximum effectiveness value.
- **Maximum value**: Enter a fixed maximum effectiveness value from which to subtract all nodes' calculated effectiveness values during cost-effectiveness calculations.
- **Select Graph Orientation**: Choose which graph format you wish to output.
- **Draw graph with cost on vertical axis**: Places cost on the Y-axis of the graph. This is the default setting.
- **Draw graph with cost on horizontal axis**: Places cost on the X-axis of the graph.

**Weighted Multi-Attribute Costs**

![Weighted Multi-Attribute Costs](image)

**Tree Preferences - Cost-Effectiveness Calculation Method - Weighted Multi-Attribute Costs**

- **Use weighted multi-attribute costs**: Check this box to activate weighted multi-attribute costs.
- **Payoff/weight grid**: Enter a weight for each payoff set.

**50.4.3 Calculation Method - Benefit/Cost**

There are a few options available to control the Benefit/Cost Calculation Method.

![Benefit/Cost Calculation Method](image)

**Tree Preferences - Benefit/Cost Calculation Method**

- **Cost payoff**: Select the payoff to use for cost calculations within the model.
- **Benefit payoff**: Select the payoff to use for benefit calculations within the model.
50.4.4 Calculation Method - Multi-Attribute

There are a few options available to control the Multi-Attribute Calculation Method.

Tree Preferences - Multi-Attribute Calculation Method

- **Optimal path**: Select High when the weighted multi-attribute calculated values should be maximized. Select Low when they should be minimized.
- **Payoff/weight grid**: Enter a weight for each payoff set. (This example has 3 payoffs).

50.5 Payoff Preferences

The Payoffs Tree Preferences category allows you to control the number of payoffs that are enabled in the model. This allows you to add payoffs to measure model outcomes beyond the primary outcome(s) for the model's calculation method.

Tree Preferences - Payoffs

- **Calculate extra payoffs**: Check this box to include the model's additional payoffs (beyond the primary outcomes) in most calculations (Rankings, Markov Cohort, Monte Carlo Simulation, etc.).
- **Number of enabled payoffs**: Select the number of payoffs to enable. Your calculation method will likely have 1 or 2 active payoffs. Increase this number to add more payoffs.
50.5.1 Discounting Rewards

The Payoffs - Discounting Tree Preferences category allows you to discount entire rewards sets based on the passage of time in Markov and DES models. For more information about the formula used in discounting, review the appropriate section about Markov models or DES models.

Tree Preferences - Discounting

- **Use global discounting**: Check this box to enable Global Discounting for the model.
- **Markov cycle length (in years)**: Enter the appropriate cycle length for your Markov model in one of two ways.
  1. Choose a common cycle length from the dropdown menu (Annually, Quarterly, Monthly, etc.). This pre-fills the time cycle value to the right. ....or....
  2. Manually enter the cycle length if you do not see the appropriate option in the list above. For example, 4 monthly cycles would be entered as 1/3.
- **DES time unit (in years)**: This refers to the units returned by time-to-event distributions. The two options to set the time interval for DES are the same as for Markov cycle length as described above.
- **Reward set/Discount rate grid**: This is where you set the discount rate to be applied to each reward set. The reward sets are generated from the enabled payoffs. If the model calls for a discount rate to only be applied to one reward set (unlikely) do not enter a discount rate for that reward set.

Enabling global discounting and apply to Markov model with Monthly cycle lengths (1/12) and 3% discount rate.

Note that you can enter either a numeric value (percentage or fraction) or you can use a variable accessible via the formula editor "=fx" button.
The figure below shows a model's Markov Info View highlighting those rewards which have been discounted with global discounting. Note there is no change to the reward in the value column, but the word *Discounted* next to the reward name indicates Global Discounting has been applied.

Markov Info view illustrating where rewards have been discounted.

### 50.5.2 Custom Payoff Names

The Payoffs - Custom Names Tree Preferences category allows you to create custom names for the enabled payoffs. You should always enter custom names if you added more payoffs to your model.

Tree Preferences - Custom Payoffs Names

- *Use custom payoff names*: Check this box to enable custom payoff names.
- *Payoff/Custom name grid*: Enter a custom name for each payoff set.

Note that the custom payoff names will be used for entry fields for payoffs and Markov rewards as well as in output reports.

### 50.5.3 Markov To Excel Payoffs

The Payoffs - Markov to Excel Payoffs Tree Preferences category allows you to select which payoffs you want to export in your Markov To Excel conversion. In the example below, the model has 5 payoffs and all are checked to export into the Excel model.

Find more details about using this feature to share models in the Markov to Excel Conversion Chapter.
50.6 Numeric Formatting

The Numeric Formatting Tree Preferences category allows you to control how numerical output is displayed within TreeAge Pro.

You can enter separate numeric formatting settings for each payoff, including both active and inactive payoff(s). As the Calculation Method preferences change, so too will the order of payoff(s) in Numeric Formatting, with the active payoff(s) presented first. In the figure below, the Calculation Method is Simple and payoff 1 is active. Any further inactive payoffs would be seen by scrolling down.

If the Calculation Method were Cost-effectiveness, then the active cost and the active effectiveness payoffs would be displayed, as well as numeric formatting for cost-effectiveness (a combination of the two payoffs). Further inactive payoffs would be displayed further down the screen.

- For payoff _: Indicates the payoff for which these Numeric Formatting preferences apply.
- Decimal places: Select the number of decimal places to display for the selected payoff.
- Add trailing zeros: This add zeros after the decimal place up to the defined number of decimal places. For example, 200.3 would be presented as 200.30 if "Decimal places" is set to 2 and "Add trailing zeros" is selected.
- **Use thousands separator**: Check this box to separate thousands using the defined separator for the model or for the computer.
- **Show numbers**: Select what order of magnitude you want to show numbers. Options include *exactly*, *in thousands*, *in millions*, *in billions* and *in percent*. The option you choose will depend on the size of the numbers used in the model.
- **Units**: Select the units that apply to that payoff.
  - **None**: Show calculated values with no units.
  - **Currency**: Show calculated values as currency. Note that the currency normally derives from the standard operating system settings on the computer. However, the currency can be overridden within the Regional Settings Tree Preferences.
  - **Custom prefix**: Display custom text before the calculated values.
  - **Custom suffix**: Display custom text after the calculated values.
- **Prefix/suffix**: Enter the custom text to be used when the **Units** are defined as **Custom prefix** or **Custom suffix**.
- **Sample**: Shows how calculated values will be displayed based on the Numeric Formatting preferences.

### 50.6.1 Probabilities

The Tree Preferences for numeric formatting Probabilities allows you to control how probabilities are displayed within TreeAge Pro.

![Tree Preferences - Numeric Formatting, Probabilities](image)

- **Decimal places**: Select the number of decimal places to display for all probabilities. For example, a probability of 0.045678 would be shown as 0.046 with the number of decimal places set to 3.
- *Show as %*: Select this box to show the probability as a percentage as opposed to a decimal value. For example, a probability of 0.045678 would be shown as 4.568% with this box checked and the number of decimal places set to 3.
- *Add trailing zeros*: This add zeros after the decimal place up to the defined number of decimal places. For example a probability of, 0.3 would be presented as 0.300 if Decimal places is set to 3 and Add trailing zeros is selected.

### 50.7 Roll Back

The Roll Back Tree Preferences category allows you to control how roll back analysis results are displayed.

- *Display calculated probabilities*: Check this box to display the calculated value of each of the probabilities using numeric formatting preferences during roll back. Turning off roll back will show the original, uncalculated probability expression.
- *Display EV at terminal and decision nodes & options only*: Check this box to display expected value roll back boxes only at terminal nodes, decision nodes, and branches of a decision node rather than at every node in the model.
- *Rollback calculates*: There are four options for the roll back display:
  - *Active Payoffs and Path Probabilities*: Displays the Expected Values for the calculation method's Active Payoffs at all nodes and Path Probabilities at terminal nodes. This is the default setting.
  - *Path Probabilities*: Displays only the path probabilities for all nodes.
  - *Active Payoffs*: Displays the Expected Values for the calculation method's Active Payoffs only.
  - *Maximin*: Select the most pessimistic option at each chance node and the best option at each decision node. This helps you choose the optimal strategy if every uncertain event goes badly.
- *Display path probabilities with all EVs*: Display path probabilities at every node along with the expected values.
- *Show Formulas and Calculated Values*: Displays the formula for payoffs and probabilities along with the calculated values.

**50.8 Risk Preferences**

The Risk Preferences Tree Preferences category allows you to determine whether to use risk preferences in expected value calculations or not. Refer to the Utility Functions and Risk Preference Chapter for more information.

**Tree Preferences - Risk Preferences**

- *Use risk preference function*: Check this box to calculate the model based on a risk function rather than expected value.
- *Risk function*: Select either a constant or non-constant risk function.

**50.8.1 Constant Risk Preference Assessment**

The Constant Risk Preference Assessment Tree Preferences category allows you to enter the risk preference coefficient.
- **Risk preference coefficient**: Enter a value that defines an amount you are willing to risk for the lottery above. This is used to create a risk preference curve. (More details are found in the Risk Preferences Chapter).

### 50.8.2 Non-Constant Risk Preference Assessment

The Non-Constant Risk Preference Assessment Tree Preferences category allows you to enter a series of risk values to generate a non-constant risk preference curve.

![Tree Preferences - Non-Constant Risk Preference Assessment](image)

### 50.9 Regional Settings

The Regional Settings Tree Preferences category allows you to define regional numeric and currency settings. For new models, these settings are pulled from your computer's operating system. However, you can override the settings in the Tree Preferences; this can be particularly useful when collaborating with colleagues in other countries.

Regional Settings within Tree Preferences control the format of input values (probabilities, payoffs, rewards, variable definitions, etc.). However, the formatting of outputs (roll back, graphs, Monte Carlo output, etc.) is controlled by the computer's regional settings. The default computer Regional Settings from the computer will be saved with the model, so it will open and run an a computer setup with different Regional Settings.
Tree Preferences - Regional Settings

- **Locale**: Select the locale that defines the numeric format for model inputs.
- **Use custom regional numeric settings**: Check this box to override the locale's regional settings for model inputs.
- **Decimal separator**: Select a period (.) or comma (,) as the decimal separator for model inputs.
- **Thousands separator**: Enter a character to use to separate thousands in model inputs. In the US, a comma is used so one million dollars could be entered like this: $1,000,000.00.
- **Currency symbol**: Enter the currency symbol to use for model inputs.
- **Symbol to the left of the number**: Check this box to enter the currency symbol to the left of the number. Uncheck it to enter the currency symbol to the right of the number.
- **Replace Separators button**: Click this button to replace the separators within the model inputs. This is described in the next section.

### 50.9.1 Replace Regional Settings

The Replace Regional Settings Tree Preferences category allows you to replace the regional settings within numerical expressions in the model.

These Tree Preferences are enabled only if the "custom regional numeric settings" preference is checked.
Tree Preferences - Replace Regional Settings

- *Inversion method*: Choose from among the following inversion methods. Each changes the values in numeric expressions within the model.
  
  *Invert periods and commas*: Replace all periods with commas and vice versa.
  *From period to comma only*: Replace all periods with commas.
  *From comma to period only*: Replace all commas with periods.
  *Custom*: Create custom inversion methods.

- *Find/Replace with grid*: Use the "+" and "X" buttons to add and delete rows from the grid. Enter the target value into the Find column and the replacement value into the Replace With column.

50.10 Other Calc Settings

The Other Calc Settings Tree Preferences category allows you to set a few additional calculation settings.
Tree Preferences - Other Calc Settings

- **Allow probabilities to not sum to 100%**: When checked, TreeAge Pro will not generate an error when probabilities do not sum to 100% and analyses will run. We recommend against using this option. Instead, you can set specific Chance and Markov nodes to be non-coherent (by selecting the node and then right-click and choose from the dropdown menu options).
- **Max. # allowed stages (cycles)**: Set the maximum number of cycles for any Markov model.
- **Tracker Modification Order**: Select the order for tracker modifications to be calculated at a specific node.
- **Microsimulation Check**: When this option is checked, you will not see the warning when you run Expected Value Calculations on a model with trackers and/or patient level distributions.

⚠️ When the Tracker Modification Order sorts by ascending priority, the secondary order is forward alpha. When it is by descending priority, the secondary order is by reverse alpha.

### 50.11 Tables

These Tree Preferences control whether to look for Global Tables and they allow you to enter a specific location for referencing Global Tables.
Tables Preferences

Check the box to look for table data in Global Table files.

If the path is entered into the input field, then TreeAge Pro will look in that path for Global Table files. If the path is not entered, then TreeAge Pro will look in the following locations within your workspace in order.

1. `<workspace>/Global Tables`
2. `<workspace>/Example Models/Special Features/Global Tables`

If a Global Tables file is found in the first location, it will not search the second location.

50.12 Markov/DES

The Markov/DES Tree Preferences allow Half Cycle Correction Method to be set for Markov Models. It also allows the default termination condition to be set for all new Markov or DES nodes.

Markov/DES tree preferences

- **WCC:** For Markov models, the Half Cycle Correction method can be set to either Traditional or Within-Cycle Correction. This impacts how rewards are defined in the model and more details can be found in the Markov Modeling Tools and Techniques Chapter.
- **Default termination conditions**: For both Markov and DES nodes, the default termination condition can be set here for all new nodes of these types.

You can access the Tree Preferences directly for Markov (or DES) models through the Markov (or DES) Info View as indicated in the figure below.

![Access Markov tree preferences](image)

**Link to Tree Preferences for Markov/DES directly in the Markov Info View (same for DES Info View)**

### 50.13 PartSA

The PartSA Tree Preferences allow time units for the Survival curves and the Time reports to be set.

![PartSA Tree Preferences](image)

**PartSA Tree Preferences**

- **Survival time unit**: Set the time unit for the model to Annual or Monthly. Note that this needs to be consistent with the time units for your Survival Functions.
- **Time Report unit**: Set the time unit for the Time Report to Annual or Monthly. This only affects the Time Report output.
- **Integration step**: Use Default or Custom. We strongly recommend using the Default, which will calculate 360 individual steps per year.
- **Default time horizon**: The default value used when new PartSA nodes are added to the model.
- **Survival curves graph**: Set the number of points to graph in the Survival Curve graph.

You can access the Tree Preferences directly for PartSA models through the PartSA Info View as indicated in the figure below.

### 50.14 Fonts

This is the first category related to Display settings.

The Fonts Tree Preferences allows you to specify the font type for several labels/values within the model.
Tree Preferences - Fonts

- **Node Font**: Click this button to select the default font for node labels/text. The font selected in this manner will apply to any new nodes created in the active tree and to any existing nodes, except for any nodes where the font has been set individually.

- **Prob Font**: Click this button to select the default font for probability expressions in both the rolled-back and unrolled-back state. This allows you to clearly distinguish between probability variable names and adjacent node descriptions.

- **EV Font**: Click this button to select the default font for expected value boxes generated during roll back. It also applies to other information which is not user-editable and displayed next to a node, such as clone names when clones are hidden, or payoff names when Always show payoff names is selected.

- **Var Font**: Click this button to select the default font for variable definitions when shown within the tree.

After clicking one of the font buttons, the font selection dialog allows you to specify the font, font style, etc.
Tree Preferences - Fonts - Font Dialog

50.15 Node Text/Comments

The Node Text/Comments Tree Preferences category allows you to show/hide certain text labels/values within the model.

- **Mark nodes with comments**: Check this box to display a small flag above the node symbol for all nodes with associated Node Comments. This flag does not print or export.
- **Hide all node texts**: Check this box to suppress all textual information in the Tree Diagram Editor. Use this flag to get a picture of the structure of your tree.
- **Hide probabilities only**: Check this box to hide only probabilities expressions in the Tree Diagram Editor, while all other textual information is visible. Use this flag to temporarily simplify the display of complex trees with many uncertainties.
- **Wrap long probability expressions**: Check this box to wrap probability expressions that may exceed the width of a node.
- **Show IDs of nodes:** Show node IDs next to the node labels in the Tree Diagram Editor and Tree Explorer.
- **Hide all notes:** Check this box to hide/show all the notes in the Tree Diagram Editor.

### 50.15.1 Node ID Report

In addition to the option to "Show IDs of nodes", you can create a Node ID Report outside of the Tree Preferences. In your model, go to the menus and choose Node > Node ID Report from the menu. The Node ID Report is displayed below.

![Node ID Report generated from the Node menu](image)

### 50.16 Printing

The Printing Tree Preferences category allows you to specify printing options for the model.

![Tree Preferences - Printing](image)

- **Printing zoom factor:** Set the zooming scale for printed output of the model. A lower percentage will fit more of the model on a page.
Note also that it is independent of any scaling specified under Page Setup. Thus, if your printer
driver allows scaling via the Page Setup command, you run the risk of applying one percentage
against another.
The printing zoom factor is also independent of the screen-display zoom factor, set via the
Modeling Palette.

50.16.1 Page Header/Footer

The Page Header/Footer Tree Preferences category allows you to specify a page header and a page
footer that are used when printing the model.

Tree Preferences - Page Header/Footer

- **Header**: Text to display at the top of each printed page of model.
- **Header Font**: Font to use for header text.
- **Header Align**: Horizontal alignment for header.
- **Footer**: Text to display at the bottom of each printed page of model.
- **Footer Font**: Font to use for footer text.
- **Footer Align**: Horizontal alignment for footer.

50.17 Terminal Columns

The Terminal Columns Tree Preferences category allows you to create terminal columns to display
during roll back of the model.
When enabled, terminal columns are presented to the right of the standard payoff values at each terminal node.

Note that you can now show extra payoffs in the Rankings report by configuring the model to "calculate extra payoffs". This is simpler and easier than Terminal Columns if all you need is the expected values for all enabled payoffs.

The following figure shows the preferences for the special features tutorial example model Terminal Columns.trex.

Tree Preferences - Terminal Columns

- **Show terminal columns**: Check this box to show terminal columns on roll back instead of expected values.
- **Terminal column grid**: Grid showing existing terminal columns.

Terminal columns can be edited directly in the grid. Click the "plus" icon to add a terminal column to the grid. Click the "X" icon to delete the selected terminal column. There is no separate terminal column dialog. The columns in the grid are described below.

- **Header**: Enter text to be displayed above the terminal column data.
- **Calculation**: Select the type of calculation to be performed for the terminal column.
  - **Expected Value**: Show the expected value of the active payoff.
  - **Incremental Value**: Show the incremental change in expected value between this strategy and the previous one.
  - **Path Probability**: Show the path probability for the terminal node.
- **Scenario Number**: Show the scenario number which counts from one starting at the top terminal node.
- **Custom**: Show a custom expression as defined in the Custom calculation column.

- **Custom calculation**: Enter a custom expression using TreeAge Pro variables, functions, etc.
- **Algorithm**: Determines how to calculate the value for a collapsed subtree. This only applies to columns using custom calculations.
  - **Weighted**: Use the weighted average from the terminal nodes contained within the collapsed subtree.
  - **At Node**: Use the value from the node at the base of the collapsed subtree.

- **Numeric format**: Select the numeric formatting to use for this value.
  - **Standard**: Use formatting for active payoff.
  - **Probability**: Use formatting for probabilities.
  - **Custom**: Use custom formatting.

- **Custom font**: Change the font preferences for the column.

Terminal columns are discussed in further detail in the Tree Display Preferences and Options Chapter.

### 50.18 Terminal Nodes

The Terminal Columns Tree Preferences category allows you to specify how terminal nodes are displayed within the model.

- **Display payoff names**: Check this box to display the name/expression of the active payoff at every terminal node. This can be helpful for identifying terminal nodes where a payoff has not been assigned. In the case of trees having multiple payoffs, this feature makes it possible to see at a glance which payoff is active.
- **Display payoffs boxed**: If you have chosen to always display payoff names, check this box to enclose the payoff names/expressions in a box. This option relates only to tree display prior to roll back; during roll back, calculated values are always boxed.
- **Automatic node numbering**: Check this box to display a node number for every terminal node. The numbering format is controlled by the *Numbering text format* field.

- **Number all nodes in tree**: Check this box to number all nodes in the model rather than numbering only the terminal nodes.

- **Numbering text format**: Use this field to specify the custom text for node numbering. Use the ^ (caret) symbol in the text to represent the scenario number.

- **Show terminal node symbols as**: Select one of the three methods for showing terminal nodes in the model. Triangles are the default (and standard) method. Diamonds are used to indicate the parallelism between terminal nodes in a tree. Lines are for those applications when you do not want any symbol displayed to the right of a final outcome.

### 50.19 Tree Editing/Layout

The Tree Editing/Layout Tree Preferences category allows you to control a few editing and visual elements of the Tree Diagram Editor.

![Tree Preferences - Tree Editing/Layout](image)

- **Default branches per node**: Select the number of branches to add when you select Add Branches from the context menu at a node. The default number applies only the first time that branches are added at a given node. Once a node has branches, additional branches are added one at a time.

- **Add branches at**: Select the location for new branches relative to existing branches when adding additional branches to a node. Dragging new nodes from the palette provides additional flexibility in this area.

- **Keyboard navigation**: Select the branch to move to when using the right arrow to navigate from a node to one of its branches.
- **Minimize empty space**: Check this box to produce a “compressed” version of your tree that minimizes empty space. Because each node no longer has its own horizontal “slice” of the tree display, this option may not be used with Align endnodes.

- **Align endnodes**: Check this box to force all terminal nodes to line up at the rightmost edge of the tree.

- **Branch lines at right angles**: Check this box to draw all branch connectors as vertical lines. By default branch connectors are drawn at whatever angle is needed to provide the most direct connection from one node to the next.

- **Show clone-copy subtrees**: Check this box to display clone-copy subtrees; display of clone masters is not affected. When this option is selected, all clone-copy subtrees are displayed with their complete structure. When this option is not selected, only the name of the clone is displayed to the right of the clone-copy anchor node, which can dramatically reduce the visual size of your tree within the Tree Diagram Editor.

### 50.20 Variables/Markov Info

The Variables/Markov Info Tree Preferences category allows you to control the way variables, Markov information and other information is displayed in the Tree Diagram Editor.

- **Display definitions at nodes**: Select the option to either hide or show variable definitions beneath nodes in the Tree Diagram Editor.

- **Show Markov information**: Show Markov information beneath the node line where applicable (Markov termination condition, Markov state rewards, Markov transition rewards, etc.). Choose whether to display only the active payoffs or all enabled payoffs.
- *Show tracker initial values*: Check this box to show the initial value of trackers at the root node.
- *Show named distributions*: Check this box to show the names of distributions at the root node.
- *Use variable categories in tree window*: Organize variables by categories in the Tree Diagram Editor.

### 50.21 Dynamic Links

This is the first category related to *Spreadsheet* preferences.

![Tree Preferences - Identifying Variables](image)

The Identifying Variables Tree Preferences category allows you to store specific variables and their values with Monte Carlo simulation output.

### 50.22 Identifying Variables

This is the first category related to *Analysis Settings* preferences.

The Identifying Variables Tree Preferences category allows you to store specific variables and their values with Monte Carlo simulation output.
Tree Preferences - Identifying Variables

This can be useful if you run/save multiple sets of simulation outputs with different variable values - potentially generated by a stored analysis sequence.

50.23 Debugging/Calculation Trace

The Tree Preference for Debugging allows you to select the information you want to show in the Calculation Trace Console and to control the console settings. The Debugging/Calculation Trace Console settings will apply to the whole model. For models with a large number of internal calculations this may take a long time. The sections about Model Debugging show how to select specific information to write to the console.

The Debugging/Calculation Trace Console Tree Preferences category allows you control over the output in the debug view during analyses.
Tree Preferences - Debugging/Calculation Trace Console

- **Show in Console**: Select the items you wish to see in the debug view as TreeAge Pro performs calculations.
- **Errors, warnings and notes**: Check this box to avoid having TreeAge Pro pop-up dialogs when warnings or error messages need to be displayed; instead, checking this box will have the text added to the Calculation Trace Console.
- **Text-only analysis output**: Check this box to write text report analysis output to the Console. For example, Rankings output is purely text and would be written to the Console.
- **Saved analysis abstract/summary**: Check this box to display summary information in the Calculation Trace Console about any new analyses available for storage. This information can be stored for later use via Stored Analysis.
- **Console settings**: Select how you want the output to the console to be displayed.
- **Clear console before each analysis**: Check this box to clear the console before each new analysis.
- **Limit console output (if # of lines exceeds)**: Select the maximum number of lines to display within the Calculation Trace Console. Older lines are dropped when the maximum number of lines
is exceeded. A larger number holds more outputs in the debug view, which uses more system resources.

The main controls for the output are in the section *Show output for*:

- *All*: Select this for all the internal calculations to be written to the Calculation Trace Console.
- *None*: Turns off debug output.
- *Selected Elements*: Select this to show only specific calculations in the Calculation Trace Console. When you select this choice, you need to select elements of the model to debug via the check boxes in the Variable Properties, Tracker Properties and Distributions Views.

For more details about using these settings see the section about Model Debugging.

### 50.24 Output Reports

The Output Reports Tree Preferences category allows you to filter the secondary reports available from Monte Carlo simulations.

There are two main options...

- Hide PSA reports for microsimulation
- Display only selected reports from list below

#### 50.24.1 Hide PSA reports for Microsimulation

The "Hide PSA reports for microsimulation" option specifically hides all secondary reports that are inappropriate for Microsimulation. Microsimulation is patient-level simulation, so secondary reports are invalid if they rely on incremental calculations among strategies on an iteration-by-iteration basis.

This option defaults to checked. Uncheck the box to see all secondary reports.

#### 50.24.2 Display only selected reports from list below

The "Display only selected reports from list below" option allows modelers to specify which secondary outputs should be displayed. This is normally used when modelers want to simplify the secondary output display to focus on a specific subset of secondary reports.

Check the option "Display only selected reports from list below" to removing some of the output options to make it easier to find the output options you wish to highlight. A modeler might choose to filter the output generated by a Player Model to make it easier for the recipient of the player model to find a specific output.
Tree Preferences - Output Reports

The reports are all types of Monte Carlo reports, and then there are group-level checkboxes for "Data", "Rankings", "PSA Outputs", "CEA Outputs" and "Distributions (Histograms)" options. Use these to check or uncheck all options within those groups.

The remaining options either include (checked) or exclude (unchecked) that specific output from the Monte Carlo simulation output. Not all options apply to all simulation output. Those restrictions are highlighted below.

- **Identifying Variables** - all output
- **All Data** - Values, Dists, Trackers - all output
- **Strategy Values** - all output
- **Trackers** - only if model contains trackers
- **Extra Payoffs, All** - only if extra payoffs are included in model
- **Distributions (by name)** - only if model contains distributions
- **Distributions (by index)** - only if model contains distributions
- **Trackers, All** - only if model contains trackers
- **Strategy Selection Frequency** - only if non-CE model
- *Distributions, All* - only if model contains distributions
- *Acceptability Curve* - CE models only TOP
- *ICE Scatter + Ellipses* - CE models only
- *EVPI/EVPPI Summary Report* - all output
- *CE Scatter Plot* - CE models only
- *CE Graph* - CE models only
- *CE Graph (inverted)* - CE models only
- *CE Rankings Report* - CE models only
- *NMB v. WTP* - CE models only
- *Incremental (INMB) v. WTP* - CE models only

**Output Report Options**

### 50.25 Report Filters

When you run Monte Carlo Simulations, you can filter the data to focus on a subgroup of those results. When filters are created, they are included here in Tree Preferences, so you can use those filters again for future simulations.

For more information on Filters, please refer to Patient Simulation Chapter.

### 50.26 Monte Carlo Options

The Advanced Monte Carlo Options Tree Preferences category allows you to specify advanced options for Monte Carlo simulation. For more details about these options see the Section Simulation Options.

There are four different options found in this category, starting with *Distribution Sampling.*
50.26.1 Distribution Sampling

There are three main options to determine which distributions to sample - all, none or some. Typically, you would sample all distributions unless you were testing the model by skipping some.

- **Sample all**: Default setting. This will sample all distributions.
- **Sample none**: Check this box so there are no sample distributions.
- **Sample some (make selections below)**: Check this box to choose the distributions you want to sample using the selection boxes.
- **Sample per EV calculation (for PSA)**: This selection box pair allow you to choose the distributions to sample for the whole cohort for PSA.
- **Sample per trial or stage (for Microsimulation)**: This selection box pair allow you to choose the distributions to sample for each individual trial to be used in Microsimulation.
- **EVPPI Sampling**: This selection box pair allows you to choose the distributions to sample for EVPPI. See the section on Value of Information for more details.

**Sample distributions during Monte Carlo:**

If you choose to sample *some* distributions, then you need to specify which distributions to sample in the next two sections.
Sample per EV calculation (for PSA): Choose the PSA-level distributions you want sampled by moving them from the left pane to the right pane using the control buttons.

Sample per trial or stage (for Microsimulation): Choose the patient-level and cycle-level distributions you want sampled by moving them from the left pane to the right pane using the control buttons.

The last section, hidden by default, only applies to EVPPI sampling where there are two simulation loops related to a 2-level PSA.

EVPPI Sampling: Choose the PSA-level distributions you want sampled in the outer PSA loop (for specific study) by moving them from the left pane to the right pane using the control buttons. Distributions in the left pane will still be sampled, but the uncertainty of those distributions will be hidden by aggregation to mean values within the EVPPI analysis. See the section on Value of Information for more details.

50.26.2 Random Number Seeding Options

Monte Carlo Simulation generates stochastic results via random number generation. Seeding options are designed to provide maximum flexibility to stabilize random number generation and hence output values within the simulation context.

- Seed random number generator: Check this box to stabilize the overall model results from one simulation to the next.
- Seed: If the prior option is checked, set the initial seed for the random number sequence. Changing this value will generate a different but repeatable set of results.
- **Stabilize Microsimulation when run as inner loop within PSA.** This option applies only to Microsimulation when running within the context of PSA. Checking this box ensures consistency among sets of patients within the Microsimulation as the outer loop PSA sampled inputs change.

- **Stabilize PSA sampling when run as an inner loop with EVPPI.** This option applies only to EVPPI simulations, which have two PSA loops. Checking this box ensures that the same set of samples are drawn from the PSA-level distributions while the outer-loop PSA sampled inputs change.

- **Stabilize Microsimulation when run as inner loop within Sensitivity Analysis.** This option applies only to Microsimulation when running within the context of deterministic sensitivity analysis (1-way, 2-way, 3-way, tornado). Checking this box ensures consistency among sets of patients within the Microsimulation as the input parameters vary within their respective ranges.

**Seeding options**

All seeding should be used cautiously. Seeding generates repeatable results from analysis to analysis or from inner loop to inner loop. It is not a substitute for running a representative number of iterations to stabilize the overall mean results from any analysis.

**50.26.3 Threading Options**

Threads are separate processes that can run concurrently on your computer. The more threads used for an analysis, the faster it will run.
There may be times when you want to limit the number of threads - when patients interact with each other and need to run on the same thread, or when you want to limit the system resources used by an analysis to leave computer power for other programs.

- *Set number of threads:* Check this box to determine a specific amount of threads you wish to run. If unchecked, TreeAge Pro will run a thread on every chip that's available.

**Multi-threading:**

### 50.26.4 Downstream Decision Options

These options are no longer used

![Tree Preferences - Monte Carlo Options - Downstream Decision Options](image)

### 50.27 Time Reporting Selection

Please read the Chapter about Time Reporting which provides extensive detail about Time Reporting incorporating using this Tree Preference.

### 50.28 Stored Analysis Abstracts and Sequences

Stored Analyses and Sequences are described in a separate chapter.

### 50.29 Application Preferences

Application Preferences control many settings and options for the TreeAge Pro application and are not associated with a specific model, and therefore apply to all models.

Application Preferences are edited using the Application Preferences Dialog.

### 50.30 Application Preferences Dialog

The Application Preferences Dialog is used to edit Application Preferences.
To open the Application Preferences Dialog:
- Choose Window > Application Preferences from the menu.

Application Preferences Dialog

Subsequent sections will describe each category of Application Preferences.

50.31 Application Preferences - Backup/Save

The Backup/Save Application Preferences category allows you control on how TreeAge Pro backs up your work.
- *Create backup copy on save*: Check this box, and TreeAge Pro will save a backup copy of each file that you open and subsequently save changes to. The backup file contains the version of the file as it existed when it was opened. No matter how many times you modify or save the file after opening it, its backup file continues to contain the original version of the document. If you close a file and then reopen it, the backup process is restarted; if a backup file already exists for a document that you open, TreeAge Pro will overwrite the existing backup file when you save the document. The backup file is created in the same directory as the original file (unless you check to save in a separate folder). The file is saved with the prefix “zOrig” to the filename; for example, the backup file for “my tree #1.trex” would be saved as “zOrig.my tree #1.trez”.

In the case of a new, untitled document, a backup file is not created the first time it is saved, since no original document file existed on disk at that point; the backup file will be created the next time you save changes to the file.

- *Save backups in a separate subfolder*: Check this box to save the backup copies in a folder called: TreeAge-backups. This folder will be within the original folder the model was in. If it is unchecked, the backups are just saved alongside the original model.

- *Prompt to save analysis output*: Check this box and TreeAge Pro will ask you to save all analysis outputs everytime you try to close them.

### 50.32 Application Preferences - Display

The Display Application Preferences category allows you to control some elements of the display.

- *Prompt to show in empty labels (optional)*: Present this as a prompt when no label has been entered for a node.
- *Disable antialiasing (restart required)*: No longer used.

**50.33 Application Preferences - Keys**

The Keys Application Preferences category allows you to setup keyboard shortcuts for functions within TreeAge Pro.

![Application Preferences - Keys](image)

Use these settings to add/edit hot key options for actions in the menu. We recommend that you leave the existing hot key options in place.

**50.34 Application Preferences - Launch Pad**

The Launch Pad Application Preferences category allows you to control the elements which appear in the Launch Pad. Experienced users may not want to see the Assistants (for example).
Application Preferences - Launch Pad

The elements are:

- "Create new" tab: Select the elements you want to see in the Create New tab.
- "Open" tab: Select the elements you want to see in the Open tab.

50.35 Application Preferences - Automatic Updates

The Automatic Updates Application Preferences category allows you control over how the TreeAge Pro application is updated as new updates are released.

Application Preferences - Automatic Updates

- Automatically find new updates and notify me: Check this box to have TreeAge Pro automatically check for new updates to the software as they become available.
- **Update schedule**: Select an option for when to check for new updates.
  - *Look for updates each time TreeAge Pro is started*: Check each time TreeAge Pro is started.
  - *Look for updates on the following schedule*: Check based on a custom schedule.
- **When updates are found**: Select a schedule for notifications regarding available updates.
  - *Notify me once about updates*: Notify once when updates are available but never again.
  - *Remind me about updates every*: Notify repeatedly when updates are available based on a custom schedule.

### 50.36 Application Preferences - Monte Carlo Distributed Processing

The Monte Carlo Distributed Processing Application Preferences category allows you to setup helper computers to spread out Monte Carlo simulations over a number of separate computers.

**Application Preferences - Monte Carlo Distributed Processing**

- **Use distributed computers**: Check this box to use helper computers.
- **Server name**: The helper computer name. The helper computer can be used to perform some iterations of a Monte Carlo simulation so that the overall simulation runs faster.
- **Status**: The status of the helper computer, which indicates whether the helper computer is available.
- **Reason**: Purpose for which the helper computer was added.
- **Add button**: Add a new helper computer.
- **Remove button**: Remove the selected helper computer.
- **Refresh button**: Refresh the status of all helper computers.
- **Select All button**: Select all helper computers in the grid.
- **Select Ready button**: Select all helper computers that are ready.
- **Deselect All button**: All helper computers are no longer selected.
Note that when you use helper computers, you typically also want to add the local computer as "localhost" to do some of the simulation work.

### 50.37 Application Preferences - Storage

The Storage Application Preference category allows you to modify the way TreeAge Pro stores data during analyses.

- **Store raw Monte-Carlo simulation data on disk** - Analysis data is stored on disk by default so that you do not exceed the computer's memory. Check this box to store the data in memory instead. Note that this option is only available for 64-bit versions of TreeAge Pro.
- **Storage location for temporary analysis** - Change the folder TreeAge Pro uses to store data for model analysis. You might change this to a different location if your workspace is on a drive with limited disk space. **NOTE** this folder is deleted after analyses so do not choose a folder where you want to save any other files.

### 50.38 Application Preferences - Python

Control the way Python functions within TreeAge Pro.
Application Preferences - Python

- Do not show enable Python question - Stop warning question each time you open a model with Python functions.
- Use external Python installation - Use a version of Python installed on your computer rather than the version bundled with TreeAge Pro (Java Python).
- Override path to Python - Enter a path to a specific installation of Python that is not the default version for your computer.
51. Technical Details & Utilities

This chapter contains technical details on the TreeAge Pro application and TreeAge Pro utilities.

51.1 TreeAge Pro products and modules

TreeAge Pro follows a modular design. The "Core" module includes both decision tree functionality, Monte Carlo simulation, multi-way sensitivity analysis, and much more. Additional features for Healthcare analysis may be added in the optional Healthcare module. Both "Core" and "Healthcare" products include the Excel™ add-in module.

The TreeAge Pro Healthcare module integrates core decision analysis functionality with specialized capabilities, including:

- Markov cohort analysis
- Individual-level, Markov simulation
- Cost-Effectiveness analysis
- Net Benefits analysis
- Additional information available at https://www.treeage.com/shop/treeage-pro-healthcare/

Healthcare Module Functions

The TreeAge Pro Excel module is included in both products. It can help:

- Automate the creation of Excel charts and reports from within TreeAge Pro
- Simplify the integration of spreadsheets and TreeAge Pro models
- Edit input data in Excel
- Output analysis data to Excel
- Additional information about the "Core" product is available at https://www.treeage.com/shop/treeage-pro/

Excel Module Functions

51.2 Node Types

Decision trees can include nodes with a number of different node types. This section lists the node types and their typical usage. The Tree Diagram Editor Palette displays all the available node types.
- **Chance**: Used to represent a situation with an unknown outcome. Each branch of the chance node represents one of the outcomes. There must be a branch for every possible outcome, and each branch will include a probability expression for the likelihood of that outcome. The hashtag (#) can be used for one of the branch probabilities, which is calculated as the complement of the sum of all other probability expressions.

- **Terminal**: Used to terminate endpoints in a model. All endnodes (no branches) must be terminal nodes. In a decision tree, a terminal node represents the end of a scenario, and payoff values are required to place value(s) on that scenario. In a Markov model, a terminal node represents the end of a cycle, and a jump state is used to return the cohort to a health state to start the next cycle. In DES models, terminal nodes function the same as in Markov models.

- **Decision**: Used to represent a decision point within a model. Each branch represents a strategy which will be evaluated separately to determine the optimal strategy at that decision node. It is typical for a model to contain a single decision node as the left most node in the model (the root node).

- **Logic**: Used like a chance node with an unknown outcome. However, each branch will have a logical expression instead of a probability expression. Logical expressions are checked from the top branch down. The model will flow to the first branch with a logical expression that evaluates to true. It is common to use the hashtag (#) for the bottom branch for when all logical expressions for the other branches are false.

- **Markov**: Used as the start of a Markov model. The Markov node and its entire subtree are part of the Markov model, which is normally part of a larger decision tree model.

- **Label**: Used to simply flow from a node to its one and only branch. It functions the same as a chance node with a single branch with probability of 100%. This is commonly used to separate dependent calculations, so the calculations at the label node are complete before the calculations are performed at the branch node.

- **Summation**: Used to sum the expected values (EVs) of all branches within a decision tree, rather than use a weighted average as is done for chance nodes. This is commonly used when there
are multiple separate value calculations and the sum of those values represents the total EV. For example, branches could be used in a legal model for compensatory damages and punitive damages, such that the total value is the sum.

- **DES**: Used as the start of a Discrete Event Simulation (DES) model. The DES node and its entire subtree are part of the DES model, which is normally part of a larger decision tree model.
- **Time**: Used only within a DES model. Each branch of a DES node represents a possible event with a time-to-event expression. Time passes and time-based value is accumulated at this node until an event occurs.
- **Entry**: Used in Dynamic Cohort models. The Entry node is used to add members to the cohort. The node branch itself has no impact on the cohort size but the branches of the entry node add members to different health states. The node must be set to non-coherent to enable additional members to be added.
- **Stop**: Used in Parallel Trial models. The Stop node is used at the point in the model where trials running through a model in parallel need to wait for resources before they can complete their actions.

### Node Types

#### 51.3 Random number generator details

Monte Carlo simulations in TreeAge Pro make use of a robust pseudo-random number generator (RNG) algorithm, the Mersenne Twister, which has the following useful properties:

1. Has a period of $2^{19937}$, or approximately $10^{6001}$ unique sequences.
2. Has negligible serial correlation between successive values in the output sequence.
3. Works fast.
4. Passes numerous tests for statistical randomness.

Distribution sampling and discrete simulation random walks utilize the RNG. By default, each RNG is “seeded” using the computer clock. This “random” seeding can be overridden by the user specifying a random seed value in the Simulation options. The Simulations Options can be found in Tree Preferences > Analysis Settings > Monte Carlo Options > Random Number Seeding Options.

In a multi-processor simulation, each thread has a separate RNG, which is started at a different position based on the clock seed or the user-specified.

Click here to review seeding options.

#### 51.4 Report Output Files (*.rptx)

Report outputs from Monte Carlo, Sensitivity, and Markov Cohort analyses can be saved in *.rptx files. These files can be reopened in TreeAge Pro to generate graphical and text output.
The *.rptx file is a zip file, which contains an H2 datasource/database (plus other files). This datasource is queryable from outside of TreeAge Pro through an H2 browser console.

You can copy the *.rptx files, change the extension to *.zip, and uncompress the files ("datasource" and "datasource.*" files are needed). The path to “datasource” will be used to connect in the browser console.

It is possible to then run the H2 database service/console from an "h2.jar" file zipped within the TreeAge Pro plugins directory; it will be easier to install H2 separately. Click here to go to the H2 site. The Download page will allow you to download the H2 Database Engine. The Quickstart page provides information on installation.

You can then run the h2.jar to open the console in a browser, add/browse to the path of your datasource, and enter the username ("sa") and password ("sa").

The H2 Console then provides access to the database tables, allowing you to create queries to pull data as needed.
H2 Console within browser

51.5 Importing TP 2009 Simulation Output

The current TreeAge Pro software can import the *.MCS simulation output files generated by TreeAge Pro 2009 and earlier software versions.

To import an *.MCS file:

- Choose File > Import/Export > Import TreeAge 200X MCS File... from the menu.
- Enter options in the Import MCS dialog (see below) and click OK.

The options in the dialog allow you to filter the number of rows and/or columns to include in the imported output. This can reduce the size of the data imported.
51.6 TreeAge Pro News Reader

The News Reader is used to provide TreeAge Pro users with important information regarding product updates, new products, training, licensing issues, etc. When new news items are available, the News Reader will retrieve and display the items.

News Reader View

Under Window, there are Application Preferences available to control the type of news items you wish to see.
51.7 Integration with other software

In TreeAge Pro, users of the Excelmodule gain access to powerful features that allow automation of TreeAge Pro tasks via scripts and macros, in order to control the updating and analysis of your models.

In addition, the embedded Python script interpreter has been improved, giving modelers easy access to the powerful Python programming language.

51.8 Installation and system requirements

To install TreeAge Pro, please go to www.treeage.com/install and enter your serial number. You will be presented with a list of installers. Choose the one that is appropriate for your computer. After installing, you will need to authorize TreeAge Pro with your license serial number.

System requirements are available at https://www.treeage.com/support/system-requirements/.

51.9 Cross-Platform Compatibility

TreeAge Pro 2011 and subsequent versions are built in the Eclipse architecture, which allows the software to run on Windows, Mac, and Linux operating systems. There are different installers for each OS available at our website. In each OS, the software should have a look and feel that for the most part matches the native view for that OS.

Since TreeAge Pro 2009 and earlier versions ran only on the Windows OS, most of the instructions in this manual describe Windows operations. There are some differences in commands/mouse-clicks on Mac and Linux. The table below describes some of these differences.

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control + key</td>
<td>Command + key</td>
<td>?</td>
</tr>
<tr>
<td>Right-click</td>
<td>Control-click</td>
<td></td>
</tr>
<tr>
<td>Function keys</td>
<td>Fn key + function key</td>
<td></td>
</tr>
</tbody>
</table>

Command differences among operating systems

51.9.1 Mac Function Keys

Mac computers often use function keys to interact with the Mac Operating System. You can release those function keys from their OS functions by changing settings in the System Preferences under the category Keyboard. Specifically...

- Check the box to use F1, F2, etc. as standard function keys.
- Uncheck the box for active use of "Expose & Spaces" or "Mission Control".
51.9.2 Linux with GNOME Desktop Environment

If you use Unix-like operating systems with the GNOME desktop environment, you may be unable to see the application's menu icons.

If you experience this problem:
- Start the gconf-editor.
- Select the checkbox in /desktop/gnome/interface/menus_have_icons

51.10 File compatibility

TreeAge Pro 2011 introduced a new XML-based model file structure.
- Models saved in TreeAge Pro 2011 or later use the file extension .trex.
- Models saved in TreeAge Pro 2009 or earlier use the file extension .tre or .pkg.

File formats

51.10.1 Compatibility issues with new features

Every 6 months, a new version of TreeAge Pro is released. This may make models built in newer software incompatible with older software. Please be careful using new features if you need to share models with a colleague that uses older software.

Model validation allows you to identify features that will not work in older post-2011 software. Use of those features must be removed if sharing with a colleague with older software.

51.10.2 Compatibility between models from TP 2009 and TP 2011

Older *.tre and *.pkg files can be opened in TreeAge Pro 2011 and subsequent versions. When you open a files from an older format, you are asked whether you want to save the file in the new format or the old format.